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 Getting Started
Before you begin using Civic Platform you must load your product license keys. Then you can begin
configuring your Civic Platform environment to best suit the unique needs of your agency, via the Setup
portlet.

The Setup portlet enables you to access a wide range of Administration portlets, where you configure your
Civic Platform implementation.

Click a topic title below for full details.

Related Links

Loading Your License Keys

Navigating to the Setup Portlet

Loading Your License Keys
Civic Platform requires license keys to access core product functionality. Accela Customer Support
provides the license key for each agency. The license key entitles the agency to a fixed number of licenses
for one or more of Accela's solutions, including:

• Civic Platform - Asset

• Civic Platform - Land

• Civic Platform - License and Case Management

• Civic Platform - Service Request

Your license entitles you to a fixed number of users for each solution. You can distribute these licenses
across the modules that comprise a particular solution, in any way that meets the requirements of your
agency. You can assign a single named user account to use one or more modules in a solution, but not a
module from another solution.

Your license can entitle you to one or more of the following add-on products that enhance core Civic
Platform functionality:

• Citizen Access

• GIS

• IVR

• Mobile Office

Use Case Example

You have five users in your agency and your agency uses three modules (Building, Planning, and
Enforcement) for your Land Management solution. You need five user licenses and you can assign these
five user accounts to any combination of the three modules. For example, you can assign all five users to
each of the modules, and you can also assign two users to the Planning module and three users to both
the Building and Enforcement modules.

To load a product license

1. Contact Accela Customer Support to obtain your product license key.
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• For online assistance, go to the Accela Success Community: https://accela.force.com/success.

• For phone assistance, call (888) 7-ACCELA, extension 5, or (888) 722-2352, extension 5. Accela
Customer Support representatives are available by phone Monday through Friday, 4:00 AM - 6:00
PM, Pacific Time.

2. Access the Setup Portlet (Navigating to the Setup Portlet).

3. Go to System Tools > Product License.

Civic Platform displays the License Details portlet.

4. Click Import.

5. Click Browse.

6. Locate and select your license key file.

7. Click Submit.

8. Restart the IIS server.

Navigating to the Setup Portlet
The Setup portlet enables you to access the Administration portlets, where you configure your Civic
Platform implementation to best suit the unique needs of your agency.

To access the Setup portlet

1. Log in to Civic Platform.

2. Civic Platform displays your personalized home page. The layout of your home page depends on how
you have configured your console (Setting Up Your Console and Home Page).

3. Navigate to Civic Platform Aministration.

Civic Platform displays the Setup portlet.
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4. Click a chevron next to a menu to expand the menu and view its available options. The Administration
menu expands for you to choose either Civic Platform Admin or Citizen Access Admin, as shown below.

5. Click a link to open the associated portlet.

Civic Platform displays the associated portlet.

Accessing Classic Administration
Civic Platform provides the “Classic” Administration interface for performing a variety of administrative
functions.

To access Classic Administration

1. Create a main link for Classic Administration (Setting Up Your Console and Home Page).

2. Click the main link for Classic Administration.
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Civic Platform displays the portlet.

3. Click the Admin Tools tab to access administrative functions; click the Daily tab to access daily user
functions.

Accessing Record Type Administration

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Civic Platform Aministration.

Civic Platform displays the Administration page.

Accessing the Form Layout Editors
To access a form layout editor

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click one of the following links to open the form layout editor you want to work with.

• Agency Profile > APO Form Layout Editor

• Agency Profile > ASI Form Layout Editor

• Agency Profile > Form Portlet Designer

• Assets > Form Layout Editor

• Structures and Establishments > Form Layout Editor

• Workflow & Activity > TSI Form Layout Editor

Civic Platform displays the form layout editor
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Accessing the Address Type Group Portlet
To access the Address Type Group portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Address Type Group.

Civic Platform displays the portlet.

Accessing the Console Configuration Portlet
To access the Console Configuration portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Console Configuration.

Civic Platform displays the portlet.
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Accessing the Content Customize Portlet
To access the Content Customize portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Content Customize.

Civic Platform displays the portlet.

Accessing the Create New Objects Portlet
To access the Create New Objects portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).
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2. Click Agency Profile > Create New Objects.

Civic Platform displays the portlet.

Accessing the Form Portlet Designer
To access the Form Portlet Designer

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Form Portlet Designer.

Civic Platform displays the portlet.

Accessing the Link Portlets Portlet
To access the Link Portlets portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Link Portlets.

Civic Platform displays the portlet.
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Accessing the Logo Portlet
To access the Logo portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Logo.

Civic Platform displays the portlet.

Accessing Menu Navigation
To access the Menu Navigation portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Menu Navigation.

Civic Platform displays the portlet.

Accessing the My Navigation Portlet
To access the My Navigation portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > My Navigation.

Civic Platform displays the portlet.
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Accessing the Portlets Portlet
To access the Portlets portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Portlet.

Civic Platform displays the portlet.

Accessing the Regional Settings Portlet
To access the Regional Settings portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Regional Settings.

Civic Platform displays the portlet.
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Accessing the Service Portlet
To access the Service portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Service.

Civic Platform displays the portlet.

Accessing the Comment Group Maintenance Portlet
To access the Comment Group Maintenance portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Standard Comments.

Civic Platform displays the portlet.
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Accessing the Text Settings Portlet
To access the Text Settings portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Text Settings.

Civic Platform displays the portlet.

Accessing the ASI Lookup Tables Portlet
To access the ASI Lookup Tables portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Application > ASI Lookup Tables.

Civic Platform displays the portlet.
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Accessing the ASI Security Portlet
To access the ASI Security portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Application > ASI Security.

Civic Platform displays the portlet.

Accessing the Expression Builder Portlet
To access the Expression Builder portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Application > Expression Builder.

Civic Platform displays the portlet.

Accessing the License Verification Maintenance Portlet
To access the License Verification Maintenance portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Application > License Verification.

Civic Platform displays the portlet.
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Accessing the Record Type Security Portlet
To access the Record Type Security portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Application > Record Type Security.

Civic Platform displays the portlet.

Accessing the Shared Drop-down List Portlet
To access the Shared Drop-down List portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Application > Shared Drop-Down List.

Civic Platform displays the portlet.

Accessing the Asset Attributes Portlet
To access the Assets Attribute portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Assets > Attribute.

Civic Platform displays the portlet.
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Accessing the Attribute Table Portlet
To access the Attribute Table portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Assets > Attribute Table.

Civic Platform displays the portlet.

Accessing the Attribute Template Portlet
To access the Attribute Template portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Assets > Attribute Template.

Civic Platform displays the portlet.
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Accessing the Condition Assessment Portlet
To access the Condition Assessment portlet

1. Access the Setup portlet (Accessing the Condition Assessment Portlet).

2. Click Assets > Condition Assessment.

Civic Platform displays the portlet.

Accessing the Rating Type Portlet
To access the Rating Type portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Assets > Rating Type.

Civic Platform displays the portlet.

Accessing the Asset Security Portlet
To access the asset security administration portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Assets > Security.

Civic Platform displays the portlet.

Accessing the Asset Type Administration Portlet
To access the Asset Type administration portlet
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1. Access the Setup portlet (Accessing the Asset Type Administration Portlet).

2. Click Assets > Type.

Civic Platform displays the portlet.

Accessing the GIS Attribute Mapping Portlet
To access the GIS Attribute Mapping portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Parcels > GIS Attribute Mapping.

Civic Platform displays the portlet.

Accessing the Calendar Administration Portlet
To access the calendar administration portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).



 |  Getting Started | 29

2. Click Calendars > Calendar.

Civic Platform displays the portlet.

Accessing the Conditions Maintenance Portlet
To access the condition maintenance portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Conditions > Condition.

Civic Platform displays the portlet.

Accessing the Contact Type Setting Portlet
To access the contact type setting portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Contact > Contact Type Setting.

Civic Platform displays the portlet.
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Accessing the Contact Identity Settings Portlet
To access the contact identity settings portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Contact > Identity Settings.

Civic Platform displays the portlet.

Accessing the Continuing Education Maintenance Portlet
To access the Continuing Education Maintenance portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click License Certifications > Continuing Education.

Civic Platform displays the portlet.

Accessing the Education Maintenance Portlet
To access the Education Maintenance portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click License Certifications > Education.

Civic Platform displays the portlet.
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Accessing the Examination Maintenance Portlet
To access the Examination Maintenance portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click License Certifications > Examination.

Civic Platform displays the portlet.

Accessing the Data Filter Portlet
To access the Data Filter portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Data Filter & Query > Data Filter.

Civic Platform displays the portlet.

Accessing the Global QuickQueries Portlet
To access the Global QuickQueries portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Data Filter & Query > Global QuickQueries.

Civic Platform displays the portlet.
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Accessing the My QuickQueries Portlet
To access the My QuickQueries portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Data Filter & Query > My QuickQueries.

Civic Platform displays the portlet.

Accessing the ASI Drill-Down Portlet
To access the ASI Drill-Down portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Drill Down > ASI Drill-Down.

Civic Platform displays the portlet.

Accessing the Inspection Type Security Portlet
To access the inspection type security portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Inspection > Inspection Type Security.

Civic Platform displays the portlet.
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Accessing the Part Contact Portlet
To access the Part Contact portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Part > Part Contact.

Civic Platform displays the portlet.

Accessing the Part Location Portlet
To access the Part Location portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Part > Part Location.

Civic Platform displays the portlet.

Accessing the Report Manager Portlet
To access the report manager portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Report > Report Manager.

Civic Platform displays the portlet.
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Accessing the SmartChart Queries Portlet
To access the SmartChart Queries portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Report > SmartChart Queries.

Civic Platform displays the portlet.

Accessing the SmartChart Portlet
To access the SmartChart portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Report > SmartCharts.

Civic Platform displays the portlet.
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Accessing the Structures and Establishments Attribute Portlet
To access the Structures and Establishments Attribute portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Structures and Establishments > Attribute.

Civic Platform displays the portlet.

Accessing the Structures and Establishments Attribute Template Portlet
To access the structures and establishments Attribute Template portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Structures and Establishments > Attribute Template.

Civic Platform displays the portlet.
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Accessing the Structures and Establishments Types Portlet
To access the Structures & Establishment Types portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Structures and Establishments > Type.

Civic Platform displays the portlet.

Accessing the Alert Portlet
To access the Alert portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Communication Manager > Alert.

Civic Platform displays the portlet.

Accessing the Audit Log Portlet
To access the Audit Log portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > Audit Log.

Civic Platform displays the portlet.
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Accessing the Batch Jobs Portlet
To access the Batch Jobs portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > Batch Engine.

Civic Platform displays the portlet.

Accessing the Delegate User Portlet
To access the Delegate User portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > Delegate User.

Civic Platform displays the portlet.
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Accessing the Export Portlet
To access the Export

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > Export.

Civic Platform displays the portlet.

Accessing the the legacy Accela GIS Integration Diagnostics Portlet
To access the legacy Accela GIS Integration Diagnostics portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > GIS Integration Diagnostics.

Civic Platform displays the portlet.
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Accessing the Import Portlet
To access the Import portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > Import.

Civic Platform displays the portlet.

Accessing the Announcement Portlet
To access the Announcement portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Communication Manager > Announcement.

Civic Platform displays the portlet.

Accessing the Notification Template Portlet
To access the Notification Template portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Communication Manager > Notification Templates.

Civic Platform displays the portlet.

Accessing the License Details Portlet
To access the License Details portlet
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1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > Product License.

Civic Platform displays the portlet.

Accessing the Public User Portlet
To access the Public User portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > Public User.

Civic Platform displays the portlet.
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Accessing the Receipt Print Audit Portlet
To access the Receipt Print Audit portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Finance > Receipt Print Audit.

Civic Platform displays the portlet.

Accessing the Alert Rule Portlet
To access the Alert Rule portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Communication Manager > Alert Rule.

Civic Platform displays the portlet.
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Accessing the Sequence Definition Portlet
To access the Sequence Definition Portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click System Tools > Sequence Generator.

Civic Platform displays the portlet.

Accessing the Occupancy Administration Portlet
To access the Occupancy Administration portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Valuation Calculator > Occupancy.

Civic Platform displays the portlet.
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Accessing the Activity Specific Info Portlet
To access the Activity Specific Info portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Workflow & Activity > Activity Specific Info.

Civic Platform displays the portlet.

Accessing the Activity Type Portlet
To access the Activity Type portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Workflow & Activity > Activity Type.

Civic Platform displays the portlet.
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Accessing the Assign Task Portlet
To access the Assign Task portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Workflow & Activity > Assign Task.

Civic Platform displays the portlet.

Accessing the Skillset Portlet
To access the Skillset portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Workflow & Activity > Skillset.

Civic Platform displays the portlet.

Accessing the Workflow Security Portlet
To access the workflow security portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Workflow & Activity > Workflow Security.

Civic Platform displays the portlet.
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Accessing the Workload Portlet
To access the Workload portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Workflow & Activity > Workload.

Civic Platform displays the portlet.

Accessing the Cost Group Portlet
To access the Cost Group portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Work Orders > Cost Group.

Civic Platform displays the portlet.

Accessing the Cost Item Portlet
To access the Cost Item portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Work Orders > Cost Item.

Civic Platform displays the portlet.
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Accessing the Work Order Task Portlet
To access the Work Order Task portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Work Orders > Work Order Task.

Civic Platform displays the portlet.

Accessing the Work Order Template Portlet
To access the Work Order Template portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Work Orders > Work Order Template.

Civic Platform displays the portlet.

Accessing the Time Accounting Group Portlet
To access the Time Accounting Group portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Time Accounting > Group.
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Civic Platform displays the portlet.

Accessing the Time Accounting Types Maintenance Portlet
To access the Time Accounting Types Maintenance portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Time Accounting > Type Maintenance.

Civic Platform displays the portlet.

Accessing the Time Accounting Profiles Portlet
To access the Time Accounting Profiles portlet

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Click Time Accounting > User Profiles.

Civic Platform displays the portlet.
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Accessing the Building Permits Portlet
To access the Building Permits portlet

1. Create a main link for the Building Permits portlet (Setting Up Your Console and Home Page).

2. Click the main link for the Building Permits portlet.

Civic Platform displays the portlet

Accessing the Trust Account Portlet
To access the Trust Account portlet

1. Create a main link for the Trust Account portlet (Setting Up Your Console and Home Page).

2. Click the main link for the Trust Account portlet.

Civic Platform displays the portlet
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Accessing the Addresses, Parcels, or Owners Portlets
To access the Addresses portlet, the Parcels portlet, or the Owners portlet

1. Create a main link for the Addresses portlet, the Parcels portlet, or the Owners portlet (Setting Up Your
Console and Home Page).

2. Click the main link you created in .

Civic Platform displays the Addresses portlet, the Parcels portlet, or the Owners portlet. The Addresses
portlet is illustrated in this example.

Accessing the Professionals Portlet
To access the Professionals portlet
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1. Add a main link for the Professionals portlet (Setting Up Your Console and Home Page).

2. Click the main link for the Professionals portlet.

Civic Platform displays the portlet

Classic and V360 Portlets
Table 1: Civic Platform Portlets

Portlet Name Description

Classic Administration The original administration page released in version 1 of
the product

Accela Ad hoc Report V360 Ad hoc Report Portlet

Accela Custom Portlet Accela Custom Portlet

Accela Custom Reports Accela Custom Reports

Accela News Accela News

Activities V360 Activities Portlet

Addresses V360 Addresses Portlet

Administration V360 Administration Portlet

Alerts V360 Alerts Portlet

ARW Reports Accela Report Writer Portlet

Asset Condition Assessment Asset Condition Assessment Portlet

Assets V360 Asset Management Portlet

Assets Common Component Provides access to assets across all solutions; not
limited to Asset Management solution. Available in Land
Management, Licensing and Case Management, and
Service Request solutions.

Batch Jobs V360 Batch Jobs Portlet

Building Permits V360 Building Permits Portlet

Bulletin Board V360 Bulletin Board Portlet

Calendar V360 User Calendar Portlet

Call Center News News In Queue: Call Center News from
ReaderBoards.com

Cases V360 Cases Portlet

Cashier Session V360 Cashier Session Portlet

Citizen User Organization Citizen User Organization

Citizen User Profile Citizen User Profile
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Portlet Name Description

Classic System Permits V360 Classic System Permits Portlet

CNET News CNET News

Communication Manager Communication Manager Portlet

Contacts V360 Contacts Portlet

Credit Card/Check Transactions Credit Card/Check Transactions Portlet

Development V360 Development Portlet

Enforce V360 Enforce Portlet

Enforcement V360 Enforcement Portlet

ESPN News ESPN Sports Headlines

Establish Genealogy V360 Establish Genealogy Portlet

eWeek News eWeek - News

FAQ V360 FAQ Portlet (1)

FAQ V360 FAQ Portlet (2)

FAQ V360 FAQ Portlet

Fire V360 Fire Portlet

Flow Diagram V360 Permit Flow Diagram Portlet

Flow Diagram V360 Service Request Flow Diagram Portlet

GIS GIS

Health V360 Health Portlet

Inspection Route Sheet Inspection Route Sheet Portlet

Inspections V360 Inspections Portlet

IntelliScript V360 IntelliScript Portlet

Invoices V360 Invoice Portlet

Jetspeed Jetspeed is a multi-device portal system with simple
syndication capabilities

Kiva Classic V360 Kiva Classic Portlet

Licenses V360 Licenses Portlet

Model Maintenance V360 Model Maintenance Portlet

My Navigation V360 My Building Navigation Portlet

My Navigation V360 My Enforcement Navigation Portlet

My Navigation V360 My Fire Navigation Portlet

My Navigation V360 My Health Navigation Portlet

My Navigation V360 My Planning Navigation Portlet

My Navigation V360 My Service Request Navigation Portlet

My Navigation V360 My Work Orders Navigation Portlet

My Navigation V360 My Navigation Portlet

My Permits V360 My Building Permits Portlet

My Tasks V360 My Tasks Portlet

New Flow Diagram V360 Building Flow Diagram Portlet
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Portlet Name Description

News Yahoo! News Top Stories

NLC Calendar National League of Cities Calendar

NY Times Opinion New York Times Opinion Page

Organization Organization

Outlook Calendar Outlook Calendar Portlet

Outlook Inbox Outlook Inbox Portlet

Owners V360 Owners Portlet

Parcels V360 Parcels Portlet

Part Inventory Part Inventory Portlet

Payment Processing V360 Payment Processing Portlet

PCMag Reviews PC Magazine Product Reviews

Permits V360 Permits Portlet

Planning V360 Planning Portlet

PM Schedules PM Schedule Portlet

Point of Sale Point of Sale

Political News Yahoo! Political News

Preference V360 Preference Management Portlet

Professionals V360 Professionals Portlet

Public Building Permits V360 Public Building Permits Portlet

Public Service Requests V360 Public Service Requests Portlet

Public Works V360 Public Works Portlet

PublicUser PublicUser

Quicklinks V360 Quicklinks Portlets (20)

Record V360 General Record Portlet

Report Manager V360 Report Manager Portlet

Reports V360 Reports Portlet (5)

Service Requests V360 Service Requests Portlet

Set Classic V360 Set Classic Portlet

Set V360 Set Portlet

Setup V360 Setup Portlet

SmartCharts 2.0 V360 SmartCharts 2.0 Portlet

SmartCharts V360 Narrow SmartCharts Portlet

SmartCharts V360 Wide SmartCharts Portlet

Structures & Establishments V360 Structures & Establishments Portlet

Task Management V360 Task Management Portlet

Tech News Yahoo! News Technology

Time Accounting V360 Time Accounting Portlet

Trust Account Trust Account
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Portlet Name Description

Turbine Turbine is a java web application development framework

US News Yahoo! News Top US Stories

User Info V360 User Info Portlet

Weather Current weather conditions for a city

Work Orders V360 Work Orders Portlet
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Part 1: Configuring the User View
Civic Platform provides functions to customize the user interface.

Related Links

Branding Civic Platform for Your Agency

Setting Up Your Console and Home Page

Customizing Menus, Tabs, and Drop-down Lists

Creating Custom Portlets

Filtering the Display of Data

Designing Forms for Portlets

Branding Civic Platform for Your Agency
You can apply your agency’s brand to your Civic Platform implementation in a variety of ways.

You can customize the text that displays throughout your implementation; you can apply your agency’s
logo to a variety of items throughout Civic Platform; and you can set up an agency dictionary that works
with the spell checker to ensure that your agency-specific nomenclature is used properly.

Click a topic title below for full details.

Related Links

Customizing Display Text

Applying Logos to Items

Associating a Logo with an Agency

Displaying a Logo or Grade Card

Applying a Logo to Ad Hoc Reports

Configuring the Spell Checker and Agency Dictionary

Customizing Display Text
There are certain display text settings throughout Civic Platform you can customize. For example, you
can replace the default text settings to reinforce the terminology used by your agency, as well as make
instructions and other messages clear to users. Text settings appear in error messages, in dialog boxes,
and in other areas throughout the interface.

To add or edit a text setting

1. Access the Text Settings portlet (Accessing the Text Settings Portlet).

2. Click New.

Civic Platform displays a blank form in the secondary portlet.
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3. Add or edit display text.

Note:  Civic Platform automatically populates the grayed out fields.

a. Click the Select Display Text icon below the field.

b. Click the text setting in the Default Value column that you want to add.

c. Accept or modify the text, in the Display Text field, that you want to display in the interface.

To use a specific parameter for a text setting, enter the parameter name surrounded by the “$$”
signs. The parameter value then displays throughout the interface.

Note:  Civic Platform does not display the Module field or Type field if you select the “Format—Phone
Number” or “Format—Postal Code” categories.

4. Click Submit.

Applying Logos to Items
You can apply a logo to an application-specific information (ASI) subgroup or to a record so you can
easily identify between items in the software. This logo or display image helps identify agencies in multiple
agency implementations and provides a visual way to identify a record. For an example of a logo displayed
on a record, see Logo Image on a Record.
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Figure 1: Logo Image on a Record

Associating a Logo with an ASI Subgroup
Associate an image with an ASI Subgroup as a means of branding an agency so users can easily
recognize the source of information. For example, associate the Oregon state logo with Oregon.

To associate a logo with an ASI Subgroup

1. Access the Logo portlet (Accessing the Logo Portlet).

2. Choose one of the following options

• To create a new agency logo association click New.

• To edit an existing agency logo association select the agency from the Logo list.

3. Complete or update the Logo fields as described in Logo Field Descriptions.

4. Click Save.

Table 2: Logo Field Descriptions

Agency Select the agency name. Agency is a required field.

Description Provide a brief description of the graphic used as the Agency Logo.

File Name Click Browse to search and select the image you want associated with the agency.

Logo Type Select the ASI Subgroup Name.

Logo URL Provide the image URL in this field when the image you want to use as the logo resides
on the web.
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Associating a Logo with an Agency
If your agency has associations with other agencies, you can create an ASI Subgroup representing each
agency and associate the city, county, or state logo with it. Creating ASI Subgroups is particularly useful
if your agency implements Citizen Access for multi-service administration. During the record creation
process, the public user views fees allocated to a permit application from the state and city in which they
live. An image displays next to the agency to indicate the agency where the fee originates, as shown on
Associating a Logo with an ASI Subgroup. The agency logos display on the Fee page, ASI Subgroup, and
on the Payment Page in Citizen Access.

To enable this feature, an administrator must configure the related Standard Choices and upload an image
in the administrative Logo portlet. The standard choice turns on the logo feature and the Logo portlet
allows you to browse and upload the image you want to associate with each agency.

Figure 2: Agency Logo on Fee Detail page in Citizen Access

To associate a logo with an Agency

1. Configure the related Standard Choice as provided in the instructions below. This configuration is to
define the agency logo type (ASI Subgroup) and used in Citizen Access to retrieve the agency log.

a. Access the Classic Administration page (Accessing Classic Administration).

b. Navigate to Agency Profile > Standard Choices.

c. Configure the Standard Choice MULTI_SERVICE_SETTINGS as described below:

Standard Choices Value AGENCY_LOGO_TYPE

Value Desc. LOGO_TYPE_CATEGORY

Civic Platform matches this logo type with the MULTI_SERVICE_SETTINGS Standard Choices
Value AGENCY_LOGO_TYPE.
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2. Access the Logo portlet (Accessing the Logo Portlet).

3. Choose one of the following options:

• To create a new Agency Logo association click New.

• To edit an existing agency logo association click the name of the agency in the Logo list.

4. Complete or update the Logo fields as described in Table 2: Logo Field Descriptions.

5. Click Save.

Table 3: Logo Field Descriptions

Agency Select the agency name. Agency is a required field.

Description Provide a brief description of the graphic used as the agency logo.

File Name Click Browse to search and select the image you want associated with the agency.

Logo Type Select the ASI Subgroup Name.

Logo URL If the image you want to use as the logo is on a website provide the image URL in this
field.

Displaying a Logo or Grade Card
You can add your agency logo to the User Information portlet. You can also add a grade card to the
Food Facility Inspection Details page in Citizen Access to indicate the inspection results for the licensed
food facilities. You can change the logo or grade card at any time, or remove it from the portlet. If your
jurisdiction covers multiple agencies, you can assign a unique logo for each agency.

Topics

• Adding a Logo or Grade Card

• Removing a Logo or Grade Card

• Changing a Logo or Grade Card

Adding a Logo or Grade Card
You can upload a logo image for each agency in your jurisdiction. Civic Platform displays the logo in
the User Information portlet. You can also upload a grade card image for the food facility to indicate the
inspection result in Citizen Access.

To upload a logo or grade card image

1. Access the Logo portlet (Accessing the Logo Portlet).

2. Click New.

Civic Platform displays the Logo form portlet.

3. Complete the fields as necessary.

For descriptions of the fields, see Table 4: Image Fields and Options.

4. Click Submit.

Table 4: Image Fields and Options

File Name Enter the file path and name of the logo image you want to display. To browse to the
file, click Browse.
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Logo Type To upload logo image, select USERINFOLOGO from the drop-down list. To upload
grade card image, select the value such as Grade A, Grade B, Grade C, or Closure.
You define the values that populate in this list in the LOGO_TYPE_CATEGORY
Standard Choice.

Description Enter a description of the logo or grade card image.

Agency Used only for uploading logo image. Select the agency where you want the logo to
display from the Agency drop-down list.

Removing a Logo or Grade Card
Civic Platform allows you to remove an image, a logo or a grade card, you added previously to the User
Information portlet or Food Facility Inspection Details page in Citizen Access. You can remove the image if
you added the wrong file, or if you no longer want to display it.

To remove a logo or grade card image

1. Access the Logo portlet (Accessing the Logo Portlet).

2. Select the image you want to remove.

3. Click Delete.

Civic Platform displays a delete confirmation message.

4. Click OK.

Changing a Logo or Grade Card
You can change the logo image that displays in the User Information portlet or displays as the grade card
image in the Food Facility Inspection Details page of Citizen Access. You can change the image that
displays if you added the wrong file, or if your agency logo changes. To change an image, you must first
remove the image and then add a new one.

To change a logo or grade card image

1. Access the Logo portlet (Accessing the Logo Portlet).

2. Select the image you want to change.

3. Click Delete.

Civic Platform displays a delete confirmation message.

4. Click OK.

Civic Platform removes the selected image.

5. Click New.

Civic Platform displays the Logo form portlet.

6. Complete the fields as necessary.

For descriptions of the fields, see Table 4: Image Fields and Options.

7. Click Submit.

Applying a Logo to Ad Hoc Reports
When a user wants to add an agency’s logo to an ad hoc report, Civic Platform looks for a logo with the
logo type AGENCY_LOGO and uses it automatically for the report.
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To apply a logo to an ad hoc report

1. Configure the Standard Choice LOGO_TYPE_CATEGORY to include the Standard Choices Value
AGENCY_LOGO.

a. Access the Classic Administration page (Accessing Classic Administration).

b. Navigate to Agency Profile > Standard Choices.

c. Configure the Standard Choice LOGO_TYPE_CATEGORY to include the following:

Standard Choices Value AGENCY_LOGO

Value Desc. A brief description to identify the logo file.

2. Access the Logo portlet (V360 Admin > Agency Profile > Logo) and add the logo you want to use:

a. Click New.

b. Click Browse to locate and select the logo file you want to use.

c. Select Logo Type = AGENCY_LOGO.

d. Select an agency from the Agency drop-down list.

e. Click Save.

The logo displays on ad hoc reports.

Configuring the Spell Checker and Agency Dictionary
You have the option to enable a spell checker utility for scrolling text fields in both Civic Platform and
Citizen Access. The spell checker allows the user to identify and correct the spelling of any text that the
user enters. For example, an inspector can check the spelling of the comments he enters when resulting
an inspection as illustrated in Figure 3: Inspection Result Comment with Spell Checker

Figure 3: Inspection Result Comment with Spell Checker
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Figure 4: Citizen Access License Request Comment with Spell Checker

Civic Platform uses a standard dictionary for all spell checking. In addition, agencies can create custom
dictionaries to incorporate industry- and agency-specific nomenclature. You can then make the custom
dictionary available to users in Civic Platform, Citizen Access, and Mobile Office. When there is a custom
dictionary available, Civic Platform uses both the standard dictionary and the custom dictionary for
checking spelling. See Creating Custom Dictionaries for Your Agency.

Note:

Civic Platform supports custom dictionaries for the English language only.

To enable spell checking

1. Access the Standard Choices Search form. (See “Editing Standard Choices in the Setup Admin” in the
Civic Platform Configuration Reference).

2. Use the search utility to locate either or both of the following standard choices:

ACA_SPELL_CHECKER_ENABLED (use to enable spell checking in Citizen Access).

SPELL_CHECKER_ENABLED (use to enable spell checking in Civic Platform and Mobile Office).

3. Enable either or both of the spell checker standard choices to set up the spell checker.

Creating Custom Dictionaries for Your Agency
Administrators can create custom dictionaries at an agency level. A Custom Dictionary portlet is available
to review and manage custom dictionary entries. It is accessible in the Setup portlet in the Agency Profile
menu. You must enable FID 0354-Custom Dictionary to configure the Custom Dictionary portlet.

When there is a custom dictionary available, Civic Platform uses both the standard dictionary and the
custom dictionary when checking spelling.

Note:

Civic Platform supports custom dictionaries for the English language only.

After you configure a custom dictionary, and you sync it with Mobile Office, users must restart Mobile Office
for the changes to take effect.

• Searching for an Existing Custom Dictionary Entry

• Adding a Custom Dictionary Entry

• Deleting an Entry
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Searching for an Existing Custom Dictionary Entry
If you need to modify or remove a dictionary entry, you can search for existing words in your custom
dictionary.

To search for an existing custom dictionary word

1. Access the Setup portlet.

2. Select Dictionary from the Agency Profile menu.

A dictionary administration portlet displays.

3. Click Search.

The Search form displays.

4. Enter search criteria as needed, then click Submit.

The search results display.

Adding a Custom Dictionary Entry
You can add as many words to your custom dictionary as you need.

To add a new word to the custom dictionary

1. Access the Setup portlet.

2. Select Dictionary from the Agency Profile menu.

A dictionary administration portlet displays.

3. Click New.

A Custom Entry form displays.
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4. Complete the fields as described.

Word Enter the word you want to add to the custom dictionary as you want it to appear
(for example, enter the word in title case or in uppercase). If you enter a word that
already exists in the standard dictionary but your entry is in a different case, Civic
Platform presents both options to the user in the Suggested list.

Description Optional: Enter a brief description of the word in this field.

5. Click Submit.

Civic Platform adds the new entry to the custom dictionary in Civic Platform, Citizen Access, and Mobile
Office.

Deleting an Entry
You can delete words from your custom dictionary as needed.

To delete a word from your custom dictionary

1. Launch the Custom Dictionary portlet.

2. Use the search functionality to locate the term you want to delete. (see Searching for an Existing
Custom Dictionary Entry).

3. Click Delete.

Civic Platform deletes the term.

Setting Up Your Console and Home Page
This section provides instructions on how to customize your console and home page, including configuring
the console layout and skin, defining the main links and portlets in the console, and customizing the text
that displays to users throughout the system.
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Click a topic title below for full details.

Related Links

Configuring the Civic Platform console

Adding a Main Link

Setting your Home Page

Adding Additional Consoles

Customizing Text

Configuring the Civic Platform console
This section provides instructions on how to set up your console, including defining your home page, and
customizing the main links that enable users to access portlets.

Topics

• Customizing a Console

• Searching for a Console Configuration

• Editing a Console Configuration

• Managing Console Permissions

• Setting your Home Page

Customizing a Console
Use the Console Editor to specify the names of the main links that display on your console, the order in
which they display, and how many main links you want to display. Main links might include Civic Platform
Administration, V360 Admin, Building, Inspection, Home, and Report Manager, for example. Then, for each
main link, you define which portlets open on your console and where. For example, inspectors might want
to associate the Calendar and Inspection portlets in the large portlet area, and the Bulletin Board portlet in
the smaller side portlet area for the Inspections main link. Some portlets allow for further customization. For
more information on customizing portlets, see Customizing Menus, Tabs, and Drop-down Lists .

Topics

• Navigating the Console Editor

• Configuring the Console Layout and Skin

Navigating the Console Editor
The Console Editor is a configuration tool that enables you to add or modify the main links and portlets
that display on your user interface. Use the Console Editor to create a unique user interface containing the
main links and portlets related to your day-to-day activities. For an example of the Console Editor and its
associated parts, see Figure 5: Console Editor.
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Figure 5: Console Editor

A Layout menu. The console layout menu. Use this drop-down menu to modify portlet layouts.

B Name label. The column label indicating the name and order of the main links on the console.

C Add Portlet button. This button activates when you select a main link. Click this button to associate a portlet
with a main link.

D Add Reference button. Administrators or users with administrative rights can click this button to add a
reference to another user’s console.

E Add Page button. Click this button to add a main link to the console. To associate a portlet with a main link,
click Add Portlet.

F Edit Properties button. Click this button to modify the name and description of a main link.

G Skin menu. If your agency uses skins (colorful displays of console elements) you can use this drop-down
menu to select and activate the skin.

H Action. Use the action buttons to remove and reposition the main link display.

Configuring the Console Layout and Skin
You can select the layout and skin to apply in your console. The layout defines the appearance and
placement of the main links in your console. The skin is the visual representation style of console
elements.

Choosing Simple Skin or Standard Skin for the Agency
Civic Platform provides both a standard skin and a simple skin, which is the default. Compared with the
standard skin, the simple skin presents streamlined look for pages and buttons, and better organizes
information in the console. The simple skin enables users to expand and collapse the record list portlet to
maximize the size of their workspace.

You can choose to enable a skin type in the Standard Choice UI_SKIN. The enabled skin type applies to
the whole agency.

The figures below present a comparison between the simple skin and the standard skin interfaces.
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Figure 6: Console Display with Simple Skin

Figure 7: Console Display with Standard Skin

Setting the Layout and Skin for the Console
You can use the console editor to set the layout and skin used specially for a console.

To set the layout and skin for a console

1. Click Console Options in the upper-right corner of the console.

Civic Platform displays the Console Editor.
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2. Select the layout from the Layout drop-down, and the skin from the Skin drop-down.

There are two layout options, V360 PA Tab Page, and V360 Tab Page. The V360 PA Tab Page layout
displays the main links in one row, which extends the page width of the console. With the V360 Tab
Page layout, the main links display in several rows, which provides a fixed-width page view, with no
need to scroll to see main links.

You can configure skin details in the super agency administration site.

Note:

If you apply the simple skin to the agency (see Choosing Simple Skin or Standard Skin for the Agency),
the skin you select here is not applicable. If you apply the standard skin to the agency, the skin selected
here takes effect in Classic Administration and Console Editor.

3. Click Save and Apply.

Civic Platform saves the settings.

Adding a Main Link
Main links display along the top of your home page and provide users with easy access to portlets.

Use the Console Editor to add, remove, or customize a main link.

You must be an administrator or a user with the proper permissions to access the Console Editor.

To add a main link

1. Click Console Options in the upper-right corner of the console.

Civic Platform displays the Console Editor.

2. To add a new main link, click Add Page in the Console Editor.

Civic Platform displays the Add Main Link page.
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3. Enter the name of the main link you want to add and click Apply.

Civic Platform displays the main link at the end of the main link list.

4. In the Console Editor, scroll to the end of the list of main links, and click the name of the main link you
just added.

5. Click Add Portlet.

Civic Platform displays a list of available portlets.

6. Locate the portlet you want to associate with the main link using the alphabetical links at the bottom of
the page or the category and parent filters at the top of the page.

7. Click Add next to each portlet you want to associate with the main link, then click Apply.

Civic Platform displays the main link details page.

8. Click Apply and then Click Save and Apply.

Repositioning or Removing a Main Link
Civic Platform allows you to customize your console by determining the names of main links and the order
in which they display. Use the Action button on the Customize page to remove or reposition main links.

To reposition or remove a main link

1. Click Console Options in the upper-right corner of the console.

Civic Platform displays the Console Editor.

2. In the Action column, reposition or remove a main link using the action buttons. These buttons are:

Move Up. Moves the main link up one position in the Console Editor. Modifies the console display by
shifting the main link to the right.

Move Down. Moves the main link down one position in the Console Editor. Modifies the console
display by shifting the main link to the right.

Remove. Removes the main link and its associated portlets.

3. Click Save and Apply.

Civic Platform saves the changes and returns to the home page.
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Repositioning or Removing a Portlet
You can customize the portlets associated with a main link by modifying the portlet position or removing
it. To accomplish these tasks, you must first navigate to the Console Editor. After you access the Console
Editor, use the action buttons to arrange the portlets.

To reposition or remove a portlet

1. Click Console Options in the upper-right corner of the console.

Civic Platform displays the Console Editor.

2. Click the main link that contains the portlet you want to reposition or remove.

Civic Platform displays the main link details page.

3. Reposition or remove a portlet using the buttons. These buttons are:

Move Up. Moves the selected portlet one position up.

Move Down. Moves the selected portlet one position down.

Move Right. Moves the portlet to the right panel.

Move Left. Moves the portlet to the left panel.

Remove. Removes the portlet from the main link.

4. When you complete the process of repositioning and removing portlets, click Apply.

Civic Platform saves your changes and displays the Console Editor.

Setting your Home Page
A home page is the first page you view after logging into Civic Platform or the page that displays after
clicking the Home button on the console toolbar. To customize your home page, you must create a main
link and add the portlets you want associated with it. Then you must ensure that the main link you want to
use for the home page is in the first position.
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Adding Additional Consoles
You can customize multiple consoles to fit the needs of different types of users and departments. This
can include creating a custom console that limits what some users have access to, and creating a more
advanced console with expanded access for other users.

To add a customized console

1. Access the Console Configuration portlet (Accessing the Console Configuration Portlet).

2. Click New.

3. Enter the console name and console description.

4. Click Customize.

For more information about how to customize your console, see Editing a Console Configuration.

5. Click Submit.

Civic Platform adds the customized console.

Searching for a Console Configuration
To search for console configuration

1. Access the Console Configuration portlet (Accessing the Console Configuration Portlet).

2. Click Search.

3. Enter the console name or console description, or both.

4. Click Submit.

Civic Platform displays the console configuration that match your search criteria.

Editing a Console Configuration
Administrators can create a standard console and assign it to a user group or module. The Console
Configuration portlet is where you organize the various console configurations. You can modify the name
and customize the color of portlets throughout Civic Platform. The color you choose for Civic Platform
displays as the background color for the portlet selected. Blue is the default color scheme. Your other
choices are: red, green, yellow, black, taupe.

To edit a console configuration

1. Access the Console Configuration portlet (Accessing the Console Configuration Portlet).

2. Select a console name from the list to modify the Console Name or Console Description.

Civic Platform displays the Console details.
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3. You can change the layout and choose a skin for your console.

a. Click Console Options.

Civic Platform displays the Console Editor.

b. If you want to change any console elements, see Customizing a Console for details.

c. Click Save and Apply.

Civic Platform returns you to the Console Configuration portlet.

4. To assign specific users to this console, click Recipient tab and follow the instructions in Managing
Console Permissions.

Managing Console Permissions
After creating a customized console, decide which agency, module, user group, and user has access to the
customized console.

If your login account has access permissions to multiple consoles, Civic Platform provides a console name
link (for example, My Console) in the right corner of the Agency Bar. You can click a console name link
to open a drop-down menu of all available consoles, and then click a console name to switch between
consoles. See Figure 8: Switching between Consoles .

Figure 8: Switching between Consoles

Go to the Recipient tab in the Console Configuration portlet (Accessing the Console Configuration Portlet)
to manage the agencies, modules, user groups, and users assigned to the customized console. For more
information, see Setting Up Security Policies.
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Customizing Text
There are certain display text settings throughout Civic Platform you can customize. For example, you
can replace the default text settings to reinforce the terminology used by your agency, as well as make
instructions and other messages clear to users. Text settings appear in error messages, in dialog boxes,
and in other areas throughout the interface.

To add or edit a text setting

1. Access the Text Settings portlet (Accessing the Text Settings Portlet).

2. Click New.

Civic Platform displays a blank form in the secondary portlet.

3. Add or edit display text.

Note:

Civic Platform automatically populates the grayed out fields.

a. Click the Select Display Text icon below the field.

b. Click the text setting in the Default Value column that you want to add.

c. Accept or modify the text, in the Display Text field, that you want to display in the interface.

To use a specific parameter for a text setting, enter the parameter name surrounded by the “$$”
signs. The parameter value then displays throughout the interface.

Note:

Civic Platform does not display the Module field or Type field if you select the “Format—Phone
Number” or “Format—Postal Code” categories.

4. Click Submit.

Customizing Menus, Tabs, and Drop-down Lists
This section provides instructions for configuring the navigation elements that enable users to access
information and product features.

Click a topic title below for full details.

Related Links

Overview

Working with Menus and Tabs
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Creating Template Menus for Modules

Creating Template Menus for User Groups

Creating User Flow Diagrams

Creating Shared Drop-down Lists

Configuring Record Detail Tabs

Defining the Create New Menu

Customizing Go To Menus

Overview
Administrators can create the following custom navigation elements that enable users to access the
information they need to perform their daily tasks.

• Menus

• Tabs

• Flow Diagrams

• Drop-down Lists

Custom menus are drop-down menus that group and organize daily tasks together. You can use custom
menus in place of, or in addition to, the standard record detail tabs. The sample screen below illustrates
the “Go To” menu, where users access custom menus, and the standard record detail tabs. The Go To
menu and the record detail tabs provide users two ways to quickly access and retrieve information to
perform their daily tasks.

Users can access custom menus by clicking the Go To menu on the upper left side of the detail form
portlets. You can display a maximum of 16 menu items on custom menus, and then arrange those menu
items so that they display in the order that is most useful to a specific module or user group.
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To enable the Go To menu, you must enable Function ID 0230: Menu Navigation Admin. You must also
enable the Standard Choice Menu_Navigation_Enabled. For more information on working with FIDs and
Standard Choices, refer to the Civic Platform Configuration Reference.

The Menu Navigation Tree
Civic Platform uses a folder structure to configure, create, and display custom menus.

Figure 9: Menu Navigation Tree shows a sample configuration of custom menus and tabs, and gives
the definitions for various navigation tree nodes. You can access the menu navigation tree by going to
Administration > Agency Profile > Menu Navigation.

Click the plus (+) or minus (-) sign in the menu navigation tree to view the configurations at different levels.
If you right-click a tree node in the menu navigation tree, the pop-up menu shows all the operations you
can perform with the node. For example, if you right-click a module name, you can add groups or menu
templates for the module, or delete the module settings.

Figure 9: Menu Navigation Tree

A The Portlet folder. Four portlet types can contain the Go To menu, custom drop-down menu and custom tabs:
Asset Data Management (asset details portlet), Record Form Portlet (record details portlet), Ref Address Form
Portlet, and Ref Parcel Form Portlet.

B The Agency folder. You can add agency-level menu template, or add modules and groups and then configure
module-level and group-level templates in this folder.

C The Template folder. You can create template menus for the entire agency or for individual modules and
groups. You can add custom menus or tabs with the right-click options, or open a template menu and then
change its settings.

D The Tab folder. You can add a tab menu and create tabs within it. Only the selected tabs display in the details
portlet when users open the portlet.

E Navigation Menus. Navigation menus are where you create or remove custom menus. You can add, cut,
copy, paste, and delete a menu with the right-click options.

F Module folders. You can create module folders and define module-level custom menu items and custom tab.
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G Group folders. You can create group folders and define custom menu items and custom tab that work for a
specific group.

H Menu items. Items are the daily tasks that a user performs. There can be a minimum of one menu item per
menu, and a maximum of 16 items per menu.

I Tab Items. If you define a tab and assign tab items to the tab, when users open the details portlet (see A),
only selected tab items display in the details portlet.

Working with Menus and Tabs
Topics

• Managing Template Menus

• Managing Menus

• Managing Tabs

Managing Template Menus
Template menus provide a starting place for creating custom menus and tabs for the entire agency or for
individual modules or groups. For example, if you want to create a menu specific to the building module,
you can copy and modify the agency template menu. You can also create a separate template menu for
the building module with tasks specific to the users within the building department.

Topics

• Creating a Template Menu

• Deleting a Template Menu

• Copying a Template Menu

Creating a Template Menu
If you assigned the template menu to a module, that template menu overrides any custom specific agency
menu. If you assigned a template menu to a user group, that template menu overrides the custom module-
level menu.

To create a template menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Expand the desired portlet folder to the agency folder level.

Civic Platform displays the agency folder.

3. Right-click the agency folder and click Add Template.

Civic Platform displays the Template Menu portlet.
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4. Complete the fields that display. For a list of field descriptions, see Table 5: Template Menu Fields.

5. Click Submit.

Civic Platform confirms you successfully created the menu template.

Table 5: Template Menu Fields

Description Enter a description of the menu.

Menu Template Name Enter a name for the template menu. For example, you might name a menu template
for the building module Default Building Menu.

Portlet Name The portlet where the menu displays. Civic Platform assigns this name automatically; it
is read-only.

Show All Tabs Select Yes or No to set whether all tab items display as the record detail tabs. Table 6:
Tab Items to Display as Record Detail Tabs shows what tab items display as the record
detail tabs at different custom tab and “Show All Tab” settings.

Status Select Enabled to display the menu. Select Disabled to hide the menu.

Table 6: Tab Items to Display as Record Detail Tabs

“Show All Tabs” Setting Custom Tab Configured What Tab Items to Display as Record
Detail Tabs?

Yes Yes Customized tab items

Yes No All built-in tabs

No Yes The first custom tab item

No No The Summary tab

Deleting a Template Menu
You can delete template menus you no longer need. When you delete a template menu, it effects all
modules, user groups, and users who had the template menu assigned to them. For example, if you have
an agency template menu and a building template menu for the building user group, all the building group
users have the building template menu assigned to them. However, if you delete the building template
menu, Civic Platform assigns the agency template menu to the building user group by default.

To delete a template menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Expand to the portlet, module, or group folder where you want to delete the template menu.

Right-click the portlet, module, or group folder where you want to delete the menu template from and
click Delete.
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Civic Platform displays a confirmation window to delete the template menu.

3. Click OK.

Civic Platform confirms you successfully deleted the menu template.

Copying a Template Menu
Copying and modifying template menus is a fast and efficient way to create multiple menus for your
agency. You can save time by creating one menu and copy/pasting it to any module, user group or user.
Then you can make minor modifications as needed for the specific modules, groups and users.

To copy the template menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Right-click the template menu folder and click Copy.

Civic Platform copies the menu template.

3. Right-click the Module or Group folders where you want to copy the menu template, and then click
Paste.

Civic Platform displays the Copy page.

4. Click OK.

Civic Platform copies the menu to the selected module or group.

Managing Menus
Menus are the basic building blocks of creating custom menu navigation. Custom navigation menus are
drop-down menus that group and organize daily tasks together. You can use custom menus in place of, or
in addition to, standard menus and record detail tabs. Civic Platform organizes the menu items to display in
the order that is most applicable to a specific module or user group. Custom navigation menus display from
the Go To menu tab on the upper left side in the detail form portlets where scroll tabs usually display.

When users select a custom navigation menu item from the Go To menu, if the detail tab includes that
menu item, the menu item becomes the current tab in the detail tabs. If the detail tabs do not include the
menu item, the menu item appears to the right of the detail tabs and becomes the current tab.
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To create menus Civic Platform requires a minimum of one menu item and a maximum of 16 menu items.
After you add menu items to a menu, you can add the menu to the template menu. After you add the menu
to a template menu you can copy/paste it to template menus in other modules or user groups, and then
make minor modifications to fit specific user needs.

Topics

• Adding a Menu to a Template Menu

• Copying a Menu to a Template Menu

• Deleting a Menu from a Template Menu

• Adding Built-in Menu Items to a Menu

• Adding Custom Menu Items

• Removing Menu Items from a Menu

Adding a Menu to a Template Menu
You can add custom drop-down menus to specific modules and individual user groups. For example, you
can create a menu to grant access to a user that has limited access to certain tasks.

To add a menu to a menu template

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Right-click the template folder and click Add Menu.

Civic Platform displays the Menu detail form portlet.

3. Complete the following fields:
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Description Enter a description for the menu.

Menu Name Enter a name for the menu.

Menu Template Name This read-only field displays the template name you selected.

4. Click Submit.

Civic Platform confirms you successfully created the menu.

Copying a Menu to a Template Menu
Copying menus is a fast and efficient way to create multiple menus for your agency. You can save time
by creating one menu and copying it to multiple modules, users, or user groups. You can then modify the
menu to meet the specific needs of the modules, users, or user groups

To copy a menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Right-click the menu folder you want to copy and click Copy.

Civic Platform copies the template menu.

.

3. Right-click the template folder where you want to copy the menu and click Paste.

Civic Platform displays the Copy page.

4. Click OK.

Civic Platform copies the menu to the template menu.

Deleting a Menu from a Template Menu
Delete menus you no longer need using the right-click options available in the left navigation portlet.
Deleted menus no longer display in the drop-down menu for the specified detail form portlet.

To delete a menu from a template menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Right-click the template menu folder where you want to delete the menu from, and then click Delete.

Civic Platform displays a confirmation window to delete the menu from the template menu.

3. Click OK.
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Civic Platform confirms you successfully deleted the menu.

Adding Built-in Menu Items to a Menu
Built-in menu items are the default menu items in Civic Platform. You create a menu by adding and
arranging menu items in a list. A menu is complete after you add the menu items, arrange them, and
organize them in the drop-down list. You add menu items at the same time you create a menu or when
modifying existing menus. You can add up to a maximum of 16 menu items to a menu.

To add and arrange Built-in menu items to a menu, use the side-to-side and up/down arrow buttons. To
move a menu item from the from the Built-in menu item list to the Selected menu item list highlight the
Built-in menu item you want to move and click the single side-to-side arrow button. The single arrow button
moves Built-in menu items to the Selected menu item list one at a time. The double arrow button moves all
the Built-in menu items to the Selected menu item list. When you have added all the menu items you want
to display, arrange the order of the Selected menu items with the up/down arrows.

To add menu items to a menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Expand the folders to the Template menu folder level.

Civic Platform displays the menus associated with the template.

3. Click the menu folder you want to add menu items to.

Civic Platform displays a Menu detail form portlet.
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4. Click the Menu Items tab.

Civic Platform displays the Menu Items portlet.

5. From the Built-in Menu Items list, select and highlight the menu item you want to add and click the
right Single Arrow button to move the menu item to the Selected list. To select all the Built-in Menu
Items, click the right Double Arrow button.

Civic Platform moves the Menu Item to the Selected Menu Items box.
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6. Use the Up/Down Arrows to select the order the menu items are to display. These buttons only effect
the order the Selected Menu Items display.

7. Click Submit.

Civic Platform confirms you successfully added the menu items to the menu.

Adding Custom Menu Items
You can add custom menu items that reference data not stored in Civic Platform using a hyperlink to
a valid URL. For example, if a building permit clerk needs to reference building codes stored on your
agency’s Intranet, you can create a custom menu item that links with your agency’s Intranet.

To add a custom menu item

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Expand the portlet folder where you want to add the template menu.

Civic Platform displays the template menu.

3. Click the menu folder where you want to add menu items.

Civic Platform displays a Menu detail form portlet.

4. Click the Menu Items tab.

Civic Platform displays the Menu Items detail page.
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5. Click New.

Civic Platform displays the Menu Items detail form portlet.

6. Complete the applicable fields. For a list of field descriptions, see Table 7: Custom Menu Item Detail
Fields. When adding a Custom menu item you are referencing a URL outside of Civic Platform.

7. Click Submit.

Civic Platform confirms you successfully created the menu item and adds it to the menu.

Table 7: Custom Menu Item Detail Fields

Description Enter a description for the menu.

Link Enter a valid URL of the website for the custom menu item.

Menu Item Label Enter the label for the menu item that you want to display in the drop-down menu.

Menu Item Name Enter the name of the menu item.

Menu Name The name of the menu for the menu item displays as read-only

Removing Menu Items from a Menu
You can delete menu items you no longer want to display.

To delete menu items from a menu
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1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Expand the folders to the template menu folder.

Civic Platform displays the menus associated with the template.

3. Click the menu folder from where you want to remove menu items.

Civic Platform displays a Menu Detail form portlet.

4. Click the Menu Items tab.

Civic Platform displays the Menu Items portlet.
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5. From the Selected Menu Items list, select and highlight the menu item you want to remove and click

the right Single Arrow  button to remove the menu item from the Selected list. To remove all the

Selected Menu Items, click the right Double Arrow button .

Civic Platform moves the menu item to the Selected Menu Items box.

6. Click Submit.

Civic Platform confirms you successfully removed the menu item.

Managing Tabs
The record detail tabs by default include every detail about a record that Civic Platform can support. If you
want to select and display a few tab items instead, you can create a tab menu and add the desired tab
items in the tab menu. Then the detail tabs only display the tab items in the tab menu. Users can quickly
and easily grasp what they want to know about a record and what they should do for the record.

What tab items display as the detail tabs rely on both the tab menu configuration and the template menu
“Show All Tabs” setting. For more information, see Table 6: Tab Items to Display as Record Detail Tabs.

You create tabs in the template menu folders in the menu navigation tree. Each template menu folder can
only hold one tab menu. Each tab menu inherits the settings from its template menu. For example, when
you disable a template menu, it also disables the tab menu.

In addition to select tab items for a tab menu, you can define the order of the tab items, and customize the
tab item labels.

See Figure 10: Tab Menu Sample. The record details portlet has a custom tab menu with four tab items.
Record, Related Records, Inspections and Work Order Tasks.

Note:

If you set the Function Identification for a tab to no access for a user group, those users are not be able to
view the tab, regardless of whether you add it to the tab menu.

Topics

• Adding a Tab Menu to a Template Menu

• Setting Tab Item Labels in a Tab Menu

• Deleting a Tab Menu
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Figure 10: Tab Menu Sample

Adding a Tab Menu to a Template Menu
You can create tabs for detail portlets. Before you add a tab menu to a portlet, decide whether you want
to enable the tab menu for the whole agency, specific modules, or individual user groups. Then follow the
instructions in Creating a Template Menu to create a template menu in the agency, specific module, or
individual user group.

To add tab menu to a template menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Navigate to the template menu with which you plan to create the tab menu. The template menu can
reside in the agency, module, or user group folder, depending on the scope in which you want the tab
menu to take effect.

3. Right-click the template menu folder, and then click Add Tab.

Civic Platform displays the Tab Detail form portlet next to the menu navigation tree.
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4. Complete the following fields.

Description Enter a description for the tab menu.

Tab Name This read-only field displays “Tab,” the default name reserved for tabs.

Template Name This read-only field displays the template name.

5. Click Submit.

Civic Platform confirms you successfully created the tab menu.

6. Click the Tab Items tab.

Civic Platform displays the Tab Items portlet.

7. Take the following actions to select tab items for the tab menu:

From the Built-in Tab Items list, select and highlight the tab item you want to add and click the right

Single Arrow  button to move the tab item to the Selected list. To remove all the Built-in Tab Items,

click the right Double Arrow button .

a. Civic Platform moves the Tab Item to the Selected Tab Items box.



 | Part 1: Configuring the User View | 88

Note:

(1) Although available as built-in tab items, the following items only work as menu items and cannot
display in the detail tabs: Copy, Clone and Assign, including Assign Inspection and Assign Task.

(2) If you select “Application Spec Info” tab item, all the ASI screens display in the detail tabs.

(3) If the Selected list is empty, all built-in tab items display in the detail tabs.

b. If you want to remove a tab item from the Selected list, select the item and click the left Single

Arrow  button. If you want to clear the Selected list, click the left Double Arrow  button.

c.

Use the Up/Down Arrows  to select the order the menu items are to display. These buttons only
effect the order the Selected Menu Items display.

8. Click Submit.

Civic Platform confirms you successfully added the tab items to the tab menu.

Setting Tab Item Labels in a Tab Menu
You can specify labels for any tab items in a tab menu. The labels are what users see for the
corresponding tab items in the detail tabs. Without labels, the tab item names represent tab items in the
tabs.

To set tab item labels in a tab menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Expand the portlet folder where the tab menu resides.

3. Click the plus (+) sign next to the tab menu folder in which you want to set labels to tab items.

The menu navigation tree expands the tab menu and displays all the tab items in the menu.

4. Select the tab item for which you want to set the label.

Civic Platform displays a Tab Item detail form portlet.
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5. Enter the new label in the Tab Item Label field. The label is what users see for the tab item in the detail
tabs.

Note:

You can ignore the Link field in the tab item detail portlet. This field is applicable for navigation menu
items only. See Adding Custom Menu Items for the description of the field.

6. Click Submit.

Civic Platform confirms you successfully added the label to the tab menu.

Deleting a Tab Menu
You can delete tab menus that are not applicable for the portlet. You can remove the tab menu from the
agency, module, or user group folder. After the deletion, all the built-in tabs display in the detail tabs for the
agency, module, or user group.

To delete a tab menu from a template menu

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Navigate to the template menu and find the tab menu you plan to delete. The template menu can reside
in the agency, module, or user group folder, depending on the scope in which the tab menu takes
effect.

3. Right-click the tab menu and click Delete.

Civic Platform displays a deletion confirmation window.

4. Click OK.

Civic Platform confirms you successfully deleted the tab menu.

Creating Template Menus for Modules
There are six modules in Civic Platform: building, service request, enforcement, licenses, permits, and
planning. All these modules perform unique tasks in Civic Platform, which requires you to create a template
menu for each module. When you add a template menu to a module you can add, delete, and modify the
menus associated with the module.

This section includes these topics:

• Adding a Template Menu to a Module

• Deleting a Template Menu from a Module
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Adding a Template Menu to a Module
Creating template menus for specific modules streamlines the different tasks for each department in the
agency. For example, the building department and the enforcement department perform some similar
tasks, but they also have some unique, department-specific tasks. Creating module specific template
menus helps users navigate to tasks that are unique to their department.

To add a template menu to a module

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Expand the portlet folder where you want to add a template menu to a module.

Civic Platform expands the navigation tree to the module’s folder level.

3. To add a template menu, choose one of the following steps:

• Right-click the module folder and click Add Template.

• Right-click the template menu folder you want to copy and click Copy.

4. To add the template menu, choose one of the following options:

• Create a Template Menu. For information on how to do this, see Creating a Template Menu.

Civic Platform displays the Menu Template detail form portlet.
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• Click the module folder you want to copy the template menu to and click Paste.

Civic Platform displays the Copy page.

5. To complete the template menu, choose one of the following options:

• Complete the fields that display. For a list of field descriptions, see Table 5: Template Menu Fields
and click Submit.

Civic Platform confirms the template menu was successful created and added to the module.

• If the template menu name is the same as the copied template menu, click OK. If you want to
change the name of the template menu you are copying enter a new name in the Name field and
click OK.

Civic Platform copies the template menu to the assigned module.

Deleting a Template Menu from a Module
If a template menu is no longer applicable to a specific module you can delete a template menu from that
module. For example, if a department within the agency has restricted access and all the tasks change
for that department, the template menu no longer applies to that department. It might be easier to delete
the existing template menu and create a new one instead of editing the existing template menu. You must
delete all the template menus sub-items before you can delete the template menu from the module.

To delete a menu from a module

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Expand the portlet and module folders where you want to remove the group.
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3. Right-click the template menu folder located in the module folder and click Delete.

Civic Platform displays a confirmation window delete the module.

4. Click OK.

Civic Platform confirms you successfully deleted the template menu.

Creating Template Menus for User Groups
Civic Platform assigns users to a user group, which enables you to control the menus and tasks users view
in each module. For example, administrators can create a menu with tasks specific to permits for users in
the permit group. Menus and template menus automatically display in the module assigned to the group
where you assign the menu or template menu.

This section includes these topics:

• Adding a Template Menu to a Group

• Deleting a Template Menu from a Group
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Adding a Template Menu to a Group
Each user performs tasks specific to the user group you assigned them to in Civic Platform. Creating
and adding template menus for specific user groups helps streamline the different tasks for each user in
the department. Not everyone in a user group performs the same tasks. For example, in the permit user
group administrators can create two different menus with tasks specific to a permit processor and a permit
inspector. Creating and adding template menus to user groups helps users navigate to task that are unique
to their job and department.

To add a menu template to a group

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Open the portlet and module folders where you want to add a template menu to a group.

3. Right-click the module folder where you want to add a group and click Add Group.

Civic Platform displays a user group list.

4. Click the user group you want to add to the module and click Submit.

Civic Platform confirms you successfully added the user group to the module.

Deleting a Template Menu from a Group
If a template menu is no longer applicable to a specific user group you can delete a template menu from
that user group. For example, if a user group within the building department has restricted access and all
the tasks change for that user group the template menu no longer applies to that user group. It might be
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easier to delete the existing template menu and create a new one instead of editing the existing template
menu for that user group. You must delete all the template menu's sub-items before you can delete the
template menu from a user group.

To delete a menu template from a group

1. Access the Menu Navigation portlet (Accessing Menu Navigation).

2. Open the portlet and module folders where you want to remove the group.

3. Right-click the group folder you want to delete the template menu from and click Delete.

Civic Platform displays a confirmation window to delete the group from the template menu.

4. Click OK.

Civic Platform confirms you successfully deleted the template menu.

Creating User Flow Diagrams
You use the My Navigation portlet to define user flow diagrams. Flow diagrams provide users with a visual
representation of the steps they follow to accomplish specific tasks. The icons in the flow diagram link to
the portlets or URLs from where users perform their tasks.
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To create user flow diagrams

1. Access the My Navigation portlet (Accessing the My Navigation Portlet>).

• Delete an existing flow diagram.

1. Locate an existing flow diagram by clicking on it in the My Navigation Name column or by
searching for it.

2. Click Delete.

• Edit an existing flow diagram.

1. Locate an existing flow diagram by clicking on it in the My Navigation Name column or by
searching for it.

2. Complete the flow diagram configuration ().

• Create a new flow diagram.

1. Click New.

2. Complete the flow diagram configuration ().

2. Complete the flow diagram configuration.

a. Complete the Diagram General tab.

My Navigation Name Enter the name for the new flow diagram. For example, you might enter “Counter
Clerk” for a diagram to assist counter clerks with a simple workflow process for
issuing a permit.

Description Enter a description of the flow diagram. For example, you might enter “Counter
Clerk workflow for issuing a new permit.”

Comments Enter any comments about the flow diagram. The entered comments display at the
bottom of the flow diagram portlet.
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b. Complete the Flow Nodes tab.

• Delete a flow node.

1. Select the checkbox next to the flow node(s) you want to delete.

2. Click Delete.

• Change the order of the flow nodes.

1. Modify the order number(s) next to the flow node(s) you want to reorder.

2. Click Submit.

• Add a new node.

1. Click the New Node button.

2. Select the link type (portlet or URL) for the new node.

3. Click Submit.

• Edit an existing node.

1. Click the hypertext link for the node you want to edit.

c. Define new node parameters or edit existing node parameters (Table 8: Flow Nodes Fields).

Table 8: Flow Nodes Fields

Order Indicates the relative order of the flow node (lowest/top to highest/bottom) in the
overall diagram. Two nodes with the same order number appear on the same line in
the flow diagram.

Portlet For portlet link type only. The name of the portlet for the flow node.

Icon For URL link type only. Select the icon you want to use for the flow node from the
Icon drop-down list.

Target The portlet frame the flow node points to.capForm. Specifies the form portlet
frame.capList. Specifies the list portlet frame.

Text Align The alignments of the text that displays next to the flow node icon.

Text The text you want to display for the flow node icon.

Alternative Text The text you want to display as the alternate text for the icon. The alternate text
displays when the cursor hovers over the icon.

URL For URL link type. The URL to the portlet for the flow node.

Onclick Specifies the JavaScript function to run when a user clicks the flow node.doReport().
Runs a report.new(). Creates a new record.

d. Complete the Recipient tab (Setting Up Security Policies).

e. Click Submit.

Creating Shared Drop-down Lists
Shared drop-down lists are configurable lists you can apply to different group codes and templates in Civic
Platform. When you define shared drop-down lists, users can access them from drop-down list values in
the specified product area.
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Example Use Case

You can create a drop-down list for a People template that indicates a licensed professional’s years of
experience. In other circumstances, you can create a drop-down list for an Application Specific Information
group indicating the number of floors in a building.

You can populate a shared drop-down list by adding values and defining their display order.

When you create a shared drop-down list, you must apply it to a specific product area (see Applying a
Shared Drop-down List).

To create a shared drop-down list

1. Access the Shared Drop-down list portlet (Accessing the Shared Drop-down List Portlet).

2. From the Shared Drop-down List tab, delete, inactivate, edit, or create a shared drop-down list.

• Delete an existing shared drop-down list.

1. Locate an existing shared drop-down list by clicking on it in the Name column or by searching for
it.

2. Click Delete.

• Inactivate an existing shared drop-down list.

1. Locate an existing shared drop-down list by clicking on it in the Name column or by searching for
it.

2. Set the Status field to Inactive.

3. Click Save.

• Edit an existing shared drop-down list.

1. Locate an existing shared drop-down list by clicking on it in the Name column or by searching for
it.

2. Complete the shared drop-down list configuration.

• Create a new shared drop-down list.

1. Click New.

2. Complete the shared drop-down list configuration.

3. Complete the shared drop-down list configuration.

Name Enter the name you want to associate with the shared drop-down list.

Status Use the drop-down list indicate if the drop-down list is active or inactive.

Description Provide a brief description for the drop-down list.

4. Click Submit or Save.

5. From the Values tab, delete a value, change the order of values, add a value, or edit a value.

• Delete a value.

1. Select the checkbox next to the value(s) you want to delete.

2. Click Delete.

• Change the order of the values.
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1. Modify the order number(s) next to the value(s) you want to reorder.

2. Click Save.

• Add a new value.

1. Click New.

2. Complete the fields for the new value.

3. Click Submit.

• Edit an existing node.

1. Click the hypertext link for the value you want to edit.

2. Edit the field value(s).

3. Click Submit.

6. Click the Associations tab to view the shared drop-down list associations.

Applying a Shared Drop-down List
When you create a shared drop-down list, you must apply it to the group or template where you want it
to display. Civic Platform accommodates shared drop-down lists for multiple groups and templates. For
more information on applying shared drop-down lists in available product areas, see Shared Drop-down
List Product Areas.

Table 9: Shared Drop-down List Product Areas

Activity Specific Information
Groups

See Working with Activity-Specific Information Group Codes.

APO Templates See Applying a Shared Drop-down List.

Application Specific
Information Groups

See Applying a Shared Drop-down List.

Asset Attributes See Creating an Attribute.

People Templates and Info
Tables

See Applying Shared Drop-down Lists in people templates.

Task Specific Information
Groups

See Applying Shared Drop-down Lists for workflows.

Configuring Record Detail Tabs
This section describes how to configure record detail tabs.

Configuring the Related Records Tab
You can configure a related records tab that enables users to build and view hierarchical relationships
between records. These relationships are referred to as parent, child, and sibling relationships in Civic
Platform.

Building relationships between records streamlines communication between different departments in
your agency and enables batch processing – an efficient way for users to execute common processes
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on multiple related records. For example, users can create a set of related records that share the same
workflow, and execute a batch process that updates the workflow task status for the entire set.

This section focuses strictly on how to configure related records. For complete details on how to this
feature, including how to designate records as parents and children, and the other practical uses of this
feature, refer to the online help available from the Help menu in Civic Platform.

Setting Related Records FIDs and Standard Choices
To enable this feature you must configure the following FIDs and Standard Choices, according to your
agency’s business objectives. For complete instructions on how to configure FIDs and Standard Choices
refer to the Civic Platform Configuration Reference and the Administrator training modules available in
Accela Success Community – specifically Configuring Related Records, parts 1 - 3.

Related Records FIDs

• FID 8154 - Application Hierarchy: enables the related records tab

• FID 8236 - Related CAPs Search: enables the Look Up button

• FID 8292 - Create Multiple Related CAPs: enables the Clone Mult button

• FID 8293 - Open New Related CAP in SPEAR: enables the Clone Sgl button

• FID 8323 - Update Related CAPs: displays an Update Related Records button, enabling users to
update or refresh the list of related records.

• FID 8395 - CAP Summary: displays record summary information about related records. Works in
conjunction with SC RELATED_CAP_SUMMARY; you must set both.

• FID 8460 - Delete Related Records: displays a Delete button, enabling users to delete related records.

Related Records Standard Choices

• RELATED_CAP_CONFIG specifies the fields (including the Application Name field) that display in the
hierarchical view of the related records tab.

• RELATED_CAP_SUMMARY enables users to display record summary information about related
records. Works in conjunction with FID 8395; you must set both.

• CAP_CHILD_DOCUMENT enables users to display documents associated with related records.
Related documents only display on the parent record. Child records do not display the documents of the
parent records.

Configuring the Application Summary Tab
You can create a customized Application Summary that contains a brief summary of the application, field
information, and links to relevant portlets.

For a complete list of sections you can add to the Record Summary tab, see Table 10: Application
Summary Page Sections.

To configure the summary tab

1. Access the Form Portlet Designer (Accessing the Form Portlet Designer).

2. Select Portlet > Record Summary.
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• Click New and assign the view as described in Designing Forms for Portlets. For example, select the
level you need, such as Agency, and then Click Submit.

3. For each field you want to display on the summary, select the field and Click OK on the Available
Fields page. To manage fields, click Available Fields.

4. Arrange the fields on the form in the same order you want them to appear to users when they complete
the form. For instructions on arranging the form, see Designing Forms for Portlets.

5. Rename any of the field labels, according to your agency’s business objectives, as follows:

a. Double click a field name to access the properties page for the field.

b. Modify the text that displays in the Label field. You cannot change the database label (DB Label).

c. Click OK.

Civic Platform displays the form with your customized field name.

6. To modify the properties of fields that display as sections or lists on the Summary page:

a. Double click a section name or list name to access its properties page.

Civic Platform displays the Properties page for the section or list.
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b. Click Customize Sub-section. Refer to Designing Forms for Portlets for details on modifying the
properties of sections and lists.

7. To restrict the display of fields based on your agency’s business objectives, you can use Expression
Builder functions. For complete details, refer to Using Expression Builder.

Note, however, that because the Record Summary page is read-only, certain functions are not available
for the Record Summary page. The only functions available for use with the Record Summary page are
the OnLoad expressions.

8. Enter a descriptive Filter Name. The Filter Name is the name you can use later to locate the form if
you need to make additional changes.

9. Click Save.

10.Configure the Application Summary page in the Menu Navigation (Go To) drop-down list so that
agency users can easily navigate to different record tabs. For instructions on how to configure Menu
Navigation, refer to Customizing Menus, Tabs, and Drop-down Lists .

11.Add the Summary tab to the Menu Navigation, so that it displays for users when they open a record.

a. From the Setup portlet, click Agency Profile > Menu Navigation.

b. From the Record Form Portlet, select the Agency > Module > Group > User > and Tab folder for
whom you want the Summary tab to display.

c. Go to the Menu Items tab, add the Summary tab from the Built in Menu Items list on the left, and
then arrange the order using the arrow buttons. See Adding Built-in Menu Items to a Menu.
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d. Click Submit.

Table 10: Application Summary Page Sections

Application Summary Page Section Section Description

Adhoc Task Status This section displays the status of any ad hoc tasks
associated with the application.

Application Comments This section displays application comments.

Application Detail Click application detail to view the Record portlet.

Application Specific Info This section displays application specific information about
the selected application type.

Application Type Click application type to view the Record portlet. The
application type displays as the record alias, if present. If a
record alias is not present, the application type displays the
4-level organization path of the record.

Application Status Click application status to view the Application Status
portlet.

Balance Click balance amount to view the Payment portlet.

Conditions of Approval Click a condition name to navigate to the Condition of
Approval portlet.

Condition Status Click a condition to view the associated Condition Detail
and History portlets.

Contact Info This section displays the contact detail for application
contacts.

Description of Work Click description of work in this section to view the Record
portlet.

Documents This section displays documents associated with the
application. Click a document’s file name to navigate to
Document Information portlet, where you can change a
document’s status and view document details, such as
Document Review Tasks and Document Review History.

File Date This section displays the date the application was
submitted.

Resulted Inspections This section displays completed inspections associated with
the application. For more information on the Inspections
section, see Configuring the Record Summary Tab
Inspection Section.

Scheduled/Pending Inspections This section displays scheduled and pending inspections
associated with the application. For more information on the
Inspections section, see Configuring the Record Summary
Tab Inspection Section.

Job Value Click job value amount to view the Additional Information
Form detail portlet.

Licensed Professional Info This section displays licensed professionals associated with
the application.

Click the license number of a licensed professional to view
the Professionals detail portlet.
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Application Summary Page Section Section Description

Parcel No This section displays parcels associated with the
application.

Click a parcel number to view the Parcel detail portlet.

Required Inspections This section displays inspections public users must
complete for Civic Platform to accept the application.

Structure This section displays structures associated with the
application.

Total Fee Assessed This section displays the total amount of fees assessed to
the application.

Click total fee assessed to view the Fee detail portlet.

Total Fee Invoiced This section displays the total amount of the fees invoiced
to the application.

Click total fee invoiced to view the Payment detail portlet.

Tracking # This section displays the application tracking number.

Workflow Status This section displays the workflow tasks associated with the
application, including an Assigned To field.

The current application status displays as a link, which
enables you to view the Workflow Task portlet.

Configuring the Record Summary Tab
Users can view a summary of an application by clicking the Record Summary tab in a record list. The
Record Summary tab displays read-only information; users cannot edit the content that displays.

Configuring the Record Summary Tab Inspection Section
The Inspections section displays pending, scheduled, and resulted inspections associated with the
selected application.

When agency users access the Inspections section, they can review the inspection type, the scheduled
date, the inspector, and the status for any pending, scheduled, or resulted inspection. Agency users can
also click the link for any inspection that displays and view the associated inspection detail.

For a complete list of the fields that display in the Inspections section, see Table 11: Application Summary
Page Inspection Fields.

To display the Inspections section, you must first configure the Application Summary page. For instructions
on how to configure the Application Summary page, see Configuring the Application Summary Tab.

You can remove the Inspections section from the Application Summary page using the Form Portlet
Designer. For instructions on removing a display section from the Application Summary page, see
Designing Forms for Portlets.

Table 11: Application Summary Page Inspection Fields

Inspection Date This field indicates the inspection date, and displays it in the Resulted subsection of
the Inspections section.

Inspection Type Displays the inspection category, such as electrical, insulation, or building.

Inspector Displays the name of the inspector scheduled to conduct the inspection.

Resulted Resulted inspections associated with the selected application display in this
subsection. Inspection results must correspond to the Approved or Denied Result
Type to display in this subsection.
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Scheduled Date This field displays in the Scheduled/Pending subsection and indicates the scheduled
date for the inspection.

Scheduled/Pending Scheduled or pending (requested) inspections associated with the selected
application display in this subsection.

Status This field displays in the Scheduled/Pending subsection and the Resulted
subsection.

In the Scheduled/Pending subsection, this field indicates whether a public user has
scheduled or requested an inspection. In the Resulted subsection, this field indicates
the result of an inspection, such as Approved or Denied.

Configuring the Conditions of Approval Tab
Use the Form Portlet Designer to customize what information displays and how it appears on the
Conditions of Approval tab for a record, an inspection, or a record set.

You can also decide which condition of approval fields appear as links in the Sort By area on the
Conditions of Approval tab. By default, the Group, Priority, and Applied Date links are available in the Sort
By area. Clicking a Sort By link sorts the conditions of approval by the corresponding field. Civic Platform
sorts the conditions of approval by group, type, status type, severity, and then priority, if users do not click
any of the links in the Sort By area.

To customize the Conditions of Approval tab

1. Access the Form Portlet Designer (Accessing the Form Portlet Designer).

2. Select one of these options from the Portlet drop-down list:

• Record Conditions of Approval List (Conditions of Approval tab for a record)

• Inspection Conditions of Approval List (Conditions of Approval tab for an inspection)

• Set Conditions of Approval List (Conditions of Approval tab for a record set)

3. Click New and assign the view as described in Designing Forms for Portlets. For example, select the
level you need, such as Agency, and then Click Submit.

Civic Platform displays a layout editor.

4. Complete the following fields.
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Filter Name Enter a descriptive name for the filter, so that you can identify it later if you need to
locate it. After you save a form, the Filter Name displays in the Name column.

Description Enter a descriptive name to help identify the purpose of the form.

Source View Name The Source View Name is inactive; you cannot modify it.

5. Click the Available Fields button.

Civic Platform displays the Conditions of Approval fields.

6. Double-click the field that you want to display for each condition of approval.

Civic Platform adds the field to the HTML editor as a predefined variable enclosed in the double dollar
signs, for example, $$conditionDescription$$.

You can enter the predefined variables for the condition of approval fields into the HTLM editor, as
needed. For a list of the condition of approval fields and the corresponding variables, see Table 12:
Condition of Approval Variables. For a description of the condition of approval fields, see the Civic
Platform Online Help, and search for “Conditions Form Fields.”

7. Use the HTML editor to format the fields, such as changing the font size and color.

8. In the Sort Order area, choose the options (do not choose display order – see note below) you want to
appear as links in the Sort By area of the Conditions of Approval tab.

Note:
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Do not select the Display Order field, as Civic Platform does not allow you to sort conditions of approval
by display order.

Civic Platform displays the fields as links on the Conditions of Approval tab.

Table 12: Condition of Approval Variables

Field Name Variable

Action by Dept $$statusByUser.deptOfUser$$

Action by User $$statusByUser.fullName$$

Active Status $$auditStatus$$

Applied Date $$issuedDate$$

Applied by Dept $$issuedByUser.deptOfUser$$

Applied by User $$issuedByUser.fullName$$

Comment $$conditionComment$$

Condition Name $$conditionDescription$$

Condition Status Type $$conditionStatusType$$
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Field Name Variable

Display Order $$displayOrder$$Note: Do not add the Display Order field or enter this
variable into the HTML editor because the field is not visible on the
Conditions of Approval tab.

Effective Date $$effectDate$$

Expiration Date $$expireDate$$

Group $$conditionGroup$$

Long Comments $$longComment$$

Priority $$priority$$

Public Display Message $$publicDisplayMessage$$

Record ID $$capID$$

Resolution Action $$resolutionAction$$

Severity $$impactCode$$

Status $$conditionStatus$$

Status Date $$statusDate$$

Type $$conditionType$$

Defining the Create New Menu
The Civic Platform console provides a Create New button on the toolbar that opens a drop-down menu
of options for creating records or performing other operational tasks. Administrators determine the Create
New button menu options by defining how many items display, which items display, and the order in
which the items display in the Create New Objects administration portlet (Figure 11: Create New Menu
Drop‑Down Menu).

Figure 11: Create New Menu Drop‑Down Menu

To define the Create New menu

1. Access the Setup Portlet (Navigating to the Setup Portlet).

2. Click Agency Profile > Create New Objects.

Civic Platform displays the Create New Objects administration portlet.
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a. In the Display column, select the option to indicate if an object displays in the Create New drop-
down menu.

Choose Yes to include the object in the drop-down menu.

Choose No to hide the object as an option in the drop-down menu.

b. Enter a number in the Display Order column for each object you want to display in the drop-down
menu. This number indicates the object position from top to bottom. The number 1 indicates the first
position in the menu.

c. Click Submit.

Customizing Go To Menus
You can group the record detail tabs into a drop-down menu called a Go To menu. The Go To menu
provides a way to quickly navigate the record detail tabs.

To access the Go To menu

1. Locate a form portlet that contains a customized Go To menu.

Civic Platform displays the customized Go To menu tab.

2. Click Go To and choose the appropriate option from the drop-down list.

The menu items in the drop-down list are the same as the record detail tabs listed across the portlet.
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System administrators can define whether users have access to the Go To menu, record detail tabs, or
both.

Civic Platform displays the detail portlet for the selected tab.

 Creating Custom Portlets
You can configure custom link portlets that provide users with links to both external websites and to
internal Civic Platform portlets.

Click a topic title below for full details.

Related Links

Working with Link Portlets

Working with the Portlets Portlet

Working with Link Portlets
Civic Platform provides 23 custom link portlets (three FAQ portlets and 20 Quicklinks portlets).

Figure 12: Sample Custom Link Portlet

To enable this functionality, first create the custom link portlet, then give users access to it by adding a
main link to it (Setting Up Your Console and Home Page) on the console page.

To delete, edit, or create a link portlet

1. Access the Link Portlets portlet (Accessing the Link Portlets Portlet).

2. Create, edit, or delete a link portlet, as follows.

a. To create a new link portlet:

a. Click New.
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b. Complete the fields in the Portlet tab.

a. To delete an existing link portlet:

Note:

Removing a link portlet removes it from any primary tabs of Civic Platform that currently display the
portlet. It also removes all links within the portlet.

a. Locate an existing list portlet by clicking on it in the Name column or by searching for it.

b. Select the checkbox for the item to delete.

c. Click Delete.

b. To edit an existing list portlet:

a. Locate the portlet you want to edit.

b. Complete the fields in the Portlet tab ().

3. Enter information in the following fields:

Portlet System Name The name of the link portlet.

Name The name to display for the link portlet. By default, Civic Platform sets this to the
Portlet System Name.

Description The description of the portlet.

4. From the Links tab, delete a link, add a link, or edit a link.

• Delete a link.

1. Select the checkbox next to the link(s) you want to delete.

2. Click Delete.

• Edit an existing link.

1. Click the hypertext link for the link you want to edit.

2. Edit the field value(s).

3. Click Submit.

• Add a new link.

1. Click New.

2. Select the link type.
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3. Click Submit.

4. Complete the fields by entering the name of the link you want to display and the target
destination of the link (either a URL or portlet specification).

5. Click Submit.

Working with the Portlets Portlet
You use the Portlets portlet to specify which portlets you can add a link to from a link portlet.

To work with the Portlets portlet

1. Access the Portlets portlet (Accessing the Portlets Portlet).

2. Do any of the following:

• Create a portlet.

1. Click New.

2. Complete the fields (see Table 13: Portlet Details).

a. For the Portlet URL field, right-click anywhere in the portlet, and choose Properties.

The URL of the portlet displays in the Address (URL) field of the Properties window.

b. Enter the portlet URL in either of the following two formats:

The complete URL. For example, https://sample.accela.com:32443/portlets/reports/
adHocReport.do?

The shortcut URL which omits the server address. For example: /portlets/reports/
adHocReport.do?

3. Click Submit.

• Edit an existing portlet.

1. Click the link to the portlet you want to update.

2. Update the fields (see Table 13: Portlet Details).

a. For the Portlet URL field, right-click anywhere in the portlet, and choose Properties.

The URL of the portlet displays in the Address (URL) field of the Properties window.

b. Enter the portlet URL in either of the following two formats:

The complete URL. For example, https://sample.accela.com:32443/portlets/reports/
adHocReport.do?

The shortcut URL which omits the server address. For example: /portlets/reports/
adHocReport.do?

3. Click Submit.

• Delete a portlet.

1. Select the checkbox next to the portlet(s) you want to delete.

2. Click Delete.
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Table 13: Portlet Details

FID The Function Identification (FID) that Civic Platform uses to control access to the
portlet. The FID setting controls access to the portlet and visibility of the link to the
portlet.

For example, if you are adding the Parcels portlet, you can enter 0005 in the field
(FID 0005 controls the accessibility of the Parcels portlet). In a link portlet which
contains the link to the Parcels portlet, the link is only visible to the users who
have access permission to the Parcels portlet. For more information about portlet
FIDs, see the Accela Civic Platform Configuration Reference.

Portlet Description The description for the portlet. You can enter the name of the portlet and any
other defining characteristics.

Portlet Icon The icon to display for the portlet if you add the portlet to a flow diagram in the My
Navigation portlet. The icon does not display for the portlet.

Portlet Page ID NA. The field is no longer used.

Portlet URL The URL for the portlet.

Filtering the Display of Data
Filters and queries enable users to find information easily and efficiently. You can configure filters and
queries to display only the data that is relevant to the user in the context of their current business objective
or use-case scenario.

Click a topic title below for full details.

Related Links

Creating a Data Filter

Assigning a Data Filter

Removing a Data Filter Assignment

Data Filter Enabled Portlets

Managing Global QuickQueries

Managing User Defined QuickQueries

QuickQuery Enabled Portlets

Creating a Data Filter
When you create a data filter, you specify the list that list contains the fields you want to filter, the values for
each field, and the users who have access to the filter.

To create a data filter

1. Access the Data Filter portlet (Accessing the Data Filter Portlet).

2. Select the portlet to which you want to apply the data filter.

3. Click Submit.

Civic Platform displays a list of the filters defined for that portlet.

4. Click New to create a new filter.

Civic Platform displays a blank form in the record tab.
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5. Complete the following fields:

Name Enter a brief name to identify the data filter.

Description Enter a description to help you identify the purpose of the data filter.

6. In the Search By section, do the following:

a. Use the first drop-down to select the Field you want to filter.

Note:

The portlet you selected in sets the filter fields available in this drop-down:

• The filter fields for the Record List portlet include all the record fields that display in the record
search form, Application-Specific Info, Address Template, Owner Template, Parcel Template, and
Module Name. However, only record-searchable APO template attributes are available.

• The filter fields for the Reference Address (Parcel, or Owner) Portlet include the address (parcel,
or owner) fields, and Address Template (Parcel Template, or Owner Template).

• The filter fields for other portlets are the fields that display in the search form of each portlet.

• If you select Application-Specific Info (ASI) as the filter field in the drop-down, Civic Platform
displays all the ASI groups page. Select an ASI group code, and then find and click the desired
ASI field in the ASI Fieldnavigation tree to specify the field you want to filter.

• If you select Address Template, Parcel Template, or Owner Templateas the filter field in the
drop-down, Civic Platform displays all the active template attributes. Click the desired attribute to
specify the field you want to filter.
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b. Use the second drop-down to select the Relational Operator you want to use. See Relational
Operators.

c. In the third field enter the Value you want to compare the field against. The value must match
a value in your agency’s database. You can click the button to the right of the field and select a
variable from the Variable picker, or enter the variable into the field manually.

See Data Filter Parameters.

• If you select a user name field such as Requestor, Civic Platform displays three fields where you
can specify the first, middle, and last name of a person. See User Name List Portlets and Search
Fields.

However, if you pick a variable as the search criteria, Civic Platform turns the three fields into a
read-only Full Name field and populates the field with the specified variable.

d. If you are filtering additional fields, enter the logical operator in the fourth field to determine how
you want to combine the field-level filters. See Logical Operators.

7. If you are filtering more than one field, do the following:

a. Click the New Field button located at the top of the portlet.
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Civic Platform adds a condition to the Search By section for the additional field.

b. Repeat for every new field.

8. To delete a field from your query, select the field and click Delete Field.

9. Click the Preview SQL button to view the SQL in the Resulting Query text field.

10.Click Submit.

Civic Platform displays a message informing you whether you created the data filter successfully, and
updates the data filter list.

Table 14: Relational Operators

Operator Description

!= Not equal to

< Less than

<= Less than or equal to

= Equal to

> Greater than

>= Greater than or equal to

IS NOT NULL Used to query fields that contain any value, regardless of what that value is.

When you use this operator, do not use a variable in the third field.

IS NULL Used to query fields that do not have a value. For example, you might set up a data filter to
query for records associated with a certain department, but not to any individual within the
department.

When you use this operator, do not use a variable in the third field.

Like The alphabetic character field values that you want to include in the filter or query contain a
string (alphabetic characters).

For example, if you want to set up a query to list all contacts with the string “Jeff” in their
email addresses, choose “Like” as the relational operator and enter “Jeff” as the value.

Table 15: User Name List Portlets and Search Fields

List Portlet “Search By” Field

AMS Asset CA List Inspector

AMS PM Schedule Log List Processed By Staff

Inspection Conditions of Approval List • Action by User

• Applied by User

Inspection List • Inspection Contact Name

• Inspector

• Requestor

My Workflow Task List • Action By (Staff)

• Assigned to Staff

Record Conditions of Approval List • Action by User

• Applied by User

Record Inspection List • Inspection Contact Name

• Requestor

Set Conditions of Approval List • Action by User

• Applied by User
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Table 16: Data Filter Parameters

Variable Name Description

$$DEPARTMENT$$ Department The department to which the current user belongs.

$$GAUSER ID$$ User ID The logged in user’s ID.

$$USERFULLNAME$$ User Full Name The logged in user’s full name.

$$GROUP$$ Group The logged in user’s user group.

$$MODULE$$ Module The name of the module for which the alert you created
the alert.

$$ORGANIZATION$$ Organization All organizations. An Citizen Access term.

$$OWNORGANIZATION$$ Own Organization The logged in citizen user’s organizations. An Citizen
Access term.

$$OWNLICENSE$$ Own License The logged in citizen user’s licenses. An Citizen Access
term.

$$PUBLICUSER_EMAIL$$ Public User’s Email The logged in citizen user’s email. An Citizen Access term.

$$SERV_PROV_CODE$$ Service Provider
Code

The logged in user’s agency code

$$TODAY+/-#$$ Today Today’s date, based on the workstation's system clock.
You can use this variable parameter in calculations to
specify a date range. For example, you could enter $
$Today-7$$to query for all records over the last week.

$$TODAY+n$$ Today +n Date range beginning with today’s date. For example, you
could enter $$Today-7$$to query for all records over the
last week.

$$USERID$$ User ID The ID of the user currently logged on to Civic Platform.

Table 17: Logical Operators

Operator Description

And Use this logical boolean operator to display values included only in multiple fields (results in a
smaller list of matches).

Or Use this logical boolean operator to display values included in one field or another (results in a
larger list of matches).

Editing a Data Filter
This section describes how to edit the data filter information that displays on the Data Filter tab.

To edit a data filter

1. Access the Data Filter portlet (Accessing the Data Filter Portlet).

2. Select the view with the data filter you want to modify.

3. Click Submit.

Civic Platform displays a list of the filters defined for the selected view.
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4. In the Name column, click the link of the filter you want to edit.

Civic Platform displays the filter details in the record tab.

5. Modify the following fields if you want:

Name Enter a brief name to identify the data filter.

Description Enter a description to help you identify the purpose of the data filter.

6. Review and edit the Search By section:

a. To delete a field from your query, select the field and click Delete Field.

b. If you want to modify the filter condition for a field, find the target field, select the new Relational
Operator you want to use for the field, and enter the new Value that you want to compare the field
against.

c. If you want to add a new field, enter the Logical Operator in the last field to determine how you want
to combine the field-level filters, click the New Fieldbutton, and perform the following:

a. Use the first drop-down to select the Field you want to filter,

b. Use the second drop-down to select the Relational Operator you want to use.

c. In the third field enter the Value that you want to compare the field against. The value must match
a value in your agency’s database. You can click the button to the right of the field and select a
variable from the Variable picker, or enter the variable into the field manually.

d. Repeat the preceding step for every new field.

7. Click the Preview SQLbutton to view the SQL in the Resulting Query text field.

8. Click Submit.

Civic Platform displays a message informing you whether you updated the data filter successfully.

Deleting a Data Filter
This section describes how to remove a data filter from Civic Platform.

To remove a data filter

1. Access the Data Filter portlet (Accessing the Data Filter Portlet).

2. Select the view with the data filter you want to delete.
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3. Click Submit.

Civic Platform displays a list of the filters defined for the selected view.

4. Select each data filter you want to delete.

5. Click Delete.

Civic Platform updates the data filter list for the selected view.

Assigning a Data Filter
You can assign data filters to individual users as well as entire user groups to limit what field values they
can see in their list views.

By default, Civic Platform applies the primary filter which you specify to any portlet. If you defined multiple
filters for a portlet, authorized users can choose which filter to apply to the view. Only one filter can apply to
a portlet at any given time. If you do not give a user the option to choose from a list of available data filters
for a portlet, Civic Platform automatically applies the primary data filter you have defined for that portlet and
assigned to that user.

To assign a data filter

1. Access the Data Filter portlet (Accessing the Data Filter Portlet).

2. Select the portlet with the data filter you want to modify.

3. Click Submit.

Civic Platform displays a list of the filters defined for the selected portlet.

4. In the Name column, click the link of the filter you want to assign (click Search if you do not see the
filter you want).

5. Click the Recipients tab.

Civic Platform displays the users and user groups you assigned the filter to.

6. Click Assign Module, Assign Group, or Assign User to assign recipients to the filter.

7. If you want the data filter to be the primary data filter for the selected user group or user, do the
following:

a. Click the Recipient Key link next to the user group or user you want to make the primary.

Civic Platform displays the Primary information.
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b. Select the Primary option.

c. Click Submit.

Removing a Data Filter Assignment
This section describes how to remove a data filter from a user or user group. If a user or group has had a
particular data filter assigned to limit their access to information, you can remove that filter if it no longer
applies.

To remove a data filter assignment

1. Access the Data Filter portlet (Accessing the Data Filter Portlet).

2. Select the portlet with the data filter you want to modify.

3. Click Submit.

Civic Platform displays a list of the filters defined for the selected portlet.

4. In the Name column, click the link to the filter with the recipient you want to remove (click Search if you
do not see the filter you want).

5. Click the Recipients tab.

Civic Platform displays a list of recipients.

6. Select each recipient you want to remove from the list.

7. Click Delete.

Civic Platform displays a confirmation message and updates the recipient list.

Data Filter Enabled Portlets
This list details the administration portlets where you can set up and use data filters.

• AMS Asset Attribute Table List: The Attribute Table list portlet.

• AMS Asset Template List: The Attribute Template list portlet.

• AMS Asset Type List: The Asset Type list portlet.

• AMS Attribute List: The Attribute list portlet.

• AMS Condition Assessment List: The Condition Assessment administration list portlet.

• AMS Cost Group List: The Cost Group list portlet.

• AMS Cost Item List: The Cost Item list portlet.

• AMS Part Contact List: The Part Contact list portlet.
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• AMS Part Location List: The Part Location list portlet.

• AMS RefRating List: The Rating Type list portlet.

• AMS WO Task Definition List: The Work Order Task list portlet.

• AMS Work Order Template List: The Work Order Template list portlet.

• StructEstabl Type List: The Structure & Establishment Types portlet.

This list details the daily user portlets where you can set up and use data filters:

• Citizen Access Record List: The record list in Citizen Access.

• AMS Asset CA List: The Asset Condition Assessment list portlet.

• AMS Asset Data List: The Assets list portlet.

• AMS Asset Work Order List: The Work Order tab in the Assets portlet.

• AMS Part Inventory List: The Part Inventory list portlet.

• AMS Part Transaction List: The Part Transaction tab in the Part Inventory portlet.

• AMS PM Schedule List: The PM Schedules list portlet.

• AMS Work Order Asset List: The Assets tab in the Work Orders portlet.

• Batch Invoice List: The Invoices list portlet.

• Batch Job List: The Batch Jobs list portlet.

• Contact Record List: The Record List tab in the Contacts portlet.

• Global Search Record List: The Record List tab in the Global Search portlet.

• Inspection List: The Inspections list portlet, and the Inspections tab in the My Tasks portlet.

• My Document Task List: The Document Review Tasks tab in the My Tasks portlet.

• My Workflow Task List: The Workflow Tasks tab in the My Tasks portlet.

• Point of Sale Transaction List: The Point of Sale list portlet.

• Record List: The Record list portlet.

• Record Set Member List: The Set Members tab in the Set: Records portlet.

• Record Status History List: The Application History tab in the Record portlet.

• Reference Address List: The Addresses list portlet.

• Reference Contact List: The Contacts list portlet.

• Reference Owner List: The Owners list portlet.

• Reference Parcel List: The Parcels list portlet.

• Reference Professional List: The Professionals list portlet.

• Reference StructEstabl List: The Structures & Establishments list portlet.
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• Related Record List: The Related Records tab in the Record portlet.

• Trust Account List: The Trust Account list portlet.

QuickQueries
A QuickQuery is a search predefined by an administrator that helps users to quickly access a list of
items. For example, you can set up a QuickQuery that refines a list of records to show only those records
assigned to a certain department. A QuickQuery does not display fields or values a data filter excludes. For
more information about data filters, see Filtering the Display of Data.

You can filter data for any field name in a list portlet. You must designate the modules, groups, or users
that can access each Global QuickQuery you create. Global QuickQueries not assigned to the user do not
appear in the user’s My QuickQueries drop-down list in the list portlet. If you set up multiple queries for a
portlet, users can add any of those queries to their My QuickQueries drop-down list, and specify one of
them as a default QuickQuery.

Multiple daily users can assign a QuickQuery the same name. Civic Platform differentiates these
QuickQueries by the user’s login name. For example, John Q. Smith and Ann Jensen can both create a
query called “Projects Due Today.” A user or administrator who wants to create two QuickQueries with
the same name on the same login account must differentiate the two. For example, “Opened Today with
Balance (Global)” and “Opened Today with Balance (My QQ).”

Managing Global QuickQueries
Global QuickQueries are QuickQueries you define for your Civic Platform users. Civic Platform gives you
the flexibility to assign QuickQueries to every user in the agency, make them available to a specific group
only, or even limit them to an individual user. If needed, you can edit, delete, and un-assign QuickQueries
previously assigned.

Topics

• Creating a Global QuickQuery

• Editing a Global QuickQuery

• Deleting a Global QuickQuery

• Assigning a QuickQuery

• Removing a QuickQuery

Creating a Global QuickQuery
For each portlet list, you can create any number of QuickQueries. For example, in the Building portlet, you
might want to sort the records by the Record ID and the street name.

You also have the option to designate one of the Global QuickQueries as the primary QuickQuery within
each portlet. You can only assign one primary Global QuickQuery at a time. If the daily user assigns a user
defined QuickQuery as primary, Civic Platform overrides the primary Global QuickQuery with the user’s
choice.

To create a QuickQuery

1. Access the Global QuickQueries portlet (Accessing the Global QuickQueries Portlet).

2. From the portlet drop-down list, choose the portlet for which you want to create a query.

3. Click Submit.
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Civic Platform displays a list of the queries defined for that view.

4. Click New.

Civic Platform displays a blank form in the secondary tab.

5. Complete these fields:

Name Enter a brief name to identify the QuickQuery.

Description Enter a description to help you identify the purpose of the QuickQuery.

6. In the Search By section:

a. Use the first drop-down to select the Field you want to filter.

Note:

The portlet you selected in sets the filter fields available in this drop-down:

• The filter fields for Record List portlet include all the record fields that display in the record search
form, Application-Specific Info, Address Template, Owner Template, Parcel Template, and
Module Name.

• The filter fields for the Reference Address (Parcel, or Owner) Portlet include the address (parcel,
or owner) fields, and Address Template (Parcel Template, or Owner Template).

• The filter fields for other portlets are the fields that display in the search form of each portlet.

• If you select Application-Specific Info (ASI) as the filter field in the drop-down, Civic Platform
displays all the ASI groups.
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Select an ASI group code, and then find and click the desired ASI field in the ASI Field
navigation tree to specify the field you want to filter.

• If you select Address Template, Parcel Template, or Owner Template as the filter field in the
drop-down, Civic Platform displays all the active template attributes. Click the desired attribute to
specify the field you want to filter.

b. Use the second drop-down to select the Relational Operator you want to use. See Table 18:
Relational Operators.

c. In the third field, enter the Value that you want to compare the field against. The value must match
a value in your agency’s database. You can click the button to the right of the field and select a
variable from the Variable picker, or enter the variable into the field manually.

See Table 19: QuickQuery Parameters
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• If you select a user name field such as Requestor, Civic Platform displays three fields where you
can specify the first, middle, and last name of a person. See Table 15: User Name List Portlets
and Search Fields.

However, if you pick a variable as the search criteria, Civic Platform turns the three fields into a
read-only Full Name field and populates the field with the specified variable.

d. If you are filtering additional fields, enter the Logical Operator in the fourth field to determine how
you want to combine the field-level filters. See Table 20: Logical Operators.

7. If you are querying more than one field:

a. Click the New Field button located at the top of the portlet.

Civic Platform adds a condition to the Search By section for the additional field.

b. Repeat for each new field.

8. To delete a field from your query, select the field and click Delete Field.

9. Click the Preview SQL button to view the SQL in the Resulting Query text field.
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10.Click Submit.

Civic Platform informs you if you created the QuickQuery successfully and updates the Global
QuickQueries list.

11.To set the QuickQuery as the primary QuickQuery for the portlet:

a. Click the Recipient tab.

Civic Platform displays a list of Recipients.

b. Click the Recipient Key link.

Civic Platform displays the Recipient Key list.

c. Select the Primary option.

d. Click Submit.

Table 18: Relational Operators

Operator Description

!= Not equal to

< Less than

<= Less than or equal to

= Equal to

> Greater than

>= Greater than or equal to
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Operator Description

IS NOT NULL Used to query fields that contain any value, regardless of what that value is.

When you use this operator, do not use a variable in the third field.

IS NULL Used to query fields that do not have a value. For example, you might set up a data filter
to query for records assigned to a certain department, but not to any individual within the
department.

When you use this operator, do not use a variable in the third field.

Like The field values that you want to include in the filter or query contain a string of alphabetic
characters. For example, if you want to set up a query to list all contacts with the string “Jeff” in
their email addresses, choose “Like” as the relational operator and enter “Jeff” as the value.

Table 19: QuickQuery Parameters

Variable Name Description

$$DEPARTMENT$$ Department The department to which the current user belongs.

$$GAUSER ID$$ User ID The logged in user’s ID.

$$GROUP$$ Group The logged in user’s user group.

$$MODULE$$ Module The name of the module for which you created the alert.

$$ORGANIZATION$$ Organization All organizations. An Citizen Access term.

$$OWNORGANIZATION$$ Own Organization The logged in citizen user’s organizations. An Citizen
Access term.

$$OWNLICENSE$$ Own License The logged in citizen user’s licenses. An Citizen Access
term.

$$PUBLICUSER_EMAIL$$ Public User’s Email The logged in citizen user’s email. An Citizen Access term.

$$SERV_PROV_CODE$$ Service Provider
Code

The logged in user’s agency code

$$TODAY+/-#$$ Today Today’s date, based on the workstation’s system clock.
You can use this variable parameter in calculations to
specify a date range. For example, you could enter $
$Today-7$$to query for all records over the last week.

$$USERID$$ User ID The ID of the user currently logged on to Civic Platform.

Table 20: Logical Operators

Operator Description

And Use this logical (boolean) operator to display values included only in multiple fields (produces a
smaller list of matches).

Or Use the logical (boolean) operator to display values included in either one or other of the fields
(produces a larger list of matches).

Editing a Global QuickQuery
This section describes how to edit information associated with a QuickQuery, including how to designate a
QuickQuery as the primary QuickQuery for the portlet.

To edit a QuickQuery

1. Access the Global QuickQueries portlet (Accessing the Global QuickQueries Portlet).

2. From the Portlet drop-down list, choose the portlet for which you want to edit a query.
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3. Click Submit.

Civic Platform displays a list of the queries defined for that view.

4. From the list of queries, click the link in the Name column of the query you want to edit.

Civic Platform displays the query details in the secondary portlet.

5. Modify these fields if you want:

Name Enter a brief name to identify the QuickQuery.

Description Enter a description to help you identify the purpose of the QuickQuery.

6. Review and edit the Search By section:

a. To delete a field from your query, select the field and click Delete Field.

b. If you want to modify the filter condition for a field, find the target field, select the new Relational
Operator you want to use for the field, and enter the new Value that you want to compare the field
against.

c. If you want to add a new field, enter the Logical Operator in the last field to determine how you want
to combine the field-level filters, click the New Field button, and perform the following:

a. Use the first drop-down to select the Field you want to filter,

b. Use the second drop-down to select the Relational Operator you want to use.

c. In the third field, enter the Value that you want to compare the field against. The value must
match a value in your agency’s database. You can click the button to the right of the field and
select a variable from the Variable picker, or enter the variable into the field manually.

d. Repeat the preceding step for every new field.

For more information on adding new fields in Search By, see Creating a Global QuickQuery.

7. If you are querying more than one field, click the New Field button located at the top of the portlet.

Civic Platform adds a condition to the Search By section for the additional field.

8. Repeat for each new field.

To delete a field from your query, select the field and click Delete Field.

9. Click the Preview SQL button to view the SQL in the Resulting Query text field.

10.Click Submit.

Civic Platform updates the Global QuickQueries list.

11.To set the QuickQuery as the primary QuickQuery for the portlet:

a. Click the Recipient tab.

Civic Platform displays a list of Recipients.

b. Click the Recipient Key link.
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Civic Platform displays the Recipient Key list.

c. Select the Primary option.

d. Click Submit.

Deleting a Global QuickQuery
This section describes how to remove a QuickQuery from your system.

To delete a QuickQuery

1. Access the Global QuickQueries portlet (Accessing the Global QuickQueries Portlet).

2. Select the portlet with the query you want to delete.

3. Click Submit.

Civic Platform displays a list of the queries defined for that portlet.

4. From the list of queries, select each query you want to delete.

5. Click Delete.

Civic Platform updates the Global QuickQueries list.

Assigning a QuickQuery
You can assign QuickQueries to individual users, to entire groups, or to modules in the Recipient tab of the
Global QuickQueries portlet (Navigating to the Setup Portlet). After you assign a query to a user or group,
those users can see the query in their My QuickQuery drop-down list in the toolbar for the applicable list
portlet. If you created multiple queries for that portlet, the user can select a primary QuickQuery to apply to
the portlet.

For more information, see Setting Up Security Policies.

Removing a QuickQuery
This section describes how to remove a QuickQuery from a user or user group.

To remove a QuickQuery from a user or user group

1. Access the Global QuickQueries portlet (Accessing the Global QuickQueries Portlet).

2. Select the portlet with the QuickQuery you want to modify.

3. Click Submit.

Civic Platform displays a list of the QuickQueries defined for the selected portlet.

4. In the Name column, click the link to the QuickQuery with the recipient you want to remove.

If you do not see the QuickQuery you want, click Search.

Civic Platform displays the QuickQuery details in the secondary portlet.

5. Click the Recipients tab.

Civic Platform displays a list of recipients.
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6. Select each recipient you want to remove from the list.

7. Click Delete.

Civic Platform displays a confirmation message and updates recipient list.

Managing User Defined QuickQueries
If you allow your agency Civic Platform users to create their own personal QuickQueries, known as My
QuickQueries, you can manage them through the Administration portlet. You can search for user defined
QuickQueries, edit them (if permitted), and delete them as needed.

Multiple daily users can assign a QuickQuery the same name. Civic Platform differentiates these
QuickQueries by the user’s login name. For example, John Q. Smith and Ann Jensen can both create a
query called “Projects Due Today.” A user or administrator who wants to create two QuickQueries with
the same name on the same login account must differentiate the two. For example, “Opened Today with
Balance (Global)” and “Opened Today with Balance (My QQ).”

For more information about defining user QuickQueries, see “Understanding QuickQueries” in the Accela
Civic Platform User Guide.

Topics

• Searching for User Defined QuickQueries

• Editing User Defined QuickQueries

• Deleting User Defined QuickQueries

Searching for User Defined QuickQueries
Depending on the size of your agency, you might have hundreds of user defined QuickQueries that agency
users create. Civic Platform enables you to search for QuickQueries created by users so you can manage
them as needed.

To search for user defined QuickQueries

1. Access the My QuickQueries portlet (Accessing the My QuickQueries Portlet).

2. Select the view for which you are creating the query.

3. Click Submit.

Civic Platform displays a list of the queries defined for that view.
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4. Click Search.

Civic Platform displays a search form.

5. Complete any fields that display to search for a QuickQuery.

6. Click Submit.

Civic Platform displays a list of queries that match your search criteria.

Editing User Defined QuickQueries
Civic Platform enables you to edit QuickQueries created by users so you can manage them as needed.

To edit user defined QuickQueries

1. Access the My QuickQueries portlet (Accessing the My QuickQueries Portlet).

2. Select Record List from the Portlet drop-down list, then click Submit.

Civic Platform displays the list of User Created QuickQueires.

3. Locate and select the QuickQuery you want to modify.

Civic Platform displays the Query with all fields editable.

4. Modify any of the fields as necessary

5. Click Submit.

Deleting User Defined QuickQueries
You can delete user defined QuickQueries as needed. You might need to delete a user defined
QuickQuery, for example, if an employee changes departments and you no longer want them to have
access to data they for which they created a QuickQuery. You might also want to delete QuickQueries for
employees who are no longer at your agency, to help keep unnecessary data out of your database.

To delete user defined QuickQueries

1. Access the My QuickQueries portlet (Accessing the My QuickQueries Portlet).

2. Select the view for which you are creating the query.

3. Click Submit.

Civic Platform displays a list of the queries defined for that view.
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4. From the list of queries, select each query you want to delete.

If you do not see the QuickQuery you want, you can search for it by clicking the Search button located
in the toolbar.

5. Click Delete.

Civic Platform updates the Global QuickQueries list.

QuickQuery Enabled Portlets
This list details the administration portlets where you can set up and use global or user-defined
quickqueries.

• AMS Asset Attribute Table List: The Attribute Table list portlet.

• AMS Asset Template List: The Attribute Template list portlet.

• AMS Asset Type List: The Asset Type list portlet.

• AMS Attribute List: The Attribute list portlet.

• AMS Condition Assessment List: The Condition Assessment administration list portlet.

• AMS Cost Group List: The Cost Group list portlet.

• AMS Cost Item List: The Cost Item list portlet.

• AMS Part Contact List: The Part Contact list portlet.

• AMS Part Location List: The Part Location list portlet.

• AMS RefRating List: The Rating Type list portlet.

• AMS WO Task Definition List: The Work Order Task list portlet.

• AMS Work Order Template List: The Work Order Template list portlet.

• StructEstabl Type List: The Structure & Establishment Types portlet.

This list details the daily user portlets where you can set up and use global or user-defined
quickqueries.

• ACA My Permit List: The My Permit List on the record home page in Citizen Access.

• Citizen Access Record List: The record list in Citizen Access.

• AMS Asset CA List: The Asset Condition Assessment list portlet.

• AMS Asset Data List: The Assets list portlet.

• AMS Asset Work Order List: The Work Order tab in the Assets portlet.

• AMS Part Inventory List: The Part Inventory list portlet.

• AMS Part Transaction List: The Part Transaction tab in the Part Inventory portlet.

• AMS PM Schedule List: The PM Schedules list portlet.

• AMS Work Order Asset List: The Assets tab in the Work Orders portlet.
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• Batch Invoice List: The Invoices list portlet.

• Batch Job List: The Batch Jobs list portlet.

• Contact Record List: The Record List tab in the Contacts portlet.

• Fees List - The Payment tab in the Payment Processing portlet.

• Inspection List: The Inspections list portlet, and the Inspections tab in the My Tasks portlet.

• My Document Task List: The Document Review Tasks tab in the My Tasks portlet.

• My Workflow Task List: The Workflow Tasks tab in the My Tasks portlet.

• Point of Sale Transaction List: The Point of Sale list portlet.

• Record List: The Record list portlet.

• Record Set Member List: The Set Members tab in the Set: Records portlet.

• Record Status History List: The Application History tab in the Record portlet.

• Reference Address List: The Addresses list portlet.

• Reference Contact List: The Contacts list portlet.

• Reference Owner List: The Owners list portlet.

• Reference Parcel List: The Parcels list portlet.

• Reference Professional List: The Professionals list portlet.

• Reference StructEstabl List: The Structures & Establishments list portlet.

• Related Record List: The Related Records tab in the Record portlet.

• Trust Account List: The Trust Account list portlet.

Designing Forms for Portlets
Form Portlet Designer enables you to customize the forms in your Civic Platform system. “Forms” are
where agency users enter data, and where Civic Platform collects all of the data that it stores in the back-
end database. You can design forms for use at the agency, module, user group, and individual user
levels, depending on your agency’s information-gathering requirements. Form layout designs and field
characteristics apply to all sub-levels.

Click a topic title below for full details.

Related Links

Working with Forms

Working with Lists

Working with Customized Views

Creating Dynamic Text Labels
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Working with Forms
Topics

• Creating a Form

• Customizing a Form

• Setting Default Values for Fields in a Search Form

• Using the Edit View Feature

Creating a Form
This section describes how to create a form using the Form Portlet Designer. To create a form, you select
the portlet and then determine what organizational level you want to apply to the form. After determining
the portlet and the organization levels, choose which fields to make available. Each field has unique
attributes you can specify; for full details see Customizing a Form.

To create a form

1. Access the Form Portlet Designer (Accessing the Form Portlet Designer).

2. Identify which users you are granting access to your new form. Click the tab that corresponds with the
access-level you are creating for the form: Agency, Module, Group, or User tab.

Best practice is to design a form on the Agency tab and then restrict access based on any other user
access: Module, User Group, and User.

If you choose the User tab you can limit access to just one user, which eliminates the possibility for
other groups to access the form.

3. Choose from the Portlet, Agency, Module, Group, and User drop‑down menus to specify where you
want the form to display. For example, if you selected the Module tab in , choose the Module from the
drop-down menu. With each selection, Form Portlet Designer refreshes and displays available options.
Also, depending on which tab you selected in , the fields vary. For example, if you selected the Agency
tab, you only need to choose an item from the Agency and Portlet drop-down menus.

4. Click New.
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Civic Platform displays a layout editor and the Available Fields page.

5. Complete the following fields.

Filter Name Enter a descriptive name for the filter, so that you can identify it if you need to locate it
later. After you save a form, the Filter Name displays in the Name column.

Description Enter a descriptive name to help identify the purpose of the form.

Source View The Source View Name is read-only and you cannot modify it.

6. Arrange the fields on the form in the same order you want them to appear for users when they complete
the form.

For complete details, see Customizing a Form.

7. Rename any of the field labels, according to your agency’s business objectives, as follows:

a. Double click a field name to access the properties page for the field.

b. Modify the text that displays in the Label field. You cannot change the database label (DB Label).

c. Click OK.

Civic Platform displays your customized field name.

8. When you are happy with the layout of the form click Save.

Customizing a Form
When you create or edit a form in the Form Portlet Designer, you can use the different controls to show,
hide, move, make read-only, and alter the available fields according to your business objectives. This
section explains the controls you can use to customize forms in the Form Portlet Designer.

To customize a form

1. Open the Form Portlet Designer by either creating or editing a form layout.

For instructions, see Creating a Form or Customizing a Form.

2. Click Available Fields.

Civic Platform displays the Available Fields page.
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3. To display or hide fields:

a. To display fields, from the list of Available Fields, double-click each field you want to add to the
form, and then click OK.

Civic Platform displays the selected field on the layout page and removes the selected fields from
the Available Fields list.

Note:

The Available Fields list also provides the Address Template, Parcel Template, or Owner Template
options. If you select any of those options, Civic Platform removes the option from the Available
Fields list and displays all active attributes of the selected template as additional fields on the form.
The APO Form Layout Editor defines the layout and display of each field in a template.

On the Record Search form, only record-searchable attributes display as available fields. You can
specify which attributes are record-searchable when creating or editing a template.

b. To hide a field, select the field on the layout page and click Delete.

4. To change the location of a field, drag the field to its new location on the layout page.

If your field arrangement causes any fields to overlap, the overlapping fields display with red borders,
enabling you to easily identify them.

If you have any overlapping fields on your form when you attempt to save it, Civic Platform returns an
error. To save the form, you must locate the overlapping fields (see the above example) and separate
them.

5. To change a field name (Label) or any of the field’s properties:

a. Double-click the field you want to change.

Civic Platform displays the Field Properties page.
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b. Modify the field properties as necessary. Note: you cannot modify the database label (DB Label).

For a list of field descriptions, see Table 21: Form Designer Field Properties

c. Click OK.

6. To add a URL link to the form:

a. Click Text, which adds a dynamic label to the form. Then double-click the dynamic label and:

• In the Label field, enter the text of the link.

• In the URL field, enter the URL for the website that opens when a user clicks the link.

7. Click Preview to review the layout of your form.

Civic Platform displays a Preview page.
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To close the preview, simply close the preview page.

8. When you are happy with the appearance of your form, click Save.

Table 21: Form Designer Field Properties

Access Key Enter the shortcut key that users can press in addition to the ALT key to position the
cursor in this field. For example, if you want users to be able to access the Asset ID
field by pressing ALT+I, enter the letter I in this field.

By Range When applicable, allows the user to search this field based on a range of values. The
default is Yes. If you select No, the field allows for searching on a single field, not on a
range. (Optional)

DB Label This field is display-only. It shows the actual name of the field as it displays in your
database.

Default Value Set a default value for the field on a search form portlet. The default value you set
appears in the field whenever users navigate to the search form portlet.

If you do not supply a value, the field can either be blank (null) or it can display the
value that the user entered during his or her last search, depending on the field type.

If you want this type of field to always appear as blank (null) in a new search, select
Set Null in the Default Value property setting for the desired field. This property is only
available for fields on search form portlets.

The default value varies depending on the By Range field property. When you set
the By Range field property to Yes, Civic Platform displays the Default From and
Default To properties instead of the Default Value property. When you set it to No,
Civic Platform displays the Default Value property only.

For more information on setting a default value for a search field, see Setting Default
Values for Fields in a Search Form.

Label Enter a label for the field as you want it to display on the form.

Mask Choose a mask type from the list of masks to apply to the field.

Read Only The default is No. Use the drop-down list and choose Yes to make the field read-only
when users access the form. Whichever level you design the form for, the read-only
characteristic then affects all of its sublevels.
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For example, if you design the form for the agency level, the read-only attribute applies
to the sublevels of module, user group, and individual users. Or, if you design the form
at the module level then the read-only characteristic applies to the sublevels of user
group and users.

Required Specify if you want to make the field mandatory. When completing a form, users must
enter information in a required field. Required fields display in the Form Layout Editor
as well on the actual form with a red asterisk.

Tab Index Enter a number to determine the position of this field in a tab sequence. When a user
is working with a form, he or she can press the TAB key to move from field to field.
The index number determines the order in which this field becomes active in relation to
other fields on the same form.

Setting Default Values for Fields in a Search Form
This section explains how to set a default value for a field in a search form. The default values you set
appear in the field whenever users navigate to the search form. For example, you can have the City field
populated with the value of “Bridgeview” when the user opens the Owner Search form so the user does not
need to manually select or enter the city name.

You can set default values in the Form Portlet Designer, in the Edit View feature, or any fields that allow
you to enter a value in the Default Value property. If you do not supply a value, the field can either be
blank (null) or it can display the value predefined by the search logic. If you want this type of field to always
appear as blank (null) in a new search, select Set Null in the Default Value property setting for the desired
field.

You can set a default value for a field of the text, numeric, date, radio button, or check box type. You
can also set a default option for a drop-down list field. However, the Default Value property setting is not
available for data picker fields such as Record Type, Department, and User, because the options for those
fields vary by agency. For radio button fields, check box fields, and drop-down list fields, the default value
must be a valid database value, instead of a label text.

Some numeric fields support a range of values as the search criteria. You can allow a range of values for
a numeric field by setting the By Range property for the desired field to Yes. This way, you can specify a
default minimum value, a maximum value, or both that you want to apply to the range of acceptable values.

To set a default value for a search field

1. Access the Form Portlet Designer (Accessing the Form Portlet Designer).

2. In the Portlet field, select the search form you want to customize.

Civic Platform displays the form layout editor.

3. Double-click field you want to change.

• Date fields

Civic Platform displays the Default Value property with a Set Null option and a Today + Days field.



 | Part 1: Configuring the User View | 139

• Fields of other types that do not support searches based on a range of values

Civic Platform displays the Default Value property with a Set Null option and a text field.

• Fields of other types that support searches based on a range of values

Civic Platform displays the Default From and Default To properties. Each default value property has
a Set Null option and a text field.
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4. Enter a default value for the field.

The value you can enter depends on the type of the field. For examples of default values, see Table 22:
Default Value Property Setting.

5. Click OK.

Table 22: Default Value Property Setting

Field Type Example Default Value Notes

Check Box Y Enter the key value of the check box status as stored in
your database.

Date Today + 90 Days Specify a date range in the Today + n Days field. If you
enter a positive integer, the default search criteria is within
X days after the current date. If you enter a negative
integer, the default search criteria is within X days before
the current date.

Drop-down List North Enter the key value of a valid option as stored in your
database. An easy way to identify the correct key value
is to view the source code for the search form in your
browser and locate the content of the option value.

Numeric 8887222352 If you set the By Range property for the field to Yes, enter
a valid number in the Default Value property setting. If
you set it to No, enter a valid number in the Default From
property setting, the Default To property setting, or both.

Radio Button Y Enter the key value of a valid option that you have stored
and identified in your database. An easy way to get the
correct key value is to view the source code of the search
form in your browser and locate the content of the option
value.

Text New Enter valid alphanumeric characters in the Default Value
property setting.
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Using the Edit View Feature
Civic Platform provides the Edit View feature to customize how information displays in a form.

To edit the view of a form portlet

1. Locate the form portlet you want to customize and click Menu.

Civic Platform displays the menu options.

2. Choose the Edit View option from the drop-down menu.

Civic Platform displays the Edit View page and the Available Fields page.

3. Complete the following fields:

Filter Name Enter a descriptive name for the form portlet. This filter name is the name you can
use to locate the form using the Form Portlet Designer.

Source View Name This field is not editable.

Description Enter a description to help identify the purpose of the form.

Align Command Use this drop-down list after you have added fields to the form. Select one or more
fields and choose the desired option from the drop-down list.

Effect Scope Specify the availability of the customized filter for the desired module, user group,
or user with the corresponding drop-down list.

4. If you want to show an available field, do the following:

a. Click Available Fields.

Civic Platform displays the Available Fields page.
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b. Select a field from the list of Available Fields. To select multiple fields, double-click each field.

c. Click OK.

Civic Platform places the selected field on the form and removes the field from the Available Fields
list.

Note:

The Available Fields list also provides the Address Template, Parcel Template, or Owner Template
options. If you select any of those options, Civic Platform removes the option from the Available
Fields list and displays all active attributes of the selected template as additional fields on the form.
The APO Form Layout Editor defines the layout and display of each active field in a template.

On the Record Search form, only record-searchable attributes can show up as additional fields. You
can specify which attributes are record-searchable when creating or editing a template.

5. To hide a selected field, select the field on the form and click Delete.

6. To change the position of a field, drag the field to the new position on the form.

7. To change a fields name or its properties:

a. Double-click the field you want to change.

Depending on the type of form you are editing, your options vary.

Civic Platform displays the Field Properties page.
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b. Complete the field properties as necessary.

For a list of field descriptions, see Table 21: Form Designer Field Properties

c. Click OK.

8. When you are happy with the appearance of your form click Submit.

Working with Lists
The List Layout Editor enables you to customize the list portlets in Civic Platform. You can set up lists at
the agency, module, user group, and even individual user levels, depending on what you want certain
users to see. When you create a list design, it applies to all sub-levels.

Topics

• Creating a List Portlet

• Editing a List Portlet Layout

Creating a List Portlet
This section describes how to create a list portlet using the List Layout Editor. To do this, select the portlet
and determine which organization level you want to apply to the list. After you determine the portlet and the
affected organization level, you can determine which fields you want to make available on the list portlet
using the List Layout Editor.

You can show or hide certain fields, make fields read-only, and control the field order and width of each
field using the List Layout Editor. Fields on a list display as column headers.

To create a list portlet

1. Identify which users can access your new list and select an existing list to use as a template upon which
to build your portlet.

For instructions to do this, see Customizing Menus, Tabs, and Drop-down Lists .

2. Click New.

Civic Platform displays the List Layout Editor.
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3. Complete the fields as necessary.

For a list of field descriptions, see Table 23: List Layout Editor Details.

4. Click Save.

Table 23: List Layout Editor Details

Available Fields Displays the fields that are available to use but are not currently displaying in the list
portlet. To move any field to the Selected Fields box, highlight the field and click the
right-arrow. To move all fields, click double arrow. Hold the CTRL key to select multiple
fields.

A > Z Ascending Select this option to further sort a selected sort order field in an ascending order
alphabetically from A to Z. This option is the default setting and is available when you
select a sort order for a field.

Contract Enter the minimum number of items to display on one page of a list.

Description Enter a description for the form.

Display Order Specify the order for displaying each field on the form.

Effect Scope Specify the availability of the customized sort/filter using the drop‑down feature for
Module, Group, and User.

Element Civic Platform lists the fields in the Selected Fields box in their current order.

Expand Enter the maximum number of items to display on one page of a list.

Filter Name Enter a descriptive name for the filter.

Label If you want to customize the text label for a field, enter the new text label in the label
field.

Mask If you want to add a mask to the display of any field, click Mask to set up the mask.

Number of Records The amount of records you want the user to see. The Contract option is the number
of records displaying when a user contracts a list in a portlet and you have more than
one portlet on your screen. The Expand field is the list of records shown when a user
expands a list in one portlet.

Record Selection Select the type of record selection icon you want to apply to the list. Civic Platform
defaults to the Check Box record selection tool. If you do not want to allow users to
select records, select None.

Required Specify if you want to make the field mandatory. If you select Yes, a red asterisk
displays on that field and a user cannot submit the form until that field has data entered
in it.

Selected Fields Displays the fields that currently display in the list portlet. To remove any field, highlight
the field and click left-facing arrow. To move all fields, click double arrow. Hold the
CTRL key to select multiple fields.

To change the order, highlight a field and click up or down arrows.

Sort Order Enter the sort order of a particular field. Civic Platform sorts lists based on the sort
order. Civic Platform sorts fields with the lowest sort order (highest priority) first, to
simplify organizing and grouping list items. For example, if you assign the sort order
of the Type field to “1st” and the sort order of the Subtype field to “2nd,” Civic Platform
sorts the list first by type and then by subtype.

Note:

If you want the newest record to appear at the top of the list, assign the Audit
Date field to the 1st sort order. This field contains the record's creation date
and time.

Source View Name Civic Platform identifies the name of the form you are modifying.
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Width Enter the number of pixels for the column width.

Z > A Descending Select this option to further sort a selected sort order field in a descending order
alphabetically from Z to A. This option is available when you select a sort order for a
field.

Editing a List Portlet Layout
You can show or hide certain fields, make fields read-only, and control the order in which fields display and
their width, with the List Layout Editor. Fields on a list display as column headers.

To edit a list portlet layout

1. Find the list to edit by identifying which users access the list.

For instructions to do this, see Customizing Menus, Tabs, and Drop-down Lists .

2. Click the list design you want to edit.

Civic Platform displays the List Layout Editor.

3. Complete the fields as necessary.

For a list of field descriptions, see Table 23: List Layout Editor Details.

4. Click Save.

Working with Customized Views

• Removing a Customized View

• Copying a Customized View

• Accessing and Assigning the View

Removing a Customized View
This section describes how to remove a customized form or list portlet. Removing a customized view
allows users to see all available fields according to the default settings.

To remove a customized view
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1. Identify which users access the customized view you want to remove.

For instructions to do this, see Customizing Menus, Tabs, and Drop-down Lists .

2. Select the customized view you want to remove.

3. Click Delete.

Civic Platform removes the form design, and updates the list of available forms.

Copying a Customized View
This section describes how to copy a customized view to another user or group of users. For example, if
you need to make a customized record list for all users who manage fee information, you need to make the
list for the billing department as well as the cashier user group. The cashier user group might not belong to
the same user group as the billing department. In such a case, you can create a customized view and copy
it to all necessary user groups.

To create a copy of a customized view

1. Select the existing customized view to use as a pattern.

For instructions to do this, see Customizing Menus, Tabs, and Drop-down Lists .

2. Use the Copy to Fields to identify which user or users you want to copy the customized view
assignment to.

For descriptions of each field, see Table 24: Copy to Field Details

3. Select each view you want to copy.

4. Click Copy in the toolbar.

Civic Platform copies the view and identifies how many customized views it successfully copied.

Table 24: Copy to Field Details

Agency Select the agency to which you want to copy the customized view.

Module Select the module to which you want to copy the customized view.

User Group Select the user group to which you want to copy the customized view.

User Select the user to which you want to copy the customized view.

Accessing and Assigning the View
To access and assign a view

1. Access the Form Portlet Designer (Accessing the Form Portlet Designer).

2. Click one of the following tabs depending on the level of form you want to create: Agency, Module,
User Group, User, Personalization, or Dynamic Text. We are using the Module tab to illustrate this
example. For a list of fields, see Table 25: View Filter Fields. Depending on the level (agency, module,
user group, or user) of the design you create, you might not see all of these fields.

The Personalization tab is view only. Administrators can only view and delete personal forms or lists.
You cannot modify lists or forms using this tab.

Civic Platform displays a list of all custom views defined for the selected organization level.



 | Part 1: Configuring the User View | 147

3. Use the filter menus to refine the list of views.

For a list of fields, see Table 25: View Filter Fields. Depending on the level (agency, module, user
group, or user) of the design you create, you might not see all of these fields.

Civic Platform updates the list to reflect the selected agency, module, user group, and view.

4. Choose one of the following as appropriate:

• Add a new customized form. For instructions, see Creating a Form.

• Add a new customized list. For instructions, see Creating a List Portlet.

• Edit an existing form. For instructions, see Customizing a Form.

• Edit an existing list. For instructions, see Editing a List Portlet Layout.

• Remove an existing customized view. For instructions, see Removing a Customized View.

• Copy an existing view. For instructions, see Copying a Customized View.

Table 25: View Filter Fields

Agency Select the agency that contains the module you want to work with.

Module Select the module that contains the user group you want to work with.

Portlet Select the list or form view you want to work with.

User Group Select the user group that contains the user you want to work with.

User Select the view you want to work with. A view is either a list or a form in Civic Platform.
Every list or form you can modify appears in this drop-down menu.

Creating Dynamic Text Labels
The Dynamic Text Tab enables you to create text labels that allow users to switch languages in
customized form layouts. Use the buttons at the top of the portlet to search for, add, or delete a dynamic
text label. After you create a label, you must add it to the form layout where you want it to display. For
instructions on creating a form layout, see Creating a Form.

Note:

The dynamic text label feature specifically applies to Civic Platform systems configured for
Internationalization.

To create a dynamic text label

1. Access the Form Portlet Designer (Accessing the Form Portlet Designer).
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2. Click Dynamic Text tab.

Civic Platform displays the Dynamic Text List view.

3. Click New.

Civic Platform displays the Dynamic Text New page.

4. Complete these fields:

Key The name of the text label.

Display Text The text that displays on the screen to the user.

Language If your system is localized/internationalized, select the desired language from the
available drop-down list to apply to the display text.

5. Click Submit.

Civic Platform adds the label to the Dynamic Text List view.
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Part 2: Setting Up Agencies, Organizations,
and People

Civic Platform provides functions to set up your agency.

Related Links

Configuring Organizations, Departments, and Users

Managing Contacts, Licensed Professionals, and Public Users

Setting Up Cross-Agency Operations

Customizing Regional Settings

Configuring Organizations, Departments, and Users
This section contains the information you need to structure your organization and conduct user
administration tasks, such as resetting passwords and assigning access permissions.

Click a topic title below for full details.

Related Links

Working with Organizations

Establishing User Groups

Managing Users

Working with Organizations
Topics

• Adding a Level to an Organization Structure

• Establishing an Organization Structure

• Editing an Organization Structure

• Establishing an Organization Alias

• Editing an Organization Level

Adding a Level to an Organization Structure
When you set up your organization in Civic Platform, you define up to six organization levels. The main
level is the service provider. Civic Platform provides this value when you implement Civic Platform. Your
service provider code is a unique code that distinguishes your agency from all other jurisdictions for which
Civic Platform is the service provider. You cannot change this value.

You can define these six levels:
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• Agency. You determine this value for one or more agencies that you set up. When you search for
departments within Civic Platform, this is the first level within an organization structure you can select.
You also use your agency name when you log in to Civic Platform.

• Bureau. An organization level within an agency.

• Division. An organization level within a bureau.

• Section. An organization level within a division.

• Group. An organization level within a section.

• Office. An organization level within a group. An office is the final level within an organization structure.
You cannot add a branch to this organization level.

Note:

When you set up an organization structure, you must include all six levels, or branches. Even if you do
not use the lower organization levels, you should add an “NA” branch for each level to include in the
structure.

Examples:

Metroville > building > na > na > na > na > na > Counter Technicians

Metroville > building > inspections > na > na > na > na > Inspectors

Metroville > buidling > na > na > na > na > Inspections > Inspectors

Civic Platform uses this structure in two places:

• To identify the department assigned to the Task in a process stack

• To assign a user to a department

When a user does anything, Civic Platform inserts not only the user name but also the assigned
department. Also, when assigning inspections or tasks, the manager can look up the department and
select a user in that department to do the required inspection or task.

To set up a hierarchy among departments, you can define branches within each branch.

Here is an example of a typical setup:

• Your Civic Platform implementation specialist defines the Service Provider as the main agency when
during your initial system set up.

• Add the first level to the main agency. Usually, this level matches or is equal to the available modules
turned on for Civic Platform. For example, if you had Building, Enforcement, and Planning modules, you
can add three levels to the Agency called Building, Enforcement, and Planning.

• Add under each first level a level called Bureau. The setup looks like this example: Metroville > Building
> Inspections Metroville > Enforcement > Inspections Metroville > Planning > Inspections

• Add additional levels to the Bureau level. For example, in Building you might have Inspections, Counter,
BuildingAdmins, and Cashier. The setup looks like this example: Metroville > Building > Inspections
Metroville > Building > Counter Metroville > Building > BuildingAdmins Metroville > Building > Cashier

• Each agency could have multiple nodes at the Bureau level. Enforcement might have Inspections,
Counter, BuildingAdmins, or Cashier. The setup looks like this example: Metroville > Enforcement >
Inspections Metroville > Enforcement > Counter Metroville > Enforcement > BuildingAdmins Metroville >
Enforcement > Cashier

When you have no more levels to add, use NA.
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To add a level to an organization structure

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > Organizations.

Civic Platform displays the Set Up Organization page with links to each organization level.

3. Click the link to the appropriate level to which you want to add a branch. For example, click Metroville.

Civic Platform displays a list of all of the branches embedded within a level. For example, if you click the
link to a specific agency, Civic Platform displays a list of all of the bureaus defined for that agency.

4. Continue to click the link to the next level as needed to add a branch to that level.

For example, to add an office to a group, click the link to the agency, then the link to the bureau, then
the link to the division, then the link to the section. Lastly, click the link to the group to which you want to
add the office branch.

5. Click Add.

Civic Platform displays an Add Branch window, where you can view the current level of the branch you
are about to add.

6. Complete these fields:

Name Enter the name of the branch that helps to identify it.

Description Enter a description of the branch that helps to identify its purpose.

Status If you want the branch to be available in Civic Platform, select Enable; otherwise,
select Disable.

7. Click Add.

Establishing an Organization Structure
After you identify the branches for each organization level in your agency, you can set up an organization
structure. An organization structure, similar to a department, identifies a certain group of staff members.
When a user searches for departments in Civic Platform, they can find the organization structures you
have set up.

Note:

Before you can define a new organization structure, you must define branches and include all six levels
of organization branches within the structure. To set up branches, see Adding a Level to an Organization
Structure.

To establish an organization structure

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > Organization.

Civic Platform displays the Set Up Organization page with links to each organization level.

Note:

Your service provider code shows up as a link under the Service Provider heading.

3. Click the link to the agency you want to include in your organization structure.
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Civic Platform displays a list of all of the bureaus within the agency.

4. Click the link to the bureau you want to include in your organization structure.

Civic Platform displays a list of all of the divisions within the bureau.

5. Click the link to the division you want to include in your organization structure.

Civic Platform displays a list of all of the sections within the division.

6. Click the link to the section you want to include in your organization structure.

Civic Platform displays a list of all of the groups within the section.

7. Click the link to the group you want to include in your organization structure.

Civic Platform displays a list of all of the offices within the group.

8. Click the link to the office you want to include in your organization structure.

9. Click Add.

Civic Platform displays an Add Structure screen. In this window, you can view the definition of the
structure you are about to add.

10.Complete these fields:

Description Enter a unique description for the structure.

Status If you want the structure to be available in Civic Platform, select Enable; otherwise,
select Disable.

11.Click Add.

Editing an Organization Structure
After you add an organization structure to Civic Platform, you might need to change the description. You
might also need to disable a structure that represents an obsolete department within your agency.

Note:

Because departments link directly to tasks, if you change a department name, you must rework every
related task and associated user in Civic Platform. Accela recommends that you do not change organization
names.

It is best practice to inform users of any departments that you disable. Departments affect many areas of
the Civic Platform system, including conditions, workflow, and inspections. If users try to use a disabled
department, Civic Platform displays a message informing them that the department is not active and to
contact their agency administrator.

To edit an organization structure

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > Organization.

Civic Platform displays a list of structures at the bottom of the window.

3. In the list of structures, click the red dot that appears next to the structure you want to edit.

Civic Platform displays the Edit Structure pop‑up window. In this window, you can view the definition of
the structure you are about to edit.

4. Update these fields:

Description Enter a unique description for the structure.
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Status If you want the structure to be available in Civic Platform, select Enable; otherwise,
select Disable.

5. Click Update.

Establishing an Organization Alias
An organization contains six organization levels. If enabled, you can have the option to specify a
department name alias. Aliases enable you to replace a multi-level organization description with an
abbreviated and descriptive alias, such as Records Department.

After you establish an alias, users can choose from a list of organization aliases when selecting a
department in these situations:

• Assigning a workflow task

• Creating a new user

• Scheduling an inspection

• Assigning an inspection

• Looking up inspection statistics

• Applying conditions

• Updating the workflow status for a set of applications

• Creating a tickler

Note:

If you choose not to establish an alias for an organization structure, Civic Platform displays the 6-level
combined version of the department name when users search for a department.

You must establish an organizational structure before you can apply an alias to the structure. For
instructions, see Establishing an Organization Structure.

To establish an organization alias

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > Organization.

Civic Platform displays the Set Up Organization page.

3. Scroll down the page to display the list of organizational structures.

4. Click the red dot that appears to the left of the organization structure you want.

Civic Platform displays the Edit Organization Structure window.

5. Complete this field:

Department Enter a unique alias that clearly represents the organization structure.

6. Click Update.

Editing an Organization Level
After you add a branch to an organization level, you might need to change the branch description. You can
enable and disable branches in your organization as needed.
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It is best practice to inform users of departments that you disable. Departments effect many areas of the
Civic Platform system including conditions, workflow, and inspections, for example. If users try to use a
disabled department, Civic Platform displays a message informing them that the department is not active
and to contact their agency administrator.

To edit an organization level

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > Organization.

Civic Platform displays the Set Up Organization page with links to each organization level.

3. Click the link to the appropriate level for which you want to edit a branch.

Civic Platform displays a list of all of the branches embedded within a level. For example, if you click the
link to a specific agency, Civic Platform displays a list of all of the bureaus defined for that agency.

4. Continue to click the link to the next level as needed to edit a branch at that level.

Click the link to the agency > the link to the bureau > the link to the division > the link to the section.
Lastly, click the link to the group where you want to edit that branch.

5. Click the red dot that appears next to the branch you want to edit.

Civic Platform displays an Edit Branch pop‑up window. In this window, you can view the current level
and the name of the branch you are about to edit.

6. Update these fields:

Description Enter a description of the branch that helps to identify its purpose.

Status If you want the branch to be available in Civic Platform, select Enable; otherwise,
select Disable.

7. Click Update.

Establishing User Groups
Topics

• Adding a User Group

• Searching for a User Group

• Editing a User Group

Adding a User Group
Before you can grant a user certain privileges in Civic Platform, you must determine what privileges you
want to include in the user group. When you add a new user group you can determine each function you
want to make available to users who are part of the group. You can also determine what level of access
you want to apply to each function—for example, “full access” or “read only.”

Note:

Although you cannot delete a user group, you can disable the user group.

To add a user group

1. Access the Classic Administration page (Accessing Classic Administration).
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2. Choose User Profile > User Group.

3. Click Add.

4. Complete the fields as described in Table 26: User Group Fields.

5. For each function, select the level of access you want to grant to the user group.

6. Click Save.

Table 26: User Group Fields

Group Name Enter a unique name for this user group that describes the functions and privileges
of the group. For example, enter “Admin Full” or “Inspectors.”

Module Select the module you want to make accessible to users in this group.

If you want to give this user group access to additional modules, you can set up a
new user group with the same name, but choose a different module.

Description Enter a description of the user group.

Status If you want the user group to be available to use Civic Platform, select Enable;
otherwise, select Disable.

Searching for a User Group
You can search for any user group on your system, including those you previously disabled. For example,
you can search for a user group to update information or to change its status.

Note:

To see a list of all user groups, Click Submit without entering the group name.

To search for a user group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User Group.

3. Enter the name of the user group in the Group Name field.

4. Click Submit.

Civic Platform displays the User Group Browse page.

5. Click the red dot next to the group you want to edit.

Editing a User Group
After you create a user group, you might need to change some of the functions and privileges within the
user group. You can change the group name as well as the group status. If you no longer use a user
group, you can disable it.

To edit a user group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User Group.

3. Search for the user group you want to edit.

4. Complete the necessary fields as described in Table 26: User Group Fields.
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5. For each function, select the level of access you want to grant to the user group.

6. Click Save.

Managing Users
Topics

• Adding a User

• Viewing a User

• Editing a User

• Setting a User Account Disable Time Frame

• Setting a User Password Time‑out Time Frame

• Manually Enabling a User Account

• Changing a User Password

• Synchronizing External User Data

Adding a User
As your agency’s staff changes, you might need to add new users to your system. You can determine the
ID and password information that the user needs to log in to Civic Platform. You can also determine the
department and the user group to which the new user belongs.

Note:

If a specific user is an inspector and you choose to automatically assign and schedule inspections, you must
identify the inspector profile. For instructions, see Inspections.

To add a user

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Click the Add New User button.

Civic Platform displays the User-Add page.
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4. Complete the fields as described in Table 27: User Fields.

5. In the User Group/Privilege section, mark the check box next to each module you want the user to be
able to access.

6. For each module that you marked, choose the user group you want to assign the user to within that
module. A single user can belong to only one user group for each module.

7. Click Save.

Table 27: User Fields

Access Mode Mark either the Standard or Alternate option.

In Standard access mode, pop-up windows sometimes display. In Alternate access
mode, Civic Platform displays information in a new window instead of in pop-up
windows.

This accommodates users who depend on accessibility devices to interpret the content
of web pages, because these devices typically cannot interpret the JavaScript used
with pop-up windows.

Account Disable Time
Frame

Enter the number of days a user account can remain inactive before it becomes
disabled. Enter this value as a non-negative integer. When the number of days since
the Last Login Date is greater than the value in this field, the account becomes
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disabled. Mark the Enable option for the Status field to manually reactivate an
account.

If you leave this field blank, Civic Platform uses the agency account disable time
frame. If both the user and agency Account Disable Time Frame fields are blank, Civic
Platform uses the default value of 90 days.

Billing Rate Enter the billing rate per hour for the user.

Cashier ID Enter the cashier identification number for the user. Civic Platform uses this number in
the receipt number to identify the cashier and workstation. The ID number must be no
more than 10 characters.

Confirm Password This field displays on the User Profile Edit page; Civic Platform uses this field together
with the New Password field to change a user password. Enter the same password you
typed in the New Password field.

Daily Inspection Units Enter the units the user is available for inspections each day. Typically, a unit is one
hour.

Department Use this button to choose the department that this user belongs to. You must choose
all six levels or organization.

For the user account of a contract inspector or a self-certified inspector, this field is
ready-only and Civic Platform sets the department to <agency>/<agency>/<agency>/
PUBLIC/NA/NA/NA.

Display Initials in Citizen
Access

Civic Platform uses this field to indicate the display of the user’s initials in Citizen
Access. Mark the check box to display the user’s initials or clear the check box to
display the user’s name in Citizen Access.

Distinguished Name If you previously authorized this user for a LDAP services, enter the LDAP identifier.
Agencies often use LDAP as user’s repository.

Email Enter the user’s email address. Public users in Citizen Access can have permissions to
view the email address provided in this field to notify the agency user of the completion
of an action item or an inspection.

Employee ID Enter the ID, abbreviation, or code your agency uses to represent this user.

Initial Enter the user initials you want displayed in Civic Platform. For example, initials display
as an indication of who re-scheduled an inspection or completed a task in workflow.
Clear this field if you do not want user initials to display.

Initial (Default) This is a read-only field displaying the default user initials based on the user’s first,
middle, and last name.

Inspector Status You can identify users as inspectors and assign them to inspections.Mark the Enable
option to identify users as inspectors; otherwise, mark the Disable option. For the user
account of a contract inspector or a self-certified inspector, Civic Platform marks the
Enable option by default.

Integrated This field displays only if you are integrating an Active Directory user into Civic
Platform. Mark Yes if you want to add an integrated user. Mark No if you do not want to
add an integrated user.

IVR User Number An interactive voice response user number automatically generates in this field.

IVR Pin Number Enter the user’s IVR pin number.

Last Login Date This read-only field automatically populates with the most recent date the user logged
into their account.

When an agency administrator manually changes the Status from Disabled to
Enabled, this field resets.

Mobile Phone Enter the user’s mobile phone number.
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New Password This field displays on the User Profile Edit page; Civic Platform uses it together with the
Confirm Password field to change a user’s password. Enter the user’s new password in
this field. Then, enter this same password into the Confirm Password field.

Note that the password strength indicator displays a visual representation of the
password security strength against the agency's minimum password requirements.
If you have trouble entering a valid password, click the Requirements link to view the
agency’s minimum password requirements.

Password Enter any combination of alphanumeric characters that the new user wants to use
to log in to Civic Platform. As a security measure, Civic Platform displays an asterisk
instead of the actual characters you enter.

Note that the password strength indicator displays a visual representation of the
password security strength against the agency's minimum password requirements.
If you have trouble entering a valid password, click the Requirements link to view the
agency’s minimum password requirements.

You cannot use special characters (@ * ! % $ #) in a password.

Password Change Use these options to determine who sets the user’s password when the old password
expires.

Select the By User option to allow users to change their own password when their
previous password expires.

Select the By Administrator option to require the administrator to change passwords.

This field defaults to agency settings. If your agency allows users to change their
passwords, Civic Platform automatically selects the By User option. If your agency
requires an administrator to change passwords, Accela Automation automatically
selects the By Administrator option.

Password Time-out
Time Frame

Enter the number of days a user password can remain valid before Civic Platform
requires a password change. Enter this value as a non-negative integer.

Preferred Channel Select which contact information to expose as the preferred method of contact on
Accela’s Contractor app. Choices include Email, Mobile Phone, Office Phone (uses
Agency level phone number), and None (default).

Section 508 Support If you want to enable the Accessibility mode for the user, mark the check box next to
the field; otherwise, clear the check box. For more information about configuration and
usage instructions for the Accessibility features in Civic Platform and Citizen Access,
see the Accessibility Configuration and Compliance Guide.

Status If you want the user to be able to access Civic Platform, mark the Enable option;
otherwise, mark the Disable option.

Title Enter the user’s job title. For example, enter “Building Inspector” or “Supervisor.”

User cannot log in to
Civic Platform and does
not consume a Civic
Platform license

When selected, the user cannot log in to Civic Platform with this account, and does not
need a Civic Platform license. However, the user can log in to Accela apps with this
account but he must obtain an Mobile Office license for app access. For user accounts
of public users, Civic Platform selects the check box by default.

When cleared, the user must obtain a Civic Platform license and can log in to Civic
Platform with this account. If the user wants to log in to Accela apps with this account,
the user must also obtain an Mobile Office license.

User Group Permission Use this section to define user access permissions, and to assign the user to the to the
appropriate user groups.

Select each module for which you want to grant access.

Select each user group for which you want to grant access.

User Login ID Enter a unique combination of alphanumeric characters that the new user wants to use
to log in to Civic Platform.
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You cannot use special characters (@ ! # $ % *) in a login ID. You can, however, use
the underscore symbol.

User must change
Password at next Logon

Use these settings to control when you want the user to change their password.

Select Yes to force the user to change their password at next login; which is best
practice if you feel the password is not secure.

Select No to allow the user to change the password when they reach the designated
password Time-out Time Frame.

User Name Enter the first, middle, or last name of the user.

Viewing a User
You can search for any user on your system, including those that you previously disabled. If you are using
Active Directory and integrating users, you can also search for Active Directory users. You might need to
search for a user to update information or change the user’s status. You can also view all users.

To view users

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

Civic Platform displays the User—Search window.

3. To display all users, click the Browse All Users button.

4. To search for a user, complete the applicable fields:

User Login ID Enter the user login identification.

User Name Enter as much of the user name as you know.

Status Select the status types you are searching for.

Exclude Public Users Choose Yes to display only agency users. Choose No to display agency and public
users.

5. Click Submit.

Civic Platform displays the User Browse window. If you have activated this feature, Active Directory
users see a “Yes” in the Integrated column.

6. Click the red dot next to the user you want to view.

Civic Platform displays the User - Edit page.

Editing a User
After you create users in Civic Platform, you might need to change certain details about the user’s profile.
For example, you might need to update the users email address if it changes. If you use Active Directory,
administrators can also either convert external users to Civic Platform users, or convert Civic Platform
users to external users.

Although you cannot delete a user from Civic Platform, you can disable a user that should no longer have
access to Civic Platform. This feature is useful when an employee leaves your agency.

To edit a user

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user you want to modify. For instructions, see Viewing a User.
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4. If you use Active Directory, choose either Civic Platform user or External User, according to your
agency’s needs.

5. Update the fields as necessary. For a list of fields, see Table 27: User Fields.

6. In the User Group/Privilege section, select each module you want the user to be able to access.

7. For each module that you select, choose the user group to which to which the user belongs within that
module.

Note:

A single user can belong to only one user group for each module.

8. Click Save.

Civic Platform updates the user profile.

Setting a User Account Disable Time Frame
Configure your system to disable individual user accounts that are inactive for a set period of time.
When an account becomes disabled, the user must contact the agency administrator, who can manually
reactivate accounts. To manually enable an account, see Manually Enabling a User Account.

You can set account disable time frames at the agency and the individual user level. The user account
disable time frame defaults to the agency-level account disable time frame, if you specified one. If you
have not set an agency disable time frame, Civic Platform uses the default time frame of 90 days. Any
value you set at the user level overrides the default value or the agency value. If the Account Disable
Time Frame field in a User Profile is blank, Civic Platform defaults to the agency‑level time frame. For
information on setting an agency‑level account disable time frame, see “Adding an Agency” in the Civic
Platform On-premise Administrator Supplement.

To set an account disable time frame

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user profile for which you want to create an account disable time frame. For instructions,
see Viewing a User.

4. In the Account Disable Time Frame field, enter the number of days an account can be inactive before
it becomes disabled.

5. Click Save.

Civic Platform updates the user profile and begins checking its activity.

Setting a User Password Time‑out Time Frame
You can require users to regularly change their password to increase your system’s security. If you choose
to allow users to change their own password, they begin receiving messages prompting them to change
their password 15 days before it expires. Users can change their password immediately, at a later log in,
or at any time during their Accela session. If users fail to change their password within the time frame, they
must change their password or have it changed by their administrator before they can log in. To change a
password during an Accela session, see Changing a User Password.

You can set password time‑out time frames at the individual user level, and multi‑agency administrators
can set a password time‑out time frame at the agency level. Any value set at the user level overrides the
default time frame or the agency time frame, if you have set one. If the Password Time‑out Time Frame
field in a user profile is blank, Civic Platform defaults to the agency‑level time frame. If you have not set
an agency time frame, the default value is 90 days. For information on setting an agency‑level account
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disable time frame, see “Adding an Agency” in the “Agencies and Functions” chapter in the Civic Platform
On-Premise Administrator Supplement.

To set a password time‑out time frame

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user profile for which you want to create a password time‑out time frame. For
instructions, see Viewing a User.

4. Complete the following fields:

Password Time‑out Enter the number of days that a password can remain active.

Password Change Select By User to allow users to change their own passwords. Select By
Administrator to only allow agency administrators to change passwords. For
information on changing a password, see Changing a User Password.

Must Change Password
Next Login

Civic Platform automatically sets this option to Yes after the password time‑out time
frame has passed. When the user or the administrator changes the password, Civic
Platform sets this option to No. You can also set this option manually.

5. Click Save.

Civic Platform updates the user profile and begins monitoring its password time‑out time frame.

Manually Enabling a User Account
After a user account becomes inactive longer than the agency or user account disable time frame, or if
the account password has expired, the user cannot access Civic Platform. The agency administrator must
manually enable the account.

To manually enable a disabled account

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user profile you want to enable. For instructions, see Viewing a User.

4. Select Enable in the Status field.

5. Click Save.

Civic Platform clears the Last Login Date field and enables the user account.

Changing a User Password
When you set the password time‑out time frame, you can choose to allow users to change their own
passwords or require that administrators change their password. For instructions on setting a password
time‑out time frame, see Setting a User Password Time‑out Time Frame.

To change a user password

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user profile you want to change the password for. For instructions, see Viewing a User.

Civic Platform displays the User - Edit page.
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4. Complete the following fields:

New Password Enter the new password for this user. If you experience trouble entering a valid
password, click the Requirements link to view your agency’s minimum password
requirements.

Note:

The password strength indicator displays a visual representation of your password security strength
against the agency's minimum password requirements.

Confirm Password Enter the new password again.

5. Click Save.

Civic Platform updates the user’s password

Synchronizing External User Data
You can synchronize external user data with user data already in your agency’s database. To do this,
you must add an Active Directory server to your Civic Platform security policies. After you do this, when a
user logs in and Civic Platform validates their credentials, Civic Platform compares the external user data
with the existing user data on the Civic Platform server and updates the Civic Platform data as needed.
Administrators can also add external users to the Civic Platform database if you activate this feature.

Additionally, administrators can either convert external users to Civic Platform users, or convert Civic
Platform users to external users. For instructions, see Editing a User.

Note:

An administrator user (ADMIN) and public users cannot be external users.

The Civic Platform user login procedure authenticates the user directly against the Civic Platform
database. When an external user logs in, Accela sends the authentication request to the external source
for validation. If the user passes the validation, Civic Platform compares the attributes of the external
source and the Civic Platform database. If there are any changes in the external source, Civic Platform
corrects the data in the Civic Platform database.

Because this procedure affects the Civic Platform database, it also affects all Accela products, including
add-ons. This means that all external users who Civic Platform has validated using this process can log in
to products such as Civic Platform, Accela Wireless, or Citizen Access.

Topics

• Adding an Active Directory Server

• Integrating a User from Active Directory

Adding an Active Directory Server
To synchronize external user data with user data already in your agency’s database, you must add an
Active Directory server to your Civic Platform security policies.

To add an Active Directory server

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Agency Profile > Security Policy.

Civic Platform displays the Agency Security Policies—Select Policy page.
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3. Click the External User Policy link.

Civic Platform displays the Agency Security Policies page.

4. Complete the External User Policy fields. For a list of field descriptions, see Table 28: External User
Policy Fields.

5. Click Save.

Table 28: External User Policy Fields

Provider URL Enter the IP address of the external user server for the specified domain controller.
For example, enter the LDAP server URL. You can use SSL LDAP with “ldaps://”
URL.

Provider Port Enter the external user server’s IP port for LDAP access to Active Directory. This
port number is usually 389.

Access User Name Enter the ID of the user who can access Active Directory when performing a search
to add new integrated users. Enter the CN (common name) from the DN of the
access user entry.

Access User Passwd Enter the password for the user ID that can access Active Directory.

Access User OU Enter the base organization unit you want to use for searches. Access User OU is
the location within Active Directory where Civic Platform should search for users.
The Active Directory administrator provides this information.

Access User DC Enter the DC (domain component) of the parent entry of the access user entry. The
Active Directory administrator provides this information.

Note:
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Civic Platform accesses the LDAP server with the following user
information: CN=<Access User Name>,<Access User OU>,<Access User
DC>.

OU Filter Optional. OU Filter defines the organization unit from which to filter users in the
Access User DC and Additional Directory Entries from the LDAP server. If undefined,
Civic Platform searches all the OUs in the Access User DC and the Additional
Directory Entries. You can specify multiple filters, separated by comma, joined by
OR.

Additional Directory Entries Enter more organization units from which to retrieve user entries. Note that you must
specify the DC and root of each organization unit. In case you want to enter multiple
additional organization units, separate them by comma.

Status To use Active Directory to synchronize the Civic Platform server, select Enable from
the drop-down list; otherwise, select Disable.

Integrating a User from Active Directory
You can synchronize existing external user data with user data already in your agency’s database. After
you have added an Active Directory server to your Civic Platform security policies, you can search for
external users to add to your database. You can also indicate the department and user group to which an
added external user belongs.

Note:

An administrator user (ADMIN) and public users cannot be external users.

To integrate a user from Active Directory

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

Civic Platform displays the User—Search page.

3. Click Add.

Civic Platform displays the User—Add page.

4. Select External User.

Civic Platform displays the External User Search button on the User—Add page.
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5. Click the External User Search button.

Civic Platform displays the External User—Search page.

-

6. Complete any of these fields:

OU Search Root Enter the base organization unit to search.

Common Name Enter the given, or first, name of the user you want to locate.

Surname Enter the family, or last, name of the user you want to locate.

7. Click Search.

Civic Platform displays the search results.
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8. Click Select for the user that you want to integrate from Active Directory.

Civic Platform auto-populates the User Login ID field with the selected user.

Note:

If you specify an Active Directory attribute (for example, Common Name) in the Standard Choice
DEFAULT_USER_LOGIN_ID, Civic Platform uses the attribute value of the selected user to populate the
User Login ID field. Otherwise, Civic Platform uses userPrincipalName of the selected user from Active
Directory to populate the field.

9. Do one of the following:

• Enter the department that you wan to associate the integrated user with.

• Click the Department button to choose a department from a list and click Submit.

10.In the User Group/Privilege section, select each module you want the user to be able to access.

11.For each module that you selected, choose the user group to which the user belongs within that
module.

Note:

A single user can belong to only one user group for each module.

12.Click Save.

Civic Platform displays a confirmation massage indicating that you successfully integrated the user.

Managing Contacts, Licensed Professionals, and Public Users
Civic Platform divides contacts into two categories: reference contacts that serve as the reference
database, and daily contacts that users add to records. Best practice is to manage contact types by
defining only generic reference contact types, such as Individual and Organization. Record each individual
or organization as one reference contact. Then link reference contacts to records in various roles, such
as Applicant, License Holder, etc. This enables you to easily track all the transactional and reference
information about every individual and organization.

After you implement Civic Platform, you might need to add new licensed professionals, as appropriate for
your agency. After you add a licensed professional, users can search for the licensed professional when
creating or editing an application.

Anyone who uses the public facing portion of Citizen Access, IVR, or other Accela add-on products are
called public users. Public users include Anonymous Users and Registered Users who either navigate
the agency’s Citizen Access website or who use IVR and follow the call flow. System administrators can
control which functions are available for both types of public users.

Click a topic title below for full details.

Related Links
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Establishing People Templates

Managing Licensed Professionals

Managing Contacts

Creating a Public User Account

Searching for a Public User Account

Managing Accounts for Registered Agencies

Editing a Public User Account

Associating Addresses, Parcels, and Owners with Public User Accounts

Changing a Public User Password

Managing Licenses Associated with Public User Accounts

Establishing People Templates
Topics

• Creating a People Template

• Adding People Fields to Forms

• Searching for a Template

• Editing a Template

• Adding an Attribute to a People Template

• Editing an Attribute

• Setting Values for a People Template Drop-down List

• Applying Shared Drop-down Lists

Creating a People Template
When you create a new template, you determine the name, type, and description of the template. there are
three main types of people templates: contact, professional, and Public User. You can define contact types
and professional types in Standard Choices.

To create a template

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > People Template.

3. Click Add.

4. Complete the necessary fields as described in Table 29: People Record Template Fields.

5. Click Submit.

6. Add one or more attributes to the template. For instructions, see Adding an Attribute to a People
Template.

7. Add the People template data to the various People forms. For instructions, see Adding People Fields
to Forms.
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Adding People Fields to Forms
After you create your new People Template you must add this template data to the various “People” forms
to enable users to see your new agency-defined People fields.

To add template data to forms

1. Navigate to the appropriate people tab (Contacts or Professionals) on the Record detail portlet.

2. To open the detail form, click the link to the contact or professional.

3. To add the new field to the form, choose Menu > Edit View.

4. From the list of fields, click Template Data.

5. Click OK.

6. In the Effect Scope section, set the user access.

7. Click Save.

Searching for a Template
You can search for any template defined on your system, including templates that you previously disabled.
For example, you might need to search for a template to update information or to change the status of the
template.

To see a list of all the templates on your system, click Submit without entering details about an individual
template.

To search for a Template

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > People Template.

3. Complete the necessary fields as described in Table 29: People Record Template Fields.

4. Click Submit.

Civic Platform displays the People Template—Browse window.

5. Click the red dot that appears next to the template that you want.

Table 29: People Record Template Fields

Template Name Enter the template name.

Template Type Select the type of template you want to find. For example, if you want to find a template
for a billing contact, choose “Billing Contact.” Except for “Public User,” which is hard-
coded into the drop-down list, Civic Platform pulls the other values from the values you
set up as Standard Choice values for Contact Types and Licensed Professional Types.
You can set up additional template types in these Standard Choices, as needed.

Description Enter a description of the template that you want.

Status Choose the current mode of the template you are searching for.

Editing a Template
After you create a template, you might need to change the description or status. You can also edit any
attributes for the template. You can provide agency users with the ability to edit licensed professional
template fields on detail and reference detail forms. This feature is available in both Civic Platform and
Citizen Access. For more information on how to configure this feature, see Editing a Template.
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Note:

You cannot change the template name or its type, but you can add a new template and disable any
templates that you no longer use.

To edit a template

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > People Template.

3. Search for the template that you want.

4. Click Edit to the right of the Template Information section.

Civic Platform displays the People Template—Edit window.

5. Complete the necessary fields as described in Table 29: People Record Template Fields.

6. Click Submit.

7. Add one or more attributes to the template.

8. Edit any existing attributes for the template, as needed. For instructions, see Editing an Attribute.

Adding an Attribute to a People Template
Each attribute that you define for the template shows up as an additional field. If the attribute is of contact
or licensed professional type, the additional field shows up when you add or edit a contact or licensed
professional of the same type as your template. If the attribute is of Public User type, the additional field
displays on the Account Registration page and Contact Information section on the Account Management
page.

If you add a drop-down list attribute to a template, you must set up the values that you want to include in
the list. Users can then choose from the values when adding or updating contacts or professionals on your
system.

To add an attribute to a people template

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > People Template.

3. Search for the template that you want.

4. Click Add.

5. Complete the necessary fields as described in Table 30: People Record Template Attribute Fields.

6. Click Submit.

Table 30: People Record Template Attribute Fields

Attribute Name Enter the name of the attribute.

Label Enter the label for the attribute that you want to display when a user adds or edits
contact information.

Data Type Use the drop-down list to define the data information type for the field. For example,
Text, Numeric, Date, or DropdownList. If you are populating field information by EMSE,
you must choose the DropdownList data type for the attribute.

Description Enter a description of the attribute that helps to identify its purpose.
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Default Value If you want to supply a default value, enter it here. If you are setting up a drop-down
list, you can add values to the drop-down list so that a user has multiple values to
choose from.

Unit If you want to attach a unit such as square feet, dollars, or miles to the first field value,
enter it here. Choose from standard choices.

New Unit If the unit you want is not in the drop-down list, type in the new unit here.

Data Type Choose the type of the attribute. You can choose from Date, Number, Radio, Text, or
Drop-down List.

Display Order Enter a number to determine the position of the first field in your Specific Information
group. For example, if you want the field to display before any other fields, enter “1.”

Required Flag If you want the record attributes to be mandatory for the people template, select Yes;
otherwise, select No.

Citizen Access Display
Configuration

Select the appropriate option(s) for implementation in Citizen Access. Indicate if you
want the people template, such as the contact template, to be available on an online
application intake form, a search form, or on the record detail page. Also, indicate if you
want the template fields to be editable on both the record detail page and on the intake
form. For more information, refer to the “Record Inquiry” chapter in the Citizen Access
Administrator Guide.

Display in Citizen
Access Lists

If you want to display the attribute as a column header in the People lists, such as
Licensed Professional list, in Citizen Access, select Yes; otherwise, select No. Civic
Platform displays attributes with this option set to Yes in Citizen Access as one of the
available options of column headers of the People lists.

Administrators can set the option to be visible in the People lists. For complete
information on how to set an attribute to be a column header, see the “Working with
Web Pages” chapter in the Citizen Access Administrator Guide.

Status If you want to let users see this field in Civic Platform, select Enabled; otherwise,
select Disabled.

Editing an Attribute
After you create a template, you might need to change it. You can update any attributes within the template
by changing the label, data type, and any other features about the attribute.

Note:

You cannot change the attribute name or delete the attribute after you save it. You can add a new attribute
and disable attributes that you no longer use, as needed.

To edit an attribute

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > People Template.

3. Search for the template that you want.

4. Click the red dot that appears next to the attribute that you want to edit.

5. Complete the necessary fields as described in Table 30: People Record Template Attribute Fields.

6. Click Submit.
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Setting Values for a People Template Drop-down List
You can add an attribute to a template that displays as a drop-down list. After you add a drop-down list
attribute to a template, you must set up the values that you want to include in the list. You can also apply
a drop-down list with preconfigured values, known as a shared drop-down list, to a template attribute. For
more information, see Applying Shared Drop-down Lists.

To set up values for a people template drop-down list

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > People Template.

3. Search for the template that you want. For instructions, see Creating a People Template.

4. Click Edit next to the drop-down list attribute that you want.

Civic Platform displays a page where you can add, delete, or update drop-down list values.

5. Do one or more of the following:

• To add a new value, click Add, enter the value in the Attribute Value field, then Click Save.

• To update an existing value, enter the value, and then Click Update.

• To delete a value, click Delete.

6. Click Close to return to the People Template—Detail window.

Applying Shared Drop-down Lists
You can apply a drop-down list with preconfigured values, known as a shared drop-down list, to a template
attribute. Shared drop-down lists provide a useful way of capturing information that is generic to multiple
people templates or people information tables.

For more information on creating shared drop-down lists, see Customizing Menus, Tabs, and Drop-down
Lists .

To apply a shared drop-down list

1. Locate the People template to which you want to apply a shared drop-down list. For instructions, see
Searching for a Template.

2. Click the red dot next to the template to which you want to apply a shared drop-down list.

Civic Platform displays the People Template Detail page.

3. Click Edit next to the drop-down list you want to modify.

Civic Platform displays the People Template Drop-down List Add page.
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4. Click Use Shared Drop-down Lists.

5. Do one of the following:

• Click Search to return all shared drop-down lists.

• Enter the first letter of the drop-down list, or enter any 0other search criteria, then click Search.

Civic Platform returns the Shared Drop-down List Browse page.

6. Click Select next to the drop-down list you want to apply.

Note:

You can only select one shared drop-down list.

Civic Platform returns to the People Template Drop-down List Add page with the Field Values from the
shared drop-down list listed in blue.

7. Click Update.

Managing Licensed Professionals
Topics

• Adding Licensed Professionals

• Searching for a Licensed Professional

• Editing a Licensed Professional

Adding Licensed Professionals
After you implement Civic Platform, you might need to add new licensed professionals, as appropriate for
your agency. After you add a licensed professional, users can search for the licensed professional when
creating or editing an application.
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A licensed professional can have the same license number for multiple license types, such as Electrical,
Mechanical, and Plumbing licenses.

Note:

Depending on how you set up the licensed professional type, you might see other attributes or other fields,
in addition to the standard attributes listed here.

To add a licensed professional

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > Licensed Professional.

3. Click Add.

4. Use the License Typedrop-down list to choose the appropriate license type.

Civic Platform displays fields specific to the license type you chose.

5. Complete the fields specific to the license type you chose. For a list of common fields, see Licensed
Professional Fields.

Civic Platform pulls these values and fields from the values you set up as Standard Choices for
LICENSED_PROFESSIONAL_TYPE. Refer to the Civic Platform Configuration Reference.

6. Click Submit.

Table 31: Licensed Professional Fields

Address Enter the licensed professional’s street address.

Address 3 Any additional address information.

Bond # If the licensed professional holds a bond, enter the bond number.

Business License # Enter the official number that identifies the business license issued to the professional
by a local agency or a jurisdiction, such as a city. A licensed professional can have the
same license number for multiple license types, such as an Electrical, Mechanical, or
Plumbing license.

Business License
Expiration Date

Enter the date when the business license is due to expire, or use the Date button to
find the date on a calendar.

Business Name Enter the name of the business associated with the business license.

City Enter the city name or click Get Cityto choose the city from a standard list.

Comment Enter any comments about the business license or licensed professional.

Comp Insurance
Company Code

Enter the code associated with the Worker’s Compensation Insurance Company. For
example, Worker’s Compensation Fund (WCF). Limit to 30 characters.

Contact Name Enter the first, middle, or last name of the licensed professional. “F/M/L” stands for
First/Middle/Last.

Contractor Business
Name

Enter the contractor business name in the text field, if applicable. For example, AJ’s
Construction. Limit to 65 characters.

Contractor License
Number

Enter the contractor’s license number. Limit to 30 characters.

Email Enter the licensed professional’s email address.

Fax Enter the licensed professional’s fax number.

FEIN If applicable, enter the licensed professional’s federal Employer Identification Number.

Insurance Amount Enter the cost, in dollar amounts, of the insurance policy.
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Insurance Company Enter the name of the licensed professional's insurance carrier.

Insurance Expiration
Date

Enter the date when the insurance policy is due to expire, or use the Date button to find
the date on a calendar.

License Expiration Date Enter the date when the business license is due to expire, or use the Date button to
find the date on a calendar.

License Issue Date Enter license's issued date; you can click the Date button to locate the date on a
calendar.

License Last Renewal
Date

Enter the license's last renewal date; you can click the Date button to find the date on a
calendar.

License Number Enter the official number that identifies the business license issued to the professional
by a local agency or a jurisdiction, such as a city.

License State Choose the state that issued the professional business license.

License Type Choose the type of license the professional holds.

Licensing Board Choose the licensing board. For example, the Louisiana State Licensing Board for
Contractors.

Phone Enter the licensed professional’s phone number.

Policy # Enter the insurance policy number.

SSN Enter the licensed professional’s social security number.

State Choose a state.

State License # Enter the official number that identifies the business license issued by the state. If
the licensed professional is an owner of a licensed food facility, enter the Alt ID field
value of a record that conducts the inspection of the food facility. For more information
about food facility inspection, see “Customizing Food Facility Inspection Search” in
the Citizen Access Administrator Guide. Note: You can create a sequence definition
for this field based on licensed professional type should an applicant fail to provide a
number here. You must configure the People Number in the Sequence Mask Definition
portlet. For information on how to create a mask, see Setting Up Number Sequences
and Masks. For information on how to create a licensed professional type, see Accela
Civic Platform Configuration Reference.

Status If you want to let users search for this professional, select Enable; otherwise, select
Disable.

Type Select the licensed professional type, and the organization the licensed professional
belongs to. You can also select Individual.

Worker’s Comp Exempt Choose a value from the drop-down list. Yes indicates the licensed professional is
exempt from Worker’s Comp. No indicates they are not.

Worker’s Comp
Expiration Date

Use the picker to enter the expiration date of the Worker’s Compensation Insurance
Policy.

Worker’s Comp Policy # Enter the policy number for the Worker’s Compensation Insurance. Limit of 30
characters.

Zip Enter the ZIP code of the licensed professional.

Searching for a Licensed Professional
You can search for any licensed professional registered on your system, including professionals that you
previously disabled. For example, you might need to search for a professional to update information or to
change the status of the professional.

Note:
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To see a list of all the professionals on your system, click Submit without entering details about an individual
professional.

To search for a licensed professional

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > Licensed Professional.

3. Complete the License Type field.

4. Complete the fields specific to the license type you chose.

5. For a list of common fields, see Licensed Professional Fields.

6. Do one of the following:

• If you do not want to search using the license type specific fields, click Submit under the City field.

• If you want to search by license-type information, complete the fields at the bottom of the window
and click Submit at the bottom of the window.

Civic Platform displays the results for your search.

Editing a Licensed Professional
You can change information about individual professionals as necessary. For example, you might need to
change a professional’s status to “disabled” after the professional’s license expires. A licensed professional
can have the same license number assigned to multiple license types, such as Electrical, Mechanical, and
Plumbing licenses. To duplicate a license number for a new professional license type, you must add a new
licensed professional record.

Note:

Depending on how you set up this licensed professional type, you might see additional attributes and fields
in addition to the standard attributes listed here.

To edit a professional

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > Licensed Professional.

3. Search for the professional that you want to edit. For instructions, see Searching for a Licensed
Professional.

4. Click the red dot next the professional you want to edit.

Civic Platform displays the Licensed Professional—Edit window.

5. Complete the fields as necessary. For a list of common fields, see Licensed Professional Fields.

6. Complete the fields specific to the license type you are working with.

7. Click Save.

Managing Contacts
Civic Platform divides contacts into two categories: reference contacts that serve as the reference
database, and daily contacts that users add to records. Best practice is to manage contact types by
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defining only generic reference contact types, such as Individual and Organization. Record each individual
or organization as one reference contact. Then link reference contacts to records in various roles, such
as Applicant, License Holder, etc. This enables you to easily track all the transactional and reference
information about every individual and organization.

Before users add new reference contacts or associate contacts with records, you must set a number
of Standard Choices to define the ways of managing contacts in Civic Platform, such as CONTACT
TYPE, AUTO_SYNC_PEOPLE, and INDIVIDUAL_CONTACT_MATCH_ CRITERIA. For instructions on
configuring the Standard Choices, refer to the Accela Civic Platform Configuration Reference.

Users often look up existing reference contacts to associate the desired one with a record. You can specify
contact identity fields to guarantee the uniqueness of each reference contact, and specify contact address
identity fields to guarantee the uniqueness of each contact address in each contact.

By default, users have full access to all contact types from within all modules and the reference Contact
portlet. If a contact type is available for a few modules, then you can limit the use of the contact type by
module through specifying the applicable module in the Contact Type Setting portlet. For more information,
see Setting Up Security Policies.

Topics

• Managing Contact Identifier Settings

• Adding a Contact

• Searching for a Contact

• Editing a Contact

• Enabling Close-Match Searches

Managing Contact Identifier Settings
Topics

• Managing Contact Address Identifier Fields

• Managing Reference Contact Identifier Fields

Managing Contact Address Identifier Fields
You can configure one or more contact address identifier fields. Civic Platform checks whether a contact
address is a duplicate of an existing active contact address in the same contact by comparing their
identifier field values (joined by AND), and prevents users from saving duplicate contact addresses.

By default, there are no contact address identifier fields in Civic Platform. After you add several contact
address identifier fields, Civic Platform executes the duplicate contact address checking in the following
ways.

• When users add or update a duplicate contact address to a contact, an error message displays
indicating the conflict.

• When you sync a record contact with a reference contact, if an address in the record contact duplicates
with an address in the reference contact, the address in the reference contact replaces the contact
address.

• When users add new contact addresses to replace old addresses, if the new address duplicates
with an active one in the same contact, Civic Platform uses the existing active contact address as a
replacement
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• In previous versions, users were able to create duplicate contact addresses. Civic Platform
automatically filters duplicate contact addresses when users look up and select contact addresses to
add in records.

To manage the contact address identifier fields

1. Access the Identity Settings portlet (Accessing the Contact Identity Settings Portlet).

Civic Platform displays the Identity Settings portlet.

2. Expand the Identity Settings node in the navigation tree, and then click Contact Address.

The Identity Settings portlet displays the list of contact address fields that you previously set as identifier
fields.

All the contact address identifier fields, joined by AND, work as one identifier in duplicate contact
address checks.

3. To modify the selection of identifier fields

a. Click the field selector next to the Address Fields for Duplicate Check label.

Civic Platform displays the list of contact address fields that you can set as identifier fields. The
available field options include all the contact address fields, except for Status, Primary, Validate, and
Contact Address ID.
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b. Select the fields you want to set as identifiers.

c. Click the Close button.

Civic Platform updates the contact address identifier fields according to your latest selection.

To clear the selection of identifier fields

a. Click the recycle bin icon next to the field selector.

Civic Platform clears the current selection of identifier fields.

4. Click the Save button to save the changes.

Managing Reference Contact Identifier Fields
You can choose to define a number of contact fields as reference contact identifier fields. Table 32:
Possible Reference Contact Identifier Fields lists your options. Civic Platform checks whether a reference
contact is a duplicate of an existing active contact by comparing their identifier field values and thus
prevents users from saving duplicate contacts. To set the comparison rule with the identifiers, Civic
Platform joins by OR the contact fields that you add separately as identifiers, and joins by AND the fields
that you combine and add as one identifier.

By default, there are no contact identifier fields in Civic Platform. After you add several contact identifier
fields, Civic Platform executes the duplicate reference contact checking in the following way.

• When users add or update a reference contact that has duplicate identifier field value with an existing
reference contact, an error message displays indicating the conflict.

To manage the contact identifier fields

1. Access the Identity Settings portlet (Accessing the Contact Identity Settings Portlet).

Civic Platform displays the Identity Settings portlet.

2. Expand the Identity Settings node in the navigation tree, and then click Reference Contact.

The Identity Settings portlet displays the list of identifier fields.

3. To add an identifier field, click Look Up to add a contact field from Table 32: Possible Reference
Contact Identifier Fields.

Civic Platform displays the list of fields you can add as identifier fields.
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4. Select the field, and then click Select. If you want two or more fields to work as one identifier (joined by
AND), select several fields, and then click Select & Combine.

Civic Platform adds the selected fields as identifiers. If a user attempts to add a reference contact that
contains an email address that exists in another contact record, Civic Platform prevents the user from
saving the duplicate contact and displays the following notification.

5. To remove an identifier field, select the identifier field and click Delete.

Civic Platform no longer regards the field as an identifier field.

Table 32: Possible Reference Contact Identifier Fields

Identifier Field Description

Email The email address of the contact.

FEIN This acronym stands for Federal Employer Identification Number and identifies
a business for tax purposes. This field is only active when the Contact Type
selected is Organization.

Driver’s License Number The driver’s license number of the contact.

Driver’s License State The driver’s license state of the contact.

Passport Number The contact’s passport number.

SSN The contact’s Social Security Number.

This field is only active when the Contact Type selected is Individual.

State ID Number The contact’s state ID number.
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Adding a Contact
To enable users to search for a contact, you must add the contact to your reference database. Your
reference database acts like a library that lets users search for certain types of stored information. For
example, users might need to search for an existing contact when creating a new application.

Note:

Depending on how you set up this contact type, you might see additional attributes and fields. You can add
or edit attributes using the people template.

To add a contact

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > Contact.

3. Click Add.

4. Use the Contact Type drop-down list to choose the appropriate contact type.

Civic Platform displays fields specific to the contact type you chose.

5. Complete the fields as described in Table 33: Contact Fields.

6. Click Save.

Table 33: Contact Fields

Address Enter up to three lines of the contact’s address information.

City Enter the city name or click the Get City button to choose from a standard list of cities.

Comment Enter any comments regarding the contact.

Contact Relationship Choose the appropriate relationship between the contact and the application.

Contact Type Choose the appropriate contact type.

Country Enter the country.

Email Enter the contact’s email address.

Fax Enter the contact’s fax number.

FEIN Federal Employer Identification Number (FEIN) associated with the contact. You can
leverage this field when performing searches for a record or eliminating duplicate
contact entries in your database.

Flag Enter the status of the hold.

For example, if the hold is still active, enter “Y” for Yes.

Hold Code If your agency places holds on certain contacts, enter the code that identifies the hold
here. For example, if a contact has bad credit, enter “Bad Credit.”

Hold Description If you enter a hold code, enter a description to help identify the code. For example,
enter “Contact has repeatedly failed to pay bills.”

ID Enter any other form of ID to help you identify the contact. For example, enter a driver
license number of a social security number.

Name Enter the First, Middle, or Last name of the contact.

Organization Name Enter the name of the organization to which the contact belongs.

Phone Enter one or two phone numbers of the contact.



 | Part 2: Setting Up Agencies, Organizations, and People | 182

SSN Contact Social Security Number. After saving, the number only displays the last 4
digits. For example ***-**-1234. You can leverage this field when performing searches
for a record or eliminating duplicate contact entries in your database.

State Choose the state.

Status If you want to let users search for this contact, select Enable; otherwise, select
Disable.

Title Enter the contact’s title. A title indicates an official position or professional/academic
qualification. For example: Mr., Mrs., Ms., Officer, RN, PhD, DDS, Professor, Judge, or
Notary. The Title field is a text field.

Zip Enter the contact’s ZIP code.

Searching for a Contact
You can search for any contact on your system, including contacts that you previously disabled. For
example, you might need to search for a contact to update information or to change the status of the
contact.

Note:

To see a list of all the contacts on your system, click Submit without entering details about an individual
contact.

To search for a contact

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > Contact.

3. Complete the fields as described in Table 33: Contact Fields.

4. Do one of the following:

• If you do not want to search using the contact type specific fields, click Submit under the City field.

• If you want to search by contact-type information, enter the information in the fields at the bottom of
the window and Click Submit.

Civic Platform displays the results of your search.

Editing a Contact
After you add a contact to your reference database, you might need to change certain information about
the contact.

Note:

Depending on how you set up this contact type, you might see additional attributes or fields in addition to the
standard attributes listed here.

To edit a contact

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose People > Contact.

3. Search for the contact that you want.

4. Complete the fields as described in Table 33: Contact Fields.
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5. Click Save.

Enabling Close-Match Searches
Configure contact match criteria to enable close-match searching in Civic Platform, Citizen Access, and
Mobile Office.

Close-match searching enables users to locate reference contacts that do not exactly match their search
criteria, but come close. The standard search function returns reference contacts that exactly match user’s
search criteria. In some cases, users might find that the search results do not include the contacts they
intend to find, for example, if the user mistypes the criteria. In that case, users can click the Close Matches
button to locate reference contacts that do not exactly match their search criteria, but come close.

To enable close-match searching, configure the following standard choices in the Standard Choices portlet
in the Setup Admin:

• ENABLE_CONTACT_ADDRESS

• INDIVIDUAL_CONTACT_MATCH_CRITERIA

• ORGANIZATION_CONTACT_MATCH_CRITERIA

See the Civic Platform Configuration Reference for more information about Standard Choices.

Creating a Public User Account
Topics

• Adding a New Public User Account

• Using a Reference Professional to Create a Public User

Adding a New Public User Account
To create a registered public user account

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Click New.

Civic Platform displays a blank registration template in the detail portlet.

3. Complete the registration fields. For a description for each field, see Table 34: Public User Registration
Fields.

4. Click Submit.

Citizen Access displays the new registration information in the Public User list portlet.

5. Associate the public user with a reference contact (Managing Contacts Associated with Public User
Accounts). If a public user does not have an association with a reference contact, the account remains
disabled in the registered agency.

Table 34: Public User Registration Fields

Civic Platform User Account This field displays the Civic Platform user login ID in read-only. When a
public user registers an account from Citizen Access or when you create an
account from the Public User portlet, Civic Platform automatically creates the
corresponding Civic Platform user account with the login ID numbered like
PUBLICUSER{seq_number}. Civic Platform automatically does the following in
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user profiles for such user accounts:Marks the user as External UserSets the
department to <agency>/<agency>/<agency>/PUBLIC/NA/NA/NA.Categorizes
the user into the default user group for public users in each module. Within each
assigned module, the external inspector is available for inspection assignments
and scheduling. Sets the inspector status to “Enable”, if the user account is for a
contract inspector or a self-certified inspector.

For the Civic Platform user accounts of contract inspectors and self-certified
inspectors, your agency can update the user profiles manually or using an
EMSE script.

For example, use an EMSE script either with the AddContractLicenseAfter or
RegistrationSubmitAfter event to set the district that the inspector is responsible
for, set the discipline based on the inspector’s license, and so forth.

The AddContractLicenseAfter event occurs after you associate a licensed
professional with the public user account of an external inspector through the
Public User portlet and the association takes affect. The RegistrationSubmitAfter
event occurs after a public user submits a registration and also occurs after
the external inspector associates a licensed professional with his public user
account through Citizen Access.

For more information about the Civic Platform user account, see Configuring
Organizations, Departments, and Users.

Account Type There are five account types of public users.

Citizen: Citizens are common public users in your agency. Citizen users access
Citizen Access to apply for and pay for permits, schedule inspections, and find
information. Citizen is the default in this field.

Authorized Agent: Authorized agents conduct authorized service sales (for
example, fishing and hunting license sales) in Citizen Access.

Authorized Agent Clerk: When authorized agents manage their accounts in
Citizen Access, they can authorize clerks to conduct authorized service sales.
You can view, but cannot create authorized agent clerks in the Public User
portlet.

Self-Certified Inspector: Self-certified inspectors upload inspection results
using Citizen Access. Self-certified inspectors are certified or licensed
professionals so you must associate at least one licensed professional to the
public user account from the Public User portlet. You can also let self-certified
inspectors themselves associate licensed professionals with their public user
accounts through Citizen Access. For details, see “Understanding Inspectors” in
the the Accela Civic Platform Concepts Guide.

Contract Inspector: Contract inspectors upload inspection results using
Citizen Access. Contract inspectors are certified or licensed professionals or
businesses so you must associate at least one licensed professional to the
public user account from the Public User portlet. You can also let contract
inspectors themselves associate licensed professionals with their public user
accounts through Citizen Access. For details, see “Understanding Inspectors”
the Accela Civic Platform Concepts Guide.

Cell Phone The public user’s cellular phone number.

Change Password at Login Select Yes to ask the public user to change password at the first time login.
Otherwise, select No.

Email The public user’s email address. By default, this is the User ID. You can modify
both the User ID and the email address separately.

Password The public user’s password used when logging in to Citizen Access.



 | Part 2: Setting Up Agencies, Organizations, and People | 185

Note: If your agency has configured password rules for the public users, then
there is a password requirements link and a strength indicator. The password
strength indicator displays a visual representation of the password security
strength against the agency's minimum password requirements.

If you have trouble entering a valid password, click the Requirements link to
view the agency’s minimum password requirements.

Confirm Password A second entry to verify the user’s password.

Password Request Answer Enter the answer to the password request question. The field maps to the
Answer field on the registration page in Citizen Access.

Password Request Question Enter one or more password request questions. The field maps to the Enter
Security Question field on the registration page in Citizen Access. The
Authentication by Security Question setting in Citizen Access Admin determines
the number of password request questions to display in this field.

If an account has password request questions and answers and the public user
forgets their password, Citizen Access requires the user to answer one of the
questions to validate the user.

If an account has no password request question, Citizen Access only requires
the user to specify the email address in the reset-password request.

Password Request Questions may be a non-required field in Civic Platform.
However, if a user logs in to Citizen Access with an account that has no
password request question, an Update Security Question and Answer section
displays for the user to specify one or more security questions and answers.

Receive SMS Message Mark or clear the check box to enable or disable SMS messaging for the public
users. This feature applies to agencies that implement custom SMS interfaces.

User ID The user identification for logging in to Citizen Access. The default User ID is
the email address provided in registration. You can modify this field to create a
unique User ID.

Using a Reference Professional to Create a Public User
You can configure the EMSE sample script REFLICPROFADDAFTER to create a public user account to
associate with a licensed professional a user enters at application-intake. The reference professional must
have an email address associated with it, for this feature to work. After the intake process, EMSE initiates
the public user account registration process for the referenced professional associated with the email
address. Civic Platform sends an activation email. When you activate the account, Civic Platform sends the
registration confirmation email to the professional. For information on the public user registration process,
including the configurations for the activation email, refer to the “Registration” chapter in the Citizen Access
Administrator Guide.

Note:

An Accela Implementation specialist or a system administrator who has received training from an Accela
Implementation specialist or a Product Manager should write the script for this feature. Improperly written
scripts can seriously damage your system by incorrectly altering or deleting data for many records. For
information on writing and implementing scripts, see the Accela Civic Platform Scripting Guide.

Searching for a Public User Account
To search for a public user account

1. Access the Public User portlet (Accessing the Public User Portlet).
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2. Click Search.

Civic Platform displays a search form.

3. Enter any search criteria in the appropriate fields.

You can search by public user registration fields, and a few contact standard fields. Civic Platform
searches for the public users that meet the specified registration criteria, and who have associations
with a contact that meets the specified contact criteria. For a description of the fields, see Table 35:
Fields for Searching Public User Accounts.

4. Click Submit.

Civic Platform displays the list of public users that match your search criteria.

Table 35: Fields for Searching Public User Accounts

Account Type There are five account types of public users.Citizen: Citizens are common public
users in your agency. Citizen users access Citizen Access to apply for and pay for
permits, schedule inspections, and to find information. Citizen is the default in this field.
Authorized Agent: Authorized agents conduct authorized service sales (for example,
fishing and hunting license sales) in Citizen Access. Authorized Agent Clerk: When
authorized agents manage their accounts in Citizen Access, they can authorize clerks
to conduct authorized service sales. You can view, but cannot create authorized agent
clerks in the Public User portlet.Self-Certified Inspector: Self-certified inspectors
upload inspection results using Citizen Access. Self-certified inspectors are certified
or licensed professionals so you must associate at least one licensed professional
to the public user account from the Public User portlet. You can also let self-certified
inspectors themselves associate licensed professionals with their public user accounts
through Citizen Access. For details, see “Understanding Inspectors” in the Accela
Civic Platform Concepts Guide.Contract Inspector: Contract inspectors upload
inspection results using Citizen Access. Contract inspectors are certified or licensed
professionals or businesses so you must associate at least one licensed professional
to the public user account from the Public User portlet. You can also let contract
inspectors themselves associate licensed professionals with their public user accounts
through Citizen Access. For details, see “Understanding Inspectors” in the Accela Civic
Platform Concepts Guide.

Address Line 2 The address information of the contact that has an association with the public user.
You can have up to three lines of address information.

Authorized Agent If you select “Authorized Agent Clerk” option in the Account Type field, you can specify
the name of the authorized agent who created the authorized agent clerks.

Civic Platform supports fuzzy string searching on the field.

Birth Date The birth date of the contact associated with the public user.

Change Password at
Login

Select Yes to ask the public user to change password at the first time login. Otherwise,
select No.

City The city of the contact associated with the public user.

Confirm Password The public user’s password. A password confirmation/verification.

Country/Region The country or region of the contact associated with the public user.

DBA/Trade Name The DBA or trade name of the contact associated with the public user. DBA is an
acronym for Doing Business As.

FEIN The FEIN information of the contact associated with the public user. FEIN is an
acronym for Federal Employer Identification Number; it identifies a business for tax
purposes.

First Name The first name of the contact associated with the public user.

Gender The gender of the contact associated with the public user.

Last Name The last name of the contact associated with the public user.

Middle Name The middle name of the contact associated with the public user.
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Organization Name The organization name of the contact associated with the public user.

P.O.Box The post office box number of the contact associated with the public user.

Password The public user’s password used when logging in to Citizen Access.

Note:

If your agency has configured password rules for the public users, then there
is a password strength indicator and a requirements link. The password
strength indicator displays a visual representation of the password security
strength against the agency's minimum password requirements.

If you experience trouble entering a valid password, click the Requirements link to view
the agency’s minimum password requirements.

Password request
answer

The answer to the password request question.

Password request
question

Choose a password request question from the drop-down list. If a public user forgets
their password, they can answer this question. If the answer is correct, Civic Platform
emails their password to the email provided from registration.

Phone 3 The phone of the contact associated with the public user.

Preferred Channel The method by which the contact associated with the public user, prefers to receive
notifications, for example by phone, email, fax, or postal mail.

Public User’s Cell Phone The public user’s cellular phone number.

Public User’s Email The public user’s email address. By default, this is the User ID. You can modify both
the User ID and the email address separately.

Receive SMS Message Click this option to enable or disable SMS messaging for the public users. This feature
applies to agencies that implement custom SMS interfaces.

Salutation The salutation to address the public user or the contact associated with the public user,
for example Mr. or Ms.

SSN The SSN of the contact associated with the public user.

State The state of the contact associated with the public user.

Street Address The street address of the contact.

Telephone The telephone of the contact associated with the public user.

Type The contact type of the contact associated with the public user.

User ID The user identification for logging in to Citizen Access. The default User ID is the email
address provided in registration. You can modify this field to create a unique User ID.

Zip Code The ZIP code of the contact associated with the public user.

Managing Accounts for Registered Agencies
To register a public user in an agency, you must associate at least one enabled reference contact in the
settagency with the public user account, and then enable and activate the public user account for the
agency.

Topics

• Managing Contacts Associated with Public User Accounts

• Enabling or Disabling an Account

• Activating a Public User Account
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Managing Contacts Associated with Public User Accounts
Follow the instructions below to manage the associations between public user accounts and contacts. You
can associate a contact with a public user; approve, reject, or remove the association; or set a contact as
the account owner of a public user.

Topics

• Associating Contacts with a Public User Account

• Setting an Associated Contact as the Account Owner

Associating Contacts with a Public User Account
To associate contacts with a public user account

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Select the user account you want to edit.

Civic Platform displays the public user account registration details.

3. Click the Contact tab.

Civic Platform displays the Contact list portlet.

4. Do any of the following:

• To search and associate a contact with a public user account.

1. Click Look Up.

Civic Platform displays the contact search form.

2. Enter your search criteria and then click Submit.

Civic Platform displays a list of reference contacts meeting the search criteria.

3. If you cannot find the contact in the results list, click Close Matches to view the close matches to
the search criteria, and select the contact from the close match contacts.

The Standard Choices INDIVIDUAL_CONTACT_MATCH_CRITERIA and
ORGANIZATION_CONTACT_MATCH_CRITERIA define the close match criteria respectively
for individual contacts and reference contacts. See the Accela Civic Platform Configuration
Reference for more information about Standard Choices.

4. Select the contact that you want to associate with the public user.

5. Click Connect.

Civic Platform links the contact with the public user account.

For contacts directly added in the public user portlet, Civic Platform approves the association by
default.

• To approve the association between a contact and the public user account.

1. Select the contact.

2. Click Approve.

• To reject the association between a contact and the public user account.

1. Select the contact that you do not want to approve the association.

2. Click Reject.
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Civic Platform rejects the association.

Note:

A public user account must have at least one approved contact association to stay enabled, so
you cannot reject an association if it is the only one with the approved status in an enabled public
user account.

• To delete the association between a contact and the public user account.

1. Select the contact that you want to remove.

2. Click Delete.

Civic Platform deletes the contact from the public user account.

Setting an Associated Contact as the Account Owner
A public user may be associated with more than one contact, but only one contact can be the account
owner of the public user. Public users can designate or change the account owner in their accounts on the
Account Management page in Citizen Access. You can also designate or change the account owner of a
public user account following the instruction in this section.

Note:

If your agency enables the Automatically Activate New Association feature in Citizen Access, the first
contact added to an account is the account owner of the account by default. If an account is created in a
version earlier than 7.3 FP2 or with the Automatically Activate New Association feature disabled, there is no
default account owner in the account.

When you add variables (for example, $$firstName$$, $$middleName$$, $$lastName$$) about the public
user contact information in notification templates, Civic Platform uses the following priority order to decide
from which contact, out of all the contacts that have approved association with the public user, to get the
variable values:

• Priority one, the account owner of the public user

• Priority two, the first individual contact that has the same email address as the account

• Priority three, the first organization contact that has the same email address as the account

• Priority four, the first individual contact that has approved association with the account

• Priority five, the first organization contact that has approved association with the account

For more information about how to create notification templates, seeWorking with Communication Manager
.

To change the account owner of a public user

1. Access the Public User portlet (Accessing the Public User Portlet), and select the user account you
want to edit.

Civic Platform displays the public user account registration details.

2. Click the Contact tab.

Civic Platform displays the Contact list portlet.

3. Select an approved contact which you want to set as the account owner of the public user.

4. Click Set as account owner.
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Civic Platform changes the account owner of the public user to be the current contact.

Enabling or Disabling an Account
To enable or disable a public user account

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Click the user account which requires a change of status.

Civic Platform displays the public user account registration details in the detail portlet.

3. Click the Registered Agencies record tab.

4. Select the Agency that requires a change status.

Note:

If you have enabled the multiple agency administration feature (see Setting Up Cross-Agency
Operations), after a public user attempts to log in to Citizen Access hosted by a different agency from the
one that created the account, you can enable and activate the public user account in the new agency.

If you enable an authorized agency or authorized agent clerk account in a different agency from the one
that created the account, the account type is Citizen, not Authorized Agent nor Authorized Agent Clerk, in
the new agency.

5. Click one of the following buttons to change the status of an account.

Disable Account. Click this button to disable the public user for the agency. Disable, in this context,
means that the public user is not able to log in to Citizen Access.

Note:

If you disable an authorized agent account, the authorized agent account becomes inactive, and all the
authorized agent clerk accounts created by the agent account become inactive as well.
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Enable Account. Click this button to enable the public user to use the account for the agency.

Civic Platform displays a message indicating a status change.

Activating a Public User Account
Topics

• Activating the Public User Account

• Using EMSE to Activate a Public User

Activating the Public User Account
If your agency does not use the activation email, your agency can activate an account manually for a user
in the Public User portlet. For example, if an account requires additional information before the agency
allows activation, you can manually activate their account for public users after the additional information
arrives at the agency in the Public User portlet.

To activate a public user account

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Click the user account which requires activation.

Civic Platform displays the public user account registration details in the detail portlet.

3. Click the Registered Agencies record tab.

4. Select the Agency that requires activation for this account.

5. Click Activate Account.

Civic Platform displays the account is active and the user has permission to log in to Citizen Access for
that agency.
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Using EMSE to Activate a Public User
Your agency can activate a public user account using an EMSE script. The script works with the
ApplicationSubmitAfter event to activate the public user in the agency, activate licenses for the public user,
and send out the activation email to the user. For example, an applicant comes to the counter to apply for a
license. While submitting the application users receive the option of creating an Citizen Access account so
that they can track progress. The counter clerk selects the option “Create online account.” EMSE creates
the online account and email the link, login, and password to the applicant.

For more information on EMSE scripts, see the Accela Civic Platform Scripting Guide.

To activate a public user account through EMSE scripting

1. Refer to the sample EMSE script below to activate a public user account, activate any licenses
associated with the account, and send the activation emails to the public user.

//Get the Service Provide Code.

var servProvCode = Accela Automation.env.getValue(“servProvCode”);

//Get the Universally Unique Identifier for public user verification.

var uuid= Accela Automation.env.getValue(“UUID”);

//Activate Public User by servProvCode and uuid.

var result = Accela
 Automation.publicUser.activatePublicUser(servProvCode,uuid);

if(result.getSuccess())

{

    //If Activate Public User Successefully, then print the User ID.

Accela Automation.print(result.getOutput());

}

else

{

    //If Activate fail, then print the error message.

Accela Automation.print(result.getErrorMessage());

}

Editing a Public User Account
You can make edits to a public user account if it requires modification. For example, if a user wants to
reset their password or change their user ID, you can update their user account registration information
with the specified request.

To edit a registered public user account
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1. Access the Public User portlet (Accessing the Public User Portlet).

2. Click the user account that you want to edit from the PublicUser list portlet.

Civic Platform displays the public user account registration details in the detail portlet.

3. Enter the modifications in the applicable fields. For a description of each field, see Table 34: Public
User Registration Fields.

4. Click Submit.

5. Click Registered Agencies record tab.

6. Click the appropriate button from the toolbar to reflect the desired status for the account. For more
information about account status, see Changing a Public User Password.

Associating Addresses, Parcels, and Owners with Public User Accounts
Public users can create public user accounts when they register to access Citizen Access. Administrators
can then link the public user account to addresses, parcels, and owners, exposing features as appropriate.
This linked relationship is particularly useful when the public user initiates an application in Citizen Access.
He or she can use the Auto-Fill drop-down list to populate the address details into the application intake
form with one click.

Associating an Address with an Account
After you have created address records, you can use the Associated Public User tab to associate one or
more public users to an address, or to disassociate one or more public users from an address.

Public users can create public user accounts when they register to access Citizen Access. Administrators
can then link the public user account to addresses, exposing features as appropriate. This linked
relationship is particularly useful when the public user initiates an application in Citizen Access. He or she
can use the Auto-Fill drop-down list to populate the address details into the application intake form with one
click.

To associate an address with a public user account

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Select the user account to which you want to edit.

Civic Platform displays the public user account registration details.

3. Click the Address tab.

Civic Platform displays the Address list portlet.

4. Click Look Up.

Civic Platform displays the Address search form.
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5. Enter your search criteria and then click Submit.

Civic Platform displays a list of addresses meeting the search criteria.

6. Select the address to which you want to associate the public user.

7. Click Connect.

Civic Platform links the address with the public user account.

8. Do any of the following:

• To view address details, click the link for the address that you want to view.

• To remove the link between an address and a public user, select the address you want to remove
and click Delete.

Associating a Parcel with an Account
After you have created parcel records, you can use the Associated Public User tab to associate one or
more public users to a parcel, or to disassociate one or more public users from a parcel.

Public users can create a public user account when they register with an agency through Citizen Access.
Administrators can then link the public user account to parcels, exposing features as appropriate. This
linked relationship is particularly useful when the public user initiates an application in Citizen Access. He
or she can use the Auto-Fill drop-down list to populate the parcel details into the application intake form
with one click.

To associate a parcel with a public user account

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Select the user account to which you want to edit.

Civic Platform displays the public user account registration details.

3. Click the Parcel tab.

Civic Platform displays the Parcel list portlet.

4. Click Look Up.

Civic Platform displays the Parcel search form.

5. Enter your search criteria and then click Submit.

Civic Platform displays a list of parcels meeting the search criteria.

6. Select the parcel to which you want to associate the public user.

7. Click Connect.

Civic Platform links the parcel with the public user account.
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8. Do any of the following:

• To view parcel details, click the link for the parcel that you want to view.

• To remove the link between a parcel and a public user, select the parcel you want to remove and
click Delete.

Associating an Owner with an Account
For more information about Owners, refer to “Managing Owners” in the Accela Civic Platform User Guide.

For more information, refer to “User Role Definitions” in the “Module Settings” section of the Citizen Access
Administrator Guide.

To associate an owner with a public user account

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Select the user account to which you want to edit.

Civic Platform displays the public user account registration details.

3. Click the Owner record tab.

Civic Platform displays the owner list portlet.

4. Click Look Up.

Civic Platform displays the owner search form.

5. Enter your search criteria and then click Submit.

Civic Platform displays a list of Owners meeting the search criteria.

6. Select the owner to which you want to associate the publicuser.

7. Click Connect.

Civic Platform links the Owner with the publicuser account.

8. Do any of the following:

• To view owner details, click the link for the owner that you want to view.

• To remove the link between an owner and a public user, select the owner you want to remove and
click Delete.
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Changing a Public User Password
When users request that you reset their password in person or by phone, ask them their security question
and verify the user’s identity. Then, send the user the password email which contains the new Civic
Platform generated password. The user’s email address must be current for this to work properly.

If you want to customize the text of the email associated with changing the user password, refer to “Email
Settings” in the “Creating Records” section of the Citizen Access Administrator Guide.

To reset a user password

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Select the user which requires a resetting of their password.

Civic Platform displays user information in the Public User detail portlet.

3. Click Send Password to reset the password.

Civic Platform displays a message indicating that it sent an email to the user with new password
information.

Managing Licenses Associated with Public User Accounts
This feature requires you to customize the content of the renewal and new license emails in Citizen Access
Admin on the General Settings page. For more information about customizing the content of the emails,
see “Email Settings” in the Citizen Access Administrator Guide.

After you configure the emails, the agency can receive email notification that a license requires approval.
Follow the instructions below to approve or reject a license for an account.

To manage licenses associated with a public user account

1. Access the Public User portlet (Accessing the Public User Portlet).

2. Choose the Account which requires the license approval.

3. Click the License tab.

Civic Platform displays a list of Licenses that are pending, approved or rejected for the account.
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4. Do any of the following:

• Add a license to a public user account.

1. Click New.

2. Select a license type, enter a license number, and then click Submit.

Civic Platform adds the license to the public user account.

• Search and associate a license with a public user account.

1. Click Look Up.

Civic Platform displays the license search form.

2. Enter your search criteria and then click Submit.

Civic Platform displays a list of licenses meeting the search criteria.

3. Select the license to which you want to associate the public user.

4. Click Connect.

Civic Platform links the license with the public user account.

• Approve a license.

1. Select the licenses that require approval.

2. Click Approve.
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• Reject a license.

1. Select the licenses that do not meet license requirements.

2. Click Reject.

Civic Platform sends a confirmation email to the account.

Setting Up Cross-Agency Operations
If you manage multiple agencies you must set up the participating agencies individually first. We
recommend that you work with the Accela Services team to formulate and incorporate best practices in the
planning and establishment of the agencies.

For more information, see the “Agencies and Functions” chapter in the Civic Platform On-premise
Administrator Supplement.

Click a topic title below for full details.

Related Links

Enabling Multiple Agency Administration

Sharing Information Across Agencies

Delegate User Management

Multi-Agency Service Management

Configuring Record Creation

Enabling Multiple Agency Administration
You can enable multiple agency administrations by setting up the agencies in a common database.

When you have multiple agencies that work together, Civic Platform offers a way to brand each agency so
that users can easily recognize the source agency of information. You do this by associating an image or
logo with an ASI Subgroup in the Logo portlets of Civic Platform.

Sharing Information Across Agencies
Civic Platform provides a way for multiple agencies to share address, parcel, owner, licensed professional,
and contact information. When you consolidate APO, licensed professional information, and contact
information, it allows users to perform searches or update information across agencies. Consolidating
information also limits duplicate information in various agency databases. For complete information
about how to consolidate licensed professionals, see Synchronizing Licensed Professional Data between
Agencies.

Topics

• Sharing Addresses, Parcels, and Owners (APO)

• Sharing Contacts

Sharing Addresses, Parcels, and Owners (APO)
To enable normal agency users to search and edit the information from other agencies without toggling
between agencies, you must configure the agency option “APO Source Number” to an identical value for
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each agency that is sharing information. For instructions, see To configure the agency option “APO Source
Number” for information sharing.

For more information on configuring the agency options, see the “Agencies and Functions” chapter in the
Civic Platform On-premise Administrator Supplement.

If the APO Source Number differs in the super-agency and sub-agency, a super-agency user can still
search for and edit the sub-agency information, provided the sub-agency administrator creates a delegate
user for the super-agency user.

For delegate users management, see Delegate User Management.

To configure the agency option “APO Source Number” for information sharing

1. Access the Classic Administration page. (Accessing Classic Administration.)

2. Choose Agency Profile > Agency.

Civic Platform displays the Agency—Search page.

3. Enter the Agency Code of the agency for which you want to share the reference information with other
agencies.

4. Click Submit.

Civic Platform displays the Agency-Browse page.

5. Click the red dot next to the agency you want to work with.

Civic Platform displays the Agency-Edit page and existing Agency Properties.
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6. Set the APO Source Number to be the same as the other agency that you want to share information
with. If you do not want an agency not to share the information this way, assign a unique APO Source
Number value to it.

7. Repeat Steps 2 through 5 for each agency that you want to share information.

Sharing Contacts
In a multiple-agency environment, you can share contacts across agencies. When an agency user adds
or updates a contact from the main agency or the sub-agency, Civic Platform can synchronize contact
information across all agencies in the multiple-agency environment. The shared contact information
includes basic contact information, contact template data, contact addresses, contact aliases, contact
relationships, and contact association with public users.

You must associate contact templates with contact types. If agencies associate different contact templates
for the same contact type, only the template fields with the same field labels synchronize between the
agencies. For example, Main Agency, Sub-Agency 1, and Sub-Agency 2 have defined the template fields
for the contact type “Applicant” as shown in the Table 36: Example Contact Templates. When you add an
applicant from Main Agency, the applicant’s information including the template fields is available in both
sub-agencies. However, Sub-Agency 2 does not display the applicant’s ethnicity. Similarly, when you add
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an applicant from Sub-Agency 2, the applicant is available in both Main Agency and Sub-Agency 1 but
those two agencies do not have the applicant’s ethnicity information.

Table 36: Example Contact Templates

Main Agency Sub-Agency 1 Sub-Agency 2

Gender Gender Gender

Language Language Language

Ethnicity Ethnicity

The sharing contacts feature requires Standard Choice configuration. Each agency must configure the
Standard Choice CONTACT_ACROSS_AGENCIES in the same way to specify which agencies share
contacts. For complete information on how to configure a Standard Choice, refer to the Accela Civic
Platform Configuration Reference.

Delegate User Management
For instructions on how to create a delegate user specific to an Citizen Access public user group, so that
they have permissions to create records for multiple agencies, see Creating a Delegate Account for a
Public User Group.

Topics

• Creating a Delegate User

• Creating a Delegate Account for a Public User Group

• Enabling Delegate User Agency Access

• Searching and Editing Delegate User Information

• Viewing Delegate User History

• Toggling between Agency Locations

Creating a Delegate User
Civic Platform uses delegate user accounts, for users external to a particular agency, to enable user to
access information across multiple agencies. The external user, for which you set up a delegate user
account, can access agency data (as a delegate) and super-agency data, for which they have a regular
user account. You can relate the delegate user account to only one external agency user.

Example Use Case

The State of Oregon functions as a super agency for the Marion County agency, the city of Portland
agency, and the city of Sandy agency. Betty Greenwood, an Oregon user, needs to access Marion County
and Portland information, but not Sandy information. Marion County and Portland administrators each
create a regular user account for Betty Greenwood, using Betty’s unique user ID from Oregon, and
designate this user account as a delegate user account for their agency.

from Civic Platform, Betty can now toggle between the Oregon, Marion County, and Portland agencies, but
not the Sandy agency, to work with information owned by those agencies. The Marion County and Portland
administrators can change or revoke Betty’s access at any time; Civic Platform tracks changes to Betty’s
delegate user account.

To create a delegate user

1. Create a user account at your agency, designated for an external agency user, and then configure the
permissions.
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a. Access the Classic Administration page. Accessing Classic Administration

b. Navigate to User Profile > User.

c. Click Add and complete the user fields. Refer to Adding a User.

d. In the User Group/Privilege section, select each module that you want the user to be able to access.

e. Assign which user group the external user belongs to for each module.

f. Click Save.

2. Define the Delegate user account. This account links the agency account with the external agency user
account.

a. Access the Delegate User portlet.

b. Click New.

Civic Platform displays the New Delegate User portlet.

c. Complete the fields as described in Delegate User Fields.

d. Click Save.

Table 37: Delegate User Fields

Allow Delegate User
Login

Select this option if you want to allow delegate users to log in to your agency.

Delegate User ID The delegate user’s User ID that your agency created. Click the picker icon to
search and select the User ID. Refer to .

Super Agency Select the delegate user’s primary agency location.

Parent User ID Enter the delegate user’s User ID at the primary agency. Click the picker icon to
search and select this information.

Status Select the user’s status. Select Enable to activate or Disable to deactivate the
delegate user account.

Creating a Delegate Account for a Public User Group
You can enable public users of Citizen Access to view information across agencies, or request services
from multiple agencies, by creating delegate user accounts in the public user group.

Note:

Permissions do not apply to public users of Citizen Access.

To create a delegate account for a public user group

1. Create a user account at your agency designated for the public user group. You do not need to assign
permissions.

a. Access the Classic Administration page. Accessing Classic Administration

b. Navigate to User Profile > User.

c. Click Add and complete the user fields. Refer to Adding a User. You do not need to assign this user
any permissions.
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d. Click Save.

2. Define the Delegate user account. This account links the agency user account with the public user
group.

a. Access the Delegate User Portlet.

a. Click New.

Civic Platform displays the New Delegate User portlet.

b. Complete the Delegate User fields as described below:

Delegate User ID Use the picker icon to select the agency user account created for the public user
group. Refer to .

Allow Delegate User
Login

Select this option to allow public user access to multi-agency information.

Super Agency Select the agency to which you want public users to have the multi-agency
access.

Status Select the delegate user status. Select Enable to activate or Disable to deactivate
the delegate user account.

Parent User ID Click the picker icon to search and select PUBLICUSER.

c. Click Save.

Enabling Delegate User Agency Access
Your agency can allow a delegate user from another agency to access your data in Civic Platform for
viewing or performing tasks. The delegate user can perform tasks or view information in your agency only
when you establish the delegate user relationship. Enable or disable delegate user access to your agency
at any time. For information on how to set up a new delegate user, see Creating a Delegate User.

To enable a delegate user

1. Access the Delegate User portlet (Accessing the Delegate User Portlet).

2. Search and select a Delegate user. If there is no delegate user account, refer to Creating a Delegate
User.

Civic Platform displays the Delegate User detail portlet.

3. Select the option to allow the delegate user access to your system at login.

4. Click Save.

Searching and Editing Delegate User Information
You can search for and edit delegate user information at any time. For example, you can do this to
inactivate a delegate user. Civic Platform stores changes to delegate user information in the Delegate User
History portlet. Refer to Viewing Delegate User History.

If you want to change permissions for the delegate user, you must make those changes to the user
account profile you established at your agency for the external user. For example, you can change a user’s
access from full access to view only. Changing a user's access restricts a delegate user from making
changes. See Creating a Delegate User or refer to Editing a User.

To search for and edit delegate user information

1. Access the Delegate User portlet (Accessing the Delegate User Portlet).
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2. Click Search.

Civic Platform displays the delegate user search portlet.

3. Enter search criteria in one or more of the delegate user fields and then click Submit. Refer to Delegate
User Fields.

Civic Platform returns a list of delegate users that meet the search criteria.

4. Select the delegate user to which you want to modify information.

Civic Platform displays the delegate user detail in the Delegate User detail portlet.

5. Make modifications. Refer to Delegate User Fields for details regarding each delegate user field.

6. Click Submit to save changes.

Viewing Delegate User History
The delegate user history portlet provides a running history of the delegate user account. Delegate
user history includes the operation name and corresponding date. For example, it shows the date
when you created or reactivated the delegate user account. This portlet does not display changes to
user permissions or any tasks that the delegate user performed. You can search and select historical
information with the delegate user search feature.

You can search and select delegate user history in two different areas. You can select a delegate user
from the list portlet and click the Delegate User History record tab. You can also click the Search History
button located in the delegate user list portlet to search for a specific operation type, activity during a date
range, or status of delegate users.

To view delegate user history

1. Access the Delegate User portlet (Accessing the Delegate User Portlet).

2. Choose any of these options:

• View delegate user history from the Delegate User detail portlet.

1. Search and select the delegate user for which you want to view history.

2. Click the Delegate User History tab.

Civic Platform displays a list of delegate user history.

• View delegate user history from the Delegate User History search results.

1. Click Search History.

Civic Platform displays the Delegate User History Search form.

2. Enter the search criteria based on the field descriptions provided in Delegate User History Fields
and click Submit.

Civic Platform displays a list of delegate users meeting search criteria.

Table 38: Delegate User History Fields

Allow Delegate User
Login

Select this option to allow public user access to multi-agency information.

Delegate User ID Use the picker icon to select the agency user account created for the public user
group.
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Operation Date Use the drop-down list to specify the type of modification for this Delegate User.
The Operation Type field lists these types of actions or operations: Create,
Delete, or Update.

Operation Type Use the drop-down list to specify the type of modification for this Delegate User.
The Operation Type field lists these types of actions or operations: Create,
Delete, or Update.

Operator Use the picker icon to expand the list of agencies and their delegate users.

Super Agency Select the agency to which you want public users to have the multiple agency
access.

Parent User ID Click the picker icon to search and select the delegate user’s User ID at their
primary agency.

Status Select the delegate user status. Select Enable to activate or Disable to deactivate
the delegate user account.

Toggling between Agency Locations
Civic Platform provides a way for a multi-agency user to switch from one agency to another. After a user
logs into their primary agency, Civic Platform displays a drop-down list in the upper areas of the page. This
list populates with the sub-agencies where they have delegate user access.

To switch between agency locations

1. To switch between agencies in Classic Administration, use the drop-down list in the upper toolbar of
your console.

2. To switch between agencies in Civic Platform, use the drop-down list in the upper area of your page.

Multi-Agency Service Management
Manage the services offered by associating the services with a record type. You can also associate the
service with a licensed professional type. For example, a licensed commercial contractor can have access
to request plumbing or water service repairs. You can also associate an address type with a service. For
example, 123 Main Street is a commercial building and has access to roof repair, water, and plumbing
services offered by the State, county, and city. For more examples of service configurations, refer to
Services Example Configurations.

Filter which services your agency offers by using the Service Lock Condition feature. This feature provides
the option to exclude services to a particular address or licensed professional.

In order for complete feature functionality, you must consider these configuration considerations. The multi-
agency services feature also applies to Citizen Access, which means the public user group must have an
associated delegate user account to enable users to view the services offered from multiple agencies. See
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Creating a Delegate Account for a Public User Group. If you want to provide public users with the ability to
request services from multiple agencies, you must configure Civic Platform before you can create records
that accommodate multi-agency functionality. This configuration requires matching service configurations
such as Application-Specific Information Subgroups at the parent and sub-agency level. Refer to the
“Creating Records” section of the Citizen Access Administrator Guide. An administrator must configure the
sharing of information across all agencies providing services. Refer to Delegate User Management.

Topics

• Adding a New Service

• Searching and Editing a Service

• Associating License Types with a Service

• Associating an Address Type with a Service

• Incorporating the Service Lock Condition

• Synchronizing Licensed Professional Data between Agencies

Adding a New Service
You can offer services from multiple agencies to your public users through ACA. You can add any service
offered by your agency or a service from an agency to which you share information. See Delegate User
Management. You can associate each service with a record type and with a Licensed Professional or
Address Type. For examples, see Services Example Configurations. These configurations determine which
services users view when logged into ACA. A pre-configured EMSE script determines which agency to use
if multiple agencies offer the same service.

The public user group or agency user must have a delegate user account to view services. Refer to
Delegate User Management for configuration information.

To learn more about associating a licensed professional type or address type, see Associating License
Types with a Service and Associating an Address Type with a Service.

To add a new service

1. Access the Service portlet (Accessing the Service Portlet).

2. Click New.

Civic Platform displays the Service portlet.

3. Complete the fields as described in Service Field Descriptions.

4. Click Save.

5. Associate a Licensed professional as described in Associating License Types with a Service.
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6. Associate an Address Type as described in Associating an Address Type with a Service.

7. Click Save.

Table 39: Service Field Descriptions

ASI Group This field automatically populates based on the selected record type.

ASI Sub Group Use the drop-down list to select the ASI Sub Group, or leave it empty. The ASI sub
group sets the scope of the service to a specific portion of the record type. If you do not
specify the ASI sub group, the service scope is identical to that of the record type.

Record Type Click the picker icon to select the Record Type you want associated with this service.

Service Enter the name of the Service.

Table 40: Services Example Configurations

Agency Service
Name

Record
Type

ASI Group ASI Sub
Group

Associated
Licensed
Professional

Associated
Address Type
Group

Oregon Water
Heating

Plumbing Plumbing_ services - Contractor Address Type
Group 1

Oregon New Drain Plumbing Plumbing_ services New
Drain_Info

Architect Address Type
Group 1 and
Address Type
Group 2

Eugene Re-roof Structural Structural_ services Re-roof_info Contractor Address Type
Group 1

Portland Fishing Fishing Fishing_ services Fishing_info Address Type
Group 2

Searching and Editing a Service
Search for an existing service and make any updates as needed. For example, you might change the
record types associated with the service.

To search and edit a service

1. Access the Service portlet (Accessing the Service Portlet).

2. Click Search.

Civic Platform displays the Service Search portlet.

3. Enter your search criteria.

Civic Platform displays a list of services that meet your criteria.

4. Select the service you want to work with.
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5. Make your modifications. Refer to Service Field Descriptions.

6. Click Save.

Associating License Types with a Service
You can associate a license type with a service, which provides a way for a user to view services and
request services appropriate to their license type. For examples, refer to Example Multi-Agency Services
and Licensed Professional Type Associations.

You can use this feature with EMSE scripts for license validation. When you update licensed professional
information in Civic Platform, you can verify the license at an external database by using a dynamic web
service. This feature also applies to a licensed professional registered with a public user account for
Citizen Access. Validation of license information can occur at the time of login.

To associate a license type with a service

1. Access the Service portlet (Accessing the Service Portlet).

2. Search and select the service you want to work with.

Civic Platform displays the service details in the detail portlet.

3. Click the License Type tab.

Civic Platform displays the Licensed Professional Type list portlet.

4. Click Look Up.

Civic Platform displays the License Type portlet.

5. Enter the Licensed Type Name and Description, or leave the fields empty.
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6. Click Submit.

Civic Platform displays the license types that meet your search criteria.

7. Select the license types you want to associate with the service, and then click Select.

Civic Platform adds the license types to the License Type list portlet of the service.

Table 41: Example Multi-Agency Services and Licensed Professional Type Associations

Agency Service Name License Type

Oregon Water Heating Contractor

Oregon Water Heating Architect

Eugene New Drain Contractor

Eugene New Drain Architect

Portland Re-roof Contractor

Portland Re-roof Architect

Associating an Address Type with a Service
You can associate an address type with a service. This feature provides a way for a user to view services
and request services appropriate to their address. For examples, refer to Example Services and Address
Type Associations.

To associate an address type with a service

1. Access the Service portlet (Accessing the Service Portlet).

2. Search and select the service you want to work with.

Civic Platform displays the service details in the detail portlet.

3. Click the Address Type tab.

Civic Platform displays the Address Type list portlet.
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4. Click Look Up.

Civic Platform displays the Address Type list portlet.

5. Enter the Address Type Name and Description you want associated with the Service.

6. Click Submit.

Civic Platform returns you to the Address Type list portlet.

Table 42: Example Services and Address Type Associations

Agency Service Name Address Type Group

Eugene Water Heating Eugene

Eugene New Drain Oregon

Portland Re-roof Oregon

Incorporating the Service Lock Condition
You can choose to limit one or more services to a particular licensed professional or address. The Service
Lock Condition feature is particularly useful if you want to lock out services from a particular agency at an
address or licensed professional, but still offer services from other agencies.

Select the Service from the Condition Name drop-down list to lock out that service from the Licensed
Professional or address. If you only want to lock out one service, create a Lock condition and associate
it with a Service Name. Create as many conditions to limit the available services for the Licensed
Professional or Address.

Topics

• Adding a Service Lock Condition to a Licensed Professional

• Adding a Service Lock Condition to an Address

Adding a Service Lock Condition to a Licensed Professional
Your agency can filter available services for a licensed professional using the Conditions portlet. Provide
a Service Lock on all services for the Licensed Professional or create a condition to lock out one particular
service.

To add a service lock to a licensed professional
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1. Access the Professionals portlet (Accessing the Professionals Portlet).

2. Select the Licensed professional to which you want to associate a Service Lock condition.

Civic Platform displays the Licensed Professional details in the detail portlet.

3. Click the Conditions tab.

Civic Platform displays the Licensed Professional Conditions portlet.

4. Go to the Severity field and select Service Lock from the drop-down list.

5. Go to the Service Name field and select the condition to which you want to associate the service lock
from the drop-down list.

6. Click Submit.

Adding a Service Lock Condition to an Address
Your agency can filter available services for an Address using the Conditions portlet. Provide a Service
Lock on all services for the Address or create a condition to lock out one particular Service.

To add a service lock condition to an address

1. Access the Addresses portlet (Accessing the Addresses, Parcels, or Owners Portlets).

2. Search and select the address to which you want to associate a Service Lock condition.

Civic Platform displays the Address details in the detail portlet.

3. Click the Conditions record tab.

Civic Platform displays the Address Conditions portlet.

4. Go to theSeverity field and select Service Lock from the drop-down list.

5. Go to the Service Name field and select the condition to which you want to associate the service lock
from the drop-down list.

6. Click Submit.

Synchronizing Licensed Professional Data between Agencies
Maintain the accuracy of licensed professional information by running a regularly scheduled batch job
to synchronize licensed professional data from super agency to sub-agency. The administrator from the
super agency is responsible for setting up the batch job for data synchronization. When you run the batch
job and Civic Platform recognizes that the sub-agency does not have the Licensed Professional in the
database, Civic Platform creates the Licensed Professional at the sub-agency with same License State,
State License number, License Type as the one at the super agency.

For information about Batch jobs, refer to Working with Batch Jobs.

To schedule a batch job that synchronizes licensed professional data between agencies

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

The Job Detail tab displays.
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3. Complete the Job detail fields as described below.

Name Provide a name for the new job.

Job Type Choose System from the drop-down list.

Description Provide a brief comment about the Job name.

4. Click Submit.

5. Schedule the Job by clicking the Job Schedule tab.

Civic Platform displays the Job Schedule portlet.

a. Complete the fields as described below:

Start Time, Start Date
and End Date

Enter the time that you want the job to execute. This time should be a time at which
the server is running and free to run the batch job. Select a start and end date too
using the date picker icon.

Schedule Status Choose one: To have the batch job run, select Active from the drop-down list. To
disable the job from running on schedule, select On Hold.
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Time Out (seconds) Specify how long you want the server to wait (in seconds) if the batch job does not
run as scheduled.

Frequency Select how often to run the batch job from this drop-down list.

b. Click Save.

Configuring Record Creation
In a multi-agency configuration, your agency requires the implementation of Citizen Access to provide
the record creation process across multiple agency services. When configured this way, Citizen Access
provides a way for public users to manage records from multiple agencies all from a single login. This
type of configuration is best used when a single Citizen Access site exists to service multiple agencies.
An example of this type of configuration is when a State hosts a single Citizen Access site that provides
access to all of the cities and counties within the state. You must perform multiple configurations for
numerous features within Civic Platform and Citizen Access for complete functionality. This section
provides the basic conceptual flow for the process to create a record, what you need to configure, and the
impact of configurations on the user interface.

Impact on the User Interface
To use this feature, you must configure multi-agency services, the sub-agency record types, and the
reports. The most critical element of the process is the main record type which works as a place holder for
sub-agency records and resides at the super agency level. The place holder record type does not require
ASI, Workflow, or Fee Setup as, again, it merely functions like a storage place. You must configure a page
flow for the place holder record type. You must also configure the record type filter in Citizen Access so
that this main record type is the only available record type available to public users. Doing so forces the
public user to initially select the place holder record type so you can associate the record types for the sub-
agency services with it moving the group of records together through the record creation process. The
following section contains the configuration instructions for the record creation feature and its impact on the
user interface.

To configure the ability to create records

1. Configure any Delegate Users to have the ability to manage multiple agencies and their services. You
must enable this feature for public users so that they have access to multiple agency services when
creating a record online. For complete configuration information, refer to Delegate User Management.

2. Configure the ability for multiple agencies to share information in a common database. Multi-agency
sharing is particularly useful when you search for addresses across multiple agencies to select a work
location. For complete configuration information, refer to Delegate User Management.

3. Enter the Official website URL on the Global Settings page. For complete configuration information,
refer to “Official Website” in the “Global Settings” section of the Citizen Access Administrator Guide.

4. Configure the multi-service functionality for multiple agencies, including:

a. Configure a record type at the super agency level. This record type does not require Application-
Specific Information (ASI), workflow, or Fee setup.

b. Configure any record types at the sub-agency level.

c. Configure ASI groups for sub-agency services. For example, ASI group plumbing services with the
sub-group water heater. For more examples, refer to Table 40: Services Example Configurations.

Note:
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You must define ASI sub-group configurations at both the parent and sub-agency level and
configured so they match. At the parent level the ASI sub-group information must exist in the
database but you do not need to associate it with a record type.

d. Set up the multi-agency services and associate them to record types, Licensed Professionals,
Addresses. You must also configure the Service Locks. For basic configuration information refer to
Multi-Agency Service Management.

e. Associate any Logos with an agency. For complete configuration information, refer to Branding Civic
Platform for Your Agency.

5. Receipt and Permit Summary configurations.

a. Configure the Receipt and Permit Summary in Report Manager. You must define receipts for each
sub-agency and super agency. You must also define an overall multi-agency receipt that includes all
sub-agency information at the super agency level. For complete configuration information, refer to
“Setting up Permit Reports” in the Citizen Access Administrator Guide.

b. Associate the receipts and the Permit Summary to buttons in Citizen Access. For complete
configuration information, refer to “Associating Reports with Print/View Buttons” in the “Reporting
Information” chapter of the Citizen Access Administrator Guide.

6. Configure the page-flow for the super agency placeholder record type. For complete configuration
information, refer to “Defining the Page Flows for Record Types” in the “Creating Records” chapter of
the Citizen Access Administrator Guide.

Configure the record type filter to exclude all records but the super agency placeholder record type. For
complete configuration information, refer to “Record Type Filters” in the Citizen Access Administrator
Guide.

Customizing Regional Settings
You can manage and accept data from people who live outside of the United States without turning on the
Internationalization and Localization feature.

Before your agency issues professional licenses and receives applications from customers who:
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• are not residents of the United States, or

• have completed education, continuing education, or examination outside the United States,

You must define regional settings for each foreign country or region. This way, both internal staff and
external citizen users can enter, format, and store the zip code or postal code, country code, phone
number, and fax number based on the selected country or region.

The regional settings for a country or region applies to Civic Platform and its add-ons such as Citizen
Access and Mobile Office.

Click a topic title below for full details.

Related Links

Defining Regional Settings for a Country or Region

Viewing or Editing Regional Settings for a Country or Region

Deleting Regional Settings for a Country or Region

Defining Regional Settings for a Country or Region
Follow the steps below to define regional settings for a country or a region other than the United States.
Do not define regional settings for the United States, because Civic Platform contains a pre-configured
regional settings entry for the United States. See Viewing Default Regional Settings for the United States
for more information.

To define regional settings for a country or region

1. Access the Regional Settings portlet (Accessing the Regional Settings Portlet).

2. Click New.

Civic Platform displays the regional settings form.

3. Complete the fields that display. For a list of field descriptions, see Table 43: Regional Settings Fields.

4. Click Save.

Table 43: Regional Settings Fields

Country/Region Use this drop down list to choose the country or region for which you want to define the
regional settings. When you enable the Standard Choice COUNTRY, this drop-down
list contains the values defined in the Standard Choice. When you disable the Standard
Choice, this drop-down list contains all the countries and regions available in the Civic
Platform database. However, to avoid any duplicate or conflict settings, this drop-down
list always excludes the countries or regions for which you have already defined the
regional settings. For more information about the Standard Choice COUNTRY, see its
listing in the “Internationalization Standard Choices” section of the Internationalization
Installation and Administrator Guide.

Default Country/Region Select this option if you want to set this country or region as the default. The country
or the region displays as the default Country/Region in a drop-down list for users (for
example, on the application intake form). You can only set one country or region as the
default one for an agency.

Another quick way to set a country or region as default is to select the country or region
from the Regional Settings list portlet and then click Set Default.

State/Province Use the drop-down list to decide the list of the states or provinces that comprise the
country or region. The options available in this drop-down list are the Standard Choices
of the Business Configuration - State/Province type. For example, this drop-down list
might have two options: one is “US_State/Province,” which defines a list of states for
the United States; and the other is “AU_State/Province,” which defines a list of states
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for Australia. So if you are defining regional settings for the United States, choose
“US_State/Province” from this drop-down list. This way, when the user selects the
United States in a form like the Contact Address intake form, the State drop-down list
in that form contains the values you define in the Standard Choice US_State/Province.
For more information about the Standard Choices of the State/Province type, see
the listing “State/Province (User-defined Name)” in the Standard Choices Reference
chapter of the Accela Civic Platform Configuration Reference. If you do not choose any
option from this drop-down list to define the states available for a country or region,
users must manually enter a state name or a province name for that country or region
in various forms.

Use ZIP Code Select this option if the country or region uses ZIP codes in addresses. If you leave this
option blank, Civic Platform ignores the Required property defined for the ZIP Code (or
Postal Code) field in the Form Portlet Designer and prevents users from filling in that
field.

ZIP Code Mask This field defines the mask for the ZIP Code (or Postal Code) field in all pages related
to contact addresses and premise addresses across Civic Platform, Citizen Access,
and Mobile Office. It is an active field only when you select Use ZIP Code. When
users select a country from the Country/Region drop-down list, the specified mask
automatically applies to the ZIP Code field. The mask ensures that users enter proper
values in the expected format and position. You can use the following placeholder and
literal characters to define a ZIP Code mask:

A: Users must enter a letter. The letter automatically capitalizes.

#: Users must enter a digit.

( ): Parentheses indicate optional fields. For example, if the ZIP Code mask is #####(-
####), the last 4 digits of the ZIP Code are optional. Users can enter “94610” or
“94610-6279” in the ZIP Code field. NOTE: Parentheses can only be used at the end of
the mask. For example, the following masks do not work: (###) ###, ### (###) ###.

Space or hyphen: Spaces and hyphens are formatting characters. They automatically
populate in the field in the position that you specify. For example, a U.S. ZIP code
might be 94596-2801, while a Canadian postal code might be M5T 2T9. The masks for
these formats are: #####-#### and A#A #A#.

Phone Number Country
Code

This field defines the country code for phone numbers and fax numbers. When
users select a country from the Country/Region drop-down list, the pre-defined value
automatically populates into the Country Code field.

Note:

You must configure Standard Choice PHONE_NUMBER_IDD_ENABLE and
set its value to Yes. Otherwise, the Country Code field is not available to
users. For more information see the “Internationalization Standard Choices”
section of the Internationalization Installation and Administrator Guide.

Phone Number Mask This field defines the mask for the Phone Number and Fax Number fields in all pages
related to contact addresses and premise addresses across Civic Platform, Citizen
Access, and Mobile Office. When users select a country from the Country/Region
drop-down list, the specified mask automatically applies to the Phone Number and
Fax Number fields. The mask ensures that users enter proper values in the expected
format and position. You can use the following placeholder and literal characters to
define a Phone Number mask:

#: Users must enter a digit.

(): Parentheses in the phone number mask differ from the ZIP code mask. These
parentheses are formatting characters. They automatically populate in the field in the
position that you specify. For example, you might always want telephone numbers
formatted like so: (510) 813-9225. The mask for this format is (###) ###-####.

Space or hyphen: Spaces and hyphens are formatting characters. They automatically
populate in the field in the position that you specify.
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Viewing or Editing Regional Settings for a Country or Region
To view or edit regional settings for a country or region

1. Access the Regional Settings portlet (Accessing the Regional Settings Portlet).

2. Select the country or region for which you want to view or update regional settings.

Civic Platform displays the regional settings form.

3. Update the fields that display, as appropriate for your agency. For a list of field descriptions, see Table
43: Regional Settings Fields.

4. Click Save.

Viewing Default Regional Settings for the United States
When your agency first implements the latest version of Civic Platform or upgrades an existing instance
to the latest version, Civic Platform automatically creates an entry for the United States in the Regional
Settings portlet. That entry populates with the default settings for the United States. See Table 44: Default
Regional Settings for the United States. You can update the settings as appropriate for your agency.

Table 44: Default Regional Settings for the United States

Country/Region United States

Default Country/Region If you set the United States as the default country, and if you do not set a default country
before upgrading Civic Platform, this option automatically enables.

State/Province STATES

Use ZIP Code Enabled

ZIP Code Mask #####(-####)

Phone Number Country
Code

1 or 001, same as the phone number country code defined for the United States in the
Standard Choice PHONE_NUMBER_IDD. If your agency does not enable or define
that Standard Choice, this field uses the US phone number country code that the
STANDARDDATA agency defines in the Standard Choice PHONE_NUMBER_IDD. For
more information about the Standard Choice, see its listing in the “Internationalization
Standard Choices” section of the Internationalization Installation and Administrator Guide.

Phone Number Mask ###-###-####

Deleting Regional Settings for a Country or Region
To delete regional settings for a country or region

1. Access the Regional Settings portlet (Accessing the Regional Settings Portlet).

2. Select the country or region for which you want to delete the regional settings.

3. Click Delete.
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Part 3: Configuring Agency Business Objects
Civic Platform provides functions to configure agency business objects.

Related Links

Creating and Configuring Records

Defining Custom Fields (Application Specific Information)

Designing Application Intake Forms

Setting Up Security Policies

Defining Sequences, Masks, and Autonumbering

Designing Workflows

Using Expression Builder

Configuring Standard Comments

Setting Up Conditions

Configuring Record-Related Activities

Configuring Standard Comments

Creating and Configuring Records
Records are the cornerstone of the system, consisting of a broad range of forms that users create and
manage within Civic Platform, including applications, cases, licenses, permits, service requests, and work
orders. Records provide a means of collecting the data that Civic Platform stores in its back-end database,
enabling users to access the data and process it to achieve your agency’s business objectives.

Click a topic title below for full details.

Related Links

Accessing Record Type Administration

Creating New Record Types

Working with Record Types

Working with Address Type Groups

Working with Application Status Groups

Working with SmartChoice Groups

Working with Virtual Folder Groups

Associating Record Types

Setting Default Clone Options

Managing Documents for Attachments
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Accessing Record Type Administration
You can access Record Type Administration portlets by selecting the Civic Platform Admin option from the
Administration Setup portlet.

To access Record Type administration

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

Creating New Record Types
This section provides instructions for creating a new record type, which involves three basic configuration
tasks:

• To begin, click Create New Record and enter basic record type information. You can access additional
record type configurations with the tabs on the record type summary navigation panel.

• Use the Settings portlet to configure additional record type features for add-ons, like Citizen Access and
legacy Accela GIS.

• Use the Other Associations portlet to configure other related items for the record type, such as fee
schedule, expiration code, application specific information, and workflows. The Other Associations
portlet is also where you can configure the ability for agency users to submit partially completed
applications.

You can save and resume as you go, but you must review all three areas of configuration to ensure you
properly configure the record type. Additional administrator configurations that you can apply to record
types include Standard Comments and Conditions. Refer to Configuring Standard Comments and  Setting
Up Conditions.

Topics

• Specifying Basic Record Type Information

• Configuring Record Type Settings

• Configuring Other Associations

Specifying Basic Record Type Information
You must complete the required fields that display in the new record type page. This basic information
allows the user to save enough critical data elements in Civic Platform so you can access the information
about additional configuration or modification later.

To create a new Record type

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Locate the module that you want to add a record type and then Click New Record Type.
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Civic Platform displays the New Record Type page.

3. Enter information in the fields as described in Table 45: New Record Type Form Fields.

At a minimum, you must complete the Record Type Alias, Group, Type, Sub-Type, and Category. When
those are complete, you can save and resume later.

4. Click Save or Save and Create Another.

Table 45: New Record Type Form Fields

Category Enter the name of the new category.

Fee Schedule Use the drop-down list to search and select a fee schedule to assign to the record type.

Group Select a group for the record type.

Partial ID Mask Use the drop-down list to search for a Partial ID Mask to identify records that users
partially completed at intake, that represent an estimate, or that a user saved and
resumed processing later in Citizen Access.

Record Key Mask Use the drop-down list to search and select a Record Key mask, which identifies
a record of this type in Civic Platform. You can also use the default value: $$yy$
$CAP-00000-$$SEQ05$$ by choosing Default from the list.

Record Type Alias Enter an alias name for the record type. Record type aliases display in the Records
list portlet. A record type alias is a short, logical name that represents the four-level
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name structure for the record type. For example, instead of displaying the record type
Licenses/Business License/Retailer/Hairdresser, you can configure a record type alias
that displays simply “Hairdresser.”If you do not see the option to specify a Record
Type alias, you might need to enable the functionality. To enable record type aliases,
set the Standard Choice ENABLE_CAP_TYPE_ALIAS. Refer to the Civic Platform
Configuration Reference for more details.

SmartChoice Group Use the drop-down list to search and select a SmartChoice group. SmartChoice Group
is an important step as it indicates what intake information Civic Platform gathers for
this record type.

Sub-Type Do one of the following: choose an existing or create a new sub-type.

To create a new sub-type, enter a name in the field for it.

To choose an existing sub-type, use the drop-down list to search and select the sub-
type you want to use.

Temporary ID Mask Use the drop-down list to search and select the mask used for the Partial ID Mask for
this record type.

Type Do one of the following: choose an existing or create a new type.

To create a new type, enter a name in the field for it.

To choose an existing type, use the drop-down list to search and select the type you
want to use.

Workflow Use the drop-down list to search and select a workflow process to assign to the record
type.

Configuring Record Type Settings
After you define the basic configuration for a record type, you can complete the record type settings. These
configurations include: settings for Citizen Access, Audit Frequency, and GIS Settings. For an overview of
the Record Type Settings page, see Configuring Other Associations.

To configure the Settings portlet

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Expand a module to search and select the record type you want to work with. For instructions on how to
search for a record type, see Searching for Record Types.

Civic Platform displays the Record Type Summary page.

3. Click the Settings tab from the summary panel.

Civic Platform displays the Settings portlet.
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4. Complete the Settings fields as described in Table 46: Record Type Settings Field Descriptions.

• Complete the Settings for Citizen Access section, as appropriate for your agency.

• Complete the Audit Frequency section, as appropriate for your agency.

• Complete the GIS Settings fields section, as appropriate for your agency.

5. Click Save.

Table 46: Record Type Settings Field Descriptions

Section on Page Field Field Description

Settings for any module Copy all associated APO Select the option to copy all associated APO
information about this record type application.

Settings for any module Duration Enter the number of days you estimate the record
should take to complete.

Settings for any module Icon Click Browse to search and select the image you want
associated with the record type.

Settings for any module IVR Number For each record type you want to assign, enter a
unique numerical value in this field. This field is not
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Section on Page Field Field Description

for a phone number. Assign a unique number to each
record type to make it faster and easier for public
users to navigate the IVR call flow. When a caller
receives a prompt to enter the record type, the caller
enters the pre-assigned numerical value entered in
this IVR Number field. For more information on how to
set this up with IVR, see the Accela Civic Platform IVR
Installation Guide.

Settings for any module Status Select Enable or Disable. You can choose to Disable
a record type to prevent users from creating this type
of record. The Disable option does not remove the
record type. All application types with the Enable
status are searchable. If you disable an application
type, you can select the Searchable option, to
enable users to search records with the disabled yet
searchable record type.

Settings for any module As Child Only Enable this option for a record type to prevent users
from selecting the record type for a stand-alone record.

Settings for Asset Module Default Production Unit Enter a fixed production quantity for a Work Order.

Settings for Asset Module Estimated Cost Per
Production Unit

Enter a value you want to use to generate the
estimated cost for each work order. Asset Module
settings are particularly useful so that Accela Civic
Platform - Asset users can record the estimated cost
per production unit.

Settings for Asset Module Unit of Production Select the unit of measure for Production Units for
the record type for Accela Civic Platform - Asset. For
example, Each, Feet, Acres, or Miles.

Settings for Asset Module Value Required to Close Select the option to indicate users must enter a value
in the Production Quantity field before they can close a
work order in Accela Civic Platform - Asset.

Settings for Enforcement
Module

Email for Hearing
Notification

Enter the email address used to send email
notifications for hearings.

Settings for Enforcement
Module

Enforcement Type Enter the enforcement type in this field. For example,
Abatement.

Settings for Citizen Access Enable Associated Forms Select this option to display the Associated Forms
step to the record creation process. Use Associated
Forms to display and manage child records for the
parent record during parent record creation. For more
information about creating parent and child records,
see the topic “Parent-Child Record Creation” in the
Citizen Access Administrator Guide. Selecting this
option also activates the Enable Partial Submission
option.Enable Partial Submission: Select this option
to enable public users to continue the application
intake process without completing all available
associated forms.

Settings for Citizen Access Enable for Application Select Enable Application to make the Record
type available in Citizen Access. When you only
select the Enable Application option, the Record
Type is available in Citizen Access, but you cannot
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Section on Page Field Field Description

automatically issue it though ACA. The agency must
approve it.

This option also flags Civic Platform to display
the Record Type alias in Citizen Access. Also
Enable Issuance: Select this option if you want to
automatically approve and issue the record type
through Citizen Access after a public user pays the
fees in full.

Settings for Citizen Access Enable Fee Estimation Select this option if you want to allow users to create
a partial application that includes a calculation
of estimated fees. Civic Platform bases this fee
estimation on the Fee Schedule.

Settings for Citizen Access Enable Renewal Select the Enable Renewal option if you want to
enable the renewal of licenses in Citizen Access for
this record type. Select this option to activate the
Enable Issuance option for this renewal, and the
Renewal Record Type drop-down list. You must then
define a renewal record type to associate with this
renewal process.

Enable Issuance: Select this option for renewals if
you want to provide issuance online, and enable the
License or Permits status change back to active when
the Citizen Access public user completes the Renewal
Application.

Choose a Renewal Record Type from the drop-
down list to designate the renewal Record Type for
the expired Record. For example, choose a Renewal
Plumber Permit for the expired plumbing permit.

Settings for Citizen Access Document Code Indicate the document code set for the types of
documents public users can upload and attach to
record types in ACA.

Settings for Citizen Access Page Flow Code Use this drop-down list to associate a Page Flow code
to this record type. The page flow code you choose
displays within Citizen Access Admin. You create and
assign the default setting for this field in Citizen Access
Admin page flow configuration. For more information,
see “Configuring the Page Flows for a Module” in
the “Creating Records” section of the Citizen Access
Administrator Guide.

Settings for Citizen Access Searchable in Citizen
Access

Civic Platform enables this option by default, which
means that the type of application is searchable in
Citizen Access. You can clear this option to make the
applications unsearchable.

Settings for Citizen Access Set the criteria for
selecting fees

To set the fee valuation associated with the record,
you can choose between the higher value or the
lower value of the Contractor Value and the Valuation
Calculator.

Settings for Citizen Access Do you want this permit
to be available through
Citizen Access

You can either select Yes to make the record type
available in Citizen Access, or select No to prevent the
record type being available from Citizen Access.



 | Part 3: Configuring Agency Business Objects | 226

Section on Page Field Field Description

Audit Frequency Audit Frequency Enter the number of months in the Audit Frequency
column to designate the interval between audits for the
Record Type. You can enter a number under any of
the Record Type Levels. For example, enter a “3” next
to the Building Permit Record Type Level to prevent
Civic Platform from selecting Building Permit Records
for auditing within a three month period.

When you edit any level of a Record Type, Civic
Platform automatically syncs the audit frequency for all
related Record Types.

For example, if you modify the audit frequency for
Building to 18 months for Building/Commercial/
Addition/Apt +5, the audit frequency for Building/
Commercial/Addition/Amusement also changes to 18
months.

GIS Settings Edit Layer If your agency uses the legacy Accela GIS, use this
field to limit users to a particular map edit layer when
using this application category. For example, if the
application category is for sewer lines, you can limit
users to editing only a sewer map layer rather than all
the edit layers. After you select the GIS Service, use
this drop-down list to select the edit layer.

GIS Settings GIS Service If your agency uses the legacy Accela GIS, use this
field to limit users to a particular map edit layer when
using this application category. For example, if the
application category is for sewer lines, you can limit
users to editing only a sewer map layer rather than all
the edit layers. Select the GIS Service that contains
the map edit layer you want to use.

Configuring Other Associations
After you define the basic configuration and the settings for a record type, you can configure the Other
Associations settings. These configurations include:

Address Type Group, Application Specific Info Group, Associated Record Types, Document Code,
Expiration Code, Fee Schedule, Inspection Group, Sequences and Masks, SmartChoice Group, Status
Group, and Workflow.

You might have already defined some of these in the basic record type setup, but you can modify them if
you have permission. Also, you can use this record type Other Associations portlet to create new codes or
groups and assign them to the record type if you have permissions.

The Other Associations portlet is also where you can configure the ability for agency users to submit
partially completed applications.

To configure the other associations portlet

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Expand a module to search and select the record type you want to work with. For instructions on how to
search for a record type, see Searching for Record Types.

Civic Platform displays the Record Type Summary page.

3. Click the Other Associations tab from the summary panel.

Civic Platform displays the Other Associations portlet.
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4. Complete the Other Association fields as described in Table 47: Record Type Other Associations
Fields.

Table 47: Record Type Other Associations Fields

Section on Page Field Field Descriptions

Sequences and Masks ID Mask Select the mask for the application type. Users can click the
ID Mask Definition link to read the pattern and definition of ID
masks. Within the Sequence Mask Definition page you can also
click Guide to review the recommended mask patterns and the
examples.

For information on sequences and masks, see Defining
Sequences, Masks, and Autonumbering.

Sequences and Masks Invoice Number
Scheme

From the drop-down list, choose the invoice number format for
the record type.

You format an invoice number scheme by creating a mask. For
an example on formatting a receipt number scheme or mask,
see Defining Sequences, Masks, and Autonumbering. Users
can click the Select a Invoice Number Scheme link to read
the pattern and definition of the invoice in this drop-down list.
For example, administrators can number invoices for the code
enforcement department differently from invoices for the permit
department.

Sequences and Masks Partial ID Mask Use the drop-down list to search for Partial ID Mask to identify
records that a user only partially completed at intake, that
represent an estimate, or that a user saved and resumed
processing later in Citizen Access. Partial ID Mask is a required
field.

Sequences and Masks Receipt Number
Scheme

From the drop-down list, choose the receipt number format for
the record type.
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Section on Page Field Field Descriptions

You format a receipt number scheme by creating a mask. For
an example on formatting a receipt number scheme or mask,
see Defining Sequences, Masks, and Autonumbering .

Users can click the Receipt Number Definition link to read the
pattern and definition of the receipt in this drop-down list. For
example, administrators can group receipts for the building
department differently from receipts for the code enforcement
department.

Sequences and Masks Record Key Mask Use the drop-down list to search and select a Record Key
mask, which identifies a record of this type in Civic Platform.
You can also use the default value: $$yy$$CAP-00000-$
$SEQ05$$ by choosing Default from the list. Record Key Mask
is a required field.

Sequences and Masks Temporary ID Mask Use the drop-down list to search and select the mask used
for the Temporary ID Mask for this record type. Temporary ID
Mask is a required field.

Document Code Default Document
CodeDefault
Document Type

Use the drop-down menu to select an existing document code.
You can view or edit this code by clicking the View/Edit link.
If you want to create a new Document Code, click the Create
new Document Code link. For complete instructions on how
to create a document code, see Managing Documents for
Attachments.Use the Default Document Type to provide a
label for type of document, such as a graphic image or photo,
diagram, or Word document.

Expiration Code Expiration Code Use the drop-down menu to select an existing expiration code.
You can view or edit this code by clicking the View/Edit link. If
you want to create a new Expiration Code, click the Create new
Expiration Code link.

For complete instructions on how to create an expiration code,
see License Renewal.

Inspection Group Inspection Group Use the drop-down menu to select an existing Inspection code.
You can view or edit this code by clicking the View/Edit link. If
you want to create a new Inspection Group, click Create New
Inspection Group.

For instructions on creating a new inspection code, see
Inspections.

Address Type Group Address Type Group Use the drop-down menu to select an Address Type Group you
want to assign to the record type.

For more information, see Working with Address Type Groups.

Status Group Application Status
Group Code

Use the drop-down menu to select an existing Application
Status Group code. You can view or edit this code by clicking
the View/Edit link. If you want to create a new Application
Status Group, click Create New Status Group.

For more information, see Working with Application Status
Groups.

Status Group Default Record
Status

Use the drop-down menu to select the default record status you
want to assign to the record type.

For more information, see Working with Application Status
Groups.
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Section on Page Field Field Descriptions

Fee Schedule Fee Schedule Use the drop-down menu to select an existing Fee Schedule.
You can view or edit the Fee Schedule code by clicking the
View/Edit link. If you want to create a new Fee Schedule, click
Create New Fee Schedule. Fee Schedule is a required field.

For more information about fee schedules, see the
Understanding Fee Items.

Workflow Workflow Use the drop-down menu to select an existing Workflow. You
can view or edit the Workflow by clicking the View/Edit link. If
you want to create a new Workflow, click Create New Workflow.
Workflow is a required field.

Workflow Enforce Validation
Prior to Workflow
Update

With this setting, when an agency user creates an application,
but does not have all the necessary information to enter data
in all of the required fields, the user can submit the application
and defer validation of the application until all the required
information is available.

When a user submits an application without validation, Civic
Platform sets a Pending Validation flag on the newly created
record. Civic Platform also creates a flag, Generated by
Cloning, which defaults to No.

SmartChoice Group SmartChoice Group Use the drop-down menu to select an existing SmartChoice
group. You can view or edit the SmartChoice Group code
by clicking the View/Edit link. If you want to create a new
SmartChoice Group, click Create New SmartChoice Group.
SmartChoice Group is a required field.

For more information about SmartChoice groups, see Working
with SmartChoice Groups.

Application Specific Info
Group

Application Specific
Info Group

Use the drop-down menu to select an existing Application
Specific Info Group. You can view or edit the Application
Specific Info Group code by clicking the View/Edit link. If you
want to create a new Application Specific Info Group, click
Create New Application Specific Info. For more information
about Application Specific Info Groups, see Defining Custom
Fields (Application Specific Information).

Virtual Folder Group Virtual Folder Group Use the drop-down menu to select an existing Virtual Folder
Group. You can view or edit the settings for the displayed
Virtual Folder group by clicking the View/Edit link. If you want
to create a new Virtual Folder Group, click Create New Virtual
Folder Group. For more information about Virtual Folder
Groups, see Working with Virtual Folder Groups.

Associated Record
Types

No StatusStatus
Group

Click the No Status link or click a status group link to prompt
users to associate a record type. For more information about
Status Group, see Working with Application Status Groups.

5. Click Save.

Enabling Submittal of Partially Completed Applications
You can enable agency users to submit partially completed applications, creating records that contain fully
functional record detail tabs. The primary mechanism that enables this functionality is a setting in the Other
Associations portlet, Enforce Validation Prior to Workflow Update, where you specify which workflow task
triggers the validation of an application.
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Civic Platform flags partially completed applications with a Pending Validation flag to easily distinguish
them from validated applications when specifying records for EMSE handling and scripting, and when
searching and filtering records. For example, you might want to write a script or conduct a search only for
fully validated records.

A typical use case for this feature is when a paper application comes into the back office and is incomplete
or does not yet contain information or documentation for all of the required fields. The agency still needs to
enter the application into Civic Platform to enable payment processing, generate deficiency letters, and for
other relevant activities.

To enable agency users to submit partially completed applications

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

Civic Platform displays the Record Type Administration portlet.

2. Open the record type for which you want to enable agency users to submit partially completed
applications. In this example, we are using a Waste Site Permit application.

Civic Platform displays the record type.

3. Click Other Associations.

Civic Platform displays the record type associations that you can modify.
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4. Scroll to the Workflow section, and in the Enforce Validation Prior to Workflow Update area, click View/
Edit.

Civic Platform displays the Workflow Task Status to Enforce Validation screen.

5. Click the selection icon.

Civic Platform displays a navigation tree.
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6. Use the navigation tree to select the workflow task and status that enforces application validation. For
example, the Application Acceptance task, Accepted status. By deferring validation until the application
reaches its Accepted status, agency staff can conduct business on the application without delay.

Working with Record Types
You can perform various tasks within the record type lists of a module. This section describes those tasks
including searching, filtering, and enabling record types. This section also provides instructions on how to
access online help.

Topics

• Searching for Record Types

• Filtering a Record Type List

• Enabling or Disabling Record Types

• Accessing Online Help for Record Types

Searching for Record Types
You can search for a record type by name. The record type search for each module returns results
instantly when you enter any partial search criteria into the search window. For example, if you start typing
a word that begins with the letter Co, Civic Platform returns all record types with a name beginning with Co.

To search for a record type

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Expand the module to reveal the associated record types.

3. Civic Platform supports quick search for record type aliases. Begin typing your search criteria in the
search window. For example, Co.
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Civic Platform returns a list of record types meeting the search criteria.

Filtering a Record Type List
You can filter record types to easily access record type information.

To filter record types list

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Expand any module to reveal the associated record types.

3. Click Set Filters.

Civic Platform displays the filtering options

4. Expand the navigation tree to expose record types for each module.

5. Select which record types you want to display.

6. Click Apply Filters.

Civic Platform filters the record types based on the filter settings.

Enabling or Disabling Record Types
A record type that requires you to enable it for a module displays an Action button. Click the Action button
in the row of the record type to display the available options.

To enable a record type
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1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Expand the module to display the associated record types.

3. Locate the record type you want to enable or disable.

4. Click the Action button and choose one of the following:

• Choose Enable from the drop-down list to enable the record type in the module.

• Choose Disable from the drop-down list to disable the record type from the module.

Civic Platform enables or disables the record type for the module.

Accessing Online Help for Record Types
You can access online help for Record Types by clicking the help button in the upper right corner of the
portlet.

To access online help for record types

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Click the online help button on the corner of the page to access online help.

Civic Platform displays the help topic on record type configuration information.
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Working with Address Type Groups
You can specify the Address Type Group Code name to associate with the application type. The purpose
is to set the types of addresses you can use or add to an application type. Specify an Address Type Group
Code name to enable Civic Platform to restrict an application type to only those specific address types
listed in the Group Code name. For more information on associating an address to an application type, see
Configuring Other Associations.

You can set an application type, for example, new commercial building permit, to allow users to only add
Street Address types and Parcel Address types to it. A user could also search for those same application
types based on the Address Type.

Topics

• Searching for an Address Type Group

• Creating an Address Type Group and Associating Address Types

• Adding an Address Type to an Address Type Group

• Deactivating an Address Type Group

Searching for an Address Type Group
Before you can edit an existing Address Type group, you must search for it.

To search for an Address Type group

1. Access the Address Type Group portlet (Accessing the Address Type Group Portlet).

2. Click Search.

Civic Platform displays the Address Type Group search page.
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3. Enter the Address Type Group name.

4. Click Submit.

Civic Platform displays the Address Type group name in the primary portlet, and the details for the
group in the secondary portlet.

Creating an Address Type Group and Associating Address Types
You can create new Address Type groups as needed.

To create an Address Type group and associate Address Types

1. Access the Address Type Group portlet (Accessing the Address Type Group Portlet).

2. Click New.

Civic Platform displays the new Address Type Group Detail information in the detail portlet.

3. Enter the Address Type Group code name. This field is a code name or an abbreviation of the address
types.

The Address Type Group names display in the Address Type Group Code drop-down list when a user
creates or edits an application type. Define address types, to enable users to only associate those
unique address types to certain application types. For example, you might require that new commercial
building permits only allow users to enter Street Address types and Parcel Address types.

4. Click Submit.

Civic Platform creates the address type group.

5. Click the Address Type tab.

6. Click Look Up to locate and associate the address types with the Address Type Group name.

Civic Platform displays the Look Up page.
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7. Enter the first few characters of an Address Type you want to locate and add it to the Address Type
Group name.

The available Address Types are controlled by the Values specified for the REF_ADDRESS_TYPE
Standard Choice.

8. Click Submit.

Civic Platform displays a list of Address Types that match your criteria.

9. Select the Address Type you want to add.

10.Click Select.

Civic Platform adds the Address Type to the Address Type Group.

11.To add additional Address Types, Click Look Up to return to the Address Type field and repeat through

Adding an Address Type to an Address Type Group
An Address Type group can contain multiple address types that allows a user to apply or search for when
creating a specific application type. Follow these steps to add Address Types to an Address Type Group
code name.

To add an Address Type to an Address Type group

1. Locate and select the existing Address Type group or create a new Address Type group.

For instructions on searching for an existing Address Type group, see Searching for an Address Type
Group.

For instructions on creating a new Address Type group, see Creating an Address Type Group and
Associating Address Types.

Civic Platform displays the Address Type Group code name detail portlet, including the Group Detail tab
and Address Type tab.
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2. Click the Address Type tab in the detail portlet.

Civic Platform displays the Address Type tab.

3. Click Look Up.

Civic Platform displays the Look Up page.

4. Enter the Address Type name or Description of the Address Type you want to add.

Civic Platform displays a list of Address Types that match your criteria.

5. Select the Address Type you want to add.

6. Click Select.

To remove an Address Type, select it and click Delete.
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Deactivating an Address Type Group
You can inactivate an Address Type group if it no longer applies within your agency.

To deactivate an address type group

1. Access the Address Type Group portlet (Accessing the Address Type Group Portlet).

2. Select the Address Type group you want to inactivate.

3. Click Delete.

To reactivate an inactive Address Type group, open the Address Type group you want to activate. In
the detail portlet, select Active from the Record Status drop-down list, and then click Save.

Working with Application Status Groups
When you create or view an application, you have the option of applying a status to each application.
Sometimes there is a group of applications that have the same list of statuses. For example, a group
of electrical building applications can all have the same list of status options, but a group of real estate
applications can have an entirely different list of statuses. In this case, you can create an Application
Status Group that applies to a specific type of application.

Topics

• Creating an Application Status Group

• Searching for an Application Status Group

• Editing an Application Status Group

Creating an Application Status Group
If you do not find the status group you want, you can create a new status group.

To create an application status group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > App Status Group.

3. Search for the group you want. For instructions, see Searching for an Application Status Group.

4. Click the red dot next to the group you want.

Civic Platform displays the Application Status Group—Edit window.

5. Click Add at the bottom of the window.

Civic Platform displays the Application Status Group—Add window.

6. Type in the status group and the status description that you want.

7. Click Save.

Searching for an Application Status Group
If you want to find a specific application status group, you can search for it.

To search for an application status group.

1. Access the Classic Administration page (Accessing Classic Administration).
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2. Choose Application > App Status Group.

3. Type in the group you are looking for and Click Submit, or just Click Submit to browse the groups.

4. Click the red dot that appears next to the status group that you want.

Editing an Application Status Group
In addition to editing an application status and the status group, you can also edit the status of the actual
group.

To edit an application status group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > App Status Group.

3. Search for the group you want. For instructions, see Searching for an Application Status Group.

4. Click the red dot next to the group you want.

Civic Platform displays the Application Status Group—Edit window.

5. Click the red dot next to the status you want to edit.

6. Update the field:

Status If you want to make this status available to users, select Enable; otherwise, select
Disable.

7. Click Save.

Working with SmartChoice Groups
This section describes how to create and define a SmartChoice Group, with instructions for each section of
the SmartChoice Group, and how to include or exclude the field groups on certain types of applications.

For instructions on applying a SmartChoice Group to an application type, follow the steps in Configuring
Other Associations.

Topics

• Adding a SmartChoice Group

• Searching for a SmartChoice Group

• Editing a SmartChoice Group

Adding a SmartChoice Group
A SmartChoice group enables you to specify parameters and settings for the fields on an intake form. For
example, you can display or hide fields, choose whether those fields are mandatory or optional, specify
where the fields display on the form, and so forth.

SmartChoice Group Settings
You can set the following parameters for fields on intake forms:

• Display: Do you want the field to display on the form?
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• Required: Is the field required or optional?

• Validate: Do you want to give users the ability to validate their entry against your database?

• Default Values: Do you want to display default values that tell users what information you expect them
to enter? (This only applies to Contact sections)

• Display Button: Where do you want the field to display on the intake form?

• Display Order: Where do you want the field to display on the intake form?

• depending on the field type (for example, Default Values are only available for certain fields):

To add a SmartChoice group

1. Access the Classic Administration page (Accessing Classic Administration).

2. In the Application area, click SmartChoice Group.

3. Click Add.

Civic Platform displays the SmartChoice Group - Add page, illustrated in the sample screen below. The
first column lists the intake form fields and its sections, starting with Record Detail; see Table 49: Intake
Form Fields and Sections for a complete list. The columns that display horizontally across the top of the
page contain the parameters you can set for each row listed in the first column.

4. Enter a name for your new SmartChoice Group.

5. For each row in the first column, specify the parameter settings for the columns that display horizontally
across the top of the page. For complete details of these settings, see Table 48: SmartChoice Group
Parameter Settings.
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Table 48: SmartChoice Group Parameter Settings

Display Click Yes to display the field on the intake form.

Click No to hide the field on the intake form.

Required Click Yes to require the user to complete this field. If you click Yes, users cannot submit
the form unless the form contains the required information. Click No to make this field
optional. If you click No, users can submit the form without entering a value in this field.

Validate Click Yes to enable a Validate button on the form. If a section requires validation, users
can only search and add information from the reference database into the section. The
reference database can be the local Civic Platform database, an external data source that
holds address, parcel, owner data, or data from ‘PERMITS’ Plus, Kiva, or GIS.

If you click Yes at the Validate and Required options of the Applicant or Contact section,
all the other sections and the fields in the intake form are inactive until users validate the
section. If a contact list requires validation, you only need to validate the primary contact
in the list. Click No to disable validation. If a section does not require validation, users
can enter new information or modify the information that they select from the reference
database.
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Default Value Specify a default value from the drop-down list to indicate the information you expect the
user to enter in the field. For example, if users generally enter billing information in this
form, you can set the default value for a contact field to “billing contact,” so that a user
who is completing the form sees “Billing Contact” in the field.

For the Multiple Contact fields, click the “Click to add contact types” link and add the
default contact types and the minimum number of contacts a user must enter. When you
set default values to “required,” users must enter the information on the form before Civic
Platform allows them to submit the form.

Display Button Check the As Owner option to display the As Owner button in this section on the form. To
hide this button, clear the check box.

Check the As Lic Pro option to display the As Lic. Pro button in this section on the form.
To hide this button, clear the check box.

Note:

In Civic Platform 7.1.0 or earlier versions, the display of the As Owner and As
Lic. Pro buttons on the Applicant and Contact sections was controlled by FID
8235-Search Owner and FID 0008 Reference Licensed Professionals. Upgrading
Civic Platform to Version 7.2.0 automatically migrates the display settings of the
As Owner and As Lic. Pro buttons to SmartChoice group configuration.

Display Order Enter a Display Order number that represents the field’s position on the form. For
example, to display the Record Detail first on the form, enter 1.

Table 49: Intake Form Fields and Sections

Record Detail The Record Detail section of a form displays the details of the record. The only
parameter that you can set for this section is the Display Order.

Address The address section of an intake form lets users enter the address of the primary parcel,
including a range of street and unit numbers.

If you set the Display and Required parameters in this section to Yes, Civic Platform
validates whether a user adds information to the Addresses section on the Location tab
upon the submittal of a new record.

Parcel The parcel section of an intake form lets users enter information about the parcel. The
County Assessor’s Parcel Number (APN) determines the parcel information.

If you set the Display and Required parameters in this section to Yes, Civic Platform
validates whether a user adds parcel information to the Parcels tab upon the submittal of
a new record.

Owner The owner section of an intake form lets users enter information about the individual or
institution that owns the parcel, property, or structure.

If you set the Display and Required parameters in this section to Yes, Civic Platform
validates whether a user adds owner information to the People tab upon the submittal of
a new record.

Licensed Professional The licensed professional section lets users enter contractor, architect, engineer, or
developer (CAED) information. The state usually provides this information, including the
license number and license type.

If you set the Display, Required, and Validate parameters in this section to Yes, Civic
Platform validates whether a user adds licensed professional information to the People
tab upon the submittal of a new record.

Applicant The applicant section lets users enter information about the individual or institution who
submits the form. If you set the Validate and Required parameters in this section to Yes,
the Validate button displays in this section. All other sections of the form are inactive,
and the user must complete the Applicant section and click the Validate button to
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activate the other sections. You cannot activate this section if you activated the Multiple
Contacts section.

If you set the Display, Required, and Validate parameters in this section to Yes, Civic
Platform validates whether a user adds applicant information to the People tab upon the
submittal of a new record. If you specify a default value for this section, Civic Platform
also validates whether a user adds the required type of applicant.

Contact 1Contact
2Contact 3

Up to three Contact sections on a form let users enter information about billing, legal,
and any additional contacts.

If you set the Validate and Required parameters in any Contact section to Yes, the
Validate button displays in the section. All other sections of the form are inactive, and
the user must complete any Contact sections and click the Validate button to activate the
rest of the form.

If you set the Display, Required, and Validate parameters in this section to Yes, Civic
Platform validates whether a user adds contact information to the People tab upon the
submittal of a new record. If you specify a default value for this section, Civic Platform
also validates whether a user adds the required type of contact.

NOTE: You cannot activate this section if you activate the Multiple Contacts section.

Multiple Contacts Set the Display option to Yes to display multiple contacts as a list and to allow users to
add more than three contacts. From the list of contacts, users can set a primary contact
and can search for, add, and delete contacts.

When you activate the Multiple Contacts section, you cannot activate the Applicant and
Contact 1, Contact 2, and Contact 3 sections.

If you set the Validate and Required parameters in this section to Yes, the Validate
button displays in this section. All other sections of the form are inactive, and the user
must complete the section and click the Validate button to activate the other sections. If
you set the Required parameter to Yes and Validate to No, Civic Platform only enforces
the Required parameter.

Note:

Multiple Contacts require the intake form available in Civic Platform 6.5. To get
this form contact Accela Customer Support and request the Civic Platform 6.5.0
Migration Document for application intake form consolidation (07ACC-03396) to
migrate to the new intake form.

If you set the Display, Required, and Validate parameters in this section to Yes, Civic
Platform validates whether a user adds contact information to the People tab upon the
submittal of a new record. If you specify a default value for this section, Civic Platform
also validates whether the user added the required type of contact.

Complainant Information The complainant section lets users enter information to identify an individual or institution
who registers a complaint. Only include this section for intake forms that you use in the
code enforcement module.

NOTE: The complaint and complainant sections of a SmartChoice group only work
with Classic Administration - Daily User. They do not work in V360. Best practice is
to configure Complaint and Complainant fields in Application Specific Information or
Application Specific Information Tables for the enforcement record types.

Complaint Information The complaint section lets users enter a description of a complaint, including the
reported address. Only include this section for intake forms that you use in the code
enforcement module.

NOTE: The complaint and complainant sections of a SmartChoice group only work
with Classic Administration - Daily User. They do not work in V360. Best practice is
to configure Complaint and Complainant fields in Application Specific Information or
Application Specific Information Tables for the enforcement record types.
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Additional Information The additional information section lets users enter information that the U.S. Census
Bureau requires in a C404 report. This report, also known as the “Report of Privately-
owned Residential Building or Zoning Permits Issued,” surveys new residential units,
additions, and alterations.

Application Status Click Yes to display the Application Status. Civic Platform displays the Application Status
based on the Application Status Group assigned to the Application Type. Click No to
hide the Application Status.

Application‑Specific
Information

The application-specific information section enables you to enter custom information
specific to your agency.

Associated GIS Features For information about GIS, refer to the Accela Civic Platform GIS Administrator Guide.

If you set the Display and Required parameters in this section to Yes, Civic Platform
validates whether a user adds GIS features to the Map Objects section on the Location
tab upon the submittal of a new record.

Structure The structure section lets users enter information about any structures under
construction. For example, “Twin Pines Mall.”

Establishment An establishment is a business or residence that occupies space in a structure. For
example, users can enter information about a store in a mall.

Event The event section lets users access an existing calendar and schedule an event related
to the intake form.

Asset Click Yes to display the Asset Section in a new permit intake form.

Click No to hide the Asset Section in a new permit intake form.

If you set the Display and Required parameters in this section to Yes, Civic Platform
validates whether a user adds asset information to the Assets tab upon the submittal of a
new record.

Application- Specific Info
Table

Click Yes to display the ASI Table section in a new permit intake form.

Click No to hide the ASI Table section in a new permit intake form.

Documents The documents section lets users attach documents, such as building plans or an
insurance bond, to a permit application. The value you enter in the Default Value field
indicates the number of documents users can attach. You can configure the maximum
number of documents or set a fixed number of documents in the Default Value field. If
you set the Default Value to null, there is no limit to the number of documents you can
allow users to add to a permit application.

To set a maximum number of documents, enter “<=#” in the Default Value field. For
example, if you want to set the maximum number of documents at 10, enter <=10. You
can also set a maximum number of documents by entering <# For example, if you want
to set the maximum number of documents at 10 or fewer, enter <11. To set a fixed
number of documents, enter “=#” in the Default Value field. For example, if the fixed
number of documents is 5, enter =5.

If you set the Display and Required parameters in this section to Yes, Civic Platform
validates whether a user adds a document to the Attachments tab upon the submittal of
a new record.

Education This section lets users enter the Education credentials of a licenced professional.

Continuing Education This section lets users enter the Continuing Education credentials for a licenced
professional.

Examination This section lets users enter the Examination details of a licenced professional.

Comments This section lets users enter any additional description or details about the application.
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Searching for a SmartChoice Group
To edit an existing SmartChoice group, you first need to find the group in your system. To see a list of all
SmartChoice groups, click Submit without entering the details about an individual group.

To search for a SmartChoice group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > SmartChoice Group.

3. Enter the name of the group that you want to find in the Group Name field.

4. Click Submit.

Civic Platform displays the SmartChoice Group browse page.

5. Click the red dot that appears next to the group that you want.

Editing a SmartChoice Group
After you set up a SmartChoice group, you might need to change certain details about it. You can change
the standard sections that you want to display in a group, as well as change the required and validation
status of each section.

You cannot change the group name.

To edit a SmartChoice group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > SmartChoice Group.

Civic Platform displays a list of SmartChoice groups.

3. Click the red dot by the SmartChoice group that you want to edit.

Civic Platform displays the SmartChoice Group Details-Edit page.
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4. Update the values for each section of the application as defined in Table 48: SmartChoice Group
Parameter Settings and Table 49: Intake Form Fields and Sections.

5. Click Save.

Working with Virtual Folder Groups
When you upload an attachment in Civic Platform, the user who uploads the attachment can select from
a pre-defined list of folders or create a new virtual folder as appropriate. However, Citizen Access users
can only select from the pre-defined virtual folder group to upload attachments. Assignation of attachments
to virtual folders serves the same purpose as an actual folder: It allows users to organize uploaded
attachments into groups (folders), making it easier to keep track of those attachments.

You can create as many virtual folders and folder groups as you need, by creating standard choices (virtual
folder groups) with the desired values (virtual folders) you want to use. You can then associate each virtual
folder group with a corresponding record type.

Note:

Existing users with file upload permissions (FID 8212) can edit the virtual folder settings.

Topics
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• Accessing the Virtual Folder Group Settings

• Creating a New Virtual Folder Group

• Viewing or Editing a Virtual Folder Group

• Assigning a Virtual Folder Group to a Record Type

Accessing the Virtual Folder Group Settings

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Expand the module you want to work with by clicking the down arrow on the right side of the module
bar.

A list of existing record types displays.

3. Select the record type for which you want to create a virtual folder group by clicking the record type
alias hyperlink. If you have a large number of record types, you can use Search to locate the desired
record type by name.

The record type summary displays.

4. In the left panel, click Other Associations.

5. From the list of associations at the top of the window, click Virtual Folder Group.

Civic Platform displays the Virtual Folder Group settings.

Creating a New Virtual Folder Group
You can add new virtual folder groups directly from the Record Type Administration portlet.

To create a new virtual folder group

1. Access the Virtual Folder Group Settings (Accessing the Virtual Folder Group Settings).

Civic Platform displays the Virtual Folder Group settings.

2. Click Create New Virtual Folder Group.

The New Standard Choice form displays in a new window.

3. Enter the name of the new virtual folder group you are creating in the Standard Choices Item Name
field.
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4. Describe the folder group you are creating; enter usage and relevant information.

5. In the Status field, select Enable.

6. In the Type field, select Business Configuration.

7. Select Virtual Folder from the drop-down list below the Type field.

8. Click Submit.

Civic Platform creates the new Virtual Folder Group. Now you must add virtual folders to your group.

9. Click Add at the bottom of the window (below the Standard Choices Value banner).

The Add Standard Choices Value form displays in a new window.

10.Enter the name of the virtual folder you want to add to the group in the Value field.

11.In the Value Desc field, describe the folder group you are creating; enter usage and relevant
information.

12.In the Status field, select Enable.

13.Click Submit.

Civic Platform adds the new folder below the Standard Choices Value banner.

14.Repeat from for each folder you want to add to the group.

15.When you finish adding folders, click Update to save your new virtual folder group and folders.

16.Close the window and return to the Virtual Folder Groups section of the Other Associations tab on the
Record Settings portlet.

17.Click Refresh  .

The new virtual folder group is now available for assignment to a record type in the drop-down list to the
far left.

Viewing or Editing a Virtual Folder Group
You can access virtual folder group details directly from the Record Type Administration portlet.

To view or edit Virtual Folder group details

1. Access the Virtual Folder Group Settings (Accessing the Virtual Folder Group Settings).

Civic Platform displays the Virtual Folder Group settings.

2. Select the virtual folder group you want to view/edit.

3. Click the View/Edit link to the right of the field.

The Standard Choices Item - Edit window displays.

4. Make modifications to the settings as needed.

5. click Update if you made changes, then close the window.

Assigning a Virtual Folder Group to a Record Type
To make virtual folders available for use to users, you must assign the appropriate virtual folder group to
each record type. You can create a unique virtual folder group for each record type. You can also assign
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a single virtual folder group to multiple record types. You cannot, however, assign multiple virtual folder
groups to a single record type.

To assign a virtual folder group to a Record Type

1. Access the Virtual Folder Group Settings (Accessing the Virtual Folder Group Settings).

Civic Platform displays the Virtual Folder Group settings.

2. Select the virtual folder group you want to associate with the current record type.

If you do not see the virtual folder group you need, you might need to add it. See Creating a New Virtual
Folder Group for information about adding a new virtual folder group.

3. Click Save in the left side panel, near the bottom.

Civic Platform assigns the selected virtual folder group to the current record type. Folders contained
within are available to users when they upload documents to records of the current type.

Associating Record Types
You can define record types that are dependent on other record types. A use case example for this is:
when public users pay fees for a record type in their shopping cart, they must also complete the application
or renewal for the dependent record types. Otherwise, the user receives a payment failure message.

For instance, a nurse applies for a nurse practitioner license, and their registered nurse license expires.
Upon check-out for the nurse practitioner license, the nurse sees on the cart page a payment failure
message informing them that they must renew and pay for the registered nurse license. After renewing and
paying for the registered nurse license, the nurse can pay for both types of licenses in the shopping cart.

When nurses renew and pay for their registered nurse licenses, they see an associated nurse practitioner
license link for application on the receipt page in the shopping cart.

To associate record types

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Expand any module to reveal the associated record types.

3. Locate the record type you want to work with.

4. Click the Other Associations portlet.

5. Locate the Associated Record Types section.

6. Do any of the following to define a record status for the selected record type:

• To define the selected record type with no status, click the No Status link.

• To define the selected record type with a status group, click the status group link.

If you do not see any status group other than theNo Status link, customize the Status Group
section. For more information about Status Group, see Working with Application Status Groups.

• To define the selected record type with a specified record status, do the following:

a. Expand the desired record status group to display the statuses within that group.



 | Part 3: Configuring Agency Business Objects | 251

b. Click any of the record status.

Civic Platform displays the Record Type List.

7. Select the Record Type you want to associate.

8. Click Select.

An information pops up.

9. Click OK.

Civic Platform associates a record type with another record type.
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10.Click Save.

Setting Default Clone Options
You can define default clone options that display when users invoke Clone Sgl and Clone Mult.

Note:

The Default Clone Options portlet must be enabled (FID 0367) before you can set default clone options by
record type.

To set default Clone Options

1. Access the V360 Administration portlet.

2. In the Setup panel, select Application > Default Clone Options.

The Default Clone Options portlet displays.

3. Select the record type for which you want to set default clone options.

You can use either the tree view to drill down to the record type you want to use. You can also click
Search to locate the record type you want.

A list of data options displays.
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4. Select which data you want to copy from the source record to the destination record. You can select a
single option or multiple options.

If you select an option that has a Select link, use the link to drill down to more specific data. For
example, you can click the Select link for Contact to select which contact types you want to copy.

5. Click Save.

Managing Documents for Attachments

• Creating a Document Group

• Searching for a Document Group

• Editing a Document Group

• Working with Document Types

• Setting Required Document Types

Creating a Document Group
A document group lets you organize the different types of documents that users might need to add to
certain applications. When you create a new document group, you determine the group name and add an
initial document type to the group. You can add more document types to the group when you edit it.

To create a document group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Review > Document.

3. Click Add.

Civic Platform displays the Document Type Add page.
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4. Create a new document group by providing a name in the New Group field.

5. Add Document Types to the Document Group. For specific instructions on how to add document types,
see Adding a Document Type.

Searching for a Document Group
You can search for any document group currently defined on your system. For example, you can search
for a document group if you want to add or update document types, or if you want to view the details for a
certain group. To see a list of all document groups in alphabetical order, click Submit without entering any
information in the search field. You can also enter partial information to perform a partial search.

To search for a document group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Review > Document.

3. Enter the group name in the Select Group field.

4. Click Submit.

Civic Platform displays the Document Group—Browse page.

5. Click the red dot that appears next to the group that you want.

Editing a Document Group
After you create a document group, you might need to change it. When you edit a document group, you
can change any of the document types that make up the group. After you create a document group, you
cannot delete the group without first deleting all document types that make up the group. When you delete
the last document type, Civic Platform automatically deletes the group.

To edit a document group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Attachments > Documents.

3. Search and select the document group you want to modify.
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4. To add, edit, or delete an additional document type, see Adding a Document Type.

5. ClickSubmit.

Working with Document Types
This section provides instructions on how to work with document types associated with a document group
and, if your agency uses Citizen Access, define how to apply permissions to public users for the document
type.

Topics

• Adding a Document Type

• Editing a Document Type

• Deleting a Document Type

Adding a Document Type
After you create a document group, you can add document types to the group. The document types that
you set up apply to both the electronic and non-electronic documents, and determine how users categorize
the documents associated with an application. If your agency uses Citizen Access, you must indicate
which public users have permissions to view, upload, and delete the document type attachment online.
The public user types include: All Citizen Access users (including anonymous users), registered users,
Licensed Professionals, Record Creator, Contact, and Owner. Administrators can specify which licensed
professionals can upload, delete, or view the document type by clicking the License Type button and
selecting the appropriate options. If you want to restrict access to a specific document, navigate to the
document tab for the record and assign additional permission settings. For instructions on how to restrict
access to a specific document, see “Defining Citizen Access Permissions for a Document” in the Accela
Civic Platform User Guide.

To add a document type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Attachments > Document.

3. Search for the document group that you want.

4. Click Add.

Civic Platform displays the Document Type-Add page.
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5. Complete one of these fields to define the document group code:

Select Group Choose an existing document group.

New Group Type in what you want to name the new group.

Note:

You should not enter a new group name here unless you want to create a new group as well as a new
document type. When you choose an existing group, Civic Platform automatically populates this field with
your choice, because this field is a required field.

6. Complete the document type fields as described in Document Type Fields.

If you want to specify the licensed professional types allowed to upload, delete, or view the document
type in Citizen Access, click Licensed Professional, indicate the specific licensed professional types,
then click Select.

7. Click Submit.

Table 50: Document Type Fields

Checklist Group Select a checklist group for the document type. Upon a successful upload of a
document, if a checklist group is associated with the document type of the document,
Civic Platform automatically adds the Auto Create checklists in the checklist group as
the document review checklist for the document. Users can add more checklists or
checklist items for the document review if they want. The steps to configure checklists
and checklist groups for document reviews are the same as configuring checklists
and checklist groups for inspections. For more information, see Managing Checklist
Groups.

Comment Enter any comments or notes about the document type.
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Deletable in Citizen
Access

Select which public users have permission to delete the document in ACA.

Document Group Document Group is a read-only field that displays the name of the Document Group for
the Document Type.

Document Type Enter the document type that you want to include in the group.

Download Automatically
to Accela Wireless?

Select Yes if you want to download files of this document group automatically to Accela
Wireless; otherwise, select No.

Downloadable in Citizen
Access

Select the users for which you want to grant permission to download the documents
of this document type. When you select Licensed Professional, click the License Type
button to select the desired licensed professionals.

Set Permissions for
Citizen Access

Select Yes to grant permission on documents of this document type to Citizen Access
users; otherwise, select No.

Uploadable in Citizen
Access

Select those individuals for which you want to grant permission to upload documents
of this document type. When you select Licensed Professional, click the License Type
button to select the desired licensed professionals. For users without Title Viewable
in Citizen Access permission, if you grant this permission to them, they can upload
documents of this document type, but they cannot view them in the document list.

Title Viewable in Citizen
Access

Select those individuals for which you want to grant access to view the document titles
of this document type. When you select Licensed Professional, click the License Type
button to select the desired licensed professionals. Note: Those users without this
permission consequently cannot download or delete documents of this document type,
even though they have the downloadable and deletable permissions.

Editing a Document Type
After you add a document type to a document group, you might need to change it. You can update type
name as well as any comments about it. If you no longer want to include the document type in the group,
you can delete it.

To edit a document type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Review > Document.

3. Search for the document group that you want.

4. Click the red dot that appears next to the document type that you want.

Civic Platform displays the Document Type-Edit page.

5. Complete the necessary fields as described in Document Type Fields.

6. Click Submit.

Deleting a Document Type
You can delete any document type in a document group. After you delete the last document type in a
group, Civic Platform automatically deletes the group. Civic Platform prompts you when this happens and
gives you the option to cancel the deletion of the document group.

To delete a document type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Review > Document.
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3. Search for the document group that you want.

4. Click Delete to the right of the document type that you want.

5. Click OK.

Setting Required Document Types
Agencies can configure Civic Platform to require certain documents when an agency user submits a
new application of a given type. Agencies can also configure document requirements when a public user
submits a new application of a given record type via Citizen Access or Mobile Office. Agencies can also
configure Civic Platform to require certain documents before a workflow task status change occurs.

You can access the Required Document Setting form both from the Administration tool in Civic Platform
and from the Citizen Access Setup form. The following procedure describes how to access the Required
Document Setting from the Administration tool.

The Role of Scripting in Required Document Functionality
Agencies can use existing EMSE scripting functionality to require documents dynamically as part of new or
existing record processing. For example, agencies can create a script that auto-applies a notice condition
that prompts for the required documents after a new application submission (ApplicationSubmitAfter)
or after a workflow status update (WorkflowTaskUpdateAfter). Agencies can also create a script
(DocumentUploadAfter) that clears required document conditions once required documents get uploaded.
Agencies may have more complex document submission requirements. For example, agencies may
configure a page flow in Citizen Access Administration to prompt for or validate required documents
by associating scripts to the OnLoad or OnSubmit event in the relevant step. Agencies can write the
script to block or not to block the page flow if a validation fails. For existing records, agencies can
use scripting to enforce or prompt for required document submissions against various business rules
for events like workflow status update (WorkflowTaskUpdateAfter) or application specific info update
(ApplicationSpecificInfoUpdateAfter).

Setting Required Document Types by Record Type
When you set required documents, the list of required documents displays on the application intake
form when a user adds a new record from Civic Platform, Citizen Access, or Accela Mobile Online. This
informs the user which documents he must prepare and submit. If the user does not attach the required
documents, he cannot submit the application.

Note:

If EDMS is not accessible from Citizen Access, the public user may be able to submit his application without
the required documents.

Before you can set required documents, you must have the following in place:

• The desired document group code and assigned documents types for that group code must exist
and have an association with the record type you are working with. See Managing Documents for
Attachments.

• The document group code to which you apply required document settings must be consistent for both
Civic Platform and Citizen Access, if the record type you are working with is available to both Civic
Platform and Citizen Access.

To set required document types by record type

1. Access the Record Type Administration portlet (Accessing Record Type Administration).
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2. Expand the module you want to work with by clicking the down arrow on the right side of the module
bar.

A list of existing record types displays.

3. Select the record type for which you want to set required document types by clicking the record type
alias hyperlink. If you have a large number of record types, you can use Search to locate the desired
record type by name.

The record type summary displays.

4. In the left panel, click Other Associations.

5. From the list of associations at the top of the window, click Document Code.

Civic Platform displays the Document Code settings. A document group code must be assigned to
the record type you are working with. If not, you must assign a document group code. See “Managing
Documents for Attachments” for more information about assigning or changing a document group code.

6. Click the View Edit link for Required Document Types.

The Required Document Setting form displays.

7. To set required documents for new record submission:

• Click the picker to the right of Required for New Record Submission. A widget displays a list of
documents included in the selected document group.

• Select the document type(s) that your agency wants to require as part of a new record submission.
If needed, you can mark Select All to require all the listed documents. The selected document types
display in the Required for New Record Submission box.

8. To set required documents for a workflow task status update:

• Click the picker to the right of Workflow Task/Status Check.

• Select each task status for which you want to require a document submittal.

• Each time you select a task status, Civic Platform adds a new row to the Required for Workflow
Status Update list. In the example below, we selected three workflow status options. Civic Platform
added three rows - one for each status option - for you to configure individually.
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9. Click outside the widget to exit the widget and interact with the new rows.

10.Click the picker to the right of the Document Types box for one of the workflow task/status check rows.

A widget displays the list of document types for the selected document group.

11.Select the document type(s) that your agency wants to require before the workflow can advance with
the selected status. If needed, you can mark Select All to require all the listed document types.

The selected document types display in the Document Types box.

12.Repeat the previous two steps for each workflow task you have listed.

13.Click Save.

Configuring Third Party Plan Review Integration

• Preparation

• Mapping Data for Third Party Document Review

• Preparing Document Types

• Other Admin Configuration
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Preparation
Before proceeding with the configuration to enable third party plan review integration, agencies must do the
following:

• Configure a Civic Platform user account for third party use.

• Include all permissions for the user account that are needed to complete a document review task, such
as review status update and check-in.

• Designate an API account for the third party application. This account will be dedicated for API calls.
Make note of the account name/password, and the web application URL.

• Configure the following standard choices: EXTERNAL_DOC_REVIEW (used to define connectivity and
authentication of the third party plan review tool, as well as enable the mapping portlet for the named
plan review tool), and EXTERNAL_REVIEWERS (used to accommodate plan reviewers who are not
Civic Platform users).

Use this Civic Platform user account information along with the URL for Civic Platform API access to
configure the connectivity to Civic Platform in the third party software. Refer to the third party software
documentation for more information.

Mapping Data for Third Party Document Review
To integrate the Civic Platform with a third party document review tool such as EPC, agency administrators
need to map data elements (fields) that are common to the Civic Platform and the third party document
review application. A data mapping tool is available to help you do that. After you configure the standard
choice EXTERNAL_DOC_REVIEW, this data mapping tool is enabled.

Topics

• Accessing the Third Party Mapping Tool

• Mapping Record Types

• Mapping Record Statuses

• Mapping Departments

• Mapping Construction Types

• Mapping Contact Types

Accessing the Third Party Mapping Tool
Configure the standard choice EXTERNAL_DOC_REVIEW to make this tool available in the Administration
portlet.

1. Open the Civic Platform Administration tool.

2. In the Setup panel, select Document > 3rd Party Integration.

Mapping Record Types
Use the record type mapping tab on the 3rd-Party Integration portlet to map Civic Platform record types to
key fields in the third party review tool, such that the sum of the fields is equivalent to the Civic Platform
record type.

Example: Map the Civic Platform record type “Building/Commercial/New Building/With Plans” to ePlanSoft
(EPC) field values for Project Type=New Building, Permit Type=With Plans, and Occupancy=Business.
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When a plan is assigned for review in Civic Platform, the Civic Platform record type displays. When the
same plan is opened in EPC, the field values for Project Type, Permit Type, and Occupancy display as you
mapped.

Note:

When mapping values between Civic Platform and EPC, note that EPC permit type options display as string
values rather than as the associated labels for each value. This is because the Create Permit EPC API
accepts the EPC Permit Type string value, not its key, as the required parameter. Other EPC field values
display label values.

To map record types

1. Access the third party mapping tool (see Accessing the Third Party Mapping Tool).

2. Select the Record Type Mapping tab.

3. Click New.

The record type mapping form displays.

4. Select the Civic Platform record type you want to map.

A record type picker is available to the right of the Record Type field. Use it to locate and select a
record type.

5. For each of the following fields in the third party tool, select a value such that, when the three are
combined, they form an equivalent value to the selected Civic Platform record type. If none of the
defined project or permit types on EPC properly map to the selected Civic Platform record type, select
Add New to add new project or permit type values on EPC.

3rd-party Project Type Type of project, such as Commercial or Residential. If you add a new ‘Project
Type’ value (select Add New), Civic Platform uses the subtype string value for
the selected Civic Platform record type as the new ‘Project Type’ value to add
to EPC.

3rd-party Permit Type Type of permit being requested, such as Deck or Roof.If you add a new
‘Permit Type’ value (select Add New), Civic Platform uses the category string
value for the selected Civic Platform record type as the new 'Permit Type'
value to add to EPC.

3rd-party Occupancy Use of building, such as Factory/Industrial or Residential.

6. Click Submit.

Mapping Record Statuses
Use the record status mapping tab on the 3rd-party Integration portlet to map Civic Platform record status
to equivalent status values in the third party review tool.

To map record statuses

1. Access the third party mapping tool (see Accessing the Third Party Mapping Tool).
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2. Select the Record Type Mapping tab.

3. Select an existing record type mapping from the list.

The mapping page displays for the selected record type mapping.

4. Select the Record Status Mapping tab.

5. Click New.

A blank row is added to the record status mapping list.

6. Select a Civic Platform record status value from the drop-down list on the left.

7. Select a corresponding third party permit status type value from the drop-down list on the right.

8. Click Submit.

9. To map an additional record status, click New and repeat this process.

Mapping Departments
Use the department mapping tab on the 3rd-party Integration portlet to map Civic Platform department
names to equivalent department values in the third party review tool.

To map departments

1. Access the third party mapping tool (see Accessing the Third Party Mapping Tool).

2. Select the Department Mapping tab.

3. Click Add.

A blank row is added to the department mapping list.

4. Select a Civic Platform department value from the drop-down list on the left.

5. Select a corresponding third party department value from the drop-down list on the right, OR

Select Add New to automatically add the Civic Platform department string value to EPC.
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Note:

The Add New option enables agencies to automatically build the same department structure on EPC as
exists on Civic Platform without having to manually input the departments separately in EPC

Note:

Agencies should ensure that the department defined in the EPC user profile is the same one that maps
to the department to which the mapping AA user belongs. If the User ID and Department values are not
consistently defined, review task assignments will return an error

6. Click Submit.

7. To map an additional department, click Add and repeat this process.

Mapping Construction Types
Use the construction type mapping tab to map Civic Platform construction type values to equivalent
construction type values in the third party review tool.

To map construction types

1. Access the third party mapping tool (see Accessing the Third Party Mapping Tool).

2. Select the Construction Type Mapping tab.

3. Click Add.

A blank row is added to the construction type mapping list.

4. Select a Civic Platform construction type value from the drop-down list on the left.

5. Select a corresponding third party construction type value from the drop-down list on the right, OR

Select Add New to automatically add the Civic Platform construction type string value to EPC.

Note:

The Add New option enables agencies to automatically build the same construction types on EPC as
exist on Civic Platform without having to manually input the departments separately in EPC

6. Click Submit.

7. To map an additional construction type, click Add and repeat this process.

Mapping Contact Types
Use the contact type mapping tab to map Civic Platform contact type values to equivalent contact type
values in the third party review tool.

To map contact types



 | Part 3: Configuring Agency Business Objects | 265

1. Access the third party mapping tool (see Accessing the Third Party Mapping Tool).

2. Select the Contact Type Mapping tab.

3. Click Add.

A blank row is added to the contact type mapping list.

4. Select a Civic Platform contact type value from the drop-down list on the left.

5. Select a corresponding third party contact type value from the drop-down list on the right, OR

Select Add New to automatically add the Civic Platform contact type string value to EPC.

Note:

The Add New option enables agencies to automatically build the same contact types on EPC as exist on
Civic Platform without having to manually input them separately in EPC

6. Click Submit.

7. To map an additional contact type, click Add and repeat this process.

Preparing Document Types
Agencies need to confirm that the document types are properly configured for third party integration.
Agencies should ensure that the following are in place:

• If your agency is using EPC as your third party plan review tool, create a document type called Plan in
Civic Platform. Agency users must use this new document type, Plan, for any document or plan to be
reviewed in EPC. As you configure the Plan document type, be sure to configure the Document Status
Group and Review Status Group for the new document type.

• For both the Plan and Correction Notice Report document types, you need to ensure that public access
via the Citizen Access is enabled. Do this by choosing Yes for the ‘Set Permission for ACA’ option for
each document type.

Other Admin Configuration
Agencies need to:

• Confirm that Street Type values (for example, Ave or Blvd) match on both Civic Platform and
on the third party document review tool. In Civic Platform, street types are configured in the
STREET_SUFFIXES standard choice.
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Defining Custom Fields (Application Specific Information)
Application Specific Information (ASI) is a collection of custom fields you can create and apply to records,
contacts, documents, conditions, and checklists, to meet the specific business objectives of your agency.
Think of ASI fields as agency-defined fields that enable you to leverage the power of the Civic Platform’s
highly configurable architecture.

You can define the processes surrounding what happens when you create or modify ASI fields and
how those changes impact existing applications. You can configure the ability to globally change ASI
groups for applications already existing in your Accela system, regardless of the application’s status. This
includes completed applications, applications that are moving through a workflow, or partially completed
applications, submitted through Citizen Access, whose application type matches the ASI group code.

If your agency has Citizen Access, you can customize certain components of its user interface by
configuring ASI details. You can design pop-up windows, write instructional text, configure the text and size
for labels, change page flows and display order, and add watermarks for ASI tables and fields. You do this
by configuring the Citizen Access sections of ASI groups and subgroups; see Designing ASI Layouts for
Citizen Access.

To reuse the same custom fields in various record types, you can create ASI groups and subgroups.

Click a topic title below for full details.

Related Links

Working with ASI Groups and Subgroups

Auto Filling ASI Fields with GIS Object Attribute Values

Designing ASI Layouts for Citizen Access

Working with ASI Group Fields

ASI Lookup Tables

Working with ASI Groups and Subgroups

• Creating New ASI Fields

• Searching for an ASI Group

• Working with ASI Subgroups

Creating New ASI Fields
Use the procedure below to create custom ASI fields. When you create a new ASI group, you specify the
group code, the name, and the first field you want to include in the group. You can set up other information
about the field, including the field type and a default value. You can set up additional fields, change
the order of fields in the group, and change any values when you edit the ASI group. When you make
modifications to an ASI group, you have the option to include the display of the newly added group or field
to existing records.

To create an application specific information group

1. Go to Civic Platform Administration > Setup Portlet > AA Admin.

2. Expand the appropriate module, then click the link for the record type you want to work with.

3. Click Other Associations.
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4. Navigate to the Application Specific Info Group section.

5. Click Create New Application Specific Info Group.

Civic Platform displays the application specific Information—Add page.

6. Complete the fields that display. For a description of the fields, see Table 51: Application Specific
Information Group Fields.

7. Click Submit.

Searching for an ASI Group
To view or edit an existing application specific information group, you must first locate the group you want.

To search for an application specific information group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > App Specific Info.

Civic Platform displays the application specific Information Search page.

3. Complete these fields:
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Application Specific Info
Group Code

Enter the group code associated with the application specific information group you
want. If you use V360, this group code is what defines the available fields for creating
custom screens.

Application Specific Info
Subgroup

Enter the code associated with the subgroup you want.

Note:

To see a list of all groups, click Submit without entering group details.

Civic Platform displays the Application Specific Info—Browse page.

4. Click the red dot beside the group you want.

Civic Platform displays the Application Specific Info Group Code—Edit page.

Working with ASI Subgroups
For each application specific information group code, you can delete or arrange the display order of
subgroups. You can create new subgroups, edit existing subgroups, and add them to the group code.

If your agency provides Citizen Access, you can perform ACA-specific configuration tasks including:
designing the layout of information and instructional text, setting the display of a pageflow, and arranging
the display order. You can do this through the Citizen Access Configuration for the ASI subgroup. For more
information, see Designing ASI Layouts for Citizen Access.

Topics

• Updating the Subgroup Display Order

• Deleting a Subgroup from a Group Code

• Creating a New Subgroup for a Group Code

• Adding an Existing Subgroup to a Group Code

• Editing a Subgroup
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Updating the Subgroup Display Order
You can update the display order of a subgroup.

To update the subgroup display order

1. Locate the ASI group you want to work with. For instructions, see Searching for an ASI Group.

Civic Platform displays the Application Specific Information Table-Edit and Manage Subgroups page.

2. Enter the display order in the Display Order field.

For example, if you want a subgroup to be first in the display order, enter 1.

3. If you want to change the display order of a subgroup fields, click the red dot next to the subgroup you
want to modify.

Civic Platform displays the Application Specific Info Table page.

4. Enter the display order in the Display Order field.

5. Click Update.

Civic Platform updates the display information.

Deleting a Subgroup from a Group Code
If you no longer need a subgroup associated with an application specific information group code, you can
remove the subgroup.

To delete a subgroup from a group code

1. Locate the ASI group you want to work with. For instructions, see Searching for an ASI Group.

2. Select the Delete option next to each subgroup you want to remove.

3. Click Submit.

Creating a New Subgroup for a Group Code
You can create a new subgroup for an existing application specific information group code.

To create a new subgroup for a group code

1. Locate the ASI group you want to work with. For instructions, see Searching for an ASI Group.

2. Click New.

Civic Platform displays the Application Specific Info Group—Add page.

3. Complete any fields that display. For a description of the fields, see Table 51: Application Specific
Information Group Fields.

4. Click Submit.

Civic Platform adds the new subgroup, and then displays the Application Specific Info page.

Adding an Existing Subgroup to a Group Code
You can search for an existing subgroup and add it to a group code.

To add an existing subgroup to a group code

1. Locate the ASI group you want to work with. For instructions, see Searching for an ASI Group.

2. Click Add.
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Civic Platform displays the Application Specific Info Group Code—Add page.

3. Select the Group Code containing the existing subgroup you want to add.

Civic Platform displays all of the subgroups associated with the group code you selected.

4. In the Subgroups field, select the subgroup you want to add.

5. Click Add.

Civic Platform adds the selected subgroup to the group code you are working with.

6. Click Update.

Editing a Subgroup
After you create an application specific information group, you might need to update a subgroup that
belongs to the group. You can apply any changes you make to all subgroups. For information about
applying or updating user access security permissions to a subgroup, see Setting Up Security Policies.

To edit a subgroup

1. Search for the application specific information group with the subgroup that you want to edit. For
instructions, see Searching for an ASI Group.

2. Click the red dot beside the subgroup that you want to edit.

Civic Platform displays the Application Specific Information page.

3. Select whether to apply changes to this subgroup only or to all subgroups.

4. Update the fields that display. For a description of the fields, see Table 51: Application Specific
Information Group Fields.

5. Click Update.

Table 51: Application Specific Information Group Fields

ACA Configuration If your agency implements Citizen Access, click ACA Configuration to access the
Application Specific Info Field - Edit page. Then complete the configurations to design
the Citizen Access form display for the group. For more information, see Designing ASI
Layouts for Citizen Access.

ACA Displayable This option controls the ability for users to view application-specific information in
Citizen Access. For example, users can view the property frontage information on a
planning application.

To allow users to have full or read only access to the application-specific information
in Citizen Access, set ACA Displayable to Yes, and configure the ASI Security
(Setting Up Security Policies) to full or read. Select No to hide the application-specific
information.Use the Hidden option for expressions when the value from a field not
displayed on the form becomes updated by the expression or the expression criteria
uses the value.
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ACA Searchable This option controls the ability for users to search for the application-specific
information in Citizen Access. For example, users can search for the property frontage
information on a planning application.

Select Yes to allow users to search by the application-specific information in Citizen
Access. Select No to hide the application-specific information from the search form.

There are four combinations of settings for the ACA Displayable and ACA Searchable
options:

If you select Yes for both options, the ASI field displays and is available for use in the
search form.

If you select Yes for ACA Displayable, but you select No for ACA Searchable, the ASI
field displays as read only in the search form.

If you select No for ACA Displayable and Yes for ACA Searchable, the ASI field does
not display in the search form. This is not a best practice configuration.

If you do not want the field to display in the search form, select No for both options. If
you select No for both options, the ASI field does not display in the search form.

Alternative ACA Label Enter a custom ASI field label to display to public users on web pages in Citizen
Access, to enable the agency to ask questions to an applicant during the application
intake process online. For example, you can change a field label from “Criminal
History” to “Have you or any member of your immediate family, including spouse,
children, parents, or siblings been convicted of a crime?”This field is available only
when you are adding a field to an ASI subgroup.

Application Spec Info
Group

Enter a unique code to identify the application specific information group that you are
creating. If you are creating a subgroup for an existing group code, Civic Platform
automatically populates this field with the group code that you are working with.

This field is read-only when you are editing a subgroup or adding a field to an ASI
group.

Application Spec Info
Subgroup

Enter the name of the subgroup you are creating.

This field is read-only when are editing a subgroup.

Application Spec Info
Subgroup Alias

Enter the subgroup alias. The alias replaces the subgroup name in all the areas that
the ASI subgroup displays to the users in Civic Platform, Citizen Access, and Mobile
Office.

Application Spec Info
Table

Choose the table group you want. You must create the table group before you can
choose it. For more information, see Working with ASI Tables.

Apply changes to all
subgroups

Choose this option if multiple groups contain the subgroup and you want to apply the
changes to the subgroup in all groups.

Apply changes to this
subgroup only

Choose this option if multiple groups contain the subgroup and you just want to apply
the changes to the subgroup in current group.

Default Value Enter a default value for the field. If you are adding an ASI group, this field defines the
default value for the first field in your application specific information subgroup.

Note:

If you are setting up a drop-down list, you can add values to the drop-down list
so that a user can choose from multiple values. For instructions, see Setting or
Editing Drop-Down List Field Values.

Display Len Specify the maximum number of characters that Civic Platform displays.

Display New ASI on
Existing Contacts

Select Yes to apply the new ASI field to existing contacts. Select No to apply the new
ASI field to new contacts only.

Display New ASI on
Existing Records

Select Yes to apply the new ASI field to existing applications. Select No to apply the
new ASI field to new applications only.
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If you cannot see the option, you must configure the related Standard Choice. Refer to
the Accela Civic Platform Configuration Reference for additional information.

Display new ASI on
existing Education/
Examination/Continuing
Education

Choose Yes to make the new user-defined field, table, or sub-group of user-defined
fields available to existing education, examination and/or continuing education records
in addition to being available for new records. Choose No to apply the new user-
defined objects to new records only.

Display Order Enter a number to determine the position of the field in a subgroup. If you are adding
an ASI group, this field determines the position of the first field in your application
specific information subgroup.

For example, to display the field before any other fields, enter 1.

Fee Indicator To use the field value in a fee calculation, enter the unique 5-digit code that you use
to identify this application-specific variable in the fee formula. You must use a value
between 10100 and 10599 and use the format displayed: $fixxxxx$For example, enter
$fi10101$

Field Type (or Type) Choose the type of field. If you are adding an ASI group, this field defines the type of
the first field in your application specific information subgroup. For more information on
field types, see Adding a Field to an ASI Group.

If the field type is a drop-down list, click Edit to update, add, or delete values from the
drop-down list. For instructions, see Setting or Editing Drop-Down List Field Values.

Field Label (or 1st Field
Label)

Enter the label of the field. If you are adding an ASI group, this field defines the label
for the first field in your application specific information subgroup.

For example, if you want to prompt end-users to specify a date, enter the word Date.

Group Display Order Enter a number to determine the position of this information group on the application
specific Information section of an application in Daily Activities. For example, if you
want this information group to display in the second position, enter 2.

Justification Use the drop-down list to determine the justification of the field value. If you display
Citizen Access in a Cyrillic font, which reads from the right side of the page to the
left, you can specify a text justification that takes into consideration the font direction.
The default setting uses left-alignment. If you cannot see any options, you must
configure the related Standard Choice. For more information about the justification,
see “Setting ASI Fields to Right Justification” in the Internationalization Installation and
Administrator Guide.

Location Query Select Yes to support populating the ASI fields with the map data from multiple GIS
layers. Select No to allow populating the ASI fields only with the map data from the
layer where the selected GIS object lies.

Max Len Specify the maximum number of characters that the field accepts.

Req for Fee Calc To require users to complete the Fee Calculation fields, click Yes or choose Yes from
the drop-down list.

Fields required for Fee Calculation display a visual indicator ($) on the permit
application form. You can configure this feature with Function Identification 0242
Required for Fee Calculation.

Required Flag (or
Required)

To require users to enter a value in this field, click Yes or choose Yes from the drop-
down list.

Searchable Flag (or
Searchable)

To let users search for applications based on this field, click Yes or choose Yes from
the drop-down list.

Status To let users see this group or this field in Civic Platform, click Enable or choose
Enabled from the drop-down list; otherwise, click Disable or choose Disabled.
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Supervisor Edit Only Select Yes or choose Yes from the drop-down list to make this information read-only to
non-supervisor users after a user creates an application. For instructions, see Limiting
ASI Editing Rights.

Unit or New Unit Enter any desired unit such as square feet, dollars, or miles that you want to attach to
the field value. Choose from Standard Choices, or enter a new unit.

Note:

If you are editing an ASI subgroup, you cannot enter a new unit.

Auto Filling ASI Fields with GIS Object Attribute Values
Civic Platform can automatically populate ASI fields in an application intake form with GIS object attribute
values when a user attaches a GIS object to the application intake form. GIS objects may represent assets
or parcels on the map.

• Enabling ASI Field Auto-Filling

Enabling ASI Field Auto-Filling
To enable ASI field auto-filling in Civic Platform

1. Create a mapping relationship where attributes of GIS objects on the various map layers are mapped to
specific ASI fields.

For instructions, see “Creating Attribute Mapping” in the Configuring Civic Platform section of the Accela
Civic Platform GIS Administrator Guide.

2. If you want to automatically populate application specific information fields with attribute values of the
GIS object that represents an asset, map each asset in Civic Platform to a GIS object in the legacy
Accela GIS.

Skip this step if you only need to automatically populate application specific information fields with
attribute values of the GIS object that represents a parcel.

For instructions, see Asset Types for detailed information.

3. Make sure the application contains the application specific information fields for which you have created
attribute mapping by associating the application type with the ASI group code.

4. Do any of the following:

• Launch the map viewer from the main console or the Record list portlet, select a GIS object that
represents an existing asset in the Civic Platform database, and perform the Create New Record,
Create Single Work Order, or Create Multiple Work Orders command.

• Look up an existing parcel that you can plot on the map and add it to the Parcel section.

• Launch the map viewer from the Parcel section, select a GIS object that represents an existing
parcel in the Civic Platform database, and perform the Send GIS Features command.

• Look up an existing asset that you can plot on the map and add it to the Asset section.

• Launch the map viewer from the Asset section, select a GIS object that represents an existing asset
in the Civic Platform database, and perform the Link Object to Work Order command.

• Launch the map viewer from the Associated GIS Features section, select a GIS object that either
represents an existing parcel or asset, and perform the Send GIS Features command.
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Note:

If you attach multiple parcels, assets, or associated GIS features to an application at a time, a dialog
box prompts you to set one item as primary. The ASI fields get the corresponding values from the
attributes of the primary GIS object.

Civic Platform uses the attributes from the GIS object in the new application form.

Designing ASI Layouts for Citizen Access
If your agency provides Citizen Access, you can customize the layout and display of ASI fields on your
Citizen Access page. You can design instructional text, labels, field arrangements, page flow configuration,
display order, and you can add watermarks for ASI tables and fields. You can configure this through the
Citizen Access configuration section of the ASI group and subgroup. For additional information on how
to design a form layout for Citizen Access, refer to the “Working with Web Pages” chapter in the Citizen
Access Administrator Guide.

Topics

• Defining ASI Layouts for Citizen Access

• Customizing Fields for Citizen Access

Defining ASI Layouts for Citizen Access
Civic Platform ASI configurations provide the ability to define online form displays. For example, you
can set the display order in a page flow, add supportive text, and you can design layouts for labels and
columns. This section provides the instructional text to help you define the ASI layouts for Citizen Access.

Note:

When you hide ASI fields using expressions on a page for a subgroup, Citizen Access re-aligns the
displayable fields appropriately. There is no indication of a missing or hidden field.

To design a layout for Citizen Access

1. Locate the application-specific information group and associated subgroups that you want to design for
Citizen Access. For instructions, see Searching for an ASI Group.

Civic Platform displays the group and subgroup information.

2. Click ACA Configuration next to the group or subgroup requiring layout configuration.

Civic Platform displays the Layout Configuration pop-up page.

3. Complete the fields as described in Table 52: ASI Group and Subgroup Layout Configuration Fields.
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4. Click Save.

Table 52: ASI Group and Subgroup Layout Configuration Fields

Column Arrangement This field becomes active when you choose to provide the ASI group information in
a two column layout. Use the drop-down menu to define how you want to display the
subgroup information. Choices are vertical and horizontal. Choose Vertical if you want
information to display down the page first, then to flow to the next column. Choose
Horizontal if you want information to flow across the page horizontally, row by row.

Note:

This setting only applies to the application page flow, and does not apply to
the Record Detail page and Record Review page.

Column Layout Use the drop-down field to set how the fields display in a column. Choose single
column layout or two-column layout for the ASI subgroup fields in the application page
flow, the Record Detail page, and the Record Review page in Citizen Access.

Field Arrangement This field is active when you choose to provide the ASI subgroup fields in a two-column
layout. Use this drop down list to determine if the fields display from left to right or top
to bottom arrangements. For example, if you number the fields 1-6, fields 1, 3, and 5
display in the left column; fields 2, 4, and 6 display in the right column for left to right
alignment. In the top to bottom arrangement, fields 1,2, & 3 in left column and 4, 5, and
6 in right column.

Instructions Use this text field to enter any accompanying instructional text for the group or
subgroup. This field supports embedded hyperlink functionality.

Label Display Specify where you want to position the field label in relation to the field. Choose Top for
the label display to be above the field. Choose Left to have the label to the left of the
field.

Note:

This setting only applies to the application page flow, and does not apply to
the Record Detail page and Record Review page.

Page Index This configuration determines if the information displays on one or more pages in
a pageflow in Citizen Access Set the display order for ASI subgroup information in
pageflow by entering a number in the Page Index field. For example, if all subgroups
have a Page Index number of 1, then all the subgroups display on one page in Citizen
Access. If you want the subgroups split up onto different pages, enter the appropriate
number for each subgroup page a configured sequence. For example, 2 indicates a
second page, 3 indicates a third page, and so forth.

Customizing Fields for Citizen Access
Use the Citizen Access Configuration page to define the online field labels, provide instructional text, or
create watermarks for application specific fields. This section provides details to help you to customize
fields for Citizen Access. For more information on how to customize fields for Citizen Access, refer to the
“Working with Web Pages” chapter in the Citizen Access Administrator Guide.

Note:

When you hide ASI fields, Citizen Access re-aligns the displayable fields appropriately. There is no
indication of a missing or hidden field.

To customize ASI fields for Citizen Access

1. Navigate to the ASI or ASIT subgroup that contains the fields that require customization.

Civic Platform displays the Application Specific Info page.
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2. Click ACA Configuration next to the field requiring customization.

Civic Platform displays the Citizen Access Configuration page.

3. Complete the fields as described below:

Alternative ACA Label Provide a custom label for the ASI field in this text field.

Instruction Enter the instructional text to support the data collection for the field.

Watermark Enter an example or words for how the user is to complete the field. This information
displays in a faint watermark in the text field.

4. Click Submit.

Working with ASI Group Fields
Topics

• Adding a Field to an ASI Group

• Editing a Field in an ASI Group

• Deleting a Field from an ASI Group

• Setting or Editing Drop-Down List Field Values

• Applying Shared Drop-down Lists

• Mapping a Field to a Session or SQL-Defined Variable

• Working with ASI Tables

• Deleting ASI Subgroups and Columns

• Configuring ASI Field and Table Drill-downs

• Limiting ASI Editing Rights

• Configuring the Record Detail Audit Log

Adding a Field to an ASI Group
You can add any number of fields to an application specific information group. In V360, the fields you apply
to the code generate the available fields list in the ASI Form Layout editor. You can also specify whether
to display a newly-added field on existing records. You can choose from any of the basic types of agency-
defined fields:
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• Number Field: Lets users enter only numeric characters in a number field. A number field displays the
word “number” to the right of the field.

• Text Field: Lets users enter only text characters in a text field. A text field displays the word “text” to the
right of the field.

• Text Area: Lets users enter multiple lines of text, such as a three-line address.

• Date Button: Lets users search for a date rather than entering a date manually.

• Yes/No Option Buttons: Lets users select either a Yes or No value by selecting the option.

• Drop-down List: Lets users choose a value from a list of predefined values determined by your agency.

• Time: Lets users enter a time value.

• Money: Lets users enter a dollar amount.

• Check box: Lets users click a check box to select the option.

To add a field to an application specific information group

1. Locate the application specific information group to which you want to add a subgroup.

2. Click Add.

Civic Platform displays the Application Specific Info Group Code—Add page.

3. Select the Group Code containing the existing subgroup you want to add.

Civic Platform displays all of the subgroups associated with the group code you selected.

4. In the Subgroups field, select the subgroup to which you want to add a field.

Civic Platform displays the Application Specific Info page.

5. Click Add.

Civic Platform displays the Application Specific Info Field—Add page.

6. Complete the fields that display. For a description of the fields, see Table 51: Application Specific
Information Group Fields.

7. Click Submit.

Editing a Field in an ASI Group
After you create an application specific information group, you might need to change it. You can add or
delete fields, or change the field type, its display order, and its default value. However, you cannot change
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the group code, the group name, or the field labels when you edit the group. Changing a field label requires
that you delete the field and add it again with the new label.

To edit an application specific information group

1. Locate the ASI group to which you want to add a subgroup. For instructions, see Searching for an ASI
Group.

2. Click the red dot next to the subgroup whose field you want to update.

Civic Platform displays the Application Specific Info page.

3. Update the information about the field you want to change. For a description of the fields, see Table 51:
Application Specific Information Group Fields.

4. Do any of the following, as appropriate for your agency's objectives:

• Click the Security button next to the field to apply or update user access security permissions to it.
For instructions, see Setting Permissions for Application-Specific Info Groups and Table Groups.

• Click the Edit button next to the field of the Drop-down List type to define the options in the drop-
down list. For instructions, see Setting or Editing Drop-Down List Field Values.

• Click the Variable Mapping button next to the field of the Text or Text Area type to map the field to
a session variable or a SQL-defined variable. For instructions, see Mapping a Field to a Session or
SQL-Defined Variable.

Deleting a Field from an ASI Group
If you no longer need a field in an application specific information group, you can delete it.

To delete a field from an application specific information group

1. Locate the ASI group that you want to add a subgroup to. For instructions, see Searching for an ASI
Group.

2. Click the red dot next to the subgroup from which you want to delete a field.

Civic Platform displays the Application Specific Info page.
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3. Click Delete next to the field that you want to delete.

4. Click OK.

Civic Platform deletes the field.

Setting or Editing Drop-Down List Field Values
After you create an application specific information group, you can add fields to the group. If you add drop-
down list fields, you must then set the values that you want to include in the list. You can also specify
a shared drop-down list, which already has preconfigured values. For information on how to implement
shared drop-down lists, see Applying Shared Drop-down Lists.

Users can choose from field values when completing an application. For example, if you add a field to
enter contact information, you can provide a drop-down list of contact types. You can also edit existing
drop-down list values or delete drop-down values that you no longer use.

To edit drop-down list values

1. Locate the specific information group with the drop-down list whose values you need to set.

2. Click the red dot next to the subgroup that contains the field for which you want to set drop-down list
values.

Civic Platform displays the Application Specific Info page.

3. Click Edit next to the drop-down list you want.

Civic Platform displays the Application Specific Info Drop-down List—Add page.

4. Choose one of the following:

• To add a new value, click Add, enter the value in the Item Value field, and then click Submit.

• To update an existing value, replace the value text and then click Update.

• To delete a value, click Delete.

Applying Shared Drop-down Lists
After you create an application specific information group, you can add a drop-down field to the group. If
you add drop-down list fields, you must then set the values that you want to include in the list. You can
implement a shared drop-down list, which already has preconfigured values.

For information on how to create a shared drop-down list, see Creating Shared Drop-down Lists.

To apply a shared drop-down list

1. Locate the Application Specific Information group to which you want to apply the shared drop-down list.
For instructions, see Searching for an ASI Group.

2. Click the red dot next to the subgroup that requires you to configure the drop-down list values.

Civic Platform displays the Application Specific Info page.
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3. Click Edit next to this drop-down list you want to modify.

Civic Platform displays the Application Specific Info Drop-down List-Add page.

4. Select the Use Shared Drop-down Lists option.

5. Do one of the following:

• Click Search to return all shared drop-down lists.

• Enter the first letter of the drop-down list, or any other search criteria, then click Search.

Civic Platform returns the Shared Drop-down List-Browse page.

6. Click Select next to the drop-down list you want to apply.

Note:

You can only select one shared drop-down list.
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Civic Platform returns to the Application Specific Info Drop-down List-Add page, and displays the Field
Values from the shared drop-down list in blue.

7. Click Update.

Mapping a Field to a Session or SQL-Defined Variable
Administrators can map application-specific information to a session variable or SQL-defined variable.
When you use the field as a template field in a report with the Save to EDMS option set to Yes, Civic
Platform can retrieve the value of the template field based on the variable mapping for the field. If Civic
Platform retrieves a blank field value from session information or SQL query results, or fails to retrieve any
value, an alert displays and you must enter the field value manually.

Civic Platform provides you with a set of standard out-of-the-box session variables. This set of variables
include frequently used parameters from Civic Platform such as Department, Module, or Service Provider
Code. For more information and a list of these session variables, see Table 53: Session Variables in
Variable Mapping.

To map a field to a session or SQL-defined variable

1. Locate the Application Specific Information group that you want to work with.

2. Click the red dot next to the desired subgroup.

Civic Platform displays the Application-Specific Info page.

3. Click the Variable Mapping button next to the Text or Text Area field you want to modify.

Civic Platform displays the Variable Mapping page.

4. To map the ASI field to a session variable, do the following:

Select “SessionVariable” from the Type drop-down list.

Civic Platform refreshes the Variable Mapping page to display the Value field as a drop-down list.

Select the session variable to which the ASI field is mapped from the Value drop-down list. For a
description of the session variables, see Table 53: Session Variables in Variable Mapping.

5. To map the ASI field to a SQL variable, do the following:

Select “Variable” from the Type drop-down list.

Enter an SQL statement in the Value field to retrieve the field value at run time.



 | Part 3: Configuring Agency Business Objects | 282

6. To remove the relationship between the ASI field and variable, leave the Type and Value fields blank on
the Variable Mapping page.

Table 53: Session Variables in Variable Mapping

Variable Description

ALTID Retrieves the alt(ernate) ID from a specific portlet.

AssetNbr Retrieves the asset sequence number from a specific portlet.

CAPID Retrieves the alt(ernate) ID from a specific portlet.

CollectionID Retrieves the public user collection ID.

Department Retrieves the department of the logged-in user.

DocumentID Retrieves the document sequence number from a specific portlet.

GAUserID Retrieves the ID of the logged-in user.

InvoiceBatchNbr Retrieves the invoice batch number.

InvoiceNbr Retrieves the invoice sequence number.

Language Retrieves the language that the logged-in user selected. For example, en_AU
(for Australian English) or en_US (for US English).

Module Retrieves the module name from a specific portlet.

ParcelID Retrieves the parcel number from the Parcels portlet.

PortletID Retrieves the portlet ID of a specific portlet.

ProviderNumber Retrieves the provider number.

PublicUserID Retrieves the user login ID that a public user generates when they create an
account.

ServiceProviderCode Retrieves the agency code for the logged-in user.

SetID Retrieves the set ID from a specific portlet.

StateLicNum Retrieves the official number that identifies the business license issued by the
state.

Today Retrieves today’s date. The workstation's system date determines this date.

TransactionID Retrieves the transaction ID.

TrustAccountReceiptID Retrieves the trust account receipt number.

UserFullName Retrieves the logged-in user’s full name.

UserGroup Retrieves the group name of the logged-in user.

UserID Retrieves the ID of the logged-in user.

Working with ASI Tables
Administrators can set up tables that let users add application-specific data with zero-to-many
relationships, which enables you to store the same data for multiple items. For example, you might want to
store the quantity and manufacturer for different types of fixtures, such as bathtubs, sinks, and drains. The
attached table’s name becomes the label that displays for the user.

An ASI table can have as many specific data fields with individual data types as you need. You can make
all of the table data fields available for use during fee calculation and for Event Manager scripts.

Topics

• Creating an ASI Table

• Editing an ASI Table
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Creating an ASI Table
Administrators can create new tables to let users add application specific data to applications. ASI tables
can have as many specific data fields with individual data types as you need.

To create an ASI table

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > Application Spec Info Table.

Civic Platform displays the Application Specific Info Table-Search window.

3. Click Add.

Civic Platform displays the Application-Specific Info Table Group-Add page.

4. Complete the fields to define the structure of the application specific table you want to create. For a
description of the fields, see Table 54: Application Specific Information Table Group Fields.

5. Click Submit to save the new table group.

Civic Platform displays the structure of the table you are defining.

6. Select whether to apply changes to this subgroup only or to all subgroups.

7. Make any necessary changes in the subgroup. For a description of the fields, see Table 54: Application
Specific Information Table Group Fields.

8. To delete a subgroup, click Delete next to the subgroup you want to delete.

Note:  Deleting all subgroups from an application specific information table group also deletes the table
group.

9. To add an existing subgroup, complete these steps:

a. Click Add.

Civic Platform displays the Application Specific Info Table Group Code—Add pop up.

b. Select whether to apply changes to this subgroup only or to all subgroups.

c. Complete the necessary fields. For a description of the fields, see Table 54: Application Specific
Information Table Group Fields.

d. Click Submit.
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10.Click Update.

Editing an ASI Table
Administrators can edit ASI tables. You can change the display order add instructional text, or add or
delete subgroups.

To edit an ASI table

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > Application Spec Info Table.

Civic Platform displays the Application Specific Info Table—Search window.

3. Enter relevant search criteria in the Group Code and Subgroup fields and click Submit. To browse all
tables, click Submit without entering any search criteria.

4. Click the red dot beside the application specific information table that you want to edit.

Civic Platform displays the Application Specific Info Table—Edit and Manage Subgroups window.

5. To change an existing subgroup’s display order, enter the number to determine the position in the
Display Order field and click Update.

6. To allow users to sort ASI table fields, clear the Disable Sorting check box. To prevent users from
using the column sort, select the Disable Sorting option.

If you clear Disable Sorting, a sort control arrow displays on the heading of each ASI table column
in all applicable locations in Civic Platform. Users can sort a column in the ASI table in ascending or
descending order.

7. To add instructional text for a group, click ACA Configuration, enter instructional text into the
Instructions text field, and then click Save.

8. To delete a subgroup, click Delete next to the subgroup you want to delete.

Note:

Deleting all subgroups from an application specific information table group also deletes the table group.

9. To add an existing subgroup from another table to the current table:

a. Click Add.
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b. From the Group Code drop-down list, choose the group code that contains the subgroup you want
to add.

c. In the Subgroups field, click the subgroup you want to add.

d. Click Add.

10.To create a new subgroup:

a. Click New.

b. Edit the fields as necessary. For a description of the fields, see Table 54: Application Specific
Information Table Group Fields.

c. Click Submit.

11.To edit an existing subgroup in the table:

a. Click the red dot beside the table subgroup you want to edit.

Civic Platform displays the subgroup edit page.

b. Edit the fields as necessary. For a description of the fields, see Table 54: Application Specific
Information Table Group Fields.

12.Click Update.

Table 54: Application Specific Information Table Group Fields

Application-Spec Info
Table Group

Enter a unique code to identify the ASI table group that you are creating. If you
are creating a subgroup for an existing group code, Civic Platform automatically
populates this field with the group code that you are working with.

Application- Specific Info
Table Subgroup

Enter the name of the subgroup you are creating.

Application- Specific Info
Table Subgroup Alias

Enter the table subgroup alias. The alias replaces the table subgroup name in all
the areas that the ASI table subgroup displays to the users in Civic Platform, Citizen
Access, and Mobile Office.

Column Name Enter the name of the first column for this table group.

Default Value Enter a default value for the first field in your application specific information table
group.

Note:

If you are setting up a drop-down list, you can add values to the drop-down
list so that a user can choose from multiple values. For instructions, see
Setting or Editing Drop-Down List Field Values.

Display Len Specify the maximum number of characters that Civic Platform displays.

Display new ASIT on
existing Records

Select Yes to apply the new ASI field to existing applications. Select No to apply the
new ASI field to new applications only.

If you cannot see the option, you must configure the related Standard Choice.

Refer to the Civic Platform Configuration Reference for additional information.

Display new ASIT on
existing Education/
Examination/Continuing
Education

Choose Yes to make the new user-defined field, table, or sub-group of user-defined
fields available to existing education, examination and/or continuing education
records in addition to being available for new records. Choose No to apply the new
user-defined objects to new records only.
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Display Order Enter a number to determine the position of the first field in your application specific
information table group. For example, to display the field before any other fields,
enter 1.

Group Display Order Enter a number to determine the position of this information table group on the
Application Specific Information Table section of an application in Daily Activities. For
example, if you want this information group to display in the second position, enter 2.

Req for Fee Calc To require users to complete the Fee Calculation fields, choose Yes.

Fields required for Fee Calculation display a visual indicator ($) on the permit
application form. You can configure this feature using the Function Identification
0242 Required for Fee Calculation.

Required Flag To require users to enter a value in this field, select the Yes option.

Searchable To make this application specific information table searchable within Civic Platform,
select the Yes option.

Status To let users see this field in Civic Platform, click Enabled; otherwise, click Disabled.

Supervisor Edit Only Select Yes to make this information read-only to non-supervisor users after a user
creates an application. For further information about this field, please see Limiting
ASI Editing Rights.

Type Choose the type of the first field in your application specific information table group.
For more information on field types, see Table 54: Application Specific Information
Table Group Fields.

Deleting ASI Subgroups and Columns
Civic Platform adds an option to delete ASI subgroup fields and ASI subgroups and columns from all
reference and transactional records. You can do this to restrict ASI subgroup fields to only display in
a historical record, new records, or both. You can also completely remove the ASI table column from
historical transactional data, instead of just disabling the column.

If you delete the ASI table subgroup, Civic Platform deletes the information from all ASI tables related to
the subgroup. If you delete the column within an ASI table, you remove the column information, but the rest
of the information in the ASI table continues to display. When you delete either a column or subgroup, it
removes the related data from ASI table reference data, ASI table transactional data, ASI table drill downs,
and ASI security data. Expression records related to the deleted ASI table column or ASI subgroup remain
intact. The V360 user experience pages affected are the Application Specific Info Table tab, the Record
Summary tab, and the new record in the Building portlet, and the Checklist tab in the Inspections portlet.

Note:

The delete function is permanent. You cannot retrieve deleted subgroup ASI tables or information.

You have several options when you delete an ASI table column or ASI subgroup. You can combine any of
these options to determine the desired result. The first option is to apply the changes to only the selected
subgroup or to all subgroups. The second is to remove the ASI table column or ASI subgroup from the
reference and associated Checklist transactional records. The third option enables you to hide the ASI
table columns and ASI subgroups for future records, but leave them visible in historical records.

To delete ASI table columns and ASI subgroups

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > Application Specific Info Table.

Civic Platform displays the Application Specific Info Table - Search page.

3. Enter relevant search criteria in the Group Code and Subgroup fields and click Submit. To browse all
tables, Click Submit without entering any search criteria.
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4. Click the red dot beside the application specific information table that you want to edit.

Civic Platform displays the Application Specific Info Table—Edit and Manage Subgroups window.

5. To delete the entire ASI table subgroup, click Delete.

Civic Platform displays the Application Specific Info Table Subgroup - Delete page.

6. Select the associated data you also want to delete.

Click Submit.

Civic Platform deletes the ASI subgroup, along with any associated data that you selected for deletion.

7. To delete a column within the ASI table subgroup, click the red dot next to the subgroup, then click
Delete next to the column you want to delete.

Civic Platform displays the Application Specific Info Column - Delete page.

8. Do one of the following:

• If you are deleting an ASI table column, select either Apply changes to this subgroup only or
Apply changes to all subgroups. If you select Apply changes to this subgroup only, Civic Platform
only removes the ASI table column from the current subgroup. If you select Apply changes to all
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subgroups, Civic Platform removes the column from all of the subgroups in which the ASI table
displays.

• To hide the ASI table column and ASI subgroup for future records, but leave them visible in historical
records, click Submit without selecting any options.

Civic Platform closes the page and hides the ASI table column or ASI subgroup from new records.

Configuring ASI Field and Table Drill-downs
You must configure Civic Platform to display ASI field and ASI table drill-downs for Civic Platform users.
The configuration steps include:

• Setting three FIDs

• Defining the ASI information in Classic Administration

• Creating or editing shared drop-down lists

• Creating or editing ASI field or ASI table drill down records.

You can associate an ASI group with the ASI field or table in the application. To specify the application to
apply the ASI drill-down field or ASI table to, you must associate the ASI group or ASI group table with the
record type. The shared drop-down lists contain the values for the ASI field or ASI table drill-downs.

Note:

As soon as you associate the ASI group with an ASI field or ASI table drill-down, the drill-down displays on
the application, even if you have not assigned values to the ASI drill down record. You can set the ASI field
or ASI table drill-down record as “inactive” until it is ready for the application.

ASI drill-downs allow users to search for the value of a column with a drill-down approach. This drill down
displays in the application. The drill-down functionality guides the user through a series of drop-down fields
that present unique data choices based on previously-selected data fields. When you complete all the
selections, Civic Platform displays a field or table drill-down table with the value results in the application.
You can apply drill-down fields to multiple application specific information groups. For example, you can
apply a table of business license types to both business or professional licenses.

For example, you can prepare a table for multiple business license types. You can specify the first option,
such as Agriculture, and then assign subgroups, such as Plants and Trees Cultivation, and Seeds and
Crops Cultivation. You can then create additional groups for each of the subgroups which narrows the
license options available. After you assign the groups and subgroups, the options display in an ASI Table
in the public user view.

Figure 13: ASI Table Drill-Down User View shows a sample completed ASI Table drill-down.
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Figure 13: ASI Table Drill-Down User View

ASI field and ASI table drill-downs are available to both Civic Platform and Citizen Access users. For
information about the additional steps required to configure ASI table drill-downs for Citizen Access
applications, see “Configuring ASI Table Drill-Downs” in the Citizen Access Administrator Guide.

To configure ASI drill-down display

1. Create or edit the ASI Group, ASI Subgroup, ASI Table Group, and ASI Table Subgroup to associate
with an ASI drill-down.

For further details on ASI and ASI tables see Working with ASI Groups and Subgroups and Working
with ASI Tables.

2. In the SmartChoice group STANDARD_SMARTCHOICE, select Yes on the Application-Spec Info or
Application-Spec Info Table option.

For further details on SmartChoice groups, see Working with SmartChoice Groups.

3. Create or edit the shared drop-down lists with the values needed for the ASI drill-down.

For details on completing this task, see Creating Shared Drop-down Lists.

4. Create or edit the ASI drill-down record.

For details on completing this task, see Creating ASI Drill-Downs.

Limiting ASI Editing Rights
Administrators can set ASI to read-only for non-supervisor roles after an application is submitted. This
means that any user other than a supervisor can only view, not edit, the information. Non-supervisor users
can enter or change the ASI during application creation, but you can designate individual fields to allow
only supervisors to update those data elements after a user saves the application. The supervisor edit only
designation can also apply to individual subgroup fields in ASI tables. For example, an intake clerk user
can create and complete all fields for an application, but, after the application is submitted, the clerk who is
a non-supervisor user can read but not edit those fields.

To limit ASI editing rights

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > Application Specific Info Table.

Civic Platform displays the Application Specific Info Table - Search page.
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3. Enter relevant search criteria in the Group Code and Subgroup fields and click Submit. To browse all
tables, click Submit without entering any search criteria.

Civic Platform displays the Application Specific Info Table Group - Add page.

4. When you create or edit the application specific information table group, set the Supervisor Edit Only
field to Yes and Click Submit.

Configuring the Record Detail Audit Log
Civic Platform provides an audit log that contains modification details for each record. Audit logs enable
you to track all activity that occurs on a record, including changes to ASI and ASI table data. You can
define an audit log for these activities within each application record.

When a user creates a record, the log records the first entry of each field. When a user makes a change to
any of the record details including ASI or ASI table values, the log records the change. The log records the
action performed such as added, updated, or deleted. The log also record the ASI or ASI table subgroup,
the field, the updated value, the date, the current user and the product. For example, if an agency user
needs to determine who changed ASI data, such as the income value for a specific record, and when they
changed it, they can access the record audit log to view ASI changes.

Note:

The audit log does not record activity on a partial record. A partial record can have many details in the
application, but it is never complete until a user Submits it. After it is complete and you submit the record, the
record detail audit log records the activity.

ASI Lookup Tables
Topics

• Understanding ASI Lookup Tables
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• Creating ASI Lookup Tables

• Adding ASI Lookup Table Rows and Columns

• Finding ASI Lookup Tables

• Editing ASI Lookup Table Data

Understanding ASI Lookup Tables
The Application Specific Information (ASI) Lookup Tables portlet enables you to create and maintain ASI
tables. ASI Lookup Tables can provide fields for users to complete or it can populate specific data as a
reference for a specific application type.

You assign the table to a record type, and the table data displays in the ASI section of that specified
record type. You can also include ASI Lookup Tables to create an expression. With Expression Builder,
administrators can design ASI tables to populate table data into other fields in the ASI section or add a new
row to the end of the ASI table and store new data in the ASI table.

To use the ASI Lookup Tables feature, you must have assigned an application specific information group
in Classic Administration. An ASI Info Group Code denotes supplemental application fields that you can
include in a standard application. Administrators can determine which fields to include in each application
specific information group and whether users can search for an application based on those fields. You can
also specify the field types (text, number, and so forth), display order, default value, and the fee indicator
for any field in an application specific information group.

After you set up an application specific information group code, you can associate it with multiple
application types. To create an application specific Information Group, see Creating New ASI Fields.

Creating ASI Lookup Tables
After you define an ASI Lookup Table, you can also apply the table or its column data by using the
Expression Builder tool (Using Expression Builder). When creating an expression you can include criteria
so the ASI Lookup Table gets a new row added to the ASI table. For example, you can define if a field
value for the ASI field called Zone has the option “R2” selected, add specific data to the end of the ASI
table.

You can also add data into a specific cell of an ASI table based on matching criteria. For example, if a user
enters “R4” into the Zone field, then you can add a corresponding row of data to the ASI table.

To create an ASI lookup table

1. Access the ASI Lookup Tables portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the ASI Lookup Table Name detail portlet with Table Structure secondary tab.

3. Click the Record Type picker, next to the Lookup Table Name field.

The Record Type navigation tree displays.

4. Use the (+) to expand the list and (-) to locate and select one application type (also referred to as record
type) to apply the lookup table name.

Civic Platform displays the Column Name drop-down list. The Record Type field displays the record
type selected.

5. Click New Column to add other columns to the ASI Lookup Table. Do the following:

a. From the New Column drop-down list, select the column name.

See the Table 55: ASI Lookup Tables Fields.
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b. Enter a lookup table name in the Lookup Table Name field associated with the ASI Group Code for
that record type.

6. Click Submit.

Civic Platform adds the new column to the ASI Lookup Table list.

7. Repeat for each new column required for the table.

8. Click the Table Data tab to set up the content for the row cells within each column.

9. In the first field of the new row, add the text of other content as required.

10.Optionally, click New to add other rows to the ASI Lookup Table.

11.Click Submit to save all modifications.

The Table Data updates to the database successfully.

Table 55: ASI Lookup Tables Fields

Column Name An inactive new Column Name displays. Complete and submit the Lookup Table Name
and Permit Type fields. Then click Table Data to the n the Table Structure secondary
tab: Click New Column and then use the Permit Type picker to select a Record Type to
associate the column to.

Lookup Table Name In the Table Structure secondary tab: Add a new name for the table. Lookup Table
Name is a required field.

Record Type In the Table Structure secondary tab: Click the application type using the Record Type
picker navigation tree. Use the (+) to expand and locate the application type to apply
the lookup table name. Record Type is a required field. Then select the Column Name
from the drop-down list.

If the application type you select has no Application Specific Information associated
with it, you must use Classic Administration to set up an ASI Group Code. Then use
the ASI Form Layout Editor in Civic Platform to design the appearance and function of
those ASI fields for that Permit Type.

Adding ASI Lookup Table Rows and Columns
Use this page to specify the permit application type that contains the ASI fields you want to add to an ASI
Lookup Table. Based on the permit type, you select the column data you want to add to the ASI table.
Then use the Table Data to add rows and enter the appropriate values, data or numerical values for each
row in each column.

You can to add one or more columns to the table.

Note:

To create a table structure you must have created an Application Specific Information Group and optionally,
a Subgroup. You can do this by going to Classic Administration > Application Type Info pages.

To create an ASI lookup table name and add columns and data

1. In the ASI Lookup Table Name detail portlet, complete these fields:
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Lookup Table Name Enter a label or name to identify the table or its columns or functions.

Permit Type Locate the permit application type to which you want to expose table data in
the ASI Lookup Table. If the Permit Type you select has no Application Specific
Information associated with it, you must use Classic Administration to set up an ASI
Group Code. Then use the ASI Form Layout Editor in V360 Admin to design the
appearance and function of those ASI fields for that Permit Type.

2. Click New Column to add other columns to the ASI Lookup Table. Specify the column name for the
drop-down list. Repeat this step for each new column required for the table. Click Submit.

Civic Platform updates the column data and the ASI Lookup Table Name field and Permit Type field
become inactive. You cannot modify these fields.

3. Click the Table Data tab to set up the content for the row cells within each column.

4. Click New to add a new row to the ASI Lookup Table.

5. In the first field of the new row, add the text of other content as required. This information populates for
daily users to refer to as they process the permit type.

6. Add additional rows and enter the data, text, or numerical values.

7. Click Submit to save all modifications.

The Table Data updates to the database successfully.

Finding ASI Lookup Tables
Find an existing Application Specific Information (ASI) table from the list by searching for it.

To locate an ASI table

1. Click Search.

Civic Platform displays the ASI lookup table search screen.

2. Enter the full name or the initial letters for the name in the Lookup Table Name field.

3. Click Submit.

Civic Platform displays search results.

4. To return to the ASI Lookup Tables list portlet, click Search, clear the search fields, and then Click
Submit.

Civic Platform displays the ASI Lookup Tables list portlet.

Editing ASI Lookup Table Data
Use this portlet to add data or delete data from a row in an ASI lookup table name.

To add data to or delete data from a row in an ASI lookup table

1. From the Table Structure tab, mark the Column Name you need to add or remove data.

2. Click the Table Data tab.

Civic Platform displays the column names and the current data for each row.

3. Do one of the following:
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a. To add a row, click New and enter the data for the new row. In the first field of the new row, add
the text of other content as required. This information populates for daily users as they process the
permit type. This information displays in the ASI section of the permit type.

b. To enter multiple row data, Click New Row.

c. To delete a row, mark the check box next to the row to remove from the table and click Delete.

Civic Platform deletes the record from the Table Data list

4. Click Submit.

"Table Data Created Successfully" displays. Civic Platform saves the changes to the ASI Lookup Table
Name.

Designing Application Intake Forms
Click a topic title below for full details.

Related Links

Understanding the Form Layout Editors

Designing a Form Layout

Creating ASI Drill-Downs

Understanding the Form Layout Editors
Consult the list below to determine which Form Layout Editor tool you need to use for the type of form you
want to create or edit.

APO Form Layout Editor

The fields you add display in any of these sections on a new application: Address Information, Owner
Information, and Parcel Information.

You specify the APO Type of Address, Parcel, or Owner. When a user creates a new application, these
fields display at the bottom of the APO Type section, for example in the Owner Information section if you
added fields to the Owner APO Type.

ASI Form Layout Editor

The unique fields you add display in the application-specific information section of an application based on
the application type.

You must obtain the application-specific information group codes for the application type you want to add
fields. When a user creates an application type, these fields display in the ASI section.

To understand how to set up application-specific information group codes, see Working with Activity-
Specific Information Group Codes. An application-specific information group is a group of fields that you
want to include on an application in addition to standard fields such as contact information. You can locate
this feature in the following areas:

• Classic Administration > Application > Application Spec Info

• V360 Admin > Application > ASI Lookup Tables.

Asset Form Layout Editor

The fields you add display in the Asset Detail form of an asset based on the asset type.
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You must obtain the Asset Template ID for the asset type where you want to add fields. When a user
creates an asset type, these fields display at the bottom of the Asset Detail form.

To learn how to set up asset templates, see Attributes and Templates

TSI Form Layout Editor

The unique fields you add display in the task-specific information section of a workflow task based on the
task.

You must obtain the task-specific information group name for the workflow task to which you want to add
fields. When a user creates an application and Civic Platform assigns a set of workflow tasks, these fields
display in the TSI section at the bottom of the Task Details form.

To understand how to set up task-specific information groups, see Configuring Agency-defined Fields
for Workflows. A workflow is a set of tasks an agency defines and follows for the purpose of managing
an application. Workflow tasks function as the agency’s to-do list when a user creates an application. A
task-specific information group is a group of fields that you want to include on a task in addition to the
standard task fields, such as status, status date, and comments. You can locate this feature in Classic
Administration under Admin Tools > Workflow > Task Specific Info.

Designing a Form Layout
Designing a form layout consists of the following topics.

Topics

• Creating a Form Layout

• Searching for a Form

• Editing a Form Layout

• Copying a Form Layout

Creating a Form Layout
Creating a new screen is the first step in setting up the fields you want to expose in a form to a certain
group of users. You can add, customize, and manipulate the size of each field, and use the buttons on the
screen to preview, align, add dynamic text, draw lines and insert tables.

To create a new form portlet layout

1. Access the appropriate Form Layout Editor (Accessing the Form Layout Editors).

2. Click New.

Civic Platform displays the Screen Name page.

3. Select the appropriate item from one of these drop-down lists, APO Type, ASI Group Code, Asset
Template ID, or TSI Group Code:

a. Select the APO Type from the drop down list.

Select the APO Type associated with the fields you want applied to the new APO Screen Name. The
APO Screen Name might be a name to easily identify the fields or their unique functions for the APO
Type.
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When a user creates a new application, the fields you add display at the bottom of the APO Type
section, for example in the Owner Information section if you added fields to the Owner APO Type.

b. Select the ASI Group Code from the drop down list.

Select the ASI Group Code applicable to the fields you want to apply to the new ASI Screen Name.
The ASI Screen Name might be a name to easily identify the fields or functions of the ASI Group
Code.

The ASI Group Code is a unique code name that identifies the application-specific information group
that you are working with. An application-specific information group is a group of fields that you want
to include on an application in addition to the standard application fields such as address, contact,
and owner details.

The items in this drop-down list are based on the Classic Administration feature under the Admin
Tools tab > Application > Application Spec Info.

For information and details on setting up application specific information groups, see Defining
Custom Fields (Application Specific Information).

c. Select the Asset Template ID from the drop down list.

Select the Asset Template ID applicable to the fields you want to apply to the new Asset Screen
Name. The fields you add display in the Asset Detail form of an asset based on the asset type.
When a user creates an asset type, these fields display at the bottom of the Asset Detail form. The
Asset Screen Name might be a name to easily identify the fields or functions of the asset template
ID or asset type.

To understand how to set up asset templates, see Attributes and Templates

d. Select the TSI Group Code from the drop down list.

Select the TSI Group Code applicable to the fields you want apply to the new TSI Screen Name. The
TSI Screen Name might be a name to easily identify the fields or functions of the TSI Group Code.

You must obtain the task-specific information group name for the workflow task to which you want to
add fields. When a user creates an application and Civic Platform assigns a set of workflow tasks,
these fields display in the TSI section at the bottom of the Task Details form.

To understand how to set up task-specific information groups, see Designing Workflows . A workflow
is a set of tasks an agency proscribes and follows for the purpose of managing an application.
Workflow tasks functions as the agency’s to-do list when a user creates an application. A task-
specific information group is a group of fields that you want to include on a task in addition to the
standard task fields, such as status, status date, and comments. You can locate this feature in
Classic Administration under Admin Tools > Workflow > Task Specific Info.

4. Click Submit.

Civic Platform displays the Screen Name page and the Available Fields page, which contains the fields
associated with the APO Type, ASI Group Code, Asset Template ID, or TSI Group Code.



 | Part 3: Configuring Agency Business Objects | 297

A The Designer tab is where you create and design the form.

B The Permission tab is where you assign permissions and make forms available to users.

C The Preview button. Click to preview your changes.

D The Available Fields button. Click to view the available fields you can add to this page. Double-click the
name of the field to add it to the form.

E The Add Label button. Click to add text to the page.

F The Add Line button. Click to add a line to the page.

G The Add ASI Table or Attribute button. This button is only available in the ASI tool and the Asset Form
Layout Editor. Click the button to add the table associated with an ASI Group Code or an Asset Template
ID to the form.

H The Alignment buttons. Click to align the fields left, right, top, or bottom.

I The ASI Properties. This link takes you to respective configuration area in Civic Platform. The fields
available pertain to the attribute template for the APO Type, the ASI subgroups, or the Workflow
subgroups. If you need to add a field to available fields list, you must first add it to the respective area: the
attribute template, ASI subgroups, or Workflow subgroups.

J The Available Fields window. This window displays all available fields for the APO Type, ASI Group Code,
Asset Template ID, and TSI Group Code. Double-click the field name to add it to the form.

5. Complete the appropriate fields for the form you are designing. Go to the substep for the screen name
you are designing: APO screen name, ASI screen name, Asset screen name, or TSI screen name.

APO Screen Name:

Align Command Use this drop-down list after you have added fields to the screen. Highlight a
field and click Align to move the field. To align multiple fields, hold the Ctrl key,
click each field you want to move, then click Align.

APO Description Enter descriptive text to help identify the form use or its function.

APO Screen Name Enter the screen name for the page.

APO Type This read-only field is pre-filled with the choice you made in .

ASI Screen Name:
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Align Command Use this drop-down list after you have added fields to the screen. Highlight a field
and click Align to move the field. To align multiple fields, hold the Ctrl key, click
each field you want to move, then click Align.

ASI Description Enter descriptive text to help identify the purpose of the form.

ASI Group Code This read-only field is pre-filled with the choice you made in .

ASI Screen Name Enter the screen name for the page. When creating a standard Condition, this
name becomes available in the Template drop-down list of the New Condition
detail portlet.

ASI Tab Label Name Enter the detail portlet tab label associated with this screen.

SPEAR Only The SPEAR Only option enables you to define ASI forms for an ASI group used
in the application. For example, an ASI group with 400 fields is a large number of
fields. Not all of those fields are necessary during record creation. Choose SPEAR
only if you want to define a form for the ASI Group Code and display it on the
application if you enabled the ASI Smart Choice group.

Asset Screen Name:

Align Command Use this drop-down list after you have added fields to the screen. Highlight a field
and click Align to move the field. To align multiple fields, hold the Ctrl key, click
each field you want to move, then click Align.

Asset Description Enter descriptive text to help identify the form use or its function.

Asset Template ID This read-only field is pre-filled with the choice you made in .

Asset Screen Name Enter the screen name for the page.

TSI Screen Name:

Align Command Use this drop-down list after you have added fields to the screen. Highlight a field
and click Align to move the field. To align multiple fields, hold the Ctrl key, click
each field you want to move, then click Align.

TSI Description Enter descriptive text to help identify the form use or its function.

TSI Group Code This read-only field is pre-filled with the choice you made in .

TSI Screen Name Enter the screen name for the page.

TSI Tab Label Name Enter the detail portlet tab label associated with this screen.

6. Add fields to the screen.

a. Click available fields to open the available fields page.

b. If there is more than one APO template, ASI subgroup, Asset template, or TSI subgroup the
available fields page has a drop-down list. Choose the template or the subgroup name from the
drop-down list. Then hold down the Ctrl key and click each field name you want to add to the page.

c. Click OK.

7. Resize and position each field using the mouse.

8. Customize the fields to change font, color, or add a watermark.

a. Right-click the field you want to customize and choose Properties.

Civic Platform displays the Properties window.

b. Customize the fields below.
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Label Custom label name for the field.

DB Label Database default label name.

Watermark Label Enter the text you want to be initially display in the field. When a user tabs or
moves off one field the results might display in the next field, replacing the
watermark label text with new data.

Font Select the font from the drop-down list. If there are no available fonts, see the
Standard Choice in Understanding the Form Layout Editors.

Justification Specify justification of label name with drop-down list.

Color Click the color picker to choose the color of the text label for the field.

Width Enter the width of the attribute field you want to display in the form.

Height Enter the height of the attribute field you want to display in the form.

9. Delete any unnecessary fields.

a. Right-click on the field you want to delete.

b. Choose Delete from the drop-down list.

10.Add lines or additional dynamic text accessed by corresponding buttons.

11.Click Preview to evaluate whether you want to make adjustments.

12.When you are happy with the form layout click Submit.

Searching for a Form
To search for a form

1. Access the appropriate Form Layout Editor (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the form layout editor search screen.

3. Enter search criteria as necessary.

For a description of the fields that display on the search screen, see Creating a Form Layout.

4. Click Submit.

Civic Platform displays the screens that match your search criteria.

Editing a Form Layout
Edit ASI screens by adding or removing fields, manipulating the size of the fields, or applying
customization.

To edit a form layout

1. Access the appropriate Form Layout Editor (Accessing the Form Layout Editors).

2. Select the Screen Name on which you want to act.

Civic Platform displays the Screen Name detail page.
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3. Make the necessary edits to fields. For information on how to make changes to the screen, see
Accessing the Form Layout Editors.

4. Click Submit.

Copying a Form Layout
You can copy an existing form layout screen name from the list and update it as necessary.

To copy a form layout

1. Access the appropriate Form Layout Editor (v).

2. Select the screen you want to copy and click Copy.

3. Make the necessary edits to fields. For information on how to make changes to the screen, see
Creating a Form Layout.

4. Click Submit.

Assigning Permissions
After creating the form, decide which user group or module requires permission to edit or view the fields.
For example, you might want to assign permission for a supervisor to enter data in the fields, limit other
users to view-only access, and perhaps restrict another group from being able to see the information
whatsoever. Make the appropriate permission assignments based on the access-level required by each
user type and group.

You can further refine permissions and access-levels by setting Application Type Security, Record Type
Security, and Workflow Security. For more information about Security, see Setting Up Security Policies.

To access and assign a view

1. Access the appropriate Form Layout Editor (Accessing the Form Layout Editors).

2. Select the Screen Name on which you want to act.

Civic Platform displays the Screen Name detail page.

3. Go to the Permissions tab.

Civic Platform displays the Permissions detail portlet for the screen name.

4. Click Assign.

5. Select the Module, Group or User from the drop-down list.

Civic Platform displays a navigation tree with associated selection.

6. Navigate through the tree view to select the associated Module, Group, or User.
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7. Click Submit.

8. Use the drop-down list to assign Full Access, Read Only, or No Access for the Module, Group, or
User.

You can change the access level at any time.

9. Click Submit.

Creating ASI Drill-Downs
ASI drill-downs guide users through a series of drop-down lists that present unique data choices based
on previously-selected data field selections. When the user completes all of the selections, Civic Platform
displays the field or a drill-down table with the value results.

Drill-downs display in the application and in the App Spec Info or App Spec Info Table tabs in the
application record.

For example, you can prepare a table for multiple business license types. You can set the first option, such
as Agriculture, and then assign subgroups, such as Plants and Trees Cultivation, and Seeds and Crops
Cultivation. You can then create additional groups for each of the subgroups which narrows the license
options available. After you assign the groups and subgroups, the options display in an ASI Table in the
public user view.

Topics

• Searching for a Drill-Down

• Creating or Editing an ASI Field Drill-Down

• Creating or Editing an ASI Table Drill-Down

• Understanding the Drill-Down Series Tab

• Assigning Values to an ASI Drill-Down Series

• Enabling Drill-Downs to Display

Searching for a Drill-Down
The drill-down feature allows users to filter the list of value results by performing a search within the ASI
drill‑down result value data.

To find a drill-down

1. Access the ASI Drill-Down portlet (Accessing the ASI Drill-Down Portlet).

2. Click Search.

Civic Platform displays the ASI Drill-Down search page.

3. Complete any fields that display. For a description of the fields, see ASI Drill-Down Table Fields.

4. Locate the ASI drill-down you want to edit in the list. Click the ASI drill-down link in the Drill Down
column.

Civic Platform displays the ASI drill-down record details.

Creating or Editing an ASI Field Drill-Down
You can create a drop-down field to enable users to search for the value of an application-specific
information field using a drill-down approach. The drill-down approach allows users to filter the list of value
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results by performing a search within the ASI drill‑down result value data. The drill-down functionality
guides the user through a series of drop-down lists that limits the selection values for subsequent fields
based on previously-selected data. When a user completes all of the selections, Civic Platform displays the
value results. You can apply drill-down fields to multiple application-specific groups.

For example, your agency can create a drill down for Business License applications. The first drill-down
lists the nature of the license, such as Agriculture, Bakeries and Confectionery, and Building Materials.
If the user selects Building Materials, the next drill-down lists materials such as Paints and Bonding
Materials, Tiles and Ceramics, and Wood and Wooden Products. If the user selects Wood and Wooden
Products, the third drill-down lists options such as Import of Wood, Furniture Repair and Refurbishing,
Plywood Manufacture, and Sawdust Collection and Recycling. For an example of a drill-down field, see
Application Record ASI Drill-Down Field.

Application-specific information fields display in the application, the App Spec Info tab of an application
record, and checklist templates for related application types. Application-specific information fields also
display in the application and Application Spec Info tab in Civic Platform.

Before you create an ASI field drill-down, you must create or edit an existing ASI drill-down and apply the
drill down to an application type.

The ASI field drill-down displays on the application, application records, and checklists specified for that
record type. If you add a drill down for an ASI group that belongs to more than one record type, the drill
down is active for all of those record types. For further details on managing application‑specific information,
see Defining Custom Fields (Application Specific Information).

Figure 14: Application Record ASI Drill-Down Field

To create or edit an ASI field drill-down

1. Access the ASI Drill-Down portlet (Accessing the ASI Drill-Down Portlet).

2. Click New, or click the name of the record you want to edit.

Civic Platform displays the Drill Down detail portlet.
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3. Complete the necessary fields, then click Submit.

For a list of fields, see ASI Drill-Down Table Fields.

Note:

As soon as you associate the ASI group with an ASI drill-down, the drill-down displays on the application
and application record, even if you have not assigned values to the ASI drill-down record. You can set
the ASI drill-down record as “inactive” until it is ready for the application.

4. Go to the Value Mapping tab.

Civic Platform displays the series order.

5. Click the plus (+) sign in the picker, then click the Parent ASI field item.

Civic Platform displays a secondary portlet that lists the shared drop-down values linked to the drop-
down selected for the Parent ASI field drill-down.

6. Select the value(s) you want to apply to the drill down, and then click Submit.

7. Click the plus (+) sign in the picker, then click the Child ASI item.

Civic Platform displays the shared drop-down values that you associated with the drop-down values.

8. Select the value(s) you want to apply to the drill down, and then click Submit.
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Creating or Editing an ASI Table Drill-Down
Users can search for the value of an application-specific information table with a drill-down approach.
Application-specific information tables display in the application and in the App Spec Info Tables tab of the
application record. The drill-down functionality guides the user through a series of windows that presents
unique data choices based on previously-selected data field selections. When the user completes all of the
selections Civic Platform displays a drill-down table with the value results. The drill-down feature allows
users to filter the list of value results by performing a search within the ASI drill‑down result value data. You
can apply drill-down tables to multiple application-specific groups. For example, the agency can apply a
table of business license types to both business or professional licenses.

You must create or edit an existing ASI table drill-down before applying the drill down to an application.

In the Drill Down detail portlet, each combination of ASI table groups and subgroups can only apply to one
active drill down at a time. The ASI table drill-down displays on the application specified for that record
type. If you add a drill down for an ASI group you assigned to more than one record type, the drilldown is
active for all of those record types. For further details on managing application‑specific information, see
Defining Custom Fields (Application Specific Information).

To create or edit an ASI table drill-down

1. Access the ASI Drill-Down portlet (Accessing the ASI Drill-Down Portlet).

2. Click New, or click the name of the record you want to edit.

Civic Platform displays the Drill Down detail portlet.

3. Complete the necessary fields, then click Submit.

For a list of fields, see ASI Drill-Down Table Fields.

Note:

As soon as you associate the ASI group with an ASI table drill-down, the drill-down displays on the
application, even if you have not assigned values to the ASI table drill-down record. You can set the ASI
table drill-down record as “inactive” until it is ready for the application.

4. Do the following:

a. Establish the drill-down relationship. See Understanding the Drill-Down Series Tab.

b. Assign values to drill-down series. See Assigning Values to an ASI Drill-Down Series.

Table 56: ASI Drill-Down Table Fields

Drill Down Enter a unique name for the ASI Table Drill-Down.

ASI Group Use the picker for the ASI Subgroup field to select the ASI Groups or ASI Table
Groups to apply to the drill down.
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You define the ASI groups and subgroups, and the ASI table groups and subgroups,
in Classic Administration > Admin Tools > Application > Application Spec Info (and
Application Spec Info Table).

ASI Subgroup Click the picker for the ASI Subgroup field, then click the ASI group or ASI table
group name to expand the view and display the ASI table subgroups applicable to
each group.

The first ASI subgroup list is the primary ASI subgroup. To choose a primary
subgroup, double-click the desired ASI subgroup. All other subgroups display in
alphabetical order.

The configuration of the primary ASI subgroup, including column names, field types,
display order, and so forth, becomes the default for all subgroups attached to the
ASI drill-down. If the configuration for subsequent ASI subgroups does not match,
Civic Platform displays an alert message to notify you that the drill down cannot
display on the ASI subgroup.

If you want to disassociate a single ASI subgroup from the ASI Field or ASI Table
drill-down, click the ASI subgroup and then click Delete.

If you want to disassociate multiple ASI subgroups, press the Ctrl key on your
keyboard while clicking the unwanted ASI subgroups. After you have highlighted all
unwanted ASI table subgroups, click Delete.

ASI Type Choose either ASI Field or ASI Table to determine which type of ASI drill-down to
create.

Apply To To determine whether the ASI drill-down displays in Civic Platform, Citizen Access,
or both products, click the appropriate option.

Record Status Use the drop-down to determine whether the drill down is currently Active or
Inactive.

Figure 15: ASI Drill-Down Table Select Single Item
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Figure 16: ASI Drill-Down Table Select Multiple Items

Understanding the Drill-Down Series Tab
The Drill Down Series tab determines how many drill-down levels you want to display in the ASI field drill-
down or ASI table drill-down. You need only add two columns in the series to display three drill-down
levels. After you have entered your information into this tab, you progress to the Value Mapping tab to
determine the data values for each level.

To understand the Drill Down Series tab

1. Access the ASI Drill-Down portlet (Accessing the ASI Drill-Down Portlet).

2. Click the link to the ASI drill-down you want to work with.

3. Go to the Drill Down Series tab. This tab determines how many drill-down levels you want to display in
the ASI table drill-down.

Note:

You cannot access the Drill Down Series tab until you save the new drill-down record.

Civic Platform displays the Drill Down Series tab in the detail portlet.
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4. Establish the drill-down relationship.

To create additional drill-down levels, repeat Substep a to c in this step. Civic Platform automatically
identifies the Parent ASI table drill-down type and shared drop-down list as the Child from the previous
level. Specify the relevant ASI Table Subgroup in the Child Column and Child Drop Down for the new
level.

Note:

You need only specify two rows for three drill downs.

a. Click New.

Civic Platform displays an ASI Drill Down series row.

b. Enter the necessary information into these fields:

Type Use the drop-down list to determine whether the Single or Multiple Selection
Drilldown page displays for the daily user. If you select “Single,” the user
can only select one value from the drill-down page. “Multiple” allows users
to select multiple options in the drill-down page by pressing the “Ctrl” key
and clicking all of the desired options on the page. For an example of the
Selection Pages, see ASI Drill-Down Table Select Single Item and ASI Drill-
Down Table Select Multiple Items.
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Parent Column/Field Select the ASI Table Group from the drop-down list. The drop-down option
relates to the ASI subgroup you selected on the Drill Down tab. When
creating a new ASI table drill-down this field is editable. When updating an
existing ASI table drill-down the field is read-only, but you can delete the
row.

Parent Drop Down Click Search to select the shared drop down list used to populate the first
level on the ASI table drill down.

Child Column/Field Select the ASI Table Subgroup from the drop-down list. The drop-down
option relates to the ASI subgroup you selected on the Drill Down tab. When
creating a new ASI table drill-down this field is editable. When updating an
existing ASI table drill-down the field is read-only, but you can delete the
row.

Child Drop Down Click Search to select the shared drop-down list used to populate the
second level on the ASI table drill down.

c. Click Submit.

Civic Platform saves the series information.

Assigning Values to an ASI Drill-Down Series
The Value Mapping tab for an ASI field drill-down enables the data values in the Child ASI Field column to
be mapped to the Parent ASI Field column data values. The Value Mapping tab for an ASI table drill-down
enables the data values in the Child ASI Table column to be mapped to the Parent ASI Table column data
values. You define the data values with shared drop-down lists. The nodes in this level depend on your
selections in the Drill Down Series tab. When you create the ASI drill-down field or the ASI drill-down table,
all of the values from the shared drop-down list display in the Value Mapping tab, which enables you to use
duplicate Child values for multiple Parent criteria. For example, two categories, such as “condominium”
and “single-dwelling,” could potentially drill down into the same subcategories of demolition, remodel, and
stick-built. An administrator can select “demolition,” “remodel,” and “stick-built” as subcategories of both
categories. For more information about shared drop-down lists, see Creating Shared Drop-down Lists.

To assign values to an ASI Drill Down Series

1. Access the ASI Drill-Down portlet (Accessing the ASI Drill-Down Portlet).

2. Click the link to the ASI drill-down you want to work with.

3. Go to the Value Mapping tab.

Civic Platform displays the series order.
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4. Click the plus (+) sign in the picker, then click the Parent ASI Field or Parent ASI Table item.

Civic Platform displays a secondary portlet.

5. Select the value(s) you want to apply to the drill down, and then click Submit.

6. Click the plus (+) sign in the picker, then click the Child ASI Field or Child ASI Table item.

Civic Platform displays the shared drop-down values.

7. Select the values you want to provide in the drill down.

8. Click Submit.

Enabling Drill-Downs to Display
Administrators must complete some configuration to enable the drill-downs to display for the user. These
steps include:

• Setting three FIDs

• Defining the ASI and ASI table groups and subgroups in Civic Platform Classic

• Setting user security permissions for the ASI group or ASI table group to Full Access

• Creating or editing shared drop-down lists

• Creating or editing ASI field or ASI table drill down records.

You associate an ASI group with the ASI field or table in the application. To specify the application to apply
the ASI drill-down to, you must associate the ASI field or table with the record type. The shared drop-down
lists contain the values for the ASI drill-downs.

Note:

As soon as you associate the ASI group with an ASI drill-down, the drill-down displays on the application
and in the application record, even if you have not assigned values to the ASI drill-down record. You can set
the ASI drill-down record as “inactive” until it is ready for the application.
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If ASI security settings block users from viewing the ASI fields or ASI tables for an application type, ASI
drill-downs assigned to that application type do not display for the user. Review these settings to ensure
you set them correctly. For information about setting permissions for an ASI field or ASI table, see Setting
Permissions for Application-Specific Info Groups and Table Groups.

ASI field and ASI table drill-downs are available to both Civic Platform and Citizen Access users. For
information about the additional steps required to configure this feature, see “Configuring ASI Table Drill-
Downs” in the Citizen Access Administrator Guide.

To enable drill downs to display

1. Set the permissions for the ASI group or ASI table group to Full Access.

For information about setting permissions for an ASI field or ASI table, see Setting Permissions for
Application-Specific Info Groups and Table Groups.

2. For ASI field drill-downs, create or edit the application-specific information (ASI) Group and ASI
Subgroup.

For ASI table drill downs, create or edit the application-specific information (ASI) Table Group and ASI
Table Subgroup.

For further details on ASI and ASI Tables see Defining Custom Fields (Application Specific Information).

3. Create or edit the shared drop-down lists with the values needed for the drill down.

For details on completing this task, see Creating Shared Drop-down Lists.

4. Create or edit the ASI field or ASI table drill-down record.

For details on completing this task, see Creating or Editing an ASI Field Drill-Down or Creating or
Editing an ASI Table Drill-Down.

Setting Up Security Policies
Security policies enable you to control who has permission to access an object and to automate what
happens next when an object type reaches a certain status.

For example, you can restrict access to a building permit application when its status is Plan Review by
limiting users ability to schedule and result inspections while the application is in that status, and allowing
them to only view the application. When the application status changes to Issued, users can schedule and
result an inspection.

Click a topic title below for full details.

Related Links

Adding Record Type Security

Adding or Editing Workflow Task Security

Adding or Editing Inspection Type Security

Adding or Editing an Inspection Default Value Policy

Adding or Editing Inspection Type and Status Security

Adding or Editing Condition Type Security

Setting Permissions for Application-Specific Info Groups and Table Groups

Adding or Editing Asset Type Security

Adding or Editing EDMS Type Security

Adding or Editing Contact Type Security

Managing Recipients in Administration Portlets
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Configuring Session Time Out

Adding Record Type Security
To set security on a record type in Civic Platform, you must first define each FID in the Standard Choice
APPLICATION_TYPE_SECURITY_FID.

The record type security defined in Civic Platform also takes effect in Mobile Office. For example, if you set
limitations on the status of a record type in Civic Platform, the limitations also apply to Mobile Office. Full
access lets users view and modify the record status when creating or editing records from Mobile Office;
Read-only access lets users only view the record status; and an access level of None lets users neither
view nor update the record status.

The process to set limitations on record status is through FID 8141 Application Status setting and the
record type security setting. The FID setting takes priority over the record type security. If you set FID 8141
Application Status to Read-only or None, Mobile Office adheres to the FID setting only. If you set FID 8141
Application Status to Full Access, Mobile Office adheres to the record type security based on these rules:

• If you assign different security levels to the record type and its record status, the permission set on the
record status takes effect. Otherwise, inherit the permission set on the record type.

• If you assign multiple security levels to an Application Status (user group, module, or agency, user
group), the security setting assigned to the user group takes effect.

• If you assign different security levels to the Application Status functional area at the same level (user
group, module, or agency), the maximum permission takes effect.

Note:

If multiple security policies apply to an individual user, the security policy assigned to the user group
determines the security level. For example, if an individual user is in a user group that has Full access
but that user has only View access, the user security policy (View) applies.

Adding or Editing Workflow Task Security
The workflow task list displays only those tasks that the workflow supervisor can fully access, determined
by workflow task security policies. No workflow tasks display if the supervisor has no access or only read
access to those tasks.

You can limit access to a building permit application if the status is Plan Review by restricting users ability
to schedule inspections and result inspections, and allowing them to only view the application. When the
application status changes to Issued, users can schedule and result an inspection.

You can configure workflow task security in the Workflow Security portlet (Navigating to the Setup Portlet).
For information on how to assign recipients to a workflow task, see Managing Recipients in Administration
Portlets.

Adding or Editing Inspection Type Security
You can establish three security levels for inspection types. Full access lets users add, modify, and delete
inspections; Read-only access lets users only view inspections; and None lets users neither view nor
change inspections.

Civic Platform uses the security settings for an inspection group or an inspection type if they are different
from the agency inspection settings. If you assign security settings for both an inspection group and a
security type within that group, the security settings for the inspection type take effect.
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Note that Civic Platform assigns access to an inspection based on the specific inspection security settings.
For example, if an inspection is read-only to a user or user group, then those users cannot modify, delete,
or copy checklists assigned to the inspection.

The inspection type security defined in Civic Platform also takes effect in Mobile Office. For example, if you
set an inspection type to No Access for a user group in Civic Platform, users of that group cannot view the
details about the inspections of that inspection type in Mobile Office. The inspection type is not available in
any Inspection Type drop-down list either.

You can configure inspection type security in the Inspection Type Security portlet (Navigating to the Setup
Portlet). For information on how to assign recipients to an inspection type, see Managing Recipients in
Administration Portlets.

Adding or Editing an Inspection Default Value Policy
To add or edit inspection default value policy

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Agency Profile > Security Policy.

Civic Platform displays the Agency Security Policies-Select Policy page.

3. Click Inspection Default Value Policy.

Civic Platform displays the Inspection Group Select screen.

4. If you know the inspection group you want to work with, enter it in the Inspection Group field; otherwise,
leave the field blank.

5. Click Submit.

Civic Platform displays the Inspection Group list.
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6. Click the link for the inspection group you want to work with. To assign security settings for all
inspection groups, click the All Inspection Groups link.

Civic Platform displays the Inspection Type list.

7. Click the link for the inspection type you want to work with. To assign security settings for the entire
inspection group, click the All Inspection Types link.

Civic Platform displays the security policy for the inspection type.
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8. To add a new agency or a new group, select from the drop-down list the Agency or Group Name whose
access level you want to specify.

9. Choose the Default Status for all new inspections assigned to the inspection group and inspection type.

10.Enter the Number of Calendar Days Available (from 1 to 90) for a public user to schedule an inspection.
The default value is 30.

Note:

To enable this feature, you must configure the inspection blockout calendar. For more information, see
Setting Up Inspection Calendars for Public Users.

11.Select Allow Same Day Inspection Scheduling, to enable users to schedule inspections on the same
day they create the application.

12.Enter the Cutoff Time after which users cannot schedule the inspection for the following day.

13.Select Enable from the Status drop-down list if you want to activate this application type security;
otherwise, select Disable.

14.If this is a new policy, Click Add.

Civic Platform adds the security group to the list.

15.Click Save.

Civic Platform saves the security policy.

Adding or Editing Inspection Type and Status Security
If your agency uses Accela Wireless, you might set a code enforcement inspector’s inspection status to
Schedule. This lets code inspectors schedule, inspect, and record the results for a broken gas or water line
immediately, instead of having to wait for someone else to schedule the inspection.

To establish an inspection type and status security policy

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Agency Profile > Security Policy.

Civic Platform displays the Agency Security Policies—Select Policy page.

3. Click the Inspection Type and Status Security link.

Civic Platform displays the Inspection Group Select page.

4. If you know the inspection group you want to work with, enter it in the Inspection Group field;
otherwise, leave the field blank.

5. Click Submit.

Civic Platform displays the Inspection Group list.

6. Click the link for the inspection type you want to work with. To assign security settings for all of the
conditions, click the All Inspection Groups link.

Civic Platform displays the Agency Security Policies—Select page.

7. Click the inspection type you want to work with.

Civic Platform displays the Agency Security Policies—Scope page.



 | Part 3: Configuring Agency Business Objects | 315

8. To add a new agency or a new group, select the agency name or group name whose access level you
want to specify. Civic Platform uses the security settings for a user group if they are different from the
agency security settings.

9. Select the Inspection Status for the agency and for the user group. Leave this field blank and select
Create if you want to allow a group or user to create a new inspection. If you leave this field blank, it
deactivates the other available options.

10.Select the access level for the group (Edit, View, or None).

11.Select Enable from the Status drop-down list if you want to activate this application type security;
otherwise, select Disable.

12.If this is a new policy, Click Add.

Civic Platform adds the inspection default value policy to the agency and group.

13.Click Save.

Civic Platform saves the inspection default value policy.

Adding or Editing Condition Type Security
To add or edit condition type security

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Agency Profile > Security Policy.

Civic Platform displays the Agency Security Policies—Select Policy page.

3. Click the Condition Type Security link.

Civic Platform displays the Condition Type Select page.

4. If you know the condition type you want to work with, enter it; otherwise, leave the field blank.

5. Click Submit.

Civic Platform displays the Condition Type list.

6. Click the link for the condition type you want to work with. To assign security settings for all the
conditions, click the All Condition Types link.

Civic Platform displays the security policy for the condition type.

7. To add a new agency or a new group, select from the drop-down list the agency name or group name
whose access level you want to specify.

8. Select the access level for the group (Full or Read-only).

9. Select Enable from the Status drop-down list if you want to activate this application type security;
otherwise, select Disable.

10.If this is a new policy, Click Add.

11.Click Save.

Civic Platform saves the security policy.
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Setting Permissions for Application-Specific Info Groups and Table
Groups

To set permissions for ASI Groups and ASI Table Groups

1. Access the ASI Security portlet (Navigating to the Setup Portlet).

2. Select the application specific information (ASI) group or table you want to give access to the users.

To apply the permissions to all ASI groups or tables, click ASI Groups or ASI Tables in the navigation
tree.

To search for a specific application specific information (ASI) group or table, complete one of these
options:

• Click the plus sign next to the ASI Group or ASI Table Group label on the navigation tree to expand
or collapse the view.

Civic Platform expands the navigation tree to display the subgroups and types.

• Click Search.

Civic Platform displays a search page.

1. Enter a value in the Search field. The user can enter a maximum of 24 characters.

2. Click OK.

You can cancel the search by clicking Cancel. Civic Platform closes the Search window and
displays the ASI Security navigation tree.

Civic Platform highlights in red all matched records through the entire ASI Security navigation
tree.
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3. Click the ASI Group or ASI Table Group to which you want to apply permissions.

Civic Platform displays the ASI Group or ASI Table Group in the permission detail portlet.

3. In the permission detail portlet, click or roll your mouse over Assign, and select an assignment option.

For more information, see Managing Recipients in Administration Portlets.

Adding or Editing Asset Type Security
You can set the access level for asset types in the Asset Security portlet (Accessing the Asset Security
Portlet). For more information, see Managing Recipients in Administration Portlets.

Adding or Editing EDMS Type Security
You can set up authentication by site or by user. If you choose site authentication, you must also set up a
site-wide user name and password. If you choose user authentication, users must enter their Civic Platform
credentials before they can perform the certain actions. If you do not set up any authentication, users can
directly access the EDMS without logging in.

To add or edit EDMS type security

1. Access the Classic Administration page (Accessing Classic Administration).
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2. Navigate to Agency Profile > Security Policy.

Civic Platform displays the Agency Security Policies—Select Policy page

3. Click the EDMS Access Security link.

Civic Platform displays the EDMS Type Select page.

4. Click the EDMS type you want to work with.

Civic Platform displays the EDMS Security window.

5. To add a new agency or a new group, select from the drop-down list the Agency or Group Name whose
access level you want to specify.

6. Select any of the access levels you want the group to have (Upload, Download, View, and Delete). This
functionality is also applicable to attachments in Citizen Access.

7. Select Enable from the Status drop-down list if you want to activate this application type security;
otherwise, select Disable.
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8. If you enable more than one EDMS security policy from the list, check the box next to the policy you
want to set as the Default policy.

Note:

Add-on products that use GovXML (the legacy Accela GIS, Accela Wireless, and Accela IVR) store
documents only in the default EDMS adapter.

9. Do one of the following:

a. To prompt users to enter their user name and password when uploading a document, select the
User option. The first time users receive this prompt to enter their user name and password, they
can select the “Remember” option for their login credentials.

b. To require users to enter credentials for EDMS authentication, select the Site option and enter the
site credentials

10.If this is a new policy, Click Add.

11.Click Save.

Civic Platform saves the security policy.

Adding or Editing Contact Type Security
Civic Platform divides contacts into two categories: record contacts that users associate or manually add
to records, and reference contacts that users work with from the Reference Contact portlet. You only need
to define security for record contact types. If you go to the Contact Type Security portlet and expand the
Record Contacts navigation tree node (see Figure 17: Record Contact Type Setting Portlets), you can view
all the contact types that are “for transactions” or “for both” in the CONTACT TYPE Standard Choice. You
can then select a contact type and establish the security levels for modules, user groups, and individual
users.

Because reference contacts are reference data, which are generally accessible and shared in various
transactions across departments, it is no longer necessary to define security for reference contact types.

In the Contact Type Setting portlet, you can limit the use of specific contact types by module and establish
three security levels for each contact type configured in the CONTACT TYPE Standard Choice. Table 57:
Contact Type Security Levels explains the security levels. Based on your Standard Choice configuration,
security policies are effective in Civic Platform, Citizen Access, and/or Mobile Office.

Table 57: Contact Type Security Levels

Security
Level

Description

Full Users can view, add, modify, and delete the contacts of certain contact types.Users can search for
records or contacts by certain contact types.Users can search for inspections by certain contact
types (in Mobile Office only).

Read-Only Users can view the contacts of certain contact types but cannot add or modify the contacts of
those types.Users can search for records or contacts by certain contact types.Users can search for
inspections by certain contact types (in Mobile Office only).

None Users have no access to certain contact types and the contacts of those types.

By default, users have full access to all contact types from within all modules and the reference Contact
portlet. If a contact type is available for multiple modules, then you can limit the use of the contact type
by module through specifying the applicable module in the Contact Type Setting portlet. If some contact
information is sensitive, then you can limit access to the sensitive information by setting Read-Only or
None access for certain users in the Contact Type Setting portlet.
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Figure 17: Record Contact Type Setting Portlets

To define security for record contact types

1. Access the Contact Type Setting portlet (Accessing the Contact Type Setting Portlet).

2. Click the plus sign (+) to the left of the Record Contacts node.

Civic Platform displays all available record contact types under the Record Contacts node.

3. Highlight the contact type to which you want to apply a security policy.

Civic Platform displays the Module list for the contact type.
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4. Click the link to the module that you want to define security levels for.

Click Add, select a module, and then click Submit to add the module to the Module list.

Civic Platform displays the Permission list for the module.

5. Click Assign and choose which level to apply the contact type security. You can select Assign
Module, Assign Group, or Assign User from the drop \\\down menu.
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Managing Recipients in Administration Portlets
Civic Platform provides a Recipient tab or a Permission tab in several administration portlets for you
to assign permissions to the relevant administrative settings. For example, Figure 18: Recipient Tab in
Console Configuration shows the Recipient tab in the Console Configuration portlet, Figure 19: Permission
Tab in Asset Type Security shows the Permission tab in the Asset Type Security portlet. You can click the
Assign buttons in either of the portlets to decide which agency, module, user group, and user has access
to the current record.

Figure 18: Recipient Tab in Console Configuration

Figure 19: Permission Tab in Asset Type Security

This section provides instructions on how to assign recipients with the Assign buttons in the Recipient or
Permission tab.

To manage recipients in an administration portlet

1. Go to an administrative portlet, and select a record in the portlet to which you want to assign recipient.

2. Click Recipient or Permission tab.

3. Click one of the following buttons to select which organization level you want to assign permission to
the record.

Note:

In different administration portlets, the availability of the buttons varies.

• Assign Agency. The entire agency has permission to the record.

• Assign Module. To select one or more modules. All users of the selected modules have permission
to the record.

• Assign Department. To select one or more departments. All users of the selected department have
permission to the record.

• Assign Group. To select one or more user groups. All users of the selected groups have permission
to the record.

• Assign User. To select one or more users. All selected users have permission to the record.
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• (In the Message administration portlet only) Assign Role. To select one or more public user groups,
including registered users, anonymous users, and licensed professionals. All selected user groups
have permission to the record.

Civic Platform displays a selection hierarchy, for example, the module-selection hierarchy.

4. In most cases, you can search for a module, group, or user in the selection hierarchy.

To search for a module, group, or user, complete the following steps:

a. Click the plus sign next to the Module, Group, or User label on the navigation tree.

Civic Platform expands the navigation tree to display names.

b. Click Search.

Civic Platform displays a search page.

c. Enter a value in the Search field. The user can enter a maximum of 24 characters.

d. Click OK.

Civic Platform highlights in red all matched records through the navigation tree.

e. Select the module, user group, or user, and then click Submit.

5. Select a recipient.
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Click plus (+) sign to expand folders in the hierarchy. Click minus (-) sign to collapse folders until you
locate the recipient you want.

6. Click Submit.

Civic Platform adds the selected recipients for the current record.

7. If you are assigning recipients in the Permission tab, specify the access level of the recipient from the
Access drop-down list (full, read or read-only, none or no access).

8. If you are assigning recipients in the Permission tab to a record type, inspection type, or asset
type, you have the options to configure more access options for the selected recipient. For example,
configure the inspection status access to an inspection type.

9. Click Submit.

Civic Platform saves the access settings.

10.If you need to remove a recipient from the recipient list, select the recipient you want to delete and click
Delete.

Configuring Session Time Out
Accela administrators can configure their system to time out after a period of inactivity, to minimize security
risks. You can specify the maximum amount of time that a Civic Platform session can remain idle before it
ends automatically, requiring the user to re-enter their login credentials. You can also configure a warning
dialog box to display, enabling the user to

By default, the time-out setting is 7200 seconds (2 hours). You can adjust the session time-out value
(in seconds) by configuring the Standard Choice SESSION_TIMEOUT at the agency level or by editing
the XPolicy.csv file at the Web server level. If both the Standard Choice SESSION_TIMEOUT and
the XPolicy.csv file specify the session time-out value, the session time-out setting at the agency level
overrides that at the server level. If the Standard Choice does not specify a session time-out value, Civic
Platform enforces the time-out setting configured in the XPolicy.csv file.

The minimum time-out value is 10 minutes (600 seconds). If you specify a value less than 600 seconds,
Civic Platform automatically enforces a session time-out period of 10 minutes.



 | Part 3: Configuring Agency Business Objects | 325

To configure the session time-out value at the Web server level

1. On the server where you host Civic Platform, open the XPolicy.csv file.

2. Locate the sso.session.timeout property in the LEVEL_DATA column.

3. Enter a value greater than 600 in the DATA1 column next to the sso.session.timeout property.

4. Save the file.

To configure the session time-out value at the agency level

1. Log in to Civic Platform.

2. Configure the Standard Choice SESSION_TIMEOUT by adding the value Timeout, with a value
description of any number greater than 600. This value is the number of seconds of inactivity after
which Civic Platform times out.

For example, if you want Civic Platform to time out after 15 minutes, set the value description to 900.
The default is 7200 (2 hours).

Refer to “Standard Choices,” in the Accela Civic Platform Configuration Reference for complete details
on setting up Standard Choices.

3. Click Update.

4. Clear the cache:

a. Navigate to the Cache List portlet.

b. Click Clear Cache.

c. Select the Cache Name option at the top of the page to select all cache items.

d. Click Clear.

Session Time Out Warning
Accela administrators can configure a session time-out warning that displays notifying users that the
session is about to expire. Users can select Yes in the time-out warning to continue their session or No to
allow their session to expire, as shown in the sample screen below:

To configure a session time-out warning

1. Log in to Civic Platform.

2. Configure the Standard Choice SESSION_TIMEOUT by adding the value Timeout Warning with a value
description of the number second prior to timing out Civic Platform displays the time out warning.

For example, if you enter a value description of 300 the time-out warning displays to the user 5 minutes
before the session times out. The default value is 120 (2 minutes). The Timeout Warning value must be
less than the time out value.

Refer to “Standard Choices,” in the Accela Civic Platform Configuration Reference for complete details
on setting up Standard Choices.
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3. Click Update.

4. Clear the cache:

a. Navigate to the Cache List portlet.

b. Click Clear Cache.

c. Select the Cache Name option at the top of the page to select all cache items.

d. Click Clear.

Defining Sequences, Masks, and Autonumbering
This section provides details about numbering sequences and masks, and how to apply them to any item
in Civic Platform that requires numbering, such as application types, invoices, and receipts.

Using the sequence generator you can define masks for numbered items. A mask in Civic Platform
determines how a number displays to a user. For example, each new permit number might have a prefix
indicating the type of permit and a date code in addition to the incremental number. A citation number can
have a prefix that identifies it as a citation and not a permit, receipt number, or other incremental record in
Civic Platform. After the initial implementation, you rarely need to modify masks.

Click a topic title below for full details.

Related Links

Accessing the Sequence Generator

Setting Up Number Sequences and Masks

Managing Sequence Intervals and Last Number Used

Understanding Recommended Mask Formats

Accessing the Sequence Generator
You can access the sequence generator portlets from the setup administration menu.

To view the sequence generator portlets

1. Go to Civic Platform Administration > System Tools > Sequence Generator.

Civic Platform displays the portlet.
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Setting Up Number Sequences and Masks
This section explains how to define a Sequence Definition. We provide instructions for Mask Definitions
and provide examples for sequence numbering and formatted output of a sequence (how the result
displays to the user).

Civic Platform divides all Sequence Definitions into three elements, the Sequence Definition, the Mask
Definition, and the Sequence Intervals.

You must define the Sequence Definition before you can assign it to a Mask Definition.

Civic Platform organizes sequence types into several categories: Agency, Asset ID, Record ID, Record
Key, Partial Record ID, Temporary Record ID, and Receipt. For each category there is a pre-defined
setting that you can use without further configuration. It is ready to use immediately.

You can refer to Table 60: Pre-Defined Sequences and Masks. This table lists each default sequence type,
mask name, sequence definition name, and a description of the default sequence types.

To create or modify a sequence

1. Access the Sequence Definition portlet (Navigating to the Setup Portlet).

2. To define a number sequence, do one of the following:

• Create a new sequence for the item by right-clicking it from the navigation tree, then select New
Sequence. You can also click the Menu button and select New Sequence from the drop-down list.

The sequence Name displays in the Sequence Definition portlet to the right.
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Civic Platform organizes the items you can apply numbering to into several categories: Agency,
Asset ID, Record ID, Partial Record ID, Temporary Record ID, Record Key, and Receipt. Each
category has a Default numbering definition that is ready to use immediately, with no configuration.
To review the pre-defined or Default settings refer to Table 60: Pre-Defined Sequences and Masks.

Sequence by Type organizes sequence definitions based on the sequence type: Agency, Asset ID,
Record Id, Partial Record ID, Temporary Record Id, Record Key, and Receipt.

Sequence by Name lists the definitions based on the starting letter of the sequence definition name,
and then by the sequence type.

Mask by Type organizes mask definitions based on the sequence type: Agency, Asset ID, Record Id,
Partial Record ID, Temporary Record Id, Record Key, and Receipt.

Mask by Name lists the mask definitions based on the starting letter of the mask name, and then by
the sequence type

• To locate an existing item in the navigation tree, click the plus sign (+) to the left of the sequence or
mask type to expand the list of items.

3. Complete or update the Sequence Definition fields. For field descriptions refer to Table 58: Sequence
Definition Fields.
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4. Click Submit.

Civic Platform saves the Sequence Definition.

5. Click Refresh in the Navigation Tree to display the sequence you just created or updated. Now, you
can apply a Mask Definition to the item.

Civic Platform loads the new sequence type you created or updated in the Navigation Tree.

6. In the tree, locate the new or updated sequence and select (+) Masks.

The Mask Definition portlet displays to the right.

7. Complete the Mask Definition fields. For field descriptions refer to Table 59: Mask Definition Fields.

8. Optionally, use the Validate button. It takes the Maximum and Minimum Length, Sequence Type,
and Sequence Number Base and validates them against the mask Pattern using a sequence of 1 and
today's date.

9. Click Submit to save the Mask Definition.

Civic Platform automatically manage the Sequence Interval.

Table 58: Sequence Definition Fields

Cache Size (Required) Enter the value to reflect how many of the numbers you want the sequence
to pull or reserve at a time. The default value is 1. We recommend you do not change
this value.

Description Text for describing the pattern or any other characteristics of this sequence definition.
Maximum of 200 characters.

Increment By (Required) Enter the number that specifies the increase using a positive integer. Civic
Platform does not support negative integers.

Interval Type Select the type of interval for this sequence. Options are None, Calendar Year,
Calendar Month, Calendar Day, Fiscal Year, Fiscal Quarter, Fiscal Month. The
sequence value restarts based upon the interval type.

For example, selecting Calendar Year means the sequence number resets itself to the
Starting Value at the start of every calendar year. Select None if you do not want the
sequence number to reset itself based upon a date.

Name Enter a unique name for this sequence definition. It must be unique within the
Sequence Type selected.

Reset Action This field works in conjunction with the Reset Value. Reset Action tells the sequence
generator what action to take if you exceed the Reset Value maximum. The default
setting is Exception. You must configure Record Keys and Record IDs to throw an
Exception.
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Note:

If you exceed the Reset Value maximum and an Exception error displays,
this is a very serious matter. Contact Accela Customer Support to resolve the
issue. You might need to change the format.

You must configure all categories to throw an exception, except the Agency sequence
type. You should only use the other one (Set to minimum) if duplicate sequence
numbers are acceptable. Do not configure the Set to minimum option unless you are
certain that duplicate numbers are not a problem.

Civic Platform stores many of the sequence numbers in database columns whose
values must be unique. If you choose the Set To Minimum option, the sequence
number resets to the Start Value if you exceed the Reset Value.

Reset Value Enter the maximum value you want Civic Platform to generate from this sequence
definition. When you exceed this maximum value the Reset Action triggers.

Sequence Type Groups of related sequence definitions. The groups are: Asset ID, Invoice, Record
ID, Partial Record ID, Temporary Record ID, Record Key, Receipt, and Agency.
One exception to this grouping is the Agency type which groups all single definitions
together. Each Sequence Type must have a unique Name.

NOTE: When you create the Mask Definition for an item, first select the Sequence
Type that is the same as the Sequence Definition. This filters the Sequence Definition
Name drop-down, listing only the Sequence Definitions available for that Type. Then
specify this Sequence Definition using the Table 59: Mask Definition Fields.

Start Value Minimum starting value for the sequence.

Status Enabled means you can use this definition. Set to Disabled if you no longer need to
use this sequence definition. You cannot delete a sequence definition

Table 59: Mask Definition Fields

Description Text for describing the pattern or any other characteristics of this mask. Maximum of
200 characters.

Maximum Length Enter a numeric value that defines the total number of allowed characters for the item
or for the formatted sequence output. For example, a receipt number, or a Record ID
number. Agency can be different for a pre-defined mask.

Minimum Length Enter the minimum number of characters for the formatted sequence output.

Name The name that defines the sequence mask.Maximum of 200 characters.

Pattern Mask pattern describes how Civic Platform formats the sequence output. You must
consider several fields when creating a pattern:

The Sequence Number Base field works with the pattern. To make the pattern human-
readable apply Base10. To use a key or coded apply Base36. The Sequence Number
Base (10 or 36) is in this part of the sequence output [$$SEQ$$].

The Reset Value and Interval Type in the Sequence Definition. See Recommended
Patterns and Sequence Reset Values.

Include the date value in the pattern of the Interval Type to prevent duplication of
numbers.

Sequence Def Name Select the sequence definition name for this mask to generate sequence numbers.

You can only select a sequence definition from the drop-down list that is the same
Sequence Type for the Mask Definition.You must define the Sequence Definition
before you can assign it to a Mask Definition.

Sequence Number Base Use Base 10 for user readable numbers. Use Base 36 to display the sequence output
[$$SEQ$$] using numbers and letters [0-9] and [A-Z].

See examples of mask patterns using Base 10 and Base 36 in Table 61: Example
Mask Patterns

.



 | Part 3: Configuring Agency Business Objects | 331

Sequence Type Select the category of the sequence. For example, Record ID or Receipt. You cannot
mix Mask Definitions and Sequence Definitions with different Sequence Types. You
also cannot assign a Record Key Mask Definition in place of a Record ID definition

Status Enabled means you can use this definition. Set to Disabled if you no longer need to
use this mask definition. You cannot delete a mask definition.

Managing Sequence Intervals and Last Number Used
Use the Sequence Interval portlets to either review the Interval Type and refer to the last number used in
the sequence. Or, if absolutely necessary, to change the value of the next number used for this Sequence
Definition.

Use the Sequence Interval portlets to either review the Interval Type and the last number used in the
sequence. Or, if absolutely necessary, to change the value of the next number used for this Sequence
Definition.

The Last Sequence Number field displays the last number used in the Sequence Interval. For example,
if 15 is the value in the Last Sequence Number field for a Batch Invoice and the Increment is 1, and you
enter 99 in the Last Sequence Number field, this forces the next Batch Invoice number to start with 100.

To review or change the Last Sequence Number value

1. Identify the item that you either need to review or change its last number used.

2. Highlight the Sequence Type in the navigation tree. For example, Agency > Batch Invoice, or Asset ID >
Default.

The Masks and Sequence Intervals options display in the tree.

3. Expand the Sequence Intervals option.

The list of Sequence Intervals displays.

4. Select the Sequence Interval name you want to review or change in the Sequence Interval list portlet on
the right.

5. Determine both the Increment By value for the item's Sequence Definition and what new number you
want to apply to the numbering of the Sequence Interval. The Last Sequence Number field displays the
last number used or applied to the item (from step 1) in Civic Platform.

6. Subtract from or add to the value, depending upon your numbering requirements, and enter it into the
Last Sequence Number field.

7. Click Submit to update the interval numbering.

Understanding Recommended Mask Formats
This section provides supporting information when using the sequence generator. It repeats key sequence
and mask concepts previously covered in this section. It also has several tables to refer to when defining
the Pattern field in a Mask Definition. This information helps ensure the pattern you design meets your
numbering requirements.

Topics

• Understanding Masks

• Pre-defined Sequence Types and Masks

• Example Mask Patterns
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• Common Date Formats

• Fiscal Date Formats

• Sequence Number Formats

• Miscellaneous Formats

• Receipt Variables for Receipt Masks

• Recommended Patterns and Sequence Reset Values

Understanding Masks
You can apply masks to phone number and postal code fields to ensure that users enter these numbers
in the appropriate format. For example, your agency might want to require users to include their country
code with their phone number, or to require users to enter phone numbers as 888.555.1212 rather than
888-555-1212. If a user attempts to enter a number in another format, Civic Platform delivers an error
message and asks them to reenter the number.

When creating masks, enter “0”s or “#”s in the positions where you want Civic Platform to accept any
number or character. Civic Platform requires users to enter all characters in the expected format and
position. For example, to create a format that forces users to enter a phone number in the format
(800)555-1212 x.555, enter (000)000-0000 x.###.

Using the sequence generator you can define masks for numbered items. A mask in Civic Platform
determines how a number displays to a user. For example, each new permit number might have a prefix
indicating the type of permit and a date code in addition to the incremental number. A citation number can
have a prefix that identifies it as a citation and not a permit, receipt number, or other incremental record in
Civic Platform. After the initial implementation, you rarely need to modify masks.

When creating the pattern of the mask, be certain that you include the interval type within the sequence
number. By including the interval type in the pattern ensures uniqueness. Without the interval type, you
might introduce duplicates.

Mask Definitions can only reference a single Sequence Definition. You can have many mask definitions
that point to the same sequence definition. This way, you can have multiple masks using the same number
pool. For example, you might want to use a single number pool for all of the application types for the
building module but have the mask display different information with that number. For example: you could
name your Record ID Sequence Definition “Building” and then your mask definitions “Building-Residential”
and “Building-Commercial” could reference Sequence Definition Building.

A mask pattern consists of a combination of variable substitutions and literal text. A pattern has one
sequence number variable you can place anywhere in the pattern. All variables can appear in any position
of the mask pattern. Enclose all variables in “$$” delimiters. For example, you write a sequence number
variable as $$SEQ08$$. For example, a mask might contain CIT to indicate that the number is a citation
number. This section details the various items that you can include in the pattern.

Sequence mask patterns return results in all uppercase.

All variable names are case-sensitive. For example $$MM$$ represents month data but $$mm$$ represents minutes
data.

For the basic building blocks of masks, refer to Example Mask Patterns.

The date patterns can represent year, month, day, day of year, hour, day of month, day of week. For a list
of all mask pattern possibilities, refer to the Common Date Formats.

With pattern masks, you can represent numbers as Base 10 (meaning each digit can be 0-9) or Base 36
(meaning each digit can be 0-9 or A-Z). For example, you can represent over 60 million different Record
Keys from the same number pool (sequence interval) without conflict.

Example Record Key pattern $$yy$$BLD-00000-$$SEQ05$$ with a base of 36
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Corresponding Record ID pattern $$yy$$BLD-$$SEQ08$$ with a base of 10

Pre-defined Sequence Types and Masks
Pre-Defined Sequences and Masks lists the predefined sequences and masks that come with Civic
Platform. This section also explains how to locate the pre-defined sequences by the Default name in the
navigation tree.

Table 60: Pre-Defined Sequences and Masks

Sequence
Type

Mask Name Mask Definition Name Description Best Practices

Agency >
Batch Invoice

Batch Invoice Batch Invoice Special Purpose Agency Sequence.
Batch Invoice definition is $$SEQ12$
$ with the numbers displayed as base
10. Sequence Interval equals “None”
which means it never resets based
upon a date.

Use the default
setting and do
not modify the
default.

Agency>
Classic
Citation
Number

Classic Citation
Number

Classic Citation
Number

Special Purpose Agency Sequence.
Classic Citation Number definition is $
$SEQ19$$ with the numbers displayed
as base 10.

Sequence Interval equals “None”
which means it never resets based
upon a date.

Use the default
setting and do
not modify the
default.

Agency >
Invoice

Invoice Invoice Special Purpose Agency Sequence.
Invoice definition is $$SEQ12$$ with
the numbers displayed as base 10.
Sequence Interval is equal to “None”
which means it never resets based
upon a date.

Use the default
setting and do
not modify the
default.

Agency
> Project
Number

Project Number Project Number Special Purpose Agency Sequence.
Project Number definition is $
$SEQ19$$ with the numbers displayed
as base 10. Sequence Interval is equal
to “None” which means it never resets
based upon a date.

Use the default
setting and do
not modify the
default.

Agency >Set
ID

< Set ID Masks
are listed
below>

Set ID Special Purpose Agency Set ID
Sequence Definition.

Set ID defaults to a single Set ID
shared by multiple Set Masks. You can
modify each Set Mask to use a unique
number pool.

The Sequence Interval is equal to
“Calendar Year” so it resets based
upon a calendar year.

Civic Platform uses this Set ID
Sequence Definition for all of the
different Set ID Masks, including
Address Set ID, Record Set ID,
Licensed Professional Set ID, Parcel
Set ID, RandomAudit Set ID, and Set
of Sets ID.

Use default
setting.
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Sequence
Type

Mask Name Mask Definition Name Description Best Practices

Address Set ID Set ID The Record Set ID Mask Pattern is $
$yy$$-SET-$$SEQ05$$ with a base
of 10. Civic Platform shares the Set ID
Sequence Definition with the other Set
ID masks.

Use default
setting.

Record Set ID Set ID The Record Set ID Mask Pattern is $
$yy$$-SET-$$SEQ05$$ with a base
of 10. Civic Platform shares the Set ID
Sequence Definition with the other Set
ID masks.

Use default
setting.

Licensed
Professional Set
ID

Set ID The Licensed Professional Set ID
Mask Pattern is $$yy$$-LP-$$SEQ05$
$ with a base of 10. Civic Platform
shares the Set ID Sequence Definition
with the other Set ID masks.

Use default
setting.

Parcel Set ID Set ID The Parcel Set ID Mask Pattern is $
$yy$$-PARCEL-$$SEQ05$$ with a
base of 10. Civic Platform shares the
Set ID Sequence Definition with the
other Set ID masks.

Use default
setting.

Set of Sets ID Set ID The Set of Sets ID Mask Pattern is $
$yy$$-SETS-$$SEQ05$$ with a base
of 10. Civic Platform shares the Set ID
Sequence Definition with the other Set
ID masks.

Use default
setting.

Asset ID >
Default

Default Default The Default Mask Pattern for the Asset
ID is $$SEQ015$$ with a base of 10.

The Sequence Interval Type is equal
to None and the Sequence Name is
“N” which means it never resets based
upon a date.

Use default
setting.

Invoice Agency-Invoice Agency-Invoice Agency Invoice Sequence. Agency-
Invoice definition is $$SEQ12$$ with
the numbers displayed as base 10.
The Sequence Interval is equal to
“None” which means it never resets
based upon a date (the agency default
if you do not set up any custom
receipts).

Use the default
setting and do
not modify the
default.

Invoice POS-Invoice
<module>

POS-Invoice <module> Agency Invoice Module.

Point of Sale invoice module masks
can follow the pattern in your agency’s
accounting system. The Mask
Definition and Sequence Definition that
applies to a POS invoice is equal to
“POS-Invoice-<module>.”

This configuration enables you to
identify what department or group
to associate with the Point of Sale
(POS) invoice. For example, replace

Configure Point
of Sale Invoice
the same as any
other custom
invoice.
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Sequence
Type

Mask Name Mask Definition Name Description Best Practices

<module> with a department name
such as “POS-Invoice-Building.” You
must create invoice sequences and
mask definitions before you can use
the point of sale features.

The Sequence Interval Type is equal
to Calendar Year and the Sequence
Name is “CYyyyy” where yyyy reflects
the year in four digits so it resets
based upon a calendar year.

Record ID Default Default The Record ID Default can handle
over 60,000,000 unique keys every
year. The Mask Pattern is $$yy$
$Record-00000-$$SEQ05$$ with a
base of 36 because it is a key.

The Sequence Interval Type is equal
to Calendar Year and the Sequence
Name is “CYyyyy” where yyyy reflects
the year in four digits so it resets
based upon a calendar year.

Use default
setting.

Record Key Default Default The Record Key Default can handle
over 60,000,000 unique keys every
year. The Mask Pattern is $$yy$
$Record-00000-$$SEQ05$$ with a
base of 36 because it is a key. The
Sequence Interval Type is equal to
Calendar Year and the Sequence
Name is “CYyyyy” where yyyy reflects
the year in four digits so it resets
based upon a calendar year.

Use default
setting.

Record Key Model Record Model Record Special Purpose Record Key
Sequence. You can have up to 9999
models defined each year in Civic
Platform. The Defaultpattern is: $$yy$
$MDL-00000-#$$SEQ04$$ The base
is 10.

Use the default
setting and do
not modify the
default.

Partial Record
ID

Default Default Special Purpose Record ID Sequence.
The Default pattern is $$yy$$EST-$
$SEQ06$$. The base is 10.

The Sequence Interval Type is equal
to Calendar Year and the Sequence
Name is “CYyyyy” where yyyy reflects
the year in four digits so it resets
based upon a calendar year.

Use the default
setting and do
not modify the
default.

Temporary
Record ID

Default Default Special Purpose Record ID Sequence.
The Default pattern is $$yy$$TMP-$
$SEQ06$$. The base is 10.

The Sequence Interval Type is equal
to Calendar Year and the Sequence
Name is “CYyyyy” where yyyy reflects

Use the default
setting and do
not modify the
default.
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Sequence
Type

Mask Name Mask Definition Name Description Best Practices

the year in four digits so it resets
based upon a calendar year.

Receipt Agency-Receipt Agency-Receipt Special Purpose Receipt Sequence.
Agency-Receipt definition is $
$SEQ12$$ with the numbers displayed
as base 10. The Sequence Interval is
equal to “None” which means it never
resets based upon a date (the agency
default if you do not define any custom
receipts).

Use the default
setting and do
not modify the
default.

Receipt POS-Receipt-
<module>

POS-Receipt-
<module>

Special Purpose Receipt.

Point of Sale receipt masks are for
special purpose Receipts. The point
of sale system uses this by getting
the Mask Definition and/Sequence
Definition named “POS-Receipt-
<module>” where <module> is the
name of the Point of Sale (POS)
receipt that you are defining.

For example, “POS-Receipt-Building.”
You must create receipt sequence and
mask definitions before you can use a
point of sale.

The Sequence Interval Type is equal
to Calendar Year and the Sequence
Name is “CYyyyy” where yyyy reflects
the year in four digits so it resets
based upon a calendar year.

Configure Point
of Sale Receipts
the same as any
other custom
receipt.

Receipt PP-Receipt PP_RECEIPT_SEQ Special Purpose Receipt. Payment
Processing receipt masks are
for special purpose Receipts.
The Payment Processing system
uses them by getting the Mask/
Sequence Definition named
“PP_RECEIPT_SEQ.”

You must create these receipt
sequence and mask definitions before
you can use Payment Processing.

Configure
Payment
Processing
Receipts the
same as any
other custom
receipt.

Receipt SET-Receipt
<module>

SET-RECEIPT_SEQ Special Purpose Receipt. Create Set
receipt masks for special purpose
Receipts. The Set/Sets system uses
this by getting the Mask/Sequence Def
named “SET_RECEIPT_SEQ.”

You must create receipt sequence and
mask definitions before you can use
Payment Processing.

Configure Set/
Sets Receipts
the same as any
other custom
receipt.

Receipt POS-Invoice-
<module>

POS-Invoice-
<module>

Special Purpose Invoice.

Create Point of Sale Invoice masks
as a special purpose Invoice. The

Configure Point
of Sale Invoices
the same as any
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Sequence
Type

Mask Name Mask Definition Name Description Best Practices

point of sale system uses them by
getting the Mask/Sequence Def named
“POS-Invoice-<module>” where
<module> is the name of the Point of
Sale (POS) invoices you are defining.
For example, “POS-Invoice-Building.”

You must create these invoice
sequence and mask definitions before
you can use POS.

other custom
receipt.

You can locate the Default settings by expanding the Sequence by Type in the navigation tree. Refer to
illustrations highlighting Default examples of a default Sequence Definition and Mask Definition for the
Asset ID.

Default Mask Definition for Asset ID, highlights where to locate the Default Sequence Definition for the
Asset.

Figure 20: Default Mask Definition for Asset ID

Default Sequence Definition for Asset ID, highlights the Default Mask Definition for the Asset ID.

Figure 21: Default Sequence Definition for Asset ID
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Example Mask Patterns
Table 61: Example Mask Patterns

Sequence Type Example Output

Invoice INV-$$yyyyMMddHH$$-$$SEQ08$$Base =
10Reset Value = 99999999 (10^8 – 1)

REC-2010083116-00000003

Record ID $$yyyy$$-$$SEQ07$$-RESBase = 10 (always
recommended for Record ID)Reset Value =
99999999 (10^8 – 1)

2008-00000001-RES2008-00000021-
RES2008-00000301-RES2008-00087601-
RES

Record ID LIC-$$yyyy$$-$$RANDOMZ06$$-$$SEQ##-####-
###$$Base = 10 Reset Value = 999999999 (10^9 –
1)

LIC-2008-9AD633-12-3456-789LIC-
2008-ZX8F3E-12-3456-789LIC-
2008-78934RT-12-3456-789LIC- 2008-
K8J7D3D-12-3456-789

Record Key $$yy$$BLD-00000-$$SEQ05$$Base=36Reset
Value = 60466175 (36^5 - 1) Note: In the pattern for
new Record Key definitions, always use Base=36,
Reset Value = 60466175 (36^5 - 1), and $$SEQ05$
$

08BLD-00000-0000108BLD-00000-
00A0108BLD-00000-0ZZ0108BLD-00000-
ZA421

Record Key $$yy$$BLD-00000-$$SEQ05$$Base = 10Reset
Value = 99999 (10^5 – 1)

08BLD-00000-0000108BLD-00000-
0001108BLD-00000-0043108BLD-00000-
08801

Receipt REC-$$CI$$-$$CDI$$-$$yyyyMMddHH$$-$
$SEQ08$$Base = 10Reset Value = 99999999
(10^8 – 1)

REC-DC4-02-2008071416-00002423

Common Date Formats
Table 62: Common Date Formats

Description Syntax Example of Output (2008-07-14 4:22 pm)

Year (2 digit) $$yy$$ 08

Year (4 digit) $$FYYY$$ 2008

Month in Year $$MM$$ 7

Month in Year $$MMM$$ Jul

Week in Year $$ww$$ 28

Week in Month $$W$$ 2

Day in Year $$DD$$ 197

Day in Month $$dd$$ 14

Day of Week in month $$F$$ 1

Day of Week in month $$EEE$$ Mon

AM/PM $$Accela
Automation$$

PM

Hour in Day (0- 23) $$HH$$ 16(Example: 2008-07-14 0:22 -> 00)

Hour in Day (1 - 24) $$kk$$ 16(Example: 2008-07-14 0:22 -> 24)

You can combine Simple Date patterns into a
single, more complex pattern.

$$yyMMdd$$ 080714
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Description Syntax Example of Output (2008-07-14 4:22 pm)

You can combine Simple Date patterns into a
single, more complex pattern.

$$yyMMM$$ 08JUL

You can combine Simple Date patterns into a
single, more complex pattern.

$$yyMMdd-HH$$ 080714-16

Fiscal Date Formats
Civic Platform supports fiscal years that start on the first day of a calendar month.

Table 63: Fiscal Date Formats

Description Syntax Example of Output (2008-07-14 4:22 pm with
Fiscal Year start = 07)

Fiscal Year (2 digit) $$FY$$ 09

Fiscal Year (4 digit) $$FYYY$$ 2009

Fiscal Quarter (1 digit) $$FQ$$ 1

Fiscal Month/Period (2 digit) $$FM$$ 01

Sequence Number Formats
Table 64: Sequence Number Formats

Description Syntax Description Example Output

$$SEQ$$Base = 10 99909990Sequence
Number (Default)

$$SEQ$$ 1-5 digits with valid digits
determined by Sequence Number
Base (2-36).

$$SEQ$$Base = 36 8Z2SDFZ9ZZ8

$$SEQ05$$Base = 10 00009000
100083830000

Sequence
Number

$$SEQ[0]n$$ [0] Left Zero Fill if sequence does
not require all n digits.n = maximum
number of digits to display. $$SEQ5$$Base = 36 19AZ10999A

Z8888

$$SEQ##-#####$
$Base = 10

01-23456

$$SEQ##-###-##$
$Base = 10

01-234-56

Sequence
Number
(formatted
number)

$$SEQ####$$ Formatted Number. Starts with # or
*. Each # represents one digit. Each
* represents one hidden digit.

Warning: Do not use hidden digits
if the sequence numbers generated
must be unique because doing so
causes the mask definition to return
duplicate sequences. Do not use
this option for asset IDs, record
keys, record IDs, or receipts for
Civic Platform to function properly.

Civic Platform treats any other
character as literal text.

$$SEQ*****-##$$Base
= 10

*****-56

Sequence
Number

$$SEQZ05$$ Legacy Record Key Sequence
Format. Most significant digit is base
36 (valid values are[0-9]|[A-Z]). All
other characters are base 10 (valid
values are [0-9].

$$SEQZ05$$ 0000199999
A0000A9999
B0000Z9999
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Miscellaneous Formats
Table 65: Miscellaneous Formats

Description Syntax Description Example Output

Literal Dollar
Sign

$$DOLLAR$$ Text $$DOLLAR$$ $

Random
Number
(Default)

$$RANDOM$$ Creates from 1-5 random digits
with values from [0-9].

$$RANDOM$$ 9 90 990
9990

Random
Number

$$RANDOM[Z][0]n$$ Creates from 1-20 random digits
with values from [0-9] (base 10)
or [0-9] |[A-Z] (base 36).[Z] set
= base 36. If not set = base 10.
[0] set = left zero fill to guarantee
the exact number of digits.n
= number of digits. Default=5,
Min=1, Max=20.

$$RANDOMZ05$$$
$RANDOMZ9$$

ASD83
23NMJKF823L12L
Z8M3829D2

Receipt Variables for Receipt Masks
The variables in Receipt Variables for Receipt Masks apply to receipt masks.

Table 66: Receipt Variables for Receipt Masks

Description Syntax Description Example
Output

Cash Drawer ID $$CDI$$ Cashier Drawer ID. Use only for receipt
sequences.

05

Cashier Workstation $$CI$$ Cashier Workstation Information. Use only
for receipt sequences

D42

Type Alias $$RECTYPE-ALIAS$$ Record Type Alias. Use only for receipt
sequences; does not work for PP-Receipt
and SET-Receipt.

Facilities
Condos

Group $$RECTYPE-1$$ The first element of application type. Use
only for receipt sequences but does not work
for PP-Receipt and SET-Receipt.

Building

Type $$RECTYPE-2$$ The second element of application type. Use
only for receipt sequences but does not work
for PP-Receipt and SET-Receipt.

Facilities

SubType $$RECTYPE-3$$ The third element of application type. Use
only for receipt sequences but does not work
for PP-Receipt and SET-Receipt.

Remodel

Category $$RECTYPE-4$$ The fourth element of application type. Use
only for receipt sequences but does not work
for PP-Receipt and SET-Receipt.

Condos

Module Name $$RECTYPE-MODULE
$$

The module name of application type. Use
only for receipt sequences but does not work
for PP-Receipt and SET-Receipt.

Building

Department Alias $$DEPT-ALIAS$$ The department name of organization. Use
only for receipt sequences.

Long Range
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Description Syntax Description Example
Output

Bureau $$DEPT-1$$ The first element of the organization level.
Use only for receipt sequences.

DSD

Division $$DEPT-2$$ The second element of the organization
level. Use only for receipt sequences.

PLN

Section $$DEPT-3$$ The third element of the organization level.
Use only for receipt sequences.

NA

Group $$DEPT-4$$ The fourth element of the organization level.
Use only for receipt sequences.

Long Range

Office $$DEPT-5$$ The fifth element of the organization level.
Use only for receipt sequences.

NA

User Name $$USERID$$ User Login ID. Use only for receipt
sequences.

Admin

Invoice Variables for Invoice Masks
Table 67: Invoice Variables for Invoice Masks

Description Syntax Description Example
Output

Record Type Alias $$RECTYPE-ALIAS$$ Record Type Alias. Facilities
Condos

Group $$RECTYPE-1$$ The first element of application type. Building

Type $$RECTYPE-2$$ The second element of application type. Facilities

SubType $$RECTYPE-3$$ The third element of application type. Remodel

Category $$RECTYPE-4$$ The fourth element of application type. Condos

Module Name $$RECTYPE-MODULE
$$

The module name of application type. Building

Department Alias $$DEPT-ALIAS$$ The department name of organization. Long Range

Bureau $$DEPT-1$$ The first element of the organization level. DSD

Division $$DEPT-2$$ The second element of the organization
level.

PLN

Section $$DEPT-3$$ The third element of the organization level. NA

Group $$DEPT-4$$ The fourth element of the organization level. LONGRANG

Office $$DEPT-5$$ The fifth element of the organization level. NA

User Name $$USERID$$ User Login ID. Admin

Recommended Patterns and Sequence Reset Values
Table 68: Recommended Patterns and Sequence Reset Values

Mask Pattern Base 10 Sequence Reset Value Base 36 Sequence Reset Value

$$SEQ01$$ 9 10^1-1 35 36^1-1

$$SEQ02$$ 99 10^2-1 1295 36^2-1

$$SEQ03$$ 999 10^3-1 46655 36^3-1
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Mask Pattern Base 10 Sequence Reset Value Base 36 Sequence Reset Value

$$SEQ04$$ 9999 10^4-1 1679615 36^4-1

$$SEQ05$$ 99999 10^5-1 60466175 36^5-1

$$SEQ06$$ 999999 10^6-1 2176782335 36^6-1

$$SEQ07$$ 9999999 10^7-1 78364164095 36^7-1

$$SEQ08$$ 99999999 10^8-1 2821109907455 36^8-1

$$SEQ09$$ 999999999 10^9-1 101559956668415 36^9-1

$$SEQ010$$ 9999999999 10^10-1 3656158440062975 36^10-1

$$SEQ011$$ 99999999999 10^11-1 131621703842267135 36^11-1

$$SEQ012$$ 999999999999 10^12-1 4738381338321616895 36^12-1

$$SEQ013$$ 9999999999900 10^13-1 9223372036854775807 36^13-1

$$SEQ014$$ 99999999999999 10^14-1 Not Applicable N/A

$$SEQ015$$ 999999999999999 10^15-1 N/A N/A

$$SEQ016$$ 9999999999999999 10^16-1 N/A N/A

$$SEQ017$$ 99999999999999999 10^17-1 N/A N/A

$$SEQ017$$ 999999999999999999 10^19-1 N/A N/A

$$SEQ019$$ 9223372036854775807 2^63-1 N/A N/A

Designing Workflows
A workflow is a set of tasks that your agency follows to process a record. Each record type has a specific
workflow process that manages the individual records created by the users. A record moves through the
workflow process as the users update the status of the workflow tasks.

Click a topic title below for full details.

Related Links

Deciding Which Tool to Use

Working with Workflow Designer

Working with the Classic Workflow Tool

Creating Task Statuses

Configuring Agency-defined Fields for Workflows

Tracking In-possession Time for a Record

Configuring Automatic Email Messages

Managing Automatically Printed Reports

Assignments, Skillsets, and Workloads

Making Workflow Task Assignments

Managing Activities
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Deciding Which Tool to Use
Civic Platform provides two options for designing workflows: the Classic Workflow tool and Workflow
Designer. You can view and edit workflows created in the Classic Workflow tool with Workflow Designer,
and vice versa.

• Working with the Classic Workflow Tool

This tool provides standard workflow configuration styles based on the Classic Administration user
interface. When designing the task relationships with the Classic Workflow tool, you must determine the
position of each task in the workflow, and use proper phase numbers as indicators to the positions.

• Working with Workflow Designer

This tool is the next generation of workflow design. Workflow Designer provides a graphical user
interface and is simpler and easier to use. Workflow Designer contains the same functionality as the
Classic Workflow tool, but has the added benefit of letting you see a visual representation of your
workflow while you design it.

The Classic Workflow tool enables you to save incomplete workflows, while Workflow Designer does not.
When you attempt to open a partially designed workflow in Workflow Designer, an error message displays,
and the workflow fails to load. In this case, you must open and edit the workflow in the Classic Workflow
tool first.

Best practice is to create all your workflows in Workflow Designer, unless the features are unique to the
Classic Workflow tool. See Workflow Configuration: Which Tool to Use for details.

Table 69: Workflow Configuration: Which Tool to Use

Workflow Configuration Task Which Tool to Use How to Access

Basic Workflow Configuration

Basic Process Configuration

Process Task Configuration

Task Status

Task Status' Email Setting

Task's Proximity Alert

Workflow Designer Navigation path: V360 Administration
> Administration > Workflow Designer
Document access: Working with
Workflow Designer.

Task specific-information definition

Task Status' Report Setting

Email Template

Classic Workflow Navigation path: Classic Admin
Tools > Workflow Document
access:Working with the Classic
Workflow Tool.

Workflow Blockout Classic Calendar administration Navigation path: Classic Admin Tools
> Calendar > Calendar

Task's Activity

Workflow Security

Workflow and Activity
administration

Navigation path: V360 Administration
> Workflow and Activity Document
access:Adding or Editing Workflow
Task Security and Configuring Record-
Related Activities.

Task Standard Condition Condition administration Navigation path: V360 Administration
> Conditions > Conditions Document
access:  Setting Up Conditions.
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Working with Workflow Designer
This section describes how to use Workflow Designer to create or edit a workflow, and how to design the
process and sub processes in the workflow. This section also contains information on where you can view
a video demonstration of creating workflows.

Topics

• Opening Workflow Designer

• Creating a Workflow

• Designing the Workflow Process

• Editing a Workflow

• Cloning a Workflow

• The Workflow Designer Menu

• The Widgets Panel

• Workflow Properties

Opening Workflow Designer
To open Workflow Designer

1. Navigate to the Administration portlet (see Navigating to the Setup Portlet).

2. From the Setup portlet, choose Administration > Workflow Designer.

Figure 22: Sample Workflow shows Workflow Designer displaying a sample workflow.
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Figure 22: Sample Workflow

A Workflow Designer Menu. Displays the New, Open, Save, Save Draft, Clone, Print, Exit and Help buttons.

B Widgets Panel. This panel provides all the available widgets that you can add to a workflow process.

C Workspace. The central panel provides the canvas for you to design workflow processes and sub processes.
Only one workflow process can be open at one time. If the workflow process has several sub processes, the
sub processes display in individual tabs.

D Navigator Panel. This panel displays a thumbnail view of the design panel. You can drag the border of the
outline in the panel to quickly change the view of the design panel.

E Property Sheet. This property sheet provides a list of properties directly related to the workflow process or sub
process displayed in the workspace, and the property settings of the widget (if any) that currently has focus.

Creating Workflows

Creating a Workflow
A best practice recommendation is to first plan out the design of your workflow on paper before you
create it in Workflow Designer. Draw a diagram of your workflow on paper to help you identify all the tasks
involved with a process, reduce oversights in your electronic version, and facilitate a thoughtful, well-
designed workflow process.

To create a workflow

1. Navigate to the Administration portlet (see Navigating to the Setup Portlet).

2. From the Setup portlet, choose Administration > Workflow Designer.

3. Click New.

The Create Workflow dialog box displays.
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4. Enter a Workflow Name.

Workflow Designer validates the name and displays a check mark by the field to indicate successful
validation.

5. You can either create a new master process for the workflow, or specify an existing process as the
master process:

• To create a new process, click Create a New Process, then enter a process name.

• To specify an existing process, click Use Existing Process, then select a process.

If you create a workflow with an existing process, after you edit and save the process in the new
workflow, Civic Platform updates the process in the other workflows associated with it.

6. Click Submit.

7. Design the workflow process as described in Designing the Workflow Process.

8. Click Save when your workflow design is complete.

If you have not yet finished designing the workflow, click Save Draft before exiting Workflow Designer.

Designing the Workflow Process
Before you start designing a workflow process, it is best practice to understand all of the tasks you plan to
include, what status a task must reach before its subsequent task can start, and how tasks relate to each
other.

Workflow Designer does not allow you to save partially completed workflows, so make sure a workflow can
meet all the following criteria before saving it:

• The workflow must have start nodes and end nodes.

• All of the nodes must connect with a flow widget.

• All of the connections (flows) must have a status.

Troubleshooting Tip: A flow widget must start from a start, fork, join or a task widget, and it must end at a
fork, join, task or an end widget. If a flow widget starts from a task widget, you must assign one or more
task statuses to the flow widget. This way, the workflow process knows what status(es) a task must reach
before its subsequent task(s) can start.

To design the workflow process
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1. Complete steps 1-6 of the preceding topic, Creating a Workflow.

2. From the Widgets panel, drag and drop a Start node and an End node onto your blank workspace.
Simply click the node (Start, for example) then drag and drop it onto the workspace, leaving space
between the nodes so you can enter details later, as show below. For descriptions of the widgets, see
The Widgets Panel.

3. From the Widgets panel, drag the workflow tasks onto the workspace.

4. To specify the task names, double-click the default task name (Task1, for example) and enter a name
for your task.

5. To connect two tasks, add a flow widget (Straight, Horizontal, or Vertical) as follows:

a. From the Widgets panel, click the appropriate flow widget.

b. Go to the workspace.

c. Hover the mouse over the center of a task.



 | Part 3: Configuring Agency Business Objects | 348

d. Wait for the mouse cursor to change from an arrow to a hand:

e. Drag the cursor to the next task and then release the mouse button.

6. To connect one task to two or more parallel tasks:

a. From the Widgets panel, drag a Fork widget between the task and the parallel tasks.

b. From the Widgets panel, drag a Straight widget to connect the task to the fork node.

c. From the Widgets panel, drag a Vertical widget to connect the fork node to each parallel task.

7. To connect two or more parallel tasks to one task:

a. From the Widgets panel, drag a Join widget between the parallel tasks and the individual task.

b. From the Widgets panel, drag a Vertical widget to connect the parallel tasks to the join.

c. From the Widgets panel, drag a Straight widget to connect the join node to the next task.
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8. After you connect all of the workflow tasks to each other, connect the last workflow task to the end node
with the Straight flow widget.

9. To create a workflow status that keeps the workflow on the same task:

a. From the Widgets panel, select Vertical.

b. Hover your mouse over the task; start and end the connection on the same task.
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10.To create a workflow status that loops back to a previous task:

a. From the Widgets panel, select Vertical.

b. Hover your mouse over the task.

c. Drag the connection back to a previous task.
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11.To add a task status:

a. From the workspace panel, select a task connection.

b. From the Flow Properties panel, click Manage Status.

c. Click New.

d. Enter the name of the status.

e. Click Submit.
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12.To define the status settings:

a. Select a task connection.

b. From the Flow Properties panel, click Manage Status.

c. From the Status Setting panel, define the appropriate settings.

13.To set the Workflow Properties for a workflow task:

a. From the workspace panel, select a task.

b. From the Task Properties panel, set the properties for the task.
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14.Click Save when your workflow design is complete.

Editing a Workflow
Regardless of where you created a workflow, whether in the Classic Workflow tool or Workflow Designer,
you can edit it in Workflow Designer.

To edit a workflow

1. Navigate to the Administration portlet (see Navigating to the Setup Portlet).

2. From the Setup portlet, choose Administration > Workflow Designer.

3. Click Open.

Workflow Designer displays the Open Workflow dialog with all the existing workflows in the General tab
and all the draft workflows in the Draft tab. The existing workflows contain all the workflows configured
in either Workflow Designer or the Classic Workflow tool.
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4. Locate the workflow. In the General tab or the Draft tab, you can filter the workflows that display by:

• Entering text in the Find by field. You can then press Enter or click the Filter button to display only
the workflows whose names start with the text.

• Clicking the page selection buttons to switch between pages.

5. Select the workflow.

6. Click Open.

Workflow Designer displays the message “Opening workflow, please wait...”

Troubleshooting Tip: If the selected workflow fails to load in Workflow Designer it might be a partially
completed workflow created with the Classic Workflow tool. If this is the case you must return to the
Classic Workflow tool, open the workflow there, and finish configuring the workflow before you can open
it in Workflow Designer.

7. Edit the workflow tasks as appropriate to your business objectives.

8. Save the workflow.

Cloning a Workflow
You can clone a workflow that is currently open in the workspace.

To clone a workflow

1. Navigate to the Administration portlet (see Navigating to the Setup Portlet).

2. From the Setup portlet, choose Administration > Workflow Designer.

3. Open a workflow.

4. Click Clone.

The Work Designer displays the Clone Workflow dialog.

5. Enter the new workflow name.

A warning sign displays if the new name is in use by an existing workflow or if the new name
contains forbidden characters. You must change the name to dismiss the warning.

6. (Optional) Enter the new process name. If you do not enter a new process name, the cloned workflow
inherits the process of the workflow you are cloning.

Workflow Designer opens the newly-cloned workflow process. The old workflow process automatically
exits in its last-saved state.

7. Modify the workflow according to the objectives you want to achieve.
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8. Click Save.

Note:

If you clone a workflow without saving it first, the newly-cloned workflow contains the changes since the
last save, while the old workflow loses the changes.

The Workflow Designer Menu

Table 70: Workflow Designer Menu Items describes the buttons in the Workflow Designer menu.

Table 70: Workflow Designer Menu Items

Button Name Description

New Click this button to start the creation of a workflow.

Open Click this button to display all the existing workflows (in the General tab) and draft
workflows (in the Draft tab). You can select a workflow or a drat workflow to edit it in the
workspace.

Save Click this button to save the current workflow, its process and sub processes, and all its
properties.

Note:

You cannot save a workflow if the workflow does not pass validation.

Save Draft Click this button to save a new workflow as a draft before completing the design of the
workflow process.

Note:

The Save Draft function does not work for general workflows that you already
saved successfully with complete process.

Clone Click this button to clone the current workflow.

Note:

The Clone function does not work for draft workflows.

Print Click this button to open the current workflow process or sub process in print layout.

Exit Click this button to exit Workflow Designer. Remember to click Save first to avoid losing
any changes.

Help Click this button to view instructions for using Workflow Designer.

The Widgets Panel
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Table 71: Workflow Designer Widgets describes the set of widgets in the Workflow Designer menu that
appears in the widgets panel. Each widget displays with a graphical icon that helps you identify it.

In the widgets panel, the straight, horizontal, and vertical widgets are flow widgets, and the start, task, fork,
join and end widgets are node widgets.

Table 71: Workflow Designer Widgets

Widget Name Description

Straight Choose a flow widget (straight, horizontal or vertical) to connect two node widgets. If you
use the straight widget, the connecting line is straight.

Horizontal Choose a flow widget (straight, horizontal or vertical) to connect two node widgets. If you
use the horizontal widget, the connecting line starts horizontally from a node and ends
horizontally at another node.

Vertical Choose a flow widget (straight, horizontal or vertical) to connect two node widgets. If you
use the vertical widget, the connecting line starts vertically from a node and ends vertically
at another node.

Start This node widget indicates the start of a workflow process.

Task This node widget indicates a task in a workflow process.

Fork This node widget indicates that multiple tasks are simultaneously active.

Join This node widget indicates that all the previous tasks must be complete before the next
task can start, or the workflow can end.

If you open a workflow configured in the Classic Workflow tool, the join widget indicates
there are several parallel tasks.

End This node widget indicates the end of a workflow process.

Workflow Properties

The property sheet resides on the right panel of Workflow Designer, and shows the properties related with
the current workflow. If a widget in the workspace has focus, the property settings of the widget, if any, also
display in the property sheet.

• A workflow’s properties always display regardless of whether a widget in the workspace has focus. For
a description of workflow properties, see Table 72: Workflow Properties.

• Task properties display when a task widget in the workspace has focus. For a description of task
properties see Table 73: Task Properties.

• Flow properties display when a flow widget (straight, horizontal, or vertical) that starts from a task
widget has focus. For a description of flow properties, see Table 74: Flow Properties.
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Table 72: Workflow Properties

Property Description

Workflow Name This read-only field displays the name of the current workflow.

Master Process Name This read-only field displays the name of the master process for the current workflow.

In-process Task
Activation

Select whether to allow users to activate or deactivate tasks in the workflow process for
a record.

Module Select the module that you want to assign the workflow to.

Status Select the status of the workflow. If you choose disabled you cannot associate the
workflow with record types.

Table 73: Task Properties

Property Description

Task Name Enter the name of the task as you want it to display to users.

Initial Status Select the task status you want to display when the task first becomes active.

When you first configure a workflow task, the drop-down list is empty. After you adds
a flow widget that suspends the task, the drop-down list displays the task statuses
configured for the flow widget. Here is an example of a flow widget that suspends a
task:

Department Use the Department drop-down list to select the department that is responsible for the
task.

Staff Use the Staff button to select a staff member that belongs to the selected department
and is responsible for the task.

Task Specific Info Group Select the specific task information group you want to associate with the current task in
the workflow process. You set up these groups in the Classic Workflow tool.

Duration (Days) Enter the number of days required to complete this task after it is active.

Estimated Hours Enter the number of estimated hours required to complete this task.

Hours Spent Required Choose Yes if you want to require that anyone who works on the task records the
number of hours spent. If you do not want to require the hours spent, choose No.

Workflow Calendar Use the drop-down list to assign a workflow calendar to the task.

Citizen Access
Displayable

If you want Citizen Access to display the task, select Yes; otherwise, select No.

Skip Tasks If you click the field entry area, a “Skip Other Tasks” window pops up. You can select
the tasks that users can skip when they complete the current task.

Note:

You cannot configure a task as the skipped task in multiple tasks. If you
configure Task A as the skipped task in task B, and then you open the “Skip
Other Tasks” window for task C, the “Skip Other Tasks” window does not list
task A as an option.

Proximity Alert If you click the field entry area, a “Proximity Alerts” window pops up. You can select the
GIS proximity alerts to apply during the execution of the task.

Sub Process Select an existing sub process that you want to add to the current task. You can also
click the icon next to the field to create a new sub process in the current task.
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Property Description

Sub Process Completion
Required

If you want the sub process in the current task to complete before moving to the next
task, select Yes; otherwise, select No.

Table 74: Flow Properties

Property Description

Task Status This field displays the status that a task must reach before the activation of its next
task. If there are multiple statuses, a task only need to reach one of the statuses before
the activation of its next task.

Application Status Enter a status in this field. If the task that the flow widget starts from reaches the Task
Status, the Application Status you enter in this field displays as the Application Status.

Parent Status This field works with the flow widget that starts from a sub process task. Enter a status
in this field. If the sub process task reaches the Task Status, the parent task that
contain the sub process changes to the status in this field.

Time Tracker Clock
Action

Select the time tracker clock action that triggers when the task reaches the selected
status. The time tracker clock controls how the Time Tracker records In Possession
time for workflow tasks and for applications.

Citizen Access
Displayable

If you want Citizen Access to display the task, select Yes; otherwise, select No.

Email Settings This field displays the number of notifications to send when the task reaches the
selected status. “0-notification” means there is no notification, “1-notification” means
Civic Platform sends one notification, and so forth.

If you click the field entry area, an “Email Settings” window pops up. You can create,
edit or remove the notifications.

Working with the Classic Workflow Tool
This section provides instructions for using the Classic Workflow tool. However, because most functions
in the Classic Workflow tool are available in Workflow Designer, best practice dictates the use of Workflow
Designer instead of the Classic Workflow tool in most cases. See Deciding Which Tool to Use for more
information.

With the Classic Workflow tool, we highly recommend that you draw a diagram on paper first, and then use
the diagram as a guide when creating your workflow. With Workflow Designer you can create the diagram
directly in the workspace.

Topics

• Understanding Workflow Tasks

• Managing Workflow Processes

• Managing Workflow Hierarchy

Understanding Workflow Tasks
You can set up several different types of tasks in each workflow process:

Parallel. A parallel task is any task in a group of tasks that share the same parallel indicator. You can set
up parallel tasks to activate independently of one another, depending on their task numbers. Workflow
participants must complete all parallel tasks in a single workflow process before the process can move
forward. You can override this constraint with a combination of skip activators and indicators.
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Branch. A branch in a workflow process lets users jump to any future task in the workflow process, possibly
bypassing tasks in the process. You can set up a branch by using the next number of the task that you
want to jump from.

Loop. A loop in a workflow process lets users return and repeat any task that they have already completed.
You can set up a branch by using the next number of the task that you want to return from and the a
number of the task that you want to return to.

Two 15-digit numbers drive any workflow process that you set up: a phase number and a next number.

Topics

• Understanding Phase Numbers

• Understanding Next Numbers

Understanding Phase Numbers
A workflow process phase number is a series of five 3-digit numbers that identify the unique position of
this task in the workflow process and its relationship with other tasks. Depending on how you set up this
number, you can determine when a user activates and when it is skipped throughout the workflow process.

Figure 23: Example Phase Number

Table 75: Phase Number Elements

Task Number Enter a unique 3-digit number that identifies this task and its order in the workflow
process.

Parallel Indicator If you want to activate this task simultaneously with other tasks, enter the 3-digit number
that matches the 3-digit number in this position for each parallel task.

Enter “000” if this task is not a parallel task.

Skip Indicator If you want to skip this task at some point during the workflow process, enter a 3-digit
indicator that matches the 3-digit activator of the task that initiates this skip.

Enter “000” if you never want to skip this task.

Loop Indicator If you need to repeat this task after a user has completed it, enter a 3-digit indicator that
matches the 3-digit activator of the task that initiates this loop.

Enter “000” if you never want to repeat this task.

Place Holder This component is currently acting as a placeholder. You can enter any 3-digit number, or
simply enter “000”

Understanding Next Numbers
A workflow process next number in is a series of five 3-digit numbers that identify the next task, or tasks, in
the workflow process. Depending on how you set up this number, you can set up the workflow to activate
the next task in the workflow process, jump to a future task, or to return to a completed task after a user
completes this task. You can also set up the workflow to skip another task when a user completes this
task.
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Figure 24: Example Next Number

Table 76: Next Number Elements

Next Task Number Enter the unique 3-digit number that identifies the next task in the workflow process.

Enter “000” if this task is the final task in the workflow.

Branch Task Number If you want to jump to a future task without completing other tasks, enter the unique 3-digit
number that identifies the future task in the workflow process.

Enter “000” if you do not want to jump to a future task.

Skip Activator If you want to skip a task after this task is complete, enter the 3-digit activator that
matches the 3-digit indicator of the task that you want to skip.

Enter “000” if you do not want to skip any tasks.

Loop Activator If you need to repeat a task after this task is complete, enter the 3-digit activator that
matches the 3-digit indicator of the task that you want to repeat.

Place Holder Enter “000” if you do not want to repeat any task.

This component is currently acting as a placeholder. You can enter any 3-digit number, or
simply enter “000”.

Managing Workflow Processes
Topics

• Adding a Workflow Process

• Editing a Workflow Process

• Viewing Process Status

• Viewing Process Status

Adding a Workflow Process
Each workflow process is a series of tasks that a workflow participant must complete before issuing a
certain type of permit or license. When you first implement Civic Platform, you must implement several
workflow processes. As necessary, you can set up additional workflow processes at any time. You can
also add or delete tasks from a process at any time.

In addition, you can put tasks into specific groups so they have the same task-specific information in a
summary that a user can view.

To add a workflow process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Process.

Civic Platform displays the Workflow Process—Edit window.



 | Part 3: Configuring Agency Business Objects | 361

3. Click Add.

4. Enter the new process name in the Process field.

5. Click Submit.

Civic Platform supplies the default workflow process.

6. Update the fields for each task in the workflow process. For a description of fields, see Table 77:
Workflow Process Fields.

Note:

Click the yellow light bulb that appears to the left of the task if you want to use the Task Flow Assistant to
help you set up phase and next numbers.

7. Click Update.

Table 77: Workflow Process Fields

Phase # Enter the 15-digit number that identifies the position of this task in the workflow process
and its relationship to other tasks. For more information about each component of a
Phase number, see Understanding Phase Numbers.

Next # Enter the 15-digit number that identifies one or more tasks in the workflow process
that you want to activate after this task is complete. For more information about each
component of a Next number, see Understanding Next Numbers.

Task Name Enter the name of the task as you want it to display to users. This field accommodates
up to 100 characters.

Initial Status Select the task status you want to display when the task first becomes active.

When you first set up a workflow process, this list is empty. After you set up the
initial process, you must set up each task status. You can then return to the workflow
process and choose an initial status.

Duration Enter the number of days required to complete this task after it is active.

Estimated Hours Enter the number of estimated hours required to complete this task.

Citizen Access
Displayable

If you want Citizen Access to display the task, select Yes; otherwise, select No.

Workflow Calendar Use the drop-down list to assign a workflow calendar to the task.

Department Use the Department button to search for the department that is responsible for the
task.

Note:

To search for a specific staff member, complete only the Staff field explained
below. Civic Platform automatically populates the Department field with the
corresponding department.

Staff Use the Staff button to search for a department and a staff member that is responsible
for the task.

If you enter a value in this field, Civic Platform carries this task assignment over to all
new applications that follow this workflow.

After creating a new application, authorized users have the option to change this
assignment.

Task-Specific Info Group Select the specific task information group you want to associate with each task in the
workflow process. Your agency sets up these groups, which allow you to associate
similar tasks in the same group.
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Hours Spent Required Choose Yes if you want to require that anyone who works on the task records the
number of hours spent. If you do not want to require the hours spent, choose No.

Editing a Workflow Process
After you add a workflow process to Civic Platform, you might need to edit workflow task details. For
example, you might need to change the order of the tasks, or change the person who is responsible for a
task. You can change the details about any task as well as add or delete tasks.

Any changes that you make to a workflow process do not affect existing applications associated with the
process.

To edit a workflow process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Process.

Civic Platform displays the Workflow Process—Edit window.

3. Enter the name of the workflow process that you want to find in the Process field.

4. Click Submit.

Civic Platform displays the Workflow Process browse page.

5. Click the red dot that appears next to the process you want under the Edit column.

6. To edit a task in the process:

a. update the fields for the task in the workflow process.

Note:

Click the yellow light bulb that appears to the left of the task if you want to use the Task Flow
Assistant to help you set up phase and next numbers.

For a description of the fields, see Table 77: Workflow Process Fields.

b. Click Update.

7. To add a new task to the process:

a. Click Add.

Civic Platform displays the Add Task page.

b. Enter the name of the task in the Task Name field.

c. Click Submit.

d. Civic Platform displays the new task at the top of the workflow process.

e. Complete the fields for each new task.

Note:

Click the yellow light bulb that appears to the left of the task if you want to use the Task Flow
Assistant to help you set up phase and next numbers.

For a description of fields, see Table 77: Workflow Process Fields.

f. Click Update.
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Note:

When deleting a task, make sure you delete any references to that task you included in the phase
number or next number of another task.

8. To remove a task from the process:

a. Click Delete to the right of the task that you want.

b. Click OK.

Viewing a Process Diagram
Viewing a workflow process lets you see a visual representation of the process. Civic Platform outlines the
structure of the workflow process for you with a flowchart. Seeing a picture of a process gives you a better
understanding of how each task relates to other tasks. Viewing the process can also help you to catch any
errors in your setup. Refer to the example of a process diagram in Figure 25: Example Workflow Process
Diagram.

Figure 25: Example Workflow Process Diagram

Consecutive tasks appear one after the other. Parallel tasks appear on the same row and they share the
same parallel indicator. Blue arrows indicate branches in the process. Red arrows indicate loops.

To view a process diagram

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Process.

Civic Platform displays the Workflow Process—Edit window.

3. Search for the workflow process you want to work with.

4. Do one of the following:

• Click the red dot that appears to the right of the process name under the View column.

• Click the red dot that appears in the Edit column next to the process that you want to view; then click
the Diagram View link that appears over the task details.

5. To maximize the view of the process, click Maximize. To restore the size of the window, click Restore.
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6. When you finish viewing the process, click Cancel or close the view window.

Viewing Process Status
You can view the status of every task in a workflow process. The Process Statuses view, lets you see the
relationship between tasks and task statuses, and link to the Task Statuses—Edit window.

To view a workflow process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Process.

Civic Platform displays the Workflow Process—Edit window.

3. Search for the workflow process or task you want to work with.

Civic Platform displays the Workflow Process—Edit window or the Task Status—Edit window.

4. Click the Process Status View link that appears near the top of the window.

5. Click the plus sign that appears to the left of any task to view the statuses defined for that task.

6. Click the link to any task status to edit the status details.

Managing Workflow Hierarchy
A workflow hierarchy is an ordered collection of processes and sub processes. You can use a workflow
hierarchy to manage sophisticated workflows at your agency. In addition to tasks and sub tasks, you can
combine processes and establish sub processes.

Editing a workflow hierarchy involves adding and removing sub processes. A sub process is similar to a
sub task that lets you break down a workflow task into smaller tasks. Sub processes let you break down a
workflow hierarchy into smaller processes. For instructions on editing the tasks in the main process or in a
sub process, see Managing Workflow Processes.

Topics

• Establishing a Workflow Hierarchy

• Adding a Workflow Sub Process to a Workflow Hierarchy

• Removing a Sub Process from a Workflow Hierarchy

Establishing a Workflow Hierarchy
Establishing a workflow hierarchy involves creating several workflow processes and then combining them
in a hierarchical organization. The benefit of establishing a workflow hierarchy is that you can create a
validated set of sub tasks that users must accomplish in a certain order.

When you establish your workflow hierarchy keep in mind that you can add only one sub process to each
task. For information about adding a sub process to the hierarchy, see Adding a Workflow Sub Process to
a Workflow Hierarchy.

To establish a workflow hierarchy

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Workflow.

Civic Platform displays the Workflow—Search page.
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3. Click Add.

Civic Platform displays the New Workflow window.

4. Complete these fields:

Workflow Enter the name of the workflow hierarchy that you want to create.

Master Process Select the name of the master workflow process to which the sub process belongs.

Inprocess Task Activation Select whether you want to allow in-process task activation for the workflow hierarchy.

5. Click Submit.

Civic Platform displays the Workflow—Edit window

A Current mode of this workflow hierarchy

B The master process folder that contains workflow tasks

C Blue dot, which indicates a task without a sub process

D Hierarchy command options

Adding a Workflow Sub Process to a Workflow Hierarchy
In a Civic Platform workflow, a sub process is a workflow process that you have already defined and which
you want to add to a task within another process.

Because you are associating an actual workflow process to a task in another workflow process, known
as the master process, you can enforce the tasks that make up the sub process. In other words, you can
determine which tasks a user must complete when, and you can require that the user complete them
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before moving on to other tasks. You can also attach documents, checklists, and comments to these tasks,
just as for a master workflow process.

To add a sub process to a workflow hierarchy

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Workflow.

3. Search for the workflow hierarchy you want.

4. Click a task within the master process folder.

Civic Platform displays the selected task in red.

5. Click Add Sub Process.

Civic Platform displays the search window for a workflow process.

6. Enter the name of the sub process that you want to add to the master flow. If you do not know the
complete name of the process, you can enter the first few characters of the name, or click Submit to
see a list of all defined processes.

7. Click Submit.

Civic Platform displays your search results.

8. Click Select to the right of the process that you want to add to your workflow hierarchy.

Civic Platform adds the sub process to the selected task in the master process folder.

A The plus or minus symbol indicates a task with a sub process
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B The sub process folder with tasks within it

C The sub process completion requirement option

9. If you want to require that users complete the new sub process as part of the master process, select
Yes; otherwise, select No.

10.Click Save.

Removing a Sub Process from a Workflow Hierarchy
To remove a sub process from a main process does not delete the process from your system, but does
delete it from the master process.

To remove a sub process from a workflow hierarchy

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Workflow.

3. Search for the workflow hierarchy you want.

4. Click a task within the master process folder.

Civic Platform displays the selected task in red.

A Selected task

B Civic Platform enables the Remove Sub Process button only when you select a task with a sub
process.

5. Click Remove Sub Process.

6. Click OK.

Creating Task Statuses
This section describes the process of creating statuses that users can apply to any task in a workflow
process, from the task properties panel. Task statuses tell Civic Platform whether reaching the status
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drives the workflow forward or backward, or keeps it the same. Based on the task status, users can choose
to activate the next task, loop back to a completed task, or branch forward to a future task. Users also have
the option to leave the current task active, by setting its status to “No Change.” All other options force the
active task to become inactive to activate another task in the workflow process.

Topics

• Configuring Agency-defined Fields for Workflows

• Tracking In-possession Time for a Record

• Configuring Automatic Email Messages

• Managing Automatically Printed Reports

To create a workflow task status

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Task Status.

3. Click Add.

4. Complete the necessary fields as described in Table 78: Workflow Task Status Fields.

5. Click Save.

Table 78: Workflow Task Status Fields

Process Code Select an existing workflow process. Civic Platform refreshes the window after
you choose a process code to display the corresponding task descriptions for the
process that you choose.

Task Status Code Enter a unique code or an abbreviation for the task status.

Task Description Select the task to which you want to add the status.

This field accommodates up to 100 characters.

Status Description Enter a brief description that helps you identify the task status as you want it to
display to users.

Resulting Action Select one of these options to determine the action when the task attains this
status: No ChangeChoose Next TaskChoose Branch TaskChoose Loop Task

Record Date Enter the date Civic Platform last updated the task status record that you want to
find.

Recorder ID Enter the user ID of the person responsible for last updating the task status record.

Application Status Enter the value to update the application to. When Civic Platform updates the task
to the task status you are defining, it then updates the application to the status you
indicate in this field. If you leave this field blank, no update to the application status
occurs.

Parent Status Enter the status of the parent task.

Citizen Access Displayable If you want Citizen Access to display this task status, select Yes; otherwise,
select No. Note: The Citizen Access Displayable setting is on the task and task
status. Only when you set the ACA Displayable field to “Yes” on both the task
and task status, are you able to display the task status Citizen Access. For more
information about task setting, see Table 77: Workflow Process Fields.

Status If you want to let users start choosing this status for workflow tasks, select Enable;
otherwise, select Disable.
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Configuring Agency-defined Fields for Workflows
Task-specific information (TSI) are the agency-defined fields that are unique to workflow tasks. Users
complete these custom TSI fields when they update a workflow task.

Civic Platform workflows leverage TSI using the following organizational hierarchy:

• Workflow tasks leverage TSI from TSI groups

• TSI groups contain one or more TSI subgroups

• TSI subgroups contain one or more TSI fields

Topics

• Creating a Task-Specific Information Group

• Editing a Task-Specific Information Group

• Adding a Field to a Task-Specific Information Group

• Editing a Field in a Task-Specific Information Group

• Deleting a Field from a Task-Specific Information Group

• Setting up Drop-down List Field Values

• Applying Shared Drop-down Lists

Creating a Task-Specific Information Group
When you create a new Task-Specific Information group, you specify the group code and its name, as
well as the first field that you want to include in the group. You can set up other information about the field,
including the field type and a default value. You can set up additional fields, change the order of fields in
the group, and change any values when you edit the task-specific group.

When you create a Task-Specific Information Group, you must also specify the category that the group
belongs to. You can set up the first field so that it is searchable or required. You can also specify a default
value and a fee indicator.

For example, you can require data entry in the field, but only after the user is ready to move to the next
task. You can then set the Required Flag to No, the No Change to No, the Next Task to Yes, the Branch
to Yes, and the Loop to Yes. When a daily user enters a status that moves an item to the next task, Civic
Platform requires the user enter the Task-Specific Information before moving to the next task.

To add a task-specific information group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Task-Specific Info.

Civic Platform displays the Task-Specific Information—Search page.

3. Click Add.

Civic Platform displays the Task-Specific Info Group—Add window.
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4. Update the fields that display. For a description of the fields, see Table 79: Task-Specific Information
Group Fields.

5. Click Submit.

Table 79: Task-Specific Information Group Fields

Task-Spec Info Group Code Enter a unique code to identify the category that the Specific Information group
belongs to.

Task-Spec Info Group Name Enter a name to identify the Specific Information group. There can be many
groups in one category. This name only applies when there is more than one
group in a category.

Group Display Order Enter a number to determine the position of this information group on the
Application Specific Information page in Daily Activities. For example, if you want
this information group to appear second, enter 2.

1st Field Label Enter the label for the first field you want to add to your Specific Information group.
For example, if you want to prompt users to specify a date, enter “Date.”

Citizen Access Displayable If you want Citizen Access to display this information, choose Yes; otherwise,
choose No.

Citizen Access Searchable If you want users to be able to search for task-specific information, select Yes;
otherwise, select No.

Display Len Specify the maximum number of characters that Civic Platform displays.

Display Order Enter a number to determine the position of the first field in your Specific
Information group. For example, if you want the field to display before any other
fields, enter 1.

Default Value If you want to provide a default value for the first field in your Specific Information
group, enter it here.
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If you are setting up a drop-down list, you can add values to the drop-down list so
that a user has multiple values to choose from. For instructions, see Setting up
Drop-down List Field Values.

Fee Indicator If you want to use the first field value in a fee calculation, enter the unique 5-
digit indicator, that you use to identify this application specific variable in the fee
formula. You must use a value between 10100 and 10599 and use the format:
$fixxxxx$For example, enter $fi10101$

Field Type Choose the type of the first field in your Specific Information group. You can
choose from Text, Date, Y/N, Number, Drop-down List, Text Area, Money, Time,
and Check box field types. For more information on field types, see Adding a Field
to a Task-Specific Information Group.

Justification If you want the field label to be right or left aligned, select the drop-down list to
select either Right Align or Left Align. Justification is useful when you are using a
language other than English that requires justification.

Max Len Specify the maximum number of characters that the field accepts.

Required Flag If you want to require the Task-Specific Information on all status actions including
a No Change, Next Task, Loop, and Branch, select Yes; if you want to make the
Task-Specific Information collection optional, select No.

Required with Task Statuses
Branch

If you set the Required Flag to No, but you want to make Task-Specific Information
required when a user selects a status that leads to a task branch, select Yes;
otherwise, select No.

Required with Task Statuses
Loop

If set the Required Flag to No, but you want to make Task-Specific Information
required when a user selects a status that leads to a task loop, select Yes;
otherwise, select No.

Required with Task Statuses
Next Task

If you set the Required Flag to No, but you want to make the Task-Specific
Information required when a user selects a status that leads to the next task,
select Yes; otherwise, select No.

Required with Task Statuses
No Change

If you set the Required Flag to No, but you want to require Task-Specific
Information when there is no change to the task status, select Yes; otherwise,
select No.

Supervisor Edit Only If you want only a supervisor to be able to edit the group options, select Yes;
otherwise select No.

Searchable Flag If you want to let users search for applications based on this field, click Yes;
otherwise, click No.

Status If you want to let users see this field in Civic Platform, select Enabled; otherwise,
select Disabled.

Unit If you want to attach a unit such as square feet, dollars, or miles to the first field
value, enter it here. You can choose from standard choices, or enter a new unit.

Editing a Task-Specific Information Group
After you create a Task-Specific Information group, you might need to change it. You can update any
fields that belong to the group by changing the field type or any other features about the field, including the
display order. You cannot change the field label, but you can add new fields to the group, and delete fields
that you no longer use.

To edit a task-specific information group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Task-Specific Info.
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Civic Platform displays the Task-Specific Information page.

3. Complete these fields to search for the group that you want to edit:

Task-Specific Info Group
Code

Enter the group code associated with the specific information group you want to
search for.

Task-Specific Info Group
Name

Enter the name of the group you want to search for. There can be many groups in one
category. This name only applies when there is more than one group in a category.

4. Click Submit.

To see a list of all groups, click Submit without entering details about an individual group.

5. In the list of groups, click the red dot that appears next to the group that you want to edit.

6. Update the fields that display. For a description of the fields, see Table 79: Task-Specific Information
Group Fields.

7. Click Update.

Adding a Field to a Task-Specific Information Group
You can add any number of fields to a Task-Specific Information group. You can choose from any of the
eight basic types of agency-defined fields:

• Number Field. Lets users enter only numeric characters in a number field. Number fields display the
word number to the right of the field.

• Text Field. Lets users enter only text characters in a text field. Text fields display the word text to the
right of the field.

• Text Area. Lets users enter multiple lines of text, such as a three line address.

• Date Button. Lets users search for a date rather than entering a date manually.

• Yes/No Radio Buttons. Lets users select one value by selecting Yes or No.

• Drop-down List. Lets users choose a value from a list of predefined values determined by your agency.

• Time. Lets users enter a time value.

• Money. Lets users enter a dollar amount.

• Check box. Lets users select a check box to select the option.

To add a field to a task-specific information group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Task-Specific Info.

3. Complete these fields to search for the group that you want:

Task-Specific Info Group
Code

Enter the unique code that identifies the category to which the Specific Information
group belongs.

Task-Specific Info Group
Name

Enter the name of the group for which you want to search.

4. Click Submit.
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To see a list of all groups, click Submit without entering details about an individual group

Civic Platform displays the Task-Specific Info—Browse page.

5. Click the red dot that appears next to the group to which you want to add a field.

Civic Platform displays the Task-Specific Information page.

6. Click Add.

7. Complete the fields that display. For a description of the fields, see Table 79: Task-Specific Information
Group Fields.

8. Click Submit.

Editing a Field in a Task-Specific Information Group
After you create a Task-Specific Information group, you might need to change it. You can add or delete
fields; change the field type, display order, and the default value. You cannot however change the group
code, group name, or the field labels when you edit the group.

To edit a task-specific information group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Task-Specific Info.

3. Complete these fields to search for the group that you want to edit:

Task-Specific Info Group
Code

Enter the unique code that identifies the category to which the Specific Information
group belongs.

Task-Specific Info Group
Name

Enter the name of the group for which you want to search.

4. Click Submit.

To see a list of all groups, click Submit without entering details about an individual group.

Civic Platform displays the Task-Specific Info—Browse window.

5. Click the red dot that appears next to the group that you want.

6. Complete the fields that display. For a description of the fields, see Table 79: Task-Specific Information
Group Fields.

7. Click Update.

Deleting a Field from a Task-Specific Information Group
If you no longer need a field in your Task-Specific Information group, or if you want to change the field
label, you can delete the field.

To delete a field from a task-specific information group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Task-Specific Info.

3. Complete these fields to search for the group that you want.

Task-Specific Info Group
Code

Enter the unique code that identifies the category to which the Specific Information
group belongs.
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Task-Specific Info Group
Name

Enter the name of the group for which you want to search.

To see a list of all groups, Click Submit without entering details about an individual group.

4. Click Submit.

5. In the list of groups, click the red dot that appears next to the group from which you want to delete a
field.

6. Click Delete next to the field that you want to delete.

7. Click OK.

Setting up Drop-down List Field Values
After you create a Task-Specific Information group, you can add fields to the group. If you add drop-down
list fields, you must then set up the values that you want to include as options in the list. You can set up the
values individually, or apply a shared drop-down list which has preconfigured values. For more information
on how to apply a shared drop-down list, refer to Applying Shared Drop-down Lists.

Users can choose values when completing an application. For example, if you are adding a field to enter
contact information, you can provide a drop-down list of contact types. Add, modify, or delete drop-down
values to create the desired list.

To set up values for a drop-down list

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Task-Specific Info.

3. Complete these fields to search for the group that you want.

Task-Specific Info Group
Code

Enter the unique code that identifies the category to which the Specific Information
group belongs.

Task-Specific Info Group
Name

Enter the name of the group for which you want to search.

To see a list of all groups, click Submit without entering details about an individual group.

4. Click Submit.

5. In the list of groups, click the red dot that appears next to the group that you want.

6. Click Edit next to the drop-down field that you want.

Civic Platform displays a page where you can add, edit, or delete drop-down list values.

7. Do one of the following:

• If you want to add a new value, click Add and enter the value in the Item Value field.

• To update an existing value, replace the value text, and then Click Update.

• If you want to delete a value, click Delete.

8. Click Close to return to the list of fields in your group.
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Applying Shared Drop-down Lists
After you create a task-specific information group and add a drop-down field to it, you must add values
to populate the drop-down list. You can set up values individually or apply a drop-down list with pre-
configured values, known as a shared drop-down list. This section provides instructions on how to apply
shared drop-down list values to a drop-down list.

For information on how to create a shared drop-down list, refer to the Customizing Menus, Tabs, and Drop-
down Lists .

To apply a shared drop-down list

1. Locate the task-specific information group to which you want to apply a shared drop-down list. For
instructions, see Editing a Task-Specific Information Group.

2. Click the red dot next to the subgroup that contains the field for which you want to set drop‑down list
values.

Civic Platform displays the Task-Specific Info page.

3. Click Edit next to the drop-down list you want.

Civic Platform displays the Task-Specific Info Drop-down List—Add page.

4. Select the Use Shared Drop Down Lists option.

5. Do one of the following:

• Click Search to return all shared drop down lists.

• Enter the first letter of the drop-down list or any other search criteria, then click Search.

Civic Platform returns the Shared Drop Down List-Browse page.
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6. Click Select next to the drop-down list you want to apply.

Note:

You can only select one shared drop-down list.

Civic Platform returns to the Task-Specific Info Drop-Down List-Add page with the Field Values from the
shared drop down list in blue underlined text.

7. Click Update.

Tracking In-possession Time for a Record
Topics:

• Setting Up Time Tracking

• Recording an Estimated Task Duration

• Setting Up an Estimated Record Due Date

• Setting a Time Tracker Clock

Setting Up Time Tracking
If you plan to set up time tracking for a record, make sure you configure the required security settings for
the record type:

• Set the Record Access to Full “Access of application type” for the agency.

• Set FID 0245 Long Term Time Tracking to Full Access security and apply it to the agency.

• Set FID 8132 Workflow to Full Access security.

For instructions on configuring record type security, see Adding Record Type Security.

To set up time tracking for a record type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > Application Type, and locate the Application Category—Edit window of the
record type you want to apply time tracking.

Civic Platform Application Category—Edit window displays.

3. Specify a value that indicates the number of days, in the Duration field, to process and complete the
application type.

Duration is the estimated Due Date for each application type. The Duration field records the time
tracking expectation. If this field has no values, the elapsed time does not display within other areas of
Civic Platform, such as the Workflow Task.

The estimated due date is dependent on record clock start date/time and the time tracking expectation
set for the record type.

Note:

You can link each task status to a Time Tracker clock action. To set this up, you must apply the record
type to a Workflow process. The Workflow process field is also on the Application Category page and
displays in the screenshot below.
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4. Click Save.

The Application Category—Edit window stores the expected duration.

5. Set up the on-duty (start time) and off-duty (end time) using the Standard Choice
LONG_TERM_TIME_TRACKING.

Use this Standard Choice to set regular working hours for a typical work day. The Time Tracker function
uses this schedule when calculating In Possession time. The on-duty time sets the time work typically
begins; for example, 8 am. The off-duty time defines the time work typically ends; for example, 5 pm.
You must include the am and pm designations with the 12-hour clock hour in the Value Description
field.

You can only define one set of working hours per agency. You can specify working hours using either
12- or 24-hour clock values. However, work hours must use the same set of clock values for the Value
Descriptions.

Set up the LONG_TERM_TIME_TRACKING Standard Choice using these values, and specify the
appropriate value descriptions.

Standard Choice Values Value Description

ON_DUTY_TIME 8:00 AM

OFF_DUTY_TIME 5:30 PM

6. To store the number of days that a task should typically take, Civic Platform uses this number of days
(Duration) along with a workflow calendar to compute the task completion date. To configure the task
status for time tracking, continue with the next set of steps, Setting a Time Tracker Clock.
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Recording an Estimated Task Duration
Administrators can use Civic Platform to store the number of days that a task should typically take. Civic
Platform uses this number of days along with a workflow calendar to compute the task completion date.
Using the workflow calendar ensures that the computed due date does not include non-working days such
as weekends and holidays. Civic Platform computes the estimated due date and time of a task as the date
and time a task begins added to the duration of days multiplied by 8 (the number of working hours in a
day).

To record an expected task duration

1. Identify the Workflow process assigned to the record type that you want to track time.

2. Access the Classic Administration page (Accessing Classic Administration).

3. Choose Workflow > Process.

4. Locate the process you want to edit or click Add to create a new process.

Civic Platform displays the Workflow Process—Edit window.

5. Click the Process Status View link.

6. In the Duration (Days) field, enter the number of days you estimate each task should take.

7. Use the drop-down list in the Workflow Calendar field to choose the workflow calendar you want to
associate with the task.

8. Click Update to save the changes made to the Workflow process page.

Setting Up an Estimated Record Due Date
Civic Platform can calculate an estimated record due date based on data that you enter. Administrators
can use Civic Platform to store the number of days that a record type typically takes for the approval
process. When the In Possession Time Clock starts, Civic Platform calculates the estimated due date by
adding the number of duration days multiplied by 8 (the number of working hours in a day) to the field,
“Application Time Start Date.”

To set up an estimated application due date

1. Access the Classic Administration page (Accessing Classic Administration).
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2. Choose Application > Application Type.

3. Locate the application type you want to edit or click Add to create a new record type.

Civic Platform opens the Application Category-Edit window.

4. In the Duration (Days) field, enter the number of days you estimate the record should take.

5. Click Save.

Setting a Time Tracker Clock
You can link each task to a Time Tracker clock action. Administrators must set Time Tracker Clock Actions
to control how the Time Tracker records In Possession time for workflow tasks and workflow records. The
task involves searching and selecting the workflow process associated with the record type, and to then
configure the task’s Status for time tracking.

The Time Tracker Clock Action field provides four settings you can apply to a Task Description: No Action,
Start, Stop, and Close. Civic Platform triggers the timer when the status of a workflow task changes, starts,
stops, or closes the time tracking, and then calculates the total time accordingly.

For example, set the Task drop-down list to “Application Acceptance” and in the Status Description field
enter “Start of Time Tracking” and set the Time Tracker Clock Action drop-down list to Start.

You can specify other task descriptions, such as “Close” and in the Status Description field enter “End of
Time Tracking” and set the Time Tracker Clock Action for the last task as Stop.

To set a Time Tracker clock on a workflow task

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Task Status.

Civic Platform displays the Task Status - Search page.

3. Enter the Task Status Code or the Process Code, using either the full name or a few initial characters of
the name.

This step requires knowing either the Task Status Code or the Process Code. This Process Code is the
code, or abbreviation, of the workflow process to which the task status belongs.

4. Click Submit.

5. Do one of the following:

• Locate the Task Description for which you want to set up the time tracking clock, and then click the
red dot next to the Process Code.
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• Click Add to add a new Task Status and Task Description to the Task Status.

6. Set the Time Tracker Clock Action so that, when the task attains this status, one of the options listed
below happens:

No Action If a task updates to a status that has the Time Tracker Clock set to “No Action” then
there is no effect on the Time Tracker clock.

Start If a task updates to a status that has the Time Tracker Clock set to “Start” then Civic
Platform starts the time tracker clock for that current task, by using the current date
and time as the start time. This clock time contributes to In Possession time.

Stop If a task updates to a status that has the Time Tracker Clock set to “Stop” then Civic
Platform halts the time tracker clock for that task. Stop does not reset the clock.

Close If a task updates to a status that has the Time Tracker Clock set to “Close” then Civic
Platform closes the Time Track Clock record.

7. Click Save.

Configuring Automatic Email Messages
Topics

• Adding an Email Message

• Searching for an Email Message

• Editing an Email Message

• Establishing Email Settings

• Specifying Email Settings in an EMSE Script

Adding an Email Message
In addition to establishing the email setting, you must compose the email message Civic Platform sends
based on the email setting. Civic Platform sends the message to a specified recipient when a workflow task
reaches a certain status, which you specify in the email setting.

To add an email message

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Email Message.

3. Click Add.

4. Complete the necessary fields as described in Table 80: Email Message Fields.

5. Click Save.

Note:

As an alternative, you can create a new email message by copying an existing one.

Table 80: Email Message Fields

Contents Code Enter a unique code, or an abbreviation, to identify the content of the email
message.
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Message Type Enter a unique name for the email message. The email setting references this
name, which determines when to send the message as well as the recipient.

Message Subject Enter the text that you want to appear in the subject line of the email.

Message Content Enter the full text message that you want to send to a recipient using email. You
can enter a message up to 2000 characters long.

Status Select the current mode of the email message. You can enable the message at
this time, or disable it and enable it later.

Searching for an Email Message
To edit an email message, you must first search for the message on your system. You can search for an
email message based on the contents code or the message name—both of which are unique identifiers for
a certain email message.

Note:

To see a list of all messages, click Submit without entering details about an individual message.

To search for an email message

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Email Message.

3. Complete the necessary fields as described in Table 80: Email Message Fields.

4. Click Submit.

Civic Platform displays the Email Message browse page.

5. Click the red dot that appears to the left of the email message that you want.

Editing an Email Message
After you compose an email message, you might need to edit the message content. In addition to editing
the content, you can change the message name, subject, and status.

To edit an email message

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Email Message.

3. Search for the email message you want. For instructions, see Searching for an Email Message.

4. Click the red dot that appears in the Edit column next to the message that you want.

5. Complete the necessary fields as described in Table 80: Email Message Fields.

6. Click Save.

Establishing Email Settings
The email setting for each workflow process determines which email message you want to send when
Civic Platform updates the workflow process. For example, after a building review is complete, you can
notify the building supervisor.

Note:
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Although you can set up multiple email messages for the same task status, Civic Platform only sends one
email message to a single recipient for each status update. Civic Platform recommends that you set up only
one recipient, one email address, and one message for each task status.

When you first add an email setting, you can specify the combination of a workflow process, task, and
status that generates an email message. You can also choose which email message you want to send
when this combination occurs. You can determine the recipient of the email message later when you edit
the email setting.

To specify email settings for a workflow task

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Email Setting.

3. Search for the workflow process with the task to which you want to add an email setting.

4. Click Add.

Civic Platform displays the Email Setting Add page.

5. Complete the necessary fields as described in Table 81: Email Settings Fields.

6. Click Submit.

Table 81: Email Settings Fields

Task Choose the workflow task. Civic Platform refreshes the window after you choose a
task to display the corresponding statuses for the task that you choose.

Notify Contact Relationship
Type

Choose the type of contact you are notifying from the drop-down list.

Notify Applicant? If you want to notify the applicant, select the tasks for which you want to send
notifications.

Notify Next Recipient? If you want to notify someone other than the applicant, choose this option and
enter the next two fields with information about this recipient.

Recipient First/Middle/Last Enter the name of the recipient.

Email Enter the email address of the recipient.

Status Choose the status that you want.

Message Type Choose the email message that you want to send.

Specifying Email Settings in an EMSE Script
You might have created EMSE scripts to update a workflow process. If you want to send an email
message after a workflow task update by EMSE, you must call the following method in the EMSE script:

Accela
 Automation.workflow.sendEmailForWorkflowTaskUpdated(Task,emailFrom,emailTo,emailCC)

The method sets the email addresses from which and to which Civic Platform sends the notification. For
other email notification parameters such as Message Type, Civic Platform reads from the email setting for
the workflow process in Classic Administration. See Table 80: Email Message Fields.

Managing Automatically Printed Reports
Topics
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• Defining Automatically Printed Reports

• Associating a Report with a Workflow Task Status

Defining Automatically Printed Reports
You can define the reports that automatically print with workflow task updates. You enter the report
configuration. If you need an example of the report configuration, you can see a template of that displays
how to configure your report.

To define automatically printed reports

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Report Management > Auto Report.

Civic Platform displays the Define Oracle and ARW Report page.

3. Select either Oracle or Accela Report Writer from the Report Type drop-down list.

4. If you want to create your report using the report template, click the Template link and Civic Platform
displays the template.

5. Configure your report in the Report field.

Please note that each report type within your agency must be unique.

6. When you finish configuring the report, click Save.

Civic Platform saves your report.

Associating a Report with a Workflow Task Status
You can create a report that automatically prints when the user changes a workflow task. After you create
and define the report, you can manage the report associations with workflow tasks.

To associate a report to a workflow status, you must add a workflow report setting. This setting identifies
which report to run when a user changes a workflow task.

To add a workflow report setting

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Workflow > Report Setting.

Civic Platform displays the Report Setting Search page.
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3. If you know the name of the workflow process you want to add a report setting to, enter the name of the
process. If you do not know, you can leave the field blank.

4. Click Submit.

Civic Platform displays the Report Setting Browse page.

5. Click the red dot by the process to which you want to add a report setting.

Civic Platform displays the Report Setting page.

6. Click Add.

Civic Platform displays the Report Setting Add page.

7. Update the fields as defined in Table 82: Workflow Report Setting Fields.
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8. Click Submit.

Civic Platform adds your workflow report setting to the Report Setting page.

Table 82: Workflow Report Setting Fields

Task Select the workflow task that you want to associate the report with. For example, if you
want to print a building permit at the end of the record acceptance process, you might
select Application Acceptance.

Status Select the workflow task status that should trigger the report. For example, if you want
to print a building permit at the end of the application acceptance process, you might
select Complete.

Report Type Select the report type for the report you want to print. The report might be an Oracle
report or an Accela Report Writer report.

Report Select the report that should that you want to automatically run. For example, if you
want to print a building permit at the end of the record acceptance process, you might
select Building Permit.

Assignments, Skillsets, and Workloads
This section contains the following topics:

Related Links

Setting up an Automatic Assignment

Making Workflow Task Assignments

Setting up an Automatic Assignment
Topics

• Setting up Workloads

• Setting up Skillsets

Setting up Workloads
To use Civic Platform’s automatic assignment, you must weight the work performed to resolve certain
types of records. This configuration allows Civic Platform to match the work to the best skillset to perform
the tasks.

Topics

• Creating a Workload

• Editing a Workload

• Deleting a Workload

Creating a Workload
This section describes how you create workloads that Civic Platform uses to determine which skillset to
assign the work to.

To create a workload object
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1. Access the Workload portlet (Accessing the Workload Portlet).

2. Click New.

Civic Platform displays the workload details.

3. Complete the Workload fields that display. For a list of field descriptions, see Table 83: Workload Detail.

4. Click Submit.

Civic Platform creates the workload and adds it to the workload list.

Table 83: Workload Detail

Description Enter a description of the workload.

Enabled Select Yes to enable the workload or No to disable the workload. Civic Platform does
not assign disabled workloads to skillsets.

Literal Value Enter a literal value to compare the object against. The value you enter must exactly
match the values your agency uses. For example, if your agency uses the date format
of MM/DD/YYYY, you must provide the literal date value of 11/16/2007 in this field.

Object You can associate workloads with specific objects and object properties. Civic Platform
can then allocate the workloads to skillsets associated with these objects. To associate
the workload with an object, select the desired object. For example, a record. Civic
Platform populates the Property drop-down with the properties for the object you
selected.

Operator Select an operator to compare the object against.

Property Select a property for the object you selected in the Object drop-down.

Type From the drop-down, select the type of workload you are creating.

Editing a Workload
This section describes how you edit workload objects.

To edit a workload object

1. Access the Workload portlet (Accessing the Workload Portlet).

2. Click the link in the Workload ID column for the workload you want to edit.

Civic Platform displays the workload details.

3. Update the Workload fields that display. For a list of field descriptions, see Table 83: Workload Detail.

4. Click Submit.

Civic Platform saves your changes and reflects the workload list to reflect them.

Deleting a Workload
This section describes how you delete workload objects.

To delete a workload object

1. Access the Workload portlet (Accessing the Workload Portlet).

2. Select the workload you want to delete.

3. Click Delete.

Civic Platform removes the workload from the workload list.
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Setting up Skillsets
To use Civic Platform’s automatic assignment, you must set up the skillsets available at your agency.
Civic Platform can then assign appropriate workloads to the department or employee with the best skillset
necessary to perform the work.

Topics

• Creating a Skillset

• Editing a Skillset

• Deleting a Skillset

Creating a Skillset
This section describes how you create skillset objects that Civic Platform uses when determining where to
assign workloads.

To create a skillset

1. Access the Skillset portlet (Accessing the Skillset Portlet).

2. Click New.

Civic Platform displays a blank form in the record detail area.

3. Complete the Skillset fields that display. For a list of field descriptions, see Table 84: Skillset Detail.

4. Click Submit.

Civic Platform saves the skillset and updates the skillset list.

Table 84: Skillset Detail

Category Select the category from the drop-down list. SR Type is the only category currently
available.

Value Click the Selection icon to select a value from the display.

Department Select the department where you want to assign the skillset.

User ID If you are creating a skillset for an individual user, use the drop-down to select the user
ID of the staff member that belongs to the department you selected.

Expertise Select the level of expertise the person has in the skills. Civic Platform assigns the
skillset points for the skillset to workload ratio based on this selection. The possible
values are as follows: Novice = 1 pointIntermediate = 5 points Expert = 10 points.

Editing a Skillset
This section describes how to edit skillsets.

To edit a skillset

1. Access the Skillset portlet (Accessing the Skillset Portlet).

2. Click the link in the Category column for the skillset you want to edit.
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Civic Platform displays the skillset details.

3. Update the Skillset fields that display. For a list of field descriptions, see Table 84: Skillset Detail.

4. Click Submit.

Civic Platform saves the skillset and updates the skillset list.

Deleting a Skillset
This section describes how to delete skillsets.

To delete a skillset

1. Access the Skillset portlet (Accessing the Skillset Portlet).

2. Select workload you want to delete.

3. Click Delete.

Civic Platform deletes the skillset and updates the skillset list.

Making Workflow Task Assignments
This section describes how to search for and assign workflow tasks.

To make a workflow task assignment

1. Access the Assign Task portlet (Accessing the Assign Task Portlet).

2. Select each task you want to assign or reassign. If you do not see the task you are looking for, Click
Search and complete the resulting fields. For a list of search field descriptions, see Table 85: Workflow
Task Search Fields.

Table 85: Workflow Task Search Fields

Alternate ID If your agency uses Alternate IDs to display permit application numbers, enter the
alternate identification number for the permit application that contains the workflow task
you want to find.

Record ID If your agency uses Record IDs to display permit application numbers, enter the record
identification number of the permit application that contains the workflow task you want
to find.

Date Use the calendar icon to select the date range or exact creation date of the workflow
task. You set the default date range at the Super Agency level in the Workflow Assign
Task Date From Default Value field.

Department Use the drop down list to choose the department responsible for the workflow task.

Staff This drop-down list filters based on the selected department. Select the staff member
responsible for the workflow task from the drop down list.

Task Enter the name of the workflow task, such as Application Acceptance or Water
Pollution Control.

3. Click Assign.

Civic Platform displays the assignment details.
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4. Complete the Workflow Assign Task fields and click Submit. For a complete list of field descriptions,
see Table 86: Workflow Assign Task Fields.

Civic Platform confirms the task assignment.

Table 86: Workflow Assign Task Fields

Department Use the drop down list to choose the department responsible for the workflow task.

Due Date Use the calendar to choose the date by which the workflow task must be complete.

Staff Use the drop-down menu to select the staff member responsible for the workflow task.
Click Current User to populate this field with the current user’s name.
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Workflow Calendar Use the drop down list to choose the workflow calendar the workflow task applies to.

Table 87: Task Detail Fields

Action By (Department) The department that last updated the task status.

Action By (Staff) The individual who last updated the task status.

Assigned Date The date of the task assignment or the date of changes to the task assignment.

Assigned To
(Department)

The department currently responsible for completing the task.

Assigned To (Staff) The individual currently responsible for completing the task.

Record ID The record to which the task belongs.

Record Type The type of record to which the task belongs.

Comments Any comments about the current status.

Due Date The expected completion date for the task. If you are searching for a task, you can click
the calendar icon located next to the From and To fields to specify a date range. Civic
Platform supplies these dates in the corresponding fields.

Duration (Days) The estimated number of days necessary to complete this task. Your system
administrator determines this value when setting up the standard workflow process.

Parent Task If the current task is a sub-task, this is a description of the parent task that the sub-task
belongs to.

Status The current status of the task.

Status Date The date when the task reached its current status.

Task The name of the task.

Managing Activities
Topics

• Adding an Activity to a Workflow Process

• Editing a Workflow Process Activity

• Deleting an Activity from a Workflow Process

Adding an Activity to a Workflow Process
When you add an activity, you must first indicate the process and task to which you are adding. Unlike
other pages in Civic Platform, you cannot search for an activity or a task or a process; you drill in. Then you
enter the activity name and description that you’re adding

To add an activity to a workflow process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Review > Activity.

Civic Platform displays the Workflow Process List browse page. If Civic Platform displays the Task
List browse page for a process you do not want, click the “browse different workflow process” link that
appears to the right of the process code.

3. Click the red dot that appears next to the process that you want.

Civic Platform displays the Workflow Task List browse page.

4. Click the red dot that appears next to the task that you want.
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Civic Platform displays the Task Activity List browse page.

5. Click Add.

6. Complete these fields:

Activity Code Enter a code, or abbreviation, that identifies the activity.

Activity Description Enter a brief description to explain what the task involves.

7. Click Submit.

Editing a Workflow Process Activity
After you add an activity to a workflow task, you can edit the activity code and its description. Any changes
you make to an activity (other than adding a new activity) do not affect existing applications. For example,
when you delete an activity it does not delete the sub-task from the application's workflow. Your changes
affect only new applications.

To edit an activity for a workflow process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Review > Activity.

Civic Platform displays the Workflow Process List browse page. If Civic Platform displays the Task
List browse page for a process you do not want, click the “browse different workflow process” link that
appears to the right of the process code.

3. Click the red dot that appears next to the process that you want.

Civic Platform displays the Workflow Task List browse page.

4. Click the red dot that appears next to the task that you want

Civic Platform displays the Task Activity List browse page.

5. Click the red dot that appears next to the activity that you want.

6. Update these fields:

Activity Code Enter a code, or abbreviation, that identifies the activity.

Activity Description Enter a brief description to explain what the task involves.

7. Click Submit.

Deleting an Activity from a Workflow Process
After you add an activity, you can delete it, as needed. Deleting an activity does not delete the sub-task
from an existing application's workflow. Your changes affect only new applications.

To delete an activity from a workflow process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Review > Activity.

Civic Platform displays the Workflow Process List browse page.

3. If Civic Platform displays the Task List browse page for a process you do not want, click the “browse
different workflow process” link that appears to the right of the process code.

4. Click the red dot that appears next to the process that you want.
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Civic Platform displays the Workflow Task List browse page.

5. Click the red dot that appears next to the task that you want

Civic Platform displays the Task Activity List browse page.

6. Click Delete next to the activity that you want.

7. Click OK.

Using Expression Builder
Expression Builder provides an easy way to define expressions that perform calculations, provide
drop‑down lists, or auto-populate fields based on the value the user selects. Well-defined expressions help
reduce data entry work and minimize data entry errors.

Click a topic title below for full details.

Related Links

Supported Environments

Sample Use Cases

Creating Expressions

Searching for an Expression

Demonstrating Expressions with Scenarios

Supported Environments
You can create an expression for either Civic Platform, or Citizen Access, or both. Civic Platform does not
support expressions for Authorized Service Customer and Authorized Service Customer Address. Citizen
Access supports expressions for ASI, ASI Table, Address, Authorized Service Customer, Authorized
Service Customer Address, Contact, Contact 1/2/3, Contact Address, Fee, Professionals, and Reference
Contact Address.

You can use Expression Builder with the following portlets.

• ASI

• ASI Table

• Address

• Applicant

• Asset

• Asset Condition Assessment

• Authorized Service Customer

• Authorized Service Customer Address

• Condition

• Condition of Approval
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• Contact, Contact 1/2/3

• Contact Address

• Fees

• Parcel

• Payment

• Professional

• Record Detail

• Reference Address

• Reference Condition

• Reference Contact

• Reference Parcel

• Workflow

Sample Use Cases
Building expressions enables you to perform the following types of actions in Citizen Access:

• Validate fields in licensed professional, ASI, and ASI table components

• Populate fields that are not visible to public users

• Gather the sum of field values

• Update fields that meet the criteria of the expression

• Populate sections in an online application, and then edit those sections in the review page

Expression Builder User Interface
You can create expressions in either wizard mode or script mode. For an illustration of the expression
creation portlet in script mode, see Figure 26: Expression Creation Portlet.
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Figure 26: Expression Creation Portlet

A Expression Name. Identifies the expression.

B Target Scope (Target Portlet, ASI Group, etc). Specify what scope that the expression works in.

C Execute Order. Specify the order to execute each expression.

D Execute Expression In. Specify where the expression applies: Citizen Access, Civic Platform, or both.

E Edit Mode. Specify whether you want to edit the expression in wizard mode or script mode.

F Status. Specify the status of the expression, active or inactive.

G Expression Area. If you select Script Mode, write the customized EMSE scripts for the desired expression in
the script entry area. If you select Wizard Mode, enter the expression criteria and the values, as the wizard
guides you through the process. S

H Error Message. Display the error details if the EMSE scripts fail to pass validation.

I Execute Fields. Pick one or more fields. When the user tabs or moves focus off of an Execute Field, the
expression executes.

J Variables. Display available fields in the target scope. You can either select the field you want to populate with
the expression, or use some fields in the criteria. Variables store field information temporarily as a program
runs.

K Operators. Use these basic mathematical symbols and date values in the expression. The “%” is the modulus,
it divides one operand by another and returns the remainder as its result.

L Standard Choices. Lists all Civic Platform Standard Choices and their values. Include these values in the
Expressions area.

Topics

• Creating Expressions

• Searching for an Expression

• Demonstrating Expressions with Scenarios
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Creating Expressions
You can create new expressions or modify existing expressions. Expression Builder provides a wizard for
building new expressions. You can also use scripts to build new expressions. Refer to the Accela Civic
Platform Scripting Guide. To learn about specific uses of Expression Builder and its effect on the Civic
Platform daily users, see the several scenarios introduced in Demonstrating Expressions with Scenarios.

Topics

• Accessing the Expression Creation Portlet

• Configuring the Expression

• Building the Expression in Wizard Mode

Accessing the Expression Creation Portlet
You can access the expression creation portlet from the Administration Setup portlet.

To access the expression creation portlet in Expression Builder

1. Access the Expression Builder portlet (Accessing the Expression Builder Portlet).

2. Click New to create a new expression.

Civic Platform displays the expression creation portlet.

Configuring the Expression
Before you start to build the expression, configure the expression basics including the expression name,
the target scope, and how to execute the expression.

To configure the expression

1. Enter a brief name to best describe the function or purpose of the expression. The Expression Name
field can have up to 60 characters, including spaces.

2. Specify the Target Portlet where users access the expression.

3. Specify the ASI Group, ASI table subgroup, or the template attributes that associate with the target
portlet and contain the fields you want to place the expression in.
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For the types of fields that you can specify with a target portlet, see Associated Field Types for
Expression Creation in Target Portlet.

You can hover over the ASI Group field to see a list of record types relevant to the ASI group.

4. Define the order in the Execute Order field to trigger the expressions that work on the same field.

5. From the Execute Expression Inarea, choose what type of user you want to expose the expression:

ACA Only Both registered users and anonymous Citizen Access users can access the
expression.

Civic Platform only Only Civic Platform users can access the expression.

Both Exposes the expression to both Citizen Access and Civic Platform users.

Note:

Citizen Access supports expressions for fields from ASI, ASI Table, Contact (including generic template
fields, template table fields, and people template fields), Fee, and Licensed Professionals.

6. Select an Edit Mode. The Edit Mode determines whether you edit the expression by wizard or EMSE
script.

The Wizard Mode displays the Expressions and Criteria wizard to assist you in building the
expressions. See Building the Expression in Wizard Mode.

The Script Mode displays the Expression script text area in which you can edit the EMSE script
manually. See the Accela Civic Platform Scripting Guide.

You can switch back and forth between modes, as appropriate.

7. Select the Status of the expression. All expressions are active by default. If you set the status of an
expression to inactive, the expression does not execute when the expression criteria are met.

8. Click the Execute Fields picker and select one or more fields. When the user tabs or moves focus off
of an Execute Field, the expression executes.

a. Click the (+) sign to expand the list of items.

The fields within each portlet, the associated fields, and Additional Options for onLoad and onSubmit
display.

b. Click an item to add it to the Execute Fields list.

The selected ASI group activates and filters the ASI subgroup drop‑down list. Additional Options
provide the possible events that can trigger the expression:

• onLoad executes the expression when you create a new record that meets the expression criteria.
The onLoad event occurs immediately when a page loads. For example, default the status to
Accepted when a user creates a new Building Record Type.
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• onSubmit executes the expression upon saving a record. The onSubmit event occurs when the
user clicks Submit on the form. For example, if the user changes the status to Accepted by entering
“A” in the ASI field.

• onPopulate executes the expression when data in the selected field populates based on a search
result. It is available when Professional, Contact Address, or Reference Contact Address is the
selected target portlet. For example, the following actions can trigger the expression: when the
user searches for and selects a Licensed Professional in an application, or when the user clicks the
Validate button in the contact address form and selects an address to add in the form.

The following Standard Choices must be have the indicated configurations in order for the
onPopulate option to be available for the Professional portlet:

NEW_SPEAR_FORM_ENABLE Enabled

MULTIPLE_LICENSE_PROFESSIONAL Disabled

MULTIPLE_APO_GIS_SELECTION Disabled

• onASITRowSubmit.This event is available only when ASI Table is the target portlet, and only works
in Citizen Access. When a public user submits a new or updated ASI table row in Citizen Access, if
the criteria of an onASITRowSubmit expression are all met, Citizen Access triggers the expression.
If you define an onASITRowSubmit expression which sets the blockSubmit property of the ASI table
form to true under certain criteria, Citizen Access can block the submission of ASI table rows when
the criteria are met.

Table 88: Associated Field Types for Expression Creation in Target Portlet

Target Portlet Associated Field Types Executable in
Civic Platform?

Executable in
Citizen Access?

ASI ASI Group Y Y

ASI Table ASI Group, and ASI Table Subgroup Y Y

Address ASI Group Y Y

Applicant ASI Group, Contact Type, Contact
Template, and Template Table if any
associated with the selected contact
template

Y N

Asset Attribute Template, and Attribute Table if
any associated with the selected attribute
template

Y N

Asset Condition
Assessment

Condition Assessment Y N

Authorized Service
Customer

- N Y

Authorized Service
Customer Address

- N Y

Condition ASI Group, Template Form, and Template
Table if any associated with the selected
template form

Y N

Condition of Approval ASI Group, Template Form, and Template
Table if any associated with the selected
template form

Y N

Contact (and Contact
1, 2, 3)

ASI Group, Contact Type, Contact
Template, and Template Table if any

Y Y
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Target Portlet Associated Field Types Executable in
Civic Platform?

Executable in
Citizen Access?

associated with the selected contact
template

Contact Address ASI Group Y Y

Fees ASI Group Y Y

Parcel ASI Group Y N

Payment ASI Group Y N

Professional ASI Group Y Y

Record Detail ASI Group Y N

Reference Address - Y N

Reference Condition Condition Entity, Template Form, and
Template Table if any associated with the
selected template form

Y N

Reference Contact Contact Type, Contact Template, and
Template Table if any associated with the
selected contact template

Y Y

Reference Contact
Address

- Y Y

Reference Parcel - Y N

Workflow ASI Group, Workflow, Process, Task
Specific Info

Y N

Building the Expression in Wizard Mode
If you select Wizard Mode to build the expression, you can fill the field names, corresponding expressions,
and criteria values in the Expressions and Criteria areas of the wizard.

To build the expression in wizard mode

1. Use the Expressions area to define the field in the expression, and define the way the expression
works on the field.

Note:

If you specify the ASI table as the target portlet for the expression, or select an ASI table subgroup,
or attribute table in the target scope in , you can only build the expression for the selected table. For a
detailed use-case of this feature, see Adding a Row in an Asset Attribute Table.

a. Select the field on which the expression affects. You can only select a target portlet field.

b. Expand the plus sign next to the target portlet in the Variables navigation tree to locate a variable.

The variables navigation tree displays the available fields for your selection.
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c. Click the variable. The variable populates in the Field Name.

You can select “FORM” to execute the expression on the whole target portlet. You can also select a
field to change the property of the field.

d. Specify a Property type for the field. The Property field identifies the type of expression. For
example, if you set the field to read-only, the Property becomes read-only.

Value Assigns the value in the Calculate Expression field to the field.

Required Sets the field to required. The Calculate Expression field defaults to True, but you
can change it to False.

Read-only Sets the field to read-only. The Calculate Expression field defaults to True, but
you can change it to False.

Message If you add “FORM” in the Field Name, displays a message in the target portlet. If
you add a field in the Field Name, displays a message next to the field.

blockSubmit If you add “FORM” in the Field Name, this property is available for blocking the
submission of the target portlet.

Note:

There is a limitation with contact expressions in Citizen Access. If you are using a contact expression
to display a message on the contact form, the “Execute Fields” box of the expression must contain
the “onSubmit” option for the message to display when users submit the form. Otherwise, the
message cannot display.

e. Click the Calculate Expression field and then, as required for the expression, navigate to the
Variables, Operators, or Standard Choices navigation trees to locate the field, operator, or value to
add to the expression.

The Variables navigation tree includes Session Variables which are the frequently used runtime
variables that are standard with Civic Platform. Session variables are available in the WHERE
clause of a statement. Session variables display between sets of double dollar signs, for example,

[$$capID1$$]

. See Session Variables.

Use the Operators navigation tree to calculate the expression.

Math operators Lists mathematical symbols [+], [-]. [*], [/] for operation. The “%” is the
modulus, it divides one operand by another and returns the remainder as
its result.
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String operators Joins two strings.

Lookup ASI Table-lookup()
Function

Populates fields in the expression with columns from ASI lookup tables.
For more details on using the ASI Lookup Tables, see Creating ASI
Lookup Tables and Populating Fields in ASI Section.

Aggregate Function Aggregates multiple values from the ASI table, fees, the condition
template table, or the asset attribute table.

fireEMSE Function Fires an EMSE script.

addDate(Date, int) Function Returns the date appended with a certain date interval.

diffDate(Date, Date) Returns the interval between two dates.

f. The Standard Choices navigation tree lists each Standard Choice available in Civic Platform along
with its values that you can use in calculating the expression. The navigation tree lists both enabled
and disabled Standard Choices. For example, if you want to create an action based on when the
Status is Completed, locate the Standard Choice “STATUSCOMPLETED” and use its value in your
expression.

g. To add more expression lines click Add Expression Line in the Expressions area.

To remove an expression line, select it, and then click Delete Criteria Line.

2. Use the Criteria area to define the expression criteria.

a. Click Add Criteria Line in the Criteria area to add criteria lines.

b. Click the Field Name. Civic Platform uses the Field Name in the criteria for the expression.

c. Locate a variable in the Variables navigation tree and then click it. The variable populates in the
Field Name.

d. Select a logical operator from the Operator drop-down list to identify the criteria for the expression.

e. Specify the Value for the criteria. You can set this to a static field value, a value from the ASI lookup
table, a Standard Choice value, or a session variable.

See Defining Custom Fields (Application Specific Information) for information on ASI lookup tables.

You can use Standard Choice values here as static values.

To look up a Session Variable and its value, click the Value field in the Criteria section, navigate to
the Session Variables navigation tree, and then click the value you want. The variable populates in
the Value field for the Criteria.

f. The Prefix is the starting parenthesis in a criteria line (also called “condition”). For Example:

(Due Date <= $$TODAY$$ AND 
 Status = Approved) OR (Est Date > $$TODAY$$) 

Both embedded conditions and parallel conditions work in the criteria. You can type one or more “(“
characters as the prefix, or leave it blank.

Embedded condition: (...(…)…)

Parallel condition: (..)…(..)

g. The Suffix is the end parenthesis in a criteria line (also called “condition”). For Example:

(Due Date <= $$TODAY$$ AND 
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 Status = Approved) OR (Est Date > $$TODAY$$) 

You can type one or more “)” characters as the prefix, or leave it blank.

h. Select AND/OR options to connect multiple criteria lines.

3. Click Validate to review the expression for errors.

The Validate button verifies that the syntax is correct. The Validate button does not test field data types
or the fields used in the expression.

4. Click Submit to save the new expression in wizard mode.

Table 89: Session Variables

Variable Name Description

$$ID$$ ID1 Retrieves the record ID from a specific portlet.

$$ID$$ ID2 Retrieves a second record ID from a specific portlet.

$$capID1$$ CAPID1 Retrieves the first 5 characters of the record
ID from a specific portlet. Example: CAPID1 =
01BLD-00000-00018

$$capID2$$ CAPID2 Retrieves the second 5 characters of the record
ID from a specific portlet. Example: CAPID2 =
01BLD-00000-00018

$$capID3$$ CAPID3 Retrieves the last 5 characters of the record
ID from a specific portlet. Example: CAPID3 =
01BLD-00000-00018

$$department$$ Department Retrieves the department of the current user.

$$firstName$$, $$lastName$$,
$$middleName$$

First NameLast
NameMiddle Name

Obtains first, last, middle name.

$$gaUserID$$ GAUserID Retrieves the ID of the current user.

$$module$$ Module Retrieves the module from a specific portlet.

$$portletID$$ Portlet ID Retrieves information on a portlet, such as a field
name.

$$publicuser_email$$ The public user email id
used in ACA.

Retrieves the public user email.

$$servProvCode$$ ServiceProviderCode Retrieves the ID for the agency.

$$today$$ Today Retrieves today’s date. The workstation's system
date determines this date. You can use this variable
parameter in calculations to specify a date range.
For example, enter $Today$ -7 to query for all
records over the last week.

$$userfullname$$ UserFullName Retrieves the user’s full name.

$$userGroup$$ UserGroup Retrieves the group of the logged-in user.

$$userID$$ UserID Retrieves the ID of the logged-in user.

Searching for an Expression
You can search for any existing expression.

To search for an expression
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1. Access the Expression Builder portlet (Accessing the Expression Builder Portlet).

2. Click Search.

Civic Platform displays the expression search portlet.

3. Enter search criteria and then click Submit.

Demonstrating Expressions with Scenarios
To learn about specific uses of Expression Builder and its effect on the Civic Platform daily user, review the
scenarios in this section. The scenarios include screen shots that depict both the configuration details for
the administrator who creates the expression, and the user’s experience when accessing the fields.

Topics

• Populating a Field When Creating a Record Type

• Adding a Row in an Asset Attribute Table

• Populating Fields in ASI Section

Populating a Field When Creating a Record Type
This scenario explains how to create the expression criteria that automatically set the Status to
“Processing” when a user creates a specific record type. The expression uses the “onLoad” function for the
record type of Building/Plan Review/Zoning Analysis and identifies the Target Portlet of Record Detail.

To build the expression criteria, refer to the steps in How to create the execute fields for onLoad function
for a new record.

To see the effect of this expression from a user experience, refer to Where the Status field populates as
“Processing” for the user.

For an overview of the user interface and its elements, see Figure 26: Expression Creation Portlet.

Where the Status field populates as “Processing” for the user

1. User creates a new record type of Building/Plan Review/Zoning Analysis/Zoning Analysis.

Civic Platform displays the application type picker.

Civic Platform loads the new application type and the status automatically updates to “Processing.”
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How to create the execute fields for onLoad function for a new record

1. Create a New expression and navigate to the Expression Name field.

Civic Platform displays the New Expression fields where you define the criteria.

2. Enter an Expression Name. This scenario uses New Record Status.

3. Select Record Detail from the Target Portlet drop-down list to specify that the expression takes effect
in the Record detail area.
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4. Select BLDG in the ASI Group for this step. Expressions require the Target Portlet and the respective
ASI Group and ASI Table Subgroup when creating or editing an expression.

5. Hover over the ASI Group field, to display the associated Record type for the selected ASI Group, for
informational purposes.

6. Optionally, use the Execute Order field to define the order you want Civic Platform to process the
expression.

7. Click the Execute Fields picker.

Civic Platform displays the Execute Fields list.

8. Expand Additional Options and click the onLoad function.

Civic Platform loads the onLoad function in the Execute Fields list.

9. In the Expressions area, do the following:

a. Single-click the Field Name to activate it.
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b. Open the Variables list, and expand Record Detail.

c. From the Fields list click the Status field.

The Expressions Field Name populates with the record type and the record Status functions.

10.Click the Calculate Expression field to activate it.

11.In the Calculate Expression field, surround the new status for this record type in double quotes and then
enter this phrase exactly: “Processing”

The “Processing” word is the default value displaying in the Status field when a user creates a new
record type for Building/Building Permit/Residential/New.

Adding a Row in an Asset Attribute Table
This scenario explains how to create the expression that automatically adds a row into an asset attribute
table when a user saves an asset.

To build the expression criteria, refer to the steps in Adding a new attribute table row.

To see the effect of this expression from a user experience, refer to Where to add a new row.

For an overview of the user interface and its elements, see Figure 26: Expression Creation Portlet.
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Where to add a new row
Where to add a new row in the attribute table of an asset

1. User creates a new asset with the asset group as HVAC, and the asset type as Boiler. The asset type
belongs to an asset template Mechanical - Boiler that links to the attribute table Attribute Table_1.

2. The asset saves successfully with a new row automatically added in the attribute table.

Adding a new attribute table row
How to add a new row for the attribute table fields of an asset

1. Create a New expression and navigate to the Expression Name field.

Civic Platform displays the New Expression fields where you define the criteria.

2. Enter an Expression Name. This scenario uses AddRowToTable.

3. Select Asset from the Target Portlet drop-down list, select Mechanical - Boiler from the Attribute
Template drop-down list, and Attribute Table_1 from the Attribute Table drop-down list. The attribute
table drop-down list shows all the attribute tables that associate with the selected attribute template.
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4. Click the Execute Fields list picker to select

Civic Platform displays the Execute Fields list.

5. Expand Additional Options and click the onSubmit function.

Civic Platform loads the onSubmit function in the Execute Fields list.

6. Select Insert Table Row in the Expressions area.

7. Assign values to the attribute table fields in the expression.

a. Single-click the Field Name in the Expressions area to activate it.

b. In the Variables list, expand the Fields under Attribute Table.

c. Click the Acres field.

The Expressions Field Name populates with the field name.
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8. Set the Property in the Expressions area as “value,” and enter the numeric value in the Calculate
Expression field: 220.

9. Click Add Expression Line to add more lines.

10.Select another field from the Variables list, and set its value.

11.Repeat step 10 until you assign values to all the necessary fields in the attribute table.

12.Click Submit to save the expression.

Populating Fields in ASI Section
This section explains how to create the expression criteria that populates read-only fields in the ASI
Section of a specific record type, based on selections made. This expression uses columns and data from
an ASI Lookup Table named ZA-1. This expression’s name is Zoning Lookup, because it populates the
appropriate references, based on the zones the user selects.

With Expression Builder, you can use the record type of Building/Plan Review/Zoning Analysis, and then
identify the Target Portlet of ASI, which is where the user accesses the fields. To build the expression
criteria, refer to the steps in How to prepare an ASI lookup table for creating the expression.

To see the effect of this expression from a user experience perspective, refer to How a user completes ASI
fields that populate messages.

For an overview of the user interface and its elements, see Figure 26: Expression Creation Portlet.

How a user completes ASI fields that populate messages

1. User creates a record type of Building/Plan Review/Zoning Analysis/Zoning Analysis.

2. Locate the ASI section of the application. An alternate location to modify this information might be in the
Zoning Analysis portlet for the record type.

Civic Platform displays the ASI fields in the Zoning Analysis section of the record.

3. Enter the value

110

into the Total Area (in square feet) of the Eligible Front Porch Area field.
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4. Select

R4

from the Zone drop-down list.

Civic Platform populates the values for the Principal Frontage, Permit Use, and Front Porch Deduction
fields.

How to prepare an ASI lookup table for creating the expression
This scenario uses data from an existing table called ASI Lookup Table called ZA-1.

The ZA-1 table contains the regulation data for zoning that populates when a user completes the ASI
section as they create a new record type of Building/Plan Review/Zoning Analysis/Zoning Analysis.

Reviewing this table now makes it easier to follow the scenario. Refer to Figure 27: ASI Lookup Table
Structure to see the structure, columns, and data in the ZA-1 table.

Figure 27: ASI Lookup Table Structure

Figure 28: ASI Lookup Table Data

How to create expression criteria for this ASI target portlet scenario
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1. Create a New expression and navigate to the Expression Name field.

Civic Platform displays a new expression fields where you define the criteria.

2. Enter an Expression Name. This scenario uses

BA-Zoning Lookup

.

3. Select Record Detail in the Target Portlet drop down list.

4. In the ASI Group field, select the group that contains the record type and the fields you want to place
an expression in. This scenario uses ASI Group ZA-2, because it requires the record type

Building/Plan Review/Zoning Analysis/Zoning Analysis

.

5. For these sub-steps, add each of the fields affected within the Target Portlet into the Execute Fields list.
The Execute Fields are the fields where users enter data and Civic Platform populates fields with read-
only information based on the user’s selections. This scenario affects these four fields:

ASI::PRINCIPAL USE AND STRUCTURE::Permit Use

ASI::PRINCIPAL USE AND STRUCTURE::Principal Frontage

ASI::ZONING ANALYSIS::Front Porch Deduction

ASI::ZONING ANALYSIS::Zone

a. Click the Execute Fields picker and expand ASI to locate and double-click ASI::PRINCIPAL USE
AND STRUCTURE::Permit Use.

ASI::PRINCIPAL USE AND STRUCTURE::Permit Use. The Permit Use field populates with data
based on what the user selects from the Zone drop-down list. In this scenario, when the user selects
R4 the Permit Use field populates with specific data from the ZA-1 ASI Lookup Table.

Civic Platform populates the field name Permit Use into the Execute Field list.
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b. Locate the other fields for this expression with the Execute Fields picker. Double-click each field
label to add it to the Execute Field list.

ASI::PRINCIPAL USE AND STRUCTURE::Principal Frontage. The Principal Frontage field
populates with data based on what the user selects from the Zone drop-down list. In this scenario,
when the user selects R4 the Principal Frontage field populates with specific data from the ZA-1 ASI
Lookup Table.

ASI::ZONING ANALYSIS::Front Porch Deduction. This field populates with data based on the user
who enters the Total Eligible Square Feet Area. See the screenshot below.

ASI::ZONING ANALYSIS::Zone. This field provides the Zone drop-down items that affect what data
populates in the Principal Frontage, Permit Use, and Front Porch Deduction fields.

6. Scroll to the Expressions area. The Expressions area is where you define the lookup criteria for each
Execute Field that calculate or trigger an expression.

7. For each field that calculates an expression, click Add Expression Line to add the field name to the
Field Name field list.

8. Click the Lookup Criteria search button to locate the table name and the column. Define the lookup
criteria for each Calculated Expression field for this scenario, click Lookup ASI Table.

Civic Platform displays the Lookup Criteria form.
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When defining expressions, you can use the ASI Lookup Tables. You can add a record to an ASI table
through an expression. You can populate a field with data from the ASI table.

The benefit when using table data is that it eliminates data entry errors that might occur if the permit
intake clerk has to manually open a separate document to locate the correct data and then type it into
specific fields.

a. To define the table and identify which columns to populate the data for the ASI::PRINCIPAL USE
AND STRUCTURE::Principal Frontage field, follow these two sub-steps:

Define the Lookup Table Name for the Principal Frontage field. Choose the ASI Lookup Table
Name of

ZA?1

for this scenario.

Set the Return Column of

Principal Frontage

. The Return Column is a column in ZA-1 that contains the values that should populate data based
on the values the permit intake clerk selects. The ASI Lookup Table columns for the Selected
Lookup Table display in the drop-down. If a user selects a column from the Variables list portlet,
default into this field.

b. Use the Field Name drop-down list and select the field for Principal Frontage.

c. Set the Operator to equal (=).

d. Click the Value field and then use the Variables to locate and add ASI::PRINCIPAL USE AND
STRUCTURE::Principal Frontage.

e. Click OK on the Lookup Criteria page.

f. Repeat the steps to provide a value for the Front Porch Deduction field with the correct references
and correct value.

9. Click Submit in the Lookup Criteria form to save the expression.

Expression Builder saves the expression criteria.
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 Setting Up Conditions
There are two kinds of conditions: conditions of approval and general conditions. The two classes
share the same logic but you use them for different purposes. Use conditions of approval to define a
list of requirements that citizens must meet to receive the approval for a permit or an inspection. Use a
general condition to indicate a problem on the record, inspection, address, contact, or another application
component. Generally, the condition severity is Lock, Hold, Notice, or Required. Administrators can
manage conditions of approval and general conditions separately through the Conditions Maintenance
portlet. For example, you can create a standard condition of approval for users to apply to a record and you
can define the status options for conditions of approval.

All conditions and condition types support using template fields that you create using application-specific
information (ASI) and application-specific information table (ASI Table) groups. To define an ASI and ASI
Table Groups for a condition template, see the section, Creating a Condition Template.

Administrators establish security policies for condition types, and then set permissions in the Conditions
Administration portlet. You configure the policies in the Security Policies Administration portlet as explained
in Setting Up Security Policies in Setting Up Security Policies. To manage permissions and privileges, use
the Conditions Administration portlet as explained in Assigning Conditions.

Click a topic title below for full details.

Related Links

Managing Condition Groups and Conditions

Establishing Condition Types

Creating a Condition Template

Applying Condition Audit Logs

Assigning Conditions

Maintaining Condition Statuses

Configuring Reference Conditions
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Managing Condition Groups and Conditions
When a user applies a condition to a component, the user must supply the condition name and then
choose from a list of pre-defined condition groups, condition types, and statuses that you have set up.

All conditions and condition types support using template fields similar to application-specific information
(ASI) and application-specific information table (ASI Table) fields. For a more detailed explanation, see
Creating a Condition Template.

Topics

• Adding a Condition Group and Adding a New Condition

• Searching for a Condition

• Viewing and Editing a Condition

• Copying a Condition

Adding a Condition Group and Adding a New Condition
When users apply conditions to an component, they can choose from a pre-defined list of groups. You can
create as many condition groups necessary. A condition group helps you organize condition types. When
you create a condition group, you can add other condition types and conditions to it.

To add a condition group and create a new condition

1. Access the Conditions Maintenance portlet (Navigating to the Setup Portlet).

2. Click to highlight any of the Condition By categories in the navigation tree. For example, click the
Condition By Type category.

3. Right-click the tree category in the navigation tree. For example, right-click the Condition By Type.

Civic Platform opens the new pop-up window.
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4. Click New Group.

Civic Platform opens the New Condition Group pop-up window.

5. Enter the new name for the condition group you need to add and click OK.

Civic Platform adds the new condition group to the Condition By Group tree view list.

6. To add one or more condition types to this group, take the following steps:

a. Right-click the group in the tree view, and click Assign Types.

Civic Platform displays the Select Condition Types form in a pop-up window.

b. Click the check boxes for the condition types you want to assign, and click OK.

Civic Platform adds the selected condition types to the condition group.

For instructions on how to add a condition type, see Adding a Condition Type.

7. To create a new condition, do one of the following:

• Click New in the Conditions Maintenance portlet.

• Right-click the group in the tree view, and click New Condition.

Civic Platform displays the New Condition form in a pop-up window.
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8. Complete the Condition Name field.

Condition Name is the name or number for the standard condition.

When a user accesses an application and applies a condition, this is the Condition Name they select.

This field accommodates up to 255 characters.

9. Specify the Condition Group, and then select the Condition Type from the drop-down list.

The Condition Type drop-down list contains the condition types you assigned to the condition group in .
If the condition type you selected associates with a template, the New Condition form refreshes and
adds the template fields below the system-defined condition fields.

10.Complete the remaining fields in the New Condition form.

For an explanation of system-defined condition fields, see Table 90: New Condition Field Descriptions
and Actions.

For further details on the spelling checker, including how to configure it, see Configuring Standard
Comments. Note that the spelling checker cannot add new words to the dictionary.

11.Click Submit.

Civic Platform saves the completed Condition Group and applies the new condition.

Table 90: New Condition Field Descriptions and Actions

Additional Information Use this unlimited text field if the body of your comment text exceeds the character
limitations of the Short Comments and Long Comments fields. This unlimited text field
supports the insertion of standard comments via the Standard Comments picker. It also
supports HTML formatting so that text pasted into the field from another source retains
its formatting.

Note:

This field is not searchable. However, the ability to perform tag-based
searches based on key words entered into ASI fields is available. Your agency



 | Part 3: Configuring Agency Business Objects | 417

can configure the Conditions portlet to include ASI fields for users to enter
important ‘searchable’ words from the Additional Info field.

Condition Group Select the Condition by Group name for the condition name or condition number you
are creating.

The condition group is an attribute of a condition that helps you organize condition
types.

This field accommodates up to 255 characters.

Condition Name Condition Name is the name or number for the standard condition name.

When a user accesses an application and applies a condition, this is the Condition
Name they select.

This field accommodates up to 255 characters.

Condition Type Select the Condition By Type name for the condition name or condition number you
are creating. The condition type is an attribute of a condition that helps you organize
individual conditions. For example, you can create a “Planning” condition type for all
conditions that apply only to components in the planning review stage.

You can associate a template with a condition type, and assign users and user group
permissions to a condition type. For more information about condition types, see
Establishing Condition Types.

Display Notice Select the options to display the notice in Civic Platform, Citizen Access, or the Citizen
Access Fee Estimate Page when they apply a condition to a record or parcel. When a
user accesses a record, the condition notice displays in the condition status bar. If you
do not select an option, the condition notice does not display. However, the condition is
applied regardless.

Include In Condition
Notice

Select from the options provided to expose the content of the selected fields to agency
users and public users. For example, if you select Short Description, Civic Platform
exposes the Short Comments text.

Inheritable Inheritable is a required field. No is the default setting. If this you set this to Yes, when
you associate a child record with a parent record, Civic Platform checks for inheritable
conditions. If found, the inheritable conditions copy to the child record with the Status
of “Applied.” If the parent record condition status updates (Status of “Not Applied”) then
the child record condition status does not update.

If you set this to No Civic Platform does not copy conditions to the child record upon
creating it from a parent record.

Long Comments (4000
char max)

Use this text field if the body of your condition comments exceeds the character
limitations of the Short Comments field, but does not exceed the 4000 character
limitation for this field. The contents of this field are searchable. This field supports the
insertion of standard comments via the Standard Comments picker.

Public Display Message This field relates only to IVR and Citizen Access.

If you enter text into this field, the result in IVR and Citizen Access is:

a) The text displays in the condition notice or condition status bar for the Condition
Name for the public user.

b) The Condition Name and Short Description do not display for the public user.

If you do not enter text into this field, the result in IVR and Citizen Access is:

a) The Condition Name and/or Short Description displays in the public user Condition
Notice.

b) If Condition Name and Short Description are de-selected, the Condition detail does
not display in the Condition Notice for a public user.
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Resolution Action Enter the actions or set of tasks the user should follow to resolve the condition severity
level so the user can move the application forward.

Short Comments (2000
char max)

Use this text field if the body of your condition comment does not exceed the 2000
character limitation for this field. The contents of this field are searchable. This field
supports the insertion of standard comments via the Standard Comments picker. To
expose the contents of this field to agency and public users, select Short Comments
for the Include in Condition Notice field.

Severity Choose a level of severity for the condition from the following:

Lock: Prevents almost any operation, except operations that result in removal of the
lock.

Hold: Restricts the addition of an activity and editing of components.

Notice: Includes special instructions to the person completing the application. It does
not impede record processing.

Required: Indicates that a user must complete a specified activity or field before
proceeding to the next step in a workflow.

Note:

The Standard Choice REMOVE_REQUIRED_IN_ADMIN_CONDITIONS
determines whether the Required severity option hides or displays.

Status Choose either Enabled or Disabled mode for the condition type. Enabled means that
you can apply the Condition Name to the assigned Application Types when a user
creates a new application.

If you disable a condition type, it prevents users from choosing that type when applying
new conditions, it does not disable existing conditions of that type. The Condition Name
is still available in the conditions list for the administrator to Enable at a later date.

Template Apply a template to a condition. All template fields and template tables display at the
bottom of the Condition details form. All conditions support the use of template fields
which you configure through application-specific information (ASI) and application-
specific information table (ASI Table) fields. For instructions on how to create a
condition template, see Creating a Condition Template.

Note:

If the condition type you select has a template, and then you select a different
template in this field, the template you select in this field applies to the
condition, and Civic Platform ignores the template associated with the
condition type.

Searching for a Condition
When you want to edit an existing condition, you first need to search for it. You can also search for a
condition group to view the group details without necessarily editing it. To see a list of all condition groups,
click Condition By Group. All condition groups display in the Condition Administration navigation tree.
To see a list of all condition, click Condition By Name/Number. All conditions and their group information
display in the Condition Administration navigation tree.

To search for a specific Condition

1. Access the Conditions Maintenance portlet (Navigating to the Setup Portlet).

2. Highlight Condition By Group or Condition By Name/Number in the Administration portlet.

3. Click Search in the Condition Administration portlet.

4. Complete any other fields to narrow your search results. For full details of the available fields refer to
Table 90: New Condition Field Descriptions and Actions.
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5. Click Submit.

Civic Platform displays all the available condition groups or conditions that meet your search criteria in
Condition Administration.

6. Click the Condition Name of the condition type that you want to modify.

The Condition Name details display in the Condition tab.

7. Make the changes and click Save.

Viewing and Editing a Condition
You can view and edit the details of a condition.

To edit a condition

1. Search for the condition you want to edit (Searching for a Condition).

2. Click the Condition Name that you want to modify.

The condition details display in the Condition tab.

3. Update the necessary fields that display.

For an explanation of system-defined condition fields, see Table 90: New Condition Field Descriptions
and Actions.

4. Click Save.

Civic Platform saves the changes for the condition.

Copying a Condition
Copy a condition to create a new, duplicate condition in the same condition group. When you copy a
condition, you create a new condition with the same details, including the condition group setting, as
the source condition. You can specify whether to copy the condition assignment options and permission
options.

To copy a condition

1. Search for the condition you want to copy (Searching for a Condition).

2. In the Condition tab, click the Menu button and choose Copy Condition from the drop-down list.

Civic Platform displays the Copy Condition portlet.

3. Complete this field:

Condition Name Enter a unique name to identify the new condition.

4. Choose the assignment options and permission options (Application Type, Workflow, etc.) you want to
copy from the source condition to the new condition. For more information, see Assigning Conditions).

5. Click Submit.
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Civic Platform displays the new condition in the Condition Detail portlet.

Establishing Condition Types
When a user applies a condition to a component, they must provide the condition group and condition type
that the condition belongs to. You must set up the condition groups and condition types in advance, and
associate one or more condition types with each condition group.

Topics

• Adding a Condition Type

• Searching for a Condition Type

• Editing a Condition Type

• Defining Condition Type Permissions

Adding a Condition Type
You can create as many condition types as necessary. A condition type is an attribute or grouping that
helps you organize individual conditions. After you create condition types, you must associate them with
proper condition groups, so the condition types can display as options in the Condition Type drop-down list
after users select a condition group when creating conditions.

To add a condition type

1. Access the Conditions Maintenance portlet (Accessing the Conditions Maintenance Portlet).

2. Highlight Condition By Type in the Administration portlet and right-click and select New Type.

3. Enter the new name for the condition type and then click OK.

Civic Platform adds the new condition type to the top of the Condition By Type navigation tree.

4. Optionally, specify the Template type. This applies only if the condition type supports template fields.

You can create a template field using the application-specific information (ASI) and application-specific
information table (ASI Table) fields. For an overview on how to create a condition template, see the
topics in the section, Creating a Condition Template.

5. Click Submit.

Civic Platform saves the condition type.

Searching for a Condition Type
When you want to edit an existing condition type, you first need to search for it. You can also search for a
condition type to view the type details without necessarily editing it.

To see a list of all condition types, click Condition By Type. All condition types display in the Condition
Administration navigation tree.

To search for a condition type

1. Access the Conditions Maintenance portlet (Navigating to the Setup Portlet).

2. Highlight Condition By Type in the Administration portlet.

3. Click Search.
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4. Enter the name of the condition type that you want to search for, select the condition template and then
click Submit.

Civic Platform returns a list of condition types that match your search criteria.

Editing a Condition Type
You can edit the details about a condition type.

To edit a condition type

1. Access the Conditions Maintenance portlet (Accessing the Conditions Maintenance Portlet).

2. Locate and select the condition type under the Condition by Type tree node.

You can also search for the condition type and then edit the details. See Searching for a Condition
Type.

Civic Platform displays the condition type details in the Condition Type tab.

3. Select another template for the condition type and then click Save.

Civic Platform saves your changes.

Defining Condition Type Permissions
You can control which user group or user can access standard conditions of a specific condition type by
defining permissions for the condition type. The permissions set for a standard condition always override
the permissions set for the condition type to which it belongs. User level permissions override user-group
level permissions. For more information about setting permissions for a standard condition, see Assigning
Conditions.

To define condition type permissions

1. Access the Conditions Maintenance portlet (Accessing the Conditions Maintenance Portlet).

2. Locate and select the condition type under the Condition by Type tree node.

You can also search for the condition type and open it. See Searching for a Condition Type.

Civic Platform displays the condition type details in the Condition Type tab.

3. Click the Permissions tab.

Civic Platform displays the Permissions tab on the Condition Type detail portlet.

4. Click Assign.

Civic Platform displays the Assign drop-down menu.

5. Select Assign Group or Assign User.

6. Navigate through the tree view to select the desired user group or user.

7. Click Submit.

Civic Platform lists the user group or user on the Permissions tab and assigns the user group or user
full access permission by default.

8. Use the drop-down next to the user group or user to assign Full Access, Read Only, or No Access.

9. Click Submit.

Civic Platform saves your changes to the permissions of the selected user group or user.
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Creating a Condition Template
The condition templates are in fact application-specific information (ASI) groups. The options in the
Template field of a condition or a condition type are all the ASI groups configured in Civic Platform. The
steps to prepare condition templates are the same as preparing ASI groups for records. This section
describes the key tasks that you must perform.

Topics

• Defining ASI Group Data for Conditions

• Setting Condition Template Permissions

• Designing a Layout for the Condition Details Portlet

Defining ASI Group Data for Conditions
When you create a template for a condition, you configure the ASI group first. The ASI group name
displays in the Template field when creating a condition or a condition type.

Note:

The template that you specify for a condition overrides the template, if any, that you associated with the
condition type of the condition.

To define an ASI subgroup in an ASI table group for a condition template, and to define more subgroups in
an ASI group, see Defining Custom Fields (Application Specific Information).

Setting Condition Template Permissions
Either ASI security settings or a customized ASI form layout can block a user or user group from viewing
certain ASI fields and ASI tables of a condition template.

The permissions set for a standard condition always override the permissions set for the condition type to
which it belongs. User level permissions override user-group level permissions. If a user has ASI security
or ASI form layout permission at the same time, the strictest access setting applies.

There are various methods to control user and group access to condition template fields.

You can assign permission based on the user login to restrict access to application-specific information
and application‑specific information (ASI) table data, including ASI groups, ASI subgroups, ASI table
groups, ASI table subgroups, ASI fields, and ASI table fields. See Setting Up Security Policies in Setting
Up Security Policies.

Note:

If you do not have access permission to an ASI group, the ASI group can still display as a condition template
option. However, when you select the ASI group as the condition template, the template field does not
display.

You can set the condition template field permissions in the ASI Form Layout tool and apply security for
module, group, and user. See Designing Application Intake Forms.

You can set access within the Condition portlet and layout the design of condition templates. Follow the
see the steps in Designing a Layout for the Condition Details Portlet.

Designing a Layout for the Condition Details Portlet
You can choose which fields you want to show in the Condition Details portlet, and you can customize
those fields. You can add a label for the field, specify its width, apply a mask, and indicate sort order and
display order. You can also specify how many items to display in an expanded and contracted list.
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You must separately design the layout of system-defined condition fields and then design the layout of the
condition template fields (ASI fields and ASI table fields).

• To design the layout of system-defined condition fields, apply the edit view feature in the Condition
Details portlet. See Designing Forms for Portlets.

• To design the layout of the condition template fields (ASI fields and ASI table fields), you can create ASI
screens for ASI groups. See Designing Application Intake Forms.

If you defined one or more ASI screens for an ASI group, and you select the ASI group as the condition
template, all the fields and tables in the ASI group display below the system-defined condition fields,
with the layout you designed in the ASI screens.

If you did not define an ASI screen for an ASI group, or you do not have permission to the ASI screen
for the ASI group, after you select the ASI group as the condition template, all the fields and tables in
the ASI group display below the system-defined condition fields, with the default layout.

Applying Condition Audit Logs
As an administrator, you can choose to enable the condition audit log functionality in Civic Platform. You
can also grant yourself and agency users permission to access the condition audit log.

Viewing and Filtering Condition Audit Logs
Administrators with access to the audit log can review condition the audit log from the condition list portlet
and condition detail portlet. See Figure 29: Condition Audit Logs in Condition List and Detail Portlet.

For instructions on how to access the audit log, see “Viewing Condition Audit Logs” in the Accela Civic
Platform User Guide.

Figure 29: Condition Audit Logs in Condition List and Detail Portlet

To view or filter the condition audit logs

1. Access the Conditions Maintenance portlet (Accessing the Conditions Maintenance Portlet).
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2. Click any of the Condition By categories in the navigation tree. For example, click the Condition By
Group category.

Civic Platform displays the conditions in the condition list portlet.

3. Complete one of these options:

• To view audit logs for multiple conditions, click View Log at the top of the condition list portlet.

• To view audit logs for one condition, click the desired condition from the condition list and then click
View Log at the top of the condition detail portlet.

Civic Platform displays the Audit Log for the condition.

4. To narrow down the audit log results, enter one or more filter criteria from the filter criteria fields. See
Table 91: Log Detail Filters and Options.

5. Click Filter.

Table 91: Log Detail Filters and Options

Audit Subtype Sub types of the Condition audit type. The audit subtypes include Condition Template
Form, Condition Template Table, and Record Condition.

Audit Type The audit type is Standard Condition.

Condition Group The condition groups for any one of the conditions.

Condition Name The name of the condition an administrator created or modified.

Condition Type The condition types for any one of the conditions.

Entity ID The identification number of a condition.

Field The field which had its value modified by an administrator.

Log Action The action completed, such as Delete. You cannot remove this detail from the log.

Log Time The date and time of the activity. For example, the date and time an administrator
updated a condition. You cannot remove this detail from the log.

Operator The user who competed the action. Here it is the Accela administrator.

Product The product an administrator was using when they made the modification listed in the
log.

Relationship Displays the source objects associated with the modified field. For example, for
a condition template field, it displays Condition Group, Condition Type, Condition
Template Subgroup, and Condition Name.

Value The value of the modified field upon completion of the action.
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Assigning Conditions
This section contains details about the administrative strategy to assign conditions for all of these areas.
However, the steps to set up and apply conditions to a record type, user group, user, inspection group
or inspection type, or workflow process are very similar. For complete details of permission options, see
Figure 30: Assign Options in Condition by Group.

Figure 30: Assign Options in Condition by Group

The steps for all of these groups or areas are the steps under this step heading Assigning a Condition to
a Workflow Process. First, you must create the condition, then locate the application type for which you
want to provide a standard condition. Select the condition(s) from a list and save them to that application
type. When a user accesses a record they might see the standard condition message. They can click the
condition link to view or modify the details for that condition as it applies to that record.

Topics

• Assigning Conditions to a Record Type

• Assigning a Condition to a User Group

• Assigning a Condition to an Inspection Group

• Assigning a Condition to a Workflow Process

Assigning Conditions to a Record Type
You can assign conditions to a record type. When a user creates a new record, the conditions you assign
to the selected Record Type copy to the new application and the Condition Status becomes “Applied.”

For full details refer to: To assign conditions to a record type, user group, inspection group, or workflow.

The conditions assigned to the record type copy over regardless of the user group permissions. The user
group security only determines if the condition displays in the list portlet and if the user can edit or just view
the condition details. This happens after a user clicks Submit on a New Application.

For example, when applying for a building permit for a new development a drainage study must occur prior
to the approval of the permit. This is a standard condition you apply to the Building Permit application.
You can create a standard condition and name it D01 Drainage Study and associate it with the Building/
Building Permit/Drainage/Grading record Type. When the user creates a new application with the Building/
Building Permit/Drainage/Grading record type, the D01 Drainage Study condition copies over to the New
Application record.

Assigning a Condition to a User Group
You can also assign a specific set of conditions to a user group, such as the Building department, whose
users have access to only those conditions that are appropriate for their department’s functions.

For full details refer to: To assign conditions to a record type, user group, inspection group, or workflow.
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Assigning a Condition to an Inspection Group
Much like assigning a condition to a record type, you can also assign a set of unique conditions to a
specific inspection group or inspection type. The conditions assigned to the Inspection Type or Group
automatically copy over regardless of the user group permissions.

Inspectors for each inspection type automatically have a list of conditions available as they process their
inspections. While the inspector follows the inspection flow process (an outline of all the inspections that a
user group must complete between the time that an application is submitted until its issuance) they have
the appropriate access to process any conditions for their inspections.

For full details refer to: To assign conditions to a record type, user group, inspection group, or workflow.

Assigning a Condition to a Workflow Process
Workflow process validation is another aspect of conditions where you can extend the conditions that
currently exist for an application to inhibit the workflow process related to that application. Process
validation lets you determine the validity of the workflow process based on the condition of the application
it belongs to. When an application becomes locked, the workflow process becomes invalid and cannot go
forward.

For full details refer to: To assign conditions to a record type, user group, inspection group, or workflow.

Depending on the status of certain tasks within the workflow, you set up Civic Platform to check the current
condition of the application and inhibit the workflow accordingly. For example, you can lock the workflow
process in the event that an occupancy certificate becomes denied and the application becomes locked.

Note:

If you want to change the workflow process or require that individual tasks reach a certain status, you can
make these changes when you set up the workflow.

You can add process validations, or checkpoints, where you want Civic Platform to check the current
condition of the application and expand those conditions to control the workflow process. For example,
after the workflow reaches the Final phase, you can check to see if the application became locked, on hold,
or has any notices associated with it. You can then determine if you need to stop or adjust the workflow
process.

After you add a process validation, you might need to change the task or task status that you originally
chose to base the validation on. You can also change the application conditions that you want the
validation to check.

To assign conditions to a record type, user group, inspection group, or workflow

1. Access the Conditions Maintenance portlet (Accessing the Conditions Maintenance Portlet).

2. Use the main Administration navigation tree to locate the condition you need. You can locate a
condition by Group, Condition Type, Name/Number, Application Type, Inspection, User Group,
or User. If you cannot locate the condition name you want to apply, you can search for it. Refer to
Assigning Conditions.

• Highlight the condition you want to apply. Note the following tips:

Click the plus sign (+) that appears to the left of the name to expand a list.

To include all the names within a list, select that name. To include only one name in the list, select
only that name and not the entire list

3. Select the Condition Name in the Condition Administration list.
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4. Click Assign.

Civic Platform displays the Condition Administration, which lists conditions

5. Complete one of these options:

• To assign the condition to a record type, click Assign and choose Assign Record Type.

Civic Platform displays the a navigation tree of the Record Types within your agency

1. Highlight the Record Types to which you want to apply a condition. Note the following tips:

2. Click the plus sign (+) that appears to the left of the name to expand a list.

To include all the names within a list, select that name.

To include only one Record Type in the list, select only that Record Type alias and not the entire
list.

3. Click Submit.

Civic Platform saves and adds the condition to the Record Type you selected.

4. If you need to further modify the Condition you applied to the Record Type refer to Searching for
a Condition to use the Condition detail portlet.
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• To assign the condition to a User Group, which might be a department, click Assign and choose
Assign User Group.

Civic Platform displays a User Group navigation tree of the user groups within your agency.

1. Highlight the User Group to which you want to apply a condition. Note the following tips:

Click the plus sign (+) that appears to the left of the name to expand a list.

To include all the names within a list, select that name.

To include only one User Group name in the list, select only that User Group name and not the
entire list.

2. Click Submit.

Civic Platform saves and adds the condition to the User Group you selected in .

3. If you need to further modify the Condition you applied to the User Group, refer to Searching for a
Condition to use the Condition detail portlet.

• To assign the condition to an Inspection Group or Inspection Type, click Assign and choose Assign
Inspection.

Civic Platform displays the Inspection Group/Type navigation tree of the inspection types within your
agency.

1. To include only one Inspection Type name in the list, select only that Inspection name and not
the entire list.
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2. Click Submit.

Civic Platform saves and adds the condition to the Inspection Group/Type you selected in step 4.

3. If you need to further modify the Condition you applied to the Inspection Group/Type, refer to
Searching for a Condition to use the Condition detail portlet.

• To assign the condition to a Workflow process, click Assign and choose Assign Workflow.

Civic Platform displays the a navigation tree of the Workflow Process/Task/Status within your
agency.

1. Highlight the Workflow Process or Workflow Task to which you want to apply a condition. Note
the following tips:

2. Click the plus sign (+) that appears to the left of the name to expand a list.

To include all the names within a list, select that name.

To include only one Workflow Process/Task in the list, select only that Workflow name and not
the entire list.

3. Click Submit.

Civic Platform saves and adds the condition to the Workflow Process you selected in step 4.
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4. If you need to further modify the Condition you applied to the Workflow Process/Status/Type refer
to Searching for a Condition to use the Condition detail portlet.

Maintaining Condition Statuses
You can manage the status options for general conditions and conditions of approval separately.

Topics

• Adding a Condition Status

• Editing and Deleting a Condition Status

Adding a Condition Status
You can set up custom condition statuses for conditions of approval to outline the condition phases. For
example, for any conditions that become obsolete, you can set up an “expired” phase. Users can choose to
apply any of these custom statuses when a user applies a general condition to a component.

To add a condition status

1. Access the Conditions Maintenance portlet (Navigating to the Setup Portlet).

2. Click Status Maintenance from the Condition navigation tree and then click Conditions of Approval
or General Conditions.

Civic Platform displays the Status Maintenance portlet for conditions of approval.

3. Click New.

Civic Platform adds a new row to the Status Maintenance table.



 | Part 3: Configuring Agency Business Objects | 431

4. Complete the following fields.

Status Enter a descriptive name for the status.

Status Type Select the Status Type from the drop-down list.Applied indicates that general
conditions are applied to the record, inspection, address, parcel, owner, licensed
professional, structure, establishment, asset, or contact. Or it indicates that conditions
of approval are applied to the record, inspection, or record set. For example, if
the Address has the condition severity level of Hold then the Address retains this
condition until it meets or resolves the condition.Not Applied removes the conditions
restrictions on the record, inspection, or the component. For example, if the Parcel
condition meets or resolves the severity level of Notice then the Parcel can continue
with normal processing.

Note:

Status Type is not configurable in Classic Administration. If you create a
status in Classic Administration or via EMSE without defining its status type,
Civic Platform automatically assigns an “Applied” status type to the Applied
status named, and a “Not Applied” status type to other statuses.

If you configure the Standard Choice
ENABLE_CONDITION_RESOLVED_DATE, when users save Applied
conditions (including conditions of approval), users save them without a
status date. Status date is only saved when a condition (or condition of
approval) is met.

Display Order Enter the numeric value for the display order of the field as it displays to users as a
condition status drop-down list. If you do not indicate a display order, it defaults to
alphabetical order.

Record Status Select Enabled or Disabled from the drop-down list. Enabled turns on the status item,
making it available for users to select in the condition status drop-down list.

5. Click Submit.

Editing and Deleting a Condition Status
After you add a condition status, you might need to change the status name or description. You can also
enable any status that has a “disabled” status or vice versa. To delete a condition status, select the status
name and click Delete.

To edit a condition status

1. Access the Conditions Maintenance portlet (Navigating to the Setup Portlet).
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2. Click Status Maintenance from the Condition navigation tree and then click Conditions of Approval
or General Conditions.

Civic Platform displays the Status Maintenance portlet for conditions of approval.

3. Do any of the following:

• To edit a condition status, edit the fields as necessary and click Submit.

• To delete a condition status, select the status name and click Delete.

Configuring Reference Conditions

Configuring How Reference Conditions are Updated
Civic Platform organizes conditions in groups called Condition Types. You can configure the behavior of
how Civic Platform updates reference conditions in the Reference Condition portlet.

Configure how to update the reference conditions as applicable to your agency. You can configure Civic
Platform to update all associated records when you sign off on a reference condition for any record with or
without a prompt. You can configure to update the reference condition by signing it off at the record level
without impacting the main parcel condition or any other associated records.

Any time you unlock or override a reference condition status from the record condition notice portlet or
Condition tab, Civic Platform records this action. This results in correct behavior for each record.

To assign a condition type with update reference condition behavior

1. Access the Conditions Maintenance portlet (Accessing the Conditions Maintenance Portlet).

2. Select Reference Conditions from the Condition navigational tree.

Civic Platform displays the Reference Conditions portlet.
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3. Click New.

4. Complete the following fields.

Condition Type Select the Condition Type from the drop-down list.

Update Reference
Conditions for all
Records.

Select an option from the drop-down list.

Yes - No Prompt If you update a reference condition on a record, it affects all
associated records with that reference condition without a prompt.

No - If you update a reference condition on a record, Civic Platform overrides the
reference on the individual record only. This does not affect the other records with the
reference condition.

Yes - Prompt - When selected, Civic Platform displays, “Would you like to update
Reference Conditions for all Records?” If you choose Yes, Civic Platform updates the
main reference condition and all of its related records.

Record Status Select to enable or disable the feature from the drop-down list.

5. Click Submit.

6. To delete a Condition Type, select the Condition Type and click Delete.

Configuring Record-Related Activities
You can create and manage activities that are unique to your agency. When you configure activities as
described in this section, users can assign activities, such as a follow-up inspections or phone-calls, to
other agency staff members.

Click a topic title below for full details.

Related Links

Working with Activity-Specific Information Group Codes

Working with Activity-Specific Information Subgroups

Working with Activity Types

Working with Activity-Specific Information Group Codes
Topics

• Creating or Editing an Activity-Specific Information Group Code

• Searching for an Activity-Specific Information Group Code

• Deleting an Activity-Specific Information Group Code

Creating or Editing an Activity-Specific Information Group Code
Before Civic Platform users can work with activity-specific information, administrators need to create group
codes for the information. Each activity-specific information group code can include many activity-specific
information subgroups. Administrators can also edit activity-specific information group codes, as needed.

You can identify fields as any of the following basic types:

• Number Field. Lets users enter only numeric characters in a number field. A number field displays the
word “number” to the right of the field.
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• Text Field. Lets users enter only text characters in a text field. A text field displays the word “text” to the
right of the field.

• Text Area. Lets users enter multiple lines of text, such as a three-line address.

• Date Button. Lets users search for a date rather than entering a date manually.

• Yes/No Radio Buttons. Lets users select either a Yes or No value.

• Drop-down List. Lets users choose a value from a list of predefined values determined by your agency.

• Time. Lets users enter a time value.

• Money. Lets users enter a dollar amount.

• Check box. Lets users click to select the option.

Creating a group code is the first step in the process for working with activity-specific information.

To create or edit an activity-specific information group code

1. Access the Activity Specific Info portlet (Accessing the Activity Specific Info Portlet).

2. Do one of the following:

• Click the activity-specific information group code you want to view.

• Search for the activity-specific information group code you want to view. For instructions, see
Searching for an Activity-Specific Information Group Code.

• Click New to create a new activity-specific information group code.

Civic Platform displays the Activity Specific Info Group Code detail portlet.

3. Complete the Activity Specific Info Group Code fields that display. For a list of field descriptions, see
Table 92: Activity Specific Info Group Code Fields.

4. Click Submit.

Civic Platform displays a confirmation message.

Table 92: Activity Specific Info Group Code Fields

Activity Specific Info
Group Code

Enter the name of the activity specific group.

Activity Specific Info
Subgroup

Enter the name of the activity specific subgroup. The subgroup identifies the specific
type of information that the agency wants to associate with the activity.
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Display Len Specify the maximum number of characters that the activity-specific information can
display.

Display Order Enter a number to determine the position of the subgroup field for the group code. For
example, to have the Date subgroup field display before the Reply By subgroup field,
enter “10” for the Date subgroup field and “20” for the Reply By subgroup field.

Default Value Enter the desired default value for the activity-specific information group code.

Fee Indicator Enter a unique 5-digit indicator to identify this application-specific variable in the fee
formula. You must use a value between 10100 and 10599 and use the following
format: $fixxxxx$. This field is optional. For example, enter $fi10101$

Field Label Enter a label for the subgroup field.

Field Type Choose the type of field in your activity specific group.

Group Display Order Enter a number to determine the position of the activity-specific information group. For
example, enter “10” to display the Phone Call group code first and “20” to display the
Email group code second.

Max Len Specify the maximum number of characters that the field accepts.

Required Flag To require users to enter a value in this field, choose Yes; otherwise, choose No.

Searchable Flag To allow users to search for the activity-specific information, choose Yes; otherwise,
choose No.

Status To allow users to use the activity-specific information field, click Enabled; otherwise,
click Disabled.

Unit Enter any unit definition that you want to attach to the field value. For example, enter
“square feet,” “dollars,” or “miles.”

Use Shared Drop-down
Lists

Select this option to associate shared drop-down lists with an activity-specific
information group code. When you select this option, a search field enables you to
search for existing shared drop-down lists. If you search for a shared drop-down list
that does not match any existing shared drop-down lists, then the Shared Drop-down
List Search page opens. Use this page to search for existing shared drop-down lists.
If you search for a shared drop-down list that matches one existing shared drop-down
list, then the existing shared drop-down list displays in the Activity Specific Info Group
Code detail portlet.

If you search for a shared drop-down list that matches multiple existing shared drop-
down lists, then the Shared Drop-down List Select page opens and you can select
the desired drop-down list.

Searching for an Activity-Specific Information Group Code
This section describes how to locate the activity-specific information group codes in your Civic Platform
system. After you locate a group code, you can view it or edit it. For instructions on editing, see Creating or
Editing an Activity-Specific Information Group Code.

To search for an activity-specific information group code

1. Access the Activity Specific Info portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Activity Specific Info Group Code search portlet
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3. Complete any of the following fields.

Activity Specific Info
Group Code

Enter the activity specific info group code you want to find.

Activity Specific Info
Subgroup

Enter the name of the activity specific info subgroup you want to find.

4. Click Submit.

Civic Platform displays the search results.

Deleting an Activity-Specific Information Group Code
You can delete a group code that has attached subgroups.

Note:

If you delete all associated subgroups, Civic Platform deletes the group code automatically. For more
information, see Deleting a Subgroup from an Activity-Specific Information Group.

To delete an activity-specific information group code

1. Access the Activity Specific Info portlet (Accessing the Activity Specific Info Portlet).

2. Select the activity specific info group code that you want to delete.

3. Click Delete.

Civic Platform displays a confirmation message.

Working with Activity-Specific Information Subgroups
Subgroups are the activity-specific information data elements that an agency defines and associates with
an activity. Administrators define subgroups as needed. An agency can use subgroups with multiple group
codes. You can copy subgroups from one group code to another as needed.

Topics

• Creating a New Subgroup for Activity-Specific Information

• Adding Existing Subgroups to Activity-Specific Info Group Codes

• Deleting a Subgroup from an Activity-Specific Information Group

Creating a New Subgroup for Activity-Specific Information
Subgroups are the activity-specific information data elements that an agency defines and associates with
an activity. You can define and associate as many subgroups as you need to an activity-defined group
code.

To create a new subgroup for activity-specific information
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1. Access the Activity Specific Info portlet (Accessing the Activity Specific Info Portlet).

2. Click the activity-specific information group code for which you want to create a subgroup.

3. Click New.

Civic Platform displays the Activity Specific Info Group Code Subgroup portlet.

4. Complete the Activity Specific Info Group Code fields that display. For a list of field descriptions, see
Table 92: Activity Specific Info Group Code Fields. If you are adding a drop-down list field, you must set
the values that you want to include in the list of the field. See Setting Drop-down List Field Values.

5. Click Submit.

Civic Platform displays a confirmation message.

Adding Existing Subgroups to Activity-Specific Info Group Codes
Agencies can copy a subgroup and use it with multiple group codes. You must associate a subgroup with
at least one group code before you can copy it.

Some subgroups that you can copy are Date, Reply By, From, and To. You can use all of these subgroups
with group code types such as Phone Call, Email, and Letter.

To add an existing subgroup to an activity-specific information group code

1. Access the Activity Specific Info portlet (Accessing the Activity Specific Info Portlet).

2. Click the group code to which you want to copy existing subgroups.

Civic Platform displays the Activity Specific Info Subgroup list portlet.

3. Click Look Up to locate the subgroup you want to copy.

Civic Platform displays the Activity Specific Info Subgroup detail portlet.

4. Complete any of the following fields.

Activity Specific Info
Group Code

Enter the activity-specific information group code from which you want to copy the
subgroups.
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Activity Specific Info
Subgroup

Enter the name of the activity specific info subgroup you want to copy to the group
code.

5. Click Submit.

6. Civic Platform displays the search results.

7. Select the subgroups you want to add to the group code.

8. Click Select.

Civic Platform copies the subgroups to the group code, and then displays the results in the list portlet.

Setting Drop-down List Field Values
If you add a drop-down list field to an activity-specific information subgroup, you must then set the values
that you want to include in the list of the field.

To add drop-down list values to a drop-down list field

1. Access the Activity Specific Info portlet (Accessing the Activity Specific Info Portlet).

2. Click the group code and then the subgroup which contains the drop-down list field.

Civic Platform displays the field list of the subgroup.

3. Click the link for the drop-down list field you want to work with.

Civic Platform displays the field detail portlet.

4. You can either specify a shared drop-down list, or add the values manually:

• To specify a shared drop-down list, select Use Shared Drop-down Lists, and follow the instructions
in Table 92: Activity Specific Info Group Code Fields.

• To add the values manually:

1. Click the Drop-down List tab.

Civic Platform displays the drop-down list detail portlet.

2. Click the New button to add values.
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3. If you want to remove a value, select the value and click the Delete button.

Civic Platform displays a confirmation message.

Deleting a Subgroup from an Activity-Specific Information Group
If a subgroup is no longer necessary, you can delete it.

Note:

If you delete all associated subgroups, Civic Platform deletes the group code automatically.

To delete a subgroup from an activity-specific information group

1. Access the Activity Specific Info portlet (Accessing the Activity Specific Info Portlet).

2. Select the activity-specific information subgroup code that you want to delete.

3. Click Delete.

Civic Platform displays a confirmation message indicating.

Working with Activity Types
After you define an activity-specific information group, and you add activity-specific information subgroups
to the group, you can create one or more activity types to associate with the activity-specific information
group. You can then specify in which portlet users can create activities with the new activity type. When
users create or modify an activity, they can enter activity-specific information related to the activity, based
on the activity type and the activity specific info group.

For example, you could associate a phone call activity type with a licensed professional. When a user sees
the phone call activity type, they know to call the associated licensed professional and add the information
exchanged during the phone call into the activity-specific information fields.

Topics

• Creating or Updating an Activity Type

• Searching for an Activity Type

• Viewing an Activity Type

• Deleting an Activity Type

Creating or Updating an Activity Type
The Activity Type administration portlet defines the activity types that users can specify when creating
activities in records or reference objects. You can associate an activity type with an activity-specific
information group that defines the fields applicable to the activity creation of the type.

There are 6 portlets that support activities. Each activity type only works for one and only one of these
portlets:
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Licensed Professional Portlet Record Portlet Reference Address Portlet

Reference Contact Portlet Reference Owner Portlet Reference Parcel Portlet

To create or update an activity type

1. Access the Activity Type portlet (Navigating to the Setup Portlet).

2. Do one of the following:

• Click New to create a new activity.

• Click the activity you want to update.

Civic Platform displays an Activity detail form portlet.

3. Complete the necessary fields as described in Table 93: Activity Type Fields.

4. Click Submit to save the changes.

Civic Platform displays a confirmation message.

Table 93: Activity Type Fields

Activity Type Enter the name of the activity.

Activity Specific Info
Group Code

Select the activity-specific information group code from the drop-down list.

Description Enter a short summary of the action taken related to the activity.

Reference Type Select to which portlet (business object) to apply the current activity type definition.

Active Select Enable if you want to display the activity to users; otherwise, select Disable.

Searching for an Activity Type
To search for an activity type

1. Access the Activity Type portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Activity Type search form portlet.

3. Complete the necessary fields as described in Table 93: Activity Type Fields.

4. Click Submit.

Civic Platform returns a list of activity types that match the search criteria.

Viewing an Activity Type
To view an activity type

1. Access the Activity Type portlet (Navigating to the Setup Portlet).
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2. Click the activity that you want to view.

Civic Platform displays the Activity Type detail form portlet.

Deleting an Activity Type
You can delete any activity that you no longer need.

To delete an activity type

1. Access the Activity Type portlet (Navigating to the Setup Portlet).

2. Select the activity you want to delete.

3. Click Submit.

Civic Platform displays a confirmation message.

Configuring Standard Comments
Standard comments are pre-defined comments that users can quickly select in lieu of the time-consuming
task of manually entering comments that they use repeatedly. Standard comments help users complete
tasks quickly and improve the consistency of the information on your system.

Standard comments exist throughout Civic Platform. Specifically, users can add standard comments when
updating workflow tasks, entering inspection results, and placing any type of condition on an object.

System administrators must configure Comment Groups, then add Comment Types to those groups,
and then create Comments for those types. You can assign each Standard Comment Group, with its
associated types and comments, to record types, inspections, workflows, and checklists. You can create
a Comment Group and assign it, then add Comment Types and Comments later; until you add Types and
Comments, the data picker on the user side is empty. You can also create a Comment Group, then add
Types and Comments to it, and then assign the group.

Click a topic title below for full details.

Related Links

Managing Standard Comment Groups

Managing Standard Comment Types

Managing Standard Comments

Enforcement Violation Comments

Managing Standard Comment Groups
The first step in managing comments is to create a comment group. The only information you need to
create a group is a comment group name.

There are two ways of assigning a comment group. You can use the Assign button in the Comment Group
main portlet or the tabs in the record portlet.

Topics

• Creating a Comment Group

• Viewing a Comment Group

• Searching for a Comment Group
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• Deleting a Comment Group

• Assigning a Comment Group

• Managing Associated Record Types

• Managing Associated Inspections

• Managing Associated Workflow Tasks

• Managing Associated Checklists

Creating a Comment Group
The only information you need to create a comment group is a comment group name. You can add
comment types and comments to the group later. When you assign a Comment Group to a record type,
inspection, workflow, or checklist, users can choose from the comments associated to the comment group
to populate their form.

To create a comment group

1. Access the Comment Group Maintenance portlet (Accessing the Comment Group Maintenance Portlet).

2. Click New.

Civic Platform displays the Create Comment Group page.

3. Enter a name in the Comment Group field.

4. Click Submit.

Civic Platform adds the new group to the Comment Group List.

Viewing a Comment Group
To view a comment group
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1. Access the Comment Group Maintenance portlet (Accessing the Comment Group Maintenance Portlet).

2. Click the name of the comment group you want to view.

Civic Platform displays the associated Comment Types and Comments.

Searching for a Comment Group
Search for existing standard comment groups.

To find a comment group

1. Access the Comment Group Maintenance portlet (Accessing the Comment Group Maintenance Portlet).

2. Click Search.

Civic Platform displays the Standard Comment Group Search portlet.

3. Complete any fields that display. For a description of the fields, see Table 94: Standard Comment
Group Search Fields.

4. Click Submit.

Civic Platform returns a list of Standard Comment Groups that meet your search criteria.

Table 94: Standard Comment Group Search Fields

Comment Group Enter the name of the comment group.

Comment Type Enter the name of the comment type.

Comment ID Enter the comment ID.
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Comment Name Enter the comment name.

Permit Type Enter the name of permit type for the comment group you are searching for.Click the
data picker icon next to this field to choose the Permit Type from a data navigation tree.

Checklist Group Enter the name of the checklist group for the comment group you are searching for.

Checklist Enter the name of the checklist for the comment group you are searching for.

Checklist Item Enter the name of the checklist item for the comment group you are searching for.

Inspection Group Code Enter the inspection group code for the comment group you are searching for.

Inspection Type Enter the name of the inspection type for the comment group you are searching for.

Workflow Process Enter the name of the workflow process for the comment group you are searching for.

Workflow Task Enter the name of the workflow task for the comment group you are searching for.

Deleting a Comment Group
You cannot delete a comment group if you assign it to a record type, inspection, workflow, or checklist. You
must first delete the relationship between the comment group and the type and then delete the comment
group.

To delete a comment group

1. Access the Comment Group Maintenance portlet (Accessing the Comment Group Maintenance Portlet).

2. Delete any comment types associated to the comment group. For instructions, see Deleting a Comment
Type.

3. In the Standard Comments portlet, select the Comment Group you want to delete.

4. Click Delete.

Civic Platform deletes the Comment Group.

Assigning a Comment Group
When you assign a comment group to a record type, inspection, workflow, or checklist, you provide users
with a drop-down list of the comments contained in the comment group. When working in the form, users
can choose a standard comment from the drop-down list to populate the Comments field.

There are two ways of assigning a comment group. You can use the Assign button in the Comment Group
main portlet or the tabs in the record portlet. Both paths display a navigation tree with all the record types,
inspection types, workflows, and checklists you can assign to a comment group. Select one or more types
and assign the comment group. Each comment type and comment belonging to the comment group is now
available for users to select when completing forms associated with the record, inspection, workflow, or
checklist type.

You can assign each comment group to multiple types. However, each record type, inspection type,
workflow, and checklist can only have one comment group assigned to it. When you try to assign a
comment group to a type that already has one, Civic Platform displays an error message.

To assign a comment group

1. Access the Comment Group Maintenance portlet (Accessing the Comment Group Maintenance Portlet).

2. Use one of two methods to select the record type, inspection, workflow, or checklist to which you want
to assign the comment group:

a. Mark the check box beside the comment group you want to assign.
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a. Hover over or click Assign.

The Comment Group Assign menu displays under the Assign button.

b. Click one of these four choices:

Assign Record Type

Assign Checklist

Assign Inspection

Assign Workflow

Civic Platform displays a navigation tree with the record types, checklists, inspections, or
workflows.

b. Click the name of the comment group you want to assign.

Civic Platform displays the Comment Types and Comments that belong to the selected Comment
Group.

a. Click one of the following tabs, depending on which type of form you want to assign to the
comment group:

Record Types

Inspections

Workflow

Checklist

Civic Platform displays the list of record types, inspections, workflows, or checklists assigned to
the comment group.
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b. Click Look Up.

Civic Platform displays a navigation tree with the record types, checklists, inspections, or
workflows created for your system.

3. Use the + and - buttons to expand and collapse the tree to find the record type, checklist, inspection, or
workflow to which you want to assign the comment group.
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4. Select the record type, checklist, inspection, or workflow to which you want to assign the comment
group.

You can mark multiple check boxes to assign the comment group to multiple record types, checklists,
inspections, or workflows.

Mark an item on a higher level to select everything below that level. Click the check box to clear marked
items.

5. Click Submit.

Civic Platform assigns the items to the specified comment group.
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Managing Associated Record Types
In this portlet you can view the record types for the standard comment group. You can also assign the
group to record types and delete the assignation.

To manage the record types for the standard comment group

1. Navigate to the comment group that you want to update associated record types.

2. Click the Record Types tab.

Civic Platform displays the Record Type list portlet.

3. Do any of the following:

• To associate a record type with the standard comment group, see Assigning a Comment Group.

• To remove a record type from the standard comment group, select the record type and then click
Delete.

Managing Associated Inspections
In this portlet you can view the inspections for the standard comment group. You can also assign the group
to inspections and delete the assignation.

To manage the inspections for the standard comment group

1. Navigate to the comment group that you want to update associated inspections.

2. Click the Inspections tab.

Civic Platform displays the Inspections list portlet.

3. Do any of the following:

• To associate an inspection with the standard comment group, see Assigning a Comment Group.

• To remove an inspection from the standard comment group, select the inspection and click Delete.

Managing Associated Workflow Tasks
In this portlet you can view the workflow tasks for the standard comment group. You can also assign the
group to workflow tasks and delete the assignation.

To manage the workflow tasks for the standard comment group

1. Navigate to the comment group that you want to update associated workflow tasks.
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2. Click the Workflow tab.

Civic Platform displays the Workflow Task list portlet.

3. Do any of the following:

• To associate a workflow task with the standard comment group, see Assigning a Comment Group.

• To remove a workflow task from the standard comment group, select the workflow task and then
click Delete.

Managing Associated Checklists
In this portlet you can view the checklists for the standard comment group. You can also assign the group
to checklists and delete the assignation.

To manage the checklists for the standard comment group

1. Navigate to the comment group that you want to update associated checklists.

2. Click the Checklist tab.

Civic Platform displays the checklist list portlet.

3. Do any of the following:

• To associated a checklist with the standard comment group, see Assigning a Comment Group.

• To remove a checklist from the standard comment group, select the checklist and click Delete.

Managing Standard Comment Types
Topics

• Creating a Comment Type

• Adding an Existing Comment Type

• Deleting a Comment Type

Creating a Comment Type
After you create a comment type, you cannot change its name or the comment group it belongs to. To
change these details, you must delete the comment type, first deleting its relationships with comments, and
then create a new comment type with the name and the comment group you want.

When you create a comment type, you can create one comment along with it or leave it blank and add
comments to it later. To add comments to an existing comment type see Adding a New Comment.

To create a comment type

1. Navigate to the comment group for which you want to create a comment type. For instructions on how
to find a comment group, see Viewing a Comment Group.

2. Click the Comment Type tab.

Civic Platform displays the Comment Type list portlet.
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3. Click New.

Civic Platform displays the New Comment Type portlet.

4. Complete the following required fields:

Comment Type Enter a name for the comment type. It is a good idea to select comment type names
that correspond with the forms you use them for. For example, you could create Code
Enforcement and Inspection comment types.

Comment ID Enter a value, either alphabetic or numeric. You can devise your own system for
assigning this value.

5. You can add a comment to this comment type now or wait until later. To add a new comment later, see
Adding a New Comment. To add an existing comment later, see Adding an Existing Comment Type. To
add a comment now, complete the following fields:

Comment Name Enter a descriptive name for the comment, to help users select the appropriate
comment from a list of available comments.

Comment Enter the text of the comment. This text is the exact wording that populates user
forms when users select this comment from a list of standard comments.

6. Click Submit.

Civic Platform saves the comment type and any comment created with it.
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Adding an Existing Comment Type
You can include comment types in multiple comment groups. For example, you can use the Violation
comment type for both inspections and for asset condition assessments. You can add the Violation
comment type to comment groups assigned to both record types.

1. Navigate to the comment group to which you want to add a comment type. For instructions on how to
find a comment group, see Viewing a Comment Group.

2. Click the Comment Type tab.

Civic Platform displays the Comment Type portlet.

3. Click Look Up.

Civic Platform displays the Comment Type Look Up portlet.

4. Enter the name of the comment type you want to find in the Comment Type field.

To see a complete list of available comment types, leave the field blank.

5. Click Submit.

Civic Platform returns a list of comment types that matches your search criterion.

6. To add a comment type from the list, mark the check box beside the comment type.

7. Click Submit.

Civic Platform adds the comment type to the current Comment Group.
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Deleting a Comment Type
When you delete a comment type, you are deleting the relationship between the comment group and the
comment type. Civic Platform does not delete the comment type from the database and you can still add it
to comment groups.

You can delete a Comment Type in two ways. Select the comment type record and delete it, or delete all
the comments contained in the comment type. To delete comments from a comment type, see Deleting a
Comment.

To delete a comment type

1. Navigate to the comment group from which you want to delete a comment type. For instructions on how
to find a comment group, see Viewing a Comment Group.

2. Click the Comment Type tab.

Civic Platform displays the Comment Type portlet.

3. Select the comment type you want to delete.

4. Click Delete.

Civic Platform deletes the comment type from the comment group. Civic Platform does not delete the
comment group from the database and you can still add it to comment groups.

Managing Standard Comments
You can add a comment to a comment type when you create the comment type. For information on
creating a comment type, see Creating a Comment Type.

Topics

• Adding a New Comment

• Viewing a Comment

• Editing a Comment

• Deleting a Comment

Adding a New Comment
You can add comments to comment types when you create them. You can also add additional comments
to existing comment types.

To add a new comment
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1. Navigate to the comment group that contains the comment type to which you want to add a comment.
See Viewing a Comment Group.

2. Click the Comment Type tab.

Civic Platform displays the Comment Type portlet.

3. Click the name of the comment type to which you want to add a comment.

Civic Platform displays the Comment List portlet.

4. Click New.

Civic Platform displays the New Comment portlet.

5. Complete these fields:

Comment ID Enter a value, either alphabetic or numeric. You can devise your own system for
assigning this value.

Comment Name Enter a descriptive name for the comment, to help users select the appropriate
comment from a list of available comments.

Comment Enter the text of the comment. This text is the exact wording that populates user
forms when users select this comment from a list of standard comments.

6. Click Submit.

Civic Platform saves the comment.

Viewing a Comment
To view a comment

1. Access the Comment Group Maintenance portlet (Accessing the Comment Group Maintenance Portlet).

2. Click the name of the comment group you want to view.

Civic Platform displays the Comment Types and Comments that belong to the selected Comment
Group.

3. Click the Comment Type tab.

Civic Platform displays the Comment Type portlet.

4. Click the hyper linked name of the comment type that contains the comment you want to view.
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Civic Platform displays the Comment List portlet.

5. Click the link for the name of the comment you want to view.

Civic Platform displays the Comment Detail portlet.

Editing a Comment
You can change the comment name and the text of the comment after it you create it.

Editing a comment in the Administration portlet does not change the comment as it appears where a user
has loaded it into a form. Users must update each instance of a comment to reflect any administrator edits.

To edit a comment

1. Find the comment you want to edit. For instructions on how to find a comment, see Viewing a
Comment.

2. Edit the Comment Name or Comment field. For a definition of these fields, see step 5 of Adding a New
Comment.

3. Click Submit.

Civic Platform saves the changes to the comment.

Deleting a Comment
Delete a comment that is no longer frequently used from a comment type. When you delete all the
comments contained in a comment type, you also delete the comment type.

To delete a comment

1. Find the comment you want to delete. For instructions on how to find a comment, see Viewing a
Comment.

Civic Platform displays the Comment List portlet.

2. Select the comment you want to delete.

3. Click Delete.

Civic Platform deletes the comment from the comment type.
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Enforcement Violation Comments
This section contains the following topics:

• Creating a Violation Code Comment Type

• Adding a Comment to the Violation Comment Type

Creating a Violation Code Comment Type
Before you can create a standard comment for a violation, you must set up a violation code comment
type. If you have already set up the violation code comment type, see Adding a Comment to the Violation
Comment Type.

To create a violation code comment type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Agency Profile > Standard Comments.

Civic Platform displays the Standard Comment Type List—Browse page.

3. Click Add.

Civic Platform displays the Standard Comment—Add page.
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4. Complete the necessary fields as described in Code Enforcement Standard Comment Details.

5. Click Submit.

Civic Platform adds the violation comment to the list of standard comments.

Table 95: Code Enforcement Standard Comment Details

Comment Type Enter a Violation Code and the comment appears in the Violation Codes drop-down
list on the Violation—Add page where a user can choose the violation to add it to
a citation. For more information on adding a violation, see “Adding a Violation to a
Citation” in the Accela Civic Platform User Guide.

Comment ID Enter an identification code for the violation comment. You should enter a code that
helps identify what the code stands for. For example, for “Violation,” you might enter
“VIO.”

Comment Name Enter a name for the violation comment, such as Violation.

Comment Enter any additional information you want attached to this violation comment. For
example, if the violation were a payment violation, the comment might say, “Payment
Overdue.”

Adding a Comment to the Violation Comment Type
If you want to add more than one comment or violation to the violation code comment type, you can do so
in the standard comment function.

To add a comment to the violation comment type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Review > Std Comment.

Civic Platform displays the Standard Comment Type List—Browse page.



 | Part 3: Configuring Agency Business Objects | 457

3. Click the red dot next to the Comment Type “Violation Code.”

4. Click Add.

Civic Platform displays the Standard Comment—Add page.

5. Complete the necessary fields as described in Code Enforcement Standard Comment Details.

6. Click Submit.

Civic Platform adds the violation comment to the list of standard comments.
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Part 4: Managing Agency Communications and
Events

Civic Platform provides functions to configure agency communications.

Related Links

Working with Communication Manager

Setting Up Calendars

Social Media Integrations

Working with Communication Manager
Communication manager is a centralized communications hub that consolidates Civic Platform’s
notification functionality into a single portlet.

Communication manager integrates with Microsoft Exchange and Outlook, enabling agency users to
send meeting requests that they arrange in the calendar portlet, view the calendar availability of meeting
attendees, and maintain Outlook emails and attachments in the Civic Platform database.

Communication manager also integrates with SMS text messaging services, enabling you to communicate
with agency and public users by text message.

Click a topic title below for full details.

Related Links

Prerequisites

Configuring General Settings

Configuring Account Settings

Viewing the 360-Degree Communications List

Viewing Communications Associated with Records

Manually Sending Emails and Text Messages

Managing Alerts

Managing Alert Rules

Announcements

Notification Templates

Variables

Customizing the Content of Agency Communications

Prerequisites
Before you configure the communication manager settings described in this section, you must have a
functioning installation of Microsoft Outlook/Exchange Server, and an SMS text messaging provider. When
configuring communication manager, Civic Platform prompts you to enter key pieces of information from
those software configurations, which enable Civic Platform to communicate with them. Accela provides an
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SMS Adapter to connect your SMS text messaging system with Civic Platform. Refer to the SMS Adapter
section of the Accela Civic Platform Installation Guide for complete details.

You must also configure the Function IDs and Standard Choices related to this feature, before you
configure communication manager settings. Refer to the Communication Manager sections of the Accela
Civic Platform Configuration Reference for complete details.

Configuring General Settings
The general settings area is where you connect your Microsoft Exchange Server to Civic Platform. This
is also where you establish system-level settings that enable agency users to send, receive, and store
emails, calendar items, SMS text messages, and attachments.

Configure the following general settings first, and then proceed to Configuring Account Settings.

Topics

• Email Server Settings

• Calendar Server Settings

• SMS Server Settings

• Attachment Settings

Email Server Settings
Follow the instructions in this procedure to enable your Civic Platform system to communicate with your
Microsoft Exchange Server.

To connect Civic Platform to your Microsoft Exchange Server

1. Go to Civic Platform Administration > Communication Manager > General Settings.

Civic Platform displays the general settings window.

2. Click the Email Server Settings tab.

3. Complete these fields:
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Email Server Select the Microsoft Exchange Server version your agency uses. To take
advantage of the functionality Communication Manager provides, you must choose
a Microsoft Exchange Server.

If you do not want to implement Communication Manager, select Standard Email
Server in this field, and the values from your ServerConfig.properties file display in
read-only format.

Email Server URL Enter the URL to your Microsoft Exchange Server Host, for example: https://
exchange.example.com/EX/Exchange.asmx.

Default User Account Enter the user name of an active email account on your Microsoft Exchange Server
to designate it as the default email account.

If an agency user does not specify a display name in the from field, when
Communication Manager sends system-level emails, it uses this default email
account as the “sent from” address.

Password Enter the password for the default email account.

Confirm Password Re-enter the password.

4. Click Test to ensure the information you provided successfully connects Civic Platform to your Microsoft
Exchange Server.

A confirmation message displays.

5. If you receive a message indicating that Civic Platform failed to connect to your Exchange Server,
revise your entries and test again until you receive a success message.

6. Click Save.

Calendar Server Settings
To configure calendar server settings

1. Go to Civic Platform Administration > Communication Manager > General Settings.

Civic Platform displays the general settings window.

2. Click the Calendar Server Settings tab.
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3. Complete these fields:

Calendar Server Select the Microsoft Exchange Server version your agency uses.

Calendar Server URL Enter the URL to your Calendar Server.

Default User Account Enter the user name of an active email account on your Microsoft Exchange Server
to designate it as the default email account Civic Platform uses for sending meeting
requests.

When Communication Manager sends system-level emails, it uses this default
email account as the “sent from” address.

Password Enter the password for the default user account.

Confirm Password Re-enter the password.

4. Click Test (see for complete details).

5. Click Save.

SMS Server Settings
To configure SMS server settings

1. Go to Civic Platform Administration > Communication Manager > General Settings.

Civic Platform displays the general settings window.

2. Click the SMS Server Settings tab.

Civic Platform displays the SMS Server Settings window.
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3. Complete these fields.

SMS Provider Choose the SMS text messaging provider your agency uses. Administrators
define the options available in this drop down list in the standard choice
COMMUNICATION_SMS_PROVIDERS Refer to the Civic Platform Configuration
Reference for more information on configuring standard choices.

Adapter URL Enter the URL for your customized SMS adapter. Accela provides a generic
adapter, which you must configure to reflect the details of your agency's SMS
service provider.

This adapter is a web service that enables Civic Platform to communicate with your
SMS provider.

Account Enter the user name you use to access your SMS provider’s web service.

Password Enter the password you use to access your SMS provider’s web service.

Confirm Password Re-enter the password.

Attachment Settings
To configure attachment settings

1. Go to Civic Platform Administration > Communication Manager > General Settings.

Civic Platform displays the general settings window.

2. Click the Attachment Settings tab.

Civic Platform displays the Attachment Settings window.
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3. Complete these fields:

Attachment Server Select the EDMS server where you want to store email attachments. Civic Platform
populates the values in this drop-down list from this standard choice: EDMS.

There is a limit of one EDMS server per agency for storing email attachments.

Maximum Size of Total Files To further restrict the maximum allowable size of attachments for a single email,
beyond the scope of Civic Platform’s standard file size restrictions, enter a value in
whole numbers here.

This field works with the two standard settings Civic Platform uses to limit the size
of attachments: First, the standard choice EDMS specifies the maximum allowable
file size for each attachment. Second, the ServerConfig.properties file that resides
on the Civic Platform web server specifies the maximum allowable file size for all
attachments within a single email.

The number you enter in this field must be equal to or less than the file size limit
specified in your ServerConfig.properties file.

4. Click Test (see for complete details).

5. Click Save.

Configuring Account Settings
The account settings area is where you configure:

• Account details that define the accounts from which agency users send outgoing emails and SMS text
messages.

• Display names that become available for agency users to choose in the “from” value of all system-
generated communications. A subset of the display names becomes available in the “from” values of
manually initiated emails, according to the user’s permission level.

• The option to retrieve all emails for the account from the Microsoft Exchange Server. For example, you
might have a general, department-level email account for which you want to enable the retrieval and
storage of all of the communications from and to the account in the Civic Platform database.

First implement Communication Manager by Configuring General Settings, then configure the following
Account Settings:

• Email Account Settings
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• SMS Account Settings

Email Account Settings
Use the procedure below to set up each account that you want to make available for agency users to use
for communicating with the public, and for retrieving emails to attach to records.

To configure email account settings

1. Go to Civic Platform Administration > Communication Manager > Account Settings.

2. Click New.

Civic Platform displays the account settings window.

3. Click the Account Detail tab.

4. Complete the following fields:

Email Account Enter the user name of the email account. This user name must be a valid user
name of the Microsoft Exchange server that you specify in Configuring General
Settings.

Email Address Enter the email address for the email account you specified in the previous field.

Display Name Enter a display name for this account. This display name populates in the “from”
values of notification templates, manual email messages, and manual text
messages. Agency users can specify the display name for their department, which
then displays as the sender of the email.

Password Enter the password of the email account.

Confirm Password Re-enter the password.

Retrieve Email from Server Check this option to copy all emails sent from and to this email address to the Civic
Platform database. When you select this option, the contents of this email account
become accessible in the communication manager portlet’s consolidated list of
communications, organized by Inbox, Outbox, Sent Items, and Deleted Items.

5. Click Test to ensure the information you provided successfully connects Civic Platform to your Microsoft
Exchange Server.
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6. If you receive a message indicating that Civic Platform failed to connect to your Exchange Server,
revise your entries and test again until you receive a success message.

7. Click Submit if you are creating a new account; Click Save if you are modifying an existing account.

8. Click the Permissions tab.

Civic Platform displays the Permissions window.

9. Click the Assign buttons to select an appropriate permission level for this account.

These permissions define which users have the ability to send manual emails from this account via a
record’s Communications tab (see Viewing Records-related Communications for more information).
When you grant a user permission, the user's name displays as the “from” value for sending manual
communications.

Refer to Setting Up Security Policies for information about assigning permissions.

10.Click Submit.

SMS Account Settings
Use the procedure below to configure outgoing SMS text messaging accounts.

SMS (Short Message Service) is a communications protocol for sending short text messages from
computers to cellular devices. You must have an active, fully configured account with an SMS service
provider before setting up SMS account settings in Civic Platform.

To configure SMS account settings

1. Go to Civic Platform Administration > Communication Manager > Account Settings.

Civic Platform displays the account settings window.

2. Click SMS Account.

3. Click New.

Civic Platform displays the SMS Accounts window.

4. On the Account Detail tab, complete these fields:

SMS Account Enter the user name of the SMS account.

Display Name Enter the name you want to display with the account when selecting “from”
values for notification templates and communications manually initiated from the
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Communications tab of a record. Different departments at an agency can each
have their own text message accounts. Users can select the appropriate “from”
values for text messages sent from their department when you configure the text
message account settings here.

Phone Number Select the phone number for the SMS account.

The SMS adapter defines the phone numbers available to choose from in this
field. This field retrieves available options from the SMS adapter web service. This
number is the sender number that displays to recipients of SMS messages.

Status Active/Inactive

5. On the Permission tab, click the Assign buttons to select an appropriate permission level for this
account.

These permissions define which users have the ability to send manual text messages from this account
via a record’s Communications tab. When you grant a user permission, the user's name displays as a
“from” value for sending manual communications.

Refer to Setting Up Security Policies for information about assigning permissions.

6. Click Submit.

Viewing the 360-Degree Communications List
Communication manager maintains a correspondence list that keeps track of all incoming and outgoing
communications (also known as a 360-degree view).

The list initially displays in chronological order, but you can sort, filter, and search the correspondence list
by title, communication type, from, to, sent date, and initiating event. You can use the operands “&” and
“or” when filtering the correspondence list. For example, you can filter all communications of type = email
or of type = SMS.

The correspondence list contains the following types of communications:

• Emails

• Text Messages

• Meeting Requests

To view the 360-degree communications list

1. Access the Communications Manager portlet by clicking the main link in Civic Platform.

If you do not have a main link to the Communications Manager portlet, create one by Setting Up Your
Console and Home Page.

Civic Platform displays the four categories of correspondence.
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2. Click to view any of the following items:

Table 96: The 360-Degree Communications List

Sent Items Click to view items sent from Civic Platform, including all sent items, items sent
manually, items sent by events and scripts, and notifications.

Outbox Click to view pending items that you have scheduled but not yet sent, items for which
you have specified a delay time, bounced items, and items that Civic Platform cannot
send due to a failure status.

Inbox Click to view emails retrieved from external email servers. The Inbox stores
emails only; it does not store text message and it does not store other types of
communications. You must select the option Retrieve Email from Server in Email
Account Settings for emails to display here.

Deleted Click to view deleted and/or restore deleted items.

Viewing Communications Associated with Records
The Records portlet contains a Communications tab where you can:

• View all the communications, incoming and outgoing, related to a selected record.

• Manually initiate communications (emails and text messages) relevant to a particular record. Emails
sent from the Records portlet automatically inherit the record ID, and Civic Platform maintains it as part
of the record.

Viewing Records-related Communications
Use the procedure below to view all communications related to a particular record.

To view communications for a specific record

1. To enable this feature, set this FID to full access: 8492-Communication List.

2. Access the Records portlet by clicking the main link in Civic Platform.

If you do not have a main link to the Records portlet, create one by Adding a Main Link.
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3. Select a record.

4. Click the Communications tab. If you do not have a Communications tab, add it by Adding a Tab Menu
to a Template Menu.

Civic Platform displays the Communications tab.

5. Click a column heading to change the sort order of the communications list.

6. Click a title link to go to the details of the communication.

Civic Platform displays the details of the communication.

Viewing Consolidated Record Activities
Communication manager includes a Consolidated Record Activities tab. This tab enables you to view a
summary list of all communications relevant to a particular record. Relevant communications include: email
messages, SMS text messages, meetings, inspections, documents, activities and workflow history.

To view consolidated record activities

1. To enable this feature, set this FID to full access: 8493-Consolidated Record Activities.

2. Access the Records portlet by clicking the main link in Civic Platform.

If you do not have a main link to the Records portlet, create one by Adding a Main Link.

3. Select a record.

4. Click the Consolidated Record Activities tab. If you do not have a Consolidated Record Activities tab,
add it by Adding a Tab Menu to a Template Menu.

Civic Platform displays the Consolidated Record Activities tab.
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Manually Sending Emails and Text Messages
To initiate communications manually

1. Access the Records portlet by clicking the main link in Civic Platform.

If you do not have a main link to the Records portlet, create one by Setting Up Your Console and Home
Page.

2. Select a record.

3. Click the Communication tab.

4. Click New > Email or New > SMS (Text Message) to manually initiate communication.

Civic Platform displays one of the following.
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5. Complete these fields:

Table 97: Manually Initiated Email and Text Message Fields

Email Fields:

Title Enter a subject for the email.

Content Enter the content of the message. You can use HTML code to create the content.
You can also add parameters and embed hyperlinks to the Record Detail page in this
field. You must define the parameters and URL in the EMSE scripts. For information
on how to define parameters and embed hyperlinks, see Embedding Links to Record
Detail Page.

From Choose a value from the drop-down list. An administrator defines the values that
populate this field. Refer to the Display Name setting in communication manager
account settings.

To, Cc, Bcc Enter an email address or click the record selection icons to the right of the fields to
specify the recipient(s) of the message (Contact/Owner/Licensed Professional/ Public
User).

Importance Select an importance: low, normal, or high. Normal is the default.

Send Date/Send Time Specify a date and time for Civic Platform to send the communication. This field is
mandatory.

Comments Enter the purpose of the communication, and any useful context you want to retain
regarding the communication. Civic Platform does not send this information to email
servers.

Send Button Click to send the email or text message.



 | Part 4: Managing Agency Communications and Events | 472

Attach Button Click to upload documents as attachments to the email. After you attach a document
the name of the document displays. If you want to remove the attachment, click the X
button next to the attachment.

Reset Button Click to remove all attachments and content from the message and reset all fields to
blank fields.

Text Message Fields:

From Choose a value from the drop-down list. An administrator defines the display
name values that populate the From field. Refer to the Display Name setting in
communication manager account settings.

To Enter a cellular phone number or click the record selection icons to the right of
the fields to specify the recipient(s) of the message (Contact/Owner/Licensed
Professional/ Public User).

Content Enter the content of the message.

Designated Send Date Specify a date and time for Civic Platform to send the communication. This field is
mandatory.

Comments Enter the purpose of the communication, and any useful context you want to retain
regarding the communication. Civic Platform does not send this information to SMS
servers.

Send Button Click to send the text message.

Reset Button Click to remove all content from the message and reset all fields to blank fields.

6. Click Send.

Managing Alerts
Topics

• Creating an Alert

• Editing an Alert

• Deleting an Alert

• Managing Alert Recipients

• Creating a Time Variable Alert

Creating an Alert
Privileged users can create alerts to notify groups at your agency of all kinds of events. After you create an
alert it displays in the Alerts portlet, where you can edit, delete, and manage its recipients.

To create an alert

1. Go to Civic Platform Administration > Communication Manager > Alert.

Civic Platform displays the Alert window.

2. Click New.

Civic Platform displays a Message Type drop-down field in the record tab.

3. Select one of the following options from the Message Type drop-down field:

• If you want to send the alert as an email message, choose Email.

• If you want to post the alert message to the Alert portlet, choose Alert Message.
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4. Click Submit.

Civic Platform refreshes the form with fields appropriate for the message type.

5. Complete any of the fields that display.

For a list of field descriptions, see Table 98: Alert Detail.

6. Click Submit.

Civic Platform displays a confirmation message and enables the Recipient and Rules tabs.

7. Choose the alert recipients.

See Managing Alert Recipients.

If you want to apply an alert rule to govern the time frame for sending an alert, see Applying an Alert
Rule to an Alert.

Table 98: Alert Detail

Content Enter the text of the alert message. In addition to the standard text, you can also enter
parameters for variables. Click the selection icon to select a parameter from a list. See
Filtering the Display of Data for a complete list of variable parameters.

For additional variables that pertain directly to Accela Civic Platform - Asset, see Table
99: Asset Management Alert Message Variables.

Duration Enter how long the alert message should remain in the Alert portlet.

External Recipients If you are sending the alert to people outside of your agency, select the kind of external
recipient from the drop-down. For example, Contacts.

Message Type Indicates whether the alert is in the form of an email or as an alert message in the Alert
portlet. After you create an alert message, you cannot change the message type.

Status Use the drop-down field to enable or disable the alert. The alert duration does not
begin, nor does the alert display, until you enable the alert.

Unit Select the units for the quantity in the Duration field (Days, Hours, Minutes, or
Seconds).
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Table 99: Asset Management Alert Message Variables

Variable Name Description

$$ALTID$$ Alt ID The asset’s alternate ID.

$$WOTEMPLATE$$ Work Order Template Template used to create the asset’s associated work
order.

$$SCHEDULEDATE$$ Schedule Date Scheduled asset condition assessment date.

$$ESTPRODUNITS$$ Est. Prod Units Estimated production units for a work order.

$$ACTUALPRODUNITS$$ Actual Production
Units

Actual production units for a work order.

$$ESTCOSTPERUNIT$$ Est. Cost Per Unit The estimated cost per production unit for a work
order. System administrators define this value at the
Application Type level.

$$COSTPERUNIT$$ Cost Per Unit The cost per unit of production for a work order.

$$ESTJOBCOST$$ Est. Job Cost Estimated total cost for the work order. This value is
the product of the Cost Per Unit and the Est. Prod.
Unit values.

$$TOTALJOBCOST$$ Total Job Cost Total cost of the job, defined by a work order.

$$ASSETGROUP$$ Asset Group Name of an asset group.

$$ASSETTYPE$$ Asset Type Name of an asset type.

$$ASSETID$$ Asset ID Asset identification name or number.

$$ASSETSTATUS$$ Asset Status Status of an asset, whether Active or Expired.

$$CLASSTYPE$$ Asset Class Type Name of an asset class type.

$$DATEOFSERVICE$$ Date of Service Date of an asset's activation or when you placed it
into service.

$$USEFULLIFE$$ Useful Life Number of years you expect to use an asset.

$$ASSETRECORDSTATUS$$ Asset Record Status Status of the asset record, whether Active or Inactive.

$$ASSETDESC$$ Asset Description Description of an asset.

$$CURRENTVALUE$$ Current Value An asset’s current value.

$$DEPRECIATIONVALUE$$ Depreciation Value Dollar amount of an asset’s value after depreciation.

$$DEPRECIATIONAMOUNT$$ Depreciation Amount Dollar amount of an asset’s depreciation.

$
$ASSETSTREETNUMBERSTART
$$

Street # (start) Initial street number of a street number range.

$$ASSETSTREETNUMBEREND
$$

Street # (end) Final street number of a street number range.

$$ASSETSTREETPREFIX$$ Prefix Any part of an address that comes before the street
name or number, such as North Windsor Dr.

$$ASSETUNITNUMBERSTART$
$

Unit # (start) Initial unit number, for example apartment number, of
a unit number range.

$$ASSETUNITNUMBEREND$$ Unit # (end) Final unit number, for example apartment number, of
a unit number range.

$$ASSETUNITTYPE$$ Unit Type Type of unit, for example, apartment or condominium.
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Variable Name Description

$$ASSETSTREETDIRECTION$$ Direction Street direction that precedes the street name, for
example West Broadway.

$$ASSETSTREETNAME$$ Street Name Street name of an asset’s address.

$$ASSETSTREETTYPE$$ Street Type Suffix used for a street, for example Lane or
Boulevard.

$$ASSETSTREETSUFFIX$$ Street Suffix
(direction)

Street direction that follows the street name, for
example 600 Maple South.

$$ASSETCITY$$ City City in which an asset resides.

$$ASSETSTATE$$ State State in which an asset resides.

$$ASSETZIP$$ Zip ZIP code for an asset’s mailing address.

Editing an Alert
This section describes how to edit an alert.

To edit an alert

1. Go to Civic Platform Administration > Communication Manager > Alert.

Civic Platform displays the Alert window.

2. Click the link to the alert you want to edit.

Civic Platform displays the alert details.

3. Edit information in the displayed fields.

For a list of field descriptions, see Table 98: Alert Detail.

4. Click Submit to save your changes.

Civic Platform displays a confirmation message, and updates the alert list.

5. Make any changes to the alert recipients, as needed. See Managing Alert Recipients.

6. Make any changes to the alert rule that governs the alert, as needed. See Applying an Alert Rule to an
Alert.

Deleting an Alert
Make sure the alert you select is the one you want to delete. If you delete the wrong alert, you must
recreate it.

To delete an alert

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Choose Communication Manager > Alert.

3. Select the alert you want to delete.

4. Click Delete.

Civic Platform displays a confirmation message.

Managing Alert Recipients
After you create an alert message, you can determine who should receive it. You can send an alert to your
entire agency or select certain departments, user groups, and even individual users within your agency.
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If you no longer need a recipient to receive the alert, you can remove the recipient from the list. Removing
a recipient from this list does not delete the recipient from your system.

For more information on managing alert recipients, see Setting Up Security Policies.

Creating a Time Variable Alert
Use time variables in alerts to notify specific users when, for example, a user creates a service order and a
specific amount of time elapses before they assign the service order to a user.

You can use the following time variables in alerts:

• $$Today$$

• $$Today+N$$

• $$Today-N$$

To configure an alert with a time variable

1. Navigate to V360 Administration > Communication Manager > Alert Rule.

2. Create a new alert rule with the following parameters:

Type: Alert Message

Rule Items: Record - Open Date <= $$TODAY-2$$ AND Record - Assigned to Staff is null

Enabled: Yes

3. Click Submit.

4. Go to Communication Manager > Alert.

5. Create a new alert with message type AlertMessage.

6. Specify the content, duration, and status (enabled).
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7. Click Submit.

8. Open the alert.

9. On the Recipient tab, click Assign User to specify the user you want to notify.

10.On the Alert Rule tab, click Look Up to specify the alert rule you created in .

To validate that the alert is working

1. Create or modify a test record with an opened date more than 2 days in the past (for example,
10/21/2013) and a scheduled date after the opened date (for example, 10/30/2013).

2. Click the Alerts link at the top of the console in Civic Platform to validate that the alert triggers
successfully:

Managing Alert Rules
For instructions on setting up alert messages and recipients, see Creating an Alert.

Topics

• Creating an Alert Rule
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• Editing an Alert Rule

• Deleting an Alert Rule

• Working with Alert Rule Associations

Creating an Alert Rule
This section describes how to create an alert rule. You can set up an alert rule with multiple conditions. For
example, you might want to send an alert to a manager if someone creates an item of a certain type and of
a particular priority. You enter each rule item in the same way, combining rules with the appropriate logical
operator. Use the parentheses to group two or more conditions.

Sending a Message Immediately
This rule is the typically the most common rule. When an action happens, the alert rule triggers an
immediate response. For example, you might want to send an alert to a department manager immediately
when someone opens an item with a Priority of “1.”

To send a message immediately

1. Go to Civic Platform Administration > Communication Manager > Alert Rule

Civic Platform displays the Alert Rule window.

2. Click New.

Civic Platform displays a blank form.

3. Complete the following fields:

Name Enter the name of the alert rule.

Description Enter a description of what the alert rule does. For example, you can describe the
condition that initiates alert, such as “Service Request Closed,” or describe the kind of
alert rule, such “Close Request Alert.”

Enabled Select “Yes” to enable the alert rule, making it available to apply to alerts; otherwise,
select “No.” Disabling rules enables you to inactivate them without deleting them from
Civic Platform.

4. Use theTypedrop-down list to choose the Alert Message option.
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5. Define one or more conditions of the alert rule. For each condition, enter information in the appropriate
field.

For definitions of the fields, see Conditions Field Descriptions.

6. If you want to add an additional condition, clickNew Item and complete the fields explained in .

7. If desired, click Show Expression to review the expression Civic Platform uses to evaluate the
condition.

8. Click Submit.

Civic Platform adds the alert rule to the list and enables the Associated Objects tab.

9. To review a list of any associated objects, such as Alerts, click the Associated Objects tab.

For instructions on applying an alert rule to an alert, see Applying an Alert Rule to an Alert.

Table 100: Conditions Field Descriptions

Close Parenthesis Use the open and closed parentheses to group sets of rule conditions.

Literal Value Enter a literal value to compare the object property against. For example, enter 1 to
have the alert rule condition evaluate only objects with a priority (property) of 1. Literal
values must match exactly the values your agency uses.

Logical Operator If the alert rule uses more than one expression, Civic Platform displays a logical
operator drop-down. Select the desired operator to combine the expressions. For more
information about your choices, see Filtering the Display of Data.

Object Select the object you want to associate with the trigger. For example, select Service
Request if you plan to associate a service request’s attribute with an alert. Civic
Platform populates the Property drop-down field with values that correspond with the
object you select.

Open Parenthesis Use the open and closed parentheses to group rule conditions together.

Property Select a property for the object you selected in the Object drop-down. For example,
if you plan to apply this rule to an alert that notifies building supervisors of records
opened on a specific date, select “Opened Date” from the Property drop-down list. Your
agency admin defines the items in this drop-down list. For a list of properties, see Alert
Rule Object Properties.

Relational Operator Select a relational operator to compare the object property against. For more
information about your choices, see Filtering the Display of Data.

Table 101: Alert Rule Object Properties

Property Name Definition

after(hour) Combine this property with others to create a time-lapse for the trigger. For example,
to send an alert one hour after an item closes, set up an alert rule item for Status =
“Closed,” then use the AND operator to combine a second rule item for after(hour)=“1.”

Asset Group Group to which an asset belongs.

Asset ID Asset identification.

Asset Type Type of asset.

Assigned Date The date a staff member receives an item.

Assigned to Department The department to which the item belongs.

Assigned to Staff The agent to which the item belongs.

Channel Reported The reporting mechanism for an item. For example, “Email,” “Call Center,” “Web.”

Class Type Class type to which asset groups and types belong.
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Property Name Definition

Closed By The person who closed the item.

Closed Date The date the user closed the item.

Current Value An asset’s current monetary value.

Date of Service The date an asset record enters into the database.

Depreciation Amount Dollar amount an asset has depreciated.

Depreciation Value Value of an asset after it has depreciated.

End Closed Date If you are searching for an object, use this field along with the Begin Closed Date to
specify a range of closed dates.

End Open Date If you are searching for an object, use this field along with the Begin Open Date to
specify a range of open dates.

ID (SR, WO, and so
forth)

The item’s identification code. Civic Platform assigns the item this code at the time of
its creation.

Last Activity Date The date when the item most recently experienced activity.

Module Name The module to which the object belongs. For example, “Service Request.”

No Activity This property enables you to specify a period, in hours, during which the item
experienced no activity. For example, if you want the alert rule to trigger an event for
items that experience no activity for 48 hours, select the “No Activity” property, the “=”
operator, and enter “48” in the Literal Value field.

Opened Date The date you opened the item.

Priority The priority of the item. For example, “1” or “2.” Your agency creates priorities in Civic
Platform.

Record Status Status, whether Active or Inactive, of an asset record.

Severity The severity of the item. Your agency determines the values you can choose from.

SR Sub Type A more specific classification for the item.

SR Type The item’s type or classification. Your agency determines the values you can choose
from.

Staff Full Name The full name of the staff member who owns the item.

Status The status of the service item. Your agency determines the values you can choose
from. You might see such statuses as Opened, Closed, or Unassigned.

Sub-Status The sub-status of the item.

Useful Life Number of years you expect to use an asset.

Sending a Message after Meeting Rule Conditions
You might want to send an alert to a citizen one hour after you close an item, to allow for a delay in case
you reopen the item for some reason. You can also create time alerts that trigger if an event does not
occur. For example, you can alert the manager of a department if items do not experience any activity, with
the “No Activity” property.

To send an alert upon completion of rule conditions

1. Go to Civic Platform Administration > Communication Manager > Alert Rule

Civic Platform displays the Alert Rule window.

2. Click New.

Civic Platform displays a blank form in the record tab.
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3. Complete the following fields:

Name Enter the name of the alert rule.

Description Enter a description of what the alert rule does. For example, you can describe the
condition that initiates alert, such as “Service Request Closed,” or describe the kind of
alert rule, such “Close Request Alert.”

Enabled Select “Yes” to enable the alert rule, making it available to apply to alerts; otherwise,
select “No.” Disabling rules enables you to inactivate them without deleting them from
Civic Platform.

4. Use the Type drop-down list to choose the Time Alert option.

5. Define the condition rule items:

Note:

This additional rule item specifies the time limit that Civic Platform waits before sending an alert
message, upon completion of rule conditions.

Open Parenthesis Leave this field blank.

Object Select the option for the desired item. For example, “Service Request,” “Record,”
or “Inspection.”Civic Platform populates the Property drop-down with the object’s
properties.

Property Select the after (hour) menu option.

Operator Select the equal (=) menu option.

Literal Value Enter the time, in hours, after completion of alert rule conditions that you want Civic
Platform to send the alert. You can use decimals to indicate fractions of an hour. For
example, 0.25 equates to fifteen minutes, 0.50 equates to thirty minutes, and 0.75
equates to forty-five minutes.

Close Parenthesis Leave this field blank.

Logical Operator If you are creating a Time Alert, choose “And” from the drop-down list and add a
condition with parameters.

6. If you want to add an additional condition, clickNew Item and complete the fields explained in .
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7. Click Show Expression to view the expression Civic Platform uses to evaluate the condition.

8. Click Submit.

Civic Platform adds the alert rule to the list and enables the Associated Objects tab.

To review a list of any associated objects, such as Alerts, click the Associated Objects tab. For
instructions on applying an alert rule to an alert, see Applying an Alert Rule to an Alert.

Editing an Alert Rule
When you edit an existing alert rule, you automatically affect objects, such as alerts, associated with the
alert rule. You do not need to update associated items individually. For example, if you decide that you
want to send alerts for a different service request type, you can simply edit the alert rule, and automatically
update all alerts associated with the alert rule.

To edit an alert rule

1. Go to Civic Platform Administration > Communication Manager > Alert Rule

Civic Platform displays the Alert Rule window.

2. In the Name column, click the alert rule you want to edit.

Civic Platform displays the alert rule details in the record tab.

3. Update the alert rule conditions as appropriate.

For field descriptions, see Creating an Alert Rule.

4. If you want to add an additional condition, clickNew Item and complete any fields that display. For field
descriptions, see Creating an Alert Rule.

For example, you might want to send an alert to a manager if someone creates an item of a certain type
and of a particular priority. You enter each rule item in the same way, combining rule items with logical
operators. Use the parenthesis to group two or more conditions.

5. If you want to delete a condition, select the condition and click Delete Item.

6. Click Show Expression if you want to view the expression used to evaluate the condition.

7. Click Submit.

Civic Platform adds the alert rule to the list and enables the Associated Objects tab.

8. To review a list of any associated objects, such as Alerts, click the Associated Objects tab.

For instructions on applying an alert rule to an object and disassociating an object from an alert rule,
see Working with Alert Rule Associations.

Deleting an Alert Rule
You can remove an alert rule from Civic Platform. Be sure to review any associated objects before deleting
an alert rule.

To delete an alert rule

1. Go to Civic Platform Administration > Communication Manager > Alert Rule

Civic Platform displays the Alert Rule window.

2. Select each rule you want to remove.

Note:

Make sure the alert rule you select is the one you want to delete. If you remove the wrong Rule, you
must recreate it.
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3. Click Delete.

Civic Platform confirms the deletion and updates the alert rules list.

Working with Alert Rule Associations
After you establish an alert rule, you can associate it with the actual system response. For example, if an
alert rule determines that Civic Platform should send an email message in response to a certain condition,
you then need to identify what email message you want to send. You can subsequently review and make
changes to the objects associated with an alert rule, which is useful if you are editing or removing an alert
rule and need to know which alert objects currently use the alert rule.

Topics

• Applying an Alert Rule to an Alert

• Disassociating an Alert Rule

Applying an Alert Rule to an Alert
This section describes how you can apply rules to an alert. For instructions on establishing an alert rule,
see Creating an Alert Rule. For instructions on creating an alert, see Creating an Alert.

To apply an alert rule to an alert

1. Go to Civic Platform Administration > Communication Manager > Alert Rule

Civic Platform displays the Alert Rule window.

2. Click the alert to which you want to apply the alert rule.

Civic Platform displays the alert details in the record portlet.

3. Click the Alert Rule tab.

Civic Platform displays the alert rules assigned to the alert.

4. Click Look Up to search for the alert rule you want to assign.

Civic Platform displays a list of all system rules.

5. Select the alert rule you want to apply.
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6. Click Select.

Civic Platform adds the alert rule to the list of rules currently governing the alert.

7. If you inadvertently add the wrong alert rule, select the alert rule, then click Delete. This disassociates
the alert rule from the alert, but does not delete the alert rule from your system.

Disassociating an Alert Rule
You create rule associations when you set up a particular system response, such as an alert. For
instructions, see Applying an Alert Rule to an Alert. If you have applied the same rule to multiple objects
(alerts or other system responses), you might find it helpful to see a list of all objects associated with the
same rule. You can disassociate an alert rule from one or more objects that use it, as appropriate.

To disassociate an alert rule

1. Go to Civic Platform Administration > Communication Manager > Alert Rule

Civic Platform displays the Alert Rule window.

2. Click the link for the alert rule whose associations you want to view or remove.

Civic Platform displays the alert rule details and associated objects.

3. Click the Associated Objects tab.

Civic Platform displays a list of objects currently associated with the alert rule.

4. Select the object you want to delete.

5. Click Delete.

Civic Platform removes the association.

Announcements
Topics

• Creating Announcements

• Searching for an Announcement



 | Part 4: Managing Agency Communications and Events | 485

• Editing an Announcement

• Deleting an Announcement

• Managing Announcement Recipients

Creating Announcements
Privileged users can create and post announcements to notify agency users or public users of all kinds of
events. For example, you can announce a change in your agency’s policies, a new employee of the month,
or advise users of a software maintenance window.

You can configure an announcement to display in either Civic Platform, Citizen Access, or both. In
Civic Platform, the announcement displays in the Bulletin Board portlet to the recipients (see Figure
31: Accessing the Announcement in Civic Platform). In Citizen Access, when the recipients click the
Announcement link on the top of the home page, a window displays under the link with the announcement
(see Figure 32: Accessing the Announcement in Citizen Access).

Note:

For the Announcement link to display in the Citizen Access home page, you must configure the
announcement settings in Citizen Access Admin. For more information, see "Announcement Settings" in the
Citizen Access Administrator Guide.

Figure 31: Accessing the Announcement in Civic Platform

Figure 32: Accessing the Announcement in Citizen Access

To create an announcement

1. Go to Civic Platform Administration > Communication Manager > Announcement.

2. Click New.

Civic Platform displays a blank form.
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3. Complete any fields that display.

For a list of field descriptions, see Table 102: Field Reference for Announcement Details.

4. Click Submit to save the announcement.

Civic Platform displays a confirmation and enables the Recipient tab.

5. Click the Recipient tab and specify the audience for your announcement. For instructions, see
Managing Announcement Recipients.

Table 102: Field Reference for Announcement Details

Message Title Enter a title.

Message Type Choose a message type.

Content Enter the text (content) of the announcement. You can enter variables in this field.

Display Message In Choose where you want to display the announcement: Citizen Access OnlyOnly
public users in Citizen Access can see the announcement.Civic Platform onlyOnly
agency users in Civic Platform can see the announcement. BothExpose the
announcement to both public users in Citizen Access and agency users in Civic
Platform. Note: You can continue to specify who can access the announcement. For
complete details, see Managing Announcement Recipients.

Date (Start) Click the calendar icon to select the date when the announcement should first appear.
You can continue to specify the time in the Time (Start) field that the announcement
begins to appear.

Time (Start) Specify the time that the announcement begins to appear.

Date (End) Click the calendar icon to select the last date that the announcement should appear.
You can use the Time (End) to continue to specify the time that the announcement
should begin to disappear. After the specified time, the announcement no longer
displays in the Bulletin Board portlet.

Time (End) Specify the time that the announcement begins to disappear.

Status Choose “Enable” to make the announcement available for distribution. Otherwise,
choose “Disable.”
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Searching for an Announcement
You can search for an announcement and edit it.

To search for an announcement

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Choose Communication Manager > Announcement.

3. Click Search.

Civic Platform displays the search form.

4. Complete any fields that display.

For a list of field descriptions, see Table 102: Field Reference for Announcement Details.

5. Click Submit.

Civic Platform returns a list of announcements that match your search criteria.

Editing an Announcement
This section describes how you can modify an existing announcement.

To edit an announcement

1. Access the Setup portlet (Navigating to the Setup Portlet).

2. Choose Communication Manager > Announcement.

3. Click the link to the announcement you want to edit.

If you need to search for the announcement, click Search.

Civic Platform displays the announcement details.

4. Update any of the fields that display.

For a list of field descriptions, see Table 102: Field Reference for Announcement Details.

5. Click Submit to save the announcement.

Civic Platform displays a confirmation and updates the announcement list.
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6. Change the announcement recipients, as appropriate.

For instructions, see Managing Announcement Recipients.

Deleting an Announcement
When an announcement becomes outdated, you can delete it from your system.

To delete an announcement

1. Go to Civic Platform Administration > Communication Manager > Announcement.

2. Select the announcement you want to delete.

3. Click Delete.

Civic Platform displays a confirmation and updates the announcements list.

Managing Announcement Recipients
After creating an announcement and choosing which users you want to expose the announcement to,
you must determine who should receive the announcement in the Recipient tab of the Announcement
portlet. If you want to post the announcement to your agency users, you can select entire agency or
select certain department, user group, or even individual users within your agency. If you want to post the
announcement to public users, you can select one or more agencies, or select certain public user groups
including anonymous users, registered users, licensed professionals, authorized agents, and authorized
agent clerks.

If a group or individual in your organizational structure or Citizen Access no longer needs to receive an
announcement, you can remove the group or individual from the list of recipients. Removing a recipient
from this list does not delete the recipient from your system.

For more information on managing announcement recipients, see Setting Up Security Policies.

Notification Templates
Topics

• Working with Notification Templates

• Embedding Links to Record Detail Page

• Searching for Notification Template

• Editing a Notification Template

• Deleting a Notification Template

Working with Notification Templates
Notification templates are emails, text messages, meeting requests, and Citizen Access announcements,
that Civic Platform sends to public users upon a triggering event or action.

Accela provides stock, pre-defined system-level templates, available out of the box with Civic Platform.
Administrators can create new notification templates, and can customize:

• The content of the message

• Which notification type (email or text message) Civic Platform sends when an action occurs that triggers
communication
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• Delayed sending options

You can add parameters to the subject and body of the message. You must declare and assign parameter
values in the EMSE scripts. When the specified event or a batch job occurs, the email notification
generates and the parameters populate with the matching value passed from the scripts. Parameters
are not case-sensitive, but you must enclose them in a pair of double-dollar signs “$$” for example, $
$ExaminationID$$. Refer to Embedding Links to Record Detail Page for more details.

Viewing the Notification Template List
The notification template list includes custom notification templates, created by administrators for
Civic Platform and Citizen Access. The notification template list also includes pre-defined system-level
templates, available out of the box, which administrators can customize to suit the agency’s business
objectives.

To view the notification template list

1. Go to Civic Platform Administration > Communication Manager > Notification Templates.

Civic Platform displays the Notification Templates window.

System-level Notification Templates
The following is a complete list of system-level Notification Templates available in communication
manager. This includes both Civic Platform Notification Templates and Citizen Access Email Notifications,
formerly accessible in Citizen Access Admin > Email Settings.

Table 103: System-level Notification Templates

AA_MESSAGE_INSPECTION_STATUS_CHANGE

AA_MESSAGE_THRESHOLD_NOTIFICATION

ACA_ACTIVATION_MESSAGE

ACA_AGENCY_ACTIVATION_MESSAGE

ACA_MESSAGE_ACCOUNT_VERIFICATION_BY_HYPERLINK

ACA_MESSAGE_ADD_NEW_LICENSE_NOTICE_AGENCY

ACA_MESSAGE_ADD_NEW_LICENSE_NOTICE_CITIZEN

ACA_MESSAGE_ASSOCIATING_LICENSE_TO_MULTIPLE_ACCOUNTS

ACA_MESSAGE_ETISALAT_PAYMENT_COMPLETION_FAILED

ACA_MESSAGE_ETISALAT_PAYMENT_COMPLETION_SUCCEEDED
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ACA_MESSAGE_ETISALAT_PAYMENT_RECONCILIATION_RESULT

ACA_MESSAGE_ETISALAT_PAYMENT_RECONCILIATION_UPLOAD

ACA_MESSAGE_ETISALAT_PAYMENT_REGISTRATION_SUCCEEDED

ACA_MESSAGE_INSPECTION_STATUS_CHANGE

ACA_MESSAGE_RENEW_LICENSE_AUTO_ISSUANCE

ACA_MESSAGE_RENEW_LICENSE_NEW_APPLICATION_NOTICE_AGENCY

ACA_MESSAGE_RENEW_LICENSE_NO_AUTO_ISSUANCE_APPROVED

ACA_MESSAGE_RENEW_LICENSE_NO_AUTO_ISSUANCE_DENIED

ACA_MESSAGE_RENEW_LICENSE_NO_AUTO_ISSUANCE_PENDING

ACA_MESSAGE_SCORES_UPDATE_NOTICE_AGENCY

ACA_MESSAGE_SCORES_UPDATE_NOTICE_PROVIDER

ACA_MESSAGE_SENDPASSWORD

ACA_INACTIVATION_MESSAGE

ACTIVATION_MESSAGE

MESSAGE_ACA_CONNECT_LICENSE_APPROVE_OWNER

MESSAGE_ACA_CONNECT_LICENSE_APPROVE_USER

MESSAGE_ACA_CONNECT_LICENSE_CONNECT_OWNER

MESSAGE_ACA_CONNECT_LICENSE_CONNECT_USER

MESSAGE_ACA_CONNECT_LICENSE_DISCONNECT_OWNER

MESSAGE_ACA_CONNECT_LICENSE_DISCONNECT_USER

MESSAGE_ACA_CONNECT_LICENSE_REJECT_OWNER

MESSAGE_ACA_CONNECT_LICENSE_REJECT_USER

MESSAGE_ACA_TRADE_NAME_APPROVED

MESSAGE_AUTOMATED_PLANREVIEW

MESSAGE_NOTICE_BUILDING

MESSAGE_NOTICE_ENFORCEMENT

MESSAGE_NOTICE_FIRE

MESSAGE_NOTICE_PLANNING

MESSAGE_NOTICE_PUBLIC WORKS

MESSAGE_NOTICE_LICENSE_EXPIRED

MESSAGE_NOTICE_RESULT_INSPECTION

MESSAGE_PAYMENT_NOTICE_BUILDING

MESSAGE_PAYMENT_NOTICE_LICENSES

MESSAGE_PAYMENT_NOTICE_PERMITS

MESSAGE_PAYMENT_RECEIPT_BUILDING

MESSAGE_PAYMENT_RECEIPT_LICENSES

MESSAGE_PAYMENT_RECEIPT_PERMITS

MESSAGE_RECEIPT_BUILDING

MESSAGE_RECEIPT_ENFORCEMENT
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MESSAGE_RECEIPT_FIRE

MESSAGE_RECEIPT_PLANNING

MESSAGE_RECEIPT_PUBLIC WORKS

MESSAGE_REPORT

MESSAGE_SEND_PASSWORD

ACA_MESSAGE_ACCOUNT_LOCKED_NOTICE_CITIZEN

ACA_MESSAGE_ACA_PROXYUSER_ADD

MESSAGE_NOTICE_MEETING_REMINDER

Creating Notification Templates
Use the procedure below to create templates for outgoing emails, meeting requests, SMS text messages,
and Citizen Access notification emails.

To create notification templates

1. Go to Civic Platform Administration > Communication Manager > Notification Templates.

Civic Platform displays the Notification Templates window.

2. Click New.

3. Click the General Details tab.

Civic Platform displays the General Details window.

4. Complete these fields:

Table 104: Communication Manager, Notification Template, General Details Tab

Template Name Enter a name for the template.

Description Enter a description of the template’s purpose.

Delay Time and Delay
Unit

Enter the number of minutes, hours, or days you want to delay sending the message
and choose a time interval (minutes, hours, or days) in the Delay Unit field.

For example, if you want to send inspection results after 14 days, enter a delay time
of 14, and then specify “days” as the delay unit in the next field.

5. If the notification is for email distribution, click the Email Content tab. If the notification is for text
message distribution, proceed to .
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Civic Platform displays the Email Content window.

6. Complete these fields:

Table 105: Communication Manager, Notification Template, Email Content Tab

From Choose a “from” value indicating who the email is from. This name displays to the
message recipient. Administrators configure the values that display here when setting
up the email account; see Configuring Account Settings.

To, Cc, and Bcc Enter specific email addresses or enter EMSE parameters such as $$contacts$$ or $
$recordcontactemail$$. You must define these values in the EMSE scripts that initiate
the communication.

In the Cc and Bcc fields, you can enter an agency email address, which is useful for
saving all communications sent to or from a particular department-wide email alias
that you set up to retrieve all emails from the server.

Another use case is to configure a script that attaches all emails sent to a Cc or Bcc to
records in Civic Platform.

Title Enter an email subject or enter an EMSE parameter. To use parameters you must
define the values in the EMSE scripts that initiate the communication. For complete
details about working with EMSE, refer to the Accela Civic Platform Scripting Guide.

Importance Select an importance: low, normal, or high. Normal is the default.

Content Enter the content of the message. In addition to standard message text, you can:

-- Include variables in the message body. Refer toVariables for a full list.
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-- Use HTML code to format the content.

-- Add parameters and embed a hyperlink to the Record Detail page in the message
body. You must define the parameters and URL in EMSE scripts.

For information on how to define parameter and embed a hyperlink, see Embedding
Links to Record Detail Page.

Display in ACA Only templates related to examinations and EDR (Electronic Document Recognition)
have the Display in ACA field. Select this option to display the notification as
an announcement in Citizen Access. For complete details on how to set up
Announcements, refer to the Citizen Access Administrator Guide, “Global Settings
Configuration” section.

Display as Alert Select this option to display an alert informing agency users that they successfully
configured the communication.

Save as Attachment Select this option to enable the attachments settings that define whether and how
Civic Platform attaches notifications to records or email recipients.

Attach To This setting is only available for system-level templates, and becomes available when
you select the Save as Attachment option.

Select Record in the drop-down list to save the email notification as an attachment to
associated records.

Select Recipient in the drop-down list, Civic Platform saves a notification as an
attachment to the recipients of the notification under the following conditions:

(1) The event that triggers when Civic Platform sends the notification contains script
that calls the EMSE method attachEmailToEntity to attach the email to specific
recipient(s);

(2) The recipient email address specified in the email content is identical with one of
the record-associated contacts or licensed professionals.

Document Group/
Category

This setting is only available for system-level templates, and becomes available
when you select the Save as Attachment option. Categorize the attachment by first
selecting a value from the Document Group drop-down list, then a value from the
Document Category drop-down list. It is important to select the Document Group first,
because the Document Category drop-down list can be different based on which
document group you choose.

EDMS Name This setting is only available for system-level templates, and becomes available
when you select the Save as Attachment option. Select the Electronic Document
Management System (EDMS) you want to save the notification to.

7. Click Save.

8. If the message is for text message distribution, click the SMS Content tab.

Civic Platform displays the SMS Content window.
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9. Complete these fields:

Table 106: Communication Manager, Notification Template, SMS Content Tab

From Choose a “from” value indicating who the text message is from. This name displays
to the message recipient. Administrators configure the values that display here when
setting up the email account; see Configuring Account Settings.

To Enter cellular phone number(s). You can also enter parameters such as $$contacts$
$. You must define these values in the EMSE scripts that initiate the communication.

Content Enter the content of the text message. This should be a very brief message and can
include agency-defined variables, such as record ID, workflow task name and due
date, and scheduled inspection time, for example.

10.Click Save.

Embedding Links to Record Detail Page
You can embed a hyperlink to the Record Detail page in notification templates. Embedding links enables
public users to instantly access the Record Detail page by clicking the hyperlink from the notification. If you
restrict record detail page access to registered users, the Login screen displays before the record detail
page.

To embed a hyperlink in a notification template to link to the Record Detail page there are four steps:

• Creating an EMSE script

• Defining a parameter to assign to returned URL

• Entering parameter to the template body

• Mapping the parameter to Record Detail page

For complete details about working with scripts, refer to the Accela Civic Platform Scripting Guide.

Creating an EMSE script
Step 1: Create an EMSE script, in which you create a function to get the Record Detail page URL

The URL returned by the function must be in the pattern as shown below:
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http://$$ACAWebSite$$/urlrouting.ashx?type=1000&Module=$$Module$$&capID1=$$CapID1$$&capID2=
$$CapID2$$&capID3=$$CapID3$$&agencyCode=$$AgencyCode$$

$$ACAWebSite$$ Citizen Access website domain.

$$Module$$ Module to which you associated the records.

$$CapID1$$, $$CapID2$$, $
$CapID3$$

Record ID fields together with the $$Module$$ and $$AgencyCode$$ to identify a
unique record in your agency.

$$AgencyCode$$ Agency code.

The following code snippet is an example of a function returning the URL of the Record Detail page.

function getACAUrl()

{

    var acaUrl = “”;

    var id1 = Accela Automation.env.getValue(“PermitId1”);

  var id2 = Accela Automation.env.getValue(“PermitId2”);

  var id3 = Accela Automation.env.getValue(“PermitId3”);

  var capResult = Accela Automation.cap.getCap(id1, id2, id3);

  if(!capResult.getSuccess())

  {

      return acaUrl;

  }

  var cap = capResult.getOutput().getCapModel();

    acaUrl = acaWebServiceSite + “/urlrouting.ashx?type=1000”; 

    acaUrl += “&Module=” + cap.getModuleName();

    acaUrl += “&capID1=” + id1 + “&capID2=” + id2 + “&capID3=” + id3;

    acaUrl += “&agencyCode=” + Accela Automation.getServiceProviderCode();

    return acaUrl;

}

Defining a parameter to assign to returned URL
Step 2: In the EMSE script, define a parameter to assign to the returned URL.

The sample code below defines a parameter called $$Url$$. Civic Platform assigns the returned URL by
function getACAUrl().
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function getParamsForSchedule()

{

     …

 //Define the parameter 

$$Url$$

 to assign to the Record Detail page URL.

addParameter(params, “$$Url$$”, getACAUrl());

…

    return params;

}

Entering parameter to the template body
Step 3: Enter text or parameter to the template body that you want to map to the Record Detail page
URL.

You can map the URL either to the text or to the parameter in the template body. For each parameter that
you add to the template body or its subject, you must assign and define its value in the EMSE scripts. For
the sample code of defining parameters, see Defining a parameter to assign to returned URL

1. Access the Notification Template portlet (Navigating to the Setup Portlet).

2. Open an existing notification template, or create a new one.

To learn how to create a notification template, see Creating Notification Templates.

3. In the Message Body field, do one of the following:

• Enter the text you want to map to the URL of the Record Detail page. For example, Click Here.

• Enter a parameter you want to map to the URL. For example, $$AlternateID$$.
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Mapping the parameter to Record Detail page
Step 4: Map the text or parameter to the Record Detail page URL.

1. Access the template body.

To learn how to access a notification template, see Entering parameter to the template body

2. Highlight the text or the parameter in the Message Body field.

3. Click the hyperlink icon.

Civic Platform displays the Hyperlink window.

4. In the Hyperlink window, select “https” from the Type drop-down list.

5. In the URL field enter the parameter you want to assign to the returned URL in the EMSE scripts ($$Url
$$, from the sample code snippet in Defining a parameter to assign to returned URL).

6. Click Save if you are editing an existing template; click Submit if you are creating a new template.

Searching for Notification Template
To search for a notification template

1. Go to Civic Platform Administration > Communication Manager > Notification Templates.

Civic Platform displays the Notification Templates window.

2. Click Search.

Civic Platform displays the Notification Template Search form.

3. Complete any fields that display.

4. Click Submit.

Civic Platform returns a list of notification templates that match your search criteria.

Editing a Notification Template
To edit a notification template

1. Go to Civic Platform Administration > Communication Manager > Notification Templates.

Civic Platform displays the Notification Templates window.
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2. Click the template name that you want to edit.

If you need to search for the message, Click Search on the top of the list.

Civic Platform displays the template detail portlet.

3. Update any of the fields that display as necessary.

For descriptions of the fields, see Creating Notification Templates.

4. Click Submit.

Deleting a Notification Template
When a notification template becomes outdated, you can delete it from your system. If a batch job uses
the deleted notification template, you cannot delete the template. You also cannot delete system templates
that come standard with the Accela solutions.

To delete a notification template

1. Go to Civic Platform Administration > Communication Manager > Notification Templates.

Civic Platform displays the Notification Templates window.

2. Select the unwanted templates.

3. Click Delete.

Civic Platform warns you that the template might be in use.

4. Click OK if you are sure you want to delete the template.

Variables
The following table lists the variables you can use when you compose system-generated emails, SMS text
messages, and notification templates.

Table 107: Communication Variables

Notification Template or Product Area Variable Description

AA_MESSAGE_INSPECTION_
STATUS_CHANGE

$$InspectorFullName$$ Inspector full name

$$CustomId$$ Customer ID

$$PermitId1$$ Permit ID1

$$PermitId2$$ Permit ID2

$$PermitId3$$ Permit ID3

$$InspectionType$$ Inspection type

$$InspectionStatus$$ Inspection status

$$InspectionDate$$ Inspection date

$$InspectionTime$$ Inspection time

$$InspectionAddress$$ Inspection address

$$RequestedComments$$ Requested comments

$$InspectionEndTime$$ Inspection end time

AA_MESSAGE_THRESHOLD_
NOTIFICATION

$$CapID$$ Record ID

$$AltID$$ Alt ID

$$AccountID$$ Trust account ID
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Notification Template or Product Area Variable Description

$$ThresholdAmount$$ Threshold amount

$$Balance$$ Balance

$$Description$$ Trust account description

$$LegerAccount$$ Leger account

ACA_ACTIVATION_MESSAGE $$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$password$$ Public user's password

$$email$$ Public user’s email address

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_AGENCY_ACTIVATION_
MESSAGE

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$password$$ Public user's password

$$email$$ Public user’s email address

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner

ACA_INACTIVATION_MESSAGE $$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
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Notification Template or Product Area Variable Description

$$state$$

$$city$$

$$address$$

$$zip$$

gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_ACA_
PROXYUSER_ADD

$$InputName$$ Proxy user's nickname

$$InviterName$$ Public user name

$$PersonalNote$$ Proxy user's invitation
message

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_ACCOUNT_
LOCKED_NOTICE_CITIZEN

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$password$$ Public user's password

$$email$$ Public user’s email address

$$UUID$$ UUID (configure in the
hyperlink within the account
activation email).

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_ACCOUNT_
VERIFICATION_BY_HYPERLINK

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$password$$ Public user's password

$$email$$ Public user’s email address
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Notification Template or Product Area Variable Description

$$UUID$$ UUID (configure in the
hyperlink within the account
activation email).

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_ADD_NEW_
LICENSE_NOTICE_AGENCY

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$LicenseNumber$$ License number

$$LicenseType$$ License type

$$mmddyy$$ Current date

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_ADD_NEW_
LICENSE_NOTICE_CITIZEN

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$LicenseNumber$$ License number

$$LicenseType$$ License type

$$mmddyy$$ Current date

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
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Notification Template or Product Area Variable Description

$$city$$

$$address$$

$$zip$$

the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_ASSOCIATING_LICENSE_TO_MULTIPLE_
ACCOUNTS

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$LicenseNumber$$ License number

$$LicenseType$$ License type

$$mmddyy$$ Current date

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_INSPECTION_
STATUS_CHANGE

$$InspectorFullName$$ Inspector full name

$$CustomId$$ Customer ID

$$PermitId1$$ Permit ID1

$$PermitId2$$ Permit ID2

$$PermitId3$$ Permit ID3

$$InspectionType$$ Inspection type

$$InspectionStatus$$ Inspection status

$$InspectionDate$$ Inspection date

$$InspectionTime$$ Inspection time

$$InspectionAddress$$ Inspection address

$$RequestedComments$$ Requested comments

ACA_MESSAGE_RENEW_
LICENSE_AUTO_ISSUANCE

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$capID$$ Record ID

$$capType$$ Record type alias

$$mmddyy$$ License expiration date
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Notification Template or Product Area Variable Description

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_RENEW_
LICENSE_NEW_APPLICATION_
NOTICE_AGENCY

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$capID$$ Record ID

$$capType$$ Record type alias

$$mmddyy$$ License expiration date

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_RENEW_
LICENSE_NO_AUTO_ISSUANCE_
APPROVED

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$capID$$ Record ID

$$capType$$ Record type alias

$$mmddyy$$ License expiration date

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
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Notification Template or Product Area Variable Description

$$address$$

$$zip$$

information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_RENEW_
LICENSE_NO_AUTO_
ISSUANCE_DENIED

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$capID$$ Record ID

$$capType$$ Record type alias

$$mmddyy$$ License expiration date

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_RENEW_
LICENSE_NO_AUTO_
ISSUANCE_PENDING

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$email$$ Public user’s email address

$$capID$$ Record ID

$$capType$$ Record type alias

$$mmddyy$$ License expiration date

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

ACA_MESSAGE_SCORES_
UPDATE_NOTICE_AGENCY

$$servProvCode$$ [Case sensitive] Agency ID;
Service Provider Code

$$ProviderName$$ [Case sensitive] Provider
name
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Notification Template or Product Area Variable Description

$$ProviderNumber$$ [Case sensitive] Provider
number

ACA_MESSAGE_SCORES_
UPDATE_NOTICE_PROVIDER

$$servProvCode$$ [Case sensitive] Agency ID;
Service Provider Code

$$ProviderName$$ [Case sensitive] Provider
name

$$ProviderNumber$$ [Case sensitive] Provider
number

ACA_MESSAGE_ SENDPASSWORD $$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user’s display name

$$password$$ Public user’s password

$$email$$ Public user’s email address

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

EMAIL_NOTICE_MEETING_ REMINDER $$Meeting.Type$$ Meeting type

$$Meeting.RespDept$$ Meeting responsible person’s
department

$$Meeting.RespName$$ Meeting responsible person
name

$$Meeting.Date$$ Meeting date

$$Meeting.Location$$ Meeting location

$$Meeting.StartTime$$ Meeting start time

$$Meeting.EndTime$$ Meeting end time

$$Meeting.IsAllDayEvent$$ All day event

$$Meeting.Subject$$ Meeting subject

$$Meeting.Attendee$$ Meeting attendee

$$Meeting.Body$$ Meeting body

$$Meeting.Comment$$ Meeting comment

$$Meeting.MaxItem$$ Maximum agenda items

$$Meeting.Agenda$$ Meeting agenda ID

$$Meeting.Duration$$ Meeting duration

$$Meeting.NoticeDate$$ Meeting notice date

$$Meeting.Status$$ Meeting status

Hearing Email Notification, defined in
Classic Administration > Workflow >
Messages

$PRIMARYAPPLICANT$ Primary applicant
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Notification Template or Product Area Variable Description

$AGENCY-DEPARTMENT$ Agency department

$HEARING_BODY$ Hearing body

$CALENDARDATEORIG$ Original calendar date

$LOCATIONORIG$ Original location

$STARTTIMEORIG$ Original start time

$CALENDARDATENEW$ New calendar date

$LOCATIONNEW$ New location

$STARTTIMENEW$ New start time

$FIRSTNAME$ Agency’s first name

$LASTNAME$ Agency’s last name

$USERTITLE$ User name

Inspection Email Notification, defined
in Classic Administration > Workflow >
Messages

$$CAPID$$ / $PERMITID$ Record or permit ID

$$CAPDETAIL$$ / $PERMITDETAIL$ Record or permit detail

$$CAPAPPTYPE$$ / $PERMITAPPTYP
$

Record or permit type

$$CAPNAME$$ / $PERMITNAME$ Record or permit name

$$CAPSTATUS$$ / $PERMITSTATUS$ Record or permit status value

$$CAPADDR$$ / $PERMITADDR$ Record or permit address

$$CAPPARCEL$$ / $PERMITPARCEL$ Record or permit parcel

$$CAPWRKDESC$$ /
$PERMITWRKDESC$

Record or permit work
description

$$INSPITEM$$ / $INSPITEM$ Inspection item

$$INSPRESULT$$ / $INSPRESULT$ Inspection result

$$INSPCOMMENT$$ /
$INSPCOMMENT$

Inspection comment

MEETING_NEW $$Meeting.Type$$ Meeting type

$$Meeting.RespDept$$ Meeting responsible person
department

$$Meeting.RespName$$ Meeting responsible person
name

$$Meeting.Date$$ Meeting date

$$Meeting.Location$$ Meeting location

$$Meeting.StartTime$$ Meeting start time

$$Meeting.EndTime$$ Meeting end time

$$Meeting.IsAllDayEvent$$ All day event

$$Meeting.Subject$$ Meeting subject

$$Meeting.Attendee$$ Meeting attendee

$$Meeting.Body$$ Meeting body

$$Meeting.Comment$$ Meeting comment

$$Meeting.MaxItem$$ Maximum agenda items

$$Meeting.Agenda$$ Meeting agenda ID

$$Meeting.Duration$$ Meeting duration
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Notification Template or Product Area Variable Description

$$Meeting.NoticeDate$$ Meeting notice date

$$Meeting.Status$$ Meeting status

MEETING_REJECT $$Meeting.Type$$ Meeting type

$$Meeting.RespDept$$ Meeting responsible person’s
department

$$Meeting.RespName$$ Meeting responsible person
name

$$Meeting.Date$$ Meeting date

$$Meeting.Location$$ Meeting location

$$Meeting.StartTime$$ Meeting start time

$$Meeting.EndTime$$ Meeting end time

$$Meeting.IsAllDayEvent$$ All day event

$$Meeting.Subject$$ Meeting subject

$$Meeting.Attendee$$ Meeting attendee

$$Meeting.Body$$ Meeting body

$$Meeting.Comment$$ Meeting comment

$$Meeting.MaxItem$$ Maximum agenda items

$$Meeting.Agenda$$ Meeting agenda ID

$$Meeting.Duration$$ Meeting duration

$$Meeting.NoticeDate$$ Meeting notice date

$$Meeting.Status$$ Meeting status

$$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$userName$$ Public user name

$$password$$ Public user password

$$email$$ Public user email

$$InputName$$ Proxy user's nickname

$$PersonalNote$$ Proxy user's invitation
message

$$InviterName$$ Public user name

$$userID$$ Public user ID

$$email$$ Public user's email

$$password$$ Public user's password

$$activationURL$$ activation URL

MEETING_UPDATE $$Meeting.Type$$ Meeting type

$$Meeting.RespDept$$ Meeting responsible person’s
department

$$Meeting.RespName$$ Meeting responsible person
name

$$Meeting.Date$$ Meeting date

$$Meeting.Location$$ Meeting location

$$Meeting.StartTime$$ Meeting start time
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Notification Template or Product Area Variable Description

$$Meeting.EndTime$$ Meeting end time

$$Meeting.IsAllDayEvent$$ All day event

$$Meeting.Subject$$ Meeting subject

$$Meeting.Attendee$$ Meeting attendee

$$Meeting.Body$$ Meeting body

$$Meeting.Comment$$ Meeting comment

$$Meeting.MaxItem$$ Maximum agenda items

$$Meeting.Agenda$$ Meeting agenda ID

$$Meeting.Duration$$ Meeting duration

$$Meeting.NoticeDate$$ Meeting notice date

$$Meeting.Status$$ Meeting status

$$ORIG_Meeting.Type$$ Original meeting type

$$ORIG_Meeting.RespDept$$ Original meeting responsible
person’s department

$$ORIG_Meeting.RespName$$ Original meeting responsible
person’s name

$$ORIG_Meeting.Date$$ Original meeting date

$$ORIG_Meeting.Location$$ Original meeting location

$$ORIG_Meeting.StartTime$$ Original meeting start time

$$ORIG_Meeting.EndTime$$ Original meeting end time

$$ORIG_Meeting.IsAllDayEvent$$ Original meeting all day event

$$ORIG_Meeting.Subject$$ Original meeting subject

$$ORIG_Meeting.Body$$ Original meeting body

$$ORIG_Meeting.Comment$$ Original meeting comment

$$ORIG_Meeting.MaxItem$$ Original maximum agenda
Items

$$ORIG_Meeting.Agenda$$ Original meeting agenda ID

$$ORIG_Meeting.Duration$$ Original meeting duration

$$ORIG_Meeting.NoticeDate$$ Original meeting notice date

$$ORIG_Meeting.Status$$ Original meeting status

MESSAGE_ACA_CONNECT_
LICENSE_APPROVE_OWNER

$$publicUserID$$ Public user ID

$$publicUserName$$ Public user Name

$$licenseNumber$$ License number

$$actionType$$ Action type, for example:
approved, rejected,
connected, disconnected.

$$actionDate$$ Action date

$$userId$$ User ID

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
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Notification Template or Product Area Variable Description

$$state$$

$$city$$

$$address$$

$$zip$$

user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_ACA_CONNECT_
LICENSE_APPROVE_USER

$$publicUserID$$ Public user ID

$$publicUserName$$ Public user name

$$licenseNumber$$ License Number

$$actionType$$ Action type, for example:
approved, rejected,
connected, disconnected.

$$actionDate$$ Action date

$$userId$$ User name

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_ACA_CONNECT_
LICENSE_CONNECT_OWNER

$$publicUserID$$ Public user ID

$$publicUserName$$ Public user name

$$licenseNumber$$ License number

$$actionType$$ Action type, for example:
approved, rejected,
connected, disconnected.

$$actionDate$$ Action date

$$userId$$ User ID

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_ACA_CONNECT_
LICENSE_CONNECT_USER

$$publicUserID$$ Public user ID

$$publicUserName$$ Public user name

$$licenseNumber$$ License number
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Notification Template or Product Area Variable Description

$$actionType$$ Action type, for example:
approved, rejected,
connected, disconnected.

$$actionDate$$ Action date

$$userId$$ User ID

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_ACA_CONNECT_
LICENSE_DISCONNECT_OWNER

$$publicUserID$$ Public user ID

$$publicUserName$$ Public user name

$$licenseNumber$$ License number

$$actionType$$ Action type, for example:
approved, rejected,
connected, disconnected.

$$actionDate$$ Action date

$$userId$$ User ID

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_ACA_CONNECT_
LICENSE_DISCONNECT_USER

$$publicUserID$$ Public user ID

$$publicUserName$$ Public user name

$$licenseNumber$$ License number

$$actionType$$ Action type, for example:
approved, rejected,
connected, disconnected.

$$actionDate$$ Action date

$$userId$$ User ID

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
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Notification Template or Product Area Variable Description

$$state$$

$$city$$

$$address$$

$$zip$$

user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_ACA_CONNECT_
LICENSE_REJECT_OWNER

$$publicUserID$$ Public user ID

$$publicUserName$$ Public user name

$$licenseNumber$$ License number

$$actionType$$ Action type, for example:
approved, rejected,
connected, disconnected.

$$actionDate$$ Action date

$$userId$$ User ID

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_ACA_CONNECT_
LICENSE_REJECT_USER

$$publicUserID$$ Public user ID

$$publicUserName$$ Public user name

$$licenseNumber$$ License number

$$actionType$$ Action type, for example:
approved, rejected,
connected, disconnected.

$$actionDate$$ Action date

$$userId$$ User ID

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_AUTOMATED_
PLANREVIEW

$$planList$$ Plan list

MESSAGE_NOTICE_LICENSE_
EXPIRED

$LICENSETYPE$ [Case sensitive] License type
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Notification Template or Product Area Variable Description

$STATELICENSENO$ [Case sensitive] State license
number

$LICENSESTATE$ [Case sensitive] License state

$LICENSELASTRENEWALDATE$ [Case sensitive] License last
renewal date

$LICENSEEXPIRATIONDATE$ [Case sensitive] License
expiration date

$FIRSTNAME$ [Case sensitive] First name

$MIDDLENAME$ [Case sensitive] Middle name

$LASTNAME$ [Case sensitive] Last name

$INSURANCECOMPANY$ [Case sensitive] Insurance
company

$POLICYNUMBER$ [Case sensitive] Policy
number

$INSURANCEEXPIRATIONDATE$ [Case sensitive] Insurance
expiration date

$BUSINESSLICENSENO$ [Case sensitive] Business
license #

$BUSINESSLICENSEEXPDATE$ [Case sensitive] business
License expiration date

MESSAGE_NOTICE_RESULT_
INSPECTION

$$CAPID$$ / $PERMITID$$ Record or permit ID

$$CAPDETAIL$$ / $PERMITDETAIL$$ Record or permit detail

$$CAPAPPTYPE$$ / $PERMITAPPTYP
$$

Record or permit type

$$CAPNAME$$ / $PERMITNAME$$ Record or permit name

$$CAPSTATUS$$ / $PERMITSTATUS$
$

Record or permit status value

$$CAPADDR$$ / $PERMITADDR$$ Record or permit address

$$CAPPARCEL$$ / $PERMITPARCEL
$$

Record or permit parcel

$$CAPWRKDESC$$ /
$PERMITWRKDESC$$

Record or permit work
description

$$INSPITEM$$ / $INSPITEM$$ Inspection item

$$INSPRESULT$$ / $INSPRESULT$$ Inspection result

$$INSPCOMMENT$$ /
$INSPCOMMENT$$

Inspection comment

$$COMPLETEDATE$$ Inspection time

$$checklistITEM$$ Major violation checklist item

MESSAGE_PAYMENT_NOTICE_
<Module>

$$servProvCode$$ Agency ID; Service Provider
Code

$$capID$$ Record ID

$$balance$$ Balance due

$$accelaFee$$ Amount of fee

$$totalFee$$ Total of all fees

$$altID$$ Alt record ID
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Notification Template or Product Area Variable Description

$$userName$$ User’s display name

MESSAGE_REPORT $$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$email$$ Public user's email

$$CAPID$$ Record ID

$PERMITID$ Record ID

$$CAPDETAIL$$ Record detail

$PERMITDETAIL$ Record detail

$$CAPAPPTYPE$$ Record type

$PERMITAPPTYP$ Record type

$$CAPNAME$$ Application name

$PERMITNAME$ Application name

$$CAPSTATUS$$ Record status

$PERMITSTATUS$ Record status

$$CAPADDR$$ Record address

$PERMITADDR$ Record address

$$CAPPARCEL$$ Record parcel

$PERMITPARCEL$ Record parcel

$$CAPWRKDESC$$ Record work description

$PERMITWRKDESC$ Record work description

$$INSPITEM$$ Inspection item

$INSPITEM$ Inspection item

$$INSPRESULT$$ Inspection result

$INSPRESULT$ Inspection result

$$INSPCOMMENT$$ Inspection comment

$INSPCOMMENT$ Inspection comment

$$firstName$$

$$middleName$$

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

First name (middle name,
last name, business name/
organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

MESSAGE_SEND_PASSWORD $$userID$$ Public user ID

$$servProvCode$$ Agency ID; Service Provider
Code

$$email$$ Public user's email

$$password$$ Public user's password

$$firstName$$

$$middleName$$

First name (middle name,
last name, business name/
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Notification Template or Product Area Variable Description

$$lastName$$

$$businessName$$

$$state$$

$$city$$

$$address$$

$$zip$$

organization name, state,
city, address, or zip) of the
public user. Civic Platform
gets the value from the public
user’s account owner or from
a contact associated with
the user account. For more
information, see Setting an
Associated Contact as the
Account Owner.

NOTICE_OF_BATCH_JOB_
COMPLETED

$$JobName$$ Batch job name

$$Result$$ Batch job result

$$EndTime$$ Batch job end time

Workflow Email Notification, defined
in Classic Administration > Workflow >
Messages

$$CAPID$$ / $PERMITID$ Record or permit ID

$$CAPDETAIL$$ / $PERMITDETAIL$ Record or permit detail

$$CAPAPPTYPE$$ / $PERMITAPPTYP
$

Record or permit type

$$CAPNAME$$ / $PERMITNAME$ Record or permit name

$$CAPSTATUS$$ / $PERMITSTATUS$ Record or permit status value

$$CAPADDR$$ / $PERMITADDR$ Record or permit address

$$CAPPARCEL$$ / $PERMITPARCEL$ Record or permit parcel

$$CAPWRKDESC$$ /
$PERMITWRKDESC$

Record or permit work
description

$$TASK$$ / $TASK$ Record or permit task info

$$TASKSTATUS$$ / $TASKSTATUS$ Record or permit task status

$$TASKCOMMENTS$$ /
$TASKCOMMENTS$

Record or permit task
comments

$$TASKACTIONBY$$ /
$TASKACTIONBY$

Record or permit task action
by

$$TASKSPECIFICINFO$$ /
$TASKSPECIFICINFO$

Record or permit task specific
info

Customizing the Content of Agency Communications
You can customize the content of the following communications:

• Email and SMS text message notifications, meeting and calendar requests, and Citizen Access email
announcements

To customize this type of communication, see Working with Notification Templates.

• Receipts and endorsements

To customize this type of communication, use the Content Customize portlet, described in this topic.

Civic Platform generates receipts or endorsements after you process a payment. Civic
Platform has default settings for all receipts and endorsements, with the exception of
TRUSTACCOUNT_RECEIPT_SUMMARY. You can use the Content Customize feature to create your own
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design for receipts and endorsements. The customized design overrides the default settings with its own
look and level of specificity.

Example Use Case

You design the set payment receipt to include the fee items paid and the remaining set balance, along
with other payment details. After you save the design, all set payment receipts generated in Civic Platform
conform to the new design.

Topics

• Adding or Updating a Customized Content

• Working in the Content Editor

Adding or Updating a Customized Content
You can customize the content for several content types. Civic Platform can only apply one design for a
content type. After you create your own design for a content type, you can either update based on the
existing design, or clear the design to return to Civic Platform's original design.

This section describes how to add or update a customized content.

To add or update a customized content

1. Access the Content Customize portlet (Navigating to the Setup Portlet).

2. Complete the fields as necessary (Working in the Content Editor).

3. Click Save.

Working in the Content Editor
Use the WYSIWYG content editor (Figure 33: Content Editor in Content Customize) to design content and
display formats.

Figure 33: Content Editor in Content Customize

Topics

• Editing Text in the Editor

• Using Variables in Customized Content

• Example Customized Content

Editing Text in the Editor
With the text toolbar in the editor, you can customize fonts and the way to organize your text.

To edit text in the editor
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1. Position your cursor where you want in the editor, and then enter the text which you want to add.

2. Highlight the text which you want to edit, and then use the text toolbar to edit text properties such as
font type, font size, font color, and text alignment.

• You can add variables to include dynamic content in the receipts or endorsement.

For the variables that you can include in the receipt and endorsement content type, refer to Using
Variables in Customized Content.

• You can add a table in the text area, and organize the payment information in a tabular way.

1. Click the Insert Table button in the toolbar.

Civic Platform displays the Insert Table dialog.

2. Enter the number of rows and columns in the text boxes, and configure the layout and spacing
settings.

3. Click OK.

Civic Platform adds the table at where the cursor was.

4. Enter the information you want to include in the table, and add variables in the table cells, as
appropriate.

5. Continue editing the remaining content.

3. For edits to the text alignment of invoices, be aware of the following:

• All fee item variable descriptions use left alignment, except “Total Invoice Amount,” “Total Payment,”
and “Balance.”

• Descriptions of the other variables (including date, operator ID, permit ID, and so forth) use left
alignment.

• All fee amounts use right alignment.

Note:

If you add a content type (RECEIPT_SUMMARY, SET_CHECK_ENDORSEMENT,
SET_RECEIPT_SUMMARY, TRANSACTION_CHECK_ENDORSEMENT,
TRANSACTION_RECEIPT_SUMMARY, TRUSTACCOUNT_CHECK_ENDORSEMENT, and
TRUSTACCOUNT_RECEIPT_SUMMARY) as a Standard Choice Value in the Standard Choice
APPLY_SYSTEM_DEFAULT_FORMAT, Civic Platform follows its own default alignment style,
instead of the alignment customized here, to generate the corresponding receipts or endorsements.

The Standard Choice APPLY_SYSTEM_DEFAULT_FORMAT only affects the alignment style of the
receipts, but not the content.

4. Click Save to save your changes.
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Using Variables in Customized Content
You can use variables in any position of the customized content. This section provides the lists of variables
that you can include in receipts and endorsement. See the following lists for details:

• Table 108: APPLICATION_ENDORSEMENT Variables

• Table 109: CHECK_ENDORSEMENT Variables

• Table 110: CHECK_RECEIPT Variables

• Table 111: CREDITCARD_RECEIPT Variables

• Table 112: RECEIPT_SUMMARY Variables

• Table 113: SET_CHECK_ENDORSEMENT and SET_RECEIPT_SUMMARY Variables

• Table 114: TRANSACTION_CHECK_ENDORSEMENT Variables

• Table 115: TRANSACTION_RECEIPT_SUMMARY Variables

• Table 116: TRUSTACCOUNT_RECEIPT_SUMMARY and
TRUSTACOUNT_CHECK_ENDORSEMENT Variables

To gain a visual understanding on how the variables affect the generated receipt or endorsement, see
Example Customized Content.

Table 108: APPLICATION_ENDORSEMENT Variables

$businessDate$ The date of payment.

$contactName$ The contact name of the payer who makes the payment.

$contactType The contact type of the contact.

$permitNBR$ The record number.

$refContactID$ The reference contact ID number.

$todayDate$ The current date.

$transNBR$ The transaction number.

Table 109: CHECK_ENDORSEMENT Variables

$adminFeeDue$ The administrator fee. This value is always 0.

$balance$ The difference between the amount of money invoiced and the
amount of money paid; the balance due.

$businessDate$ The date of payment.

$cashDrawerID$ The cashier's drawer ID number.

$changeDue$ The balance if the payment amount is more than the amount due.

$checkAmount$ The check amount.

$checkTendered$ The money received from check.

$operateID$ The cashier's user ID.

$payerContactType$ The contact type of the payer.

$payerName$ The payer name.

$payerRefContactID$ The reference contact ID of the payer.

$paymentMethodAndAmount$ The payment method and payment amount.
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Pemit Fee Due The value can be 'Permit', 'Licenses' or 'Gen/Var'.

Note:

Unlike other variables, this variable uses no “$$”
delimiters.

$permitFeeDue$ The fee due in the record.

$permitNBR$ The record number.

$receiptNbr$ The receipt number.

$refNBR$ If the payment method was a check or some other document,
such as a money order, this is the check number or number that
appears on the document.

$sessionNbr$ The cashier session sequence number.

$todayDate$ The current date.

$totalAmtPaid$ The total payment amount.

$totalInvoice$ The total invoice amount.

$totalPaid$ The total amount already paid.

$transNBR$ The transaction number.

Table 110: CHECK_RECEIPT Variables

$authorizationCode$ The check authorization code.

$batchNumber$ The batch number of the invoice.

$businessDate$ The date of payment.

$cashDrawerID$ The cashier's drawer ID number.

$checkNumber$ The check number.

$checkType$ The check type.

$convenienceFee$ A fee assessed to cover the cost of processing.

$feeDue$ The fee due.

$hostCode$ The authorization code returned from third party

$objectID$ The ID of the record or set for which a user is processing
payment.

$objectType$ The entity type (such as record) for which a user is processing
payment.

$operatorID$ The cashier's user ID.

$processingFee$ The processing fee.

$referenceID$ If the payment method was a check or some other document,
such as a money order, this is the check number or number that
appears on the document.

$totalAmount$ The total payment amount.

$transactionID$ The transaction ID.

Table 111: CREDITCARD_RECEIPT Variables

$authorizationCode$ The credit card authorization code.

$batchNumber$ The batch number of the invoice.



 | Part 4: Managing Agency Communications and Events | 519

$businessDate$ The date of payment.

$cardNumber$ The credit card number.

$cardType$ The credit card type.

$cashDrawerID$ The cashier's drawer ID number.

$convenienceFee$ A fee assessed to cover the cost of processing.

$feeDue$ The fee due.

$hostCode$ The authorization code returned from third party

$objectID$ The ID of the record or set for which a user is processing
payment.

$objectType$ The entity type for which a user is processing payment. Allowable
values are: SET, Permit, POS, Trust Account, Transaction or
Group.

$operatorID$ The cashier's user ID.

$processingFee$ The processing fee.

$referenceID$ If the payment method was a check or some other document,
such as a money order, this is the check number or number that
appears on the document.

$totalAmount$ The total payment amount.

$transactionID$ The transaction ID.

Table 112: RECEIPT_SUMMARY Variables

$adminFeeDue$ The administrator fee. This value is always 0.

$balance$ The difference between the amount of money invoiced and the
amount of money paid; the balance due.

$businessDate$ The date of payment.

$cashDrawerID$ The cashier's drawer ID number.

$changeDue$ The balance if the payment amount is more than the amount due.

$checkAmount$ The check amount.

Note:

You can replace “check” with another payment method
in the variable name, for example, $cashAmount$. The
variable stands for the amount by the payment method.

$checkTendered$ The money received from check.

$feeItems$ The fee items.

$operateID$ The cashier's user ID.

$paymentMethodAndAmount$ The payment method and payment amount.

Pemit Fee Due The value can be 'Permit', 'Licenses' or 'Gen/Var'.

Note:

Unlike other variables, this variable uses no “$$”
delimiters.

$permitNBR$ The record number.

$receiptNbr$ The receipt number.

$receivedType$ The form of payment.
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$refNBR$ If the payment method was a check or some other document,
such as a money order, this is the check number or number that
appears on the document.

$sessionNbr$ The cashier session sequence number.

$todayDate$ The current date.

$totalAmtPaid$ The total payment amount.

$totalInvoice$ The total invoice amount.

$totalPaid$ The total amount already paid.

$transNBR$ The transaction number.

Table 113: SET_CHECK_ENDORSEMENT and SET_RECEIPT_SUMMARY Variables

$adminFeeDue$ The administrator fee. This value is always 0.

$balance$ The difference between the amount of money invoiced and the
amount of money paid; the balance due.

$businessDate$ The date of payment.

$cashDrawerID$ The cashier's drawer ID number.

$changeDue$ The balance if the payment amount is more than the amount due.

$checkAmount$ The check amount.

$checkAmount$ The check amount.

Note:

You can replace “check” with another payment method
in the variable name, for example, $cashAmount$. The
variable stands for the amount by the payment method.

$checkTendered$ The money received from check.

$feeItems$ The fee items.

Note:

This variable is applicable in
SET_RECEIPT_SUMMARY, not in
SET_CHECK_ENDORSEMENT.

$operateID$ The cashier's user ID.

$paymentMethodAndAmount$ The payment method and payment amount.

$permitFeeDue$ The fee due in the record.

$receiptNbr$ The receipt number.

$receivedType$ The form of payment.

Note:

This variable is applicable in
SET_RECEIPT_SUMMARY, not in
SET_CHECK_ENDORSEMENT.

$refNBR$ If the payment method was a check or some other document,
such as a money order, this is the check number or number that
appears on the document.

$sessionNbr$ The cashier session sequence number.

$setId$ The identification number of the set for which you are processing
payment.
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$setName$ The name of the set for which you are processing payment.

$todayDate$ The current date.

$totalAmtPaid$ The total payment amount.

$totalInvoice$ The total invoice amount.

$totalPaid$ The total amount already paid towards the set invoice.

$transNBR$ The transaction number.

Table 114: TRANSACTION_CHECK_ENDORSEMENT Variables

$businessDate$ The date of payment.

$cashierDrawID$ The cashier's drawer ID number.

$forPermitNbr$ The record number for which a user is processing payment.

$forPOSTransNbr$ The POS transaction number for which a user is processing
payment.

$paymentMethodAndAmount$ The payment method and payment amount.

$receiptNbr$ The receipt number.

$sessionNbr$ The cashier session sequence number.

$todayDate$ The current date.

$totalAmtPaid$ The total payment amount.

Table 115: TRANSACTION_RECEIPT_SUMMARY Variables

$adminFeeDue$ The administrator fee. This value is always 0.

$ATMTendered$ The money received from ATM.

$balance$ The difference between the amount of money invoiced and the
amount of money paid; the balance due.

$billedTendered$ The money received from bill.

$businessDate$ The date of payment.

$cashierDrawID$ The cashier's drawer ID number.

$cashTendered$ The money received from cash.

$changeDue$ The balance if the payment amount is more than the amount due.

$checkTendered$ The money received from check.

$couponTendered$ The money received from a coupon.

$creditCardTendered$ The money received from a credit card.

$currentAmtPaid$ The current amount paid.

$debitCardTendered$ The money received from a debit card.

$feeItems$ The fee items.

$forPermitNbr$ The record number for which a user is processing payment.

$forPOSTransNbr$ The POS transaction number for which a user is processing
payment.

$internalTransferTendered$ The money received from internal transfer.

$journalEntryTendered$ The money received from journal entry.

$lockboxTendered$ The money received from a lock box.
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$miscCreditTendered$ The money received from miscellaneous credit.

$moneyOrderTendered$ The money received from money order.

$multipleTendersTendered$ The money received from multiple tenders.

$operatorID$ The cashier's user ID.

$otherTendered$ The money received from other payment methods.

$permitFeeDue$ The fee due in the record.

$receiptNbr$ The receipt number.

$receivedType$ The form of payment.

$sessionNbr$ The cashier session sequence number.

$todayDate$ The current date.

$totalAmtPaid$ The total payment amount.

$totalInvoiceAmount$ The total invoice amount.

$totalPayment$ The total amount already paid.

$trustAccountTendered$ The money received from trust account.

$unapplied$ The unapplied credit.

$waiverTendered$ The money received from waiver.

$writeOffTendered$ The money received from write off.

Table 116: TRUSTACCOUNT_RECEIPT_SUMMARY and TRUSTACOUNT_CHECK_ENDORSEMENT Variables

$accountBalance$ The balance of the trust account.

$accountNBR$ The trust account ID number for the trust account.

$amount$ The payment amount.

$businessDate$ The date of payment.

$cashDrawerID$ The cashier's drawer ID number.

$refNBR$ If the payment method was a check or some other document, such as a money
order, this is the check number or number that appears on the document.

$sessionNbr$ The cashier session sequence number.

$tenderType$ The payment type.

$todayDate$ The current date.

$transComments$ The comments added in the transaction.

$transNBR$ The transaction number.

$transType$ The transaction type.

Example Customized Content
The following code snippet is an example of the content for the RECEIPT_SUMMARY content type:

The functioning variables for RECEIPT_SUMMARY are as following:  
--------------- 
Record Receipt Summary Template  
 
Session Nbr: $sessionNbr$ 
Trans NBR: $transNBR$ 
For Permit Nbr: $permitNBR$ 
Business Date: $businessDate$ 
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Today Date: $todayDate$ 
Permit Fee Due: $permitFeeDue$ 
Admin Fee Due: $adminFeeDue$ 
Total Amt Paid: $totalAmtPaid$ 
Operate ID: $operateID$ 
 
CashDrawerID: $cashDrawerID$ 
 
Fee Items  
$feeItems$ 
 
Total Invoice Amount: $totalInvoice$ 
Total Payment: $totalPaid$ 
Balance: $balance$ 
---------------- 
$paymentMethodAndAmount$ 
Change Due: $changeDue$ 
Cash Tendered: $cashAmount$ 
Check Tendered: $checkAmount$ (Ref#$checkTendered$)  
Ref: $refNBR$ 
 
payor:$payor$ 

With the previous example, Civic Platform generates the receipt summary for a record, as illustrated in
Figure 34: Example Receipt Summary .

Figure 34: Example Receipt Summary

Setting Up Calendars
Civic Platform provides the following four calendar types:

• Inspection

• Meeting

• Agency Holiday
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• User

You can configure these calendars so that agency users can schedule meetings, inspections, and so forth.

Click a topic title below for full details.

Related Links

Configuring Calendars

Working with Calendars

Setting Up and Maintaining Calendars

Setting Up and Maintaining Supervisors

Setting Up and Maintaining Meeting Types

Scenarios

Managing Calendar Items though the Calendar Portlet

Configuring Calendars
Before you can create, access and use calendars, configure the appropriate Function Identifications (FIDs)
and Standard Choices. Refer to the Accela Civic Platform Configuration Reference. Inspection calendars
require additional setup before use.

Working with Calendars
After you configure the calendars, most calendar related operations take place in the calendar
administration portlet.

Topics

• Finding a Calendar

• Viewing Daily, Weekly, and Monthly Calendars

• Printing a Calendar

• Cloning and Copying Calendars

• Assigning Daily Units

• Scheduling Calendar Items

Finding a Calendar
You can navigate calendars by type, name, permission, or inspection type. You can also search for a
calendar by different search criteria.

You can find an existing calendar by expanding and navigating the calendar portlet search for a user
calendar to modify calendar details and scheduled user leaves.

To find calendar

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

Civic Platform displays a portlet for navigating or searching calendars.



 | Part 4: Managing Agency Communications and Events | 525

• To navigate to a calendar by type, expand the calendar categories on the left side panel until you
find the calendar.

• Click Search to find a calendar by specifying search criteria.

Civic Platform displays the Calendar search page.

a. Complete the fields and click Submit. For a complete list of Calendar search fields, see Table 124:
Calendar Search Fields.

Civic Platform displays the calendars that match your search criteria in the Calendar list portlet.

Note:

You can use search to locate inactive holiday calendars.

Viewing Daily, Weekly, and Monthly Calendars
Each calendar provides Daily, Weekly, and Monthly tabs to view different time frames of scheduled
calendar items.

To view a calendar

1. Find the calendar you want to view (Finding a Calendar).

2. Click the Daily tab.

Civic Platform displays start time, end time, the calendar type, and the name of the calendar items
scheduled for the current day.

• Click the link in the calendar item column to display the schedule details.

• Click the New button to schedule a calendar item (Assigning Daily Units).
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• Click the option to select a calendar item and delete the item or perform one Menu button
operations.

3. Click the Weekly tab.

Civic Platform displays calendar items scheduled for the current week.

• Click the link for the calendar item to display the schedule details.

• Click the left and right arrows at the top of the calendar to page through the weeks.

• Click Show all items for calendars to display all calendar items (Creating Master Calendars).

• Click the New button to schedule a calendar item (Assigning Daily Units).

• Hover over the Menu button and select one of the operations to perform on the calendar.

4. Click the Monthly tab.

Civic Platform displays calendar items scheduled for the current month.
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• Click the link for the calendar item to display the schedule details.

• Click the left and right arrows at the top of the calendar to page through the months.

• Click the New button to schedule a calendar item (Assigning Daily Units).

• Click Show all items for calendars to display all calendar items (Creating Master Calendars).

• Hover over the Menu button and select one of the operations to perform on the calendar.

Printing a Calendar
You can print calendars from the Weekly or Monthly Calendar views. Calendars print exactly as they
display. For example, if you print a calendar from the Weekly Calendar view, then the calendar prints the
week in view. This same logic applies to monthly calendar views.

To print a calendar

1. Find the calendar you want to print (Finding a Calendar).

2. Click the Weekly or Monthly tab.

Based on the tab you click, Civic Platform displays the Weekly or Monthly calendar view.

3. Click Print.

Accela displays a printable version of the calendar in your browser window.

4. Choose File and select Print from your browser menu.

Cloning and Copying Calendars
Use the clone feature and the copy feature to apply standard block-out dates, times, and other calendar
details to multiple calendars. Clone a calendar to create a new, duplicate calendar. When you clone a
calendar, you specify the source calendar content you want to include in the new calendar, including block
out days, holidays, weekends, and other shared information. Copy a calendar to duplicate source calendar
details, such as block out days, holidays, and meetings, to an existing target calendar.
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Use Case Example

You have holidays that apply to all departments in your agency. You can set up holidays in one calendar
and copy this information to other calendars.

To clone or copy a calendar

1. Find the calendar you want to clone or copy (Finding a Calendar).

2. Clone the calendar by completing one of these actions:

• From the navigation tree, right-click on the calendar you want to clone and choose Clone Calendar
or Copy Calendar from the drop-down list.

• From the Calendar detail portlet, hover over the Menu button and choose Clone Calendar or Copy
Calendar from the drop-down list.

Civic Platform displays the clone (shown) or copy calendar portlet.

3. Complete Calendar Name (for clone) or Copy To Calendar (for copy) field:

Calendar Name When cloning a calendar, enter a unique name to identify the new calendar.

Copy To Calendar When copying a calendar, enter the name of the calendar to which to copy the select
includes.

4. Choose the source items you want to include from the cloned or copied calendar. The type of calendar
that you clone or copy, such as an inspection or meeting, determines the type of information you can
clone or copy (Table 117: Cloning and Copying Calendar Includes).

Table 117: Cloning and Copying Calendar Includes

Block Out Days Inspection and User calendars.

Districts Inspection calendars.

Meetings Meeting calendars.

Meeting Agenda Meeting calendars.

Meeting Attendees Meeting calendars.

Holidays Agency Holiday calendar

Inspection Calendar Items Inspection calendars.

Inspections Inspection calendars. Copies or clones inspection block out periods.

Permissions Inspection and Meeting calendars.

Weekend Agency Holiday calendar. Copies or clones weekend block out periods.

5. Click Submit.

Civic Platform creates the cloned calendar or copies the included information to the specified calendar.
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Assigning Daily Units
When you create a calendar, you set the default number of time blocks (units) you can schedule per day
in the #Units Allocated per Time Range field (Table 119: Calendar Detail Field Descriptions). This #Units
Allocated per Time Range field gets its default value from the daily unit setting you assign in the calendar.

To assign daily units

1. Find the calendar you want to modify (Finding a Calendar).

2. Click the Daily, Weekly, or Monthly tab.

3. Hover over the Menu button and select Assign Daily Units from the drop-down list.

Civic Platform displays the Assign Daily Units portlet.

4. Select the date for which you want to assign a special unit. The value in the # Units Allocated per Day
field determines the default number of units in a date.

Note:

The portlet lists all the dates in the current month by default. Click the calendar icon above the date list to
retrieve the dates of a different month.

5. Modify the unit value in the Units column, as required.

6. Click the Submit.

Civic Platform updates the daily unit settings.

Scheduling Calendar Items
You can schedule calendar items in the Daily, Weekly, or Monthly tab for any of the calendar types:

• Inspection
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• Event

• Hearing

• Agency Holiday

• User

• Meeting

To schedule a calendar item

1. Find the calendar you want to modify (Finding a Calendar).

2. Click the Daily, Weekly, or Monthly tab.

3. Click the New button.

Civic Platform displays the Calendar Item portlet.

4. Complete the fields that display. For a complete list of the fields that display, see Table 118: Calendar
Item Field Descriptions.

5. Click the Submit button.

Table 118: Calendar Item Field Descriptions

All-Day Event Mark this check box if you want the calendar item you schedule to occupy the entire
calendar day on which it is scheduled. When you mark this check box, the Start
Time and End Time drop-down lists are greyed out.

Calendar Item Enter a distinct name for the calendar item you want to schedule.

Comments Enter comments related to the calendar item you schedule. For example, if you are
scheduling a hearing, you might want to enter a hearing description, such as, “Plan
review for proposed subdivision.”

Date Use the Date button to choose a day to schedule the calendar item or type in the
calendar item date.

End Recurrence If you are scheduling a recurring calendar item, indicate when you want to end the
recurring calendar item. To continue a calendar item indefinitely, leave this field
empty.

End Time Select the calendar item end-time using the drop-down list.

Hearing Body This field appears only when you schedule a calendar item on a hearing calendar.

Enter the name of the hearing body that will attend the hearing. For example, you
might enter Planning Commission or Land Use Appeals Board. A hearing body
is an individual or a group of people responsible for reviewing applications in a
public setting, such as planning commission or land use appeals board members.
Hearing body members mediate hearings and might be required to reject or accept
applications based on the hearing results.

Location This field appears only when you schedule a calendar item on a hearing calendar.

Select the hearing location from this drop-down list. The values that populate this
list are determined by the Standard Choice, HEARING LOCATION (see the Accela
Civic Platform Configuration Reference).

Maximum Items This field appears only when you schedule a calendar item on a hearing calendar.
Enter the maximum number of applications that can be reviewed at the hearing.

Maximum Agenda Items This field appears only when you schedule a calendar item on a meeting calendar.
Enter the maximum number of agenda items that can be reviewed at the meeting.
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Meeting Body This field appears only when you schedule a calendar item on a meeting calendar.
Select the meeting body from the drop-down list. The values that populate this list
are determined by the Standard Choice, MEETING BODY (see the Accela Civic
Platform Configuration Reference).

Meeting Status This field appears only when you schedule a calendar item on a meeting calendar.
Select the status of the meeting, such as Approved or Pending. The displayed
values depend on the status group for the meeting type determined by the Standard
Choice MEETING_TYPE_STATUS_{Group Name} (see the Accela Civic Platform
Configuration Reference).

Meeting Type This field appears only when you schedule a calendar item on a meeting calendar.
Select the type of the meeting from the drop-down list. Civic Platform only displays
those meeting types for which you have permission.

Organizer This field appears only when you schedule a calendar item on a meeting calendar.
This field is read-only, and displays the current user as the organizer of the meeting
calendar item.

Recurrence - None Mark the radio button if you are scheduling a one-time calendar item.

Notice Date This field appears only when you schedule a calendar item on a hearing calendar.

Enter the date when you want a hearing notice e-mailed to designated recipients.
You determine the hearing notice e-mail recipients in the Send Email Notification To
drop-down list.

Recurrence - Repeat every
day(s)

To repeat a calendar item over a certain number of days, select this option and
enter the number of days between each calendar item.

Recurrence - Repeat every
week(s) on

To repeat a calendar item over a certain number of weeks, select this option, enter
the number of weeks between each calendar item, and choose the day of the week
when you want the calendar item to occur.

Recurrence - Repeat every
month(s) on

To repeat a calendar item over a certain number of months, select this option, enter
the number of months between each calendar item, and choose the day of the
week when you want the calendar item to occur.

Recurrence - Repeat every
year(s)

To repeat a calendar item over a certain number of years, select this option and
enter the number of years between each calendar item.

Reminder This field appears only when you schedule a calendar item on a meeting calendar.
Specifies the number of days, before the meeting, to send out a reminder
notification.

Responsible Person This field appears only when you schedule a calendar item on a meeting calendar.
Select the responsible person for the meeting. Click Current User to populate this
field with the current user’s name.

Send E-mail Notification To This field appears only when you schedule a calendar item on a hearing calendar.

When a hearing is scheduled, a hearing notice can be e-mailed to designated
recipients. Select a value from this drop-down list to determine the hearing notice e-
mail recipients. You can choose from these values:

All Licensed Professionals and Contacts

Contacts

Licensed Professionals

Primary Licensed Professional and Contact

Start Time Select the starting time for the calendar item using the drop-down list.

Status This field appears only when you schedule a calendar item on a hearing calendar.

Select a value from this drop-down list to determine the status of the hearing
calendar item, such as Approved or Pending. The values that displays in this drop-
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down list are determined by the status group you set for the hearing calendar item
type. You associate a status group with a hearing calendar item type in the Event
Type Maintenance portlet.

Subject This field appears only when you schedule a calendar item on a meeting calendar.
Enter the subject of the meeting.

Type Select a value from this drop-down list to classify the type of calendar item you
schedule. For example, you might set Inspection, Hearing, Holiday, Block-out, and
Weekend as values in this drop-down list.

You configure the values for this drop-down list in the Event Type Maintenance
portlet. When you set up an event type, you designate the calendar the event type
applies to in the Calendar Type drop-down list.

# Units Allocated Per Time
Range

This field appears only when you schedule a calendar item on an inspection
calendar.

Enter a number to define the maximum number of inspections that users can
schedule within the time range defined in the calendar item.

Note:

The field gets its default value from the daily unit setting (Assigning Daily
Units). If you change the value, the setting in the # Units Allocated Per
Time Range field overrides the daily unit setting.

Regardless of whether FID 8400 is enabled or disabled, when users
schedule an inspection (using or not using the auto-assign functionality),
Civic Platform calculates the available units before scheduling, specifically:

• Calculating the available inspection units against the # Units Allocated
Per Time Range setting;

• Calculating the available inspector units against the Daily Inspection
Units setting in the inspector user profile.

Units Displayed in ACA This field appears only when you schedule an inspection type calendar item. It
identifies the number of time blocks (units) displayed for a daily calendar item in
Citizen Access.

The default value of the field depends on the setting of the ACA Schedule Time
Block of the calendar in which the calendar item is created:

If the ACA Schedule Time Block field is not configured, you can enter the number of
block units to be included in the calendar item in the Units Displayed in ACA field.

If the ACA Schedule Time Block field is configured, the default value of Units
Displayed in ACA = Available time in the calendar item / ACA Schedule Time Block.

For description of the ACA Schedule Time Block field, see Table 119: Calendar
Detail Field Descriptions.

Votes By Body Members This field appears only when you schedule a calendar item on a hearing calendar.

Mark an option to indicate whether or not the hearing body members who attend
the hearing will vote on the applications they review.

Setting Up and Maintaining Calendars
Civic Platform manages four calendar types (Inspection, Meeting, Agency Holiday, and User). Civic
Platform uses the same process for setting up different type calendars. Where applicable, the procedures
in this section detail these differences.
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Topics:

• Creating a Calendar

• Modifying Calendar Details

• Assigning Calendar Permissions

• Assigning Districts

• Assigning and Removing Inspection Types

• Assigning Inspectors from the Supervisor Calendars

Creating a Calendar
Civic Platform provides the following four calendar types:

• Inspection

• Meeting

• Agency Holiday

• User

Use this procedure to create instances of any of the calendar types listed.

To create a new calendar

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

• Click New.

• From the navigation tree, right-click any calendar node and then click New Calendar.

Civic Platform displays the Calendar detail portlet.
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2. Complete the calendar details (Table 119: Calendar Detail Field Descriptions).

Table 119: Calendar Detail Field Descriptions

# Scheduling Attempts* For inspection calendars. Indicates the number of times Civic Platform attempts to
schedule a calendar event or an inspection before displaying an error message.

# Units Allocated per Day* For inspection calendars. This field determines the default number of units in the
daily unit setting (see Assigning Daily Units).

ACA Schedule Time Block For Citizen Access inspection calendars, this field specifies the time of every time
block available for scheduling inspections in an inspection calendar. For example,
if you enter 30 minutes in the field, every inspection unit is 30 minutes by default in
the inspection calendar.

Note:

The time of each time block is not necessarily the same as the time that an
inspection unit takes.

Calendar Name* Enter a distinct name for the calendar you want to create.

Comments Enter specific comments related to the calendar, if applicable.

Default Block For Civic Platform inspection calendars, this field specifies the default block of time
that an inspection unit takes in an inspection calendar. For example, if you enter 30
minutes in the default block field, every inspection unit is 30 minutes by default in
the inspection calendar.

Department For a user calendar, select the department that the calendar applies to.

Enable for ACA For an inspection calendar, select this option to enable an inspection calendar for
Citizen Access. If you do not select this option, the calendar is not available for
Citizen Access inspection scheduling.

Meeting Reason For a meeting calendar, enter the meeting reason, if any, for reference.

Hide Inspection Times in
ACA

For an inspection calendar, select this option if you want inspection time intervals to
be visible to public users with inspection scheduling permissions.

Location For a meeting calendar, select the location that the meeting takes place.

Priority* For an inspection calendar, enter a numeric value to designate priority over other
calendars. The lower the number, the higher the priority. Civic Platform searches
calendars, with a 1 priority, for available units before calendars with a priority of 2.

Schedule # of Days Out For an inspection calendar, enter the maximum number of future days available
for calendar scheduling. Enter a value of 0 to make the calendar unavailable for
scheduling. For no scheduling restrictions, leave the field blank. You can enter up to
three integers in this field.
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For example, if the current date is June 5, 2009 and you enter a value of 10, then
scheduling for the selected calendar is only available from June 5, 2009 to June 15,
2009.Use this feature to limit calendar scheduling.

For example, you might have an inspection calendar set up for electrical inspectors.
If some of the electrical inspectors in your agency plan to be out of the office for
a conference, or if other inspectors have planned vacation days, you can limit
calendar scheduling availability in advance. This prevents users with scheduling
authorization on your agency’s calendars, such as supervisors, inspectors, and
agency employees, from scheduling inspections when inspectors are unavailable.
Similarly, you might limit scheduling availability for event calendars based on the
planned absence of agency personnel.

Schedule Cut-Off Time AM/
PM

For an inspection calendar, use these fields to set a cut-off time for inspection
scheduling. If users make a inspection scheduling request after the cut-off time,
the earliest possible inspection date is one day later than the date counted directly
using the Schedule Days in Advance setting (when they make the scheduling
request before the cut-off time).Table 120: Inspection Date Based on the Schedule
Days in Advance and Schedule Cut-off Time Settings shows an example on how
Citizen Access gets the inspection date based on the Schedule Days in Advance
and Schedule Cut-off Time settings.

Schedule Days in Advance For an inspection calendar, use this field to configure the preparation time needed
by agency staff for inspections. For example, if you configure the Schedule Days
in Advance as 3 and a user wants to schedule an inspection on July 12, 2014, the
user must make the inspection scheduling request on July 9, 2013, so that the
agency staff have 3 days to prepare for the inspection.

The Schedule Days in Advance setting works jointly with the Schedule Cut-Off
Time setting.

Table 120: Inspection Date Based on the Schedule Days in Advance and Schedule
Cut-off Time Settings shows an example of how Citizen Access gets the inspection
date based on the Schedule Days in Advance and Schedule Cut-off Time
settings.

Status* Indicates whether the calendar is available for use. The default calendar status is
Active. The status field is inactive for AGENCY HOLIDAY calendars.

This field designates calendar availability on the user side. Enable the calendar to
give users the calendar option in the user daily calendar list. Disable the calendar to
keep the calendar in the administration list, but omit it from the user calendar list.

Type* Select the type of calendar from the drop-down list, such as AGENCY HOLIDAY,
INSPECTION, MEETING, OR USER.

User For a user calendar, select the user that the calendar applies to.

3. Click Submit.

Table 120: Inspection Date Based on the Schedule Days in Advance and Schedule Cut-off Time Settings

Possible Inspection DateExample Schedule
Days in Advance
Setting1

Example Schedule
Cut-off Time Setting1 If scheduled before 2:00 PM If scheduled after 2:00 PM

- 2:00 PM The same day or later 1 day later2

5 - 5 days later2 5 days later2

5 2:00 PM 5 days later2 6 days later2

- - The same day or later The same day or later
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Possible Inspection DateExample Schedule
Days in Advance
Setting1

Example Schedule
Cut-off Time Setting1 If scheduled before 2:00 PM If scheduled after 2:00 PM

1These settings work in Citizen Access, and do not apply to supervisors.2The block out days in the inspection
calendar are excluded during the counting.

Modifying Calendar Details
To modify calendar details

1. Find the calendar for which you want to set or modify permissions (Finding a Calendar).

2. Click the Details tab.

Civic Platform displays the calendar details portlet.

3. Complete the calendar details (Table 119: Calendar Detail Field Descriptions).

4. Click Submit.

Assigning Calendar Permissions
You can assign permissions to inspection and meeting type calendars. You can assign Full, Read, or None
as the calendar permission for user groups and individual users.

Use Case Example

You hire new agency personnel and add them to an existing Counter Clerk group in the Building module.
You limit calendar access to include only trained personnel.

Use Case Example

You create an inspection type calendar for all the user groups or users that belong to a particular building
district. After you assign permissions to a particular user or user group, the inspectors in those groups have
permission to view, schedule, and reschedule inspections for the associated calendar type.

To assign user permissions or group permissions to a calendar type

1. Find the calendar for which you want to set or modify permissions (Finding a Calendar).

2. Click the Permissions tab.

Civic Platform displays the calendar permissions portlet with current group permissions, if any.
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3. Assign a new permission.

a. Click Assign.

Civic Platform displays the modules for which you can assign group permission.

b. Expand the modules to find the group(s) for which you want to assign a permission.

c. Select the group(s) and select permission from the drop-down list.

d. Click Submit.

Note:

By default, Civic Platform sets the permission to Full for the newly assigned group. You might need to
modify this permission depending on your business requirements.

4. Modify an existing permission.

a. Select the group for which you want to modify a permission.

b. Select a new permission from the drop-down list.

Full Full grants users access to all functions for the associated calendar.

Read-Only Read-Only grants users access to view but not modify functions for the associated
calendar.

None None denies users access to functions for the associated calendar.

c. Click Submit.

5. Delete a group permission.

a. Select the group for which you want to remove all permission.
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b. Click Delete.

Civic Platform removes the group from the list.

Assigning Districts
You can assign districts to inspection type calendars. You can assign different inspection times based on
the district. When users schedule an inspection for a record, the district information in the record address,
together with the settings in the inspection district calendar, determine the date and time availability for
scheduling.

Use Case Example

You create an inspection calendar to arrange inspections in District A on Monday and Tuesday, and create
another calendar to arrange the same types of inspections in District B on Wednesday and Thursday.

To assign districts to a calendar

1. Find the calendar for which you want to set or modify districts (Finding a Calendar).

2. Click the Districts tab.

Civic Platform displays current district associations, if any.

3. Click Assign to add a district association.

Civic Platform displays available districts.

a. Select the district(s).

b. Click Submit.

Note:

If you do not associate an inspection calendar with any district, the inspection calendar applies to all
districts.

4. Delete a district association.

a. Select the district.
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b. Click Delete.

Assigning and Removing Inspection Types
You can assign inspection types and inspection groups to inspection calendars. For example, if you
want to create a calendar for electrical inspections, you can assign an electrical inspection group to the
calendar. Civic Platform associates inspection types included in the electrical inspection group with the
inspection calendar.

Inspection types are also one filtering criterion used for automatic inspection scheduling. For more
information on working with the inspection type calendar filtering criteria, see Setting Up Automatic
Inspection Scheduling.

For instructions on configuring inspections for automatic scheduling see Inspections.

Inspection types distinguish inspections, such as mechanical, electrical, and building inspections. Assign
inspection types to inspection type calendars to define calendar scope. For example, you might want to
associate mechanical inspection types with a mechanical inspection type calendar.

To assign an inspection type to a calendar

1. Find the calendar for which you want to set or modify inspection types (Finding a Calendar).

2. Click the Inspection Types tab from the detail portlet.

Note:

See Inspections for information on setting up inspection types.

Civic Platform displays the inspection types list portlet.

3. Assign a new inspection type.

a. Click Assign.

Civic Platform displays the Civic Platform inspection types.
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b. Select the inspection type(s) you want to assign.

c. Click Submit.

Civic Platform adds the inspection type to the inspection calendar type with default settings.

4. Modify Citizen Access inspection type settings.

a. Select the inspection group for which you want to modify settings.

b. Modify the settings in accordance with (Table 121: Inspection Scheduling Fields for Citizen Access).

Table 121: Inspection Scheduling Fields for Citizen Access

Schedule Inspection in
ACA

Choose one of the available scheduling options in Citizen Access:None - Does
not allow public users to schedule this inspection type online.Request Only -
pending- only allows public users to request for an inspection online. The agency
coordinates the appointment for the inspection date and time.Request Same Day
Next Day- allows public users to request an inspection for the same day, next
day, or next available day, based on inspection type calendar parameters defined
on the inspection type. For more information about inspection parameters, refer
to Inspections. The inspection cut-off time displays on this page. If you set the
cut-off time as 3:00PM and a public user schedules an inspection at 4:00PM and
selects the Same Day option, Civic Platform schedules the inspection for the first
appropriate inspection slot on the next business day.

Note:

After public users schedule inspection types that you set up for auto-
assignment using the Request Same Day Next Day option, you cannot
reschedule or cancel the inspections. After public users schedule manual
inspections by using the Request Same Day Next Day option, they can
reschedule and/or cancel them.

Schedule using calendar - Allows public users to schedule inspections based on
the availability on the inspection type calendar.

Cancel Inspection in
ACA

Use the drop-down list to indicate if you want to allow public users to cancel
inspections in ACA. Yes allows public users to cancel inspections online.No restricts
public users from the ability to cancel inspections online.

Reschedule Inspection
in ACA

Use the drop-down list to indicate if you want to allow public users to reschedule
inspections in ACA. Yes allows public users to reschedule inspections online.No
restricts public users from the ability to reschedule inspections online.

Enable Ready Time in
ACA

Use the drop-down list to indicate if you want to allow public users to specify ready
time for inspections in the Ready Time field in the ACA Request page. Yes allows
public users to specify inspection ready time. No restricts public users from the
ability to specify inspection ready time.

c. Click Submit.
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5. Delete an inspection group.

a. Select the inspection group.

b. Click Delete.

Assigning Inspectors from the Supervisor Calendars
Civic Platform integrates inspection calendars and supervisor calendars to facilitate inspection scheduling.
A supervisor manages and assigns inspectors to inspections. A supervisor can change the view in the
supervisor calendar to show assigned inspections for the current calendar, assigned inspections for all
calendars, or unassigned inspections that require inspector assignment. For more information about
assigning inspections, refer to “Inspections” in the Accela Civic Platform User Guide.

To assign inspectors to an inspection from the supervisor calendar

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the calendar on which you want to act.

3. Click the Monthly tab to select the monthly calendar display.

4. Display supervisor unassigned calendar inspections by selecting the appropriate option from the Show
drop-down list.

Civic Platform displays applicable calendar information based on selection.

5. Select the inspection to assign an inspector.

6. Click the Menu button and select Assign Inspector from the drop-down list.

Civic Platform displays an inspections portlet.

7. Select the Address and/or Parcel for the inspection.

8. Click Submit.

9. Select the inspector.

The inspectors on this page vary depending on the inspection type, district, and available units.

10.Click Submit.

Civic Platform updates the inspection with the inspector.

Setting Up and Maintaining Meeting Types
Meeting types define the different types of meetings that an agency might conduct, such as tax hearings
and plan reviews. You must set up meeting types before you can schedule meetings.

Meeting types regulate meetings by applying a specific group of settings to all meetings of a specific
meeting type. When you schedule a meeting, you specify the meeting type.

The topics in this section involve specifying the settings for the areas comprising a meeting type definition.

Note:

You must create a meeting type before you can modify it to complete the meeting type definition.

Topics

• Finding a Meeting Type

• Creating Meeting Types
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• Modifying Meeting Type Details

• Setting or Removing Meeting Type Permissions

• Setting or Removing Record Type Associations

• Setting or Removing Workflow Task Associations

• Setting or Removing Attendee Type Associations

• Setting or Removing District Associations

• Setting or Removing Vote Result Options

• Setting Notification Template Associations

• Deleting Meeting Types

Finding a Meeting Type
You can search for an existing meeting type to modify meeting type settings.

To search for a meeting type

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Click the Meeting Type Maintenance navigation tree.

Civic Platform displays the Meeting Type Maintenance list portlet.

3. Click Search.

Civic Platform displays the Meeting Type search page.
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4. Complete the fields. For a complete list of Meeting Type fields, see Table 122: Meeting Type Field
Descriptions.

5. Click Submit.

Civic Platform displays the meeting types that match your search criteria.

Creating Meeting Types
When you set up meeting types, you designate the type and the status group. You must create the meeting
type first, then complete the tabs for the meeting type to complete the meeting type definition.

To create a meeting type

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Click the Meeting Type Maintenance navigation tree.

Civic Platform displays the Meeting Type Maintenance list portlet.

3. Choose one of these options:

• Click New in the Meeting Type Maintenance list portlet.

• Right-click any Meeting Type Maintenance navigation tree node, and then click New Meeting Type.

Civic Platform displays the Meeting Type detail portlet.
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4. Complete the meeting type field details (Table 122: Meeting Type Field Descriptions).

5. Click Submit.

Civic Platform displays a confirmation message indicating successful creation of the meeting type.

Table 122: Meeting Type Field Descriptions

Label Description

Description A description of the meeting type.

Meeting Type* The name to identify the meeting, such as Staff Meeting or Facility Reservation.

Status The status of the meeting, active or inactive. If a meeting type is active, it displays in
the Type drop-down list on the Calendar Meeting Scheduling page.

Meeting Type Status
Group

The status group for the meeting type. The values for this drop-down list depend on
the settings in the MEETING_TYPE_STATUS_[STATUS_GROUP_NAME] Standard
Choice, APPROVED, PENDING, or DENIED, for example.

Template A list of active ASI group codes. The selected template determines additional fields
that display in the details tab for meetings of the specified type.

Modifying Meeting Type Details
You can modify existing meeting types to change the field values.

To modify a meeting type

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to modify.

• Navigate to the meeting type from the navigation tree in the calendar administration portlet.

• Use search to find the meeting type of interest (Finding a Meeting Type).

3. Modify the meeting type fields as required. For a complete description of meeting type fields, see Table
122: Meeting Type Field Descriptions.

4. Click Submit.

Setting or Removing Meeting Type Permissions
Your ability to view meeting details depends on your group membership, your group’s permission with the
meeting type, for which a particular meeting is an instance, and the calendar used to schedule the meeting
type. Table 123: Meeting Calendar and Meeting Type Permissions summarizes your permissions based on
the interaction of calendar and meeting type permissions.
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Table 123: Meeting Calendar and Meeting Type Permissions

Meeting Calendar
Permission

Meeting Type
Permission

User Access

None Cannot open meeting.

Full Open meeting in Read Only mode. User can upload and
download documents, but not delete documents.

Read Open meeting in Read Only mode. User can upload, download,
and view documents, but not delete documents.

Read

None Cannot open meeting.

Full Open meeting and perform all operations.

Read Open meeting in Read Only mode. User can upload, download,
and view documents, but not delete documents.

Full

None Cannot open meeting.

To set or modify meeting type permissions

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to modify.

• Navigate to the meeting type from the navigation tree in the calendar administration portlet.

• Use search to find the meeting type of interest (Finding a Meeting Type).

3. Click the Permissions tab.

Civic Platform displays the meeting permissions portlet with current group permissions.

4. Assign a new permission.

a. Click Assign.

Civic Platform displays the modules for which you can assign group permission.
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b. Expand the modules to find the group(s) for which you want to assign a permission.

c. Select the group(s) and select permission from the drop-down list.

d. Click Submit.

Note:

By default, Civic Platform sets the permission to Full for the newly assigned group. You can modify
this permission depending on your business requirements.

5. Modify an existing permission.

a. Select the group for which you want to modify a permission.

b. Select a new permission from the drop-down list.

c. Click Submit.

6. Delete a group permission.

a. Select the group for which you want to remove all permission.

b. Click Delete.

Civic Platform removes the group from the list.

Setting or Removing Record Type Associations
You can associate or disassociate one or more record types with a meeting type. When you schedule a
meeting of a particular meeting type, you select instances of the associated record types to be the agenda
items for your meeting.

Use Case Example

You create a meeting type named Review and associate building records with that meeting type. When
you schedule a meeting and designate it as a Review meeting type, you can link building records to the
meeting as agenda items.

To set or remove record type associations

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to modify.

• Navigate to the meeting type from the navigation tree in the calendar administration portlet.
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• Use search to find the meeting type of interest (Finding a Meeting Type).

Note:

If you do not associate a record type with the meeting type, meeting organizers can add any kind of
record type to the meeting.

3. Click the Record Types record tab.

Civic Platform displays current record type associations.

4. Add a new record type association.

a. Click Assign.

Civic Platform displays a list of record types.

b. Select the record types you want to associate with the meeting type.

c. Click Submit.

5. Delete a new record type association.

a. Select the record types you want to disassociate with the meeting type.

b. Click Delete.

Setting or Removing Workflow Task Associations
If you associate a workflow task with a meeting type, you can write an EMSE script that automatically
launches a meeting request upon completion of the associated workflow task. See the Accela Civic
Platform Scripting Guide.

To set or remove a workflow task association
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1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to modify.

• Navigate to the meeting type from the navigation tree in the calendar administration portlet.

• Use search to find the meeting type of interest (Finding a Meeting Type).

3. Click the Workflow record tab.

Civic Platform displays current workflow task associations.

4. Click Assign to add a workflow task association.

Civic Platform displays the navigation tree for the Workflow Process Task Status.

a. Select the workflow items you want to associate with the meeting type.

b. Click Submit.

5. Delete a workflow item association.

a. Select the workflow items you want to disassociate with the meeting type.

b. Click Delete.

Setting or Removing Attendee Type Associations
When you associate attendee types with a meeting type, you specify the contact type(s), licensed
professional type(s), and user disciplines that should attend a meeting.

To set or remove an attendee type association

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to modify.
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• Navigate to the meeting type from the navigation tree in the calendar administration portlet.

• Use search to find the meeting type of interest (Finding a Meeting Type).

3. Click the Attendee Types tab.

Civic Platform displays current attendee type associations, if any.

4. Click Assign to add an attendee type association.

Civic Platform displays available attendee types.

a. Select the attendee type(s) you want to associate with the meeting type.

b. Click Submit.

5. Delete an attendee type association.

a. Select the attendee type(s) you want to disassociate with the meeting type.

b. Click Delete.

Setting or Removing District Associations
When scheduling meetings, you can filter potential meeting attendees by their district associations.

To set or remove an district association

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to modify.

• Navigate to the meeting type from the navigation tree in the calendar administration portlet.

• Use search to find the meeting type of interest (Finding a Meeting Type).

3. Click the Districts tab.

Civic Platform displays current district associations.
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4. Click Assign to add a district association.

Civic Platform displays available districts.

a. Select the district(s) you want to associate with the meeting type.

b. Click Submit.

5. Delete a district association.

a. Select the district(s) you want to disassociate with the meeting type.

b. Click Delete.

Setting or Removing Vote Result Options
You can set or remove voting values associated with a meeting type. By default, Civic Platform uses two
vote result options; Accept and Reject.

To set or remove a voting value association

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to modify.

• Navigate to the meeting type from the navigation tree in the calendar administration portlet.

• Use search to find the meeting type of interest (Finding a Meeting Type).

3. Click the Vote tab.

Civic Platform displays current vote result options.
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4. Click Add to add a voting option.

Civic Platform displays a dialog to enter a voting option.

a. Enter a vote result option.

b. Click Submit.

5. Delete a vote result option.

a. Select the vote result option(s) you want to remove.

b. Click Submit.

Setting Notification Template Associations
Civic Platform supports the ability to send email notifications to contacts on a case or license. You can also
send notifications to internal staff not specifically related to a case, for example, the hearing officer.

To set notification template associations

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to modify.

• Navigate to the meeting type from the navigation tree in the calendar administration portlet.

• Use search to find the meeting type of interest (Finding a Meeting Type).

3. Click the Notification tab.

Civic Platform displays the dialog to manage notification template associations.
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4. Select the notification template you want to associate with each combination of action and user.

If required, click the View Detail link to view the notification template. See Working with Communication
Manager  for information on modifying notification templates.

5. Click Save.

Deleting Meeting Types
You can delete meeting types as necessary. For example, your agency might set up a temporary meeting
type that you delete after the scheduled meeting occurs. When you delete a meeting type, Civic Platform
sets the meeting type to inactive. Civic Platform does not remove the meeting type from the database.

To delete a meeting type

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Select the meeting type you want to delete.

• Navigate to the meeting type from the navigation tree in the calendar administration portlet.

• Use search to find the meeting type of interest (Finding a Meeting Type).

3. In the top half of the calendar details portlet, select the meeting type you want to delete.

4. Click Delete.

Setting Up and Maintaining Supervisors
You can assign a user supervisory rights. After you assign a user supervisory rights, you can add users to
the supervisor's team and create a master calendar. A master calendar allows supervisors to review team
member assignments and manage workflow.

If you are a supervisor, you have the ability to view unassigned inspections and make inspection
assignments.
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Topics:

• Assigning or Removing Supervisory Rights

• Setting Up and Maintaining Supervisor Teams

• Creating Master Calendars

Assigning or Removing Supervisory Rights
To assign a user supervisory rights

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Click the Supervisor Maintenance node from the navigation tree.

Civic Platform displays a list of supervisors.

3. Click Assign to make a user or group a supervisor.

Civic Platform displays the list of users and groups, per module.

a. Select the user(s) and groups (s) you want to make supervisors.

b. Click Submit.

4. Remove a supervisor.

a. Select the user(s) and groups (s) you want to remove as supervisors.
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b. Click Delete.

5. Click Submit.

Civic Platform adds the group(s) or user(s) to the list of supervisors.

Setting Up and Maintaining Supervisor Teams
To set up and maintain a supervisor team

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Click the Supervisor Maintenance node from the navigation tree to list all supervisors or navigate the
tree to select a specific user or a specific group supervisor.

Civic Platform displays all the defined supervisors or the specific supervisor selected.

3. Select the supervisor for which you want to add or remove team members.

4. Click My Team tab.

5. Click Assign.

Civic Platform displays the list of users and groups, per module.
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a. Select the user(s) and groups (s) to add to the supervisor team.

b. Click Submit.

Civic Platform adds the selected user(s) and group(s).

6. Remove a supervisor team member.

a. Select the user(s) and groups (s) you want to remove from the supervisor team.

b. Click Delete.

Civic Platform removes the selected user(s) and group(s).

Creating Master Calendars
You can create a master calendar that merges multiple calendars into a single calendar view. A master
calendar makes it easier for supervisors to avoid conflicts when scheduling their team’s work assignments.

To create a master calendar

1. Access the Calendar Administration portlet (Accessing the Calendar Administration Portlet).

2. Click the Supervisor Maintenance node from the navigation tree to list all supervisors or navigate the
tree to select a specific user or a specific group supervisor.

Civic Platform displays all the defined supervisors or the specific supervisor selected.
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3. Select the supervisor for which you want to create a master calendar.

4. Click the Master Calendar tab.

Civic Platform displays currently assigned master calendars.

5. Add calendar(s) to your master calendar.

a. Click Look Up.

Civic Platform displays the calendar search form.

b. Complete the fields on the form (Table 124: Calendar Search Fields).

Table 124: Calendar Search Fields

# Scheduling Attempts Enter the number of scheduling attempts defined for the calendar you want to find.

# Units Allocated per
Day

Enter the number of units scheduled per day for the calendar you want to find.

Calendar Name Enter the distinct name for the calendar you want to find.

Status Select the status of the calendar you want to find from this drop-down list. You can
select Active or Inactive.
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Type Select the type of calendar you want to find. You can select Meeting or Inspection.

c. Click Submit.

Civic Platform displays calendars that match the search criteria.

d. Select the calendar(s) you want to add to your master calendar.

e. Click Select.

Civic Platform adds the calendar to your master calendar.

6. Remove calendar(s) from you master calendar.

a. Select the calendar.

b. Click Delete.

Civic Platform removes the calendar from your master calendar.

Configuring Meeting Email Notifications
You can configure meeting email notifications so that meeting attendees receive a notice upon scheduling,
changing, rescheduling, or cancelling a meeting.

To configure meeting email notifications

1. Access the Content Customize portlet (Navigating to the Setup Portlet).

2. Configure the four message types described below:

EMAIL_NOTICE_MEETING This is the subject line for the meeting notice email.
Civic Platform sends this email when a user schedules a
meeting.

You can configure this email subject to include details
provided by email subject and email body variables
(Table 125: Meeting Notice Email Message Subject
Variables and Table 126: Meeting Notice Email Message
Body Variables).

EMAIL_NOTICE_MEETING_CHANGE This is the subject line for the meeting change notice
email. Civic Platform sends this email when a user
changes a scheduled meeting.

You can configure this email subject to include details
provided by email subject and email body variables
(Table 125: Meeting Notice Email Message Subject
Variables and Table 126: Meeting Notice Email Message
Body Variables).

EMAIL_NOTICE_MEETING_RESCHEDULE This is the subject line for the meeting reschedule notice
email. Civic Platform sends this email when a user
changes a scheduled meeting.
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You can configure this email subject to include details
provided by email subject and email body variables
(Table 125: Meeting Notice Email Message Subject
Variables and Table 126: Meeting Notice Email Message
Body Variables).

EMAIL_NOTICE_MEETING_CANCELLATION This is the subject line for the meeting cancellation
notice email. Civic Platform sends this email when a user
changes a scheduled meeting.

You can configure this email subject to include details
provided by email subject and email body variables
(Table 125: Meeting Notice Email Message Subject
Variables and Table 126: Meeting Notice Email Message
Body Variables).

Table 125: Meeting Notice Email Message Subject Variables

$AGENCY-
DEPARTMENTS$

The agency department responsible for the hearing, such as a planning commission or
land use appeals board.

$ALTID$ The alternate identification number for the application.

$NEW_HEARING_BODY$ The new hearing body members assigned to a hearing.

$NEW_STATUS$ The new hearing status.

$ORIG_HEARING_BODY
$

The original hearing body members assigned to a hearing.

$ORIG_STATUS$ The original hearing status.

$PERMITID$ The application identification number.

Table 126: Meeting Notice Email Message Body Variables

$AGENCY-
DEPARTMENTS$

The agency department responsible for the hearing, such as a Planning Commission.

$NEW_DURATION$ The updated hearing duration.

$NEW_END_TIME$ The updated hearing end time.

$NEW_HEARING_BODY$ The updated hearing body.

$NEW_HEARING_DATE$ The updated hearing date.

$NEW_LOCATION$ The updated hearing location.

$NEW_MAX_ITEM$ The updated hearing max item. The max item value is the number of applications
reviewable at one hearing.

$NEW_NOTICE_ DATE$ The updated hearing notice date.

$NEW_START_ TIME$ The updated hearing start time.

$ORIG_DURATION$ The original length of the scheduled hearing.

$ORIG_END_TIME$ The original end time of the scheduled hearing.

$ORIG_HEARING_BODY
$

The original committee members/ individuals scheduled to attend the hearing.

$ORIG_HEARING_DATE
$

The original hearing date.

$ORIG_LOCATION$ The original hearing location.
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$ORIG_MAX_ITEMS$ The original hearing max item. The max item value is the number of applications
reviewable at one hearing.

$ORIG_NOTICE_ DATE$ The original hearing notice date.

$ORIG_START_ TIME$ The original hearing start time.

$RECIPIENT_ NAME$ The primary applicant associated with the application scheduled for a hearing review.

$SENDER_FIRST_NAME
$

The email sender’s first name.

$SENDER_LAST_NAME$ The email sender’s last name.

$SENDER_TITLE$ The email sender’s official title.

Scenarios
Topics

• Setting Up Inspection Calendars for Public Users

• Creating an Inspection Calendar with 30 Minute Intervals

• Setting Up Automatic Inspection Scheduling

Setting Up Inspection Calendars for Public Users
This procedure consolidates the steps documented in this guide and in the Citizen Access Administrator
Guide to set up inspection calendars for public users.

To set up inspection calendars for public users

1. Set up public users calendars in Civic Platform.

a. From the calendar portlet Details tab, select Enable for ACA (Calendar Detail Field Descriptions).

b. If you have more than one Citizen Access inspection calendar, from the calendar portlet Details tab,
set the Priority field (Calendar Detail Field Descriptions).

c. From the calendar portlet Inspections Type tab, enter Citizen Access related parameters
(Inspection Scheduling Fields for Citizen Access).

2. Set up public user calendars in Citizen Access.

a. From the Inspections section of the Module Settings page in Citizen Access Setup, set user
permissions for Citizen Access calendars (Citizen Access Settings for Inspection Scheduling). See
“Inspections” in the Citizen Access Administrator Guide.
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Figure 35: Citizen Access Settings for Inspection Scheduling

b. From the Application Status section of Module Settings page in Citizen Access Setup, restrict public
users’ scheduling permissions to certain inspection types for a particular record status, if required
(Citizen Access for Restricting Inspection Scheduling). See also “Application Status” in the Citizen
Access Administrator Guide.
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Figure 36: Citizen Access for Restricting Inspection Scheduling

Creating an Inspection Calendar with 30 Minute Intervals
If your agency only conducts inspections from 8:00 am to 12:00 pm, you can create a calendar with
available inspection times from 8:00 am to 12:00 pm. Configuring your calendars this way enables you to
direct users only to the calendar times available for inspection scheduling.

To create an Citizen Access Calendar with 30 minute inspection intervals

1. Create a new inspection type calendar with 30 minute time blocks (Creating a Calendar).

Use the values in Citizen Access Inspection Type Calendar Criteria.
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Table 127: Citizen Access Inspection Type Calendar Criteria

# Scheduling Attempts 0

# Units Allocated per
day

16

Default Block 30 minutes

Priority 1

Status Active

Type Inspection Type

2. Go to the Daily tab for your newly created calendar and create a new daily calendar item that defines
AM inspection times with the criteria listed below. The inspection units correspond to the 30 minute
inspection intervals established for the calendar.

Calendar Item AM Inspection Range

End-Time 12:00 PM

Start-Time 8:00 AM

Type Inspection

For example, if inspections are only available for scheduling from 8:00 am to 12:00 pm, the Units
Displayed in ACA box auto-populates with 8 inspection units.
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3. Create a new daily calendar item to block out a lunch hour and populate the fields with the criteria listed
below:

Calendar Item Lunch

End-Time 1:00 PM

Start-Time 12:00 PM

Type Block-out

4. Create a daily calendar item that defines PM inspection times with the criteria listed below.

Calendar Item PM Inspection Range

End-Time 4:00 PM

Start-Time 1:00 PM

Type Inspection

Civic Platform displays the three calendar items in the Daily tab.
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5. Log in to Citizen Access and schedule an inspection for an application.

The Citizen Access Calendar displays inspection time blocks in 30 minute intervals.

Setting Up Automatic Inspection Scheduling
You can set up Civic Platform to automatically schedule inspections upon application submittal. When you
automatically schedule inspections, Civic Platform verifies inspector profiles against inspection types and
assigns the appropriate inspector. Inspector assignments vary depending on geographic district, inspector
discipline, calendar permissions, and workload availability.

When you set up inspection types and inspector profiles for automatic scheduling, Civic Platform
automatically assigns the inspector whose profile best matches the inspection type you are scheduling.

Note:

If you do not set up inspector profiles, Civic Platform attempts to balance workloads, but might over book at
any time.

You can manually change automatically scheduled inspection assignments through the Civic Platform
inspection calendars (Setting Up and Maintaining Calendars). If you automatically schedule inspections
in Citizen Access or Accela Interactive Voice Response, you do not have the option to modify inspector
assignments.
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To set up automatic inspection scheduling

1. Determine the inspection type you want to use for automatic inspection scheduling (Managing
Inspection Groups).

2. Determine the shortest length of time it takes to complete an inspection, across all inspection types, and
consider this time interval as one unit.

For example, you might determine that the unit value equals the duration of electrical inspections, 30
minutes.

3. Determine the number of units (time segments) required to complete the inspection type of interest.

If one unit equals 30 minutes, for example, an hour-long inspection type equals two units and a ninety-
minute inspection type equals three units.

4. Set up the inspection types in Classic Administration.

a. Access the set up form for inspection groups (Classic Administration > Admin Tools >
Inspection > Inspection).

b. Specify a unit value for all the inspection types subject to automatic scheduling (Inspection Unit
Values).

Figure 37: Inspection Unit Values

Inspection Type Units illustrates example settings for different inspection types.

Table 128: Inspection Type Units

Inspection Type Length Unit Value (1 unit = 30 minutes)

Electrical inspection 30 minutes 1 unit

Plumbing inspection 1 hour 2 units

Water Heater inspection 45 minutes 1.5 units

c. Set the Auto Assign drop-down list value to Yes for each of the inspection types you want to
subject to automatic scheduling (Inspection Type Configuration).
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Figure 38: Inspection Type Configuration

5. For each inspector that want to automatically schedule, set up the daily capacity to do inspection work.

a. Access the set up form for user profiles (Classic Administration > Admin Tools > User Profile >
User).

b. Select a user.

Civic Platform displays user details.
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c. In the Daily Inspection Units field, enter the number of units you expect the inspector to complete
each day.

Use the unit definition from Inspection Unit Values as the basis for determining the number of daily
inspection units. For example, if an inspector has six hours available for inspections each day and
each unit equals 30 minutes, the inspector can accommodate twelve units per day.

6. For each inspector that you want to automatically schedule, set up their applicable districts and their
disciplines.

a. Access the set up form for user profiles (Classic Administration > Admin Tools > User Profile >
User).

Civic Platform displays the user profiles page.

b. From the list of users, click the User Profile link.

Civic Platform displays the user profiles page.

c. Edit the user profile to include the districts and disciplines that apply to the inspector.

Inspector Profile Examples illustrates examples of how you can configure inspector profiles.



 | Part 4: Managing Agency Communications and Events | 568

Table 129: Inspector Profile Examples

User Name Group District Daily
Inspection
Units

Department Discipline

Allison Inspection Bldg North 12 Bldg Electrical

Matthew Inspection Bldg North 5 Bldg Plumbing

Greg Inspection Bldg North 15 Bldg Water Heater

7. Set up the inspection type calendar (Setting Up and Maintaining Calendars).

a. Set up the calendar block-out times (Calendar Detail Field Descriptions). Block-out times are the
days and times during which you cannot schedule inspections, such as holidays and weekends.

b. Set up the number of units per day to allocate for inspections (Calendar Detail Field Descriptions).

Best practice is to match the time you ascribed to the inspection unit value (Inspection Unit Values),
30 minutes for example, with the time setting in the Default Block field.

To determine the number of units per day to allocate, add the daily inspector units of the of all
inspectors assigned to a calendar. For example, if the inspectors in Inspector Profile Examples have
a total of 32 inspection units per day. If you assign Matthew, an inspector with 5 daily inspection
units, and Greg, an inspector with 15 daily inspection units, to the same calendar, you should set the
calendar units at 20 units per day.

c. Set up districts and inspection types (Assigning Districts and Assigning and Removing Inspection
Types).

For example, if you have a mechanical inspection type calendar, assign the districts that apply the
calendar, as well as assigning the mechanical inspection types. When you automatically schedule
inspections for inspection types associated with a calendar, Civic Platform first attempts to schedule
the inspection on the associated calendar for the district in which the inspection record is registered.

d. Assign inspector permission (Assigning Calendar Permissions).

Civic Platform assigns inspectors to calendar events with district assignments and discipline
assignments that match the districts and disciplines in the inspector’s profile (Inspector Profile
Examples).
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Managing Calendar Items though the Calendar Portlet
Administrators access calendar functionality through the Setup portlet (Figure 39: Accessing Calendars
through the Setup Portlet) or a link to the Calendar portlet on the main console. End users can only access
calendar functionality through the link on the main console.

Calendar functionality accessed through the Setup portlet differs from calendar functionality accessed
through the main console. This section addresses scheduling of calendar events with the Calendar portlet
that you access from the Setup portlet. The Accela Civic Platform User Guide provides information on
scheduling calendar events with the Calendar portlet you access from the main console.

Figure 39: Accessing Calendars through the Setup Portlet

Scheduling Inspections from a Record List
Civic Platform provides the capability to schedule inspections directly from a record list, without having to
navigate to the calendars area.

To schedule an inspection from a record list

1. Access the Building Permits portlet (Navigating to the Setup Portlet).

2. Select the record for which you want to schedule an inspection.

Civic Platform displays the application details in the detail portlet.

3. From the details portlet, click the Calendar secondary tab.

Civic Platform displays all event type and inspection type calendars for the current month.

4. Use the drop-down lists to change the month and year.

5. Use the Show drop-down list to filter event type or inspection type calendars.

6. Click the New Inspection button., Civic Platform displays the inspection type list portlet for the
application.

7. Select an inspection you want to schedule for the application.

8. Click Submit.

Civic Platform displays the inspection schedule page.

9. Specify the inspection scheduling information.

10.Click Submit.
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Civic Platform displays a message indicating you scheduled the inspection successfully.

Social Media Integrations
Civic Platform and Citizen Access provide integrated functionality from two industry leaders in social
media: Facebook and Twitter. This feature enables public users to “like” and “tweet” records, automatically
publishing certain record details – that you specify in the configuration process – on their Facebook and
Twitter pages.

This section guides you through each step in the process:

• Setting up Facebook and Twitter accounts to properly communicate with Accela

• Configuring the scripts and security settings that enable public users to share Accela content on
Facebook and Twitter

• Configuring the social media functionality of “liking” and “tweeting” records from Accela to Facebook
and Twitter.

Because this feature uses HTTP Secure (HTTPS), you must have an HTTPS-enabled security certificate.
HTTPS is a communications protocol that layers specific security measures on top of applications
that you deploy over the internet. HTTPS adds the security capabilities of SSL/TLS to standard HTTP
communications, providing website authentication and protecting against common types of security risks.

Because the Citizen Access web server uses TinyURL functionality, you must ensure that the web server
can successfully connect to www.tinyurl.com before you begin. For example, verify that your firewall
settings on the web server do not prohibit access to the tinyurl website.

Click a topic title below for full details.

Related Links

Example Use Cases

Setting Up the Facebook Integration

Setting Up the Twitter Integration

Configuring Social Media Permissions and Comments

Example Use Cases
A construction contractor and avid social media user is building an addition onto his client’s home. He goes
to his city’s Facebook page and clicks the ACA-Facebook app, completes the permit application, and then
shares the information on his Facebook page, tagging his client and generating “likes” from his and his
client’s Facebook friends.

Public users apply for permits and post the information to Facebook and Twitter by clicking “like” and
“tweet,” keeping their friends and other citizens in the loop on new construction projects, businesses, and
land use information in their area.

Setting Up the Facebook Integration
Before you can begin using the Facebook integration you must follow each of the procedures listed below.
Do not skip any steps unless they are optional.

Topics:
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• Creating Your Agency ACA-Facebook App

• Enabling Authenticated Referrals

• Adding Your Facebook App to Your Agency Page

• Customizing the Facebook Login and Landing Pages

• Configuring Social Media Permissions and Comments

Creating Your Agency ACA-Facebook App
To enable public users to access the services available in your Citizen Access implementation from within
Facebook, you must first create an ACA-Facebook app using the procedure below.

To create your agency’s ACA-Facebook app

1. Go to https://developers.facebook.com.

2. Click Apps.

3. Login with an existing Facebook account or create a new one that you can use specifically for
maintaining your Accela Facebook integration.

If you choose to create a new Facebook account for this purpose, Facebook might require you to
submit a scanned government-issued ID card to verify your identity. Facebook has implemented this
new security measure to protect against fraudulent activities. This security measure is not required if
you log in with an established Facebook account.

4. Click Create New App or Go To App. The button you see depends on whether you have previously
developed any Facebook apps.
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The Create New App window displays.

5. In the App Name field enter a name for your app, using this syntax:

<Your Agency Name> <Page Tab Name> 

Choose a name that meets your agency’s preferred nomenclature, for example, “New York State Online
Services.” This section uses the fictitious name “City of Progress Citizen Access” as an example.

6. The App Namespace field is optional. Leave this field blank for now; you can provide this detail later in
this procedure.

7. Web Hosting is optional. Leave this option blank.

8. Click Continue.

A Security Check displays.

9. Enter the Security Check text in the box provided and Click Submit.

The following message displays.
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10.Decide whether you want to use a mobile phone or a credit card to verify your account.

If you choose the mobile phone option and you previously connected your mobile phone to a different
Facebook account, you must re-establish the connection with your mobile phone on your other
Facebook account. You can only associate a mobile phone number with one Facebook account at a
time.

11.Click Mobile Phone or click Credit Card and complete the process of verifying your account.

12.Return to the Create New App page and click Continue.

A second and final Security Check window displays.

13.Enter the security code in the box provided and Click Submit.

The Apps Settings page displays.
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Figure 40: App Settings

14.Enter information into the following fields, which correspond to the green labels A - K in the sample
screen above. Leave all other fields blank or accept the default values.

Table 130: App Settings Fields

A Click the generic placeholder image to the left of the App Name to upload a logo for your agency. This
image becomes the profile picture for your agency.

B The App ID displays here and is a critical component of your ACA-Facebook app; you must copy and
paste this App ID when you get to of Adding Your Facebook App to Your Agency Page, later in This
section.
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C Click Edit Icon to upload an icon to represent your agency’s ACA-Facebook app. This icon becomes the
icon that users click to access Citizen Access from your agency’s Facebook page.

Basic Info

D The Display Name field displays the name you entered in . Accept this default value.

E In the Namespace field enter the name you want to use for the app’s URL. Enter all lower case letters
with no spaces or special characters. Use the following syntax:

cityofprogress

In this example, entering cityofprogress in the Namespace field creates the following URL: https://
app.facebook.com/cityofprogress

F In the App Domains field enter the server domain for the server where you host your Citizen Access
implementation. Use the following syntax:

 aca.<youragency>.com 

If you are not sure what to enter here you can verify it by checking the URL of the login page for your
Citizen Access implementation.

Select how your app interacts with Facebook

G Expand the Website with Facebook Login section. In the Site URL field, copy and paste the following
site URL text, but change <APP_DOMAIN> in the sample below to your app domain.

https://<APP_DOMAIN>/facebook-aca/socialmedia/facebookportal.aspx?&fb_source=search&ref=ts

When you finish entering the site URL it should look similar to this example:

https://aca.cityofprogress.accela.com/facebook-aca/socialmedia/facebookportal.aspx?
&fb_source=search&ref=ts

You will use this site URL again when you get to fields H and J below.

H Expand the App on Facebook section. Copy and paste the Site URL (G) into the following fields: (H)
Canvas URL (H) Secure Canvas URL

I Expand the Page Tab section. In the Page Tab Name field, enter the text for the link to your ACA-
Facebook app. The text that you enter here becomes the link users click to access Citizen Access from
your agency’s Facebook page. For example, you can enter Citizen Access, Online Services, or any text
you prefer.

J Copy and paste the Site URL (G) to the following fields:(J) Page Tab URL (J) Secure Page Tab URL

K Set the Page Tab Width to Wide (810px)

15.When you finish entering items A - K, Click Save Changes and move on to the next procedure,
Enabling Authenticated Referrals.

Enabling Authenticated Referrals
Authenticated referrals is a Facebook feature that ensures all referral traffic from Facebook to your
application already has a connection to Facebook. With this feature, when users come to your app they
are automatically logged in and, if you configure the option, they receive a prompt to enter any permission
information you configure.

This feature provides the ability for public users to log in to Citizen Access using their Facebook account
credentials; Civic Platform saves the password and establishes a link between Citizen Access and their
Facebook page. Public users can also choose to create a new Citizen Access account and use their
Facebook credentials to set up their Citizen Access account.

After you enable Authenticated Referrals, when a new user clicks your app on Facebook they receive the
Authentication prompt. This dialog requests the permissions specified in the User & Friend Permissions
field described below.
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To enable authenticated referrals

1. Go to https://developers.facebook.com.

2. Click Apps > Edit App > Auth Dialog.

The New Auth Dialog page displays.

3. In the User & Friend Permissions field enter email and user-birthday, as shown in the sample screen.

4. Click Save Changes.

Creating Your Agency Facebook Page
If your agency already has a Facebook page you can skip this section.

1. Go to http://www.facebook.com/pages/create.php and create a Facebook page for your agency, as
follows:

2. Click Company, Organization or Institution.

3. Choose the Category: Government Organization.

4. In the Company Name field enter the name of your agency. For example, “City of Progress.”

5. Click “I agree to Facebook Pages Terms.”

6. Click Get Started.

7. Upload a Profile Picture and Click Save Photo.

8. Enter basic information about your agency and Click Save Info.
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9. Set the Facebook Web Address for your agency and click Set Address.

10.Facebook displays your agency page.

11.Facebook prompts you to “like” your page, add a time line, and provide information to populate your
new page.

12.When you finish populating your agency’s Facebook page, it displays with the Admin Panel active. Click
Hide in the upper-right corner of the Admin Panel to display your page in public user mode, then move
on to the following procedure.

Adding Your Facebook App to Your Agency Page
To add your Facebook App to your agency’s Facebook page:

1. Using Notepad or another text editor construct a URL based on the following example.

https://www.facebook.com/dialog/pagetab?app_id=44090126958236711&next= https://
aca.dev.accela.com/cityofprogress

The syntax for this URL is:

https://www.facebook.com/dialog/pagetab?
app_id=YOUR_APP_ID&next=YOUR_ACA_DOMAIN/YOUR_AGENCY’S_NAMESPACE

a. Change YOUR_APP_ID to the app ID that displays in field B of Figure 40: App Settings.

b. Change YOUR_ACA_DOMAIN to the app domain you entered in field F of Figure 40: App Settings.

c. Change YOUR_AGENCY’S_NAMESPACE to the namespace you entered in field E of Figure 40:
App Settings.

2. When you finish constructing this URL copy it to your clipboard (ctrl + c).

3. Open a new browser tab and then paste the URL into the address field (ctrl + v).

The following page displays.

4. Choose your agency’s Facebook Page and then click Add Page Tab.

5. In Facebook, find your agency’s page; for example, enter City of Progress in the Search field and press
enter.

6. Click the search result that matches your agency’s page.

Your Agency’s page displays with the Citizen Access app.
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7. Click the link to your agency’s ACA-Facebook app to load ACA.

The Citizen Access Login page displays.

8. Sign in with your Citizen Access credentials; Civic Platform saves the password and establishes a
link between Citizen Access and your Facebook page. This one-time process establishes your login
credentials. You can also choose to create a new Citizen Access account and use your Facebook
credentials to set up your Citizen Access account.

Customizing the Facebook Login and Landing Pages
You can easily customize the text and icons on the login page and landing page public users see when
they click the ACA-Facebook app in Facebook. This process is illustrated in the sample screen below.

To customize the Facebook Login and home pages

1. Sign in to Citizen Access Admin: Go to Civic Platform > Admin > Setup portlet > Administration > ACA
Admin.

2. Navigate to General Settings > Social Media in the left pane.

3. Click one of these options:

• To customize the Login page text and its icons, click Facebook Account Login in the left pane.

• To customize the page that displays your agency’s Citizen Access services, click Facebook Home
Page in the left pane.

Your Facebook app displays in Citizen Access.
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4. Refer to Customizing Text and Images on Web Pages in the Citizen Access Administrator Guide for
detailed instructions on how to modify the text and images.

Setting Up the Twitter Integration
Civic Platform’s integration with Twitter enables agency users to post Twitter comments, also known as
“tweets,” from within the Civic Platform interface, by triggering certain EMSE events. For example, you
can configure the EMSE event, ApplicationSubmitAfter, to automatically tweet record details upon record
creation.

Before you can begin using the Twitter integration you must follow each of the procedures listed below. Do
not skip any steps unless they are optional.

Topics

• Enabling Function ID 0347-Social Media

• Creating a Twitter Account for Your Agency

• Generating the Access Token Key and Secret

• Customizing the Twitter Account Name

• Configuring Social Media Permissions and Comments

Enabling Function ID 0347-Social Media
Before you can configure and use this feature, you must enable it by setting Function ID 0347-Social
Media. For complete instructions on setting a Function ID, refer to “Working With FIDs and Standard
Choices” in the Accela Civic Platform Configuration Reference.
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Creating a Twitter Account for Your Agency
Establish a Twitter account that represents your agency if your agency does not already have one. The
Twitter account you create for your agency enables users to tweet information from within Civic Platform,
using this agency-wide, group Twitter account.

To create an agency-wide Twitter account

1. Go to https://dev.twitter.com.

2. Choose a Twitter name for your agency that represents a public image that citizens can recognize and
identify with your agency.

The Twitter account you configure in this step becomes the Twitter account you use for generating the
access token key and secret in the next procedure.

3. Complete the registration process.

Generating the Access Token Key and Secret
Generate an access token key and an access token secret from Twitter and register them in Civic Platform.
The token key and the token secret become the login credentials users enter to post Twitter messages
from within Civic Platform.

Note:

All users at the same Civic Platform website share the same access token key and access token secret.
Users post messages to the same Twitter account that the administrator uses to generate the access token
key and access token secret.

To generate the access token key and access token secret

1. Go to Civic Platform Administration > System Tools > Social Media.

Civic Platform displays the Social Media administration portlet.

2. Click Generate.

Civic Platform displays the Access Token Generator page.

3. Click Get PIN Code.
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Civic Platform redirects you to the Twitter authorization entry page.

4. Enter your Twitter account credentials, and then click Authorize app.

Twitter provides the PIN code.

5. Enter the PIN code in the Access Token Generator page, and then click Generate.

Civic Platform displays the access token key and access token secret.

6. Return to the Social Media administration portlet, and enter the Twitter connection details.
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Access Token Secret The access token secret that displays in the Access Token Generator page.

Access Token Key The access token key that displays in the Access Token Generator page.

Proxy Host Optional. The host address of the proxy server that you plan to use for posting
tweets.

Proxy Port Optional. The port of the proxy server that you plan to use for posting tweets.

7. Click Save.

Civic Platform saves the access token secret and access token key for posting tweets.

Customizing the Twitter Account Name
To change the Twitter account name from Civic Platform to your agency’s Twitter account name, after
generating your access token key and access token secret in Twitter, you must configure the related
Standard Choice.

Table 131: Standard Choices Configuration

Name New/
Existing

Level Standard
Choice
values

Value Description Description

SOCIAL_
MEDIA_
SETTINGS

New Agency TWITTER CONSUMER_KEY=*****,CONSUMER_SECRET=
*****

The Standard Choice registers
the consumer key and consumer
secret you get from the Twitter
site. Replace the “*****” in the
Value Desc with the actual
consumer key and consumer
secret strings.

Configuring EMSE Methods for Twitter Integration
Civic Platform uses EMSE methods for posting tweets. With the methods, users can read and post Twitter
comments from within Civic Platform.

The following EMSE method posts messages to twitter:

ScriptResult post(String providerCode, String url, Map<String, Object>
 params)

The following EMSE method generates an empty Map object into which you can put the parameters (

params)
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:

Accela Automation.oAuthClient.initPostParameters()

Sample Script and Sample Tweet
Topics:

• Sample POST Request Script

• Sample Tweets Posted from Civic Platform

Sample POST Request Script
This sample script posts the message “A message from Accela!” to Twitter:

//Sample of Post request 
function updateTwitterStatus() 
{ 
var client = Accela Automation.oAuthClient; 
var oauthProviderCode = 'TWITTER'; 
var url = 'https://api.twitter.com/1/statuses/update.json'; 
var params = client.initPostParameters(); 
params.put('status', 'A message from Accela!'); 
var scriptResult = client.post(oauthProviderCode, url, params); 
if (scriptResult.getSuccess()) 
         { 
Accela Automation.print(“Success: “ + scriptResult.getOutput()); 
      } 
else 
     { 
Accela Automation.print(“Failure: “ + scriptResult.getErrorMessage()); 
         }           
} 

Sample Tweets Posted from Civic Platform
Associate the Sample POST Request Script with the ApplicationSubmitAfter event. When users create a
new application and save it, it triggers the ApplicationSubmitAfter event. The following tweets display on
the Twitter account for which you configured the access token key and secret.

Configuring Social Media Permissions and Comments
At a minimum, users must have permission to view a record to be able to “like” and “tweet” a record. You
can further refine who has the ability to “like” and “tweet” records by configuring Social Media Settings in
Citizen Access Admin, using the procedure below.

Users who have permission to “like” and “tweet” records see “like” and “tweet” buttons on records they
have access to in Citizen Access. Clicking “like” posts record details to the user’s Facebook page. Clicking
“tweet” posts record details to their Twitter page. You can configure the record details and the text that
display as comments on Facebook and Twitter, as follows.

To configure social media permissions and social media comments
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1. Sign in to Citizen Access Admin: Go to Civic Platform > Admin > Setup portlet > Administration > ACA
Admin.

2. For each module where you are implementing social media functionality, select the module and then
click Module Settings under General Settings.

3. Scroll down to Social Media Settings.

4. Choose which users can “like” and “tweet” records:

• All Citizen Access Users

• Record Creator Only

• None

5. Next, configure the comments that display when a user clicks “like” or “tweet” on a record. In the Shared
Comments field, shown in the sample screen below, construct a brief comment containing the record
detail variables and the text that you want to display on user’s Facebook and Twitter pages.
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Part 5: Automated Data Processing
Civic Platform provides functions to automate data processing.

Related Links

Processing Sets

Setting Up Random Audits

Configuring Audit Logs

Processing Batch Jobs

Importing and Exporting Settings

Processing Sets
Sets provide a way to quickly and efficiently process groups of records in bulk. For example, you can use
sets to organize multiple applications or multiple service requests into groups for batch processing. You
can use sets to simultaneously update the workflow for several applications or service requests at a time.
For example, you can use a set to simultaneously update the Architect for several applications.

You can create sets of many types of records, not just applications and service requests. There is no
limit to the number of records you can include in a set. Civic Platform allows administrators to extend set
functionality to multiple types of sets for the agency. A group of records, addresses, parcels, or licensed
professionals can also make up a set for batch processing.

You can enhance basic set functionality by including the ability to incorporate conditions, comments, or
the application of licensed professionals, owners, and/or contacts to a set. Other functionality includes
generating reports and running scripts for record sets.

You can also create sets of sets, which enables you to group multiple sets together, and then perform fee
analysis and payment processing for multiple sets simultaneously.

Click a topic title below for full details.

Related Links

Configuring Basic Set Functionality

Locating Records in a Set

Exporting a Set Member List to CSV

Extending Set Functionality

Creating Records from a Parcel Set

Generating Reports for Sets

Enabling Random Audits of Sets

Configuring Set of Sets Functionality

Configuring Set Types
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Configuring Basic Set Functionality
You can configure basic set functionality to enable tabs, buttons, and record details, for example, by setting
FIDs for the following set types:

• Record sets

• Parcel sets

• Address sets

• Licensed professional sets.

To enable this functionality, set the applicable FIDs. Refer to the Accela Civic Platform Configuration
Reference.

Locating Records in a Set
The Sets portlet has a Record ID filter, enabling you to query a set member list to locate a record in the set,
then modify the record or delete it from the set. This filter enables you to query the set member list using
both Record ID and Alt-ID.

Exporting a Set Member List to CSV
You can export a set member list to a CSV file by navigating the Set Member tab and then selecting the
CSV Export option, as shown below.
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Extending Set Functionality
You can enhance the basic set functionality of record, parcel, address, and licensed professional set types
by including the ability to incorporate conditions, comments, and the execution of scripts on set members.

To implement the functions described in this section, refer to "Processing Sets' in theCivic Platform User
Guide.

Topics

• Enabling Set Conditions

• Enabling Comments

• Executing Set Scripts

• Applying Owners to Sets

• Applying Licensed Professionals to a Record Set

• Applying Contacts to a Record Set

• Changing the Status in Record Sets

Enabling Set Conditions
Civic Platform can simultaneously associate a condition with record, parcel, address, and licensed
professional set members, and provide the same owner functionality for the set members as it does for
individual records, parcels, addresses, and licensed professionals. Civic Platform displays these conditions
on the Conditions tab for the set.

Civic Platform applies and enforces conditions on all Civic Platform data, regardless of whether your
agency stores address, parcel, owner (APO) or licensed professional data in a Civic Platform database or
external APO database.

Enabling Comments
You can enable a set comment field so that users can broadcast information regarding problems or special
information applicable to the set members. Civic Platform displays these comments on the Comments tab
for the set. You can configure set comments for record, address, and licensed professional set types. You
can configure a spell checker to display under all text fields.
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Executing Set Scripts
Civic Platform provides the ability to run a pre-configured EMSE (Event Manager and Script Engine) script
on record, parcel, address, and licensed professional set types. You configure the applicable Standard
Choices and Standard Choices Values for each set type in order to populate the drop-down list of available
EMSE scripts from the Execute Script button in each set portlet.

Applying Owners to Sets
Civic Platform can simultaneously associate an owner with record and parcel set members, and provide
the same owner functionality for the record and parcel set members as it does for individual records and
parcels. Civic Platform displays these owners on the Owners tab for the set.

Applying Licensed Professionals to a Record Set
Civic Platform can simultaneously associate a licensed professional with record and parcel set members,
and provide the same licensed professional functionality for the record and parcel set members as it does
for individual records and parcels. Civic Platform displays these licensed professionals on the Licensed
Professionals tab for the set.

Applying Contacts to a Record Set
Civic Platform can simultaneously associate a contact with record set members, and provide the same
contact functionality for the record set members as it does for individual records. Civic Platform displays
these contacts on the Contacts tab for the set.

Changing the Status in Record Sets
Civic Platform can simultaneously associate a status with record set members, and provide the same
status functionality for the record set members as it does for individual records. Civic Platform displays the
status on the Status tab for the set.

Creating Records from a Parcel Set
Based on the specified parcel condition and status criteria for a parcel set, Civic Platform can create
records and record sets.

To create records from parcel sets, refer to "Processing Sets" in theAccela Civic Platform User Guide.

Generating Reports for Sets
Civic Platform can simultaneously associate reports for record, parcel, address, and licensed professional
set members, and provide the same viewing and printing report functionality for set members as it does for
individual records, parcels, addresses, and licensed professionals. When implemented, the specified report
runs one time for each set member.

To implement this function, manually assign reports in the Record Details portlet to the set member list
portlet in Report Manage. Set the session variables shown in Table 132: Session Variables for Set Reports
for Report Manager for each record set.

Table 132: Session Variables for Set Reports for Report Manager

Set Type Variables

Record Sets SETID ($$setID$$)CAPID($$capID$$)

Parcel Sets ParcelID ($$parcelID$$) SETID ($$setID$$)

Address Sets AddressID ($$addressID$$)SETID ($$setID$$)
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Set Type Variables

Licensed Professional Sets LicensedProfessionalID ($$licensedprofessionalID$$)SETID ($$setID$$)

For more information about Report Manager, see Report Manager for more information about Session
Variables, see Report Manager.

Enabling Random Audits of Sets
You can configure how frequently Civic Platform audits a record or percentage of records, specify the level
at which to perform the audit (record type-level, module-level, or agency-level), and specify a maximum
number of records each audit can return.

Agency users can audit a randomly selected set of permits, applications, work orders, or other types of
records. Civic Platform selects the set to audit based on specific parameters you define. After generating
the set, you can filter the set, run a report, execute a script, and otherwise audit the set.

For more information about configuring random audits, see Setting Up Random Audits.

Configuring Set of Sets Functionality
You can configure set of sets functionality to combine similar sets (for example, record sets) into a set of
sets to facilitate convenient ways for batch analysis and processing. You use the “set of sets” functionality
primarily for accounting functions.

Configuring Set Types
Set types play an important role in working with sets because set types define which reports and scripts
are available, and who has permission to run those reports and scripts.

Note:

You must create the reports and scripts you need before you can associate them to a set type in this portlet.
See Report Manager for more information.

Topics

• Accessing the Set Type Portlet

• Creating a New Set Type

• Defining Set Status Values

• Setting Permissions

• Assigning Scripts

• Searching for a Script

• Set Type Portlet Fields and Buttons

Accessing the Set Type Portlet
Use the Set Type portlet to create and manage set types.

1. Open the Civic Platform Admin portlet.
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2. In the Setup menu, choose Application > Set Type.

The Set Type portlet displays.

Creating a New Set Type

1. Access the Set Type portlet (see Accessing the Set Type Portlet).

2. Click New.

A blank Set Type form displays.

3. Complete the fields with available data:

Set Type Name Enter the name of the set type in this box.

Reports Choose the reports you want to be able to run for this set type. Do so by clicking
the Select button to the right of the Reports field label. You can select more than
one report.

Comments Enter commentary about the set type in this field.

4. Click Submit.

Civic Platform creates the new set type and a new row displays in the set type portlet. Additional tabs
for the new set type are available. Use the new set types to define set status values (see Defining Set
Status Values), set permissions to use the set type (see Setting Permissions), and select scripts to
associate with the new set type (see Assigning Scripts).
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Defining Set Status Values

1. Create a new set type or open an existing set type by clicking the set type name hyperlink.

The Set Type detail portlet displays.

2. Click the Set Status tab.

The Set Status page displays.

3. Click New.

A blank row appears.
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4. Enter a status value as you want it to appear in the Set Status drop-down on the Set tab.

5. Click Submit to save.

6. Repeat steps 3 through 5 to add additional status values.

Setting Permissions
You can add one or several assignment choices. If an individual user does not have permission to use a
set type, the set type does not appear to the user in the Set Type drop-down list on the Set tab.

To set permissions

1. Create a new set type or open an existing set type by clicking the set type name hyperlink.

The Set Type detail portlet displays.

2. Click the Permission tab.

The Permission page displays.

3. Click Assign to display a menu of assignment choices.

A list of available choices displays.

4. Select one of the options from the Assign menu.

5. Select the agency, module, group, department, or user you want to add to the Permission list.

6. Click Submit.

The selected agency, module, group, department, or user displays on the Permission tab.

7. Repeat steps 3 through 6 to grant another agency, module, group, department, or user with permission
to access the current set type.

Assigning Scripts
You can assign scripts directly to a set type. When a user with permission to work with the set type opens
a set record in Civic Platform, the user can run the associated scripts directly from the Set portlet.

To assign a script
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1. Create a new set type or open an existing set type by clicking the set type name hyperlink.

The Set Type detail portlet displays.

2. Click the Scripts tab.

The Scripts page displays.

3. Click Look Up to locate script(s) you want to associate to the current set type.

4. Enter full or partial criteria to locate the script you need and click Submit or press Enter.

A list of scripts meeting your search criteria displays.

5. Select each script you want to associate to the current set type, then click Select.

Civic Platform associates the selected scripts to the set type.

Searching for a Script
If you have associated many scripts to a single set type, you can use Search to locate a particular script.

To search for a script

1. Create a new set type or open an existing set type by clicking the set type name hyperlink.

The Set Type detail portlet displays.

2. Click the Scripts tab.

The Scripts page displays.

3. Click Search.

4. Enter search criteria and then click Submit.

Search results meeting your criteria display.
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Set Type Portlet Fields and Buttons
The following table lists and defines the fields and buttons available in the Set Type portlet. Civic Platform
groups fields and buttons by secondary tab.

Table 133: Set Type Portlet Fields and Buttons

SET TYPE TAB

Comments Enter comments about the current set type.

Default Set Status You can define a default set status as needed by selecting an option from the
drop-down. When you create a new set using the current set type, Civic Platform
automatically applies the default set status.

Note:

Before you can define a default set status, you must create status options
on the Set Status tab.

Reports Click the Select button to the right of the Reports field label to access a list of
reports you can associate with the current set type. Select one or more reports as
needed.

Reset Click this button to restore the displayed fields to the last saved values.

Set Type Name Enter the name of the set type in this field.

Submit Click this button to save new or modified data on this tab. After you Click Submit,
you cannot use the Reset button to restore any previous data.

SET STATUS TAB

Delete Click this button to delete selected status values.

New Click this button to create a new status value.

Status Maintenance/Status Enter the set type status exactly as you want it to appear in the Set Type Status
drop-down list.

Submit Click this button to save new or modified data on this tab.

PERMISSION TAB

Assign Click this button to view a menu of options you can choose from in assigning
permission to use a set type. Available options include: Assign Agency, Assign
Module, Assign Group, Assign Department, and Assign User.

Delete Click this button to delete selected assignments.

SCRIPTS TAB

Delete Click this button to delete selected scripts from the list, thereby disassociate the
script and the set type.

Description Enter a concise description for a selected script in this field.

Look up Click this button to search for scripts you want to associate with the current set
type. See Assigning Scripts for details.

Script Code This read-only field displays the code, or name, of a chosen script

Search Click this button to search the list of currently associated scripts.

Submit Click this button to save new or modified data on this tab.
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Setting Up Random Audits
You can determine how frequently you perform audits on a record or percentage of records, specify the
level at which you perform the audit (record type-level, module-level, or agency-level), and determine the
maximum number of records each audit can return.

Click a topic title below for full details.

Related Links

Setting Record Type Audit Frequency

Configuring Reports for Random Audit Sets

Setting Record Type Audit Frequency
For more information about creating and editing Random Audit groups, see “Random Audits” in the Accela
Civic Platform User Guide.

To set a record type audit frequency

1. Access the Record Type Administration portlet (Accessing Record Type Administration).

2. Select the Portlet and the Record Type for which you want to set the audit frequency.

Civic Platform displays the Record Type Information.

3. Click the Setting option, and scroll to the Audit Frequency section.
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4. To designate the interval between audits for a record type, enter the number of months in the Audit
Frequency column. You can enter a number under any of the record type levels. For example, enter 3
in the Audit Frequency field for the Licenses record type to prevent the audit of licenses within a three
month period.

When you edit any level of a record type, Civic Platform automatically syncs the audit frequency for
all related record types. For example, if you modify the audit frequency for Licenses to 18 months for
Licenses/Medical/Pharma/Pharmacist, the audit frequency for Licenses/Medical/Pharma/Renewal also
changes to 18 months.

5. Click Save.

Configuring Reports for Random Audit Sets
After you have enabled the random audit feature, agency users can generate audit sets and can run
reports for the sets. You must configure the reports that are available to run on random audit sets.

This section provides instructions for creating reports specifically for the random audit portlet. For more
general information about reports, refer to Report Manager.

To configure a random audit report

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Either locate an existing report to assign to the random audit portlet or create a new report.

• To assign an existing report to the random audit portlet, use the navigation tree to locate the report.

1. Use the plus (+) and minus (-) buttons to find reports by category, name, permission, portlet, or
workflow.

2. When you have located the report, click the report’s name. Proceed to step 4.

The report’s details display in the report portlet.

• To create a new report, enter the new report information in the blank Report Detail form that displays
before you select a report to view from the navigation tree. Or, right-click a category of the navigation
tree, and then click New Report.

1. Complete the fields that display. For a description of the fields, see Table 134: Report Detail.

2. Click Submit to save the report detail.

Civic Platform saves the report detail and adds the report to the selected category in the
navigation tree.
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3. Click Preview to preview the report.

If the report contains required parameters Civic Platform displays a parameter prompt window, as
illustrated below:

4. Enter the report parameters if required.

For information on adding report parameters, see Report Manager.

Civic Platform displays the report preview in another window.

3. To assign the desired report to the random audit portlet, click the Portlets tab.

Civic Platform displays the list of portlets to which the report belongs.

4. Click New.

Civic Platform displays the form to select a portlet to assign to the report.



 | Part 5: Automated Data Processing | 598

5. Complete the following fields:

Portlet Name Choose List - Audit Set Member List from this drop down menu.

Module Choose a module from this drop down list. The report is available in the chosen portlet
for all users with access to this module.

Display Choose Single Window to display the report in one pop up window, and choose
Multiple Windows to display each report in its own pop up window.

6. Click Submit.

Civic Platform saves your changes and adds the report to the list of portlets to which the report belongs.

When users hover over the Reports button in the Random Audit portlet, the report’s name displays.
When users click the report’s name, the report runs on the set.

Table 134: Report Detail

Category Select the appropriate category for the report. Civic Platform uses this category to
organize and display the report for the user in the Reports Portlet or in form and list
portlets.

Default Printer Select the printer you want to use. Entering a default printer automatically prints a
report when a user runs it and notifies the user that printing has occurred.

To add a default printer to the list, see Report Manager.

Description Enter a description of the report. For example, enter “The inspection list report displays
the total number of inspections within a specific date range, ordered by inspection
type.”

EDMS Select the Electronic Document Management System (EDMS) you want to save the
report to. EDMS is available for all report services and types with the exception of client
executables. For information on adding or removing the EDMS options in the drop-
down, refer to the Accela Civic Platform Configuration Reference.

EDMS Object Select the Electronic Document Management System (EDMS) object you want to save
the report to. When you save a report it displays under the Documents or Attachments
tab for the associated object. Options include: Record, Parcel, Workflow, and Asset
Inspections. EDMS is available for all report services and types with the exception of
client executables.

Name Enter the name you want to display for the report in the Reports Portlet or Report
Menu.

Output Format Select the output format of the report. The options depend on the formats the report
service supports. Options include Adobe Acrobat (.pdf), Microsoft Word (.doc),
Microsoft Excel (.xls), Rich Text Format (.rtf), and CSV comma-delimited (.csv). If
you leave Output Format blank, Civic Platform uses the default viewer for the report
service. For information on updating output formats,Report Manager.
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Print Only Select Yes or No from this drop-down list to indicate whether you want to print the
report.

Report Link Click the Select Report Link to choose the reports available in the report directory
on the server. To expand the reports list, select Expand Reports from the menu. To
contract the list to display a small list of reports, select Contract Reports from the
menu.

Reports Portlet 1
Reports Portlet 2
Reports Portlet 3
Reports Portlet 4
Reports Portlet 5

Select the Reports portlet where you want the report to appear. A report can appear on
more than one Reports portlet. For instructions and information on where the Reports
portlets appear or how to make them visible, see Designing Forms for Portlets.

Report Service Select the report service to use for the specified report. The options selected in the
drop-down filter the reports that display in the Report Link window. For information on
how to update existing or add additional report services, see Report Manager.

Save to EDMS Select whether or not you want to save the report to the Electronic Document
Management System (EDMS) specified in the EDMS field. Choose Yes to
automatically save the report to EDMS. Choose No to not save the report automatically
to EDMS.

Send in Email This option becomes active based on the report format you select in the Output
Format box. To activate this option, you must select an output format that is not the
default format.

Select this option to allow users to send a report to application contacts. When you
select this option, you must also designate a corresponding set of email recipients from
the associated drop-down list. The record contacts in the drop-down list values refer to
the contacts for the session application. Drop-down list values include:

Attach all Record Contacts

The application contacts and licensed professionals. When you select this option and
users run a report, a Send in Email button appears on the report preview page. Users
click this button to select email recipients.

Attach Primary Record Contacts

The application primary contacts and licensed professionals. When you select this
option and users run a report, a Send in Email button appears on the report preview
page. Users click this button to select email recipients.

Auto-Attach all Record Contact

The application contacts and licensed professionals. When you select this option and
users run a report, Civic Platform automatically sends an email to application contacts
and licensed professionals.

Auto-Attach Primary Record Contacts

The application primary contacts and licensed professionals. When you select this
option and users run a report, Civic Platform automatically sends an email to primary
application contacts and licensed professionals.

You can define email subject and body under the EMAIL_REPORT_SUBJECT and
EMAIL_REPORT_CONTENT content customize types. The Send in Email field
supports multiple languages.

For more information on working with the content customize form, see Working with
Communication Manager .

To configure email reports for Citizen Access Users, contact the Accela services
implementation team. These scripts do not contain any event logic and an
implementation specialist must review them prior to you using them. The available
event scripts are: SendReportInEmail-1 and SendReportInEmail-2

Template Click Browse to select the Rich Text Format (.rtf) template report. The template can be
up to 5MB. When you save a template type report, the template name displays next to
the template label. This field displays only for the RTF report service type.

Type Select the report type or the report engine used to launch the report. This includes
Crystal, Oracle, Microsoft Reporting Services, and Accela Report Writer.
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Configuring Audit Logs
Civic Platform enables audit log functions when you create a new agency. To set up this feature you must
be a super administrative user who can access their Agency Profile. For information on how to become a
super agency administrator, please contact your Accela implementation specialist. On-premise customers
can find the agency profile setup information in the "Agencies and Functions" section of the Civic Platform
On-premise Administrator Supplement.

Click a topic title below for full details.

Related Links

Configuring the Inspection Detail Audit Log

Configuring the Record Status History

Configuring the Record List Audit Log

Configuring the Receipt Print Audit Portlet

Configuring the Inspection Detail Audit Log
To configure an inspection detail audit log

1. Access the Audit Log portlet (Accessing the Audit Log Portlet).

2. Select Inspection Detail from the View drop-down list.

Civic Platform displays the audit log elements for inspection detail.
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3. Select the inspection detail elements you want to include in the Inspection Detail audit log. You can also
click the Element check box to select all available elements. You must select at least one inspection
detail element for the audit log.

For a complete list of inspection detail elements, see Table 135: Inspection Detail Audit Log Fields.

4. Click Save.

Civic Platform displays a confirmation message.

Table 135: Inspection Detail Audit Log Fields

Alternate ID An identification other than the main identification, such as a parcel ID.

Department The department responsible for the inspection modification, such as Building or Code
Enforcement.

Inspection Date The inspection's schedule date.

Inspection Type The type of inspection, such as Building, Electrical, or Insulation.

Inspector The inspector assigned to conduct the inspection.

Record ID The application identification number.

Record Type The type of application, such as a Commercial or Residential Building Permit.

Request Comment Any comments related to the inspection. These comments can be user comments or
those that populate based on predefined Standard Comments.

Request Date The request date for the inspection.

Requestor The name of the individual who requested the inspection.

Result Comment Any comments related to the inspection. These comments can be user comments or
those that populate based on predefined Standard Comments.

Scheduled Date The inspection’s scheduled date.

Status The inspection status, such as Approved, Pending, or Denied.

Submit Date The date when a user submitted the application.

Configuring the Record Status History
When a user clicks the View Log button in the Application History tab of a record, the Record Status
History displays, and details all changes to an application’s status.

Figure 41: Record Status History View Log Button

For example, if a user deletes a status that they entered in error, the deleted status displays in the audit
log, as shown in the screen shot below.

Note:

If a user changes the status for a record and then attempts to delete the most recent status, Civic Platform
displays a warning message. The message states: “You are deleting the latest history, which causes an
inconsistency between the current status and the latest history record. Do you want to continue?” Click Yes
to delete the latest history. Click No to return to the working area without deleting the status history entry.
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Figure 42: Record Status History Audit Log

To configure a Record Status History audit log

1. Access the Audit Log portlet (Accessing the Audit Log Portlet).

2. Select Record Status History Form from the View drop-down list.

Civic Platform displays the audit log elements for the Record Status History Form.

3. Select the Record status history elements you want to include in the Record Status History audit log.
You can also click the Element check box to select all available elements. You must select at least one
element for the audit log.

For a complete list of record status history form elements, see Table 136: Record Status History Audit
Log Fields.

4. Click Save.

Civic Platform displays a confirmation message.

Table 136: Record Status History Audit Log Fields

Action By The individual responsible for the application status modification.

Action by Department The department responsible for the application status modification, such as Pending or
Open.

Comment Any comments related to the application status history update. The comments that
display in the audit log can be those a user entered manually or those that Civic Platform
populates by predefined Standard Comments.

Status The status of the inspection record inspection status, such as Approved, Pending, or
Denied.

Status Date The date Civic Platform applied the current status.

Status History
Number

A number automatically generated to identify and track the status history changes.
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Configuring the Record List Audit Log
The Record List audit log displays when a user clicks the View Log button in the Building portlet as
illustrated in Figure 43: Record List View Log Button. When a user clicks the View Log button, a page
displays details about user actions and the records affected.

See Figure 43: Record List View Log Button for an example view of the Record List audit log.

Figure 43: Record List View Log Button

Figure 44: Record List Audit Log

To configure a Record List audit log

1. Access the Audit Log portlet (Accessing the Audit Log Portlet).

2. Select Record List from the View drop-down list.

Civic Platform displays the Record List audit log elements.

3. Select the record list elements you want to include in the Record List audit log. You can also click the
Element check box to select all available elements. You must select at least one record list element for
the audit log.
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For a complete list of record list elements, see Table 137: Record List Audit Log Fields.

4. Click Save.

Civic Platform displays a confirmation message.

Table 137: Record List Audit Log Fields

Alternate ID An identification other than the main identification, such as a parcel ID.

Record ID The application identification number.

Record Type The type of application, such as a Commercial or Residential Building Permit.

Status The record status, such as Deleted.

Configuring the Receipt Print Audit Portlet
You can configure the Receipt Print Audit portlet to enable users to view which users printed receipts, the
receipt type, receipt number, and the date the user printed the receipt.

You must enable FID-0324 to enable access to the Receipt Print Audit portlet. Refer to the Accela Civic
Platform Configuration Reference for details on enabling FIDs. After you enable this FID users can access
the portlet from Setup Administration > Finance > Receipt Print Audit. The portlet displays as follows:

Processing Batch Jobs
Batch jobs enable you to reduce your workload by automating repetitive tasks for multiple records all at
once, during regularly scheduled intervals.

You can schedule batch jobs to do a variety of tasks, including synchronizations with legacy Accela GIS or
the Index server.

Click a topic title below for full details.

Related Links

Working with Batch Jobs

Manually Executing a Batch Job

Terminating a Batch Job
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Viewing the Batch Job Log

Working with Batch Jobs
Topics

• Creating Batch Jobs

• Editing a Batch Job

• Deleting a Batch Job

• Searching for a Batch Job

Creating Batch Jobs
Civic Platform supports a variety of batch jobs including: asset/GIS synchronization, index server/
application server synchronization, email notification, PM schedule work order generation, geotagging,
inspection routing, and asset calendar index rebuilding. Please review the topics in this section for
instructions on how to set up batch job functionality.

Topics

• Creating a PM Schedule Batch Job

• Creating a Global Search Index Batch Job

• Creating an Asset GIS Sync Batch Job

• Creating a Batch Job for Expired License Email Notifications

• Creating a Proxy User Process Batch Job

• Creating a Script Batch Job

• Creating a Geotagging Batch Job

• Creating a Batch Job for Rebuilding Asset Calendar Index

• Creating an Optimized Inspection Route Batch Job

Creating a PM Schedule Batch Job
You can create a batch job that automatically generates work orders in advance of a scheduled
preventative maintenance. The batch job generates all work orders associated with the PM schedule in
a time frame you determine. Schedule the batch job to correspond with the PM schedule so that Civic
Platform generates work orders at the same time interval as the PM schedule.

To create a new preventative maintenance schedule batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

Civic Platform displays the New Batch Job portlet.

3. Complete the following required fields:

Name Enter an intuitive name for the batch job.
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Description Enter a brief description of the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, no matter whether the job is successful or not. You can configure the
email template named NOTICE_OF_BATCH_JOB_COMPLETED to customize the
notification. For information about how to edit an email notification template, see
Working with Communication Manager .

Job Server Select the server for running the batch job.

Job Type Select job type “System” from this drop‑down menu.

Service Category After you select job type “System” from the Job Type drop‑down menu, the Service
Category drop‑down menu displays. Select the batch job you want to create, in this
example, PM Schedule.

4. Click Submit.

Civic Platform creates the batch job and then displays the Batch Job Detail portlet.

5. Associate PM Schedules to the batch job by completing the following steps:

a. Select the PM Schedule option from the Service Category drop‑down menu.

Civic Platform displays the New PM Schedule Batch Job portlet.

b. Click the PM Schedule tab.

Civic Platform displays the PM Schedule List tab.

c. Click Look Up.

Civic Platform displays the PM Schedule Search portlet.



 | Part 5: Automated Data Processing | 607

d. Complete any fields that display. For a description of the fields, see Table 139: Batch Job PM
Schedule Fields.

e. Click Submit.

Civic Platform displays a list of PM Schedules that match your search criteria.

f. Click the PM Schedules you want to add to the batch job.

Select only active PM Schedules you have not already assigned to the batch job. Otherwise, an
error message displays.

g. Click Select.

Civic Platform associates the PM Schedule(s) to the batch job.

h. To remove a PM Schedule from a batch job, select it and click Delete.

6. Define the Job Schedule by completing the following steps:

a. Click the Job Schedule tab.

Civic Platform displays the Job Schedule portlet.
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b. Complete the following fields as described in Table 138: Job Schedule Field Descriptions.

c. Click Save.

Civic Platform saves the batch job.

d. Table 138: Job Schedule Field Descriptions

End Date If you select a value other than Once in the Frequency field, the End Date field
activates. Enter the date on which the batch job stops running or select a date by
clicking on the data picker beside the field.

Frequency Select the frequency with which the batch job runs from this drop‑down menu. Batch
jobs can run once, daily, weekly, monthly, or yearly.

PM Generate PM Generate is a required field that enables you to specify how far in advance the
batch job generates work orders. Enter a number in the first field, then select Days,
Weeks, Months, or Years from the drop‑down menu in the second field.

For example, to generate work orders two weeks in advance of the PM Schedule
batch job, enter 2 in the numeric field and select Weeks from the drop‑down menu.
Or, enter 15 in the numeric field and select Days from the drop‑down menu.

Schedule Status Use this drop‑down menu to turn a batch job on and off. Select Active to activate
the batch job. Select On Hold to deactivate the batch job and save its information.

Start Date Enter the date on which the batch job starts or select a date by clicking on the data
picker beside the field.

If you set a batch job Schedule Status to Active but do not specify a Start Date, an
error message displays when you try to save the batch job.

Start Time Determine the time of day at which the batch job begins running by selecting hour,
minute, and a.m./p.m. from drop‑down menus.

If you set a batch job Schedule Status to Active but do not specify a Start Time, an
error message displays when you try to save the batch job.

Time Out (seconds) Enter the number of seconds a batch job attempts to run before timing out.

Table 139: Batch Job PM Schedule Fields

Asset Group Enter the Asset Group Code.

Asset ID Enter the Asset ID of an asset that belongs to the asset type you are looking for.

Asset Type Enter the name of the asset type you are looking for.

Comments Enter any comments associated with the maintenance schedule.

Generate Single Work
Order for All Addresses

Select this option to create a work order for each asset address linked to this PM
schedule. Otherwise, the PM schedule creates a single work order for all addresses.
This option is not active if you select the Include Addresses in Asset’s Work Order
option.
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Generate Single Work
Order for All Assets

Select this option to create a work order for each asset linked to this PM schedule.
Otherwise, the PM schedule creates a single work order for all linked assets.

Generate Work Orders
for Child Assets up to n
level(s)

Select this option to create work orders for linked assets and their child assets up to
three levels.

Generate Work Order if
Previous One Opened

Select this option to allow the PM schedule to create a work order for an asset that
has a previous work order still open.

Include Addresses in
Asset’s Work Order

Select this option to include the addresses linked to the PM schedule in asset work
orders created by the schedule.

Include Child Assets
in Parent item’s Work
Order

This option becomes active when you check the Generate Work Orders for Child
Assets up to n level(s) box. Select this option to create one work order for a parent
asset and its child assets. Otherwise, each child asset receives a work order.

Link Asset Addresses
to Work Orders

Check this box to show an asset’s addresses in work orders created for that asset.

Primary Only This option becomes active when you check the Link Asset Addresses to Work
Orders box. Check this box to show only an asset’s primary address in work orders
generated by this PM schedule.

Record Status Select the status of the record.

Schedule Name Enter a unique name to identify the schedule.

Schedule Status Use this drop-down list to select the status of the scheduled maintenance. Example:
Active or Expired. The status controls whether or not the maintenance schedule
executes a work order. If the status is active, Civic Platform generates a work order.
If the schedule's status is not active, Civic Platform does not execute a work order
after the expiration date.

Template Select the name of the work order template used for the schedule.

Time Interval Enter the number of days/weeks/months/years between work orders generated for
scheduled maintenance tasks.

Trigger By Enter the date you used as the basis of the next maintenance due date. You can set
this field to the Opened Date, Scheduled Date, or Completed Date of the last PM
work order.

Trigger Date Enter the first date that the scheduled maintenance is due.

Usage Interval Enter the usage interval between scheduled maintenance activities. For example,
the number of miles or runtime hours. If you specify a usage interval, Civic Platform
checks the usage interval prior to the time interval. If you did not enter a usage
interval, Civic Platform generates work orders based on the time interval only.

Creating a Global Search Index Batch Job
The underlying engine for Civic Platform global search is the Apache Lucene full-text search engine. You
must create and execute a batch job to build the initial index files on the index server with the current
database data. It is best practice to execute batch jobs after you finish running all data conversion loading
jobs. After you build the initial index, the index server automatically updates the index with the transaction
data that users enter into the database through Civic Platform. There is no need to frequently rebuild the
index, for example, no need to run the batch job daily or weekly.

You can define the batch job to support the global search for one or more objects including records,
addresses, licensed professionals, assets, parcels, documents, and contacts. By default, the batch job
supports all the mentioned objects. You can modify the supporting scope by configuring the Standard
Choice GLOBAL_SEARCH_BUILD_INDEX_ENTITIES.

To create a global search index batch job
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1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New and complete the Batch Job fields as described below.

Name Rebuild Index

Description Add the description for the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, no matter whether the job is successful or not. You can configure the
email template named NOTICE_OF_BATCH_JOB_COMPLETED to customize the
notification. For information about how to edit an email notification template, see
Working with Communication Manager .

Job Server Select the server for running the batch job.

Job Type Select job type “System” from this drop‑down menu.

Service Category Global Search Rebuild Index.

3. Click Submit.

Civic Platform saves the batch job details.

4. Click the Job Schedule tab.

5. Define the batch job schedule, including the start time, the start date, and the frequency. Refer to Table
138: Job Schedule Field Descriptions for a list of field definitions.

Note:

There are only two options, “Once” and “Monthly,” of the frequency with which the Global Search Index
batch job runs.

6. Click Save.

7. If at any time you want to review the batch job history, click the Log tab. See Viewing the Batch Job
Log.

Civic Platform displays the list of completed Rebuild Index batch jobs.

Creating an Asset GIS Sync Batch Job
You can create a batch job that automatically updates an asset type with any information entered for asset
records of that asset type in legacy Accela GIS. For example, an agency worker in the field is observing
multiple hydrants over the course of a week. You can create a batch job that takes all information that
users add to records of the type Hydrant and that run each Friday afternoon. All information you enter in
the field using legacy Accela GIS also enters in the corresponding Accela Civic Platform - Asset records.
Schedule this batch job to run at regular intervals so that information gathered in legacy Accela GIS is
regularly and automatically incorporated into your regular asset records.

Note:

If you want to move attribute information in the sync job, you must link the GIS attribute field with an attribute
field in Accela Civic Platform - Asset before running the synchronization. See Asset Types.

To create a new asset GIS synch batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

Civic Platform displays the New Batch Job portlet.

3. Complete the following required fields:
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Name Enter an intuitive name for the batch job.

Description Enter a brief description of the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, no matter whether the job is successful or not. You can configure the
email template named NOTICE_OF_BATCH_JOB_COMPLETED to customize the
notification. For information about how to edit an email notification template, see
Working with Communication Manager .

Job Server Select the server for running the batch job.

Job Type Select job type “System” from this drop‑down menu.

Service Category After you select the Service job type from the Job Type drop‑down menu, the
Service Category drop‑down menu displays. Select Asset Sync.

4. Click Submit.

Civic Platform creates the batch job and then displays the Batch Job Detail portlet.

5. Associate asset types to the batch job by completing the following steps:

a. Click the Asset Type tab.

Civic Platform displays the Asset Type portlet.

b. Click Look Up.

Civic Platform displays the Asset Type Search portlet.

c. Complete any fields that display. For a description of the fields, see Table 140: Batch Job Asset
Type Fields.

d. Click Submit.

Civic Platform returns a list of asset types that match your search criteria.
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e. Click the asset type(s) you want to add to the batch job.

f. Click Select.

Civic Platform adds the asset type(s) to the batch job.

6. Define the Job Schedule by completing the following steps:

a. Click the Job Schedule tab.

Civic Platform displays the Job Schedule portlet.

b. Complete the following fields:

Start Time Determine the time of day at which the batch job begins running by selecting hour,
minute, and a.m./p.m. from drop‑down menus.

If you set a batch job Schedule Status to Active but do not specify a Start Time,
an error message displays when you try to save the batch job.

Schedule Status Use this drop‑down menu to turn a batch job on and off. Select Active to activate
the batch job. Select On Hold to deactivate the batch job and save its information.

Start Date Enter the date on which the batch job starts or select a date by clicking on the
data picker beside the field.

If you set a batch job Schedule Status to Active but do not specify a Start Date,
an error message displays when you try to save the batch job.

Time Out (seconds) Enter the number of seconds a batch job attempts to run before timing out.

Frequency Select the frequency with which the batch job runs from this drop‑down menu.
Batch jobs can run one time, daily, weekly, monthly, or yearly.

End Date If you select a value other than Once in the Frequency field, the End Date field
becomes active. Enter the date on which the batch job stops running or select a
date by clicking on the data picker beside the field.
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PM Generate PM Generate is a required field that enables you to determine how far in advance
the batch job generates work orders. Enter a number in the first field, then select
Days, Weeks, Months, or Years from the drop‑down menu in the second field.

For example, to generate work orders two weeks in advance of the PM Schedule
batch job, enter 2 in the numeric field and select Weeks from the drop‑down
menu. Or, enter 15 in the numeric field and select Days from the drop‑down
menu.

c. Click Save.

Civic Platform saves the Job Schedule the batch job.

Table 140: Batch Job Asset Type Fields

Asset Group Use the drop-down menu to select the asset group.

Asset ID Mask Use the drop‑down menu to select the default prefix for the asset type you are
looking for. An ID mask can contain strings that show part of the application number
that Civic Platform recognizes and acts on before showing the application number.

Asset Type Enter an asset type.

Asset Type Code Enter an asset type code.

Class Type Select an asset class type from this drop‑down menu.

Comments Comments in the asset type record.

Description The description field of the asset type you are searching for.

GIS ID for Asset ID Select the ID used for the asset type ID in GIS from this drop‑down menu.

GIS Layer Select the GIS layer to which the asset type belongs from this drop‑down menu.

GIS Service Select the GIS service used by the asset type from this drop‑down menu.

Master Inventory in GIS This read-only option indicates whether the asset type is present in the inventory of
all mapped objects in legacy Accela GIS.

Record Status Select Active, Inactive, or All from this drop‑down menu.

Template ID Select a template from this drop‑down menu.

Creating a Batch Job for Expired License Email Notifications
Civic Platform can scan licensed professionals for all expired licenses and insurance coverage lapses,
and then send email notifications to all of the appropriate parties. Create a batch job for expired email
notifications by configuring the Send License Expired Email batch job category and defining the batch job
schedule.

To create a batch job for expired email notifications

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

3. Complete the fields as described below:

Name Enter a Name for the batch job.

Description Provide a brief description of the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, no matter whether the job is successful or not. You can configure
the email template NOTICE_OF_BATCH_JOB_COMPLETED to customize the
notification. For information about how to edit an email notification template, see
Working with Communication Manager .
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Job Server Select the server for running the batch job.

Job Type Select the job type “System” from this drop‑down menu.

Service Category Send License Expired Email

4. Click Submit.

5. Click the Job Schedule tab.

6. Define the batch job schedule. Complete the fields as described in Table 138: Job Schedule Field
Descriptions

7. Click Save.

Creating a Proxy User Process Batch Job
You can create a batch job that sets the delegate invitations to expire on the expiration day or to purge the
expired or declined invitations after the purge day arrives. The batch job runs at an interval you determine.
You configure the expiration day and purge day in Citizen Access administration. For more information see
“Delegates Settings” in the Citizen Access Administrator Guide.

To create a proxy user process batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

3. Complete the following fields:

Name Enter a Name for the batch job.

Description Provide a brief description of the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, no matter whether the job is successful or not. You can configure
the email template NOTICE_OF_BATCH_JOB_COMPLETED to customize the
notification. For information about how to edit an email notification template, see
Working with Communication Manager .

Job Server Select the server for running the batch job.

Job Type Select the job type “System” from this drop‑down menu.

Service Category Proxy User Process

4. Click Submit.

5. Click the Job Schedule tab.

6. Define the batch job schedule. Complete the fields as described in Table 138: Job Schedule Field
Descriptions. Best practice is to set the Frequency to Daily.

7. Click Save.

If at any time you want to review the batch job history, click the Log tab. See Viewing the Batch Job
Log.

Creating a Script Batch Job
You can create a batch job for running a script on a regular schedule that you define. For example, you
create a script that deletes partially completed applications, and then create a batch job to associate with
the script. The batch job regularly removes partially completed applications from Civic Platform.

To create a script batch job
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1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

3. Complete the following fields:

Name Enter a Name for the batch job.

Description Provide a brief description of the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, no matter whether the job is successful or not. You can configure
the email template NOTICE_OF_BATCH_JOB_COMPLETED to customize the
notification. For information about how to edit an email notification template, see
Working with Communication Manager .

Job Server Select the server for running the batch job.

Job Type Select the Script job type from this drop‑down menu.

Script Code From the drop-down list select the script that you want to associate with the batch job.
For information on creating a script, see the “Event and Script Setup” chapter in the
Accela Civic Platform Scripting Guide.

4. Click Submit.

5. Specify the job schedule to run the batch job by completing the following steps:

a. Click the Job Schedule tab.

b. Define the batch job schedule. Complete the fields as described in Table 138: Job Schedule Field
Descriptions.

c. Click Save.

6. Specify the default values of the parameters required to run the script by completing the following steps:

a. Click the Parameters tab.

Civic Platform displays the Parameters portlet.

b. Click New.

Civic Platform displays the New Parameter portlet.



 | Part 5: Automated Data Processing | 616

c. Complete any fields that display. For a description of the fields, see Table 141: Script Batch Job
Parameters.

d. Click Submit.

Table 141: Script Batch Job Parameters

Data Type Enter the data type of the parameter. The data type must correspond to the data
type defined for the parameter in the script.

Default Value Assign a value to the parameter for the script to run.

Description Enter a description for the parameter.

Display Order Not applicable.

Parameter Name Enter the name of the parameter.

Required Flag Select the required flag as Yes.

Status Use the drop-down to select if the parameter record is active or inactive for the
script.

Creating a Geotagging Batch Job
Geotagging is the process of adding geometry information to various objects, to enable users to perform
nearby queries or spatial queries.

• A nearby query searches for records, inspections, and asset condition assessments within the map
extent, within one or more selected GIS features, or near one or more selected GIS features.

• A spatial query searches for assets which are near to a selected GIS feature, so that users can link the
assets to a PM schedule.

You can create a batch job that automatically geotags all existing data objects in the Civic Platform
database, including geocoded addresses and GIS features. Civic Platform also automatically geotags new
data objects one by one when users select new geocoded addresses or GIS features from the map and
associate them with an asset, a parcel, or a record that exists in Civic Platform.

Associating a record, an inspection, an asset or a condition assessment with geotagged data objects
enables users to find the item within the map extent, within one or more selected GIS features, or near one
or more selected GIS features.

Note:

To geotag addresses, make sure that Civic Platform can connect to a map integration environment that has
a geocoding service and you have set that map integration environment as the default map service for Civic
Platform.

For information about how to define a geocoding service, see “Retrieving and Selecting a Geocoding
Service” in the Accela Civic Platform GIS Administrator Guide.
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For information about how to set a default map service for Civic Platform, see “Configuring GIS Services in
Civic Platform” in the Accela Civic Platform GIS Administrator Guide.

To create a new geotagging batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

Civic Platform displays the New Batch Job portlet.

3. Complete the following required fields:

Name Enter an intuitive name for the batch job.

Description Enter a brief description of the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, whether the job is successful or not. You can configure the email template
named NOTICE_OF_BATCH_JOB_COMPLETED to customize the notification
content. For information about how to edit an email notification template, see Working
with Communication Manager .

Job Server Select the server for running the batch job.

Job Type Select System job type from this drop‑down menu.

Service Category After you select System job type from the Job Type drop‑down menu, the Service
Category drop‑down menu displays. Select the batch job you want to create, in this
example, Geotagging Existing Record.

4. Click Submit.

Civic Platform creates the batch job and then displays the Batch Job Detail portlet.

5. Specify the job schedule to run the batch job by completing the following steps:

a. Click the Job Schedule tab.

b. Define the batch job schedule. Complete the fields as described in Table 138: Job Schedule Field
Descriptions.

Best practice is to set the Frequency to Once.

c. Click Save.

Creating a Batch Job for Rebuilding Asset Calendar Index
The asset calendar becomes available from Civic Platform 7.3 FP1. For the calendar to display asset
events that occurred before you upgrades Civic Platform to 7.3 FP1, you must build indexes for asset
events on the index server.

Note:

The index server can automatically update the index with all the asset events that occur after Civic Platform
upgrades to 7.3 FP1.

Before you create a batch job for rebuilding asset calendar index, you must configure the Standard Choice
ASSET_CALENDAR_BUILD_INDEX_DURATION. This Standard Choice defines the start date and end
date of a duration. The batch job only builds indexes for the asset events whose event time (for example,
event schedule time) falls in the duration. For more information about the Standard Choice, refer to the
Accela Civic Platform Configuration Reference.

To create a batch job for rebuilding asset calendar index
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1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

Civic Platform displays the New Batch Job portlet.

3. Complete the following required fields:

Name Enter an intuitive name for the batch job.

Description Enter a description about the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, no matter whether the job is successful or not.

Job Server Select the server for running the batch job.

Job Type Select System from this drop‑down menu.

Service Category Select Asset Calendar Rebuild Index from this drop‑down menu.

4. Click Submit.

Civic Platform creates the batch job and then displays the Batch Job Detail portlet.

5. Specify the job schedule to run the batch job by completing the following steps:

a. Click the Job Schedule tab.

b. Define the batch job schedule. Complete the fields as described in Table 138: Job Schedule Field
Descriptions.

Best practice is to set the Frequency to Once.

c. Click Save.

Creating an Optimized Inspection Route Batch Job
You can create a batch job to generate the sequence of inspection route sheet items for each inspector,
based on the start location, the end location, and the default route type in the inspector’s user profile. See
Inspections for a description of the three fields.

The inspection route sheet items are the inspections scheduled for the next available day or the day after
that, depending on when you run the batch job. For example, if you run the batch job between September
15, 10:00 pm and September 16, 10:00 pm, the batch job generates the sequence of inspections
scheduled between September 16,10:00 pm and September 17, 10:00 pm. If you run the batch job
between September 16, 10:00 pm and September 17, 10:00 pm, the batch job generates the sequence of
the inspections scheduled between September 17, 10:00 pm and September 18, 10:00 pm.

You can run this batch job at the end of the prior day for the next day’s jobs, or at the middle of the night.
Supervisors can also manipulate the order of the route sheet items after the automatic generation.

To create an Optimized Inspection Route batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click New.

Civic Platform displays the New Batch Job portlet.

3. Complete the following required fields:

Name Enter an intuitive name for the batch job.

Description Enter a brief description of the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, whether the job is successful or not. You can configure the email template
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named NOTICE_OF_BATCH_JOB_COMPLETED to customize the notification
content.

Job Server Select the server for running the batch job.

Job Type Select System job type from this drop‑down menu.

Service Category After you select System job type from the Job Type drop‑down menu, the Service
Category drop‑down menu displays. Select the batch job you want to create, in this
example, Optimize Inspection Route.

4. Click Submit.

Civic Platform creates the batch job and then displays the Batch Job Detail portlet.

5. Specify the job schedule to run the batch job by completing the following steps:

a. Click the Job Schedule tab.

b. Define the batch job schedule. Complete the fields as described in Table 138: Job Schedule Field
Descriptions.

c. Click Save.

Editing a Batch Job
You can edit the job schedule for a batch job at any time. Refresh the page to implement the change. After
you have created a batch job you can only edit the Job Description field in the Job Details portlet.

You can add and remove PM schedules and asset types to from PM Schedule and Asset GIS Sync batch
jobs, respectively, at any time after you create the batch job.

Topics

• Editing the Job Schedule and Description

• Adding a PM Schedule to an Existing Batch Job

• Removing a PM Schedule from an Existing Batch Job

• Adding an Asset Type to an Existing Batch Job

• Removing an Asset Type from an Existing Batch Job

• Adding a Parameter to an Existing Batch Job

• Removing a Parameter from an Existing Batch Job

Editing the Job Schedule and Description
You can edit the job schedule and its description for any batch job after you have created it.

To edit a batch job

1. Access the Batch Jobs portlet (Navigating to the Setup Portlet).

2. Click the link of the batch job you want to edit.

Civic Platform displays the Batch Job Details portlet.

3. If the job is not currently running, you can make the following changes to the batch job:

• Modify the Job Description field in the Job Detail tab.

• Modify any fields in the Job Schedule tab.
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• Modify the association of the batch job with PM schedule or the asset type.

4. Click Save.

Civic Platform saves the changes to the batch job. Refresh the page to implement the changes.

Adding a PM Schedule to an Existing Batch Job
Add additional PM schedules to an existing batch job.

To add a PM schedule to an existing batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click the link of the batch job you want to edit.

Civic Platform displays the Batch Job Details portlet.

3. Click the PM Schedule tab.

Civic Platform displays the PM Schedule list portlet.

4. Click Look Up.

Civic Platform displays the PM Schedule Search portlet.

5. Complete any fields that display. For a description of the fields, see Table 139: Batch Job PM Schedule
Fields.

6. Click Submit.

Civic Platform returns a list of PM Schedules that match your search criteria.

7. Click the PM Schedule(s) you want to add to the batch job.

8. Click Select.

Civic Platform adds the PM Schedule to the batch job.

Removing a PM Schedule from an Existing Batch Job
To remove a PM Schedule from a PM Schedule batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click the link of the batch job you want to edit.

Civic Platform displays the Batch Job Details portlet.

3. Click the PM Schedule tab.

Civic Platform displays the PM Schedule list portlet.

4. Select the PM Schedule(s) you want to remove from the batch job.

5. Click Delete.

Civic Platform removes the PM Schedule from the batch job.

Adding an Asset Type to an Existing Batch Job
Add asset types to an existing batch job to broaden the number of asset records that update with GIS
information when the batch job runs.

To add an asset type to an existing asset/GIS sync batch job
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1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click the link of the batch job you want to edit.

Civic Platform displays the Batch Job Details portlet.

3. Click the Asset Type tab.

Civic Platform displays the Asset Type portlet.

4. Click Look Up.

Civic Platform displays the Asset Type Search portlet.

5. Complete any fields that display. For a description of the fields, see Table 140: Batch Job Asset Type
Fields.

6. Click Submit.

Civic Platform returns a list of asset types that match your search criteria.

7. Click the asset type(s) you want to add to the batch job.

8. Click Select.

Civic Platform adds the asset type(s) to the batch job.

Removing an Asset Type from an Existing Batch Job
To remove an asset type from an existing asset/GIS sync batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click the link of the batch job you want to edit.

Civic Platform displays the Batch Job Details portlet.

3. Click the Asset Type tab.

Civic Platform displays the Asset Type portlet.

4. Select the asset type(s) you want to remove from the batch job.

5. Click Delete.

Civic Platform removes the asset type(s) from the batch job.

Adding a Parameter to an Existing Batch Job
Add additional parameters to an existing script batch job.

To add a parameter to an existing script batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click the link of the script batch job you want to edit.

Civic Platform displays the Batch Job Details portlet.

3. Click the Parameters tab.

Civic Platform displays the Parameters list portlet.

4. Click New.

Civic Platform displays the New Parameter portlet.
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5. Complete any fields that display. For a description of the fields, see Table 141: Script Batch Job
Parameters.

6. Click Submit.

Civic Platform adds the parameter to the batch job.

Removing a Parameter from an Existing Batch Job
To remove a parameter from a script batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click the link of the batch job you want to edit.

Civic Platform displays the Batch Job Details portlet.

3. Click the Parameters tab.

Civic Platform displays the Parameters list portlet.

4. Select the parameter(s) you want to remove from the batch job.

5. Click Delete.

Civic Platform removes the parameter(s) from the batch job.

Deleting a Batch Job
You can only delete a batch job when it is not running in the process queue. You must also remove any
associated PM schedules and asset types from a batch job to delete it. For instructions on removing PM
schedules and asset types, see Removing an Asset Type from an Existing Batch Job and Removing
an Asset Type from an Existing Batch Job. For instructions on terminating a running batch job, see
Terminating a Batch Job.

To delete a batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Select the batch job(s) you want to delete.

3. Ensure that the batch job is not running by checking its Job Status column.

If the job is running, follow the steps outlined in Terminating a Batch Job.

4. Ensure that the batch job has no PM schedules or asset types by checking the PM Schedule or Asset
Type tabs.

If there are PM schedules, follow the steps outlined in Removing an Asset Type from an Existing Batch
Job.

If there are asset types, follow the steps outlined in Removing an Asset Type from an Existing Batch
Job.
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5. Click Delete.

Civic Platform deletes the batch job.

Searching for a Batch Job
You can locate a batch job by any of these criteria, Name, Job Type, Schedule Status, and Job Status.

To find a batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click Search.

Civic Platform displays the Batch Job Search portlet.

3. Complete any of the following fields:

Name Enter the batch job name.

Description Enter a brief description of the batch job.

Email Enter the email address where you want Civic Platform to send emails after job
completion, no matter whether the job is successful or not. You can configure
the email template NOTICE_OF_BATCH_JOB_COMPLETED to customize the
notification. For information about how to edit an email notification template, see
Working with Communication Manager .

Job Type Select the job type from this drop‑down menu.

Schedule Status Select the Job Schedule Status from this drop‑down menu. Job schedules can be
either Active or On Hold.

Job Status Select the batch job’s status from this drop‑down menu. Available values are
Complete, Running, In Process Queue, and Terminated.

4. Click Submit.

Civic Platform returns a list of batch jobs that match your search criteria.

Manually Executing a Batch Job
You can manually execute a batch job at any time, with no interference with the job schedule; the batch job
continues to run without interruption on its regular schedule.

To manually execute a batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click Execute.

3. The following message displays: “Execute places the selected job(s) in the processing queue.” Batch
job(s) continue to run as scheduled. Do you want to continue?”

Click OK to run the batch job.

Click Cancel to return to the Batch Job List portlet without running the batch job.
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If you clicked OK, you place the batch job in the process queue and its Job Status reflects this. If you
clicked Cancel, Civic Platform returns to the Batch Job List portlet.

4. The executed batch job displays in the log along with scheduled batch jobs. To view the log, click the
Log tab.

Civic Platform displays the Batch Job Log portlet.

Terminating a Batch Job
If for any reason you need to stop a batch job that is either in the process queue or is running, you can
navigate to the batch job record, and then click Stop. This does not affect the job schedule; unless you edit
the batch job schedule, the job continues to run according to that schedule. To edit the batch job schedule,
see Editing the Job Schedule and Description.

To stop a batch job

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click the link name of the batch job you want to stop.

You can determine whether the job is currently running by checking the Job Status column of the batch
job.

3. Click Stop, on the Job Detail tab.
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4. The following message displays: “Are you sure you want to stop the batch job?”

Click OK to stop the batch job.

Click Cancel to return to the Batch Job List portlet without stopping the batch job.

If you Click OK, the batch job is stopped. If you click Cancel, Civic Platform continues running the batch
job and then displays the Batch Job List portlet.

5. The terminated batch job displays in the log. To view the log, click the Log tab.

The Results column indicates whether the batch job completed, terminated, or timed out.

Civic Platform displays the Batch Job Log portlet.

Viewing the Batch Job Log
Each time you run a batch job on schedule, manually execute it, terminate it, or when a batch job times
out, this activity displays in the batch job log.

To view the batch job log

1. Access the Batch Jobs portlet (Accessing the Batch Jobs Portlet).

2. Click the link name of the batch job whose log you want to view.

Civic Platform displays the Batch Job Detail portlet.

3. Click the Log tab. For a description of the information contained in this log, see Table 142: Batch Job
Log Fields.

Civic Platform displays the Batch Job Log portlet.
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Table 142: Batch Job Log Fields

Log ID Civic Platform automatically generates a sequential number to identify each log entry.

Start Time The time at which the batch job started.

End Time The time at which the batch job completed, you terminate it, or it times out.

Result This column indicates whether the batch job successfully ran. The possible values in
this column are:

Complete: The batch job ran successfully.

Terminate: The batch job was manually stopped.

Time Out: The batch job’s running time exceeded the Time Out setting in the Job
Schedule.

Message Message describing the batch job’s result.

Record Date The creation date for the log entry.

Importing and Exporting Settings
Click a topic title below for full details.

Related Links

Transferring Settings

Exporting Data to CSV

Transferring Settings
The Import and Export portlets are for transferring settings data, such as filters and queries.

For transferring record and configuration data, use Data Manager. Refer to the Data Manager chapter in
the Accela Civic Platform Migration Guide for complete details.

Example Use Case

You create an entirely new user group and want to copy a set of data filters from an existing user group.
You export the data filters, modify the XML file to add the new user group, and then import the file again.

Topics

• Exporting Settings

• Importing Settings

Exporting Settings
When you export settings data, Civic Platform creates an XML file that uses a specific file naming
convention to indicate the information contained in the file, and the date and time you exported the
information. If you change the file name, you must leave the export type unchanged. If you change the
export type in the file name, Civic Platform cannot import the XML file.

To export settings

1. Access the Export portlet (Accessing the Export Portlet).

2. Enter the agency name you use to log in to Civic Platform.

3. Select Export from the drop-down list.



 | Part 5: Automated Data Processing | 627

4. Click Submit.

5. Click Save and select the location where you want to save the XML file. Close the Save As dialog box.

Civic Platform saves the XML file in the location you select.

Importing Settings
You can only import files that correspond to the import item type you select. For example, if you select
SmartCharts as the import item type, you cannot import data filters.

To import settings

1. Access the Import portlet (Accessing the Import Portlet).

2. Select the Import Item. Browse for the Import File.

3. Click Submit.

Civic Platform prompts you to back up your old data.

4. Click the Yes button to back up old data, or the No button to proceed without backing up.

5. Civic Platform imports the settings.

Exporting Data to CSV
Civic Platform provides a CSV Export item in the menu of every list portlet or list tab. Users can select the
CSV Export item to export the list of records on display into a CSV file.

Civic Platform also provides a CSV Export button beside an application-specific information (ASI) table, on
the precondition that the ASI table has some data in the database. Users can click the button to export all
the data stored in the database for the ASI table, not only the data on display, into a CSV file.

To control the number of records users can export to a CSV file, you must configure the Standard Choice
EXPORT_MAX_RECORDS. The value you set for this Standard Choice determines the maximum number
of records users can export.
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Part 6: Reporting and Analytics
Civic Platform provides report functions.

Related Links

Standard Reports

Report Manager

SmartCharts

Standard Reports
Civic Platform provides a set of out-of-the-box, standard reports that users can run to extract data from
your database for analysis purposes. For information on how to configure standard reports in Report
Manager, see Report Manager.

Standard reports are available in all modules: Service Request, Land Management, Licensing and Case
Management, Asset Management, Citizen Access, and Accela common services. Accela developed these
reports using state-of-the-art reporting tools such as Crystal Reports, Oracle Reports, Microsoft Reporting
Services, and Accela Report Writer.

Some reports are available in multiple formats (for example, Crystal Reports and MSSQL Reports). For
reports that are available in two formats, you can make both report type formats available.

Civic Platform provides access to all of these standard reports and enables you to configure user access
and parameters in Report Manager. Configuring standard reports involves setting up the parameters users
can specify to filter the report and provide the necessary report output. You can set up reports so that
they automatically include the parameters, or you can require users to manually supply report parameter
criteria.

You can generate standard reports in different output formats, such as PDF, HTML, and Excel (.xls) for tab
delimited reports. For more information on output formats, refer to "Reporting" in the Accela Civic Platform
User Guide or the documentation that came with your reporting software.

Click a topic title below for full details.

Related Links

Address Activity Report

Assessor Report

Asset Detail Report

Asset List Report

Building Permit Report (HTML)

Census Bureau C-404 Report

Certificate of Occupancy Report

Fee Payment by Account Report

Fee Payment by Application Report

Hearing Report

Inspection Activity Report

Inspection Count Report
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Inspection Request List Report

Inspection Result List Report

Monthly Permit Summary Report

Permit Report

Service Request Aging Report by Alias

Service Request Aging Report by Type

Service Request Statistics Report

Violation History Report

Work Order Aging by Activity Structure Report

Work Order Aging by Number Report

Work Order Aging by Template Report

Work Order Aging by Type Report

Work Order Cost by Category Report

Work Order Costs by Work Order Report

Work Order Cost by Work Type Report

Work Order Detail Report

Work Order Forecasting Report

Work Order List Report

Work Order Report

Address Activity Report
The Address Activity Report contains the address details and history of an application by address and
module.

Report Name: STND_AAAA_0500035_R51230.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Address, Primary Address Only, Module

Assessor Report
The Assessor Report displays the valuation of applications filed or issued during a specific date range
and grouped by application type/subtype. Users can filter this report by file date or workflow task date,
depending on how you set up the parameters in Report Manager.

Report Name: STND_AAAA_0500455_R5123.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Application Module, Type, Subtype, Category, Date Range, Filter By, Workflow Task, Status

Asset Detail Report
The Asset Detail Report displays information about assets, including asset details, asset attributes, asset
attribute tables, child assets, and the addresses and work orders associated with the assets.

Report Name: AssetDetail

Report Type: MSSQL Report, Crystal Report
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Parameters: Agency ID, Asset Sequence Number

Asset List Report
The Asset List Report lists the total number of assets by asset types.

Report Name: AssetList

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID

Building Permit Report (HTML)
The Building Permit-HTML Reports is report of a Building Permits with application details including job
address, owner, applicant, contractor, valuation, and fees. This report includes a customizable legal
declaration. This report is available in HTML format and is accessible from the Permit tab.

Report Type: Accela Report Writer, Oracle Reports

Parameters: Application Number

Census Bureau C-404 Report
The C-404 report is a report that you send to the U.S. Census Bureau. This report provides data required
for the following C-404 form sections: New Residential Buildings, Additions, Alterations & Renovations to
Existing Structures, and Construction over $500,000.

Report Name: STND_AAA_0500537_R60131.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Application Module, Type, Subtype, Category, Workflow Task, Status, Status Date

Certificate of Occupancy Report
The Certificate of Occupancy report contains the permit number, owner name and address, and the
property address.

Report Name: STND_AAAA_0500545.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Application Number

Fee Payment by Account Report
The Fee Payment by Account report contains details of payments and refunds for a specific date range,
grouped by account number.

Report Name: STND_AAAA_0500033_C51117.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Payment Date Range
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Figure 45: Example Fee Payment by Account Report

Fee Payment by Application Report
The Fee Payment by Application report contains payment summaries for applications during a specific date
range, for one or all application types.

Report Name: STND_AAAA_0500032_C51117.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: File Date Range, Application Module, Type (optional), Subtype (optional), Category (optional)

Hearing Report
The Hearing Report contains hearing information relative to a case or a license. This report is available in a
calendar format or in a list format.

Report Name: STND_AAAA_0700217.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: File Date Range, Case or License (optional)
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Figure 46: Example Hearing Report

Inspection Activity Report
The Inspection Activity Report contains details of scheduled and completed inspections for a specified date
range, inspector, and application type. Civic Platform groups the report by inspector and inspection date.

Report Name: STND_AAAA_0500037_R51209.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Application Type, Inspector, Inspection Date

Figure 47: Example Inspection Activity Report

Inspection Count Report
The Inspection Count report provides a count of inspections during the specified range by inspector and
inspection Type. This report also provides the scheduled and completed inspections including counts by
C404 code.

Report Name: STND_AAAA_0500039_R51229.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Inspection Date, Scheduled Inspections, Completed Inspections, Show Inspector - Inspection
Details, Count by C404 Code.
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Figure 48: Example Inspection Count Report

Inspection Request List Report
The Inspection Request List report contains details of scheduled inspections for a specified date, inspector,
or application number. This report first sorts the data by inspector, and then by application number.

Report Name: STND_AAAA_0500564_R60111.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Inspection Date, Inspector Name, Application Number, Sort By, Application Module

Inspection Result List Report
The Inspection Result List report contains details of inspection results for a specified date range, inspector,
or application number. The report groups inspection results first by inspector and then by application
number.

Report Name: STND_AAAA_0500565_R60130.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Inspection Date Range, Inspector Name, Application Number, Sort By, Application Module

Monthly Permit Summary Report
The Monthly Permit Summary report contains details of applications during a specific date range, for one or
all application types.

Report Name: STND_AAAA_0500031_R60105.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Date Range, Application Module, Type, Subtype, Category
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Figure 49: Example Monthly Permit Summary

Permit Report
The Permit report provides details such as job address, work description, parcel number, owner,
contractor, and fees for one permit.

Report Name: STND_AAAA_0500575_R51230.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Application Number

Service Request Aging Report by Alias
The Service Request Aging Report displays a record of Service Requests meeting specified parameters,
including 1-30 days, 31-60 days, 61-90 days, >90 days, and a total.

Report Name: STND_AAM_0700227.xml

Report Type: Accela Report Writer

Parameters: Service Request Open Date range, Service Request Assigned Date range, Service Request
Scheduled Date range, Status, Assigned to Department, Assigned to Staff

Figure 50: Example Service Request Aging Report by Alias

Service Request Aging Report by Type
The Service Request Aging Report displays a record of Service Requests meeting specified parameters,
including 1-30 days, 31-60 days, 61-90 days, >90 days, and a total.

Report Name: STND_AAM_0700225.xml
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Report Type: Accela Report Writer

Parameters: Service Request Open Date range, Service Request Assigned Date range, Service Request
Scheduled Date range, Status, Assigned to Department, Assigned to Staff

Figure 51: Example Service Request Aging Report by Type

Service Request Statistics Report
The Service Request Statistics Report contains a count of Service Requests that match the report
parameters, and a count of all related Work Orders, including any open or closed Work Orders.

Report Name: STND_AAM_0700229.xml

Report Type: Accela Report Writer

Parameters: Record Type, Record Sub-Type, Record Category, Service Request Open Date range,
Service Request Assigned Date range, Service Request Scheduled Date range, Status, Assigned to
Department, Assigned to Staff

Figure 52: Service Request Statistics Report by Type
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Violation History Report
The Violation History report contains details of Enforcement cases that have associations with a specific
contact or address.

Report Name: STND_AAAA_0500454_R60203.xml

Report Type: Accela Report Writer, Oracle Reports

Parameters: Contact Type, Contact Name, Address, File Date

Work Order Aging by Activity Structure Report
The Work Order Aging by Activity Structure Report displays a count of Work Orders by activity structure
which meet specified parameters, including 1-30 days, 31-60 days, 61-90 days, >90 days, and a total.

Report Name: WOAgingByActivityStructure

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Asset Group, Asset Type, Opened Date Range, Scheduled Date Range, Assigned
Date Range, Assigned Department, Assigned Staff, Work Order Status

Figure 53: Example Work Order Aging Report by Activity Structure

Work Order Aging by Number Report
The Work Order Aging by Number Report (A) displays a count of Work Orders by number which meet
specified parameters, including 1-30 days, 31-60 days, 61-90 days, >90 days, and a total.

• Report A

Report Name: WOAgingByNumber

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Asset Group, Asset Type, Opened Date Range, Scheduled Date Range,
Assigned Date Range, Assigned Department, Assigned Staff, Work Order Status

• Report B

Report Name: STND_AAAA_0700223.xml

Report Type: Accela Report Writer

Parameters: Asset Group, Asset Type, Work Order Open Date range, Work Order Assigned Date
range, Work Order Scheduled Date range, Status, Assigned to Department, Assigned to Staff
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Figure 54: Example Work Order Aging Report by Number

Work Order Aging by Template Report
The Work Order Aging by Template Report (A) displays a count of Work Orders by template which meet
specified parameters, including 1-30 days, 31-60 days, 61-90 days, >90 days, and a total.

• Report A

Report Name: WOAgingByTemplate

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Asset Group, Asset Type, Opened Date Range, Scheduled Date Range,
Assigned Date Range, Assigned Department, Assigned Staff, Work Order Status

• Report B

Report Name: STND_AAAA_0700219.xml

Report Type: Accela Report Writer

Parameters: Asset Group, Asset Type, Work Order Open Date range, Work Order Assigned Date
range, Work Order Scheduled Date range, Status, Assigned to Department, Assigned to Staff

Figure 55: Example Work Order Aging Report by Template
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Work Order Aging by Type Report
The Work Order Aging by Type Report (A) displays a count of Work Orders by type which meet specified
parameters, including 1-30 days, 31-60 days, 61-90 days, >90 days, and a total.

• Report A

Report Name: WOAgingByType

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Asset Group, Asset Type, Opened Date Range, Scheduled Date Range,
Assigned Date Range, Assigned Department, Assigned Staff, Work Order Status

• Report B

Report Name: STND_AAAA_0700221.xml

Report Type: Accela Report Writer

Parameters: Asset Group, Asset Type, Work Order Open Date range, Work Order Assigned Date
range, Work Order Scheduled Date range, Status, Assigned to Department, Assigned to Staff

Figure 56: Example Work Order Aging by Type Report

Work Order Cost by Category Report
The Work Order Cost by Category Report lists work order cost information by work order categories. The
cost information includes estimated cost, costing, parts cost, and the total cost of work orders.

Report Name: WOCostByCategory

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Asset Group, Asset Type, Opened Date Range, Scheduled Date Range, Assigned
Date Range, Assigned Department, Assigned Staff, Work Order Status



 | Part 6: Reporting and Analytics | 639

Work Order Costs by Work Order Report
The Work Order Cost by Work Order Report lists work order cost information by work order. The cost
information includes estimated cost, costing, parts cost, and the total cost for work orders.

Report Name: WOCostByNumber

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Asset Group, Asset Type, Opened Date Range, Scheduled Date Range, Assigned
Date Range, Assigned Department, Assigned Staff, Work Order Status

Work Order Cost by Work Type Report
The Work Order Cost by Work Type Report lists work order cost information by work order type. The cost
information includes estimated cost, costing, parts cost, and the total cost for work orders.

Report Name: WOCostByType

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Asset Group, Asset Type, Opened Date Range, Scheduled Date Range, Assigned
Date Range, Assigned Department, Assigned Staff, Work Order Status

Work Order Detail Report
The Work Order Detail Report contains information about work orders, including work order details, asset,
costs, part, and address info.

Report Name: WODetail

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Work Order ATl_ID

Work Order Forecasting Report
The Work Order Forecasting Report provides a report showing the forecast of required resources, based
on pending work orders. The forecast information includes the total of Est. Prod Units and Avg. Prod Units.

• Report A

Report Name: WOForecast

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID, Asset Group, Asset Type, Opened Date Range, Scheduled Date Range,
Assigned Date Range, Assigned Department, Assigned Staff, Work Order Status

• Report B

Report Name: STND_AAM_0700233.xml

Report Type: Accela Report Writer

Parameters: Asset Group, Asset Type, Open Date range, Assigned Date range, Scheduled Date range,
Status, Assigned to Department, Assigned to Staff
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Figure 57: Example Work Order Forecasting Report

Work Order List Report
The Work Order List Report provides a list of work order types and the total work orders per type.

Report Name: WorkOrderList

Report Type: MSSQL Report, Crystal Report

Parameters: Agency ID

Work Order Report
The Work Order Report contains a summary of work order information, including asset information,
addresses, existing costs, existing parts cost, new costs, work order tasks, and associated service
requests.

Report Name: AACE_AMS_0700207_R71221.xml

Report Type: Accela Report Writer

Parameters: Agency ID, User Name, ID

Report Manager
This section explains how reporting engines integrate with Civic Platform and provides step-by-step
instructions on how to set up, organize, and configure reports so they are easily accessible to users in
Civic Platform.

Note to On-premise Agencies: If your agency hosts the Civic Platform system, there are additional
setup and administrative tasks you must perform to successfully use Report Manager with Crystal Reports
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Server, Oracle, and Microsoft Reporting Services. For complete details, refer to the Civic Platform On-
premise Administrator Supplement.

Click a topic title below for full details.

Related Links

Setting Up Report Services

Organizing Reports

Setting Up a Report

Additional Report Options

Setting Up Report Services
Topics

• Pre-Configuring Report Services

• Adding a Report Service

• Editing a Report Service

• Removing a Report Service

Pre-Configuring Report Services
Before you can add report service settings to Report Manager, you must make the report service
accessible from within Civic Platform and set up a reports directory to access reports in Report Manager.

• Accela-hosted and On-premise customers: contact your Accela Implementation Specialist to obtain a
copy of the Civic Platform On-Premise Administrator Supplement and refer to the documentation set
that came with your reporting software.

• Accela subscription customers: the professional services team performs this configuration as part
of your initial setup. If you cannot find the report services you are looking for, contact your Accela
Implementation Specialist.

Adding a Report Service
When the pre-configuration is complete, you can add as many report services as you need. Depending
on the type of report service, required settings can change. For example, a Client Executable report
does not require the location of the report directory because the report runs on the client workstation.
Crystal Reports require additional security information such as agency and environment to filter reports
appropriately.

Report services added to Report Manager display in the Report Service drop-down list in the Report Detail
portlet shown in Figure 58: Report Service Drop-down List.
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Figure 58: Report Service Drop-down List

The Report Output Formats selected for the report service display in Output Format drop-down list in the
Report Detail portlet shown in Figure 59: Report Format Output Drop-down List.

Figure 59: Report Format Output Drop-down List

To add a report service

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand Settings in the navigation tree.

3. Right-click Report Services and select New Report Service from the menu.
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Civic Platform displays the Report Service setup form.

4. Complete the fields as described in Table 143: Report Services Field Descriptions . These fields vary
depending on the Report Type you select.

5. Click Submit.

Civic Platform saves the report services settings and is available when setting up reports.

Table 143: Report Services Field Descriptions

Agency Enter the agency code used to determine the specific reports directory folder to
use when displaying reports in the Report Picker window in the Report Detail
portlet. Civic Platform requires this field only for the Crystal Report type.

Authentication Method Select the authentication method for the report service type.

Basic authentication and NT authentication are applicable to Crystal Report,
Oracle Report 6i, MSSQL2005 Report, and MSSQL 2008 Report.

SSO authentication is applicable to Oracle Report 10g/11g.

Environment Enter the name or ID of the environment the Crystal Report should run from.
You can use the same report service for multiple environments; for example, a
production environment and a training environment. Civic Platform requires this
field only for the Crystal Report type.
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Password If your MS SQL Reporting Service requires Civic Platform to authenticate itself,
enter the password from the user name and password account you created for
the Reporting Service in IIS or through the Computer Management console.

Report Name List URL Enter the URL to the directory where you are storing your reports. Civic Platform
uses this URL to display the reports that appear in the Report Link popup
window when setting up a new report. The URL should include the server
name and the folder structure to locate the reports, as shown in the following
example: Example Report Name List URL: http://reporting.accela.com/infospc/
ReportManagerment/searching/getRptName.jspThis field is not applicable for
the report type Client_EXE because it launches an executable file on the user’s
workstation and does not access the server for the report directory location.

Report Output Format Select each report format that is compatible with the reporting service. For
report type Client_EXE the only use .doc, .rtf, or .xls formats.

Report Service Name Enter the name used to describe the report service. For example, CRYSTAL
or ORACLE. After you save the report service, this option appears in the drop-
down list in the Report Detail form portlet. For an example, see Figure 58:
Report Service Drop-down List.

Report Service Type Select the type of reporting service you are using to launch reports. Options:
Accela Report Writer (ARW), Client_EXE, Oracle Report, Microsoft Report,
Crystal Report.

Note:

Report service settings vary depending on the report type.

Report Service URL Enter the URL location of the report service.

Note:

You can only specify the server name (not IP address or domain) for
the report service URL with NT authentication.

Here is an example of the Report Service URL without NT authentication:

http://reporting.bridgeview.com/infospc/
ReportManagement/RunReport.jsp

Here is an example of the Report Service URL with NT authentication:

http://reporting/ReportServer$SQL2K5

Security Enter the security information (user name and password) necessary to access
the Oracle reporting service. Civic Platform requires this field only for Oracle
Report types.

User Name and Password If your reporting service requires Civic Platform to authenticate itself, enter the
authentication user name and password.

Editing a Report Service
Use caution when editing report service settings, as these settings affect your user's ability to access and
run reports. For example, if the Report Service URL or Report Name URL is not valid, the user receives an
error when running a report. When reporting components change, the corresponding report service setting
dynamically updates. For example, if your network administrator switches the server where you are storing
reports or report services, you can dynamically update the report service settings with little or no negative
affect on the users.

Updates to the Report Service Name and Report Output Formats change the options that appear in the
Report Detail form. For example, if you clear the check box for the Adobe Acrobat (PDF), this option is no
longer available for reports using that report service.
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To edit a report service

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the Settings option in the navigation tree.

3. Expand the Report Services option in the navigation tree.

Civic Platform displays any existing Report Services.

4. Click the report service you want to edit.

Civic Platform displays the detail for the Report Service Form selected.

5. Update the fields as necessary. For more information see Figure 67: Single Column RTF Template
Source File.

6. Click Submit.

Civic Platform saves the report services settings and is available when setting up reports.

Removing a Report Service
You can remove report services that are incorrect or that you no longer need. You must also remove the
reports that you reference in the report service, or update them to use a different report service, before
you can remove a report service. After you remove a report service it is no longer available within Report
Manager when setting up reports.

To remove a report service

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the Settings option in the navigation tree.

3. Expand the Report Services option in the navigation tree.

Civic Platform displays the report services available in Report Manager.

4. Right-click the report service you want to remove and click Remove Report Service.

Civic Platform removes the Report Service from the Report Manager.
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Organizing Reports
Topics

• Adding a Category

• Copying Reports

• Removing a Category

• Accessing Reports by Name

Adding a Category
You can add custom categories to organize the reports presented to the user in the Reports Portlet. You
must add categories to the report administration before defining a report and its attributes.

The categories that display for the user must contain at least one report to display in the Reports Portlet.
The visibility of these categories also depends on the reports permissions. For example, if the Building
category contains reports that are only accessible by the Building Inspector user group, the Building
category displays only for that user group. This feature enables you to create custom categories for user
groups and modules. For more information on assigning report permissions, see Assigning Permissions to
Reports.

The My Reports option in the Reports Portlet does not require any setup in the reports administration. This
option appears for each user and does not require any setup or configuration.

To add a category

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Right-click the Reports by Category link in the navigation tree, and then click New Category.
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Civic Platform displays the new category page.

3. Enter the Category name.

4. Click OK.

Civic Platform creates a new category. After refresh, the reports display in alphabetical order.

5. To add a new report to the category, right-click the new category and select New Report. For more
information on adding a report, see Adding a Report.

Civic Platform displays the new report detail form portlet.

Copying Reports
You can move or copy reports from one category to another in the Reports by Category navigation tree,
with the copy/paste or drag-and-drop options. The copy/paste function provides a quick way to reference a
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report under more than one category. For example, the Census Bureau C-404 Statistical report gets ran by
more than one department. You can copy/paste the report into each department category and change the
report name as appropriate for that department. The report attributes copy over along with the report, so
you do not need to re-do the setup steps for each copy of the report. However, if you make changes to a
report that has multiple copies, you must either apply the changes to each copy of the report or delete the
report and create new copies of the updated report.

To copy a report to a category

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate to the report you want to copy.

3. Right-click the report and click Copy.

4. Right-click the category where you want to copy the report and click Paste or Paste Special.

Civic Platform displays the Paste or Paste Special page.

5. Enter the Report name. If you clicked Paste Special, select the report attributes you want to add to the
report.

6. Click OK.

Civic Platform copies the report to the selected category and displays it in alphabetical order.

To move a report to another category

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate to the report you want to move or copy.
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3. Drag the report to the target category.

Civic Platform displays a pop-up menu with the Copy Report and Move Report options.

4. Do one of the following:

a. Click Copy Here to make a copy of the report and add it to the target category.

b. Click Move Here to move the report to the target category.

Civic Platform copies or moves the report and its attributes to the target category.

Removing a Category
Categories removed from Report Manager affect the organization and user access to the reports listed
under that category. You must delete any reports assigned to the category before you can remove the
category. For more information on deleting reports, see Deleting a Report.

To remove a category

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the category you want to remove.

3. Delete any reports under the category by right-clicking each report and clicking Delete.

Civic Platform deletes the selected reports.

4. Right-click the category and click Delete.

Civic Platform deletes the category from Report Manager.

Accessing Reports by Name
Civic Platform sorts reports added to reports administration by report name in the navigation tree. The first
level of the navigation tree is from A-Z, and displays the reports according to their first letter. For example,
the Permit Report displays under the letter “P.” This organization option is helpful when searching for a
specific report.
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To access a report by name

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the Reports by Name link in the navigation tree.

Civic Platform expands the Reports by Name category and displays a letter for the first letter of each
report added to Report Manager.

3. Click the first letter of the report you are looking for.

Civic Platform displays a list of reports that starts with the selected letter.

4. Click the report you want to access.

Civic Platform displays the report detail for the selected report.
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Setting Up a Report
To add reports to Report Manager each report must have the appropriate security parameters and must
reside in the reports directory on the server. Reports you do not add to this directory are not accessible to
Report Manager.

There are two ways for a user to run reports in Civic Platform. One is through the use of the Reports
Portlet, which allows users to select a management-type report that typically analyzes data from across the
database, such as a daily cash receipts report, or a monthly C-404 Statistical Report. The second way is
from specific form or list portlets. These reports generally focus on a specific record or set of records such
as a Permit Print or notification letter.

You can organize reports by category, so that users can easily find the reports they need in the Reports
Portlet.

After adding reports to Reports Manager, you can configure additional options, such as adding parameters,
assigning permissions to user groups and modules, and associating reports with workflow tasks. For more
information on these configuration options, refer to the appropriate topics in this guide.

On-premise customers are responsible for setting the security parameters in each report and maintaining
the reports directory. For information on how to do this, refer to the Civic Platform On-premise
Administrator Supplement.

Topics

• Adding a Report

• Editing a Report

• Renaming a Report

• Deleting a Report

• Setting up Report Parameters

• Assigning Permissions to Reports

• Attaching Reports to a Portlet

• Attaching Reports to a Workflow

Adding a Report
Before you add a report to the report administration, you must add specific security parameters to the
physical report. Accela-hosted and subscription customers must send each newly developed report to an
Accela implementation specialist. Civic Platform adds the security parameters to the report and places
it in the appropriate directory on the report server. You can access this directory from the Report Link in
the Report Manager administration setup. On-premise customers, refer to the Civic Platform On-Premise
Administrator Supplement for steps on setting these parameters and placing the reports in the appropriate
directory.

Civic Platform organizes reports within reports administration by category. You must identify the categories
before adding reports to Report Manager. These categories also display in the Reports Portlet, so that
users can easily find the reports they need.

You can create and manage online inspection reports in Mobile Office the same way as they create
and manage reports in Civic Platform. The Report Manager portlet provides a report category,
Mobile Office Reports. If you add reports into the report category, and configure the Standard Choice
ENABLE_AMO_ONLINE_REPORT, the reports are accessible on Mobile Office devices.

When adding a report to the reports administration, you must specify the report process service such
as Crystal, Oracle, Microsoft Reporting, Accela Report Writer, RTF, or URL Report. This identification
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sends the request to execute the appropriate report engine when a user runs a report. Depending on the
report service, different formatting options are available including Adobe Acrobat (.pdf), Microsoft Excel
(.xls), Rich Text Format (.rtf), and many others. A preview of each report is available from the report detail
form portlet. Use the preview to confirm that the correct reporting engine launches and the correct report
displays before moving on to additional setup and configuration steps.

You can save reports to an Electronic Document Management System (EDMS), except for client
executable reports, which you cannot save to an EDMS. With the EDMS options in the Report Detail form,
you can set the report to automatically save to the EDMS and categorize the report into a document group.
You can also save reports to specific objects such as Record, Parcel, Workflow, and Asset Inspection. For
more information on saving reports to EDMS, see Saving Reports to a Document Management System.

You can assign a report to a default printer to automatically print when a user runs the report. When a user
runs a report set to automatically print, they receive a notification message when their report prints.

After you add reports to Report Manager, you can make them accessible to users in Civic Platform from
the Reports portlets, other portlets, and workflow tasks. There are also additional set up and configuration
steps for reports that include; adding parameters and assigning permissions to user groups and modules.
These options are available in the reports administration of Report Manager. For more information on
these options, refer to the appropriate topics in this guide.

To add a report

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Click New Report at top of the navigation tree or right-click a category or report in the navigation tree
and select New Report.

Civic Platform displays the report detail form portlet.

3. Complete the fields described in Table 144: Report Detail.

4. Click Submit to save the report detail.

Civic Platform saves the report detail and adds the report to the selected category in the navigation
tree.
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5. Click Preview to preview the report.

Civic Platform prompts you to enter any required parameters.

6. Enter the report parameters if required.

Civic Platform displays the report preview in another window.

Table 144: Report Detail

Authentication Method Select the authentication method for the report service type.

Note:  This field displays only when you select the URL_Report process
service. With other process services, Civic Platform configures this field when
you set up the related report service. See Setting Up Report Services.

Category Select the appropriate category for the report. Civic Platform uses this category to
organize and display the report for the user in the Reports Portlet or in form and list
portlets.

If you add a report to run in Mobile Office, Select the Mobile Office Reports.

Description Enter a description of the report. For example, enter “The inspection list report displays
the total number of inspections within a specific date range, ordered by inspection
type.”

Document Group/
Category

Categorize the report by first selecting a value from the Document Group drop-
down list, then a value from the Category drop-down list. It is important to select
the Document Group first, because the Category drop-down list can be different,
depending on which document group you choose.

EDMS Select the Electronic Document Management System (EDMS) you want to save the
report to. EDMS is available for all report services and types with the exception of client
executables.

EDMS Object Select the Electronic Document Management System (EDMS) object you want to
save the report to. When you save the report it displays under the Documents or
Attachments tab for the associated object. Options include: Record, Parcel, Workflow,
Asset Condition Assessment, Inspection, Reference Contact, Reference Professional
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and Set. EDMS is available for all report services and types with the exception of
client executables. If you select Record Contact (or Record Professional) as the
EDMS Object option, you can further select one or more contact types (or licensed
professional types) in the Type selection box. When users run the report in a record,
Civic Platform attaches the report to the contacts (or licensed professionals) of the
selected types that are associated with the record. If none of the record contacts (or
licensed professionals) are of the selected types, Civic Platform does not attach the
report to any record contact (or licensed professionals).

Name Enter the name you want to display for the report in the Reports Portlet or Report
Menu.

Output Format Select the output format of the report. The options vary depending on the formats the
report service supports. Options can include Adobe Acrobat (.pdf), Microsoft Word
(.doc), Microsoft Excel (.xls), Rich Text Format (.rtf), and CSV comma-delimited (.csv).
If you leave Output Format blank or set it to default, Civic Platform uses the default
viewer for the report service. For information on updating output formats, see Setting
Up Report Services.

Note:

Tag reports in authorized service sales only supports “PDF” format.

Mobile Office online reports do not support Default Format.

Print Copies Enter the number of copies you can print.

Print Only Select Yes or No from this drop-down list to indicate whether you want to print the
report.

Report Link Click the Select Report Link to choose the reports available in the report directory
on the server. To expand the reports list, select Expand Reportsfrom the menu. To
contract the list to display a small list of reports, select Contract Reportsfrom the
menu.

Note:  Because Mobile Office users can only run an online report on an
inspection, the report you choose must include one and only one parameter
for getting the inspection ID. The parameter for getting the inspection ID is
already hard coded for Mobile Office online reports. You need not follow the
instructions in Adding Report Parameters to add the parameter.

Reports Portlet 1
Reports Portlet 2
Reports Portlet 3
Reports Portlet 4
Reports Portlet 5

Select the Reports portlet where you want the report to appear. A report can appear on
more than one Reports portlet. For instructions and information on where the Reports
portlets appear or how to make them visible, see Designing Forms for Portlets.

Reprint Limit on Citizen
Access

If you are adding a license tag report for authorized service sales in Citizen Access,
you must select the maximum number of reprint requests that an authorized agent or
authorized agent clerk can make.

This field displays when you set the “Sent to Printer” option to Local DataMax-O’Neil E-
Class Mark III Printer, and associate the report with the Print Tag button (portlet name:
Button - Citizen Access Print Tag).

Note:  You must configure the Standard Choice REPRINT_REASONS to
define a list of possible reprint reasons for the authorized agent or clerk to
select.

Password Enter the authentication password.

Note:  These fields display only when you select the URL_Report process
service and choose the authentication method as basic authentication or
NT authentication. With other process services, Civic Platform configures
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these fields when you set up the related report service. See Setting Up Report
Services.

Process Service Select the report service to use for the specified report. The options selected in the
drop-down filter the reports that display in the Report Link window. The RTF and
URL_Report options is always available. For details on these options, see Using RTF
Templates and Using URL Reports. The other process service options are the report
services you set up in Setting Up Report Services.

Note:  If you select the URL_Report process service and then set the
authentication method to “Basic Authentication” or “NT Authentication,” users
can run a report and have it open directly without a login prompt appearing.
Civic Platform passes the authentication information to the report server.
However, if the report opens in a web browser, users have view-only access,
and any links within the report do not function.

Save to EDMS Select whether or not you want to save the report to the Electronic Document
Management System (EDMS) specified in the EDMS field. Choose Yesto automatically
save the report to EDMS. Choose No to not save the report automatically to EDMS.

Send in Email This option is either active or inactive, based on the report format you select in the
Output Format box. To activate this option, you must select any output format other
than the default format.

Select this option to enable users to send a report to record contacts. When you select
this option, you must also designate a corresponding set of email recipients from the
associated drop-down list. The record contacts in the drop-down list values refer to the
contacts for the session application.

Drop-down list values include:

Attach all Record Contacts:All application contacts and licensed professionals. When
you select this option and users run a report, a Send in Emailbutton appears on the
report preview page. Users click this button to select email recipients.

Attach Primary Record Contacts: Application primary contacts and licensed
professionals. When you select this option and users run a report, a Send in
Emailbutton appears on the report preview page. Users click this button to select email
recipients.

Auto-Attach all Record Contacts: All application contacts and licensed professionals.
When you select this option and users run a report, Civic Platform automatically sends
an email to application contacts and licensed professionals.

Auto-Attach Primary Record Contacts: Application primary contacts and
licensed professionals. When you select this option and users run a report, Civic
Platform automatically sends an email to primary application contacts and licensed
professionals.

You can define email subject matter and email content under the
EMAIL_REPORT_SUBJECT and EMAIL_REPORT_CONTENT content customize
types. This field supports multiple languages. For more information on working with the
content customize form, see Customizing the Content of Agency Communications.

To configure email reports for Citizen Access Users, contact the Accela Services
Implementation Staff, who can assist in writing event logic for the following scripts:
SendReportInEmail-1 and SendReportInEmail-2

Send to Printer Select the printer you want to use. Enter a default printer to automatically print the
report and notify the user of its completion. To add a default printer to the list, see
Setting a Default Printer.

Note:  Authorized agents or authorized agent clerks print license tags for their
customers in authorized service sales in Citizen Access. To enable agent to
print license tags to their local printer, you must select the printer option “Local
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DataMax-O’Neil E-Class Mark III Printer” for the tag report. You must also
associate the report with the Print Tag button (portlet name: Button - Citizen
Access Tag).

Template Click Browse and select a report template in Rich Text Format (.rtf). The template can
be up to 5MB. This field only applies to RTF report service type.

User Name Enter the authentication user name.

Note:  These fields display only when you select the URL_Report process
service and choose the authentication method as basic authentication or
NT authentication. With other process services, Civic Platform configures
these fields when you set up the related report service. See Setting Up Report
Services.

Editing a Report
You can edit report details, but be aware that your edits can affect how the report behaves and runs. If you
identify report parameters, permissions, and workflows for the report and you modify the report link, the
report might not behave correctly.

The Report Name, Category, and the Show in Report Portlet options affect what the user sees. If you
rename, move, or hide a report the report list that displays for the user changes accordingly.

To edit a report

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Locate the report you want to edit, using the navigation tree, and then click the report name.

Civic Platform displays the report detail form portlet.

3. Update the report details as necessary. For field definitions, see Table 144: Report Detail.

4. Click Submit.

Civic Platform updates the report detail.

Renaming a Report
The ability to rename the report is available under any of the categories in the navigation tree. It is
important to understand that renaming a report under one category, such as Reports by Name, renames
the report under another, such as Reports by Category.

The name that displays in the navigation tree is also the name that displays for the users. When you
rename a report in the reports administration, the report reflects the change in the Reports Portlet and in
the portlet where the user accesses the report.
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To rename a report

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Locate the report you want to edit, using the navigation tree, and then click the report name.

Civic Platform displays the report detail form portlet.

3. Right-click the report and click Rename.

Civic Platform displays the Rename Report page.

4. Enter the Report Name.

5. Click OK.

Civic Platform renames the report.
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Deleting a Report
When you delete a report from Report Manager, it removes the report from the report administration, and
removes the reference to the report under categories in the Reports portlet and from any form or list portlet
in which it appears. The report remains in the report directory on the server and accessible to Report
Manager at a later date if needed. To remove a report from the reports directory on the server, contact your
Accela implementation specialist or refer to the Civic Platform On-premise Administrator Supplement.

To delete a report

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate and right-click the report you want to delete from the navigation tree.

3. Click Delete option.

Civic Platform displays a confirmation window to delete the report.

4. Click OK to confirm the deletion of the report.

Civic Platform deletes the report from Report Manager and any reference to the report from the user
portlets.

Setting up Report Parameters
Use report parameters to assist users in filtering data for their report. You can set these parameters to
prompt users to enter ranges of values that define the report’s content. Civic Platform presents users with
drop-down lists, date pickers, and other parameter fields where users must specify the values and ranges
for the data they want to display on their report.

Figure 60: Civic Platform Parameter Prompt Window

Parameters not set up in Report Manager and required in the report display the parameter prompt window.
These parameters require users to enter exact values to correctly filter the report. For example, users must
enter dates in the correct format, MM/DD/YYYY or yyyy-mm-dd. The figure below shows a sample Crystal
Reports parameter prompt.

Figure 61: Crystal Reports Parameter Prompt Window
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Topics

• Adding Report Parameters

• Editing Report Parameters

• Deleting Report Parameters

Adding Report Parameters
Report parameters must exactly match the spelling of the parameter in the physical report. This includes
parameters users must enter manually, as well as those provided by Civic Platform and automatically sent
to the report. An example of an Accela provided parameter is record ID. The Building portlet supplies the
record ID and automatically displays it on the report.

Use default values for parameters that generally do not change. You can also use default values to set
or hard-code parameters, such as record type. The record type in a report run from a specific record
portlet such as Building does not change. To hard-code a value, the parameter must not be visible in the
parameter prompt window, and you must enter the value as the default value.

Set the visibility to no for any additional parameters that do not need to display in the parameter prompt
window, such as an Accela-provided parameters. If the report has required parameters the user does not
supply, the reporting service prompts for this value before running the report.

To add parameters for Rich Text Format (RTF) template type reports or URL reports, you must identify the
variables used in the report as report parameters. For information on how to set up variable parameters
for RTF templates, see Creating RTF Templates, Using Variables in Reports, and Setting Up URL Reports
Containing Variables.

To add report parameters

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the category of the report you are looking for.

3. Click the report to which you want to add parameters.

Civic Platform displays the report detail form portlet.

4. Click the Parameters tab.

Civic Platform displays a list of parameters for the report.
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5. Click New.

Civic Platform displays the report parameter intake form portlet.

6. Complete the fields as described in Table 145: Report Parameter Field Definitions.

Note that the Type field option, PortletVariable populates additional required fields as shown here. The
PortletVariable populates the Portlet drop‑down list so you can associate a report with a list or a form
portlet. The available fields load in the Default Value field.

7. Click Submit.

Civic Platform saves the report parameter detail and returns to the report parameters list portlet.

Table 145: Report Parameter Field Definitions

Allow Multiple Values Select this option to enable users to select multiple values from the drop-down
parameter list. This field is only available if you select the parameter type as drop-down
list.

Default Value Enter or select the default value that displays in the parameter prompt window for the
parameter.

If you select the parameter type as Variable, this field is a drop-down list with all the
variables defined in Adding a Variable. Note that if you select a variable with a result-
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set of multiple columns as the default value, the drop-down list parameter only reads
the first column value from the variable.

If you select the parameter type as PortletVariable, this field is a drop-down list that
loads the available fields in the portlet you selected.

If you select the parameter type as SessionVariable, this field is a drop-down list
with the standard session variables as listed in Table 148: Report Manager Variable
Parameters .

Display Order Enter the order number that the parameter should display in the parameter prompt
window.

Mask Enter the format for the parameter. For example, enter MM/DD/YYY for a date.

Name Enter the name of the parameter you want to display to the user in the parameter
prompt window.

Report Parameter Name Enter the name of the parameter as it appears in the report. This field value must
match the exact spelling of the report parameter.

Required Use the drop-down to specify whether the parameter optional or required. If set to
Required, the user must enter the parameter before running the report.

Rows Returned If you select a variable parameter Type, this field enables you to limit the number of
rows returned for the variable parameter.

Type Select the data type of the parameter.

To provide value options in a parameters drop-down list for users to select and send to
report, select the type as Drop-down List.

To send the record type value automatically to the report from the record portlet, select
the type as RecordType.

To link reports to a portlet and have values from the portlet passed as parameters,
select the type as PortletVariable. For example, you can create a Trust Accounts detail
report that links to the Trust Account list portlet or detail portlet. When users run the
report, information from the selected trust account portlet acts as parameters for the
report.

Visible Use the drop-down to select if the parameter should or should not display in the
parameter prompt window.

Editing Report Parameters
Editing a report parameter can affect if and how the report parameter displays in the Accela parameter
prompt window. For example, when you change the visibility of a parameter to NO, the parameter no
longer displays. If the report has required parameters, the user receives the parameter prompt window
supplied by the reporting service. The parameter prompt window also displays if you do not properly enter
the Parameter Name. This type of change can be confusing to the user and requires another step before a
user can run the report.

Updating report parameters for template type reports and variables requires unique values that differ from
the standard report parameters used by the major report services. For information on how to set up these
unique parameters, see Using Variables in Reports.

To edit a report parameter

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the category that contains the report.

3. Click the report you want to edit.

Civic Platform displays the report detail form portlet.
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4. Click the Parametersportlet tab.

Civic Platform displays a list of parameters for the report.

5. Click the Name of the parameter from the list.

Civic Platform displays the detail of the report parameter.

6. Update the fields as necessary; refer to Table 145: Report Parameter Field Definitions for field
descriptions.

7. Click Submit.

Civic Platform saves the report parameter detail and returns to the report parameters list portlet.

Deleting Report Parameters
If you remove report parameters, including Accela provided parameters or values manually entered by a
user, Civic Platform no longer sends them to the report. The parameter no longer displays in the parameter
prompt window. If a report requires the parameter, Civic Platform prompts the user to enter the value in the
prompt window provided by the reporting service. The parameter prompt can be confusing for users, and
creates another step for the user before they can run the report.

To delete a report parameter

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).
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2. Expand the category that contains the report.

3. Click the report from which to remove parameters.

Civic Platform displays the report detail form portlet.

4. Click the Parameterstab.

Civic Platform displays a list of parameters for the report.

5. Select the Nameof the parameter you want to delete.

6. Click Delete.

Civic Platform deletes the report parameter from the report.
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Assigning Permissions to Reports
Permissions for both module and user groups apply to the Report Portlet and portlet-specific reports.
Use report permissions to restrict access to a report to a specific module or user group. If an agency or
department uses the Building and Service Request modules, they only see the reports that apply to those
modules. User groups such as building inspectors, only see the reports that relate to inspections such as a
Scheduled Inspections Report and Inspections by Inspector Listing Report.

Use report permissions to provide security for reports that contain sensitive data. For example, you can
assign reports that contain sensitive data only specific management individuals should access, such as
revenue based reports, to a specific user group. Only those users in that user group have access to the
report.

Topics

• Assigning a Report to a User Group

• Assigning a Report to a Module

• Assigning Permissions to Mobile Office Online Reports

• Removing Report Permissions

• Setting Permissions on Ad hoc Report Data Sources

• Removing Permissions for Ad hoc Report Data Sources

Assigning a Report to a User Group
Report permissions include allowing a specific user group to access a report or a list of reports. You can
also use this feature to filter reports that the user group should not see. For example, the Building module
contains user groups such as field inspectors, permit technicians and property and maintenance. You
assign the inspector user group only to those reports that relate to inspections, including reports that are
accessible from the Reports portlet and portlet-specific reports. In order for a user group to have access
to the report menu on a list or form portlet, they must have permission to at least one or more reports
assigned to that portlet. If the user group does not have permission to any reports from that portlet, the
report menu is not visible.

The navigation tree provides access to the list of reports assigned by module and then by user group from
the Reports by User Group category. To view the user groups assigned to a specific report, navigate to the
report using any of the categories in the navigation tree and, select the Permissions tab.

For more information on assigning report to a user group, see Managing Recipients in Administration
Portlets.

Assigning a Report to a Module
You can assign a report to one or more modules as a way to control access to the report baseline. For
example, an agency that uses the Building and Service Request modules only has access to the reports
assigned to those modules.

You can assign a report that users access in more than one module, such as an address label, to all
modules where it is applicable. Making copies of a report to apply to each individual module causes the
report to display duplicated in the Reports Portlet or from form or list portlets.

All reports within Civic Platform from the Reports Portlet or list or form portlet use the permissions set on
each report to filter the reports a user has access to. In addition to modules, you must assign reports to
user groups. For more information, see Managing Recipients in Administration Portlets.

For more information on assigning a report to a module, see Setting Up Security Policies.
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Assigning Permissions to Mobile Office Online Reports
Permissions for both module and user groups to an Mobile Office Online report apply to the users who run
the report in the Mobile Office client:

• When you assign an Mobile Office online report to a user group, only the Mobile Office users which
belong to the same user group can access the report.

• When you assign an Mobile Office online report to a module, the report is only available for the
inspections which belong to the records in the same module.

Removing Report Permissions
You can remove report permissions when a report is no longer used by a user group or module -- or if you
added it by mistake. When you remove a permission, the user group or module no longer has access to
the report.

The navigation tree provides access to the list of reports assigned by module and then be user group from
the Reports by User Group category. To view all permissions assigned to a specific report, navigate to the
report using any of the categories in the navigation tree and, select the Permissions tab.

To remove a report permission

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the category and click the report.

Civic Platform displays the report detail form portlet.

3. Click the Permissions portlet tab.

Civic Platform displays a list of permissions for the report.

4. Select the permissions you want to remove.

5. Click Delete.

Civic Platform removes the permissions for the selected report.

Setting Permissions on Ad hoc Report Data Sources
Configure access to data and data sources (tables) for the Ad hoc Report portlet in Report Manager by
setting permissions on a User Group and/or Module basis. When you set permissions for a data source, a
user in the assigned user group (and/or with access to the assigned module) can use that data source to
write reports in the Ad hoc Report portlet.

Use the standard choice ADHOC_REPORT_DB_VIEW to control which DB views (data sources) are
available in the Report Manager Ad hoc Report Data Sources list. If you do not configure this standard
choice, Civic Platform uses default DB Views.

For more information on setting permissions on Ad hoc report data sources, see Managing Recipients in
Administration Portlets.

Removing Permissions for Ad hoc Report Data Sources
You can remove access to data and data sources (tables) for the Ad hoc Report portlet by deleting
permissions from the Ad hoc Data Sources Permissions list. When you delete a permission, users from the
deleted group or with access to the deleted module are no longer able to use the current data source for ad
hoc reporting.

To delete ad hoc reporting permissions

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).
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2. Expand Settings > Ad hoc Report Data Sources.

A list of data sources (tables) displays.

3. Select the data source you want to delete permissions for.

The Permissions form for the selected data source displays.

4. Select each permission setting you want to delete.

Before you click Delete, double check your deletion choices. You do not get an opportunity to confirm the deletion
after you click the button.

5. Click Delete.

Civic Platform removes the selected permissions for the current data source. The current data source
is no longer available to users associated with the deleted module or user group for use in their ad hoc
reports.

Attaching Reports to a Portlet
Users can run reports against a single record or small set of specific records. These portlet-specific reports
are accessible from the reports menu located on a list or form portlet, as shown in the screen shot below.
Examples of these reports include Permit Print, Certificates of Occupancy, and notifications.

Figure 62: Report Button in Building Portlet

The Reports menu is accessible from any portlet within Civic Platform when you add at least one report
to a portlet. The reports that display in each portlet vary depending on the user group and module
permissions specified for each report. An administrator must assign user groups and modules to each
report so that users can access them.

Portlet-specific reports generally use the Accela provided parameters that use a selected record or set of
records to filter data in a report, which enables users to run very specific reports without having to enter
parameter values. For example, a permit report generates when a user selects a specific permit from the
Building portlet and runs the report. If the values required to run the report are not available, the report can
return incorrect results and errors. For these types of reports, the report can be greyed-out in the report
menu so that users cannot run the report. For example, to run a report on approved building permits, the
permit must have a status of “Approved” in the Building portlet. If the building permit has any other status,
the report is greyed-out in the report menu list, preventing the user from running the report. This feature not
only prevents users from printing incorrect reports but provides a list of valid reports for the specific record.

If you use Citizen Access, you can display a print/view report button on the user interface for a specific
report. Assign the record type report to a button by selecting the button name from the Portlet Name drop-
down list. For more information on how to assign a report to a print/view button in Citizen Access, refer to
the Citizen Access Administrator Guide.

Topics

• Adding a Report to a Portlet
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• Defining Criteria for a Portlet-Specific Report

• Removing a Report from a Portlet

Adding a Report to a Portlet
Portlet-specific reports use a single or small set of specific records such as a building permit, notification
letter, or receipt. These types or reports can added to any of the form or list portlets within Civic Platform
from a report drop-down list. The report menu only displays when you add a report to the portlet.

You can add a single report to more than one portlet and display it in the Reports Portlet. To do this you
must verify that the report parameters work from the various locations.

Portlet-specific reports use the permissions set for each report, by user group and module, which means
you must assign a user group and/or module to the report for it to display in the portlet. For information on
assigning permissions, see Assigning Permissions to Reports.

To view the list of reports for a specific portlet, expand the Reports by Portlet option in the navigation tree.
To view the portlets that display on a specific report, click the report from any category on the navigation
tree, and select the Portlet tab. To add criteria to a portlet-specific report, see Defining Criteria for a Portlet-
Specific Report.

To add a report to a portlet

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate to the report you want to add to a portlet.

3. Click the report you want to add to a portlet.

Civic Platform displays the Report detail form portlet.

4. Click the Portletstab.

Civic Platform displays the portlets for the report.

5. Click New.

Civic Platform displays the portlet detail form portlet.
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6. Enter the field described in Table 146: Report Portlets Field Definition.

7. Click Submit.

Civic Platform dynamically assigns the report to the portlet.

Table 146: Report Portlets Field Definition

Description Enter a brief description on the report and how it should behave from the specific
portlet.

Display Select the type of display for the report.

Module Select the module the for the portlet where you want to display the report.

Portlet Name Select the portlet on which you want to display the report. If you use Citizen Access,
select the appropriate Print/View Report button from the list. For more information on
how to assign a report to a Print/View Report button in Citizen Access, refer to the
Citizen Access Administrator Guide.

Defining Criteria for a Portlet-Specific Report
Portlet-specific reports generally use the Accela provided parameters that use a selected record or set of
records to filter data in a report, which enables users to run very specific reports without having to enter
parameter values. For example, a permit report generates by selecting a specific permit from the Building
portlet and running the report. If the values required to run the report are not available within the selected
record, the report can return incorrect results and errors. For these types of reports, the report can be
disabled in the Report menu so that users cannot run it. For example, to run a report for approved building
permits, the status must be “Approved” on the selected record. If the permit has any other status, the report
displays inactive or “grayed-out” in the report menu list, as shown in the screen shot below. This feature
prevents the user from selecting and running a report that is not applicable to the selected record or set of
records.

Figure 63: Unsuccessful Report

For reports associated with Civic Platform portlets, you can set criteria only for form portlets. The criteria
option is not applicable to list or search portlets.

If you associate several reports with the same Citizen Access Print/View button, you must set the criteria
for every report.

To set criteria for a portlet-specific report

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate to and click the report to which you want to add criteria.

Civic Platform displays the Report detail form portlet.

3. Click the Portletstab.



 | Part 6: Reporting and Analytics | 669

Civic Platform displays the portlets for the report.

4. Click the Create Criteria or Edit Criterialink for the portlet to which you want to add criteria. If the
desired portlet does not display, you can add it by following the steps under Adding a Report to a
Portlet.

Civic Platform displays the Portlet Criteria portlet.

5. Complete the following fields:

Prefix Enter the prefix for the field name you want to use to set the criteria. You can also use
Prefix to handle complicated criteria using brackets for the LIKE and OR expressions.
See screen shot below.

Field Name Select the portlet field for which you want to set criteria on the selected portlet. For
example, to set criteria for building permits with an Approved status, select a field
name of Status, and Operator of =, and a Value of Approved.

Operator Select the appropriate operator you want to use in the criteria formula for the selected
field. For example, to set criteria for building permits with an Approved status, select a
field name of Status, and Operator of =, and a Value of Approved.

Value Enter the appropriate value used to determine the criteria. For example, to set criteria
for building permits with an Approved status, select a field name of Status, and
Operator of =, and a Value of Approved. You can also use the wildcard % with the
value. For example, to include all Permit Types that start with “Building,” use the value
“Building%” with the wildcard.

Suffix Enter the suffix for the field name you want to use to set the criteria. You can use
Suffix to close complicated criteria using brackets in the Prefix for LIKE and OR
expressions. See screen shot below.

AND/OR Select one of the following to join two or more criteria conditions.AND operator
displays a row of ALL conditions listed that are true. OR operator displays a row of
ANY of the conditions listed that are true.
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Figure 64: Prefixes and Suffixes in Report Criteria

6. Click New Field to add additional criteria to a portlet.

Civic Platform displays another line in under the previous criteria record.

7. To delete a field, select the field and click Delete Field.

8. When you finish adding criteria click Submit.

Note:  Make sure you remove all blank criteria before submitting the record. If you submit a record with
blank criteria, the update fails, Civic Platform deletes the blank record, and you must submit the records
again.

Civic Platform updates the criteria for the portlet.

9. Click Cancel to return the Portlet list portlet.

Civic Platform displays the Portlet list and updates the Menu Criteria.

Removing a Report from a Portlet
You remove reports from a portlet by removing the reference to the portlet. When you remove a report, it
no longer displays in the report drop-down list.
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If you are removing the only report associated with the portlet, the report drop-down list disappears. There
must be at least one report assigned to the portlet in order for the report menu to be display.

To remove a report from a portlet

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate to the report you want to remove from the portlet.

3. Click the report you want to remove from the portlet

Civic Platform displays the Report detail form portlet.

4. Click the Portletstab.

Civic Platform displays the portlets for the report.

5. Select the portlets you want to remove the report from.

6. Click Delete.

Civic Platform removes the report reference from the deleted portlet.

Example: Setting a Portlet for Meeting Reports
You can configure reports so that agency users can access and run reports from the Meeting Agenda
portlet in the Calendar list portlet and the Meeting record tab in the Record list portlet.

You must add Meeting Reports to Report Manager before you can set the portlet display. For instructions
on how to add a report, refer to Adding a Report.

To set up a portlet for a meeting report

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand and collapse the tree nodes to find the Meeting Report you want to modify.

Civic Platform displays the Report Detail form portlet.

3. Click the Portlets tab.

Civic Platform displays the portlets associated with the selected report.

4. Click New.

Civic Platform displays the Portlet detail page.
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5. If you want the selected report to display on the Meeting Agenda portlet, select List - Meeting Agenda
List from the Portlet Name drop-down list. If you want the report to display on the Meetings tab in the
Record list portlet, select List - Record Meeting List from the Portlet Name drop-down list.

6. Complete these remaining fields:

Description Enter a report description. For example: “The meeting report displays the meeting
date, location, and associated applications.”

Display Select a value from the drop-down list that indicates if you want the report to display in
one or more windows.

Module Select a module from the drop-down list that indicates where you want the report to
display.

7. Click Submit.

Civic Platform updates the report detail.

Attaching Reports to a Workflow
You can associate reports with workflow tasks and configure them to automatically print when the
user changes the status of a task. For example, if you want to print a building permit at the end of the
application process, you can associate the building permit with the application acceptance task. Then you
configure the status to execute the automatic printing of the report.

Topics

• Adding a Report to a Workflow

• Editing a Report Association with a Workflow

• Removing a Report from a Workflow

Adding a Report to a Workflow
You can configure reports to automatically print at the end of a workflow task. For example, to print a
building permit at the end of the application acceptance process, select the building permit report from
the report administration. Then, associate a workflow to the report by selecting the application process,
acceptance task, and the complete status; this enables you to automatically run and print the building
permit report when its status changes to “Complete.”

To add a report to a workflow

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate to and click the report you want to add to a workflow.

Civic Platform displays the Report detail form portlet.

3. Click the Workflowtab.

Civic Platform displays the workflow assigned to the report.

4. Click New.

Civic Platform displays the report intake form by workflow portlet.
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5. Enter information in the fields as described in Table 147: Reports by Workflow Field Definitions.

6. Click Submit.

Civic Platform saves the report to the workflow task.

Table 147: Reports by Workflow Field Definitions

Process Select the workflow process. For example, to print a building permit at the end of the
application acceptance process, select Building.

Status Select the workflow task status that should trigger the report. For example, if you want
to print a building permit at the end of the application acceptance process, you might
select Complete.

Task Select the workflow task you want to associate with the report. For example, to print
a building permit at the end of the application acceptance process, select Application
Acceptance.

Editing a Report Association with a Workflow
When the requirements for the automatic printing of a report from a workflow task change, you must edit
the information in report administration. When you change a workflow’s process, task, or status, it effects
when the report automatically prints, and you must make the appropriate changes.

If the existing report is incorrect, you must remove the association between the report and workflow, select
the correct report and then associate it with the workflow task. For more information, see Removing a
Report from a Workflow and Adding a Report to a Workflow.

To edit a report associated with a workflow

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate to and click the report you want to edit the workflow.

Civic Platform displays the Report detail form portlet.

3. Click the Workflowtab.

Civic Platform displays the workflow assigned to the report.
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4. Click the linkfor the workflow task you want to edit.

Civic Platform displays the report by workflow detail form portlet.

5. Update the fields as necessary. For field definitions see Table 147: Reports by Workflow Field
Definitions.

6. Click Submit.

Civic Platform saves the changes to the association with the workflow task.

Removing a Report from a Workflow
Remove reports from workflow tasks from the report administration workflow tab or the Reports by
Workflow category in the navigation tree. To remove the association from the navigation tree, search for
the report under the workflow task, right-click the report, and select Remove Association. Removing the
report association stops the report from automatically printing when the workflow status updates.

To remove a report from the workflow tab

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Navigate to and click the report you want to remove a workflow.

Civic Platform displays the Report detail form portlet.

3. Click the Workflowtab.

Civic Platform displays the workflow assigned to the report.

4. Select each workflow you want to remove.

5. Click Submit.

Civic Platform removes the report from the workflow and displays the report by workflow list portlet.
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Additional Report Options
Topics

• Using Variables in Reports

• Using RTF Templates

• Saving Reports to a Document Management System

• Using URL Reports

• Invoking a Client-Based Application

• Running Reports in EMSE

• Setting a Default Printer

• Using Barcodes in Payment Reports

Using Variables in Reports
Variables are raw database scripts that you execute directly against the Civic Platform Oracle or MS SQL
Server database, outside of a report writer or a development tool. You can incorporate these scripts into a
report or report template as parameters and populate them with data from Civic Platform. For example, to
extract the full name of the primary owner, use the database script displayed in Figure 65: Report Variable
Script for Primary Owner Full Name Query in the report variable form.

Figure 65: Report Variable Script for Primary Owner Full Name Query

This tool provides a wide variety of reporting possibilities and is only available to super administrative users
with a working knowledge of database scripts. Complicated queries that return large amounts of data effect
the performance of the database and slow the responsiveness of the application. For information on how to
become a super administrator, contact your Accela implementation specialist.

Report Manager includes a set of standard out-of-the-box session variables. This set of variables include
frequently used parameters from Civic Platform such as Department, Module, or Service Provider Code,
Today. For more information and a list of these session variables, see Table 148: Report Manager Variable
Parameters .

Topics
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• Adding a Variable

• Editing a Variable

• Removing a Variable

Adding a Variable
You must be a super administrator user to add variables to Report Manager. If you do not have access,
contact your Accela Implementation Specialist to change your permissions.

Variables are raw database scripts that you execute directly against an Oracle or MS SQL Server database
outside of a report writer or a development tool. You use variables as report parameters to populate
specific data in RTF template type reports developed using Microsoft Word. You can also use variables as
parameters in a URL string for a URL report. For example, to extract the primary owner full name, use the
database script in the report variable form. For instructions on adding this variable to an RTF template, see
Using RTF Templates or Setting Up URL Reports Containing Variables.

Civic Platform includes a set of frequently used runtime variables as a standard, out-of-the-box
configuration. You can use runtime variables in the WHERE clause of an SQL statement. You must
surround runtime variables by “$$” signs and must enclose them in single quotes for Civic Platform to
return the values as a string. For example, to retrieve the agency code for the logged in user, use ‘$
$ServiceProviderCode$$’. See the screenshot below for an example of how to use the session variable
within an SQL script. For a list of the standard runtime variables, see Adding a Report Parameter Variable.

Figure 66: Example of Runtime Variables in SQL Statement

BEST PRACTICE RECOMMENDATION
It is best practice to test your variables and your scripts in a test environment before running them against
a production database or making them available to reports.

This feature provides a way to run queries and simple scripts to return small amounts of data. Do not
use this tool to run complicated queries or scripts that return large amounts of data. Running these types
of queries against a production database can negatively affect the database and degrade application
performance, which causes portlets and lists to load slowly or become unresponsive. It is also possible to
lock the database, which prevents you from saving records and causes applications to stop responding.

A best practice recommendation is to add security parameters to these variables. You might have users
that do not have permission to view sensitive information, so it is important to write scripts that filter
sensitive data according to your agency’s best practices. For example, agencies that share a database
must add the $$ServiceProviderCode$$ parameter to display only records created by their agency.

To add a variable

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand Settings in the navigation tree.

Civic Platform displays the Report Manager setting options.
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3. Expand Variables in the navigation tree.

Civic Platform displays the variables available within Report Manager.

4. Right-click Variables and select the New Variable option.

Civic Platform displays the Report Variable form in the right window.

5. Complete the following fields:

Name Enter the name to describe the variable. For example, you might name a script that
returns the primary owner first and last name, “Primary Owner Full Name.”
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SQL Enter the database script into the SQL window. Make sure to test the script against
the database first. When filter data, you can use standard session variables as
described in Figure 66: Example of Runtime Variables in SQL Statement or hard code
the value. You can specify multiple columns in the Select statement as the value of
the variable.

Note:

If the variable populates a drop-down list parameter and its Select statement
contains multiple columns, the drop-down list parameter only read the first
column value from the Select statement.

6. Click Submit..

Civic Platform saves the variable.

Editing a Variable
Editing a variable might be necessary if a query fails against the database or you need to update it for any
reason. Any changes to variables results reflect in the reports using the variable. It is important to keep a
list of all variables used in each report and review them before making any changes.

To edit a variable

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand Settings in the navigation tree.

Civic Platform displays the Report Manager setting options.

3. Expand Variables in the navigation tree.

Civic Platform displays the variables available within Report Manager.
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4. Double-click the variable you want to edit.

Civic Platform displays the Report Variable details in the right window.

5. Edit the applicable fields below:

Name Update the name of the variable. For example, Primary Owner Full Name.

SQL Update the database script in the SQL window. Make sure you test the script against
the database first.

6. Click Submit..

Civic Platform updates the variable.

Removing a Variable
To remove a variable, you must first remove the variable from any reports that use it, specifically RTF
template and URL reports. After you remove variable it is no longer available to any reports.

To remove a variable

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand Settings in the navigation tree.

Civic Platform displays the Report Manager setting options.
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3. Expand Variables in the navigation tree.

Civic Platform displays the variables available within Report Manager.

4. Right-click the variable to remove and select the Remove Variable option.

Civic Platform removes the variable.

Adding a Report Parameter Variable
A list of frequently used runtime variables come standard with Civic Platform; you can use them in the
WHERE clause of an SQL statement. You must surround the runtime variables by “$$” signs and you must
enclose them in single quotes for Civic Platform to return the values in a string. For example, to retrieve
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the agency code for the logged in user, use ‘$$ServiceProviderCode$$’. Figure 66: Example of Runtime
Variables in SQL Statement displays how to use the session variable within an SQL script.

Table 148: Report Manager Variable Parameters  below lists the supported runtime report parameter
variables.

Table 148: Report Manager Variable Parameters

Variable Name Description

$$ID$$ ID1 Retrieves the record ID from a specific portlet.
This variable works only for portlet-specific
reports.

$$ID$$ ID2 Retrieves a second record ID from a specific
portlet. This variable works only for portlet-specific
reports.

$$capID1$$ CAPID1 Retrieves the first 5 characters of the record
ID from a specific portlet. Example: CAPID =
01BLD-00000-00018

$$capID2$$ CAPID2 Retrieves the second 5 characters of the record
ID from a specific portlet. Example: CAPID =
01BLD-00000-00018

$$capID3$$ CAPID3 Retrieves the last 5 characters of the record
ID from a specific portlet. Example: CAPID =
01BLD-00000-00018

$$department$$ Department Retrieves the department of the logged-in user.

$$gaUserID$$ GAUserID Retrieves the ID of the logged-in user.

$$module$$ Module Retrieves the module from a specific portlet.
For example, if the report is available in the
Building list portlet, Civic Platform sends the value
“building” to the report. This variable works only for
portlet-specific reports.

$$serviceProvCode$$ ServiceProviderCode Retrieves the ID for the agency. You can use
this to filter reports to include records only for the
specified agency. It is a required parameter for
many reports and agencies that share data.

$$FirstName$$ FirstName Retrieves the user’s first name.

$$MiddleName$$ MiddleName Retrieves the user’s middle name.

$$LastName$$ LastName Retrieves the user’s last name.

$$userfullname$$ UserFullName Retrieves the user’s full name.

$$userGroup$$ UserGroup Retrieves the group of the logged-in user.

$$userID$$ UserID Retrieves the ID of the logged-in user.

$$today$$ Today Retrieves today’s date. Civic Platform determines
this date by the workstation's system date. You
can use this variable parameter in calculations to
specify a date range. For example, enter $Today$
- 7 to query for all records over the last week.

$$portletID$$ Portlet ID Retrieves information on a portlet, such as a field
name.
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Using RTF Templates
Agencies can create frequently used letters and forms that use run-time variables to populate data from
the Civic Platform database. Variables can be standard session variables such as today’s date and your
agency name. Variables can also be custom SQL queries that extract specific data. For example, a
warning letter to a citizen about specific code violations can populate with the current date and your agency
name using session variables. You can use custom variables for the agency contact information, owner
contact information as well as the code violation case # and description. The letter can also include an
image, such as the agency’s logo.

You can develop letters and forms using Microsoft Word templates that you save as Rich Text Format
(RTF) files. You add these files to Report Manager; they are accessible from the Report Portlet or portlet-
specific reports menus. You can also save these files to an Electronic Document Management System
(EDMS). You also define the EDMS object to save the report to a record, parcel, workflow, asset condition
assessment, inspection, or set. For example, you can save an approval letter to build a new structure
to the building permit record. For more information and instructions, see Saving Reports to a Document
Management System.

The four major steps to create Rich Text Format (RTF) template based reports include:

• Create variables to embed in the report. A variable is an SQL statement that you add directly into
Report Manager

• Add the variables to Civic Platform using Report Manager so they are available to the RTF report at
runtime

• Create the report, including variables, using a word processor to create a template that you can save as
an RTF file

• Adding the RTF report to Civic Platform using Report Manager

For information and instructions on report variables, see Using Variables in Reports.

• Creating RTF Templates

• Adding RTF Template Reports to Report Manager

Creating RTF Templates
Rich Text Format (.rtf) template based reports use variables to populate data from the Civic Platform
database. Variables can be standard session variables that populate generic data such as today’s date,
agency name, user name, and specific module. These types of variables do not require any configuration;
you can use them as report parameters. For a list of session variables, see Table 148: Report Manager
Variable Parameters .

Variables can also be raw Microsoft SQL scripts that run against the database to extract specific
information. You can add these scripts to Report Manager and use them in reports, specifically RTF
template reports. For information on how to create variables, see Using Variables in Reports.

An RTF report template can have multiple variables. You surround these variables by the “<$” and “$>”
signs such as, <$capID$>. When the user runs a report, it replaces the defined variables with the actual
value from the SQL statement. You can return variable results in different formats such as a single column
and a single row, a single column and multiple rows, or multiple columns and a single row. The examples
below display how you can use the different formats within an RTF template report.

Example1. rtf in Figure 67: Single Column RTF Template Source File is an example of an RTF template
that uses a variable named <$Fees$>. At runtime, Civic Platform replaces <$Fees$> with the results of
an SQL query that returns a single column and multiple records. For an example, see Figure 68: Single
Column RTF Template Output.
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Figure 67: Single Column RTF Template Source File

Figure 68: Single Column RTF Template Output

In Figure 68: Single Column RTF Template Output Civic Platform replaces <$Fees$> with a list of fee
values returned from executing the following SQL statement:

Note:

SELECT FEE_VALUE “Fee List” FROM FEES WHERE...

Civic Platform replaces the heading for the variable <$Fees$> with the name of the column alias “Fee List”
from the SQL query. If you do not use an alias, the column name [FEE_VALUE] displays as the column
label.

Example2.rtf Figure 69: Multiple Column RTF Template Source File is an example of an RTF template that
uses a variable named <$Fees$> which has multiple columns and multiple rows.

Figure 69: Multiple Column RTF Template Source File

Figure 70: Multiple Column RTF Template Output



 | Part 6: Reporting and Analytics | 684

In Figure 69: Multiple Column RTF Template Source File, Civic Platform replaces <$Fees[0]$>, <
$Fees[1]$>, and <$Fees[2]$> with a list of fee values from executing the following SQL statement:

SELECT FEE_DATE “Fee Date," FEE_TYPE “Fee Type," FEE_VALUE “Fee Value”  
FROM FEES  

WHERE...

Civic Platform preserves spaces, tabs, text, or punctuation added to the template, as shown in Figure 70:
Multiple Column RTF Template Output, which enables you to embed variables within the text of a report.
For example, the property <$address$> in the city of <$city$> has violated Ordinance No. <$ordinanceNo
$>. The result of the report at runtime reads, “The property 111 N. 500 W. in Saint Mary’s City has violated
Ordinance No. 0098791.”

Create a template based report using a word processor such as Microsoft Word. After you create a
template, you must add it to Report Manager with the appropriate variables and report parameters for the
report to function correctly.

To create an RTF Template

1. Do the following to create an RTF-template-based report skeleton:

a. Open a new or existing Rich Text Format (RTF) file or Microsoft Word document.

b. Format the template and leave place holders for the fields you want populated from Civic Platform.

For example, enter brackets around the fields you want to populate. Civic Platform preserves
spaces, tabs, text, punctuation, and/or images.

c. Save the template on your local drive.

2. Create or use existing MS SQL script variables to populate the placeholders in the RTF report. Your
script might require more than one variable depending on the type of data.

For example, the RTF example requires two variables. The first populates the Owner Name [Full
Name], and the second populates the following fee information: [Fee Date], [Fee Type], and [Fee
Amount].

The column names in the select statement of the MS SQL script must match the order in which the
variables appear in the report. For example, [Fee Date], [Fee Type], and [Fee Amount] populate in this
order by entering the associated column names in the order they appear in the select statement of the
SQL script as illustrated here:

For more information on creating variables, see Adding a Variable.
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3. Do the following to set variables in the RTF template:

a. Open the template from your local drive.

b. Replace the placeholders with the name you want to use to identify the variable and enclose them in
<$ and $>.

For example, if the MS SQL script variable returns fee information, use <$Fees$>. If the variable
returns more than one value, add a number to define the order in which it displays in the SELECT
statement; start with zero (“0”). The example below uses the SQL statement from Step 2.

c. Save the template in Rich Text Format (.rtf) on your local drive.

4. Do the following to add the RTF report to Report Manager:

a. In the Setup portlet, click the Report item and choose Report Manager from the drop-down menu.

Civic Platform displays the Report Manager administration portlets.

b. Right-click a Reports by Category option in the left navigation tree and select New Report.

Civic Platform displays a new Report detail form in the right window.
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c. Complete the following required fields:

Name Enter the name of the report. The Name field is the name that appears in the
Reports portlet or portlet-specific report menu.

Category Select the category under which you want the report to display.

Process Service Select the RTF process service.

Civic Platform updates the Report Link to Template and displays a browse button.

d. Click Browse to find the report on your local drive.

Civic Platform displays the Windows Explorer with the folders on your local drive.
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e. Navigate to and click the report you want to add.

f. Click Open.

Civic Platform selects the RTF report and displays the file name for reference.

g. Complete the following required fields. For information on additional optional fields, see Table 144:
Report Detail.

Reports Portlet 1 - 5 Select each Reports Portlet on which you want to display the report. For
information and instructions on the location of these portlets and how to add them,
see Designing Forms for Portlets.

Save to EDMS Specify whether you want to save the report to EDMS. For more information, see
Saving Reports to a Document Management System.

h. Click Submit..

Civic Platform adds the report to Report Manager and displays it the report under the specified
category.

i. To preview the report, click Preview. This preview does not populate the variables but confirms you
have the correct template.

Civic Platform displays a preview of the report.

5. Do the following to link variable parameters to the RTF report:
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a. Click the Parameters tab.

Civic Platform displays the Parameters list portlet.

b. Click New.

Civic Platform displays the Parameters detail portlet.

c. Complete the following required fields. For the additional optional fields and their descriptions, see
Table 145: Report Parameter Field Definitions.

Name Enter the name of the parameter. For example, to add a variable parameter that
returns fee information, use “Fees.”

Type Select the Variable parameter type.

Report Parameter Name Enter the name of the variable. Use this name in the RTF template to specify the
location where you want to return and populate the variable values on your report.

For example, the template displayed in uses the “Fees” variable. This name must
match the exact spelling used in the RTF template.

Visible Select NO to send the parameters directly to the database and automatically
populate the RTF report without prompting the user.

Default Value Select the SQL script variable, that returns the values for the RTF report. For
example, use “Fees” to populate the fee information.

Display Order Enter the display order for the variable as it displays in the RTF template. The
display order defines the order in which Civic Platform runs the SQL script
variables and then returns values.

Figure 71: RTF Report Parameter Detail

d. Click Submit..

Civic Platform creates the variable parameter and then displays it in the Parameters list portlet.
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Adding RTF Template Reports to Report Manager
After you create your RTF template report and save it to your local drive, you can add it to Report
Manager. To add an RTF report you must first define the RTF report service. See Setting Up Report
Services for complete instructions on adding an RTF report service.

If your RTF template contains variables, you must define those variables as report parameters. For
example, if the template contains the variable <$Fees$>, you must identify and define a parameter for
Fees. The name of the parameter must match the exact spelling of the variable in the RTF report. If your
report contains more than one variable value, you can specify the order in which you want the values to
display on the report by defining the display order in the variables; start with 0 (zero). Refer to the following
sample screen which illustrates Fee Date, Fee Type, and Fee Value, along with their respective sort order
definitions [0], [1], and [2]:

You can save RTF template reports to an Electronic Document Management System (EDMS) allowing
the user to save a snapshot of data for historical purposes. You can also save RTF template reports as
specific EDMS object types such as records, parcels, workflow, asset condition assessment, inspections
and sets. Templates save automatically at runtime. For more information on saving to EDMS, see Saving
Reports to a Document Management System.

You can save RTF reports in multiple formats, including Microsoft Word and Adobe Acrobat (PDF). The
available output options are native to the report service. After you save an RTF report a Preview button
becomes enabled so you can preview the report prior to printing. To update the RTF report, you must
make the changes on your local drive and upload the updated template by clicking the Browse button in
the Report Detail portlet.

The steps below provide instruction on how to add an existing RTF report for which you previously defined
the variables. For instructions on creating a new RTF template report, see Creating RTF Templates.

To add RTF template based reports

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Right-click the Reports by Category option in the left navigation tree and select New Report.

Civic Platform displays a new report detail form in the right window.

3. Complete the following fields. For additional field definitions, see Table 144: Report Detail.

Name Enter the name of the report. The Name field is the name that appears in the report
portlet or portlet-specific report menu.

Category Select the category under which you want to display the report.

Report Service Select the RTF report service. If the RTF report service is not available, you must set
it up. For instructions, see Setting Up Report Services.

Civic Platform updates the Report Link to Template and displays a browse button.
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4. Click Browse to find the template report.

Civic Platform displays the Windows Explorer with the folders on your local drive.

5. Navigate to and click the report you want to add.

6. Click Open.

Civic Platform selects the RTF report and displays the file name for reference.

7. Complete the following fields. For additional field descriptions, see Table 144: Report Detail.
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Reports Portlet 1 - 5 Select each Reports Portlet where you want to display the report. For information
and instructions on the location of these portlets and how to add them, see Designing
Forms for Portlets.

Save to EDMS Specify whether you want to save the report to EDMS. For more information, see
Saving Reports to a Document Management System.

8. Click Submit..

Civic Platform adds the report under the specified category.

9. To preview the report before saving, click Preview.

Civic Platform displays report preview.

10.Do the following to link the variables in the RTF template:

a. Click the Parameters tab.

Civic Platform displays the parameters list portlet.

b. Click New.

Civic Platform displays the parameter detail portlet.

c. Complete the following fields. For field description on additional fields, see Table 145: Report
Parameter Field Definitions.

Name Enter the of the parameter. Example, date, status, fees, address info etc.

Type Select the Variable parameter type.

Report Parameter Name Enter the name of the variable. Use this name in the RTF template to specify
the location where you want to return and populate the variable values on your
report. For example, the report parameter name for the RTF template in Figure
69: Multiple Column RTF Template Source File is ‘Fees’.

Visible Select NO to send the parameters directly to the database and automatically
populate the RTF report without prompting the user.

Default Value Select the variable (sql script), that returns the values for the RTF report.

Display Order Enter the display order for the variable as it displays in the RTF template. The
display order defines the order in which the variable values display on your report.

d. Click Submit..

Civic Platform creates the variable parameter and then displays in the parameters list portlet.
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11.To add the RTF template report to run from a specific portlet, such as the Building portlet, click the
Portlets tab. For more information on adding reports to portlets, see Attaching Reports to a Portlet.

Saving Reports to a Document Management System
You can automatically save and categorize a report into a document type in an Electronic Document
Management System (EDMS). Saving reports to EDMS allows users to save a snapshot of data at any
given time. You save the template fields of the reports into the EDMS as part of the document information
(metadata) during report generation. Civic Platform synchronizes the template fields with the metadata in
the EDMS if you satisfy the following requirements:

• You must properly configure the standard choice EDMS; set the EDMS vendor to STANDARD and
append the string “VERSION=7.2.0” the end of the value description.

• You must define a set of application-specific information fields (document template fields or metadata)
for the document type you categorize the report into.

• The document template fields are mapped to session variables and SQL variables. For more
information about mapping document template fields to variables, see Defining Custom Fields
(Application Specific Information).

You can save reports and templates to any of the following EDMS object: Record, Parcel, Workflow, Asset
Condition Assessment, Inspection and Set. For example, to allow a user to save the C-403 report run
monthly, you can configure the report to save to EDMS and to the record, while also categorizing it to the
PDF category for the RepAttach group.

You can save reports to multiple Electronic Document Management Systems. For example, you might
want to save building permit reports to Civic Platform’s EDMS, and save the C-404 Statistical Reports to
your agency’s EDMS on your company Intranet. You can add additional Electronic Document Management
Systems by setting the appropriate Standard Choices. For instructions on adding new EDMS options, refer
to the “Standard Choices Reference” section of the Civic Platform Configuration Reference.

Saving reports to EDMS is available for all report types and all services with the exception of the client-side
executables.

To set a report to save to EDMS

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Use the navigation tree to find and click the report you want to save to EDMS.

Civic Platform displays the report details in the right window.

3. Complete following fields:
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Save to EDMS Choose Yes or No so specify whether or not to save to EDMS. If you choose Yes,
Civic Platform activates the Document Group/Category drop-down lists.

Document Group/
Category

Use the drop-down lists to select the document group and document category to
categorize the report. It is important to select the Document Group first because the
Category drop-down list loads based on which document group you choose.

EDMS Object Select the EDMS object type. Your options are: Record, Parcel, Workflow, Asset
Condition Assessment, Inspection and Set.

EDMS Select the Electronic Document Management System to which you wan to save the
report.

4. To test the report, click Preview.

Civic Platform runs the report and displays the report.

5. Click OK to save to EDMS.

Civic Platform saves the EDMS

6. Click Submit..

Civic Platform saves your EDMS report settings.

Using URL Reports
You can define a URL as a report source that a Civic Platform user can launch. For example, you can set
up a Permit Print report that users can run from an agency, from a government website, or from a report
server.

The URL feature can also launch a web page. For example, a clerk from the Health Planning and
Development confirms that a licensed professional architect’s license is valid according to the CSLB,
Consumer Affairs, Professional Engineers Board, and the Architects Board. A link to these websites and or
databases through a URL allows the user to access the information.

In addition, the agency's website or its document management system can also be helpful to the user.
These URL links and the URL reports are available from the reports portlet and specific portlet report
menu.

Topics

• Setting up URL Reports

• Setting up URL Links

• Setting Up URL Reports Containing Variables

Setting up URL Reports
You can define a URL string as a report source that a Civic Platform user can launch. For example, a
user can run a Permit Print report from an agency website, a government website, or a report server. You
configure this by appending the report URL with the parameters you want to pass. Civic Platform then
passes the parameters from the URL to the report server when a user clicks a link on a website.

The Permit Print report requires specific parameters to differentiate between the URL Permit Print and the
Civic Platform Permit Print report.

To set up a URL report

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Right-click Reports by Category from the navigation tree and select New Report from the menu.

Civic Platform displays a new report detail form in the right window.
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3. Complete the following required fields. For a list of field definitions, see Table 144: Report Detail.

Name Enter the name of the report. The name you enter displays in the Report Portlet or
portlet-specific report menu. If this is a Permit Print report, enter Permit Print.

Category Select the category the report belongs to.

Report Service Use the drop-down to select the URL_Report report service.

Report Link Enter the URL to the report source. For example, enter http://permit.accela.com.
To pass static parameters, include them in the URL address. For example, enter
http://permit.accela.com/PERMITID07BBP-00000-0010. To pass Accela-provided
parameters, you must add parameters in the Parameters portlet. You might also
need to accommodate the end of the URL to accept the parameter with /index.jsp so
that the parameter value matches the following example: http://permit.accela.com/
index.jsp/permitID=07BBP-00000-0010. For instructions on adding parameters, see
Setting up Report Parameters.

Note:

You must specify the server name (not IP address or domain) in the
report link URL if you want to apply NT authentication for the report. Here
is an example of the report link with NT authentication: http://reporting/
ReportServer$SQL2K5.

4. Click Submit..

Civic Platform saves the URL report.

5. To add parameters to the report click the Parameters tab. For instructions, see Setting up Report
Parameters or Setting Up URL Reports Containing Variables.

Setting up URL Links
The URL feature can also launch a web page. For example, a clerk from the Health Planning and
Development confirms that a licensed professional architect’s license is valid according to the CSLB,
Consumer Affairs, Professional Engineers Board, and the Architects Board. A link to these websites and
or databases through a URL allows the user to access the information. Linking to your agency website or
your document management system can also be helpful to the user. Adding URL links to the support page
provides easy access to user forums and technical assistance.

To set up a URL link from the reports portlet

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).
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2. Right-click the Reports by Category from the navigation tree and select New Report from the menu.

Civic Platform displays a new report detail form in the right window.

3. Complete the following required fields. For a list of field definitions, see Table 144: Report Detail.

Name Enter the name of the URL link. The name you enter displays in the Report Portlet or
portlet-specific report menu. For example, enter “Support.”

Category Select the category the report belongs to. For example, enter “Company Information.”

Report Service Use the drop-down to select the URL_Report report service.

Report Link Enter the URL to the website or service. For example, enter “http://www.accela.com/
support/support_overview.asp”

4. Click Submit..

Civic Platform saves the URL link.

Setting Up URL Reports Containing Variables
Variables are raw database scripts Civic Platform executes directly against the Civic Platform Oracle or
MS SQL Server database outside of a report writer or development tool. You can use these scripts to pass
parameters to a URL report, like variables in an RTF report. Before you can run a report, you must set up
the variables and a URL report service in Report Manager. For information on how to set up a variable,
see Using Variables in Reports. For information on how to set up a report service, see Setting Up Report
Services.

A super administrator can add variables to Report Manager and specify them as accessible to users along
with Civic Platform session variables. You can then define the number rows you want to return from these
variables to your report by adding them to the end of the report URL.

The following example demonstrates how to set-up and run a URL report using a variable and limiting the
number of rows returned.

A Civic Platform administrator develops a report to open the EDMS for up to 5 parcel numbers for specific
record selected from Civic Platform.

How to set up a URL report containing and limiting the return of variables

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. In the navigation tree, expand the Settings node and click Variables to create a variable within Report
Manager using super agency user rights.

For example, the variable in the graphic below specifies the return of all parcel numbers for a record.
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3. Add a Variable.

a. Right-click the Variables option in the navigation tree and then click New Variable OR

Click Menu and choose New Variable.

b. Type in Name of the Variable

c. Enter the SQL script with the Standard Session Variables. Example, ‘$$capId1$$'

If you need more information about Variables, see Adding a Variable.

4. Click Menu and choose New Report from the drop-down list.

5. Complete the following required fields. For a list of field definitions, see Table 144: Report Detail.

Name Enter the name of the report. The name you enter displays in the Report Portlet or
portlet-specific report menu. If this is a Permit Print report, enter Permit Print.

Category Select the category the report belongs to.

Report Service Use the drop-down to select the URL_Report report service.

Report Link Enter the URL to the report source. For example, enter http://permit.accela.com. To
pass static parameters, include them in the URL address. For example, enter http://
permit.accela.com/PERMITID07BBP-00000-0010.

To pass Accela-provided parameters, you must add parameters in the Parameters portlet.

6. Click Submit.

7. Add variable information:

a. Click the Parameter tab.
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b. Click New to add a new variable. For a list of session variables, see Table 148: Report Manager
Variable Parameters .

c. Complete the fields as described in Table 145: Report Parameter Field Definitions.

For this example, the parameter is a variable type that returns 5 rows.

d. Click Submit..

8. Assign permissions to the appropriate modules or users to access the URL report. For information on
how to assign permissions, see Assigning Permissions to Reports.

The following example shows the URL report assigned to the Licenses Module.

9. Add the URL report to the appropriate portlet. For information on how to add a report to a portlet, see
Adding a Report to a Portlet.

The following example shows the URL report assigned to the Record Detail Form.

10.Run the report

a. Navigate to the portlet to which you want to run the report.

For this example, Building> select a permit in the Record portlet.

Open a permit record, click the Reports menu, and choose the report from the drop-down list.
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Civic Platform opens a new window to display the URL report.

Invoking a Client-Based Application
You can launch client-side executables (Microsoft Word and Microsoft Excel) from a report menu. This
enables users to launch reports that reside on their local machine from within Civic Platform, and populate
those reports with data from Civic Platform. Use this feature to invoke any type of client-side executable,
such as Crystal Reports, a custom application that you use for internal processing, or to print a report on a
special printer that requires a client-side application.

To use this feature for reports developed in Microsoft Excel, the user must save the file on their local
workstation. The user does not enter the file at runtime nor does the report use an existing report file from
the report directory. You define the path to this executable file when creating a Client_EXE report service.
For example, enter c:/program files/microsoft office/exel.exe in the Report Service URL field.

Any number of Excel reports on a client’s workstation can use this report service by creating different
reports. To define the report file path, you must create a very specific report parameter. You must set
the Report Parameter Name “File_Path” and the Default Value defines the path to the spreadsheet. For
example, c:/MyDocuments/Spreadsheets.xls. This parameter must be present or it prevents the file from
opening and the user receives an error. You must identify any parameter values you want to pass to the
report as additional report parameters. For instructions, see Setting up Report Parameters.

Client-side executables, with the exception of Microsoft Excel, do not require the “File_Path” parameter.
You can include the file path in the command line for the Report Service URL. Use this option for
executables that you do not use for multiple reports, such as a letter template that populates the agency
name, and address. The Report Service URL includes the path to the executable and the report’s file.

To pass static parameter values to a report or program, you must add them to the end of the command
line. For example, to execute a letter with the agency name and address, use the command line; c:/
program files/microsoft word/word.exe C:/MyDocuments/Documents.doc ‘Accela, Inc.’ ‘555 So. Main
Street, Sandy, Utah’. To pass parameters from the Civic Platform database, you must define the individual
parameters for the report. For instructions, see Setting up Report Parameters.

Client-side executable type reports cannot save to an Electronic Document Management System (EDMS).
However, users can save the report to their local machine with the standard save options in programs such
as Word and Excel.

To add a client-side executable

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the Settings node in the navigation tree.

3. Right-click the Report Services option and select New Report Service from the menu.
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Civic Platform displays the Report Service Form.

4. Complete the following fields:

Report Service Name Enter the name of the report service. Use a name that describes the executable.
This name appears in the Report Service drop-down list in the report detail form. For
example, enter MS Excel EXE.

Report Service Type Select the Client_EXE option.

Report Name List URL Enter the file path to the executable. For example, enter “c:/program files/microsoft
excel/excel.exe" If you are defining a path for an executable other than Microsoft
Excel, you can define the file path and the static parameters at the end of the
command line. For example, enter “c:/program files/microsoft word/word.exe C:/
MyDocuments/Documents.doc ‘Accela, Inc.’ ‘555 So. Main Street, Sandy, Utah’”

Report Service URL Report Service URL is the server address.

5. Click Submit..

Civic Platform saves the report service.

6. Right-click Reports by Category and select the New Report option.

Civic Platform displays the report detail form.
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7. Complete the following fields:

Name Enter the name of the report.

Category Select the category the report should display under.

Report Service Select the client-side executable report service. For example, select MS Excel EXE or
MS Word EXE.

8. Click Submit..

Civic Platform saves the report detail.

9. For Microsoft Excel reports, click the Parameters tab.

Civic Platform displays the report parameters list form.

10.Click New.

Civic Platform displays the report parameter detail form.

11.Complete the following fields:

Name Enter the name “File Path” to identify the special file path parameter.

Type Select the String data type.

Report Parameter Name Enter “File_Path” as the report parameter name. This parameter name must be
present for the excel file to open on the user’s workstation.

Default Value Enter the path to the file on the user’s workstation. For example, enter “c:\My
Documents\Spreadsheets.xls” as shown in Figure 71: RTF Report Parameter Detail.

12.Click Submit..

Civic Platform saves the report parameter.
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13.To add parameter values to pass to the report, click New. For information and instructions in Setting up
Report Parameters.

Running Reports in EMSE
The Event Management Scripting Engine (EMSE) has full control of launching reports set up in Report
Manager. EMSE retrieves the Report Object through the report name and automatically provides
parameter values. You can set up reports to save automatically to an Electronic Document Management
System (EDMS) in a variety of formats including Adobe Acrobat (.pdf), Microsoft Excel (.xls), and Rich Text
Format (.rtf). You can set up an event script to send and save reports to multiple destinations, and then run
the reports multiple times. Contact your Accela Services Implementation representative for information on
writing and running this kind of event script. For general information on using scripts in Civic Platform, see
the Accela Civic Platform Scripting Guide.

Setting a Default Printer
To send a report directly to a printer when a user runs it, you must identify a default printer. The default
printers added to Report Manager are available in the Report Detail form portlet shown in Figure 72:
Default Printer Drop-down List. You select these printers from the network printer list, ensuring the
accessibility to the printer when running the report.

Figure 72: Default Printer Drop-down List

A report that has a default printer assigned prints automatically when a user selects it from the Reports
Portlet or from a specific portlet's report menu. You can also set a report with an assigned printer to run
based on the status change of a specific workflow task. You can also set a report with an assigned printer
to run based on the status change of a specific workflow task. For example, a user prints an application
at the time of acceptance. When the user runs the report they receive a message notifying them that the
report printing is complete.

To add a default printer to a specific report, select the printer in the Report Detail form portlet. For more
information on the Report Detail form portlet, see Adding a Report.

To add a default printer

1. Access the Report Manager portlet (Accessing the Report Manager Portlet).

2. Expand the Settings option from the navigation tree.

3. Right-click the Printers option and select New Printer from the menu.
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Civic Platform displays the add printer portlet.

4. Complete the following fields:

Printer Name Enter the name of the printer. This name displays in the default printer drop-down list
in the Report Detail form.

Printer Select the network printer you want to use as a default printer when automatically
printing reports.

5. Click Submit..

Civic Platform saves the network printer as the default printer.

Using Barcodes in Payment Reports
Payment reports such as invoices developed in Civic Platform can use barcodes to enhance process
efficiency.

Barcodes imprinted in the reports or invoices must follow code 39. Each barcode represents some field
value, for example, record ID, receipt number, and invoice number. With the reports in the Payments
portlet, you can embed a hot key combination in a barcode. When users scan the barcode, the cursor
automatically moves to the field indicated by the hot key setting, and the value in the barcode populates
the field.

Table 149: Barcodes for Hot Keys lists the hot keys in the Payment Processing portlet that can be
embedded in barcode.

Table 149: Barcodes for Hot Keys

Hot Key Barcode for the Hot Key Task

Ctrl + Shift + 1 .W.X1.X.W To go to the 1st field in the portlet that can get
focus.

Ctrl + Shift + 2 .W.X2.X.W To go to the 2nd field in the portlet that can get
focus.

Ctrl + Shift + 3 .W.X3.X.W To go to the 3rd field in the portlet that can get
focus.

Ctrl + Shift + 4 .W.X4.X.W To go to the 4th field in the portlet that can get
focus.

Ctrl + Shift + 5 .W.X5.X.W To go to the 5th field in the portlet that can get
focus.

Ctrl + S (TBD) To go to the global search field in the portlet.

Note:
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Hot Key Barcode for the Hot Key Task

After you move the cursor to the global
search field, you cannot go to the other
fields by scanning the other barcode.
This behavior is unique to this hot key.

The Intermec SR30 Handheld scanner is the only scanner that Civic Platform supports for the barcode
scanning feature. For information about installation and configuration of the barcode scanner, see
“Barcode Scanner Configuration” in the Accela Civic Platform Installation Guide.

SmartCharts
Click a topic title below for full details.

Related Links

Creating a SmartChart

Searching for a SmartChart

Editing a SmartChart

Deleting a SmartChart

Managing SmartChart Permissions

Managing SmartChart Queries

Creating a SmartChart
You can create a SmartChart based on the queries your Accela implementation specialist defines.

To create a SmartChart

1. Access the SmartChart portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays a blank form in the record detail portlet.
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3. Complete the applicable fields.

For descriptions of fields, see Table 150: SmartChart Setup Fields.

4. Click Submit to save the SmartChart.

Civic Platform updates the SmartChart list.

5. Assign the SmartChart to the desired user groups.

For instructions, see Managing SmartChart Permissions.

Table 150: SmartChart Setup Fields

Background Color You can enter the HTML hexadecimal equivalent for the color you want directly into
this field, if you know what it is. Otherwise, click the icon next to this field and choose a
color from the color palette.

Category (X) Axis Label If you are setting up a column bar chart or a line chart, enter the text you want to
display as a label below the horizontal category axis.

Chart Type Select one of the following: Column Bar Chart, Line Chart, Pie Chart, Odometer,
Speedometer.

Column If you are setting up a column bar or a line chart, choose a column from the list that you
want to use to group the SmartChart values. For example, if you want to display a line
chart showing the number of each permit application type in your list, choose “Record
Type Alias.”

Critical Start If you are setting up a speedometer, enter the value where you want the speedometer
to start displaying a different color, which indicates a critical zone.

Data Source Type Select a data source type.

Date Column
Calculations

If you are setting up a column bar or a line chart, select this option to base your
statistical function and resulting SmartChart values on date columns (today, assigned
date, closed date, and opened date). Use the Date Operand drop-down lists to specify
the starting and ending dates you want to use. Civic Platform subtracts one date from
the other and determines the number of days between these dates. Civic Platform
uses this number to calculate the resulting SmartChart values. For example, if you
want to determine the total number of days it took to process certain types of permit
applications after they were submitted, select “Closed Date” in the first operand field
and select “Opened Date” in the second.
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Module Select a module.

Numeric Columns If you are setting up a column bar or a line chart, select this option if you want to
base your statistical function and resulting SmartChart values on a numeric column.
Specify the numeric column you want to use. For example, if you want to display a pie
chart showing on average how far along certain types of permit applications are in the
permitting process, choose “Percent Complete.”

Query Select a query.

Range End If you are setting up a speedometer, enter the highest value you want to display on the
speedometer; this serves as the ending point of your range.

Range Start If you are setting up a speedometer, enter the lowest value you want to include on the
speedometer; this serves as the starting point of your range.

Show Category Value
(Vertical) Axis

If you are setting up a column bar or a line chart, choose “Yes” from the drop-down list
to display a label below the horizontal (category) axis.

Show Legend If you are setting up a line chart or a pie chart, select “Yes” if you want to display a
legend with the SmartChart.

Show Title Select “Yes” if you want to display the title at the top of the SmartChart; otherwise,
select “No.”

Show Value (Y) Axis
Label

If you are setting up a column bar or a line chart, choose “Yes” from the drop-down list
to display a label to the left of the vertical (value) axis.

SmartChart Title Enter a name to help you identify the SmartChart.

Statistical Function If you are setting up a column bar or a line chart, choose the statistical function from
you want to use to calculate numeric SmartChart values. You can choose from the
following functions: average, sum, count, minimum, maximum, standard deviation,
variance. For example, if you want to display a line chart showing the number of each
permit application type in your list, choose “Count.”

Thumbnail Height Enter the desired height in pixels. In combination with the Thumbnail Width field, this
determines the size of thumbnail view of the SmartChart.

Thumbnail Width Enter the desired width in pixels. In combination with the Thumbnail Height field, this
determines the size of the thumbnail view of the SmartChart.

Value (Y) Axis Label If you are setting up a column bar or a line chart, enter the text you want to display as a
label to the left of the vertical (value) axis.

Warning Start If you are setting up a speedometer, enter the value where you want the speedometer
to start displaying a different color, which indicates a warning zone.

Searching for a SmartChart
This section describes how to search for a SmartChart.

To search for a SmartChart

1. Access the SmartChart portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the SmartChart search form.

3. Edit any of the fields that display.

For field descriptions, see Table 150: SmartChart Setup Fields.

4. Click Submit.

Civic Platform returns a list of SmartCharts that match your search criteria.
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Editing a SmartChart
This section describes how to change existing SmartChart definitions.

To edit a SmartChart

1. Access the SmartChart portlet (Navigating to the Setup Portlet).

2. Click the link in the SmartChart Title column to the SmartChart you want to edit.

If you do not see the SmartChart you are looking for, click Search. See Creating a SmartChart Query
for a list of field descriptions.

Civic Platform displays the chart details in the record detail portlet.

3. Edit any of the fields that display.

For field descriptions, see Table 150: SmartChart Setup Fields.

4. Click Submit.

Civic Platform saves your changes and updates the SmartChart list.

Deleting a SmartChart
If you no longer need a SmartChart, you can remove it from Civic Platform.

To delete a SmartChart

1. Access the SmartChart portlet (Navigating to the Setup Portlet).

2. Select the SmartChart you want to remove.

Note:

Ensure the SmartChart you select is the one you want to delete. If you remove the wrong SmartChart,
you must recreate it.



 | Part 6: Reporting and Analytics | 707

If you do not see the SmartChart you are looking for click Search and locate it. See Table 150:
SmartChart Setup Fields for a list of field descriptions.

3. Click Delete.

Civic Platform updates the SmartChart list.

Managing SmartChart Permissions
Topics

• Assigning Permissions to a SmartChart

• Removing Permissions from a SmartChart

Assigning Permissions to a SmartChart
You can assign SmartCharts to an agency, a module, or a user group, which enables you to control
user access to a SmartChart. For example, SmartCharts that you assign to a user group automatically
display in the SmartChart portlets of users who belong to the group. Users who do not want to view the
new SmartChart can remove it manually by customizing the portlet contents. For more information on
configuring portlets, see Setting Up Your Console and Home Page. To configure forms and views, see
Designing Forms for Portlets.

To assign permissions to a SmartChart

1. Access the SmartChart portlet (Navigating to the Setup Portlet).

2. Click the link in the SmartChart Title column to the chart you want to assign permissions.

If you do not see the SmartChart you are looking for, click Search and locate it. See Table 150:
SmartChart Setup Fields for a list of field descriptions.

Civic Platform displays the chart details in the record detail portlet.

3. Click the Recipient tab.

Civic Platform displays a list of agencies, user groups, and users that can currently view the
SmartChart.

4. Do one of the following to select the organization level to which you want to assign the SmartChart:

• Click Assign Agency to assign the SmartChart to an entire agency.

• Click Assign Module to assign the SmartChart to all groups associated with a module.

• Click Assign User Group to assign the SmartChart to all members of a user group.

Civic Platform displays an organization structure hierarchy that corresponds to the level you
selected. For example, a hierarchy of all the user groups in your agency.

5. Click the specific agency, module, or user group to which you want to assign the SmartChart.



 | Part 6: Reporting and Analytics | 708

6. Click Submit.

Civic Platform updates the recipient list.

Removing Permissions from a SmartChart
You can remove access rights to a SmartChart from an agency, a module, or a user group.

To remove a SmartChart from a recipient

1. Access the SmartChart portlet (Navigating to the Setup Portlet).

2. Click the link in the SmartChart Title column to the chart you want to assign permissions.

If you do not see the SmartChart you are looking for click Search and locate it. See Table 150:
SmartChart Setup Fields for a list of field descriptions.

Civic Platform displays the chart details in the record detail portlet.

3. Click the Recipient tab.

Civic Platform displays a list of agencies, user groups, and users that can currently view the
SmartChart.

4. Select the recipient from which you want to remove the SmartChart.

5. Click Delete.

Managing SmartChart Queries
Agencies that host their own Civic Platform permit applications can manage the queries that return the
information that SmartCharts format. On-premise system administrators can manage these queries by
clicking the SmartChart Queries link located in the Setup portlet of Civic Platform. These queries display
the SmartChart queries in Civic Platform.

A “Super Agency” does not currently exist for SmartCharts; administrators can create queries only for
the agency to which their log in applies. Administrators who want to create a query for multiple agencies
must create the same query using an administrator log in for each agency in which they want to create the
query.

Note:

Use caution when creating queries so that you do not inadvertently grant access to sensitive data. Queries
can provide access to sensitive data and can require an in-depth knowledge of the Civic Platform database.
Staff who create queries should have an in-depth knowledge of SQL and a copy of the Civic Platform ERD
(Entity Relationship Diagram) for the Civic Platform version that they are using.

Topics

• Creating a SmartChart Query

• Searching for a SmartChart Query

• Editing a SmartChart Query
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• Deleting a SmartChart Query

Creating a SmartChart Query
This section describes how to create a SmartChart query.

To create a SmartChart query

1. Access the SmartChart Queries portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays a form beneath the query list you use to enter query information.

3. Enter information in the following fields:

Query Name Enter a name that describes the information the query retrieves.

Query SQL Enter the SQL for the Query.

The return set of the SQL statement must always have the signature <NUMBER>, <STRING>. For
example, the following statement is not valid because its signature is <STRING>, <STRING>:

Select b1_per_id1, b1_per_id2 from b1permit where serv_prov_code = ‘$
$SERV_PROV_CODE$$’

The following correction is valid, because “count(*)” is of type <NUMBER> and b1_per_id1 is of type
<STRING>:

Select count(*), b1_per_id1 from b1permit where serv_prov_code = ‘$
$SERV_PROV_CODE$$’ group by b1_per_id1

The reason for this requirement is intuitive for the Column Bar, Line, and Pie chart types. <NUMBER> is
the value for the Y axis and <STRING> is value for the X axis.

Note that even though the speedometer and the odometer chart types only expect a single numeric
value, the SQL statement still requires the <NUMBER>, <STRING> signature, for consistency. You
cannot enter statements that do not have the <STRING> part of the signature. For example, the
following statement does not work for an odometer chart, because the signature of the return set is just
<NUMBER>:

Select count(*) from b1permit where 
serv_prov_code = ‘$$SERV_PROV_CODE$$’

Instead, write the statement as follows:

Select count(*), ‘BLANK’ from b1permit where serv_prov_code = ‘$
$SERV_PROV_CODE$$’

The <STRING> (‘BLANK’ in this case) can be any value except an empty string.

Note:

Civic Platform provides a few useful environment variables for your Queries. Prefix the variables with “$
$” and terminate them with “$$” Remember to surround variables with single-quotes (‘) if you want Civic
Platform to interpret them as strings. You can use the following environment variables anywhere in your
Queries:

$$SERV_PROV_CODE$$. The Service Provider Code (Agency) of the user currently logged-in.

$$USERID$$. The User ID of the user currently logged-in.

4. Click Submit.

Civic Platform saves the query and adds it to the query list. This query is now available to
administrators from the Query drop-down on SmartChart forms.
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Searching for a SmartChart Query
This section describes how to search for a SmartChart query.

To search for a SmartChart query

1. Access the SmartChart Queries portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the SmartChart Query search form.

3. Edit the following search criteria as desired:

Query Name Edit the query’s name.

Query SQL Edit the SQL for the query.

4. Click Submit.

Civic Platform returns a list of SmartChart queries that match your search criteria.

Editing a SmartChart Query
This section describes how to edit a SmartChart query.

To edit a SmartChart query

1. Access the SmartChart Queries portlet (Navigating to the Setup Portlet).

2. Click the link in the Query Name column of the query you want to edit.

3. Edit information in the following fields, as desired:

Query Name Edit the query’s name.

Query SQL Edit the SQL for the query.

4. Click Submit.

Civic Platform validates the Query. If the query does not execute, or does not have the correct result
set signature (<NUMBER>, <STRING>), then Civic Platform displays an error message. If there is no
error message, the Query becomes available to administrators on the Query drop-down on SmartChart
forms.

Deleting a SmartChart Query
This section describes how to delete a SmartChart query.

To delete a SmartChart query

1. Access the SmartChart Queries portlet (Navigating to the Setup Portlet).

2. Select the query you want to delete.

Use caution when selecting a query to delete; if you delete the wrong query you might need recreate the entire
query.

3. Click Delete.

Civic Platform deletes the query and updates the query list.
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Part 7: Accounting
Civic Platform provides accounting functions.

Related Links

Understanding Fee Items

Fee Formulas

Invoices and Payment Periods

Trust Accounts

Point of Sale

Payment Processing

Time Accounting Tracker

Setting Up Fees
This section provides information about the various ways to implement fees and their associated
administrative setup. Before you begin, familiarize yourself with the fee setup process as explained in
Understanding Fees and Citizen Access.

Click a topic title below for full details.

Related Links

Understanding Fees and Citizen Access

Managing Fee Schedules

Understanding Fee Items

Setting Up a Flat Fee Item

Working with Point of Sale Fee Items

Creating Fees with Fee Calculation and ASI Data

Adjusting Fees Based on Agency Valuation

Adjusting Fees based on Occupancy Versioning

Working with Occupancy Groups

Prioritizing Fees Using Pay Allocation

Enabling Fee Estimation

Purging Partial Application Fees

Understanding Fees and Citizen Access
To ensure Citizen Access generates the fees you want to make available to public users on an application
type, do the following:

• Enable the record types you want available in Citizen Access.
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• Verify that the Fee Items that you assign to record types available in Citizen Access have the ACA
fields defined. Refer to Understanding Fee Items.

• Ensure that the following elements have the required fields defined that enable fee calculations to
obtain the data necessary to generate the fee:

• the application-specific information tables

• application-specific groups

• workflow task-specific information groups

Managing Fee Schedules
Topics

• Searching for a Fee Schedule

• Creating a New Fee Schedule

• Editing a Fee Schedule or Creating a New Version

• Managing Fee Groups

• Copying a Fee Schedule

• Assigning a Module to a Fee Schedule

Searching for a Fee Schedule
If you want to locate a particular fee schedule for editing or informational purposes, you can do a search for
it. There are multiple ways to search for a Fee Schedule. You can search for fee schedules by name, date,
or status.

To search for a Fee Schedule

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Schedules.

Civic Platform displays the Fee Schedule - Search Screen

Enter your search criteria with one of the search options below:

a. To search by Fee Schedule.

Enter the name of an existing fee schedule in the Fee Schedule field.

b. To search by Version

Enter the name of an existing fee schedule in the Fee Schedule field

Then, enter the version in the Version field. You cannot perform a search by version alone.

c. To search by Effective Date

Click Date to select a date from the calendar or enter a date into the Effective Date field manually.

d. To search by Status

To return all fee schedules select All.

To return only enabled fee schedules, select Enable.

To return only disabled fee schedules, select Disable.
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3. Click Submit.

Civic Platform returns a list of fee schedules meeting the defined search criteria.

Creating a New Fee Schedule
Civic Platform provides a way to easily create a fee schedule that can have multiple version numbers that
relate to the effective date. Although you can create multiple versions of a fee schedule, only one can be
active and enabled at a time. You can configure different versions of a fee schedule, so that the amount of
the fee matches the rate of inflation.

To create a fee schedule

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Schedules.

3. Click Add.

Civic Platform displays the Fee Schedule - Add screen.

4. Complete the fields. See Table 151: Fee Schedule Fields for a list and description for each fields.

5. Click Submit.

Table 151: Fee Schedule Fields

Comment Provide a comment or a description about the fee schedule. For example, this fee is for
a registration or a mobile home application fee.

Disabled On The last date you enabled the fee schedule. The effective date for a fee schedule is the
enable date from one version to the enable date of the next version. The disable date is
for your informational and is optional.

Effective Date Enter the start date for the fee schedule.

Fee Schedule Provide the name for the fee schedule.

Status Select whether the fee schedule is active. Choose between Enable or Disable.

Version Enter the version for the fee schedule. The version must be unique for the fee
schedule. Version can be alphanumeric with special characters.

Editing a Fee Schedule or Creating a New Version
After you create a fee schedule, you can modify it to create a new version. You can also edit any fee
schedule to change effective dates or status.
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To edit a fee schedule

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Schedules.

3. Search for an existing fee schedule. For more information on how to search for a fee schedule, see
Searching for a Fee Schedule.

Civic Platform returns a list of fee schedules meeting the search criteria.

4. Click the red dot next to the fee schedule you want to edit.

Civic Platform displays the Fee Schedule - Edit screen

5. Edit the Fee Schedule. Refer to the following editing options:

• Modify your fee schedule. Edit fields using the list of field descriptions, see Table 151: Fee Schedule
Fields.

• Create a new Version for a fee schedule.

Click Create New Version and complete the fee schedule fields to create a new version of the fee
schedule. The old version remains unchanged.

• Add, Edit, or Disable Fee Items from the fee schedule.

Click Add to add a Fee Item or click the red dot next to the Fee Item you want to edit.

For more information on fee items, see Setting Up a Flat Fee Item.

6. Click Save.

Managing Fee Groups
In a fee schedule, you can create fee item groups comprised of one or more fee items. When adding fee
items to a group, you can add them to an existing group or create a new group for them. When a group is
no long used by any fee item, Civic Platform automatically deletes the group.

Topics

• Adding Fee Items to a Fee Group

• Removing Fee Items from a Fee Group

Adding Fee Items to a Fee Group
You can set up a group that contains one or more fee items. You can add a fee item to one or more
groups. See Figure 73: Fee Item List.

Figure 73: Fee Item List

To add fee items to a fee group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Schedules.
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3. Search for an existing fee schedule. For more information on how to search for a fee schedule, see
Searching for a Fee Schedule.

Civic Platform returns a list of fee schedules meeting the defined search criteria.

4. Click the red dot next to the fee schedule you want to edit.

Civic Platform displays the Fee Schedule - Edit screen page.

5. Select the fee items that you want to add to the one or more groups.

6. Click the Add to Group button.

Civic Platform displays the Fee Item - Assign to Group window.

7. Do one of the following:

• To create a new group for the fee items, enter a group name in the Add to New Group field.

• To add the fee items to the existing groups, select the groups you want in the Add to Existing
Group list.

• To add the fee items to a new groups as well as to existing groups, do both of the previous steps.

8. Click Submit.

Removing Fee Items from a Fee Group
You can remove fee items from assigned groups. Civic Platform automatically deletes groups that do not
have any fee items.

To remove fee items from a fee group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Schedules.

3. Search for an existing fee schedule. For more information on how to search for a fee schedule, see
Searching for a Fee Schedule.

Civic Platform returns a list of fee schedules meeting the defined search criteria.

4. Click the red dot next to the fee schedule you want to edit.

Civic Platform displays the Fee Schedule - Edit screen page.

5. Select the fee items you want to remove from their assigned groups.

6. Click Remove from Group.

Civic Platform displays the following page.
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7. Select each group in the Available Groups list that you want to remove the fee item from.

8. Click Submit.

Copying a Fee Schedule
You can copy a fee schedule to create a new fee schedule version and also to eliminate the task to
recreate fee items. After you copy the fee schedule with a new name, you can edit the schedule name and
modify fee items as appropriate to your agency objectives.

To copy a fee schedule

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Copy Schedule.

Civic Platform displays the Copy Schedule window.

3. Complete the fields:

Schedule Name Enter a name for the schedule.

Copy Schedule From Choose an existing schedule from the drop-down list.

4. Click Submit.

5. Edit the fee item as appropriate to your agency's objectives. For instructions, see Editing a Fee
Schedule or Creating a New Version.

Assigning a Module to a Fee Schedule
By default, every fee schedule functions in all modules. You can, however, limit a fee schedule to work in
specific modules. For example, if your agency has a building module, a code enforcement module, and a
service request module, you can have fee schedules, specific to building permits, that you do not want to
assign to the other modules.

To assign a module to a fee schedule

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Manage Schedule.

Civic Platform displays the Fee Schedule Search window.
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3. Enter any search criteria. You can leave these fields blank to return all the fee schedules.

4. Click Submit.

Civic Platform displays the following page.

5. Click the red dot by the fee schedule you want to work with.

Civic Platform displays the Fee Schedule Edit window.

6. Use the drop-down list to select a module to assign.

7. Click Save.

Civic Platform returns to the Fee Schedule Browse page.

8. For each additional module you want to assign, repeat steps 4-6.

Understanding Fee Items
Topics

• Understanding Fee Items

• Searching for a Fee Item

• Copying a Fee Item

Understanding Fee Item Fields
This section provides you with descriptions of fee items fields. It is critical to understand how the fee item
configuration works so you can create the various ways to create fees in Civic Platform. This section
provides instructions on how to create simple fees and complex fees.
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To access the fee item page

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Item.

Civic Platform displays the Fee Item-Search page.

3. Choose one of the following to access a Fee Item page:

• Click Add to create a new fee item.

• Click Submit with or without any search criteria. Select a fee item from the results list to display the
Fee Item Edit page displays.

Figure 74: Fee Item-Add Page

Table 152: Fee Item Fields

Fee Item Code Enter a unique code to identify the source or purpose of the fee item. For example,
if you use this fee item to calculate the value of a window as part of a remodeling
project, enter “Window.”If it is a Point of Sale item, provide a unique code to identify
the POS item's source and purpose. For example, shirt, hat, map, or mug.
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Fee Schedule Enter the fee schedule that this fee item belongs to. For example, enter
“Remodel.”For a Point of Sale item, make certain that the fee schedule
is exactly the same as the Standard Choice Value Description for
POINT_OF_SALE_FEE_SCHEDULE.

Note:

You can add the same fee item to different fee schedules by copying a fee
item and changing the fee schedule or applying it to a new version of the
fee schedule.

Version Choose the version for the fee schedule set up for the fee item. A fee schedule can
have different versions based on the start and end dates.

Fee Description Enter a brief description of the fee item to identify its source or purpose. For
example, enter “Remodel Window Fee” or a “Map of Sandy City and Streets” for a
Point of Sale item.

Comment Enter a detailed description of the fee item to explain the fees purpose, logic, and
any additional information associated to the fee.

Unit Choose a fee unit from the drop-down list. For example, if you assess the fee
depending on area, select the unit representative of square footage.

Calc Formula Choose the formula that you want to use to calculate this fee item. Accela provides a
list of standard fee formulas when you implement Civic Platform.

For all point of sale fee items, choose CONSTANT from the drop-down list. The
CONSTANT fee formula allows you to establish a set fee independent of ranges or
valuations. For example, if you want to establish a flat rate for a city map, you can
use the CONSTANT fee formula to establish a $10 fee. Any fee calculated using
this formula is the product of the constant and the quantity that a user enters while
assessing fees. For example, if you specify that the constant for a city map is $10
and a user enters 2 as the quantity, then the total fee for two electrical applications
is $20.00.

For more information about calculation formulas, see Fee Formulas.

Calc Variable Enter the parameter(s) for the fee formula. If you want to define multiple parameters,
separate each parameter with a comma. The number and order of the parameters
vary depending on the standard fee formula. Administrators define most of these
parameters, but agency users or public users generally determine the variable x
(Quantity) in the mathematical equation of the fee formula.

All Point of Sale items use the CONSTANT Calc Formula, or (ax). So you can enter
the amount of the fee for one item (variable a) in this field and it is multiplied by the
number a public user enters for the quantity on the application intake form (variable
x).

Another example of a Calc Variable is when you calculate a fee item based on the
LINEAR_WITH_MIN_MAX fee formula (ax + b). You can enter 15,0,0,9999 and, in
this example, a = 15, b = 0, minimum value = 0, and the max value = 9999.

For more information on variables, see Fee Formulas.

Default Value If you want the fee item to have a default quantity value, choose Y and enter the
default quantity in the field. If you do not want a default quantity, choose N.

Fee Indicator (QTY) Civic Platform uses this text field to enable you to enter a custom fee indicator to
populate the quantity field in ACA. Enter a unique code in this field. When the 'Fee
Indicator' in the fee item has a value of (range. $FI10100$~$FI10599$), Citizen
Access locates the application specific information which has the matching 'Fee
Indicator' value (range. $FI10100$~$FI10599$) and then replaces the quantity (Qty)
with the ASI value. Citizen Access implements this functionality regardless of 'Auto
Assess' settings.
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If the 'Fee Indicator' in fee item has no value, Citizen Access follows the existing
logic to retrieve the 'Quantity' value for the fee item when you set 'Auto Assess' to
'Y'.

Note:

If the Fee Indicator in the fee item and the fee indicator in ASI do not
match, Civic Platform uses the default value of 0. For more information, see
Creating Fees with Fee Calculation and ASI Data.

Round Fee Item If you want the calculated fee item to round to the nearest dollar amount, choose Y,
and then choose either Round Up, Round Down, or Round to Nearest dollar. If you
want the fee to display the exact value, choose N.

For example, your agency charges an Inspection Penalty Fee if a property is not
ready for an inspection when the inspector arrives. You can use a percentage
formula to penalize 10% of the original inspection fee. This 10% value as calculated
by the formula could be $4.56. To ensure the Inspection Penalty Fee is always a
round number, you can choose to round the item up.

Required If you want to require users to complete the Quantity field, choose Y; otherwise,
choose N.

Auto Invoiced If you want to automatically invoice the fee item, select Y, otherwise, choose N. No
indicates that you want to manually invoice the fee items in Civic Platform.

Note:

This field does not effect the Fee Item display on the Fee Page or Fee
Estimate Page in Citizen Access.

Auto Assess If you want the fee to add automatically when you save the application for the first
time, select Y, otherwise, chose N.

Quantity Enter the number of items you want to apply to the fee.

Priority Enter a number to determine the order of payment for the fee item.
This field is only necessary if you enable Standard Choice option
FULL_PAY_ALLOCATION_OPTIONS. For more information see Prioritizing Fees
Using Pay Allocation.

Minimum Enter the minimum value of the calculated fee value.

Maximum Enter the maximum value of the calculated fee value.

Seq for Calculation Enter a number to determine the position of the fee item within the fee calculation
sequence.

Display Order Enter a number to determine the position of the fee item within the fee schedule. For
example, if you want the fee item to display before any other fee items, enter 1.

Display in ACA This field defines permissions for the Fee Item Quantity field in Citizen Access.
Options are Y/N/Read-only.

Y- Yes indicates the fee item displays on the Citizen Access Fee page.

N- No indicates the fee item does not display on the Citizen Access Fee page.

Read-Only indicates the fee item displays on the Citizen Access Fee page, but the
quantity field is read-only.

Required in ACA This field becomes active when you set the Display in ACA field to Yes or Read-
Only. After the field becomes activate, you can choose Y or N. Y indicates the Fee
Item quantity must have a value greater than zero. N indicates you do not require
the Fee Item quantity. The value of this field is compatible with EMSE.

Assess Adjustment on
Recalculation

If you want to adjust the assessment when recalculating the fee, mark the Y option;
otherwise, mark N.
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Adjustment Credits
Allowed

If you want to allow adjustment credits, mark the Y option; otherwise, mark N.

Status If you want to make the fee item available to users in Civic Platform, mark Enable;
otherwise, mark Disable.

Payment Period Choose the payment period to which the fee item belongs. For example, if you want
to assess and invoice the fee item during the inspection phase of a project, choose
Inspection. A payment period is a subset of the fee schedule.

For a point of sale item, you must choose Final.

Subgroup Enter the code for the subgroup to which this fee item belongs. A fee item can
belong to multiple subgroups. If you want this fee to belong to more than one
subgroup, separate each group with a delimiter such as a comma.

Fee Allocation This field defines whether and how to split the total fee in the fee item among up to
three account codes. Options are No Allocation, Percentage, and Fix Amount and
Residual.

No Allocation - You do not want to split the fee between account codes.

Percentage - You want to split the fee between two or three account codes by
percentage.

Fix Amount and Residual - You want to split the fee between two or three account
codes by fix amount. If you select Percentage or Fixed Amount and Residual in
this field, go to the Account Code field to configure the account codes and the
allocations.

Note:

When public users assess fees, Citizen Access allocates the total fee
amount to the account code(s) associated with the fee items as configured.
Public users are unaware of the allocation because it happens in the
background.

Account Code If you select Percentage in the Fee Allocation field, enter up to three account codes
here, and specify the percent of the fee amount each account code gets. You must
make sure that the sum of the percent add up to 100.

If you select Fix Amount and Residual in the Fee Allocation field, enter up to three
account codes here.

You can specify the dollar amount that the first one or two account codes can get,
but you cannot specify the dollar amount for the last account code, because the last
one gets the residual amount.

Calculated If you want to use the calculation records to determine a fee value, select Y,
otherwise, select N.

Calculation Record # Click Select to choose the calculation record you want to use to evaluate a fee
value. You can call other calculation records from the initial calculation record.

Searching for a Fee Item
Administrators can search for a fee item to view its associated details or make any modifications to it. You
can enter a variety of search criteria including the fee code, fee schedule, payment period, subgroup, or
the fee description. Civic Platform returns all fee items when you do not enter any search criteria and then
Click Submit.

To search for a fee item

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Item.
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Civic Platform displays the Fee Item-Search page.

3. Enter your search criteria. For information about Fee Item Fields, see Understanding Fee Items.

4. Click Submit.

Civic Platform returns a list of fee items meeting the search criteria.

5. Select the fee item you want to work with by clicking the red dot next to the fee item code.

Copying a Fee Item
You can create a new fee item by copying an existing one. After you copy the fee item, you must provide
a new fee item name and define the fee item details including the fee schedule, pay period, and the fee
formula parameters.

To copy a fee item

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Item.

Civic Platform displays the Fee Item—Search page.

3. Search for the fee item that you want to copy. For instructions on how to search for a fee, see Creating
Fees with Fee Calculation and ASI Data.

Civic Platform displays the Fee Item—Edit page.

4. Click Copy.

Civic Platform displays the Fee Item-Add page with field information copied from the previously selected
fee item.

5. Update the necessary fields as described in Understanding Fee Items.

6. Click Save.

Setting Up a Flat Fee Item
To set up a simple fee item for an application, administrators must have already pre-defined a fee
schedule and a payment period. See Managing Fee Schedules and Invoices and Payment Periods. Then,
administrators must create a fee item with configurations for a simple fee. After you set up the fee item
on a fee schedule, administrators can assign the fee schedule to one or more application types. A fee
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schedule can accommodate multiple fee items. Numerous simple fees and more complex fees can coexist
on the same fee schedule.

To create a simple fee

1. Verify an applicable fee schedule and a pay period. See Managing Fee Schedules.

2. Access the Classic Administration page (Accessing Classic Administration).

3. Navigate to Fees > Fee Item.

Civic Platform displays the Fee Item-Search page.

4. Choose one of the following:

• To create a new fee item click Add.

• To copy an existing fee item and modify it to create a new fee item:

Search for the fee item to copy. Enter search criteria and then click Submit. Select the fee item you
want to copy and click Copy.

Civic Platform displays the Fee Item-Add page.

5. Complete the fee item fields with the following criteria:

a. Complete the required fields, Fee Item Code, Fee Schedule, Version, and Payment Period.

b. Choose Constant from the Calc Formula drop-down list.

c. Customize the fee item by configuring the remaining fee item fields. For definitions of the fee item
fields, refer to Understanding Fee Items.

6. Click Save.

Civic Platform assigns the fee item to the defined fee schedule.

7. Assign the fee schedule with the flat fee item to appropriate application types. For more information
about application types, see Creating and Configuring Records.

Working with Point of Sale Fee Items
For complete information on how to implement point of sale and cashiering, refer to Point of Sale.

Creating Fees with Fee Calculation and ASI Data
This section describes how to create fee calculations and codes. After you create the fee calculation, you
can associate the calculation to a fee item with the fee calculation code. See Understanding Fee Items.

This section explains these topics:

• Using the Fee Calc Utility

• Using the Fee Calc Criteria Utility

• Associating Multiple Criteria with One Fee Calculation

• Associating Fee Calculations with Fee Items
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Using the Fee Calc Utility
Use the Fee Calc form to create the if - then statement which is the basis for the calculation. For example,
if X is true then do Y, if false then do Z.

There are two operators for each fee calculation. The first operator, Running Total Operator, determines
how the calculation deals with the running total. The second operator, Permit Value operator, determines
how the fee calculation deals with the field referenced by the fee calculation.

To use the Fee Calc utility

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Calc.

Civic Platform displays the Fee Calc Search window.

3. Enter Fee Calc information and complete one of these options:

• Search for an existing Fee Calc code by clicking the Submit button.

• Create a new Fee Calc item by clicking the Addbutton.

Civic Platform displays the Fee Calc - Add page.

4. Enter the appropriate fields for the new or existing calculation.

For a description of Fee Calc fields, see Table 153: Fee Calc Fields.
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5. Click Save.

Table 153: Fee Calc Fields

Calculation Uses Value Enter the calculation value for the selected fee calc.

Description Enter the description for the calculation.

Effective Date Enter the date the Fee Calculation becomes active.

FALSE Select another calculation or continue if False.

Fee Calc Code Enter the Fee Calculation’s unique identification code.

Field Name Use the drop-down menu to select the appropriate field name.

Field Type Enter the field type for the calculation.

Permit Value Operator Select the type of mathematical operation to perform on the application value. For a
description of operators, see Table 154: Fee Calc Operators.

Running Total Operator Select the type of mathematical operation to perform on the running total. Select the
type of mathematical operation to perform on the application value. For a description of
operators, see Table 154: Fee Calc Operators.

Table Name Use the drop-down menu to select the appropriate table name. You can use the
attached tables for calculations. The calculation totals a specific column and it uses
that total in another calculation. If an attached table contains two rows, Civic Platform
combines the specified column for the two rows, such as 20 + 10 = 30, and the total is
available for evaluation by a fee calculation.

TRUE Select the next calculation to perform if the results of the fee criteria are True.

Table 154: Fee Calc Operators

Running Total Permit Value Description

= = No change to the value listed in the Calculation Uses
Value field.

= + The base fee plus the Calculation Uses Value.

= - The base fee minus the Calculation Uses Value.

= * The base fee multiplied by the Calculation Uses Value.

= / The base fee, divided by the Calculation Uses Value.

+ = The Calculation Uses Value plus the running total.

+ + The base fee plus the Calculation Uses Value, plus the
running total.

+ - The base fee minus the Calculation Uses Value, plus
the running total.

+ * The base fee multiplied by the Calculation Uses Value,
plus the running total.

+ / The base fee, divided by the Calculation Uses Value,
plus the running total.

- = The Running Total minus the Calculation Uses Value.

- + The Running Total, minus the base fee plus the
Calculation Uses Value.

- - The Running Total, minus the base fee minus the
Calculation Uses Value.
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Running Total Permit Value Description

- * The Running Total, minus the base fee multiplied by
the Calculation Uses Value.

- / The Running Total, minus the base fee, divided by the
Calculation Uses Value.

* = The Calculation Uses Value multiplied by the running
total.

* + The Running Total, multiplied by the base fee plus the
Calculation Uses Value.

* - The Running Total, multiplied by the base fee minus
the Calculation Uses Value.

* * The Running Total, multiplied by the base fee
multiplied by the Calculation Uses Value.

* / The Running Total, multiplied by the base fee, divided
by the Calculation Uses Value.

/ = The Running Total divided by the Calculation Uses
Value.

/ + The Running Total, divided by the base fee plus the
Calculation Uses Value.

/ - The Running Total, divided by the base fee minus the
Calculation Uses Value.

/ * The Running Total, divided by the base fee multiplied
by the Calculation Uses Value.

/ / The Running Total, divided by the base fee divided the
Calculation Uses Value.

Using the Fee Calc Criteria Utility
Use the Fee Calc Criteria form to pull data that fits the fee calculation’s stated criteria. You cannot
determine some calculations until the data on the application is complete. Fee calculations differ based on
the data on the application. The fee criteria determines the path for the fee calculation follows and how to
evaluate the data based on the criteria.

To use the Fee Calc Criteria utility

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Calc Criteria.

Civic Platform displays the Fee Calc Criteria Search window.
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3. Enter Fee Calc information and complete one of these options:

• Search for an existing Fee Calc Criteria code by clicking the Submit button.

• Create a new Fee Calc Criteria item by clicking the Addbutton.

Civic Platform displays the Fee Calc Criteria - Add page.

4. Select a Fee Calc Criteria, then enter the appropriate fields for the requested calculation.

For a description of the Fee Calculation Criteria fields, see Table 155: Fee Calc Criteria Fields.

5. Click Save.

Table 155: Fee Calc Criteria Fields

Description Enter the description for the fee calc criteria calculation.

Effective Date Enter the date the Fee Calculation becomes effective.

End Range Enter the ending amount for the fee calc criteria.

Fee Calc Code Enter the code for the Fee Calculation used for this Fee Calc Criteria.

Fee Calc Criteria Code Enter the Fee Calculation Criteria’s unique identification code.

Field Name Use the drop-down menu to select the appropriate field name. Civic Platform populates
these fields based on the Fee Calculation IDs.
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Field Type Enter the field type for the calculation.

Start Range Enter the starting amount for the fee calc criteria.

Table Name Use the drop-down menu to select the appropriate table name.

Associating Multiple Criteria with One Fee Calculation
An administrator can add zero (0) to many fee criteria records on a single fee calculation record. Civic
Platform evaluates each criteria record as TRUE or FALSE. If all of the fee criteria are TRUE, the fee
calculates the TRUE path. If any of the fee criteria records are FALSE, the fee calculates the FALSE path.

Civic Platform can also evaluate each criteria record as an AND or OR statement. The table below
illustrates how Civic Platform evaluates fee criteria records. Given the following criteria on a single fee
calculation:

Criteria 1 = A OR B

Criteria 2 = C OR D

Criteria 3 = E OR F

When you enter the following values into the application data and Civic Platform evaluates them by
the criteria, Civic Platform uses a single fee calculation record as illustrated in Table 156: Single Fee
Calculation Evaluation Descriptions.

For more information about fee calculations, see Using the Fee Calc Utility. For more information about fee
calculation criteria, see Using the Fee Calc Criteria Utility.

Table 156: Single Fee Calculation Evaluation Descriptions

Criteria 1 Criteria 2 Criteria 3 Evaluation

A A E TRUE

A D f TRUE

A C Z FALSE

X C F FALSE

B Y F FALSE

X Y Z FALSE

B D F TRUE

Associating Fee Calculations with Fee Items
After you create the fee calculation, an administrator must associate the Fee Calc with the Fee Item. When
a user selects a fee item, the fee calculations associated with that fee item trigger within Civic Platform. For
more information about creating or adding fee calculations, see Creating Fees with Fee Calculation and
ASI Data.

To associate a fee calculation with a fee item

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Items.

Civic Platform displays the Fee Item - Search page.
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3. Enter Fee Item information and complete one of these options:

• Search for an existing Fee Item by clicking the Submit button.

• Create a new Fee Item item by clicking the Add button.

4. Click the red dot by the fee item you want to work with.

Civic Platform displays the Fee Item - Edit page.

5. Enter the fee calculation information in these fields:

Calculated If you want to use the calculation records to determine a fee value, select Y,
otherwise, choose N.

Calculation Record # Select the calculation record you want to use to evaluate a fee value. You can call
other calculation records from the initial calculation record.

Minimum Enter the minimum value of the calculated fee value.

Maximum Enter the maximum value of the calculated fee value.

6. Click Save.

Adjusting Fees Based on Agency Valuation
Topics

• Managing the Default Valuation Calculator

• Managing Valuation Calculator Versioning

Managing the Default Valuation Calculator
Topics

• Adding a Valuation to the Calculator
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• Editing a Valuation for the Calculator

• Factoring with a Regional Modifier

Adding a Valuation to the Calculator
As users assess fees for new jobs, you might need to add new valuations to your system. A job valuation
lets you determine or estimate the market value for a certain type of occupancy.

For example, a Type I apartment complex might include only one bedroom unit valued at less than Type III
apartments, which include additional bedrooms and other amenities.

A job value also reflects the value of the work required for occupancy. For example, a Type III apartment
complex might require a certain number of man-hours to complete, or a certain type of building materials.

To add a valuation

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Valuation Calc.

3. Click Add.

4. Complete the necessary fields for a valuation calculator line item as described in Table 157: Valuation
Fields.

5. Click Save.

Table 157: Valuation Fields

Extra Amount Use this numeric data field to add any extra dollar amounts to the Total Valuation.
You can use both positive or negative numbers. Format the number with a decimal
(max total numbers before decimal is 6 and max total number after decimal is 2).

Multiplier Civic Platform uses this numeric data field to modify a valuation. You can use
it in addition to the Regional Modifier for calculations. The value entered in this
field multiplies the total Valuation (before Extra Amount) in addition to the regional
modifier.

An agency can valuate based on the multiplier alone, which means it can operate
excluding the Regional Modifier.

Format the number with a decimal (max total numbers before decimal is 5 and
max total number after decimal is 4).

Occupancy Enter the purpose, or use, of the property or building that is the basis for the
valuation. An occupancy is typically a building or part of a building you can occupy,
such as apartments, homes, hospitals, auditoriums, churches, or banks.

Type of Work Enter the qualities of the occupancy that indicate the work required to build
the occupancy. For example, if the occupancy is a basement, you might enter
“finished” as the qualifier.

Unit Enter the measurable aspect of work required for the occupancy. The unit enables
you to calculate the value of the occupancy, or job value.

Unit Cost Enter the cost of the unit that you determine is the measurable aspect of the work
required for the occupancy.

You can automatically adjust all unit costs in your system with a regional modifier.
A regional modifier enables you to multiply unit costs depending on market
demands. For more information, see Factoring with a Regional Modifier.
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Fee Indicator Enter a unique code to identify this valuation, or job value. For example, if you are
calculating the value for a Type I apartment complex, you might enter “APTI.” You
can use fee indicators in some fee formulas to assess fees.

Editing a Valuation for the Calculator
As necessary, you can edit existing valuations. You can change the type of work, unit, unit cost, and the
fee indicator for any valuation.

To edit a valuation

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Valuation Calc.

3. Search for the calculation that you want.

4. Complete the necessary fields as described in Table 157: Valuation Fields.

5. Click Save.

Factoring with a Regional Modifier
The regional modifier enables you to multiply any unit cost that you set up in the valuation calculator by a
factor that you specify. You can use the regional modifier to adjust all unit costs in your system according
to market demands. For example, you might need to increase your prices by 10% due to the effects
of inflation. When a user assesses fees based on the valuation calculator, Civic Platform adjusts the
assessment by the same factor.

If your agency chooses to create a fee modified with occupancy versioning, administrators have the option
to configure the fee excluding the regional modifier. You do this by selecting Exclude from Regional
Modifier. For more details, refer to Table 158: Valuation Version Fields and Creating an Occupancy
Version.

To factor with a regional modifier

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Regional Modifier.

3. Enter the regional modifier factor in the Regional Modifier field.

4. Click Save.

Managing Valuation Calculator Versioning
See the Civic Platform Configuration Reference.

Adjusting Fees based on Occupancy Versioning
This section provides information so agencies can create a fee item and then modify it with valuation
calculator versioning.

For more information about occupancy groups, see Working with Occupancy Groups. For information on
how to run a batch for occupancy versioning, see Running a Batch Update for Occupancy Versions.

Topics

• Searching for an Occupancy Version
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• Creating an Occupancy Version

• Editing an Occupancy Version

• Copying an Occupancy Version

• Deleting an Occupancy Version

Searching for an Occupancy Version
Agency administrators can search for existing occupancy versions. For example, if you want to clone an
existing occupancy to create a new version, you must first locate the existing version.

To search for an occupancy version

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Search using one of these methods:

a. Click Occupancy By Name or Occupancy By Type in the picker, then select the item you want
from the search results.

b. Click Search, then complete the necessary fields as described in Table 158: Valuation Version
Fields, and then click Submit.

Civic Platform displays the occupancy search results.

3. Click the name of the occupancy you want to view.

Civic Platform displays the selected occupancy version in the detail portlet.

Table 158: Valuation Version Fields

Exclude from Regional
Modifier

Select this option to create a valuation occupancy record that excludes the regional
modifier to calculate total valuation. Clear this option to enable regional modifier
functionality.

Occupancy Enter the purpose, or use, of the property or building you are basing this valuation on.

An occupancy is typically a building or part of a building that you can occupy, such as
apartments, homes, hospitals, auditoriums, churches, or banks.

Type of Work Enter the qualities of the occupancy that indicate the work required to build the
occupancy.

For example, if the occupancy is a basement, you might enter “finished” as the qualifier.

Version Enter the occupancy version identifier. This field works with the “Effective Date” and
“Disabled on Date” fields to determine which version is active. Only one version can be
active at a time.
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Unit Enter the measurable aspect of work required for the occupancy. The unit enables you to
calculate the value of the occupancy, or job value.

Unit Cost Enter the cost of the unit that you determine is the measurable aspect of the work
required for the occupancy.

You can automatically adjust all unit costs defined on your system with a regional
modifier. A regional modifier enables you to multiply unit costs depending on market
demands. For more information, see Factoring with a Regional Modifier.

Fee Indicator Enter a unique code to identify this valuation, or job value. For example, if you are
calculating the value for a Type I apartment complex, you might enter “APTI.” You can
use fee indicators in some fee formulas to assess fees.

Effective Date Enter the beginning date for the occupancy version. This field works with the “Version”
and “Disabled on Date” fields to determine which version is active. Only one occupancy
version can be active at a time. For example, you can configure different versions of
occupancy codes so that the amount of the fee matches the rate of inflation. In this case,
you can configure the new version to go into effect on the same day you disable the
previous version.

Disabled on Date Enter the end date for the occupancy version. This field works with the “Version” and
“Effective Date” fields to determine which version is active. Only one occupancy version
can be active at a time. For example, you can configure different versions of occupancy
codes so that the amount of the fee matches the rate of inflation. In this case, you can
configure the new version to go into effect on the same day you disable the previous
version.

Status Select “Enabled” or “Disabled” from the drop-down menu to determine whether this
version of the occupancy is active. If you select “Enabled,” the version is active, and
displays for the Civic Platform user.

Creating an Occupancy Version
You can create a new valuation calculation occupancy version according to your agency’s needs. For
example, your agency specializes in Residential properties and adds duplexes as a new structure type.
You can create a new occupancy code for duplexes.

To create a valuation occupancy version

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Open a New Occupancy form using one of these methods:

• Right-click on any of the Occupancy By Name or Occupancy By Type options in the picker, and then
click New Occupancy in the pop-up.

• Click New in the Occupancy Maintenance list toolbar:

Civic Platform displays the new Occupancy form in the detail portlet.
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3. Complete the necessary fields as described in Table 158: Valuation Version Fields.

4. Click Submit.

Editing an Occupancy Version
You can edit the details of a valuation occupancy. For example, can configure different versions of
occupancy codes so that the amount of the fee matches the rate of inflation. You edit the existing version
to determine the Disabled on Date, and then create a new version to be effective on a certain date.

To edit an occupancy version

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Search for the occupancy version you want to edit.

For instructions on searching for an occupancy version, see Searching for an Occupancy Version.

Civic Platform displays the occupancy version details in the secondary portlet.

3. Update the necessary fields as described in Table 158: Valuation Version Fields.

4. Click Submit.

Copying an Occupancy Version
You can copy the information from an occupancy version to create a new version. Copying versions saves
you time, as the fields for the new version automatically populate based on the values from the previous
version. For example, you can configure different versions of occupancy codes so that the amount of the
fee matches the rate of inflation. You can clone the previous occupancy version, and then update the
values in the Version, Unit Cost, and Effective Date fields. This new version becomes effective on the
same date you disabled the previous version. Only one valuation version can be active at one time.

To copy an occupancy version

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Search for the occupancy version you want to copy.

For instructions on searching for an occupancy version, see Searching for an Occupancy Version.

Civic Platform displays the occupancy versions that match the search criteria in the list portlet.

3. Select the occupancy you want to copy, and then click Copy.

Civic Platform populates the fields in the detail portlet, based on the values from the copied occupancy.

4. Update the desired fields as described in Table 158: Valuation Version Fields.

Note:



 | Part 7: Accounting | 735

The Type of Work field is the only field that does not populate the exact value from the parent version.
This field populates as “Copy of <value>”

5. Click Submit.

Deleting an Occupancy Version
You can delete an occupancy version if needed.

To delete an occupancy version

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Search for the occupancy version you want to delete.

For instructions on searching for an occupancy version, see Searching for an Occupancy Version.

Civic Platform displays the occupancy versions that match the search criteria in the list portlet.

3. Select the occupancy you want to delete.

4. Click Delete.

Working with Occupancy Groups
Topics

• Managing Occupancy Groups

• Associating Occupancies with an Occupancy Group

• Running a Batch Update for Occupancy Versions

• Associating an Occupancy Group with Record Types

Managing Occupancy Groups
The Group Maintenance navigation tree enables you to manage all the information associated with
occupancy groups, including creating, searching, and deleting groups.

Topics

• Searching for an Occupancy Group

• Creating an Occupancy Group

• Editing an Occupancy Group

• Deleting an Occupancy Group

Searching for an Occupancy Group
Agency administrators can search for existing occupancy groups and modify the group information. For
example, if you want to run a batch update for selected occupancy versions, you must first locate the
occupancy group.

To search for an occupancy group

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Navigate to Civic Platform V360 and click the Admin primary tab.



 | Part 7: Accounting | 736

3. In the Setup portlet, click the Valuation Calculator item and choose Occupancy from the drop-down
menu.

Civic Platform displays the Valuation Calculator tool.

4. Click Search.

Civic Platform displays the Occupancy Group Search page.

5. Enter the name of the group name you want to locate in the Group Name field and click Submit.

Civic Platform displays the occupancy groups that match your criteria in the Occupancy Group
Maintenance list portlet.

Creating an Occupancy Group
Agency administrators can create occupancy groups to manage occupancy types and versions. For
example, you can group together similar occupancies by creating a group for residential occupancies and a
group for commercial occupancies.

To create an occupancy group

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Click New in the Group Maintenance list toolbar:

Civic Platform displays the new Group Occupancy form in the Occupancy Group Maintenance detail
portlet.
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3. Enter a unique group name and then click Submit.

Civic Platform displays a confirmation message indicating that you successfully created the group.

4. Add occupancy versions to the group by completing the steps described in Creating Occupancy Version
Associations.

Editing an Occupancy Group
You can edit the details of an occupancy group. For example, you can associate additional occupancy
versions with a group or remove occupancy version associations.

To edit an occupancy group

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Search for the occupancy group you want to edit.

For instructions on searching for an occupancy group, see Searching for an Occupancy Group.

3. Update the occupancy group name and associated occupancy versions. For more information on
working with occupancy associations, see Associating Occupancies with an Occupancy Group.

4. Click Save.

Civic Platform saves the changes and displays a confirmation message.

Deleting an Occupancy Group
You can delete an occupancy group as needed. When you delete an occupancy group, you remove the
association between the occupancy and the occupancy group; you do not delete the occupancies from
Civic Platform.

To delete an occupancy group
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1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

For instructions on searching for an occupancy group, see Searching for an Occupancy Group.

Civic Platform displays the search results in the Occupancy Group list portlet.

2. Select the occupancy group you want to delete.

3. Click Delete.

Civic Platform displays a confirmation message.

Associating Occupancies with an Occupancy Group
System administrators create occupancy groups by associating occupancy versions with an occupancy
group name. After you create an occupancy group, you can establish occupancy version associations by
going to the Associated Occupancy tab. For example, you can create an occupancy group for commercial
structures. You can then associate commercial occupancies, which can include office buildings, hospitals,
and schools, with the commercial occupancy group. Occupancy versions can belong to one or more
groups.

The Associated Occupancy tab provides you with the option of cloning occupancy versions. When you
clone an occupancy version, you add the new occupancy version to all the occupancies in the same group.

Topics

• Creating Occupancy Version Associations

• Deleting Occupancy Version Associations

• Cloning Occupancy Versions

Creating Occupancy Version Associations
You can customize occupancy groups be establishing occupancy version associations.

To create an occupancy version association

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Click the Group Maintenance picker.

Civic Platform displays the Group Maintenance list portlet.

3. Click the occupancy group to which you want to add occupancy version associations.

Civic Platform displays the Group Maintenance detail portlet.
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4. Click the Associated Occupancy tab.

Civic Platform displays the Associated Occupancy detail portlet.

5. Click Look Up, complete the associated fields, and then click Submit. For a complete list of fields that
appear in the Occupancy Search Portlet, see Table 158: Valuation Version Fields.

Civic Platform displays the occupancy versions that match your criteria in the detail portlet.

6. Select the name of the occupancy version you want to associate.

7. Click Save.

Civic Platform adds the occupancy version, and then displays the Associated Occupancy detail portlet.
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Deleting Occupancy Version Associations
You can remove the association between occupancy versions and occupancy groups as needed. For
example, when you clone occupancy versions, you might need to remove occupancy versions that are not
applicable to the new group.

To delete an occupancy version association

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Click the Group Maintenance picker.

Civic Platform displays the Group Maintenance list portlet.

3. Click the occupancy group for which you want to remove occupancy version associations.

Civic Platform displays the Group Maintenance detail portlet.

4. Click the Associated Occupancy tab.

Civic Platform displays the Associated Occupancy detail portlet.

5. Select the occupancy version for which you want to remove an association and click Delete.

Civic Platform deletes the occupancy version association and refreshes the Associated Occupancy
detail portlet.

Cloning Occupancy Versions
Each occupancy group can contain different occupancy versions. You can clone each occupancy version
one or more times. When you clone occupancy versions, you can create new occupancy groups for similar
occupancies without having to reassociate occupancy versions with a group.
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When you clone an occupancy version, you can modify the Version, Effective Date, and Disabled on Date
fields. The values for the Unit, Unit Cost, Fee Indicator, and Status fields remain the same as the version
used for cloning.

Note:

If there are multiple occupancy versions with the same occupancy and the same type of work, Civic Platform
only clones the most recent version.

To clone an occupancy version

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Click the Group Maintenance picker.

Civic Platform displays the Group Maintenance list portlet.

3. Click the occupancy group that contains the occupancy versions you want to clone.

Civic Platform displays the Group Maintenance detail portlet.

4. Click the Associated Occupancy tab.

Civic Platform displays the Associated Occupancy detail portlet.

5. Clone one, multiple, or all occupancy versions:

• Clone one or more occupancy versions.

Select the versions you want to clone, and then click Clone.

• Click the Clone All button to clone all occupancy versions.

Civic Platform displays the Occupancy Version Clone portlet.

6. Complete the fields in the Occupancy Version Clone portlet and click Submit. For a complete list of
occupancy version clone fields, see Table 159: Occupancy Version Clone Fields.

Civic Platform creates the new occupancy version for the occupancies in the selected group and
refreshes the Associated Occupancy detail portlet.

Table 159: Occupancy Version Clone Fields

Disabled on Date Enter the end date for the occupancy version. This field works with the “Version” and
“Disabled on Date” fields to determine which version is active. Only one occupancy
version can be active at a time.
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For example, you can configure different versions of occupancy codes so that the
amount of the fee matches the rate of inflation. In this case, you want the new version
to go into effect on the same day you disable the previous version.

Effective Date Enter the beginning date for the occupancy version. This field works with the “Version”
and “Disabled on Date” fields to determine which version is active. Only one occupancy
version can be active at a time.

The default value for this field is one day after the disabled date of the cloned
occupancy version. For example, if you clone an occupancy version with a disabled on
date of 5/6/12, then the default effective date for the new occupancy is 5/7/12.

Group Name Enter the group name you to which you want to copy occupancy versions. If you leave
this field blank, Civic Platform clones the occupancy versions to the current group.
If you enter a new group name in this field, it creates a new group and it clones the
selected occupancy versions to the new group.

Version Enter a unique name or a unique number sequence to identify the version. This field
works with the “Effective Date” and “Disabled on Date” fields to determine which
version is active. Only one version can be active at a time.

If you enter a version name or version number that is currently in use, Civic Platform
prompts you to enter a unique version identifier. This field is a mandatory field and it is
case-sensitive.

Running a Batch Update for Occupancy Versions
You can simultaneously update occupancy version values in an occupancy group using the Batch Update
tab. For example, if you want the occupancy versions in a particular occupancy group to correspond to the
end dates of a financial quarter, you can update the dates for all the versions at once. When you save your
changes, Civic Platform updates all the occupancy versions in the selected occupancy group.

If you run a batch update for multiple versions that include the same occupancy name and same type of
work, Civic Platform only updates the most recent version. When you update an occupancy version, all the
groups to which the occupancy version belongs reflect the changes.

To run a batch update for occupancy versions

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Click the Group Maintenance picker.

Civic Platform displays the Group Maintenance list portlet.

3. Click the occupancy group that contains the occupancy versions you want to update.

Civic Platform displays the Group Maintenance detail portlet.

4. Click the Batch Update tab.

Civic Platform displays the Batch Update detail portlet.

5. Complete the fields in the Batch Update list portlet. For a complete list of fields, see Table 158:
Valuation Version Fields.
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6. Click Submit.

Civic Platform updates all the occupancy versions in the selected occupancy group.

Associating an Occupancy Group with Record Types
After putting occupancies into a group, you can assign the occupancy group to record types. Doing so
enables you to associate occupancies in the group with the records of the corresponding record types
during the record creation process.

To associate an occupancy group with record types

1. Access the Occupancy Administration portlet (Navigating to the Setup Portlet).

2. Click the Group Maintenance picker.

Civic Platform displays the Group Maintenance list portlet.

3. Click the occupancy group that you want to associate with record types.

Civic Platform displays the Group Maintenance detail portlet.

4. Click the Record Types tab.

Civic Platform displays a list of record types you associated with the occupancy group.

5. Click Assign.

Civic Platform displays the record type navigation tree.

6. Use the + and - buttons to expand and collapse the navigation tree to find the record type to which you
want to assign the occupancy group.

7. Select the desired record type.

You can choose to assign the occupancy group to multiple record types.

Select an item on a higher level to select everything below that level.

8. Click Submit.

Civic Platform assigns the record types to the specified occupancy group.

Prioritizing Fees Using Pay Allocation
Administrators have the option to set the priority of fee items. This option allows users to apply full payment
to the most important items first, rather than applying the payment to a percentage of all items equally.
Items you do not prioritize default to the lowest priority. Civic Platform disburses payment to the priority
items first according to order of priority, then paid to the rest of the items based on a percentage of the
remaining payment.

For example, there are three fee items outstanding. If you enable this feature and enter the item priority,
Civic Platform pays in full the item with the highest priority, then the second, then the third, and so forth. If
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you do not enable the feature, Civic Platform automatically distributes payments to each of the fee items by
percentage.

Enabling Fee Estimation
For feature functionality, administrators must do the following: 1-Enable the related Function Identification
(FID) numbers. 2- Predefine fee schedules with applicable fee items for application types. 3- Indicate which
fields require user information so Civic Platform can generate fee item calculations. Administrators can
define required fields for the following areas of the software:

• Application-Specific Information groups

• Application-Specific Information tables

• Workflow Task-Specific Information groups

When an agency sets a field as required for fee calculation, Civic Platform displays the letter F beside the
field.

To allow estimation of fees on partially completed applications

1. Enable fee estimation for Application Type Categories.

a. Open each application type for which you want to enable fee estimation.

b. Select Enable Fee Estimation. You must select this option to enable Fee Estimation in Citizen
Access.

c. Verify a Fee Schedule.

If your agency uses Citizen Access, you must define which fee items on the fee schedule display,
are mandatory, and invoiced so they display for public users online. See Understanding Fee Items.

d. Click Save.

2. Define the required fields for fee calculation information in application-specific information groups:

a. Define any fields you want to require user information with regard to fee calculations. For
instructions, see Working with ASI Groups and Subgroups.

b. In the Application Specific Information group, choose Yes in the Required field.

c. In the Specific Information group, choose Yes in the Req for Fee Calc field.

3. Define the required fields for fee calculation information in application-specific information tables:

a. Set up the table for which you want to make information required for fee calculations. For
instructions, see Creating ASI Lookup Tables.

b. For each column of the Application Specific Information table that you want to require, choose Yes in
the Required field.

c. For each column of the Application Specific Information table that you want to require for fee
calculation, choose Yes in the Req for Fee Calc field.

4. Define the required fields for fee calculation information in workflow tasks:

a. Set up the workflow task-specific subgroup whose fields you want to make required for fee
calculations. For instructions, see Creating Task Statuses.
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b. For each field of the workflow task that you want to require, choose Yes in the Required field.

c. For each field of the workflow task that you want to require for fee calculation, choose Yes in the
Req for Fee Calc field.

d. Save your changes.

Purging Partial Application Fees
Partial applications are those applications that users save without submitting or save and resume later.
A Civic Platform administrator defines how many days partially completed applications remain in Civic
Platform before it removes them. Civic Platform also deletes the assessed fees that have associations with
the applications. For instructions on how to purge partial applications from Civic Platform using a batch job
script, see Creating a Script Batch Job.

Fee Formulas
Fee formulas enable you to configure how Civic Platform calculates fees. Ideally, a user should not need
to think about how Civic Platform generates fees when they enter a fee quantity. You can assist users
and facilitate ease-of-use by configuring fee amounts and the parameters that generate calculations. For
example, you can establish minimum fees and maximum fees. It is important to note, however, that while
you can configure fee amounts and fee quantities, you cannot modify the fee formulas themselves, as they
are part of the standard configuration that comes with Civic Platform.

When a user assesses a fee, Civic Platform calculates the fee based on parameters such as constants,
quantities, job values, or values from a specific information field on an application.

Some formulas allow you to include constants and application specific field values. You can include these
values as part of your parameters (also known as calculation variables) when you set up a fee item.
For instructions, see Understanding Fee Items. If you choose to use application specific field values in
your fee formula, you must use a fee indicator that corresponds with the fee indicator referenced within
the application specific information field. For more information, see Defining Custom Fields (Application
Specific Information).

Click a topic title below for full details.

Related Links

CONSTANT Formula

FEE_MULTIPLIER Formula

FIXED_FEE_BY_RANGE Formula

FIXED_FEE_BY_RANGE_ENHANCED Formula

FIXED_FEE_BY_RANGE_MULTIPLIER Formula

ICBO_BLDG_PERMIT Formula

ICBO_STYLE Formula

ICBO_STYLE_ENHANCED Formula

LINEAR_MIN_MAX_RANGE_PARAM Formula

LINEAR_MIN_MAX_VALUATION Formula

LINEAR_WITH_MIN_MAX Formula

LINEAR_WITH_MIN_MAX_ENHANCED Formula
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MIN_FEE_ADD_ON Formula

MIN_FEE_ADD_ON_FEESCHEDULE Formula

PENALTY Formula

SG-LINEAR_WITH_MIN_MAX Formula

SG-LINEAR_WITH_MIN_MAX Formula

SG-PERCENTAGE Formula

CONSTANT Formula
The CONSTANT fee formula enables you to establish a set fee independent of ranges or valuations. For
example, if you want to establish a flat $35 rate for an electrical permit, you can use the CONSTANT fee
formula to establish the $35 fee.

Any fee calculated using this formula is the product of the constant and the quantity that a user enters
while assessing fees. For example, if you determine the constant for any electrical permit to be “35” and a
user enters “2” as the quantity, then the total fee for two electrical permits is $70.00.

Input Parameter Format

a

Example

Electrical Permit Fee is $35. The user enters in 1 unit. The formula calculates as $35.

Input Parameter Definitions

a The rate constant for any fee Civic Platform calculates using this formula.

FEE_MULTIPLIER Formula
The FEE MULTIPLIER formula lets you calculate fees based on the product of two or more parameters as
well as the quantity from a fee assessment. You specify the number of parameters and the value of each
parameter. You can use fee indicators as input parameters and for specifying constant value.

A fee indicator is a unique 5-digit indicator that indentifies a certain application specific field value. When
using a fee indicator as an input parameter, you must use a value between 10100 and 10599 and use this
format: $fixxxxx$, such as $fi10101$. For more information about entering input parameters, see Setting
Up Fees.

A sample use case for FEE_MULTIPLIER is to calculate parking fees. For example, you can use this
formula to calculate a parking fee that is the product of a fixed fee, multiplied by the number of cars, and
the number of days those cars remain in a parking garage.

If your agency charges $15.00 per car per day to park in a company garage and the number of cars in the
garage (calculated from an application specific field that uses a fee indicator) is 2 and the number of days
those cars were in the garage (calculated from the quantity entered on the fee assessment) is 5, then the
total fee assessment is 15 x 2 x 5 or $150.

Formula Equation

x * a * b * c *...n

Input Parameter Format

a,b,c,...n

Example

Parking fees = Number of Cars * Number of Days parked * Fee($) /Day /Car.

X = number of cars

Formula Parameter: $FI10101$,$FI10102$



 | Part 7: Accounting | 747

So, if X = 5 cars, $FI10101$ = 10 days and $FI10102$ = 15.00 dollars

Then Parking Fee = 5 * 10 * 15 = 750.00 dollars

Input Parameter Definition

a Any value that you want to use to calculate the FEE_MULTIPLIER fee item. In addition to fixed values, you
can also enter a fee indicator, such as $fi10101$. To calculate the fee, Civic Platform multiplies this value
by any other input parameters as well as the quantity that the user enters on the fee assessment page.

b Any value that you want to use to calculate the FEE_MULTIPLIER fee item. In addition to fixed values, you
can also enter a fee indicator, such as $fi10101$. To calculate the fee, Civic Platform multiplies this value
by any other input parameters as well as the quantity that the user enters on the fee assessment page.

n Any value that you want to use to calculate the FEE_MULTIPLIER fee item. In addition to fixed values, you
can also enter a fee indicator, such as $fi10101$. To calculate the fee, Civic Platform multiplies this value
by any other input parameters as well as the quantity that the user enters on the fee assessment page.

X User input.

Conditions

There is no limit to the number of parameters or fee indicators that you can specify. You can also use
negative parameters.

FIXED_FEE_BY_RANGE Formula
The FIXED FEE BY RANGE formula lets you assess a fixed, or set fee depending on the quantity that a
user enters when assessing the fee. For example, you can charge a $50 licensing fee for day-care facilities
that care for up to six children, and charge a $100 licensing fee for facilities that care for fifteen children.

Formula Equation

X Fee

0 – R1 F1

R1 – R2 F2

R2 – R3 F3

R3 or more F4

Input Parameter Format

F1,R1,F2,R2,F3,R3,...Fn,Rn

Example

Labor Camp Fee where

# of Employees Fee

0-7 (0=<x=<7) $0

8-25 (8=<x=<25) $135

26-50 (26=<x<50) $350

50 or more (50=<x) $500

X = number of employees

Formula Parameter: 0,7,135,25,350,50,500

Input Parameter Definitions

F The fixed fee that you want to assess for any quantity that falls within the specified range of values.

R The maximum value within a range of quantities.

X User input.

Conditions
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• There is no limit to the number of ranges you can set up for this fee formula, but the total number of
characters that you can use to enter input parameters is 500.

• If you set up only one range, the fee is always equal to the fee for that range.

FIXED_FEE_BY_RANGE_ENHANCED Formula
The FIXED FEE BY RANGE ENHANCED formula lets you assess a fixed, or set fee depending on the
quantity that a user enters when assessing the fee. This formula calculates fees based upon data in
application specific information. This formula works the same as the FIXED_FEE_BY_RANGE formula,
except that it applies only to application specific information.

Formula Equation

$FI10xxx$ Fee

1 - R1 F1

R1 – R2 F2

R2 – R3 F3

R3 or more F4

Input Parameter Format

$FI10xxx$,F1,R1,F2,R2,F3,R3,F4

Example

$FI10100$ Fee

1 -100 23.20

101-200 34.80

201-300 81.10

301 or more 115.80

X = value of $FI10100$

Formula Parameter: $FI10100$, 23.20,100,34.80,200,81.10,300,115.80

Input Parameter Definitions

F The fixed fee that you want to assess for any quantity that falls within the specified range of values.

R The maximum value within a range of input quantities.

Conditions

• There is no limit to the number of ranges you can set up for this fee formula, but the total number of
characters that you can use to enter input parameters is 500.

• If you set up only one range, the fee is always equal to the fee for that range.

FIXED_FEE_BY_RANGE_MULTIPLIER Formula
The FIXED FEE BY RANGE MULTIPLIER formula lets you assess a fixed, or set fee depending on
the quantity that a user enters when assessing the fee. This formula calculates fees based on data in
application specific information and multiplies the quantity that a user enters by the fee that you specify in
the formula.

Formula Equation
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$FI10xxx$ Fee

1 - R1 F1*X

R1 – R2 F2*X

R2 – R3 F3*X

R3 or more F4*X

Input Parameter Format

$FI10xxx$,F1,R1,F2,R2,F3,R3,F4

Example

Apply residential capital expansion fees based on square feet, where Civic Platform stores measurement
for square feet in application specific information. Civic Platform applies fees according to this table.

Library Parks Police Fire

Up to 700 Sq. Ft. $260.00 $866.00 $64.00 $93.00

701-1200 Sq. Ft. $368.00 $1227.00 $91.00 $132.00

1201-1700 Sq. Ft. $433.00 $1443.00 $107.00 $155.00

1701-2200 Sq. Ft. $498.00 $1659.00 $123.00 $128.00

Over 2200 Sq. Ft. $606.00 $2020.00 $150.00 $217.00

Sample Use Case: Library Application 1

Square Feet: 700 Quantity Entered when assessing the fee: 1 The total library fee Civic Platform returns
with the new fee formula is: 1 * ($260) = $260

Sample Use Case: Library Application 2

Square Feet: 700 Quantity Entered when assessing the fee: 3 The total library fee Civic Platform returns
with the new fee formula is: 3 * ($260) = $780

Sample Use Case: Library Application 3

Square Feet: 800 Quantity Entered when assessing the fee: 3 The total library fee Civic Platform returns
with the new fee formula is: 3 * ($368) = $1104

Sample Use Case: Library Application 4

Square Feet: 2600 Quantity Entered when assessing the fee: 3 The total library fee Civic Platform returns
with the new fee formula is: 3 * ($606) = $1818

Input Parameter Definitions

F The fixed fee that you want to assess for any quantity that falls within the specified range of values.

R The maximum value within a range of input quantities.

X User input.

Conditions

• There is no limit to the number of ranges you can set up for this fee formula, but the total number of
characters that you can use to enter input parameters is 500.

• If you set up only one range, the fee is always equal to the fee for that range multiplied by the user
input.

ICBO_BLDG_PERMIT Formula
If your agency sets up standard job values according to the International Conference of Building Officials
(ICBO), you can use your valuations to calculate building permit fees. For example, you can determine the
fee for all job values between $1500 and $20,000.
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For each range that you include in the ICBO BLDG PERMIT formula you must determine the maximum
job value in that range, the fee factor for that range, and the modular base for that range. You should
also determine the minimum fee for a job value within any range. Depending on the ICBO valuations, the
ICBO_BLDG_PERMIT formula can calculate fees based on these values.

Formula Equation

If X =< R1 (below Range 1), then Fee = M

If R1 < X = R2 (Range 1), then Fee = M + N1 * (mod(X) base B1 – R1) / B1

Generalized:

If Ri < X = Ri+1, then Fee = M + Sum(Flower ranges) + Ni * (mod(X) base Bi – Ri) / Bi

Out of Range:

If X > Rmax, then Fee = M + Sum(Flower ranges) + Nmax * mod(X) base Bmax – Rmax) / Bmax

Input Parameter Format

[M, R1, N1, B1 (, R2, N2, B2], (R3, N3, B3 …,Rmax, Nmax,Bmax))

Where,

M is the minimum fixed fee.

Ri is the range below.

Ri+1 is the range above.

Ni is the fee factor for range i.

Bi is the modular base for range i.

Fi is the fee for range i.

Example 1

This example illustrates the Building Permit Fees based on the parameter below for Valuations of $1500
and $20,000.

Parameter:

(23.50,500,3.05,100,2000,14,1000,25000,10.10,1000,50000,7,1000,100000,5.60,1000,500000,4.75,1000,1000000,3.65,1000,9999999,3.65,1000)

Valuation (X) = $1500 Fee = $54.00

Valuation Range Maximum Fee
Equation at this
Range

Maximum Fee at
this Range

Equation at a
Valuation (X) within
this Range

Fee at a Valuation
within this Range

$1 - $500 23.50 $23.50 23.50 $23.50

$500 - $2000 (2000 – 500) / 100 *
3.05

$45.75 (X – 500) / 100 * 3.05
(1500 – 500) / 100 *
3.05

$30.50

SUM $23.50 + $30.50 $54.00

Valuation (X) = $20,000 Fee = $321.25

Valuation Range Maximum Fee
Equation at this
Range

Maximum Fee at
this Range

Equation at a
Valuation (X) within
this Range

Fee at a Valuation
within this Range

$1 - $500 23.50 $23.50 23.50 $23.50

$500 - $2000 (2000 – 500) / 100 *
3.05

$45.75 (2000 – 500) / 100 *
3.05

$45.75

$2000 - $25000 (25000 – 2000) / 1000
* 14

$322.00 (X – 2000) / 1000 *
14(20000 – 2000) /
1000 * 14

$252.00

SUM $23.50 + $45.75 +
$252.00

$321.25

Example 2
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Parameter: (10, 100, 1.5, 10, 200, 1, 20)

If X = 15, because X = R1, then Fee = M, therefore Fee = 10.

If X = 123, because R1 < X = R2, then Fee = M + Sum(Flower ranges) + N1 * (mod(X) base B1 – R1) / B1

Fee = 10 + 0 + 1.5 * (mod(123) base 10 – 100) / 10

Fee = 10 + 1.5 * (130 – 100) / 10

Therefore, Fee = 14.5

If X = 209, because X > Rmax, then Fee = M + Sum(Flower ranges) + N2 * mod(X) base B2 – R2) / B2

Fee = M + N1 * (mod(R2) base B1 – R1) / B1 + N2* mod(X) base B2 – R2) / B2

Fee = 10 + 1.5 * (mod(200) base 10 – 100) / 10 + 1 * (mod(209) base 20 – 200) / 20

Fee = 10 + 1.5 * (200 – 100) / 10 + 1 * (220 – 200) / 20

Fee = 10 + 15 + 1

Therefore, Fee = 26

If X = 451, because X > Rmax, then Fee = M + Sum(Flower ranges) + N2 * mod(X) base B2 – R2) / B2

Fee = M + N1 * (mod(R2) base B1 – R1) / B1 + N2 * mod(X) base B2 – R2) / B2

Fee = 10 + 1.5 * (mod(200) base 10 – 100) / 10 + 1 * (mod(451) base 20 – 200) / 20

Fee = 10 + 1.5 * (200 – 100) / 10 + 1 * (460 – 200) / 20

Fee = 10 + 15 + 13

Therefore, Fee = 38

Example 3

Parameter: 10, 100, 1.5, 10, 200, 1, 20, 1000, 3, 100

If X = 451, because R2 < X =< R3, then Fee = M + Sum(Flower ranges) + N2* mod(X) base B2 – R2) / B2

Fee = M + N1 * (mod(R2) base B1 – R1) / B1 + N2 * mod(X) base B2 – R2) / B2

Fee = 10 + 1.5 * (mod(200) base 10 – 100) / 10 + 1 * (mod(451) base 20 – 200) / 20

Fee = 10 + 1.5 * (200 – 100) / 10 + 1 * (460 – 200) / 20

Fee = 10 + 15 + 13

Therefore, Fee = 38

If X = 1550, because X > Rmax, then Fee = M + Sum(Flower ranges) + N3 * mod(X) base B3 – R3) / B3

Fee = M + N1 * (mod(R2) base B1 – R2) / B2+ N2 * mod(R3) base B2 – R2) / B2+ N3 * (mod(X) base B3 –
R3) / B3

Fee = 10 + 1.5 * (mod(200) base 10 – 100) / 10 + 1 * (mod(1000) base 20 – 200) / 20 + 3 * (mod(1550)
base 100 – 1000) / 100

Fee = 10 + 1.5 * (200 – 100) / 10 + 1 * (1000 – 200) / 20 + 3 * (1600 – 1000) / 100

Fee = 10 + 15 + 40 + 18

Therefore, Fee = 83

Input Parameter Definitions

M The minimum fee for any job value; a fixed fee for job values within your first range of job values.

R The maximum value within a range of job values.

N The fee factor used to multiply the range a job values.

B The modular base of the job value. The modular base determines how Civic Platform rounds off a job
value, such as the nearest tenth.

Conditions

• There is no limit to the number of ranges you can set up for this fee formula, but the total number of
characters that you can use to enter input parameters is 500.

• If you set up only one range of job values, the fee is equal to the minimum fixed fee (M).
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• If you configure multiple ranges up to Rn, the fee includes the sum of the minimum fee and the
maximum fee for all other ranges up to and including Rn-1.

• For an ICBO 1997 Administrative Code Building Permit Fee, use these parameters:

23.5,500.3.05,100,2000,14,1000,25000,10.1,1000,50000,7,1000, 100000,
5.6,1000,500000,4.75,1000,1000000,3.65,1000

ICBO_STYLE Formula
The ICBO STYLE formula is similar to the ICBO_BLDG_PERMIT formula in that it lets you configure fee
formulas for a range of values.  Instead of calculating fees based on job values, the ICBO_STYLE formula
bases fees on the quantity that users enter when assessing fees.

For each range that you include in the ICBO_STYLE formula you must determine the maximum quantity in
that range, the fee factor for that range, and the modular base for that range. You should also determine
the minimum fee for any within any range. The fee for each quantity that falls within a pre-defined range is
dependent on the sum of fees for all previous ranges.

Input Parameter Format

M,R1,N1,B1,R2,N2,B2,R3,N3,B3,...Rn,Nn,Bn

Where,

M is the minimum fixed fee.

Ri is the range below.

Ri+1 is the range above.

Ni is the fee factor for range i.

Bi is the modular base for range i.

Fi is the fee for range i.

Example

A Client requires a fee formula with a changing base fee plus a sliding percentage over a defined range of
inputs. Such as:

$1001 - $5000 = $80.00 + 3% of excess over $1000.00

$5001 - $10,000 = $250.00 + 2% of excess over $5000.00

$10,001 - $25,000 = $350.00 + 1% of excess over $10,000.00

$25,001 and Over = $520.00 + 3/4% of excess over $25,000.00

You must break down this fee schedule into four individual formulas, one for each range.

Parameters:

Formula1 = (80,1000,.03,1,5000,0,0) for the $1001 - $5000 range

Formula2 = (250,5000,.02,1,10000,0,0) for the $5001 - $10,000 range

Formula3 = (350,10000,.01,1,25000,0,0) for the $10,001 - $25,000 range

Formula4 = (520,25000,.0075,1,999999,0,0) for the over $25,000 range

If X=2000, the user must enter X into Formula1, because R1 < X = R2, then

Fee = M + N1 * (mod(X) base B1 – R1) / B1

Fee = 80 + .03 * (mod(2000) base 1 – 1000) / 1

Fee = 80 + .03 * (2000 – 1000) / 1

Fee = 80 + .03 * 1000

Fee = 80 + 30

Therefore, Fee = 110

If X= $30,000, the user must enter X into Formula4, because R1 < X = R2, then
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Fee = M + N1 * (mod(X) base B1 – R1) / B1

Fee = 520 + .0075 * (mod(30000) ) base 1 – 25000) / 1

Fee = 520 + .0075 * (30000 – 25000) / 1

Fee = 520 + .0075 * 5000

Fee = 520 + 37.5

Therefore, Fee = 557.5

Input Parameter Definitions

M The minimum fee for any job value; a fixed fee for job values within your first range of job values.

R The maximum value within a range of quantities. For example, if you want to configure fees for a range of
quantities between 0 and 500, enter 500.

N The fee factor used to multiply the user input. For example, if in addition to the minimum fee you want to
charge 3% of the total quantity, enter .03.

B The modular base of the job value. The modular base determines how Civic Platform rounds off a user
input value, such as to the nearest tenth.

X User input.

Conditions

• If you want to set up a fee formula with a changing minimum fee for each range of quantities, you must
set up individual fee items for each range. Each fee item can use only one formula. When you create
the fee item, make sure you enter the input parameters and choose the formula that is appropriate for
the range you want to set up.

• There is no limit to the number of ranges you can set up for this fee formula, but the total number of
characters that you can use to enter input parameters is 500.

• If you set up only one range of job values, the fee is equal to the minimum fixes fee (M).

• If you configure multiple ranges up to Rn, the fee includes the sum of the minimum fee and the
maximum fee for all other ranges up to and including Rn-1.

ICBO_STYLE_ENHANCED Formula
The ICBO STYLE ENHANCED formula is similar to the ICBO_STYLE which lets you set up unique fees for
a range of values that a user enters. The user input used in this formula is the quantity that a user enters
when assessing the fee. Each range of quantities can have a unique minimum fee, a unique modular base,
and a unique fee factor.

Unlike the ICBO_STYLE formula, you do not need to set up an individual formula with unique input
parameters for each range. You can include the minimum value, the modular base, and the fee factor for
each range within a single set of input parameters. The fee calculated is not dependent on any other range
values.

Formula Equation

If X =< R1 (below Range 1), then Fee = M0 + N0 * Ceiling(X – R0) base B0

If R1 < X = R2 (Range 1), then Fee = M 1+ N1 * Ceiling (X – R1) base B1

Generalized:

If Ri < X = Ri+1, then Fee = Mi + Ni * Ceiling (X – Ri) base Bi

Out of Range:

If X > Rmax, then Fee = Mmax + Nmax * Ceiling (X – Rmax) base Bmax

Input Parameter Format

M0,N0,B0,R1,M1,N1,B1, (R2,M2,N2,B2, (R3,M3,N3,B3,...Rn,Mn,Nn,Bn))
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Where,

Mi is the base fee.

Ni is the fee factor for range i.

Bi is the modular base for range i.

Ri+1 is the range above (R0 = Civic Platform assumes 0 for the low end).

Fi is the fee for range i.

Example

A Client requires a fee formula with a changing base fee plus a sliding percentage over a defined range of
inputs. Such as:

$1001 - $5000 = $80.00 + 3% of excess over $1000.00 per 100 unit increment

$5001 - $10,000 = $250.00 + 2% of excess over $5000.00 per 500 unit increment

$10,001 - $25,000 = $350.00 + 1% of excess over $10,000.00 per 1000 unit increment

$25,001 and Over = $520.00 + 3/4% of excess over $25,000.00 per 1000 unit increment

Parameters:

(0,0,1,1000,80,.03,100,5000,250,.02,500,10000,350,.01,1000,25000,520,.0075,1000)

If X=500, not in the range

Fee = 0 + 0*(x-0)/1 = 0

If X=2050, first range

Fee = M1 + N1 * Ceiling(X – R1) base B1

Fee = 80 + .03 * Ceiling(2000 – 1000) / 100

Fee = 80 + .03 * 11

Fee = 80 + 3.3

Therefore, Fee = 83.3

If X= $30,000

Fee = M + N1 * Ceiling (X – R1) base Bmax

Fee = 520 + .0075 * Ceiling (30000 – 25000) / 1000

Fee = 520 + .0075 * 5

Fee = 520 + 0.038

Therefore, Fee = 520.04

Input Parameter Definitions

M The minimum fee for any job value within a range.

R The minimum value within a range of job values. For example, if you want to configure fees for a range of
job values between $1000 and $5000, enter 5000.

N The fee factor used to multiply the range a job values. For example, if in addition to the minimum fee you
want to charge 3% of the job value, enter, enter .03.

B The modular base of the job value. The modular base determines how Civic Platform rounds off a job
value, such as to the nearest tenth.

X User input.

Conditions

• There is no limit to the number of ranges you can set up for this fee formula, but the total number of
characters that you can use to enter input parameters is 500.

• Any modular base (B in this formula) cannot equal zero and must be greater than one.
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LINEAR_MIN_MAX_RANGE_PARAM Formula
The LINEAR MIN MAX RANGE PARAM formula is a range formula. Range formulas let you set up unique
parameters depending on the range in which the user input or the job values belong. For example, you can
set up a minimum fee for job values less than $5000 that is different than the minimum fee for job values
greater than $5000.

The LINEAR_MIN_MAX_RANGE_PARAM formula is a unique formula. This formula enables you to
calculate fees based on user input as well as standard job values. This formula calculates fees based
on job values or the value from a specific information field on an application. With a fee indicator, you
determine what value you want to use when you set up the fee item. You can use a unique fee indicator for
each specific information value or job value that you set up.

For example, if you set up a specific information field for an application to collect the total value of
employee salaries, you can configure fees based on the value that a user enters. When you add a field
to a specific information group, you assign a fee indicator to it. When you set up a fee item based on the
specific information value, you must use the same fee indicator as an input parameter.

Formula Equation

$FI10100$ * a / B

Input Parameter Format

$Fixxxxx$,a1,B1,m1,M1,R1,a2,B2,m2,M2,R2,...an,Bn,mn,Mn,Rn

Example

$FI10100$,0.15,1000,30,150,200000,0.15,1000,30,150,1000000,0.15,1000,30,150,999999999.

Gross Receipt (in Additional Specific Information, $FI10100$) is $210,000. The user enters 1 unit for the
Business License Fee. Civic Platform calculates the fee as $210,000 * 0.15 / 1000 = $31.50

Input Parameter Definitions

Fi The fee indicator is a five-digit number between 10100 and 10599. Civic Platform uses the indicator to
identify a job value, or a specific information value from an application.

a The fee factor used to multiply the job value or the specific information value. For example, if you want to
assess a fee based on 15% of an annual salary value, enter .15.

B The modular base of the job value or the specific information value. The modular base determines how
Civic Platform rounds off a job value, such as to the nearest tenth or hundredth.

m The minimum fee that you want to assess for any value that falls in a specific range.

M The maximum fee that you want to assess for any value that falls in a specific range.

R The maximum value within a range of values. For example, if you want to set up input parameters for
values that are less than $4000, enter 4000.

Conditions

• There is no limit to the number of ranges you can set up for this fee formula, but the total number of
characters that you can use to enter input parameters is 500.

• A fee indicator must be a five-digit number between 10100 and 10599.

LINEAR_MIN_MAX_VALUATION Formula
The LINEAR MIN MAX VALUATION formula does not accommodate value ranges. Using this formula
you can configure fees that increase based on a job valuation or a unit price. You can also determine the
minimum fee and maximum fee for any fee item that uses this formula. For example, you can set up a plan
review fee that is 65% of the total valuation, at least $10.00, but not more than $1000.00.

This formula takes into account user input: the quantity that the user enters when assessing the fee. For
example, if a user assesses a fee for 1000 square feet, and the unit price for each square foot is $0.44,
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then the quantity of 1000 is multiplied with the unit price to calculate the fee. The quantity for a fee item
based on a valuation is typically 1. For example, if a user is assessing a fee for a plan review and Civic
Platform calculates the fee item based on the total job value, the user enters “1” to indicate that one plan
review is complete.

Formula Equation

c,a,b,min,max or $FI00003$,a,b,min,max or a*$FI00003$ * X + b

Input Parameter Format

c,a,b,m,M

Example 1

Pool Heater Fee of $15 per pool heater.

X = number of pool heaters

Formula Parameter: $FI00003$,15,0,0,999999

Example 2

Electrical Base Fee of $25.00

X = 1

Formula Parameter: 0,25,25,25

Example 3

Inspection Fee of $80 per hour with a minimum of ½ hour.

X = number of hours

Formula Parameter: 80,0,40,999999

Example 4

A Plan Review Fee of 65% of the total Valuation.

X=1

Formula Parameter: $FI00003$,0.65,0,999999

Formula Calculation: The Valuation = $40,000.00

When you enter X = 1, the fee is then 40000*0.65*1+0 = 26,000.00

Example 5

A Police Impact Fee of $0.44/sq.ft. plus a base fee of $10.00.

X=2000 (enter in Sq. Ft.)

Formula Parameter: 0.44,1,10,0,999999

Formula Calculation:

If X = 2000 (or 2000 square feet), Fee = (0.44)(1)(2000)+10 = $890.00

Input Parameter Definitions

c The unit price or the fee indicator of a valuation. A fee indicator is a five-digit number between 10100 and
10599 that identifies a standard valuation or the value of a specific information field on an application.

a The fee factor used to multiply the unit price or  job value. For example, if you want to assess a fee of 65%
of the total valuation, enter .65.

b The base fee that you want to add to the product of C and A. For example, if you want to add a base fee of
$10.00 to any fee, enter 10.

m The minimum fee that you want to assess regardless of user input.

M The maximum fee that you want to assess regardless of user input.

X User input.

Conditions

A fee indicator must be a five-digit number between 10100 and 10599.
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LINEAR_WITH_MIN_MAX Formula
The LINEAR WITH MIN MAX formula is the simplest fee formula. This formula does not account for value
ranges, and you cannot use valuations with this formula. This formula calculates a fee based on the
product of the quantity that a user enters when assessing a fee and the unit price.  For example, if the unit
price for a single pool heater is $15.00, the fee for two heaters is $30.00.

Formula Equation

a * X + b

Input Parameter Format

a,b,m,M

Example 1

Pool Heater Fee of $15 per pool heater.

X = number of pool heaters

Formula Parameter: 15,0,0,999999

So, if X = 5 heaters à Fee = 5 * 15 = $75

Example 2

Electrical Base Fee of $25.00

X = 1

Formula Parameter: 0,25,25,25

So, if X = 1 à Fee = $25

Example 3

Inspection Fee of $80 per hour with a minimum of ½ hour.

X = number of hours

Formula Parameter: 80,0,40,999999

So, if X = 5 hours à Fee = 5 * 80 = $400

So, if X = 0.25 hours (or 15 min.)à Fee = $40 (because 0.25 * 80 = $20, which is less than $40, the
minimum fee.)

Input Parameter Definitions

a The unit price. For example, if you want to assess a fee of $15.00 for a single pool heater, enter 15.

b The base fee that you want to add to the product of “a” and the quantity that a user enters when assessing
the fee. For example, if you want to charge a base fee of 25.00 for any electrical work, enter 25.

m The minimum fee that you want to assess regardless of user input.

M The maximum fee that you want to assess regardless of user input.

X User input.

LINEAR_WITH_MIN_MAX_ENHANCED Formula
The LINEAR WITH MIN MAX ENHANCED formula is similar to the LINEAR_WITH_MIX_MAX formula in
that you cannot use valuations. This formula calculates fees based only on the quantity that a user enters
when assessing a fee. You can however, set up input parameters for multiple ranges of quantities. For
example, you can assess a design review fee of $350 per house unit, and $150 per house unit after 15
units.

Formula Equation

ai * (X – Ri) + bi

X Fee

0 - R1 a * ( X ) + b
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X Fee

R1 – R2 a1 * ( X – R1 ) + b1

R2 – R3 a2 * ( X – R2 ) + b2

R3 or more a3 * ( X – R3 ) + b3

This formula assumes the initial range begins with zero. You can enter the minimum value only for
subsequent ranges. For example, if you want an initial range of 0-5, enter “5” as the R1 input parameter.

Input Parameter Format

a,b,m,M,R1,a1,b1,m1,M1,R2,a2,b2,m2,M2,...Rn,an,bn,mn,Mn

Example 1

Design Review Fee ($350 per house unit, $150 per house unit after 15 units)

X Fee

0 - 15 350 * X + 0

15 or more 150 * (X – 15) + 5250

X = number of house units

Formula Parameter: 350,0,0,9999999,15,150,5250,0,9999999

Formula Calculation:

So, if X = 10 house units, then Fee = 350 * 10 + 0 = $3500.

So, if X = 20 house units, then Fee = 150 * (20 – 15) + 5250 = $6000.

Example 2

A Day Care Operation Fee:

x Fee

0 - 6 35 * X + 0

7 -12 50 * (X – 12) + 50

12 or more 50 * (X – 12) + 50

When the number of children is less than 6, fee = $35.00

When the number of children is between 7 and 12, fee = $50.00

When the number of children is greater than 12, fee = $50.00 + (X –12)*2

X =number of children

Formula Parameter: 0,35,0,999999,6,0,50,0,999999,12,2,50,50,999999

Formula Calculation:

So if X = 5 Children, then Fee = 35 * 5 + 0 = $175.00

So if X = 10 Children, then Fee = 50 * (10 –12) = $500.00

Input Parameter Definitions

a The unit price. For example, if you want to assess a fee of $15.00 for a single pool heater, enter 15.

b The base fee that you want to add to the product of “a” and the quantity that a user enters when assessing
the fee. For example, if you want to charge a base fee of 25.00 for any electrical work, enter 25.

m The minimum fee that you want to assess regardless of user input.

M The maximum fee that you want to assess regardless of user input.

R The minimum quantity within a range of quantities. For example, if you want to assess a unique fee for
quantities greater than or equal to 5, but less than 15, enter “5” for R1 and “15” for R2.

X User input.
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MIN_FEE_ADD_ON Formula
The MIN FEE ADD ON formula lets you assess a fee on top of the sum of all other fees Civic Platform
assesses on an application. For example, if the sum of all assessed fees is $35.00 and you want to always
charge a minimum fee of $50.00, the MIN_FEE_ADD_ON formula makes up the difference of $15.00.

You can set up a minimum parameter so that the total sum of all assessed fees never falls below the
minimum. You can also determine a base fee that you want to add onto the minimum fee.  If the sum of all
assessed fees is above the minimum fee, the MIN_FEE_ADD_ON formula does not affect the fee balance
in any way.

Civic Platform calculates a subtotal of the fees, minus the MIN_FEE_ADD_ON fee, and compares the
subtotal to the min parameter. If the subtotal is less than the min parameter, then Civic Platform enters a
value in the MIN_FEE_ADD_ON fee so that the total (including the MIN_FEE_ADD_ON fee) equals to the
min parameter. If the subtotal is greater than or equals to the min parameter, then Civic Platform enters
zero in the MIN_FEE_ADD_ON fee.

Input Parameter Format

a,b,min,max

Example

1,0,50,99999999

There are two fees: Electrical fee of $35, and Planning Review fee of $10.

The subtotal is $35 + $10 = $45, which is less than 50.

The user enter 1 unit for MIN_FEE_ADD_ON fee. Civic Platform enters $5 to this MIN_FEE_ADD_ON fee.
The total fee then is $50.

Input Parameter Definitions

a The fee factor used to multiply the subgroup total.

b The base fee that you want to assess in addition to any minimum fee.

min The minimum fee that you want to assess independent of the total sum of all fee items Civic Platform
already assessed.

max The maximum fee that you want to assess

MIN_FEE_ADD_ON_FEESCHEDULE Formula
The MIN FEE ADD ON FEESCHEDULE formula lets you assess a fee on top of the sum of all other
fees Civic Platform has assessed for a fee schedule. For example, if the sum of all assessed fees
in a particular fee schedule is $35.00 and you want to always charge a minimum fee of $50.00, the
MIN_FEE_ADD_ON_FEESCHEDULE formula makes up the difference of $15.00.

You can set up a minimum parameter so that the total sum of all assessed fees on a fee schedule never
falls below the minimum. You can also determine a base fee that you want to add onto the minimum fee.
If the sum of all assessed fees falls above the minimum fee, the MIN_FEE_ADD_ON_FEESCHEDULE
formula does not affect the fee balance in any way.

This fee calculation has nothing to do with the Sub Group fee items calculation. You cannot include a
minimum fee in a sub group because Civic Platform calculates the fee items after it calculates the sub
group fee items.

Input Parameter Format

a,b,min,max

Example

1,0,60,99999999

There are two fees: Electrical fee of $35 (Fee schedule = ELE03), and Mechanical Base fee of $10 (Fee
schedule = MECH03).
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Because this fee formula calculates minimum fee based on Fee schedule,

Electrical fee is $35, which is less than $60 (for ELE03 fee schedule)

System adds the Electrical Min fee as $60 - $35 = $25

Mechanical Base fee is $35, which is less than $60 (for MECH03 fee schedule)

System adds the Mechanical Min fee as $60 - $10 = $50

There are 4 fee items for this application

Electrical fee = $35

Electrical Min fee = $25

Mechanical Base fee = $10

Mechanical Min fee = $50

The total fee for this application is $120

ELE03 Min Fee Add On $25 and it is the same way for MECH03 fee schedule.

Note that this $25 is the $60 minimum fee ($60 - $35 = $25) for fee schedule ELE03. This calculation
ensures that the total fees are at least $60.

Input Parameter Definitions

a The fee factor used to multiply the subgroup total.

b The base fee that you want to assess in addition to any minimum fee.

min The minimum fee that you want to assess independent of the total sum of all fee items Civic Platform has
assessed already.

max The maximum fee that you want to assess

PENALTY Formula
The PENALTY formula is similar to the MIN_FEE_ADD_ON formula, which lets you assess a penalty
fee based on the total outstanding balance of new and invoiced fees added prior to the fee item with the
PENALTY formula. For example, if the sum of all unpaid fees exceeds $3000, you can assess a penalty
fee of $10.00 for every $1000 over a certain limit.

A unique feature of the PENALTY formula is that it figures user input in the equation. The user input
referenced is the quantity that a user enters when assessing the penalty fee. You can set up the PENALTY
formula with minimum fees and maximum fees. Civic Platform forces any penalty fee that falls below this
range to the minimum fee. Civic Platform forces any fee that falls above this range to the maximum fee that
you determine.

Civic Platform calculates the PENALTY formula as follows: Total fee assessed * X * (a/100) + b

Input Parameter Format

a,b,min,max

Example 1

10,5,50,9999

Total fees assessed is $100. The penalty fee calculation is:

X = 1

Penalty fee = $100 * 1 * (10 /100) + 5 = $15.00

Because the penalty fee of $15.00 is less than minimum fee amount, which is $50, the penalty fee is
$50.00

Example 2

20,100,50,99999

Total fee assessed is $100. The penalty fee calculation is:

X = 1

Penalty fee = $100 * 1 * (20/100) + 100 = $120.00
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Because the penalty fee of $120.00 is more than the minimum fee amount of $50 and less than the
maximum fee amount of $99999, the penalty fee calculates to $120.00.

Input Parameter Definitions

a The percentage, or fee factor that you want to multiply with the total sum of all assessed fees. Enter a
percentage value that is NOT in the form of a decimal. For example, if you want to assess a penalty fee
that is 20% of the sum of all assessed fees, enter 20. Civic Platform divides this value by 100 in the fee
formula resolve “20” to a percentage (20/100).

b The base fee that you want to add to the product of “a,” the quantity that a user enters, and the total sum
of all assessed fees.

min The minimum penalty fee that you want to assess.

max The maximum penalty that you want to assess.

X The user enters the X parameter.

SG-LINEAR_WITH_MIN_MAX Formula
The SG-LINEAR WITH MIN MAX formula is similar to the MIN_FEE_ADD_ON formula, which lets you
assess a fee based on other fees. This formula is unique, as it lets you assess a fee based on a subgroup
of assessed fees, rather than the total sum of all assessed fees.

After you assess a group of fees, you can assess an additional fee that belongs to a certain subgroup,
based on the sum of all the fees that belong to the same subgroup within the same fee schedule.
Subgroups are similar to fee indicators, which Civic Platform uses to identify a single valuation; however,
you can include multiple fee items in a single subgroup. When you configure fee items, you have the option
to associate each fee with a unique subgroup.

Civic Platform sums up all the fees in this subgroup, then takes the subtotal, multiplies it by a, and adds b
to it.

Input Parameter Format

a,b,min,max

Example

10,50,0,999999

There are two fees: Electrical fee of $35, and Planning Review fee of $10.

The SUBGROUP subtotal is $35 + $10 = $45.

Civic Platform calculates as $45 * 10 + 50 = $500.

Input Parameter Definitions

a The fee factor used to multiply the subgroup total. For example, if you want to assess a fee that is 65% of
the subgroup sum, enter 65.

b The base fee that you want to assess in addition to any minimum fee.

min The minimum fee that you want to assess, independent of the total sum of all fee items previously
assessed.

max The maximum fee that you want to assess.

SG-PERCENTAGE Formula
The SG-PERCENTAGE formula lets you assess the fee of a fee item based on the sum of other fees that
belong to the same subgroup as the fee item.

Similar to fee indicators, which Civic Platform uses to identify a single valuation, subgroups let you identify
multiple valuations for all fee items with the same subgroup. When you configure fee items, you have the
option to associate each fee with a unique subgroup. To include additional fee items in the same subgroup,
you must use the same subgroup code for each fee item you want to include in the subgroup.
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Input Parameter Format

a

Example

75

There are four fees in the same subgroup SUBGROUP75: Electrical fee of $35, Planning Review fee of
$10, Checking fee of $40, and Building Permit fee of the SG-PERCENTAGE formula, and with 75 as its
calc variable.

After you add the Electrical fee, Planning fee, and Building Permit fee (quantity: 1) to a record,

The Building Permit fee = ($35 + $10) * 75% = $33.75.

After you invoice the Electrical fee, if the Standard Choice SG-
PERCENTAGE_EXCLUDE_INVOICED_FEE is Yes,

The Building Permit fee = $10 * 75% = $7.50.

And if you invoice the Building Permit fee, and add the Checking fee to the record, if the Standard Choice
SG-PERCENTAGE_EXCLUDE_INVOICED_FEE is Yes,

The Building Permit fee = $7.50.

Input Parameter Definitions

a The percentage point which you want to multiply with the subgroup total. For example, if you want to
assess a fee that is 75% of the subgroup sum, enter 75.

Conditions

• You can configure the Standard Choice SG-PERCENTAGE_EXCLUDE_INVOICED_FEE
to determine whether to include the fees of all the other fee items in the sum, or only the
fees of the fee items that are of the New status. Note that if the Standard Choice SG-
PERCENTAGE_EXCLUDE_INVOICED_FEE is Yes, when users recalculate the fees in a record, and
the fee item of the SG-PERCENTAGE formula has an “Invoiced” status, the recalculation does not
change the value of the fee item.

• Any subtotal that you calculate using the SG-PERCENTAGE formula cannot include fee items that Civic
Platform calculates using the SG-LINEAR_WITH_MIN_MAX formula. This formula is already a subtotal
of other fee items.

• When a user assesses a SG-PERCENTAGE fee, it appears at the bottom of the list of assessed fees.
Because this fee involves sub-totaling other fees, Civic Platform assumes this fee is the final fee in a list
of fees.

• If a fee item uses the SG-PERCENTAGE formula, and its “Assess Adjustment on Recalculation” is Yes
in the Fee Item – Edit page in Classic Administration, if the fee item already exists in a record, users
cannot add the fee item again unless the existing item status is VOIDED.

Invoices and Payment Periods
This section addresses the administrative setup for invoices and payment periods.

Payment periods act as a flag for batch processing for invoicing customers so that the agency knows
what application fees to bill to a customer and when. An agency can control who can remove fees from a
submitted or partial application.

Click a topic title below for full details.

Related Links

Managing Payment Periods
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Configuring Invoicing Options

Managing Payment Periods
Topics

• Configuring Payment Periods

• Adding a Payment Period

• Searching for a Payment Period

• Editing a Payment Period

Configuring Payment Periods
See Accela Civic Platform Configuration Reference.

Adding a Payment Period
As necessary, you can add new payment periods to Civic Platform. When you add a payment period, you
can choose the order in which you want payment periods to display within a fee schedule. When a user
assesses a fee, payment periods with a lower display order appear first in the list.

To add a payment period

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Payment Period.

3. Click Add.

4. Complete these fields:

Payment Period Enter a unique name to identify the payment period. For example, enter “Final” to
identify a payment period that occurs at the end of the application process.

Display Order Enter a number to determine the position of the payment period within a list of
payment periods. For example, if you want the period to display before any other
periods, enter 1.

Status If you want to make the payment period available to users in Civic Platform, select
Active; otherwise, select Inactive.

5. Click Save.

Searching for a Payment Period
If you want to edit an existing payment period, you first need to search for the period in your database. You
can also search for a payment to view details about the payment period without necessarily editing it. You
can search for a payment period based on the payment period name and status.

To see a list of all payment periods, click Submit without entering details about an individual period.

To search for a payment period

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Payment Period.
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3. Complete these fields:

Payment Period Enter the name of the payment period for which you are searching.

Record Status Choose the payment period you want to find. You can search for enabled or disabled
items.

4. To see a list of all payment periods, click Submit without entering details about a period.

5. Click Submit.

6. If Civic Platform displays a list of options, click the option that you want.

Editing a Payment Period
You can change the display order or the status of any pay period.

To edit a payment period

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Payment Period.

3. Search for the payment period that you want.

4. Update these fields:

Display Order Enter a number to determine the position of the payment period within a list of
payment periods. For example, if you want the period to display before any other
periods, enter 1.

Status If you want to make the payment period available to users in Civic Platform, select
Active; otherwise, Select Inactive.

5. Click Save.

Configuring Invoicing Options
See Accela Civic Platform Configuration Reference.

Trust Accounts
This section introduces the Trust Account portlet, its functionality, and the required administrative setup
tasks.

To use trust accounts in Citizen Access, you must configure trust accounts in both Civic Platform (as
described in this section), and in Citizen Access. The setup of trust accounts for registered public users in
Citizen Access is in the “Trust Accounts” section of the Citizen Access Administrator Guide.

Click a topic title below for full details.

Related Links

Configuring Trust Account Functionality

Managing Trust Account Transactions

Viewing and Printing Trust Account Reports
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Configuring Trust Account Functionality
Civic Platform allows you to maintain the trust accounts in your agency. You can create a new account,
edit information about an existing account, or close an account that is no longer needed. Use this section
to customize the receipt summary and email notifications when the trust account balance is below a
defined threshold amount. Maintaining your trust accounts helps to keep the trust account information
accurate and current.

Topics

• Enabling Trust Account Email Notifications

• Enabling Receipt Summaries and Hyperlink Receipt IDs

• Customizing the Content of Trust Account Notifications

• Associating Addresses with a Trust Account

• Searching for a Trust Account

• Creating a Trust Account

• Editing a Trust Account

• Removing Associated Addresses from a Trust Account

• Associating Parcels with a Trust Account

• Removing Associated Parcels from a Trust Account

• Associating People with a Trust Account

• Removing Associated People from a Trust Account

• Viewing Associated Records for a Trust Account

• Closing a Trust Account

• Automating Trust Accounts

Enabling Trust Account Email Notifications
When the balance of a trust account is less than the threshold amount you defined in the trust account,
Civic Platform can send a low balance email notification to the trust account administrator and to other
contacts, as described below. To enable email notifications you must configure email addresses in four
places in Civic Platform, as described below.

To enable trust account email notifications

1. Configure the email credentials of your preferred “Sent From” email account in the
ServerConfig.properties file on your av.biz server. For complete details, refer to the Accela Civic
Platform Installation Guide and follow the instructions in the section, “Configuring “Sent From” Email
Address for Trust Account Notifications.”

2. Configure the name and email address of the recipient(s) of trust account email notification(s) in the
following places in Civic Platform. You can have up to three recipient types, as described below:

a. To send email notifications to the citizen responsible for this trust account, configure the standard
choice TRUST_ACCOUNT_ADMINISTRATOR to include their name and email address. See the
Civic Platform Configuration Reference for complete details.
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b. To send email notifications to an Accela user, configure their email address in their user profile in
Civic Platform (Classic Admin > Tools > User Profile > User). Then select that user profile in the
“Assigned to Staff” setting of a record associated with the trust account, as illustrated here:

c. To send email notifications to a licenced professional and/or a contact, configure the Associated
People in the Trust Accounts portlet by choosing the Licensed Professional and/or Contact to whom
you want to send email notifications. Search for an existing licenced professional and/or contact,
then select it. If the licenced professional and/or contact does not already exist you must first create
it and then select it here.

Enabling Receipt Summaries and Hyperlink Receipt IDs
To enable customized receipt summaries and hyperlink receipt IDs
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1. Enable full access to FID 8286: Fees Print Receipt Summary. Enabling this FID does two things: it
enables customized receipt summaries, and it transforms the receipt ID field on the Transactions tab
of the Trust Account portlet from static text to a hyperlink (shown in the sample screen below), giving
users easy access to the receipt summary.

Troubleshooting Tip: If you do not see this FID in the modules and user groups where you are trying to
implement this functionality, you must first enable the FID at the Super Agency level. After you enable
the FID at the Super Agency level it becomes available in all modules and user groups.

Refer to the Civic Platform Configuration Reference for instructions on enabling FIDs.

2. Configure ActiveX controls and trusted sites in Internet Explorer. This is a necessary component of
customized receipt summaries – if you do not properly configure ActiveX controls, you cannot view
or print customized receipts. Refer to the Accela Civic Platform Installation Guide and follow the
instructions in: “ActiveX Controls for Cashiering and Trust Accounts” and “Accela Server Trusted Site
for Cashiering and Trust Accounts.”

Troubleshooting Tip: If you have not installed ActiveX Controls, Internet Explorer notifies you with one
of the prompts below. Follow the prompts to install ActiveX Controls.

Customizing the Content of Trust Account Notifications
You can customize the content of the following types of trust account communications:

• Detailed trust account receipt summaries

• Email notifications Civic Platform sends when a trust account balance falls below a threshold amount

• Trust account check endorsement details

To customize the content of trust account check endorsements or receipts
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1. Access the Content Customize portlet (Navigating to the Setup Portlet).

2. In the Content Customize portlet, specify one of the following from the Type field in Content Customize:
TRUSTACCOUNT_CHECK_ENDORSEMENT or TRUSTACCOUNT_RECEIPT_SUMMARY. For a
description of using the Content Customize tool, see Working with Communication Manager .

To enable the threshold notification email

1. Access the Notification Template portlet (Navigating to the Setup Portlet).

2. Configure the notification template with the following template
name: AA_EMAIL_THRESHOLD_NOTIFICATION_CONTENT or
AA_EMAIL_THRESHOLD_NOTIFICATION_SUBJECT.

To set up trust account reports

1. Define the report using Report Manager. To use this tool, see Report Manager.

2. In Report Manager, do the following:

a. When adding the report, select the Parameter TrustAccountReceiptID or TransactionID from the
Default Value field.

b. Assign the report to the portlet to get the custom report: specify either Link - Trust Account Withdraw
portlet, or the Link - Trust Account Deposit portlet.

Users can access the trust account reports through the Transactions list portlet in the Trust Account
portlet. The Deposit For and Payment Method fields also display in Transactions list portlet. To set
them up, see Accela Civic Platform Configuration Reference.

Associating Addresses with a Trust Account
You can associate a trust account with addresses for one or more records. This is a useful feature if the
user or administrator wants to track billing for fees on the record, or set up automatic payments for record
fees.

Note:

This feature can only associate addresses you have already listed in Civic Platform.

To associate addresses with a trust account

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Trust Account.

3. Create a new trust account or open an existing trust account. For instructions, see Creating a Trust
Account or Searching for a Trust Account.

4. Select the Associated Address tab.

Civic Platform displays the Associated Address portlet.

5. Click Associate Address.

Civic Platform displays the Associated Address form portlet.

6. Complete any fields to search for the address you want to associate with the trust account.

7. Click Submit.

Civic Platform displays the results of your search.
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8. Select each address that you want to associate with the trust account.

9. Click Select.

Civic Platform adds the address(es) to the trust account

Searching for a Trust Account
You can quickly search for a trust account by various pieces of account information. For example, you can
search for a trust account by name, search for all active trust accounts, or search for all trust accounts that
have a zero balance.

To search for a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Trust Account search page.

3. Complete any fields that display. For a list of field descriptions, see Table 160: Trust Account Form
Fields.

4. Click Submit.

Table 160: Trust Account Form Fields

Account ID The account ID number for the trust account.

Balance The balance of the trust account in dollars

City The city in which the address resides.

County The county in which the address resides.

Description The description of the trust account.

Dir Choose a type of street, such as “Lane” or “Boulevard.”

Direction Use this drop-down list to indicate a street direction. For example, choose N to
indicate a north direction. This usually indicated the directional area of a city or
street, such as North Broadway.

Distance Enter a distance from another landmark used to locate the address.

First Name The first name of the person to whom you are assigning the trust account.

Inspection District Prefix Enter the prefix for the inspection district within which the address resides.

Last Name The last name of the person to whom you are assigning the trust account.

Ledger Account The ledger account of the trust account.

Lot The name, or boundaries, of the lot associated with the application.

Middle Name The middle name of the person to whom you are assigning the trust account.

Neighborhood The neighborhood within which the address resides.

Neighborhood Prefix The prefix for the neighborhood within which the address resides.

Overdraft NoThe trust account is not eligible for the overdraft option.YesThe trust account is
eligible for the overdraft option.

Overdraft Limit The overdraft limit amount, in dollars, for the trust account.

Parcel # Part or all of the parcel number you are searching for.

People Type ContactsAnyone other than licensed professionals associated with the trust
account.Licensed ProfessionalAn individual who holds a license associated with
the trust account.
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Prefix Any part of the address that should come before the street name or number, such as
a direction. For example “north” in North Willow Drive

Range The range number of the address.

Reference Address ID The identification for any reference address.

Secondary Road The road for the secondary address.

Secondary Road Number The number of the address’s secondary road.

Section The section of the subdivision in which the address resides.

State The state in which the address resides.

Status ActiveThe trust account is open and active.ClosedThe trust account is not active.

Street Name The street name for the address.

Street # (end) The street number that makes up the address. If you are searching for an address,
you can specify a range of street numbers in the corresponding Start and End fields.

Threshold When the trust account balance is below the threshold amount, Civic Platform can
send a notification email to the address associated with trust account.

To configure notifications, use the Content Customize tool. For further explanation
see Working with Communication Manager . The two options to specify for this
notification are: AA_EMAIL_THRESHOLD_NOTIFICATION_CONTENT and
AA_EMAIL_THRESHOLD_NOTIFICATION_SUBJECT

Type The type of item associated with the property that you are searching for, such as
Licensed Professional, Contact, Address or Parcel.

Unit # (Number) The unit number, for example, the apartment number. If you are searching for an
address, you can specify a range of unit numbers in the corresponding Start and End
fields.

Unit Type The type of structure for this address, for example, apartment or condo.

X Coordinate The latitudinal coordinate for the address. Coordinates are useful when you use a
GPS device to locate the property.

Y Coordinate The longitudinal coordinate for the address. Coordinates are useful when you use a
GPS device to locate the property.

Creating a Trust Account
You can create trust accounts for licensed professionals and other contacts in your Civic Platform
system. Trust accounts are useful for individuals who need to pay fees for applications regularly, such as
contractors. This not only saves the individual a trip to your agency to pay their fees, but also helps your
agency staff by minimizing lines.

To create a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the Account Detail tab on the Trust Account form portlet.

3. Complete any fields that display. For a list of field descriptions, see Table 160: Trust Account Form
Fields.

4. Click Submit.

Civic Platform creates the trust account and then displays the account information.

5. To add associated items to the trust account:
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• To associate addresses, follow the instructions as explained in Associating Addresses with a Trust
Account.

• To associate parcels, follow the instructions as explained in Searching for a Trust Account.

• To associate individuals to the trust account, follow the instructions as explained in Associating
People with a Trust Account.

6. To remove items from the trust account:

• To remove an associated address, follow the instructions as explained in Removing Associated
Addresses from a Trust Account.

• To remove an associated parcel, follow the instructions as explained in Removing Associated
Addresses from a Trust Account.

• To remove an associated individual from a trust account, follow the instructions as explained in
Removing Associated Addresses from a Trust Account.

Editing a Trust Account
You can edit trust account information at any time. Civic Platform allows you to change account detail
fields, and add or remove individuals associated with the trust account.

To edit a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select the trust account that you want to edit.

Civic Platform displays the Account Detail tab on the Trust Account form portlet.

3. Edit any fields that display. For a list of field descriptions, see Table 160: Trust Account Form Fields.

4. Click Submit.

Civic Platform edits the trust account information.

5. To add associated items to the trust account:

• To associate addresses follow the instructions in Associating Addresses with a Trust Account.

• To associate parcels follow the instructions in Searching for a Trust Account.

• To associate individuals to the trust account follow the instructions in Associating People with a Trust
Account.

6. To remove items from the trust account:

• To remove an associated address follow the instructions in Removing Associated Addresses from a
Trust Account.

• To remove an associated parcel follow the instructions in Removing Associated Addresses from a
Trust Account.

• To remove an associated individual from a trust account follow the instructions in Removing
Associated Addresses from a Trust Account.
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Removing Associated Addresses from a Trust Account
You can remove associated addresses from a trust account.

To remove associated addresses from a trust account

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Trust Account.

3. Create a new trust account or open an existing trust account. For instructions, see Creating a Trust
Account or Searching for a Trust Account.

4. Select the Associated Address tab.

5. Select the address or addresses you want to remove.

6. Click Delete.

Civic Platform removes the selected addresses from the trust account.

Associating Parcels with a Trust Account
You can associate a trust account with parcels for one or many records. This is a useful feature if the user
or administrator wants to track billing for fees on the record, or set up automatic payments for record fees.
If there is a lock on a parcel, you cannot associate it with a trust account until you resolve the lock.

Note:

Civic Platform can only associate parcels that are currently in Civic Platform.

To associate parcels with a trust account

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Trust Account.

3. Create a new trust account or open an existing trust account. For instructions, see Creating a Trust
Account or Searching for a Trust Account.

4. Select the Associated Parcels tab.

Civic Platform displays the Associated Parcels portlet.

5. Click Associate Parcel.

Civic Platform displays the Associated Parcel form portlet.

6. Complete any fields to search for the parcel you want to associate with the trust account.

7. Click Submit.

Civic Platform displays the results of your search.

8. Select each parcel that you want to associate with the trust account.

9. Click Select.

Civic Platform adds the parcel(s) to the trust account.

Removing Associated Parcels from a Trust Account
You can remove associated parcels from a trust account.

To remove associated parcels from a trust account
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1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Trust Account.

3. Create a new trust account or open an existing trust account. For instructions, see Creating a Trust
Account or Searching for a Trust Account.

4. Select the Associated Parcel tab.

5. Select the parcel or parcels you want to remove.

6. Click Delete.

Civic Platform removes the selected parcels from the trust account.

Associating People with a Trust Account
It is best practice to associate a trust account with a contact or licensed professional who has the authority
to deposit and withdraw funds from the trust account. Trust accounts are most useful for individuals who
need to pay fees for applications regularly, such as a contractor.

To associate people with a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Create a new trust account or open an existing trust account. For instructions, see Creating a Trust
Account or Searching for a Trust Account.

3. Select the Associated People tab.

4. Complete one of these options:

• To add a licensed professional to the trust account, click Associate Licensed Professional.

• To add a contact to the trust account, click Associate Contact.

Civic Platform displays the Associated People form portlet.

5. Complete any fields to search for the individual you want to associate with the trust account.

6. Click Submit.

Civic Platform displays the results of your search.

7. Select each individual that you want to associate with the trust account.

8. Click Add to Trust Account.

Civic Platform adds the individual to the trust account.

Removing Associated People from a Trust Account
You can remove associated individuals from a trust account. For example, if the foreman of a construction
company resigns, you can remove that individual’s association from the trust account.

To remove associated people from a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Create a new trust account or open an existing trust account. For instructions, see Creating a Trust
Account or Searching for a Trust Account.

3. Select the Associated People tab.
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4. Select the individual(s) you want to remove.

5. Click Delete.

Civic Platform removes the selected individuals from the trust account.

Viewing Associated Records for a Trust Account
For more information about the Associated Records tab refer to Figure 75: Viewing Records Associated
with a Trust Account.

Figure 75: Viewing Records Associated with a Trust Account

Configuring Public User Permission for a Trust Account
You can grant permissions that enable a public user (citizen or authorized agent) to perform trust account
transactions and print trust account reports in Citizen Access.

To enable public user permissions for a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Create a new trust account or open an existing trust account. For instructions, see Creating a Trust
Account or Searching for a Trust Account.

3. Select the Public User Permission tab.

4. Click Look Up.

Civic Platform displays the public user search portlet.

5. Enter search criteria as needed and click Submit.

Civic Platform returns a list of public users that meet the search criteria.

6. Select the public user you are granting trust account permissions.

Note that you can only enable permissions for citizens and authorized agents to use a trust account.
You cannot enable authorized agent clerks to use trust accounts. You can associate one and only one
trust account with an authorized agent.

7. Click Approve.

The approved public user can pay with the trust account in the Citizen Access website.
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Closing a Trust Account
When a trust account is no longer needed, you can close it. You cannot delete a trust account, you can
only close it. There are several reasons why you might want to close a trust account. For example, if the
trust account owner wants to close it, the trust account is dormant, or if you opened the a trust account
erroneously. You can close a trust account at any time and if needed, you can reopen a closed trust
account.

To close a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select the trust account that you want to close.

3. Click Close from the toolbar drop-down menu.

Civic Platform closes the trust account.

Automating Trust Accounts
See Accela Civic Platform Configuration Reference.

Managing Trust Account Transactions
After you set up a trust account, you can use the account to perform transactions. Transactions include
depositing, withdrawing, and transferring money. You can also make adjustments to a trust account as
needed.

Topics

• Depositing Money into a Trust Account

• Transferring Money between Trust Accounts

• Withdrawing Money from a Trust Account

• Making an Adjustment to a Trust Account

Depositing Money into a Trust Account
One of the first transactions performed on a trust account is depositing money. You can deposit money into
an active trust account at any time.

To deposit money into a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select the trust account that you want to edit.

Civic Platform displays the Account Detail tab on the Trust Account form portlet.

3. Select Deposit from the drop-down menu.

4. Enter the dollar amount you want to deposit in the Amount field.

5. Click Submit.

Civic Platform deposits the money into the selected trust account and then displays the Account Detail
tab.
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Transferring Money between Trust Accounts
If an individual has multiple trust accounts they can transfer money between their accounts. The individual
must have a legitimate stake in each account involved in the fund transfer. You can only transfer funds
between accounts associated with the same individual.

To transfer money between trust accounts

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select the trust account that you want to transfer money from.

Civic Platform displays the Account Detail tab on the Trust Account form portlet.

3. Select Transfer from the drop-down menu.

4. Enter the dollar amount you want to transfer in the Amount field.

5. Select the trust account you want to transfer the money to from the Target Account ID drop-down list.

6. Click Submit.

Civic Platform transfers the money into the selected trust account and then displays the Account Detail
tab.

Withdrawing Money from a Trust Account
To withdraw money from a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select the trust account that you want to withdraw funds from.

Civic Platform displays the Account Detail tab on the Trust Account form portlet.

3. Select Withdraw from the drop-down menu.

Civic Platform displays the Withdraw fields for the selected trust account.

4. Enter the dollar amount you want to withdraw in the Amount field, add Comments.

5. If you added the Payment Method field to the Withdraw form for this trust account, specify the Payment
Method.

6. Click Submit.

Civic Platform withdraws the money from the selected trust account and then displays the Account
Detail tab.

Making an Adjustment to a Trust Account
Civic Platform allows you to make adjustments to a trust account, for example, if you make an accounting
error, you can make the necessary correction. Adjustments allow you to add or remove money from a trust
account.

To make an adjustment to a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select the trust account that you want to withdraw funds from.

Civic Platform displays the Account Detail tab on the Trust Account form portlet.

3. Select Adjust from the drop-down menu.
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4. Complete these fields and options:

Amount Enter the dollar amount you want to adjust for the selected trust account.

Transaction Type - Credit
Adjust

Select this option to add money into the trust account for entered amount.

Transaction Type - Debit Adjust Select this option to remove money from the trust account for the entered
amount.

5. Click Submit.

Civic Platform adjusts the money for the selected trust account and then displays the Account Detail
tab.

Viewing and Printing Trust Account Reports
Civic Platform provides multiple types of reports to help your agency keep track of trust accounts. You can
view and print trust account reports as needed.

Topics

• Viewing the Transaction History of a Trust Account

• Printing the Negative Balance Trust Account Report

• Printing a Trust Account Transaction Report

Viewing the Transaction History of a Trust Account
You can view the entire transaction history of a trust account, which can be helpful if a customer disputes
transactions, if you discover an accounting error, or if you need to produce records for an audit. You can
view the transaction history of any trust account at any time.

To view the transaction history of a trust account

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select the trust account for which you want to view the history.

Civic Platform displays the Account Detail tab on the Trust Account form portlet.

3. Select the Transactions tab.

Civic Platform displays the history for the selected trust account.

Printing the Negative Balance Trust Account Report
If your agency allows individuals to overdraw their trust accounts, the Negative Balance report helps you
keep track of individuals that owe your agency money. The report shows you all of the trust accounts that
currently have a negative balance.

To view the negative balance trust account report

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select Negative Balance Trust Account Report from the primary portlet drop-down menu.

Civic Platform displays the Negative Balance Trust Account Report.

3. Print the report using your browser.
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Printing a Trust Account Transaction Report
The Transaction report enables you to print individual transaction records. Transaction reports are helpful
if an individual either needs a receipt of the transaction, or has questions regarding past transactions. You
can select the transactions from the trust account history list that you want to print, and then print either
individual transactions or multiple transactions.

To print a trust account report

1. Access the Trust Account portlet (Navigating to the Setup Portlet).

2. Select the trust account that you want to print a report for.

Civic Platform displays the Account Detail tab on the Trust Account form portlet.

3. Select the Transactions tab.

4. Select the transactions you want to print a report for.

5. Click Print Report.

Civic Platform displays a report of the selected transactions.

6. Click Print from your browser toolbar or select Print from the browser menu.

Civic Platform prints the selected transactions report.

Point of Sale
This section describes how On-Premise customers can configure Civic Platform to accept point of sale
payments.

The audience for this section is an agency who hosts its own Civic Platform server and data. If Accela
hosts the Civic Platform server at its data center, consult with the Accela Success Community: https://
accela.force.com/success for information on successfully implementing your point of sale system, including
receipt set up.

When configuring the point of sale, a fee schedule must exist and it needs to include the CONSTANT
formula, CONSTANT value, and FINAL period. To plan and configure a fee schedule, see the
Understanding Fee Items. For complete details refer to Setting Up a Point of Sale Fee Item and Fee
Schedule.

Part of setting up a fee item, including fee items for a record or fees for point of sale items, is generating
a receipt and printing a receipt. By default, Civic Platform generates a system default receipt number for
receipts.

For a broader explanation of all pre-defined sequences available in Civic Platform see the receipts listed in
Defining Sequences, Masks, and Autonumbering.

For a list of supported web browsers, refer to the Civic Platform Release Notes.

Click a topic title below for full details.

Related Links

Point of Sale Prerequisites

Configuring the Point of Sale

Point of Sale Prerequisites
Prior to performing the setup steps in this section, you must configure the following FIDs and Standard
Choices.
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• FID 8288 Fees Point of Sale and FID 8289 Fees Point of Sale Refund

• Standard Choices POINT_OF_SALE_TYPE and POINT_OF_SALE_FEE_SCHEDULE

Follow the instructions in the Accela Civic Platform Configuration Reference.

Configuring the Point of Sale
Complete the steps in order as presented to ensure that the point of sale feature works properly. Refer to
the following sections for complete details.

In summary, to configure the point of sale:

1. Set the point of sale Function Identifications (FID) 8288 Fees Point of Sale, and 8289 Fees Point of
Sale Refund to Full Access, and set the user group access level.

2. Set up a point of sale fee schedule for each Accela module your agency uses. For information on
managing fee schedules, see Understanding Fee Items.

3. Create two Standard Choices: First create POINT_OF_SALE_TYPE and then create
POINT_OF_SALE_FEE_SCHEDULE. Set the values for each of these Standard Choices according to
the instructions in the Civic Platform Configuration Reference.

It is important to specify correct values for these Standard Choices to ensure proper implementation of
this feature. The Civic Platform Configuration Reference provides complete documentation for setting
up these Standard Choices.

4. Configure the receipt sequence and its mask definition. For a general discussion of the Sequence
Generator function, see Defining Sequences, Masks, and Autonumbering.

After you complete these steps, point of sale fees work like all other fees in Civic Platform. Civic Platform
adds, assesses, and processes fee items through a cashier payment without an associated application.

Because Civic Platform automatically invoices point of sale fee items, users can only add and void fee
items. When users apply payment in point of sale, Civic Platform processes it automatically without a
payment apply screen.

Setting Up a Point of Sale Fee Item and Fee Schedule
When setting up the point of sale fee item the fee schedule must match the Standard Choice value exactly.
Both the fee item code and the fee schedule have a maximum character length of 12.

To set up a point of sale fee item

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Fees > Fee Items.

3. Click Add.

Civic Platform displays the Fee Item - Add page.
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4. Complete the Fee Item fields that apply to Point of Sale in Table 161: Fee Item Fields Applicable to
Point of Sale. For more information see Understanding Fee Items.

5. Click Save.

6. To create more Fee Items for this Point of Sale fee schedule click Copy and edit the Fee Item Code
and Fee Description.

Table 161: Fee Item Fields Applicable to Point of Sale

Fee Item Code Enter a unique code to identify the source or purpose of the Point of Sale fee item.
For example, shirt, hat, map, or mug.
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Fee Schedule Enter the fee schedule that this fee item belongs to. Make certain that the fee
schedule is exactly the same as the Standard Choice Value Description. For
example, if you are adding a fee schedule for the Building module the fee schedule
is POS_BLD_SCH.

Version Choose the fee schedule version. A fee schedule can have different versions based
on the start fee and end fee date.

Fee Description Enter a brief description of the fee item to identify its source or purpose. For
example, if the fee item you created was a map the fee description might be a map
of city streets.

Comment Enter a detailed description of the fee item to explain the fees purpose, logic, and
any additional information associated to the fee.

Unit Choose a fee unit from the drop-down list. For example, if you assess the fee on
area, select the unit representative of square footage.

Calc Formula Choose CONSTANT from the drop-down list for all Point of Sale items. For all point
of sale fee items, choose CONSTANT from the drop-down list. The CONSTANT fee
formula enables you to establish a set fee independent of ranges or valuations.

For example, if you want to establish a flat rate for a city map, you can use the
CONSTANT fee formula to establish a $10 fee.

Any fee calculated using this formula is the product of the constant and the quantity
that a user enters while assessing fees. In this example, if you specify that a
constant for an electrical application is $10 and a user enters 2 as the quantity, then
the total fee for two electrical applications is $20.00.

For more information the CONSTANT formula, see Fee Formulas.

Calc Variable For point of sale, the Calc Variable only supports numbers. For example, you might
enter: 10.

Default Value If you want the fee item to have a default quantity value, choose Y and enter the
default quantity in the field. If you do not want a default quantity, choose N.

Round Fee Item If you want the calculated fee item to round to the nearest dollar amount, choose Y,
and then choose either Round Up, Round Down, or Round to Nearest dollar. If you
want the fee to display the exact value, choose N.

For example, your agency charges an Inspection Penalty Fee if a property is not
ready for an inspection when the inspector arrives.

You can use a percentage formula to penalize 10% of the original inspection
fee. This 10% value as calculated by the formula could be $4.56. To ensure the
Inspection Penalty Fee is always a round number, select this option to round up the
fee.

Status If you want to make the fee item available to users in Civic Platform, select Enable;
otherwise, select Disable.

Payment Period You must choose Final for the payment period, because point of sale items are not
dependent on an application review process.

Subgroup Enter the code for the subgroup to which this fee item belongs. A fee item can
belong to multiple subgroups. If you want this fee to belong to more than one
subgroup, separate each group with a delimiter, such as a comma.

Account Code If your agency wants to apportion this fee item to one of your agency accounts, you
can enter up to three codes for the account here. These codes do not affect Civic
Platform, but you can use them for your agency’s budget purposes.



 | Part 7: Accounting | 782

Payment Processing
Administrators can configure Civic Platform to enable processing tools that allow for easy intake of
payments across multiple records and Point of Sale (POS) items. Citizens can pay for fee items using
multiple tenders at the agency’s place of business. Agency cashiers handle payments for each record
by manually entering the payment information, or using a magnetic card reader to read credit card
information.

Click a topic title below for full details.

Related Links

Configuring the Payment Processing Console

Enabling Automatic Payment Allocation

Configuring Online Payment Processing

Setting Up Payment Functionality Online

Configuring the Payment Processing Console
Civic Platform stores payment amounts in Civic Platform as a transaction payment history. For example,
an inspector can pay his renewal license fees or he can buy a map from a clerk at the County building. The
Payment Processing Console and functions that display below Figure 76: Payment Processing Console
have complete details in the “Managing Payments” section of the Civic Platform User Guide.

Figure 76: Payment Processing Console

Specify acceptable payment methods for each Civic Platform module that your agency uses. For example,
configure the cash option, the credit card option, and the trust account option to display for Civic Platform
users to choose from.

You can enable a Received drop-down list field on all payment locations in Civic Platform, such as the
Payment Processing console or the Payment tab of a record. This field displays the form of payment, such
as In Person, Mail, and Fax. On the Refund page the drop-down field displays Refund and indicates the
form of the refund, such In Person or Credited to Card.

You can also use a single invoice for multiple records.
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Enabling Automatic Payment Allocation
The automatic payment allocation function bypasses the allocation screen when you process a full
payment or an overpayment from the Payment tab for a specified group.

For example, when a cashier selects one or more fee items and processes a full payment or an
overpayment on a record, Civic Platform automatically allocates the payment amounts to any specified fee
item without any interaction by the user. Civic Platform bypasses the payment processing allocation screen
and processes the payment transaction immediately.

Configuring Online Payment Processing
Your agency can accept online payments in the form of credit cards and in the form of checks in Civic
Platform and Citizen Access by connecting with an outside payment provider such as PayPal Payflow Pro.
To connect with a payment provider, you must configure an Accela-provided Electronic Payments Adapter
or an agency-provided EPayments Adapter.

For example, Accela provides an adapter to connect Civic Platform to the PayPal Payflow EPayments
Gateway.

The Civic Platform adapter supports the following providers:

• Custom Redirect

• Govolution

• Official Payments CoBrand+

• Official Payments STP

• PayPal Payflow Pro 4.3

• Virtual Merchant

Accela recommends that agencies use the Accela-provided PayPal Payflow Pro4.3 EPayments Adapter
using a merchant account for a bank that PayPal supports.

For instructions on configuring an EPayments Adapter, see the zip file ePayments Configuration Guide and
Scripts. This file contains the Accela Electronic Payments Configuration Guide and a set of related scripts.

After you complete the Epayment configuration for online payments, extend online payment functionality
on the user interface with payment configurations for Citizen Access, see Setting Up Payment Functionality
Online.

Setting Up Payment Functionality Online
Citizen Access leverages payment configuration within Civic Platform and enables you to provide payment
services online. You configure most online payments in Civic Platform and set up additional options for
Citizen Access.

After your agency has configured online payments for Civic Platform, you must customize the associated
online payment web pages in Citizen Access. Refer to “Customizing Web Pages Associated with Fees” in
the Citizen Access Administrator Guide for a list of pages that require customization.
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Time Accounting Tracker
You can define any number of Time Accounting types with details about the type of activity that you are
recording. You can then assign a default hourly rate adjustment -- or a percentage adjustment -- to use to
assess the cost of the activity. Time Accounting provides methods for assigning various security settings,
Time Accounting types, and hourly rates to specific users.

If you want to assign rights to time accounting supervisors to allow them to lock other user’s time
accounting, the details on how to use and set up are in Locking Time Accounting for Another User.

To allow users to add multiple time accounting entries on inspection details and to the workflow tasks, see
the functionality described in Configuring Access to Inspections and Workflow.

Begin by configuring the Time Accounting Groups, then the types. Time Accounting Types must belong to
a Time Accounting Group, and User profiles must belong to a Time Accounting Group and Type.

Click a topic title below for full details.

Related Links

Managing Time Accounting Groups

Managing Time Accounting Types

Managing Time Accounting User Profiles

Configuring Access to Inspections and Workflow

Locking Time Accounting for Another User

Managing Time Accounting Groups
Use Time Accounting Groups to categorize Time Accounting Types. From the Time Accounting Group
portlet, the agency user can create a group and assign Time Accounting Types, User or User Group
permissions. These groups become the tasks for which the user is tracking his time. For example, the
agency user creates a Time Accounting Group called Electrical Permit, and associated tasks include
electrical inspections.

To control access to time accounting entries in Civic Platform and Mobile Office, see the required settings
in Configuring Access to Inspections and Workflow.

Topics

• Creating a Time Accounting Group

• Searching for a Time Accounting Group

• Editing a Time Accounting Group

• Inactivating a Time Accounting Group

• Managing Time Accounting Group Permissions

Creating a Time Accounting Group
Users can create a new Time Accounting Group to fit the needs of the agency.

To create a new Time Accounting group

1. Access the Time Accounting Group portlet (Navigating to the Setup Portlet).

2. Click New.
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Civic Platform displays the New Time Accounting Group form in the secondary portlet.

3. Enter the Group Name and information in any of the other desired fields.

For a list of Time Accounting Group Detail fields, see Table 162: Time Accounting Group Detail Fields.

4. Click Submit.

Civic Platform adds the Group to the Time Accounting Group list and displays the new Group detail in
the detail portlet.

5. Add User or User Group permissions and Time Accounting Types to the new Time Accounting Group.

For instruction on how to add a User or User Group, see Managing Time Accounting Group
Permissions.

For instruction on how to add Time Accounting Types, see Managing Time Accounting Types within a
Group.

Searching for a Time Accounting Group
Search within the Time Accounting Group list for an existing group. For example, if you are not sure
whether a group you want to add already exists, you can search for it.

To search for an existing Time Accounting group

1. Access the Time Accounting Group portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Time Accounting Group search page.

3. Enter search criteria for the group you want.

For a list of Time Accounting Group Detail fields, see Table 162: Time Accounting Group Detail Fields.

4. Click Submit.

Civic Platform displays the groups that match the search information.

5. If more than one group fits the criteria, click the name of the group you want, or try searching again with
more information.

Editing a Time Accounting Group
Users can edit the details in an existing Time Accounting Group.

To edit a Time Accounting group

1. Access the Time Accounting Group portlet (Navigating to the Setup Portlet).

2. Search for the group you want to edit and click the group name to open the detail portlet.
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For instructions on how to search for an existing Time Accounting Group, see Searching for a Time
Accounting Group.

3. Enter the updated information in the desired fields.

For a list of Time Accounting Group Detail fields, see Table 162: Time Accounting Group Detail Fields.

4. Click Save.

Table 162: Time Accounting Group Detail Fields

Group Name Enter a distinctive name for the group. This name displays in the Time Accounting
Group drop-down list in the User Time Accounting portlets. For example, Application.

Record Status Select whether the Group record is active or inactive.

Description Enter a description for the Time Accounting group. For example, if the group name is
Application, the description might be “Any work completed on an application.”

Record By Civic Platform populates the name of the user who creates or updates the group.

Record Date Civic Platform populates the date you created or updated the group.

Inactivating a Time Accounting Group
You cannot delete Time Accounting Groups. Users can inactivate groups at any time, even they have
attached Time Accounting Types.

To inactivate a Time Accounting group

1. Access the Time Accounting Group portlet (Navigating to the Setup Portlet).

2. Search for the group you want to edit and click the group name to open the detail portlet.

For instructions on how to search for an existing Time Accounting Group, see Searching for a Time
Accounting Group.

3. Complete one of these tasks:

• Select the Time Accounting Group(s) you want to inactivate, and then click Delete.

• In the detail portlet for the desired group, select Inactive from the Record Status drop-down field, and
then click Save.

Civic Platform inactivates the Time Accounting Group(s).

Managing Time Accounting Group Permissions
You can specify the access that Civic Platform users have for Time Accounting Types within a group. For
example, agencies can allow certain users to view Time Accounting type information, but not to edit the
information. Permissions set for individual users override permissions set for the group. For example, if the
user has “Full” access, but the user group the user belongs to is “None,” the user still has full access to
view and update the Time Accounting group or type in the Time Accounting portlet.

Each of these users or user groups can have a different level of access:

Full Civic Platform users in this group can access and edit all Time Accounting types in this
group. Full Access is the default access mode. Unless you change the access level for
a Time Accounting group, all users have Full permission to view and to edit applications
related to that group.

Read Civic Platform users in this group can view and create new records, but cannot edit or
delete the record after they save it.

None Civic Platform users cannot access the Time Accounting types in this group.



 | Part 7: Accounting | 787

You can manage user profiles and user groups in Civic Platform. For information on adding or editing a
user profile, see Configuring Organizations, Departments, and Users.

There are three user levels available in Time Accounting: administrator, supervisor, and user. Users with
administrator privileges can view and edit any records for which any other user has access. Supervisors
can view and edit any records within their user group. Users can only view or edit their own records. The
Access Mode column enables you to inform the current user what type of access you have enabled for
each time entry type. Valid values are:

N User cannot delete or make changes to the entry.

D User can delete this entry.

E Users can make changes to any of the fields, unless they are read-only.

DE The user can delete this entry or make changes to any of the fields that are not read-
only.

Topics

• Assigning Time Accounting Group Permissions

• Removing Time Accounting Group Permissions

Assigning Time Accounting Group Permissions
Agency users can select one or more users or user groups to assign to a Time Entry Group.

To assign Time Accounting group permissions

1. Access the Time Accounting Group portlet (Navigating to the Setup Portlet).

2. Create a new Time Accounting group, or select an existing group.

For instructions on how to create a new Time Accounting group, see Creating a Time Accounting
Group.

For instructions on how to search for an existing Time Accounting group, see Searching for a Time
Accounting Group.

3. Click the Permissions tab.

Civic Platform displays the Time Accounting Permissions tab.

4. Click Assign.

Civic Platform displays a navigation tree of all User Groups set up within the agency.
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5. Search for the desired User ID or User Group in one of two ways:

• Click Search and enter the User ID or User Group name.

If Civic Platform finds a match, the navigation tree expands to show the results highlighted in red.

• Scroll through the navigation tree of User Groups and drill down to locate individual users.

6. Select the User Group or User ID you want to add to the Time Accounting group.

7. Click Submit.
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Civic Platform displays an updated list of users on the Permissions tab.

8. Select the user access level in the Access field and then click Submit.

Removing Time Accounting Group Permissions
Agency users can remove permissions for groups that no longer apply to the Time Accounting group.

To remove Time Accounting group permissions

1. Access the Time Accounting Group portlet (Navigating to the Setup Portlet).

2. Create a new Time Accounting group, or select an existing group.

For instructions on how to create a new Time Accounting group, see Creating a Time Accounting
Group.

For instructions on how to search for an existing Time Accounting group, see Searching for a Time
Accounting Group.

3. Click the Permissions tab.

Civic Platform displays the Time Accounting Permissions tab.

4. Select the user group or the individual user you want to remove from the Time Accounting group.

5. Click Delete.

Managing Time Accounting Types
A Time Accounting type is the application that the user is recording time for, such as an electrical
inspection. When users enter time, the options available depend on group permissions, profile settings,
and the record type or application type for which the user is entering time. You can define Time Accounting
types for use in any application type. Agency users can associate one Time Accounting type with multiple
groups.

You also assign the level of access that any Civic Platform user or user group has to any particular Time
Accounting type.

Topics

• Searching for a Time Accounting Type

• Editing a Time Accounting Group

• Cloning a Time Accounting Type

• Deleting a Time Accounting Type
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• Managing Time Accounting Type Permissions

• Managing Time Accounting Types within a Group

Creating a Time Accounting Type
Users can create a new Time Accounting type.

Note:

Civic Platform does not allow duplicate entries. This implies that another record exists that has the same
Time Entry Type Name, Group, Type, Sub Type, and Category. If you enter a duplicate, the following
message displays, “The Time Accounting Type or Record Type entered already exists.”

To create a new Time Accounting Type

1. Access the Time Accounting Types Maintenance portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the New Time Accounting Type page in the detail portlet.

3. Enter the new Time Accounting type information in the necessary fields.

For a list of Time Accounting Type fields, see Table 163: Time Accounting Type Detail Fields.

4. Click Save.

5. Assign user or user group permissions.

For more information about Time Accounting Type permissions, see Managing Time Accounting Type
Permissions.

Table 163: Time Accounting Type Detail Fields

Active Select whether this type is Active or Inactive.

Billable Select whether the agency can bill for this type. The default status is “Yes.”

Record Type Use the picker to select the Record Type, Sub Type, and Category. Users can select
any level of the navigation tree. For example, if you select the Building group, the
type displays as Building\ALL\ALL\ALL. If you select N/A in the Usage field, this field
automatically locks at “ALL” and you cannot make any other selections.

Detailed Description Enter a description for this type.

Hourly Rate Enter the rate per hour for this type. The Hour Rate can be zero, or any positive
or negative value. This field must remain at zero if the user enters a value in the
Percentage Adjustment field.
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Name Enter a name for this Time Accounting type. Name is a required field.

Percentage Adjustment Enter the percentage adjustment for this type. For example, 1.25 equals 125%. The
Percentage rate can be zero or any negative or positive value. This field must remain
at zero if the user enters a value in the Hourly Rate field.

Record By This field displays the user who last updated the record. This field auto-populates.

Record Date This field displays last record update date. This field auto-populates.

Time Accounting Group This field displays all active Time Accounting groups.

Usage Select either Record or N/A record type in the drop-down list. The default is Record,
and indicates the Time Accounting type is mandatory to process the application. N/A
indicates that the type has no relationship to a specific application. If you select N/A,
the Record Type fields Group, Type, Sub Type, and Category locks at “ALL,” and you
cannot make any other selections.

Searching for a Time Accounting Type
Users must search for an existing Time Accounting type before the user can edit or clone a type.

To search for a Time Accounting type

1. Access the Time Accounting Types Maintenance portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Time Accounting Type - Search page.

3. Enter search criteria for the type you want.

For a list of Time Accounting type fields, see Table 163: Time Accounting Type Detail Fields.

4. Click Submit.

Civic Platform displays the types that match the search criteria.

5. If more than one type fits the criteria, click the name of the type you want, or try searching again with
more information.

Editing a Time Accounting Type
Users can edit some of the values for a Time Accounting type.

To edit a Time Accounting type

1. Access the Time Accounting Types Maintenance portlet (Navigating to the Setup Portlet).

2. Locate the Time Accounting type you want to edit.

For instructions on how to search for an existing Time Accounting type, see Searching for a Time
Accounting Type.

3. Update the desired fields.
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For a list of Time Accounting type fields, see Table 163: Time Accounting Type Detail Fields.

4. Click Save.

5. Update user or user group permissions.

For more information about Time Accounting Type permissions, see Managing Time Accounting Type
Permissions.

Cloning a Time Accounting Type
The Clone option is similar to the New option, except that the fields in the detail portlet populate with the
values of the Time Accounting type you are cloning. The Clone operation saves the user time and reduces
the amount of data users must enter when creating Time Accounting types that have the same name but
apply to different application types. Permissions, N/A Types and Record Types transfer from the existing to
the cloned type when you configure the Permission option under the Includes section of the Cloned Time
Accounting Type detail page. Users can only clone one type at a time.

To clone a Time Accounting type

1. Access the Time Accounting Types Maintenance portlet (Navigating to the Setup Portlet).

2. Select the Time Accounting type you want to clone.

For instructions on how to search for an existing Time Accounting type, see Searching for a Time
Accounting Type.

3. Click Clone.

Civic Platform displays the Clone Time Accounting Type in the detail portlet.

4. Update the desired fields.

For a list of Time Accounting type fields, see Table 163: Time Accounting Type Detail Fields.

To clone user Permissions, select Permission in the Includes section.

5. Click Submit.

6. Assign user or user group permissions.

For more information about Time Accounting Type permissions, see Managing Time Accounting Type
Permissions.

Deleting a Time Accounting Type
Agency users can delete one or more Time Accounting types at one time.
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Note:

You cannot delete Time Accounting types associated with Time Accounting records or Time Accounting
profiles.

To delete a Time Accounting type

1. Access the Time Accounting Types Maintenance portlet (Navigating to the Setup Portlet).

2. Select the Time Accounting type(s) you want to delete.

3. Click Delete.

Managing Time Accounting Type Permissions
You can assign user groups and individual users to Time Accounting types and assigned a level of access
to the type. Use the permissions on the Time Accounting group level as the default permissions for each
Time Accounting type. Agency users can assign additional permissions from the Time Accounting type
portlet. For more information about Time Accounting group permissions, see Managing Time Accounting
Group Permissions.

User permissions include:

Full Civic Platform user can access and edit the Time Accounting type. Full is the default
access mode. Unless you change the access level for a Time Accounting type, all users
have Full permission to view applications and edit applications related to that type.

Read Civic Platform users in this group can view and create new records with this Time
Accounting type, but cannot edit or delete the record they save it.

None Civic Platform users cannot access the Time Accounting types.

Permissions set for individual users override permissions set for the group. For example, if the user has
“Full” access, but the user group the user belongs to “None,” the user still has full access to view and
update the Time Accounting group or type in the Time Accounting portlet.

Topics

• Assigning Permissions to a Time Accounting Type

• Removing Permissions from a Time Accounting Type

Assigning Permissions to a Time Accounting Type
If you associate the Time Accounting type with a Time Accounting group, the assignments and access
level might already exist. You can update or assign additional user groups or individual users, as
appropriate. For example, a group of home inspectors assigned to the Electrical Inspection type can have
full permission to view and edit Time Accounting information for that type.

For more information about Time Accounting group permissions, see Managing Time Accounting Group
Permissions.

To assign Time Accounting group permissions

1. Access the Time Accounting Types Maintenance portlet (Navigating to the Setup Portlet).

2. Create a new Time Accounting type, or select an existing type.

For instructions on how to create a new Time Accounting type, see Creating a Time Accounting Group.

For instructions on how to search for an existing Time Accounting type, see Searching for a Time
Accounting Type.

3. Click the Permissions tab.
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Civic Platform displays the Time Accounting Permissions tab in the detail portlet.

4. Click Assign.

Civic Platform displays a navigation tree of all User Groups set up within the agency.

5. Search for the desired User ID or User Group in one of two ways:

• Click Search and enter the User ID or User Group name.

If Civic Platform finds a match, the navigation tree expands to show the results highlighted in red.
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• Scroll through the navigation tree of User Groups to locate individual users.

6. Select the User Group or User ID you want to add to the Time Accounting group.

7. Click Submit.

Civic Platform displays an updated list of users on the Permissions tab.

8. Select the user access level and then click Submit.

Removing Permissions from a Time Accounting Type
Agency users can remove permissions for types that no longer apply to the Time Accounting type.

To remove Time Accounting group permissions

1. Access the Time Accounting Types Maintenance portlet (Navigating to the Setup Portlet).

2. Locate the Time Accounting types that contains the permission(s) you want to remove.

For instructions on how to search for an existing Time Accounting type, see Searching for a Time
Accounting Type.

3. Click the Permissions tab.

Civic Platform displays the Time Accounting type Permissions tab.

4. Select the user group or individual user you want to remove from the Time Accounting group.
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5. Click Delete.

Managing Time Accounting Types within a Group
Agency users determine which Time Accounting types to associate with a Time Accounting group. For
example, if the Time Accounting group was for Electrical Permits, the agency can associate all of the tasks
required to issue an Electrical Permit with the Electrical Permits group.

For more information about Time Accounting Types, see Managing Time Accounting Types .

Topics

• Assigning Time Accounting Types

• Removing Time Accounting Types

Assigning Time Accounting Types
Users can assign one or more Time Accounting types to a Time Accounting group.

To assign Time Accounting types to a Time Accounting group

1. Access the Time Accounting Group portlet (Navigating to the Setup Portlet).

2. Create a new Time Accounting group, or select an existing group.

For instructions on how to create a new Time Accounting group, see Creating a Time Accounting
Group.

For instructions on how to search for an existing Time Accounting group, see Searching for a Time
Accounting Group.

3. Click the Time Accounting Types tab.

Civic Platform displays the Time Accounting Types tab.

4. Click Look Up.

Civic Platform displays the Time Accounting Type: Search portlet.

5. Enter the search criteria in the available fields.

For a list of Time Accounting Type fields, see Table 163: Time Accounting Type Detail Fields.

6. Click Submit.

Civic Platform displays all Time Accounting types that fit the search criteria.
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7. Select the Time Accounting type(s) that you want to add to the group.

8. Click Select.

Removing Time Accounting Types
Agency users can remove Time Accounting types from a Time Accounting group when they no longer
apply to the group.

To remove Time Accounting types from a Time Accounting group

1. Access the Time Accounting Group portlet (Navigating to the Setup Portlet).

2. Select the Time Accounting group that contains the type you want to remove.

For instructions on how to search for an existing Time Accounting group, see Searching for a Time
Accounting Group.

3. Click the Time Accounting Types tab.

Civic Platform displays the Time Accounting Types tab.

4. Select the type you want to remove.

5. Click Delete.

Managing Time Accounting User Profiles
Access to the Time Accounting Browser and the ability to perform time accounting data entry is controlled
by the Civic Platform user's Time Accounting profile. You can assign these users permission levels within
Time Accounting groups and types. For example, a group of home inspectors assigned to the Electrical
Inspection type can have full permission to view and edit Time Accounting information for that type.

Topics

• Searching for User Profiles

• Updating Time Accounting User Profiles

• Copying Time Accounting User Profiles

• Inactivating Time Accounting User Profiles

Searching for User Profiles
Agency users can search for Civic Platform user profiles to give access to the Time Accounting feature or
update profile information. To create a new user Time Accounting profile, see Creating a Time Accounting
User Profile.

Agency users can only edit user profile information related to Time Accounting in this portlet. If you
want to create a new user profile, or edit profile information other than Time Accounting information, see
Configuring Organizations, Departments, and Users.

To search for user profiles

1. Access the Time Accounting Profiles portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the User Time Accounting Profiles - Search page.
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3. Enter the information you are searching for into one or more of the search fields.

For a list of Time Accounting user profile search fields, see Table 164: Time Accounting User Profile
Fields.

4. Click Submit.

Civic Platform displays all of the user profiles that match the search criteria.

5. If more than one type fits the criteria, click the name of the type you want, or try searching again with
more information.

Updating Time Accounting User Profiles
The agency user can add or maintain a Time Accounting profile. When you select a user that does
not have a Time Accounting profile, the profile details initialize to the default value, and the edit portlet
automatically resets to New Profile mode. The user cannot access the Time Accounting Types tabs until
you save the Time Accounting User Login ID. The agency user can add or update Time Accounting profile
and Time Accounting type information.

Note:

Agency users can only edit user profile information related to Time Accounting in this portlet. If you want
to create a new user profile, or edit profile information that other than Time Accounting, see Configuring
Organizations, Departments, and Users.

Topics

• Creating a Time Accounting User Profile

• Editing a Time Accounting User Profile

• Managing Time Accounting Types Related to User Profiles

Creating a Time Accounting User Profile
Before you can define Time Accounting types, you must first create user profiles.

You can only edit user profile information related to Time Accounting in this portlet. If you want to create
a new user profile, or edit profile information other than Time Accounting, see Configuring Organizations,
Departments, and Users.

To create a new Time Accounting user profile

1. Access the Time Accounting Profiles portlet (Navigating to the Setup Portlet).

2. Search for the Civic Platform user profile.

For instructions on searching for a Civic Platform user profile, see Searching for User Profiles.

Civic Platform displays the Time Accounting Profile in the detail portlet.
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3. Enter the User Login ID and all other relevant fields.

For a list of Time Accounting user profile fields, see Table 164: Time Accounting User Profile Fields.

4. Click Save.

5. Add associated Time Accounting types.

For more information on adding or editing Time Accounting types from the user Time Accounting profile,
see Managing Time Accounting Types Related to User Profiles.

Table 164: Time Accounting User Profile Fields

Active Select Yes or No to indicate whether the user’s Time Accounting profile is active.

Hourly Rate Enter the rate per hour for this user. The Hour Rate can be zero, or any positive or
negative value.

May Delete Other User’s
Time Accounting

Select an option from the drop-down list to determine whether the user has Supervisor
or Administrator access to delete another user's Time Accounting entries. The options
in this list include No, Supervisor, and Administrator.

If you select No the user does not have access to delete another user’s entries.

If you select Supervisor, the user can delete Time Accounting entries entered by a
user in the Supervisor’s user group. Civic Platform does not restrict this option by the
Number of Days That Delete Is Allowed field.

If you select Administrator, the user can delete Time Accounting entered by any other
user. Civic Platform does not restrict this option by the Number of Days That Delete Is
Allowed field.

May Enter Materials and
Cost

Select Hidden, Yes, or No from the drop-down list to indicate whether the user can
enter materials and cost information in Time Accounting entries. If you select Hidden
the user cannot view or enter data into this field. If you select No the field is read-only.

Note:

If you configure the Standard Choice TIME_ACCOUNTING_SETTINGS,
you can select Hidden for this field, so that all users add material and cost
information in the Equipment/Materials section of the time accounting entry
form.

May Enter Start/Stop/
Elapsed Time

Select Yes or Elapsed Time Only from the drop-down list to indicate whether the user
can enter the time in all three fields. If you select Yes, the user can enter the time in the
Start, End, and Elapsed Time fields, and the application validates that the elapsed time
equals the difference between the start and end time. If you select Elapsed Time Only,
the Start Time and End Time fields are read-only.
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May Enter Time
Accounting

Select Yes or No from the drop-down list to indicate whether the user can enter Time
Accounting entries. Users that do not have rights to enter their own time accounting
entries can still have Supervisor or Administrator rights to browse and modify other
entries, and generate reports.

May Enter Vehicle and
Mileage

Select Hidden, Yes, or No from the drop-down list to indicate whether the user can
enter vehicle information and mileage information in Time Accounting entries. If you
select Hidden the user cannot view or enter data into this field. If you select No the field
is read-only.

Note:

If you configure the Standard Choice TIME_ACCOUNTING_SETTINGS,
you can select Hidden for this field, so that all users add vehicle and mileage
information in the Equipment/Materials section of the time accounting entry
form.

May Lock Other User’s
Time Accounting

Select an option from the drop-down list to indicate whether the user has Supervisor or
Administrator access to modify the details of another user's Time Accounting entries.
Administrator and Supervisor roles can edit locked entries, and they can lock or unlock
time accounting records. The specific functions on these roles display here.

May Modify Billable Flag Select Yes or No from the drop-down list to indicate whether the user can modify the
billable when entering Time Accounting entries. If you select No the billable flag is
read-only. No is the default setting. If you select Yes the user can make updates and
automatically populate the record from the Time Accounting type configuration.

May Modify Log Time
Accounting Date

Select Yes or No in the drop-down list to indicate whether the user can modify the date
the user enters Time Accounting entries. If you select No, Civic Platform automatically
populates the entry date.

May Add/Modify Other
User’s Time Accounting

Select an option from the drop-down list to indicate whether the user has Supervisor
or Administrator access to add or modify the details of another user's time accounting
entries. The fields this setting grants update access to are: Time Accounting Type,
Logged Date, Start Time, End Time, Elapsed Time, Billable Flag, Materials and Cost of
Materials, Vehicle Information and Mileage, and Notation.

If you select No, the user cannot add or modify other users’ time account records. If
you select Supervisor, the user can add time accounting records for users that belong
to the same user group, and modify their time accounting records. Civic Platform does
not restrict this option by the Number of Days That Update Is Allowed field. If you
select Administrator, the user can add time accounting records for any other users, and
modify any time accounting record. Civic Platform does not restrict this option by the
Number of Days That Update Is Allowed field.

May Modify Rates and
Cost

Select an option from the drop-down list to indicate whether the user can modify rates
and cost information in Time Accounting entries. The options in this list include Hidden,
No, Yes, Supervisor, and Administrator. If you select Hidden the user cannot view or
enter data into the Rates and Costs fields. If you select No the field is read-only.

If you select Yes the setting is only valid until the age of the current entry exceeds
the number of days specified in the Number of Days That Update Is Allowed field.
If you select Supervisor, the user can modify the hourly rate and the percentage
adjustment of their own Time Accounting entries, as well as those entered by a user in
the Supervisor’s user group. Civic Platform does not restrict this option by the Number
of Days That Update Is Allowed field.

If you select Administrator, users can modify their hourly rate and their percentage
adjustment for their own Time Accounting entries, as well as those entered by any
other user. Civic Platform does not restrict this option by the Number of Days That
Update Is Allowed field.
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May See Other User’s
Time Accounting

Select Yes or No from the drop-down list to indicate whether the user, such as a
Supervisor or Administrator, can view Time Accounting entries assigned to other users.

Number of Days That
Delete is Allowed

The number of days defaults to 999 which indicate that the user can delete his/her own
entries any time. A value of 0 indicates that the user can never delete an entry after
they write it to the database.

A value of 1 - 998 indicates the number of days a user has permission to delete an
entry. After the specified number of days has passed the entry becomes archived and
the user can no longer delete it.

You can configure Time Accounting Supervisors and/or Administrator rights to override
this date and delete any entry, for any user, at any time.

Number of Days That
Update is Allowed

The number of days defaults to 999 which indicate that the user can update his/her
own entries any time. A value of 0 indicates that the user can never update an entry
after they write it to the database.

A value of 1 - 998 indicates the number of days a user has permission to update an
entry. After the specified number of days has passed entries become archived and the
user can no longer update them.

You can configure Time Accounting Supervisor and/or Administrator rights to override
this date and update any entry, for any user, at any time.

Time Accounting Group This drop-down list displays all Time Entry Groups in Civic Platform includes an option
ALL Groups and all other Time Entry Groups with a record status= ‘A’ (active). User
can select as many Time Accounting Groups as they have permissions for.

Time Accounting Types Select whether the user can access All Time Accounting Types, or only Specified Time
Accounting Types drop the drop-down list. If you set Specified Time Accounting Types,
the Look Up button displays on N/A Types and Record Types tabs and populates all
active types automatically selected for the group. If you set All Time Accounting Types,
the Look Up button disappears and populates all active types assigned to the selected
Time Accounting group.

Record By This field displays the user who created the record. This field auto-populates.

Record Date This field displays the date a user created the record. This field auto-populates.

User ID The user’s login identification. Use the picker to get the user ID by department.

User Name The user’s full name.

Editing a Time Accounting User Profile
Agency users can update a Civic Platform user’s Time Accounting profile and associated Time Accounting
Types at any time. Agency users can only edit user profile information related to Time Accounting in this
portlet. If you want to create a new user profile, or edit profile information other than Time Accounting, see
Configuring Organizations, Departments, and Users.

To update Time Accounting user details

1. Access the Time Accounting Profiles portlet (Navigating to the Setup Portlet).

2. Search for the Civic Platform user profile.

For instructions on searching for a Civic Platform user profile, see Searching for User Profiles.

Civic Platform displays the Time Accounting Profile in the detail portlet
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3. Update the detail fields as necessary.

For a list of Time Accounting user profile fields, see Table 164: Time Accounting User Profile Fields.

4. Click Save.

Managing Time Accounting Types Related to User Profiles
A Time Accounting type is the application that the user is recording time for, such as an electrical
inspection. Agency users can associate Time Accounting types to user groups or individual users as
needed.

There are two different usage classifications for Time Accounting Types: Record Types and N/A Types.
Civic Platform uses Record Types to process applications. As the employees log their activity in Time
Accounting, the agency can calculate the fees and charges and apply them to the application in realtime.
For example, an agency can track the time a user spends on a particular process or group of processes.
N/A Types do not directly relate to processing any specific information. This information is for reporting
purposes only.

For more information about Time Accounting Types, see Managing Time Accounting Types .

Topics

• Adding Time Accounting Types to a User Profile

• Editing Time Accounting Types for a User Profile

Adding Time Accounting Types to a User Profile
Agency users can associate Time Accounting types with a user profile from the User Profile portlet.

You can add Time Accounting types to a user profile by user group through the Time Accounting Group or
Time Accounting Type portlet. For more information, see Managing Time Accounting Group Permissions or
Managing Time Accounting Type Permissions.

To associate a Time Accounting type with a user profile

1. Access the Time Accounting Profiles portlet (Navigating to the Setup Portlet).

2. Search for the Civic Platform user profile.

For instructions on searching for a Civic Platform user profile, see Searching for User Profiles.

Civic Platform displays the Time Accounting Profile in the detail portlet.

3. Click the N/A Types or Record Types tab.

Civic Platform displays the desired Types tab in the detail portlet.
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4. Click Look Up.

Civic Platform displays the Time Accounting Type: Search page in the detail portlet.

5. Enter the search criteria for the type you want to locate.

For a list of Time Accounting type fields, see Table 163: Time Accounting Type Detail Fields.

6. Click Submit.

Civic Platform displays the types that match the search criteria.

7. If more than one type fits the criteria, click the name of the group you want, or try searching again with
more detailed search criteria.

8. Select the Time Accounting type or types you want to associate with the user Time Accounting profile.

9. Click Select.

Civic Platform adds the selected Time Accounting types to the associated Record Type list in the detail
portlet.

Editing Time Accounting Types for a User Profile
Agency users can adjust the cost for a Time Accounting type to fit a user’s unique profile. For example, a
home inspector can require a higher inspection rate for residential properties located on an island because
he has to pay bridge toll fees.

To edit Time Accounting types within a user profile

1. Access the Time Accounting Profiles portlet (Navigating to the Setup Portlet).

2. Search for the Civic Platform user profile.

For instructions on searching for a Civic Platform user profile, see Searching for User Profiles.

Civic Platform displays the Time Accounting Profile in the detail portlet.

3. Click the N/A Types or Record Types tab.

Civic Platform displays the desired Types tab in the detail portlet.

4. Click the Time Accounting type you want to edit.

Civic Platform displays the Record Type rate adjustment page in the detail portlet.
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5. Select the rate type you want to use.

For a description of the rate types, see Table 163: Time Accounting Type Detail Fields, or Table 164:
Time Accounting User Profile Fields.

6. Click Save.

Copying Time Accounting User Profiles
The Clone operation copies key profile information and the Time Accounting types from an existing Time
Accounting user profile into a new profile. Cloning saves time and reduces the amount of data you must
enter when creating a Time Accounting Profile.

Agency users can only edit user profile information related to Time Accounting in this portlet. If you want
to create a new user profile, or edit profile information other than Time Accounting, see Configuring
Organizations, Departments, and Users.

To clone a user Time Accounting profile

1. Access the Time Accounting Profiles portlet (Navigating to the Setup Portlet).

2. Search for the Civic Platform user profile.

For instructions on searching for a Civic Platform user profile, see Searching for User Profiles.

Civic Platform displays the User Time Accounting Profiles list.

3. Select the profile you want to clone. You can only clone one user Time Accounting profile at a time.

4. Click Copy.

Civic Platform displays a the Copy Time Accounting Profile page in the detail portlet.
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5. Select the User Login ID from the drop-down list.

6. Enter information in the rest of the fields as needed.

For a list of user profile fields, see Table 164: Time Accounting User Profile Fields.

7. Update the Time Application types as needed.

For instructions on adding or editing Time Accounting types, see Managing Time Accounting Types
Related to User Profiles.

8. Click Submit.

Inactivating Time Accounting User Profiles
Agency users can inactivate Time Accounting profiles for Civic Platform users at any time. Agency users
can only edit user profile information related to Time Accounting in this portlet. If you want to edit or delete
profile information other than Time Accounting, see Configuring Organizations, Departments, and Users.

To inactivate a Time Accounting user profile

1. Access the Time Accounting Profiles portlet (Navigating to the Setup Portlet).

2. Search for the Civic Platform user profile.

For instructions on searching for a Civic Platform user profile, see Searching for User Profiles.

Civic Platform displays the User Time Accounting Profiles list.

3. Complete one of the following options.

• Select the profile(s) you want to inactivate, and then click Delete.

• Open the user profile you want to inactivate. In the Profile record tab in the detail portlet, select No in
the Active field. Click Save.

Note:

If you select a user who does not have an active Time Accounting profile, the delete feature has no
effect on that profile.

Configuring Access to Inspections and Workflow

Understanding Inspection Detail and Workflow User Pages
In the Time Accounting portlet, only owners have the right to create their time accounting entries. If
administrators or supervisors, configured in Time Accounting profiles, want to create another user’s time
accounting entries, they can do it in the Time Accounting section of the Inspection Detail and Workflow
detail page.

Inspection administrators, workflow administrators, time accounting administrators and time accounting
supervisors have different permissions in the new Time Accounting section.

Inspection administrators have full permissions for the standard inspection fields, but no permissions for
the new Time Accounting fields.

Workflow administrators have full permissions for the standard workflow task fields, but no permissions for
the new Time Accounting fields.

Time Accounting Administrator/Supervisor has full permission for the new Time Accounting fields in both
inspection detail and in workflow pages.
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Locking Time Accounting for Another User
The locking feature is available for assigning rights to time accounting administrators and time accounting
supervisors to lock other user’s time accounting; they can run a batch job to lock all Time Accounting
records. To run a batch job, see Working with Batch Jobs.

Time accounting administrators and time accounting supervisors can lock other user’s time entries and can
edit the entries. During the locking period, the owner cannot update the locked time accounting. Each time
accounting entry has a Lock Status field so a user can set the status to locked or unlocked.

To set time accounting locking for a user profile

1. Access the Time Accounting Profiles portlet (Accessing the Time Accounting Profiles Portlet).

2. Select a user from the User Time Accounting Profiles list.

3. Select No, Supervisor, or Administrator from the drop-down list.

No – The user has no right to lock other user’s time accounting.

Supervisor – The user can lock the time accounting entries of a user in the same user group.

Administrator – The user can lock the time accounting entries of any other user.
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Part 8: Land Management
Civic Platform provides functions specific to a land management solution.

Related Links

Managing Property: Addresses, Parcels, and Owners

Structures and Establishments

Inspections

Managing Property: Addresses, Parcels, and Owners
Property includes all of the address, parcel, and owner (APO) information that users can associate with
records:

• Addresses are physical locations within parcels.

• Parcels are an area of land that has a specific location and legally defined boundaries. A parcel can
have multiple addresses.

• Owners are associated with specific parcels; they are often responsible for their parcels and can serve
as a point of contact.

You store APO data in your Civic Platform database as reference data. Reference data is reusable
content that you can add to records without having to recreate the content for each record. For example,
an administrator creates a parcel record, with information on the location and size of the parcel. This
information is reference data. When a user creates an application to build a house on the parcel, the
information contained in the parcel record is reusable within the application.

When users add APO reference data to a record, they select an existing address, parcel, or owner from
a list. The APO reference data resides in your agency's database. Users do not need to enter any new
information. If users edit or remove the APO reference data associated with a record, the change only
affects the current record. The original information in the database remains unchanged.

You can also manually add new property information to a record by filling out a set of forms. New property
data remains solely with the record; it does not automatically update to the reference database.

Click a topic title below for full details.

Related Links

Configuring APO Functionality

Working with Reference Data

Maintaining APO Templates

Configuring APO Functionality
You can configure the address, parcel, and owner (APO) portlets in Civic Platform according to your
agency’s best practices.

After you configure how you want to handle APO transactions in Civic Platform, users can add, edit, split,
merge, and copy or move parcel associations, according to your agency’s objectives.
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Refer to the Accela Civic Platform User Guide for full details on establishing parcel genealogy, splitting,
and merging parcels.

Topics

• Configuring FIDs and Standard Choices

• Configuring APO Form Fields

• Mapping GIS Attribute Fields to Parcel Fields

Configuring FIDs and Standard Choices
Refer to the Civic Platform Configuration Reference, "Address, Parcel, Owner (APO)" section for complete
details on the FIDs and Standard choices you must configure to enable their functionality in Civic Platform.

You can configure your system to synchronize parcel information associated to addresses and owners you
add or remove from a permit record. When you associate a parcel to an address, if you add or remove that
address from a permit record, the parcel information can populate the record as well, either automatically
or following a message prompt. For information on configuring reference data synchronization, see
APOSE_SYNCHRONIZE in the Accela Civic Platform Configuration Reference.

Configuring APO Form Fields
The following tables represent the fields available on the tabs of the address, parcel, and owner (APO)
portlets. You can choose to include or exclude any of these fields, based on your agency’s needs and
preferences. You can set user access levels and specify which fields are required and which are optional.

For instructions on configuring the fields, refer to Designing Forms for Portlets.

• Address Fields

• Address Search Fields

• Parcel Fields

• Table 168: Parcel Search Fields

• Owner Fields

• New Attachment Form Fields

Address Fields
Table 165: Address Fields

Street # (Start) In combination with the Street # (End) field, use this field to specify the street number
for this address. Use the Fraction drop-down list to include fractional street numbers
such as “1/2.”

Street # (End) In combination with the Street # (Start) field, use this field to specify the street number.
Use the Fraction drop-down list to include fractional street numbers such as “1/2.”

Unit # (Start) In combination with the Unit # (End) field, use this field to specify a range of unit
numbers for this address.

Unit # (End) In combination with the Unit # (Start) field, use this field to specify a range of unit
numbers for this address.

Unit Type Choose a unit type such as Apt. or Suite.
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Direction Use this drop-down list to indicate a street direction. For example, choose “N” to
indicate a north direction. This usually indicates the directional area of a city or street,
such as “North Broadway.”

Street Name Enter the street name.

Suffix Use this drop-down list to choose a street type such as “Lane” or “Boulevard.”

City Enter the city name or click Get City to choose a standardized city name.

State Use this drop-down list to choose the state name.

Zip Enter the ZIP code. Because this is a free-text field, you can include a four-digit
extension. For example, enter 84070-2431.

County Enter the county to which the address belongs.

Country Enter the country to which the address pertains.

Address Description Enter a description of the address.

X Coordinate Enter the latitudinal coordinate for the parcel.

Y Coordinate Enter the longitudinal coordinate for the parcel.

Primary Address You can indicate the primary address of a parcel when you edit the parcel.

Status If you want to make the address available in Civic Platform, select Enable; otherwise,
select Disable.

Address Search Fields
Table 166: Address Search Fields

Parcel # Enter the parcel number.

Subdivision If you have set this up, enter the name of the subdivision. If you have defined
subdivisions, choose the subdivision from the drop-down list.

Lot If you have set this up, enter the lot name. If you have defined lots based on
subdivisions, choose the lot from the drop-down list.

Owner Name Enter the name of the parcel owner.

Street # (Start) Enter the starting street number.

Street # (End) Enter the ending street number.

Street Direction Use this drop-down list to indicate a street direction. For example, choose “N” to
indicate a north direction. This usually indicates the directional area of a city or street,
such as “North Broadway.”

Street Name Enter the name of the street.

Street Suffix Use this drop-down list to choose a street type such as “Lane” or “Boulevard.”

Unit # (Start) Enter the starting unit number.

Unit # (End) Enter the ending unit number.

City Enter the city name or choose a standardized city name.

State Use this drop-down list to choose the state name.

Zip Code Enter the ZIP code. Because this is a free-text field, you can include a four-digit
extension. For example, enter 84070-2431.  

County Enter the county to which the address belongs.

Country Enter the country to which the address pertains.
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Status If you want to search for addresses available in Civic Platform, select Enable;
otherwise, select Disable.

Parcel Fields
Table 167: Parcel Fields

Parcel # Enter the official parcel number as determined by the county assessor.

Section Enter a section number to download any parcels in that section number.

Township Enter a township number to download any parcels in that township number.

Range Enter a range number to download any parcels in that range number.

Subdivision If you have set this up, enter the name of the subdivision. If you have defined
subdivisions, choose the subdivision from the drop-down list.

Lot If you have set this up, enter the lot name. If you have defined lots based on
subdivisions, choose the lot from the drop-down list. A block can contain one or more
lots on a plot survey.

Block Enter the name or the street number of the block associated with this application. A
block is a rectangular space, surrounded by streets. A parcel can contain one or more
blocks.

Tract Enter the name of the tract associated with this application. A tract consists of
contiguous parcels all with the same owner.

Area Enter the total area of the parcel. Your agency determines the standard unit of
measure, such as acres or square feet.

Census Tract Enter the unique number assigned by the Census Bureau that identifies the tract to
which this parcel belongs.

Book/Page/Parcel Use these three fields to enter a reference to the physical location of this parcel
information in the County Assessor’s or other responsible department’s records.

Land Value Enter the total value of the land within the parcel.

Exempt Value Enter the total value of any tax exemptions that apply to the land within the parcel.

Improved Value Enter the total value of any improvements to the land within the parcel.  

Inspection District Enter the inspection district to which the parcel belongs.

Supervisor District Enter the supervisor district to which the parcel belongs.

Council District Enter the council district to which the parcel belongs.

Map Reference Enter the reference to where the map for this parcel exists, such as a map book.

Map # Enter the unique map number that identifies the map for this parcel

GIS Sequence # Enter the ID number that you use to identify the parcel in Geographic Information
Systems (GIS).

Plan Area Enter the plan area in which the parcel belongs.

Legal Description Enter the legal description of the parcel, the parcel bounds, or its characteristics. You
can also include a reference to the official documents that contain this description.

Parcel status If you want to make the parcel available in Civic Platform, select Enable; otherwise,
select Disable.

Primary Parcel When an application has more than one parcel associated with it and you need to
designate a primary parcel, click Yes. For each application there can be only one
primary parcel.
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If an application has only one parcel, Civic Platform automatically designates it as the
primary parcel.

To change the option from “No” to “Yes” you must first change the current primary
parcel designation.

In most other actions, the primary parcel setting information also applies. For example,
when cloning or copying the application (Daily > Application > Copy Application) the
parcel primary setting copies over to the new application.

Parcel Search Fields
Table 168: Parcel Search Fields

Parcel # Enter the official parcel number determined by the county assessor. Depending on
the issuing department, the format of the parcel number can be different on different
applications.

Subdivision If you have set this up, enter the name of the subdivision. If you have defined
subdivisions, choose the subdivision from the drop-down list.

Lot If you have set this up, enter the lot name. If you have defined lots based on
subdivisions, choose the lot from the drop-down list.

Address: Street # Enter a range of street numbers in the start field and end field.

Address: Direction Enter the direction of the street. For example, enter “North.”

Address: Street Name Enter the name of a street.

Address: Suffix Choose a street type such as “lane” or “boulevard.”

Address: Unit # Enter a range of units in the start field and end field.

Address: City Enter a city name.

Status Select the current mode of the parcel that you want to find. You can search for enabled,
disabled, pending, or all items.

Primary Parcel Specify “All” to search every parcel in Civic Platform. This search option ignores if you
define the parcel as the primary parcel or not on an application.

Specify “Yes” to search for only primary parcels on an application. Specify “No” to
search for parcels that are not the primary parcel on an application.

Owner Name Enter the name of the person, business, or organization that owns the parcel.

Note:

Civic Platform supports fuzzy string searching on the field even if users does
not enter the fuzzy search symbol (%).

Owner Fields
Table 169: Owner Fields

Owner Title If applicable, enter the owner’s title.

Full Name Enter the owner’s full name.

Note:

Civic Platform supports fuzzy string searching on the field even if users does
not enter the fuzzy search symbol (%).

Name (F/M/L) Enter the first, middle, or last name of the owner.

Address Enter the owner’s street address.
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City Enter the city or click Get City to choose the city that corresponds with the owner’s
street address.

State Choose the state that corresponds with the owner’s street address.

Country Enter the country that corresponds with the owner’s street address.

ZIP code Enter the ZIP code that corresponds with the owner’s street address.

Phone # Enter the owner’s telephone number.

Fax # Enter the owner’s fax number.   

Address Enter the owner’s mailing address.

City Enter the city or click Get City to choose the city that corresponds with the owner’s
mailing address.

State Choose the state that corresponds with the owner’s mailing address.

Country Enter the country that corresponds with the owner’s mailing address.

ZIP code Enter the ZIP code that corresponds with the owner’s mailing address.

Tax ID # Enter the owner’s tax ID number.

Event ID # Enter the ID number of the significant event related to the parcel.

Primary Owner You can indicate the primary owner of a parcel when you edit the parcel.

Owner Status If you want to make the owner available for searching in Civic Platform, select Enable;
otherwise, select Disable.

New Attachment Form Fields
Table 170: New Attachment Form Fields

Document Description Enter a brief description of the document.

Document Group/Category Select the document group and document category for the file. When selecting a
document group, the category field drop-down list changes to provide list items for the
selected document group.

Document Name Enter a title for the document.

File Name Click Browse to locate the file.

Source/EDMS Name Select the name for your agency’s electronic document management system. Note that
this field can have either of these titles, depending upon your agency’s configuration.

User Email Enter one or more email addresses that you want to associate with the attachment. You
can enter the user’s email address, the address of the document author, or any other
related email address. Separate multiple addresses with commas.

Mapping GIS Attribute Fields to Parcel Fields
To enable users to create parcels for selected GIS features from ESRI ArcMap and support synchronizing
parcel information between Civic Platform and the legacy Accela GIS, you must map each GIS attribute to
a parcel field in Civic Platform. For more information about where the GIS attribute comes from and how its
maximum field length is determined, see “Understanding Field Mapping” in the Accela Extension for Esri
ArcMap User Guide.

To map GIS attributes to parcel fields

1. Access the GIS Attribute Mapping portlet (Navigating to the Setup Portlet).

Civic Platform displays the GIS Attribute Mapping portlet.



 | Part 8: Land Management | 813

2. Complete these fields that appear in sequence:

GIS Service This drop-down list displays all the map services configured for your agency. After
you select a map service, the GIS Layer drop-down list populates with all the
related map layers.

GIS Layer This drop-down list displays all the map layers configured for the map service you
select in the GIS Service drop-down list. After you select a map layer, the GIS ID for
Parcel # drop-down list populates with all the related GIS attributes.

GIS ID for Parcel ID This drop-down list displays all the attributes for the map layer you select in the GIS
Layer drop-down list. Select the GIS attribute that you want to use for the Parcel ID
in Civic Platform.

Civic Platform displays the attributes that belong to the selected map service and map layer.

3. Select a desired parcel field from the Civic Platform Attribute drop-down list next to the GIS attribute
that you want to map the parcel field to.

Note:

Make sure that each Civic Platform attribute is of the same data type and at minimum the same data
length with the mapped GIS attribute. For a numeric Civic Platform attribute that has decimal places,
make sure both its integer and its fraction length is no less than that of the mapped GIS attribute.
Otherwise, you cannot save the mapping.

4. Click Save.
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Working with Reference Data
You can track relationships between different types of reference records, such as addresses, parcels, and
owners. You can associate owner and address records to a parcel record to facilitate efficient and accurate
data entry.

Topics

• Adding New Addresses, Parcels, and Owners

• Editing Existing Addresses, Parcels, and Owners

• Searching for Addresses, Parcels, or Owners

Adding New Addresses, Parcels, and Owners
This procedure describes how to add new address, parcel, and owner reference data to your Civic Platform
database. Adding APO reference data enables users to select an existing address, parcel, or owner from a
list when they create a new record.

After you add an address to your reference database, you can enable it to make the address available for
searching when setting up an application, or specifying the addresses for a parcel. You can add owners
to your system and link them to one or more parcels. You can also add owners not directly linked to any
parcel.

To add new addresses, parcels, and owners

1. Click the Property main link.

Civic Platform displays the Property page, which is comprised of the Address, Parcel, and Owner
portlets.
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2. Before you can add or edit an address, parcel, or owner you must search for it in your Civic Platform
database.

Search for the address, parcel, or owner by entering search criteria into any field. For a description of
fields, see Address Search Fields, Table 168: Parcel Search Fields, and Table 169: Owner Fields.

3. Click Submit.

Civic Platform returns a list of addresses, parcels, or owners.

4. Click New.

Civic Platform displays an address, parcel, or owner detail form.



 | Part 8: Land Management | 816

5. Enter address, parcel, or owner data into the form fields. For field descriptions, refer to Table 165:
Address Fields, Table 167: Parcel Fields, and Table 169: Owner Fields.

6. Click Submit.

Civic Platform displays a success message.

Editing Existing Addresses, Parcels, and Owners
After you add APO reference data, you can edit it as needed. You can also change APO reference data
independent of any particular address, parcel, or owner when you edit the record.

To edit an existing address, parcel, or owner

1. Complete - of Adding New Addresses, Parcels, and Owners.

2. Click the link to the address, parcel, or owner that you want to edit.

• For addresses, the street number is the link.

• For parcels, the parcel number is the link.

• For owners, the owner name is the link.

Civic Platform displays the address, parcel, or owner detail form.
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3. Edit the form fields, as needed. For field descriptions, refer to Table 165: Address Fields, Table 167:
Parcel Fields, and Table 169: Owner Fields.

4. Click Save.

Civic Platform displays a success message.

Searching for Addresses, Parcels, or Owners
When you want to edit an existing address, you first need to find it in your reference database. You might
also need to search for an address if you want to view details about the address without changing it.

You can search for any owner defined on your system, including those that you previously disabled. For
example, you can search for an owner to update information or to change the status of the owner.

To search for an address, parcel, or owner

1. Complete - of Adding New Addresses, Parcels, and Owners.

2. Complete any of the search criteria fields as described in Address Search Fields, Table 168: Parcel
Search Fields, and Table 169: Owner Fields.

3. Click Submit.

4. Click the link to the address, parcel, or owner that you want.

• For addresses, the street number is the link.

• For parcels, the parcel number is the link.

• For owners, the owner name is the link.

Civic Platform displays the address, parcel, or owner detail form.
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Maintaining APO Templates
Address Parcel Owner (APO) Templates let you set up the fields, or attributes, that you want to include
on each address, parcel, or owner record in your system. For example, you might want to know the
organization that sponsors a particular owner.

These attributes show up as fields in addition to the standard fields, such as “name” and “address.” You
can set up different templates for addresses, parcels, or owners. For example, you can collect unique
information about addresses that you do not require for owners.

Configuring this functionality is available in Classic Administration.

Topics

• Adding an APO Template

• Adding APO Fields to Forms

• Searching for an APO Template

• Editing an APO Template

• Adding an Attribute to an APO Template

• Editing an APO Template Attribute

• Setting Up Values for a Drop-Down List

Adding an APO Template
When you create a new template, you determine the name, type, and description of the template. APO
templates generally include attributes, or fields, that apply only to addresses, parcels, or owners.

To add an APO template

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Property > APO Template.

Civic Platform displays the Attribute Template—Search page.
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3. Click Add.

4. Complete these fields:

Template Name Enter the name of template.

Template Type Choose the appropriate template type.

Description Enter a description of the template to help you identify its purpose or the attributes
within the template.

5. Click Submit.

6. Add one or more attributes to the template. For instructions, see Adding an Attribute to an APO
Template.

7. Add the APO template data to the various APO forms. For instructions, see Adding APO Fields to
Forms.

Adding APO Fields to Forms
After you create your new APO Template you must add this template data to the various APO forms to
enable users to see your new agency-defined APO fields.

To add template data to forms

1. Navigate to the appropriate property tab (Address, Parcel, or Owner) on the Record detail portlet.

2. To open the detail form, click the link to the address, parcel, or owner.

3. To add the new field to the form, choose Menu > Edit View.

4. From the list of fields, click the Template field.

5. Click OK.

6. In the Effect Scope section, set the user access.

7. Click Save.

Searching for an APO Template
You can search for any address, parcel, or owner template defined on your system, including templates
that you previously disabled. For example, you might need to search for a template to update information
or to change the status of the template.

Note:
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To see a list of all the templates on your system, Click Submit without entering details about an individual
template.

To search for an APO template

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Property > APO Template.

Civic Platform displays the Attribute Template—Search page.

3. Complete these fields:

Attribute Template Name Enter the name of template.

Attribute Type Choose the type of template you want to find. For example, if you want to find an
address template, choose “Address.”

Description Enter a description of the template that you want.

Status Select the current mode of the template that you want to find. You can search for
enabled or disabled items.

4. Click Submit.

Civic Platform displays the APO Template Browse page.

5. Click the red dot that appears next to the template that you want.

Editing an APO Template
After you create a template, you might need to change the template description, status, or attributes. You
can also add or edit any attributes defined for the template.
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You cannot change the template name or template type, but you can add a new template and disable any
templates that you no longer use.

To edit an APO template

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Property > APO Template.

Civic Platform displays the Attribute Template—Search page.

3. Search for the APO template that you want. For instructions, see Searching for an APO Template.

4. Click the red dot next to the template you want to edit.

Civic Platform displays the Attribute Template page for the template you selected:

5. Click the Edit Info button that appears to the right of the Template Information section.

Civic Platform displays the Attribute Template—Edit window.

6. Update these fields:

Description Enter a description of the template to help you identify its purpose or the attributes
within the template.

Status If you want to let users see this field in Civic Platform, select Enable; otherwise,
select Disable.
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7. Click Submit.

8. Edit any attributes for the template. For instructions, see Editing an APO Template Attribute.

Adding an Attribute to an APO Template
After you create a template, you can define attributes for the template. Each attribute that you define for
a specific template shows up as an additional field when users add or edit an address, parcel, or owner
based on that template.

When you add attributes to a template, you can determine whether the attribute displays as a text field, a
drop-down list or another data type, such as an option button. You can also determine whether the field is
mandatory or optional.

To add an attribute to an APO template

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Property > APO Template.

Civic Platform displays the Attribute Template—Search page.

3. Search for the APO template that you want. For instructions, see Searching for an APO Template.

Civic Platform displays the Attribute Template page for the template you selected:

4. Click Add.

Civic Platform displays the Attribute Template’s Attribute—Add window.
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5. Complete the necessary fields as described in Table 171: Address, Parcel, and Owner Template
Attribute Fields.

6. Click Submit.

Table 171: Address, Parcel, and Owner Template Attribute Fields

Attribute Name Enter the name of the attribute.

Label Enter the label for the attribute that displays when a user adds or edits address,
parcel, or owner information.

Description Enter a description of the attribute that helps to identify its purpose.

Default Value If you want to supply a default value, enter it here. If you are setting up a drop-down
list, you can add values to the drop-down list so that a user has multiple values to
choose from.

Unit If you want to attach a unit such as “square feet,” “dollars,” or “miles” to the first field
value, enter it here. You can choose from standard choices, or enter a new unit.

Data Type Choose the type of the attribute. You can choose from Date, Number, Radio, or
Drop-down List types.

Display Order Enter a number to determine the position of the first field in your Specific
Information group. For example, if you want the field to display before any other
fields, enter 1.

Required Flag If you want this attribute to be mandatory for the Address, Parcel, and Owner
template, select Yes; otherwise, select No.

Citizen Access Displayable If you want Citizen Access to display this attribute, select Yes; otherwise, select
No.Note: If you select No for this attribute, when users associate an APO that
contains the attribute with a record, the attribute does not display in Citizen Access,
but its value is stored for the record.

RecordSearchable If you want to allow users to search for records using this attribute, select Yes;
otherwise, select No.

Status If you want to let users see this field in Civic Platform, select Enabled; otherwise,
select Disabled.
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Editing an APO Template Attribute
After you add an attribute to a template, you might need to change it. You can update any attributes within
the template by changing the label, data type, and any other features of the attribute.

You cannot change the attribute name or delete an attribute, but you can add a new attribute and disable
attributes that you no longer use.

To edit an APO Template Attribute

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Property > APO Template.

Civic Platform displays the Attribute Template—Search page.

3. Search for the APO template that you want. For instructions, see Searching for an APO Template.

4. Click the red dot next to the template you want to edit.

Civic Platform displays the Attribute Template page for the template you selected:

5. Click the red dot that appears next to the attribute that you want to edit.

Civic Platform displays the Attribute Template’s Attribute—Edit page.
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6. Complete the necessary fields as described in Table 171: Address, Parcel, and Owner Template
Attribute Fields.

7. Click Submit.

Setting Up Values for a Drop-Down List
Templates a collection of several attributes. You can add an attribute to a template that displays as a drop-
down list. After you add a drop-down list attribute to a template, you must set up the values that you want
to include in the list. Users can then choose from the values when adding or updating addresses, parcels,
or owners.

To set up values for a drop-down list

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Property > APO Template.

Civic Platform displays the Attribute Template—Search page.

3. Search for the APO template that you want. For instructions, see Searching for an APO Template.

4. Click the red dot next to the template you want.

Civic Platform displays the Attribute Template page for the template you selected:
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5. Click Edit next to the drop-down list attribute that you want.

Note:

The Edit button is only available next to the drop-down list attribute.

Civic Platform displays a page where you can add, edit, or delete drop-down list values:

6. Do one or more of these options:

• If you want to add a new value, click Add, enter the value in the Attribute Value field, and then click
Save.

• To update an existing value, replace the value text and then click Update.

• To delete a value, click Delete.

7. Click Close to return to the list of fields in your template.

Structures and Establishments
This topic describes the configuration tasks for the Structures and Establishments module, and contains
detailed information on creating structure and establishment types.

The first step in managing Structures and Establishments is to create structure and establishment types.
After you define a type, you can customize the fields that display in records of that type. You do this by
creating attributes, characteristics of structures or establishments that display as data entry fields, and
gathering groups of attributes into templates. After you attach a template to a type, the fields contained
in the template display in records created from that type. Both attributes and templates share information
between the structures and establishments module and the asset management module of Civic Platform.
You can find complete details about managing attributes and setting up templates in Attributes and
Templates.

You can also use the Form Layout Editor to customize the layout of structure and establishment records.
Design a layout for a template, then attach the template to structure and establishment type. All structure
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and establishment types that you attach this template to display this layout. For complete information on
working with the Form Layout Editor, refer to Designing Forms for Portlets.

You can configure your system to synchronize address, parcel, or owner information associated to
structures that users add to or remove from records. When you associate a parcel to a structure, if a
user adds that structure to or removes it from a record, the parcel information can populate the record as
well, either automatically or following a message prompt. For information on configuring reference data
synchronization, see Managing Property: Addresses, Parcels, and Owners.

Click a topic title below for full details.

Related Links

Configuring Structures and Establishments

Managing Structure and Establishment Types

Configuring Structures and Establishments
When you associate an establishment with a structure, you can configure your system to take the APO
data associated to the establishment and automatically associate it to the structure.

Enabling Structures and Establishments for Application Intake Forms
You can make sections for structures and establishments on the Application Intake Form. Enable
the Structure and Establishment fields in a SmartChoice group. Any application type associated with
this SmartChoice group includes the Structure and Establishment sections. For more information on
SmartChoice groups, see Creating and Configuring Records.

To enable structures and establishments for application intake form

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > SmartChoice Group.

Civic Platform displays the SmartChoice Group Search page.

3. In the Group Name field enter the name of the SmartChoice group for which you want to enable the
Structures and Establishments sections.

To see a complete list of SmartChoice groups, leave this field blank.

To create a new group, see Creating and Configuring Records.

4. Click Submit.

Civic Platform returns a list of SmartChoice groups that match your search criteria.

5. Click the red dot beside the SmartChoice group you want to edit.

Civic Platform displays the SmartChoice Group Details - Edit page.
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6. To enable the Structure and Establishment sections in application intake forms for application types
associated to this SmartChoice group, select the Yes option in the Structure and Establishment fields.

7. Click Save.

Civic Platform saves your changes.

Managing Structure and Establishment Types
This section discusses the creation and editing of Structure and Establishment types. When you create
structure and establishment types, you determine the kinds of structure and establishment records users
can create, including the data entry fields that display in the record forms.

You can attach templates to your structure and establishment types. These consist of groups of attributes,
which are pieces of information users need to track structures and establishments. Civic Platform shares
attributes and templates between the structures and establishments module and the asset management
module. For information on attributes and templates, see Attributes and Templates.

You can also design the form layout for templates, automatically applying the layout to any structure or
establishment type that uses the template. For information on the Form Layout Editor, see Designing a
Form Layout.

Topics

• Creating a Structure or Establishment Type

• Searching for a Structure or Establishment Type
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• Editing a Structure or Establishment Type

• Deactivating a Structure or Establishment Type

• Activating a Structure or Establishment Type

Creating a Structure or Establishment Type
Accela users can create structure and establishment records to track complex properties, such as malls,
that contain multiple business and residential establishments within one structure. You create structure and
establishment types that users choose from to create these records. You can customize each type with
specialized fields and layout.

Some examples of structure types are Mall and Apartment/Commercial. You can create establishment
types for the Apartment/Commercial structure type, such as Apartment, Restaurant, Coffee House, and
Book Store.

To include customized fields in a structure or establishment type, you can attach a template to the type.
For information on templates, see Working with Templates.

To create a structure or establishment type

1. Access the Structures and Establishments Types portlet (Accessing the Structures and Establishments
Types Portlet).

2. Click New in the Structure and Establishment Types portlet.

a. You can also click or hover over the Menubutton in the Structure and Establishment Type navigation
tree.

b. Click the New Type option.

Civic Platform displays the New Structure and Establishment portlet.

3. Complete the following required fields:

Category Select either Structure or Establishment from this drop‑down menu.

Type Enter a name for the Structure or Establishment type you are creating.

Template ID Select a template from this drop‑down menu. For information on templates, see
Working with Templates.

4. If you choose, you can complete the Description field.

5. Click Submit.
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Civic Platform creates the structure or establishment type.

Searching for a Structure or Establishment Type
To find a structure or establishment type using the navigation tree

1. Access the Structures and Establishments Types portlet (Accessing the Structures and Establishments
Types Portlet).

2. In the navigation tree, use the + and - buttons to expand and contract the following categories:

Struct & Establ Types by
Category

Lists all Structure and Establishment types; organizes the types by Structure and
Establishment category.

Struct & Establ Types by
Type

Lists all Structure and Establishment types; organizes the types by Structure and
Establishment type.

Struct & Establ Types by
Template

Lists all Structure and Establishment types; organizes the types by Structure and
Establishment template.

3. Click the name of the type you want to view.

Civic Platform displays the type detail portlet.

To find a structure or establishment type in the primary portlet

1. Access the Structures & Establishments Types portlet (Accessing the Structures and Establishments
Types Portlet).

2. In the Structure & Establishment Types portlet, click Search.

Civic Platform displays the Structure and Establishment Type search portlet.
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3. Complete any fields that display.

4. Click Submit.

Civic Platform returns a list of structure and establishment types that match your search criteria.

Editing a Structure or Establishment Type
To edit a structure or establishment type

1. Find the structure or establishment type you want to edit. For instructions on how to find a structure or
establishment type, see Searching for a Structure or Establishment Type.

Civic Platform displays the Structure and Establishment Type detail portlet.

2. You can edit the following fields:

Template ID Select a template from this drop‑down menu. Templates are groups of attributes that
display as data entry fields in a structure or establishment record. When you change
the template, you change the field content of the structure or establishment type.

Description Edit the description of this structure or establishment type.

3. Click Save.

Civic Platform saves the changes to the structure or establishment type.

Deactivating a Structure or Establishment Type
After you create a structure or establishment type, you cannot delete it from the database. You can,
however, deactivate the type. When you deactivate a type, it no longer displays in the Structure and
Establishment Types list, but it still appears in the navigation tree for structure and establishment types.

To deactivate a structure or establishment type

1. Find the structure or establishment type you want to delete. For instructions on how to find a structure
or establishment type, see Searching for a Structure or Establishment Type.

2. Select the structure or establishment type(s) you want to delete.



 | Part 8: Land Management | 832

3. Click the Deactivate button.

Civic Platform deactivates the type and removes it from the Structures and Establishments Types list.

Activating a Structure or Establishment Type
You can activate a deactivated structure or establishment type. Locate the type in the navigation tree and
then click its name to restore it to the Structures and Establishments Types list.

To activate a structure or establishment type

1. Access the Structures & Establishments Types portlet (Accessing the Structures and Establishments
Types Portlet).

2. In the navigation tree, use the + and - buttons to locate the structure or establishment type you want to
activate by expanding and contracting the following categories:

Struct & Establ Types by
Category

Lists all Structure and Establishment types; organizes the types by Structure and
Establishment category.

Struct & Establ Types by
Type

Lists all Structure and Establishment types; organizes the types by Structure and
Establishment type.

Struct & Establ Types by
Template

Lists all Structure and Establishment types; organizes the types by Structure and
Establishment template.

3. Click the hyper linked name of the structure or establishment type you want to activate.

Civic Platform activates the type and restores it to the Structures and Establishments Types list.

Inspections
This topic describes the configuration tasks involved with setting up all of the different inspections that
users need to complete for a certain type of application. You determine which inspections that you deem
required in an inspection group, and the order in which users must complete them. For example, if you
require a Foundation Wall, Electrical, and Plumbing inspection before issuing a building permit, you can set
up a Building inspection group that includes those inspections for all Building application types.

There can be one or more inspection types in an inspection group. With each inspection type you must
specify the checklist group, result group and grade group, which are the guidelines to follow for performing
the actual inspection and for resulting the inspection score, inspection status, and inspection grade.

You can activate the auto assign feature for individual inspection types that automatically schedules
inspections and assigns them the appropriate inspectors.
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After you create an inspection group and add inspection types, you can set up an inspection flow process.
The inspection flow process is an outline of all the inspections that a user group needs to complete
between the application submittal and the issuance of a permit or license to the applicant. For explanations
of these steps refer to Managing Inspection Flows and Milestones.

Click a topic title below for full details.

Related Links

Managing Inspection Groups

Establishing Inspection Types

Setting Up an Inspector Profile

Managing Inspection Scheduling

Working with Inspection Result Groups

Working with Inspection Grade Groups

Managing Checklist Groups

Establishing Checklists

Configuring Inspection Route Sheets

Assigning Inspection Categories

Managing Inspection Flows and Milestones

Managing Inspection Groups
Topics

• Creating an Inspection Group

• Searching for an Inspection Group

• Editing an Inspection Group

Creating an Inspection Group
When you create an inspection group, you determine the group code, the group name, and the inspection
types the group includes.

To create an inspection group

1. Access the Classic Administration page (Accessing Classic Administration).

2. ChooseInspection > Inspection.

Civic Platform displays the Inspection - Search page.

3. Click Add.
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4. Complete these fields:

Inspection Group Code Enter a unique group code. You might want to enter a shortened version of the
inspection group name as the group code. For example, you might name an
inspection group Restaurant Build Out and shorten the title to RestBuildOut for the
inspection group code.

Inspection Group Name Enter a unique group name. Inspection Group Name is the full-length version of a
short name for an inspection group code. For example, you might name an inspection
group Restaurant Build Out and shorten the group code to RestBuildOut.

5. Click Submit.

Civic Platform displays the Inspection-Edit page.

6. Add one or more inspection types. For information on how to add inspection types to inspection groups,
see Adding an Inspection Type.

Searching for an Inspection Group
You can search for any inspection group in Civic Platform, including disabled inspection groups. Conduct a
search when you want to modify inspection group information, such as inspection types or inspection auto-
assignment. To view all inspection groups, click Submit on the Inspection Search page without completing
the Search fields.

To search for an inspection group

1. Access the Classic Administration page (Accessing Classic Administration).

2. ChooseInspection > Inspection.

Civic Platform displays the Inspection - Search page.

3. Complete these fields:

Inspection Group Code Enter the inspection group code for the inspection group you want to find.

Inspection Group Name Enter the inspection group name for the inspection group you want to find.

4. Click Submit.

Civic Platform displays the inspection group(s) that matches your search criteria on the Inspection -
Browse page.

5. Click the red button next that appears in the Edit column next to the inspection group you want.

Civic Platform displays the Inspection - Edit page.

Editing an Inspection Group
After you add an inspection group, you might need to modify the group information, including associated
inspection types, checklist groups, inspection point values, and their display order.

To edit an inspection group
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1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

Civic Platform displays the Inspection Search page.

3. Search for the inspection group that you want.

For instructions on searching for an inspection group, see Searching for an Inspection Group.

Civic Platform displays the Inspection - Edit page.

4. Make any necessary changes to the inspection group. For a complete list of editable fields, see Table
172: Inspection Group Fields.

5. Click Update.

Civic Platform updates the selected inspection group.

Establishing Inspection Types
You can create different inspection types for a particular inspection group. For example, you can have a
building inspection group, but there might be different inspection types for the different inspections that fall
under the building category. You can add as many inspection types to an inspection group as you need.
Inspection types within a group form the list of required inspections for any application associated with the
inspection group.

Topics

• Adding an Inspection Type

• Editing an Inspection Type

• Deleting an Inspection Type

• Assigning Disciplines to an Inspection Type
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Adding an Inspection Type
After you create an inspection group, you can add inspection types to the group. For example, you can
include a Foundation Wall inspection and a Fire inspection in the same group. You can later edit an
inspection type.

Note:

You cannot associate an inspection result group with an inspection type at the same time you create the
inspection type. You can do that when you edit the inspection type.

To add an inspection type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

3. Search for the inspection group that you want.

For instructions, see Searching for an Inspection Group.

4. Click the Inspection Group Code link corresponding to the inspection for which you want to add an
inspection type.

For field descriptions see Table 172: Inspection Group Fields.

Civic Platform displays the Inspection - Edit page.

5. Scroll to the Inspection - Edit screen and click the Add Type button.

Civic Platform displays the following.

6. Enter the name of the type in the Inspection Type field.

7. Click Save.

Table 172: Inspection Group Fields

Citizen Access Inspection
Display

Select Yes to enable the display of these inspections in ACA. Select No to hide
the inspections from Citizen Access. You can set a specific inspection to display
in or hide from Citizen Access in V360. For complete information, see “Displaying
an Inspection in Citizen Access,” in the “Inspections” chapter of the Accela Civic
Platform User Guide.

Citizen Access Multi-
Inspection Schedule

Select Yes to enable the scheduling of multiple inspections for this inspection type
in Citizen Access. Select No to limit the number of inspections to one time only for
each application intake form in Citizen Access.Use this feature to allow a customer
to schedule repeat inspections. For example, contractors typically require multiple
concrete inspections for a large project requiring many pours.

Allow Failed Checklist Items Select Yes to allow the inspection to pass with failed checklist items for the current
inspection type or from previous inspections.

Select No to require all current and failed checklist items to pass inspection prior
to signing off on the inspection.

Allow to edit inspection
result / inspection grade /

After users go through the inspection checklist items and enter their statuses, Civic
Platform automatically populates the inspection result, inspection grade, checklist
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checklist total score /
checklist major violation

total score and checklist major violation option for the inspection. Inspection
supervisors always have the right to override these auto-populated values.

Select Yes to enable normal users (other than inspection supervisors) to edit the
auto-populated values.

Select No to forbid normal users from editing the auto-populated values.

Auto Assign To activate the auto assign inspection scheduling feature, choose Yes from the
drop-down list. To de-activate the auto assign inspection scheduling feature,
choose No from the drop-down list.

Cancel Restriction Select an option based on your agency’s policy for cancelling inspections. This
restriction applies only to Citizen Access public users.

If you want no restrictions on inspection cancellation, select No Restriction.

If you want to restrict inspection cancellation, select the Hours Prior or Days
Prior option and then enter a time and a date. For example, if you want to restrict
inspection cancellation to 11:00 AM one day prior to the inspection date, select
Days Prior and choose One Day Prior at 11:00 AM in the associated drop-down
lists.

Capture and Carry Over
Failed Checklist Items

Select a value from this drop-down list if you want failed checklist items to be
transferred to the checklist of the next inspection that users schedule for the same
application in Civic Platform or Citizen Access.

Select one of these values:

Auto: Select this option if you want selected failed checklist items automatically
transferred to the checklist of the next inspection.

Auto-All: Select this option if you want all failed checklist items automatically
transferred to the checklist of the next inspection.

Prompt: Select this option if you want a prompt to display that allows agency
users to select which failed checklist items should be transferred to the next
inspection checklist for an application. Note that with this option, Citizen Access
does not carry over any failed checklist items.

For complete instructions on how to configure checklist items for carry-over, see
Carrying Over Failed Checklist Items.

Configuration Select one of the following options from the drop-down menu.

Inspection Disciplines:

Select this option if you want to assign a discipline to the selected inspection type.
Civic Platform uses disciplines to categorize inspections. For example, you might
assign Electrical inspection types, including Rough Electric and Electrical Outlet
inspection types, to the Electrical Discipline. Administrators can set up discipline
values with the Standard Choice INSPECTOR_DISCIPLINES. For instructions
on configuring this Standard Choice, see the Accela Civic Platform Configuration
Reference. Civic Platform also uses disciplines as filtering criteria for automatic
inspection scheduling. For more information on automatic inspection scheduling,
see Setting Up Automatic Inspection Scheduling.

Click Recurrence & Relationship Setting to configure those elements. You can
configure automatic scheduling of recurring inspections based on a set period of
time. You can base the time on the completion date of the previous inspection or
on the initial creation date of the record. See Working with Recurring and Related
Inspections.

This link provides a visual of related inspections and reportable linkage between
inspections. It enables you to differentiate the parent inspection from follow-
up inspections. To allow users to modify related inspections, see Relating
Inspections.
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Inspection Categories:

Click the Inspection Categories link to assign the inspection type to one
or more inspection categories. Civic Platform uses categories to organize
inspection types. This helps public users, for example, to easily locate the desired
inspection type when they try to schedule or request an inspection for a record
in Citizen Access. Inspection categories are pre-defined by the Standard Choice
INSPECTION_CATEGORY. For instructions on configuring this Standard Choice,
see Accela Civic Platform Configuration Reference.

Configure By Select an inspection option, based on your agency’s preferences and best
practices:

Inspection Flow: Choose this option if you want to require public users to
complete inspections in a certain order. With this option, you can enable the
simultaneous completion of tasks, and you can allow public users to skip tasks
that become unnecessary due to the completion of another task.

Inspection MileStone: Choose this option to implement inspection milestones
as checkpoints in the inspection process. These checkpoints require public users
to complete an inspection before they can move on to the next set of inspections
within the inspection group.

To learn about setting up an inspection flow process, see Assigning Inspection
Categories.

Department Click the Department button to select the department responsible for the
inspection type.

Display Order Enter a number to determine the position of the inspection type within a list of
types. For example, if you want users to complete one type of inspection before
any others, enter “1.”

Flow Enabled To include the inspection in the inspection flow process, choose Yes from the
drop-down list.

For an explanation of setting up an inspection flow process, see Assigning
Inspection Categories.

Grade Group Choose an active grade group that you want to assign to the inspection type. For
instructions, see Managing Checklist Groups.

Checklist Group Choose an existing group that you want to edit. For instructions, see Establishing
Checklists. The Checklist Group field has a Configure the Required Checklist icon
next to it. You can click the icon to set required checklists in the checklist group
that inspectors must complete in the inspections of the inspection type.

Inspection Flow Click this button to configure inspection flow process for a selected inspection
group. To learn about setting up an inspection flow process, see Assigning
Inspection Categories.

Inspection Score Select the method for calculating total scores based on the sub scores of the
checklist items. These are your options:

Total sub scores (the default method) Displays the sum of all the checklist item
scores.

Average of subtotal scoresDisplays the average score of all the checklist items.

Lowest subtotal scores Displays the lowest checklist item score.

Highest subtotal scores Displays the highest checklist item score.

Subtracted sum of the scores (this option works with the Total Score
field)Subtracts the total score of all the checklist items from the Total Score
defined for the inspection type.

Inspection Type Enter the name of the inspection type.
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IVR Number Enter a unique number for the inspection type within the inspection group if IVR
access is available.

Max Points Enter the maximum number of points allowed before this type of inspection fails.
If the total score of an inspection (the sum of points for all items on all checklists)
is equal to or greater than this maximum, the Inspection Result Code list does not
display the Passed option and the Inspection fails.

Required/Optional Specify whether you want to make inspections required or optional. Each
inspection that specify as Required must pass for the application to be complete.

Reschedule Restriction Select an option based on your agency’s policy for rescheduling inspections. This
restriction applies only to Citizen Access public users.

If you want no restrictions on inspection rescheduling, select No Restriction.

If you want to restrict inspection rescheduling, select Hours Prior or Days
Prior and specify a time and date. For example, if you want to cut off inspection
rescheduling at 11:00 AM one day prior to the inspection date, select Days Prior
and choose One Day Prior at 11:00 AM in the associated drop-down lists.

Result Group Choose an existing group that you want to edit. See Working with Inspection
Result Groups.

Total Score If you select the Subtracted sum of the scores option in the Inspection
Score drop-down list, enter the total score from which to subtract the sum of the
inspection sub scores for calculating the inspection total score.

This field is not valid with other options in Inspection Score.

Units Enter the number of inspection units used as criteria when automatically
scheduling inspections. An inspection type unit indicates the shortest length of
time it takes to complete an inspection. Civic Platform measures all inspections
as multiples of the unit value. For example, you might determine that the unit
value equals the duration of electrical inspections, 30 minutes. Civic Platform then
measures all inspections in 30 minute increments: hour-long inspections are two
units and ninety-minute inspections are three units.

The unit value should relate to the default time block you configure in your
inspection calendars.

Editing an Inspection Type
After you add an inspection type to a group, you can change the type. For example, you can change the
type name or the display order.

To edit an inspection type

1. Access the Classic Administration page (Navigating to the Setup Portlet).

2. Choose Inspection > Inspection.

3. Search for the inspection group that you want.

For instructions, see Searching for an Inspection Group.

4. Click the Inspection Group Code link corresponding to the inspection for which you want to add an
inspection type.

Complete the necessary fields as described in Table 172: Inspection Group Fields.

5. Click Update.
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Deleting an Inspection Type
After you add an inspection type to a group, you can delete a type.

To delete an inspection type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

3. Search for the inspection group that you want.

For instructions, see Searching for an Inspection Group.

4. Click the Inspection Group Code link corresponding to the inspection for which you want to add an
inspection type.

5. Click Delete next to the Inspection Type that you want.

6. Click OK.

Assigning Disciplines to an Inspection Type
To assign disciplines to an inspection type:

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

3. Search for the inspection group that you want.

For instructions, see Searching for an Inspection Group.

4. Click the red dot for the Inspection Group Code link corresponding to the inspection type you want to
modify.

Refer to field descriptions in Table 172: Inspection Group Fields.

5. Click the Configuration button at the far right side of the page.

The Configuration drop-down menu displays.

6. Click the Inspection Disciplines option.

Civic Platform displays the Inspection - Disciplines List.

7. Click the Add button on the Disciplines section of the Inspection Disciplines.

Civic Platform displays the Disciplines List.

8. Select each discipline that you want to assign to the inspection type. To choose all disciplines, click
Disciplines.

9. Click Submit.
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The selected districts display in the bottom section of the Inspection Disciplines List.’

To remove any of the listed disciplines click the corresponding Delete button located to the right of the
discipline

10.Click Cancel.

Setting Up an Inspector Profile
Set up a user account and a user profile for an inspector in Civic Platform. This profile identifies the
inspector, and provides details such as daily inspection maximums or units, districts, disciplines, and
scheduling availability. You can then use this information to assign and schedule the appropriate inspector
when automatically scheduling inspections. This profile also identifies the default start location, the default
end location, and the default routing type for an optimized inspection route. You can create a batch job to
generate the sequence of inspection route sheet items for each inspector based on this information.

Configure your agency’s inspector profiles so inspectors get assignments to inspections that correspond to
inspector units, districts, disciplines, and inspection calendars.

Daily inspector units reflect the number of inspections an inspector can conduct each day. For example,
if an inspector has six hours available for inspections each day and each unit equals 30 minutes, then the
inspector can accommodate twelve units per day.

To automatically schedule inspections, the feature must be active for each type of inspection. For
information on how to turn this feature on, see Establishing Inspection Types.

Topics

• Identifying Daily Inspection Units

• Defining Location and Type Information for Inspection Routes

• Assigning and Unassigning Inspector Districts

• Assigning Inspection Disciplines

• Assigning a Calendar to an Inspector

Identifying Daily Inspection Units
You can automatically assign and schedule inspectors by using the inspector profile information. When
you configure inspector profiles you specify the maximum daily inspection units for an inspector, such as
hours, number of inspections per day, or any type of unit, according to your agency's objectives and best
practices. For example, if an agency identifies the daily inspections units as number of inspections per day
and an inspector generally completes five fireplace inspections a day, the daily inspection unit is 5.

Inspection units must be consistent from one inspector to the next for automated inspection scheduling to
work properly. These units form the basis of criteria for assigning an appropriate inspector.

To identify daily inspection units

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user you want to work with and click the User Information link next to the user.

Civic Platform displays the User - Information page.
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4. Enter a value in the Daily Inspection Units field.

5. Click Submit.

Civic Platform updates the daily inspection units.

Defining Location and Type Information for Inspection Routes
You can define the start location, the end location, and the default routing type for an inspection route. And
then create a batch job to generate the sequence of inspection route sheet items for each inspector based
on this information. For more information about the batch job, see

To define location and type information for inspection routes

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user you want to modify and click the User Information link next to the user.

Civic Platform displays the User - Information page.

4. Complete these fields:

Start Location Enter the full address of the start location for an inspection route. For example,
1001 Adler CIR, Sacramento CA 95864.
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End Location Enter the full address of the end location for an inspection route. For example,
1001 Adler CIR, Sacramento CA 95864.

Default Routing Type Enter the default routing type for inspection route optimization.

5. Click Submit.

Assigning and Unassigning Inspector Districts
You can assign an inspector to one or more districts within their inspector profile. This information is a
critical component when automatically scheduling inspections. Civic Platform uses this information when
searching for an available inspector.

To assign or un-assign inspection districts

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user you want to work with and click the User Information link next to the user.

Civic Platform displays the User - Information page.

4. To assign a district:

a. Click the Select District button.

Civic Platform displays the User Districts - Add From Standard Choices page.

b. Mark the appropriate check box next to each district that you want to assign to the inspector. To
select all districts, mark the District check box.

c. Click Submit.
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The selected districts display in the bottom section of the User - Information page.

5. To remove any of the listed districts from the inspector’s profile, click the corresponding Delete button
located to the right of the district.

Assigning Inspection Disciplines
You can assign an inspector to one or more disciplines. Civic Platform uses these disciplines as criteria in
searches for an applicable inspector when automatically scheduling inspections.

To assign inspection disciplines to an inspector

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user you want to work with and click the User Information link next to the user.

Civic Platform displays the User - Information page.

4. Click the Add button on the Disciplines section of the Inspector Profile.

Civic Platform displays the Disciplines List page.

5. Mark the appropriate check box next to each discipline that you want to assign to the inspector. To
choose all disciplines, mark the Disciplines check box.

6. Click Submit.

The selected districts display in the bottom section of the User - Information page.

Note:

You can remove any of the listed disciplines from the inspector’s profile by clicking Delete.
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Assigning a Calendar to an Inspector
You can assign one or more calendars to an inspector. If you identify a calendar for a user group, the
inspector automatically inherits the calendar and its availability and blackout days. You can associate
additional calendars with the inspector at the user level. Civic Platform uses the user group and user level
calendars to confirm the availability of an inspector when automatically scheduling inspections.

For more information on using calendars, see Setting Up Calendars.

To assign a calendar to an inspector

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose User Profile > User.

3. Search for the user you want to work with and click the User Information link next to the user.

Civic Platform displays the User - Information page.

4. Click the Add button on the User Level section under Inspector Calendars.

Civic Platform displays the Inspector Calendar - Search page.

5. Search for the calendar by entering a portion or all of the calendar name.

6. Click Submit.

Civic Platform displays the Inspector Calendar Search Result pop-up window.

7. Click Select next to the applicable inspector calendar you are looking for.

Civic Platform updates the Inspector Calendar - User Level section with the selected calendar and
returns to the User - Information page.

Managing Inspection Scheduling
Topics

• Setting Up Automatic Inspection Scheduling
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• Defining Re-Schedule and Cancel Inspection Parameters

• Working with Recurring and Related Inspections

• Configuring Multiple Inspection Scheduling

• Understanding Same Day Next Day Inspection Scheduling

• Scheduling Requests and Pending Inspections

Setting Up Automatic Inspection Scheduling
You can configure Civic Platform to automatically assign inspectors. Before automatic inspection
scheduling can work properly, you must set up the inspector profile, inspection conditions (including
inspection disciplines, districts, and calendar availability), and you must enable the automatic inspection
scheduling feature.

When performing automatic inspection scheduling, Civic Platform checks for available inspectors meeting
the conditions. The candidate inspectors display in the Inspector Calendar list with an order in which those
most largely meet the conditions display on the top of those less able to meet the conditions.

You must configure the following to properly enable and use automatic inspection scheduling:

• Inspector districts: This feature enables Civic Platform to check the inspection districts of the
applications against the inspectors’ districts.

• Civic Platform follows gets inspection district information in this order: (1) The inspection district
setting of the parcel; (2) The inspection district setting of the address; (3) The inspection district that
the parcel belongs to in the GIS map.

Note:

A parcel can overlap multiple GIS inspection districts. If you configure the Standard Choice
GIS_BUFFER_DISTANCE, Civic Platform can artificially shrink the parcel to a degree, and get
the inspection district that the major portion of the parcel maps to. For instructions on adding
the Standard Choice, refer to the “Standard Choices Reference” chapter in the Civic Platform
Configuration Reference.

• For configuring inspectors district, see Assigning and Unassigning Inspector Districts.

• Inspection disciplines: This feature enables Civic Platform to check the discipline of the inspection type
against the inspectors’ districts. For configuration details, see Assigning Disciplines to an Inspection
Type.

• Inspector profiles: Each inspector has an inspector profile that contains their daily inspection units,
district location, identified disciplines, and availability. Civic Platform checks this profile and the
conditions identified for the inspection to assign the appropriate inspector. For configuration details, see
Setting Up an Inspector Profile.

• Configure inspection calendars: This feature enable Civic Platform to get the available dates and times
from the inspection calendars with matching inspection type and district settings. For configuration
details, see Setting Up Automatic Inspection Scheduling.

• Enable automatic inspection scheduling, as described in the following procedure.

Enabling automated inspection scheduling:

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.
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3. Search for the inspection group code you want to activate auto assign.

4. Click the Inspection Group Code link corresponding to the inspection for which you want to activate
auto assign.

For field descriptions see see Table 172: Inspection Group Fields.

Civic Platform displays the Inspection-Edit page.

5. Use the Auto Assigndrop-down list for the inspection you want and select ‘Yes’ to activate the auto
assign inspection feature.

6. Click Update.

Civic Platform turns on the auto assign feature for the inspection and returns to the Inspection -Edit
window.

Defining Re-Schedule and Cancel Inspection Parameters
You can configure reschedule and cancel parameters to determine when inspections are eligible for
rescheduling and cancelling from Citizen Access. Inspection type parameters control whether public users
can reschedule or cancel inspections. This feature prevents public users from rescheduling or cancelling
an inspection right before its scheduled start time and ensures that inspection calendars are stable and
consistent.

For example, you might set a reschedule restriction for a Code Enforcement inspection at 5:00 PM one day
prior to the inspection date. Meaning that public users can only reschedule a Code Enforcement inspection
until 5:00 PM the day before the inspection's scheduled date.

When you set inspection type reschedule and cancel parameters, you must also set the Citizen Access
inspection type display. You can configure inspection type display in the Calendar Administration portlets.

In the Calendar Administration portlets, you must first associate inspection types with an inspection
calendar. After you associate inspection types, you can determine how each inspection type displays in
Citizen Access using the Cancel Inspection in Citizen Access, Reschedule Inspection in Citizen Access,
and Schedule Inspection in Citizen Access drop-down lists.

Select a value of Yes for the Reschedule Inspection in Citizen Access and Cancel Inspection in Citizen
Access drop-down lists if you want to give public users the option to reschedule or cancel inspections.
Select a value of No for the Reschedule Inspection in Citizen Access and Cancel Inspection in Citizen
Access drop-down lists if you do not want public users to have the option of rescheduling or cancelling
inspections in ACA.

When you enable reschedule and cancel features, public users can only reschedule and cancel
inspections based on the parameters you set for each inspection type.

For a complete description of how to configure inspection calendars for Citizen Access, see Setting Up
Inspection Calendars for Public Users.

To set inspection type reschedule and cancel parameters

1. Access the Classic Administration page (Accessing Classic Administration).
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2. Choose Inspection > Inspection.

Civic Platform displays the Inspection - Search page.

3. Complete the fields below or click Submit to search all inspection group codes:

Inspection Group Code Enter the code of the inspection group that contains the inspection types for
which you want to set inspection reschedule and cancel restrictions.

Inspection Group Name Enter the name of the inspection group that contains the inspection types for
which you want to set inspection reschedule and cancel restrictions.

4. Click Submit.

Civic Platform displays the search results on the Inspection-Browse page.

5. Click the red dot in the column next to the inspection group code that contains the inspection types for
which you want to set inspection scheduling restrictions.

Civic Platform displays the Inspection - Edit page.

6. Select an option and set time values and date values for the Cancel Restriction and Reschedule
Restriction fields. For a description of these fields, see Table 172: Inspection Group Fields.

7. Click Update.

Civic Platform updates the inspection type.
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Working with Recurring and Related Inspections
You can configure a relationship between an inspection and one or more follow-up inspections. You can
create an inspection as a child inspection of a parent inspection. You can also relate inspections manually.

The recurring and related inspections functionality works together. From the inspection group code you
add and configure inspection types, specifying related inspection groups and then setting up your agency’s
requirements to automate the scheduling of required inspections.

This section provides instructions for scheduling related inspections, based on the status of a previous
inspection. Related inspections can be a follow-up or recurring inspections, based on the status of the
original inspection type.

The first set of steps, from through enable you to configure statuses for inspection types so that
when an inspection achieves that status, the inspection type automatically reschedules as a recurring
annual inspection in one year. You set this type of recurring inspection by using the Next Recurring
Inspection option in the Related Type field. For example, each year a restaurant is subject to annual food
establishment inspections to ensure continued compliance with city ordinances.

If an inspection attains a negative status (e.g., Denied), you can use this procedure (start with ) to create
a related follow-up inspection. You might, for example, apply a follow-up inspection to occur in 15 days
after the failure. Doing so gives the restaurant owner time to make any corrections and it can help ensure
availability in the inspector’s schedule. You set this type of recurring inspection by using the Status of
Denied with the Follow-up Inspection option in the Related Type field.

To allow users to modify relationships, see Relating Inspections.

To schedule a recurring inspection when it attains a certain status

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

3. Search for the inspection group that you want.

4. Click the red dot for the Inspection Group Code link corresponding to the inspection type you want to
modify. The Inspection - Edit field descriptions are in Table 172: Inspection Group Fields.

Civic Platform displays the Inspection - Edit screen.
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5. Locate the Inspection Type. In this example, to automatically schedule the annual food establishment
compliance inspection, click the Configuration button at the far right side of the page.

The Configuration drop-down menu displays.

6. Select the Recurrence & Relationship Setting option.

You can use disciplines as filtering criteria for automatic inspection scheduling. To use the Inspection
Disciplines option, see Assigning Inspection Disciplines. For more information on automatic inspection
scheduling, see Setting Up Automatic Inspection Scheduling.

The Inspection Recurrence & Relationship Setting page displays.

7. Click the Add Inspection Type link.

The Add Related Inspection Type window displays.
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8. Specify these required fields for the type of inspection: Status, Inspection Group, and Inspection
Type. To continue with this example to automatically schedule the annual food establishment
compliance inspection, set the Status to Approved and specify an appropriate Inspection Group and
Inspection Type.

To bypass any Status on an inspection, select Not Relevant to Status. This means that no matter
what the inspection status is, Civic Platform sets the inspection to the Next Recurring Inspection, and it
initiates upon the creation of the next application.

9. Click Continue.

The Add Related Inspection Type window displays other fields.

10.Specify these required fields: Related Type, Interval, and Schedule # of Days Earlier. To continue
with this example to automatically schedule the annual food establishment compliance inspection,
set the Related Type to the Next Recurring Inspection option. Doing so automatically sets when the
inspection type is Initiated From which is the Completion Date of the Previous Inspection. You must
enter the Interval using either 365 Days or 1 Year. You also need to enter the number of days prior
to the interval that Civic Platform can schedule the inspection. Enter this number in the Schedule # of
Days Earlier field.

11.Click Finish.

The inspection type displays under the Status - Approved list.
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12.Next, configure the follow-up inspection if the inspection achieves a status of Fail. Doing so automates
the scheduling for the annual building structure inspection.

13.Click the Add Inspection Type link.

The Add Related Inspection Type window displays.

14.Specify these required fields for the type of inspection: Status, Inspection Group, and Inspection
Type. To continue with this example to automatically schedule the annual food establishment
compliance inspection, set the Status to Denied and specify an appropriate Inspection Group and
Inspection Type.

15.Click Continue.

The Add Related Inspection Type displays.

16.Specify these required fields: Related Type, Follow Up Method, and the# of Days Later. To continue
with this example to automatically schedule the annual food establishment compliance inspection,
set the Related Type to the Follow-up Inspection option. Doing so sets the Follow-up Method to
automatically. Enter 15 days for the number in the # of Days Later field. Doing so means Civic Platform
automatically schedules the follow-up inspection for 15 days after the inspection status reaches Denied.

Alternately, you can specify Prompt in the Follow-up Method field to require the user to acknowledge
the rescheduling.
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17.Click Finish.

Civic Platform displays all recurring and related inspection settings.

18.Click Submit.

Civic Platform saves all related inspection type data.

Relating Inspections
You can relate an inspection manually to another inspection in a relationship. When a daily user accesses
the Inspection Detail page the parent with child inspections displays caret signs next to it, like so: >>. In the
Related Inspections tab it lists a hierarchy with parent and related child inspections that provide a visual
of related inspections and reportable linkage between inspections to allow you to differentiate the parent
inspection from its follow-up inspections.

A menu item populates as shown in Figure 77: Schedule Related Inspections Menu Option.

Figure 77: Schedule Related Inspections Menu Option

Configuring Multiple Inspection Scheduling
Civic Platform provides a way for your agency to allow public users to schedule or re-schedule inspections.
When your agency implements Citizen Access, you can provide public users with the ability to request/
schedule multiple or repeat inspections. For example, a contractor might require multiple concrete pours
for a large project and thus require numerous concrete inspections. This feature allows the contractor to
schedule multiple concrete inspections for their project based on their pour days.

To implement this feature, you must set the Citizen Access Multi-Inspection Schedule field to Yes for
an Inspection type. See Table 172: Inspection Group Fields. Then, you must enable multiple inspection
scheduling for a module in Citizen Access Configuration on the Module Settings page. If you do not enable



 | Part 8: Land Management | 854

multiple inspection scheduling for a module in Citizen Access, public users do not have the ability to
schedule multiple inspections for an inspection type, even if the configuration in Civic Platform allows for
it. For complete configuration instructions for this feature, see the “Managing Inspections” section in the
Citizen Access Administrator Guide.

Understanding Same Day Next Day Inspection Scheduling
You can specify how public users schedule inspections online by configuring inspection calendars. Civic
Platform provides different inspection scheduling configuration options, including same day and next
business day scheduling. This section describes the steps necessary to configure inspection scheduling for
Citizen Access.

The configuration that you complete in Civic Platform affects the inspection scheduling options in Citizen
Access. In Civic Platform, you set the scheduling options for each inspection type. For example, if want
to give public users the option of choosing the date and time on which they schedule an inspection, then
set the calendar display by configuring the dates and times from which public users can choose. You can
also configure inspection scheduling so that public users can only choose from three inspection scheduling
options: Same Day, Next Business Day, and Next Available Day. When public users choose one of these
three scheduling options, Civic Platform schedules the inspection on the date and time that best match the
selected option.

Scheduling Requests and Pending Inspections
Civic Platform provides the ability to manage inspection scheduling for public users and user groups. You
do this through the request/pending inspection feature for Civic Platform and Citizen Access. This feature
allows a public user to request an inspection date. Civic Platform does not set the appointment, but it sets
a flag on the inspection and assigns a pending status to it until the agency approves the inspection date
and time.

For example, a public user logs into their Citizen Access account and requests a plumbing inspection
on September 6th during AM hours. After the public user submits their request through Citizen Access,
the inspection maintains a pending status until the agency approves the inspection appointment by using
the inspection calendar. Upon approval, Civic Platform uses EMSE to send an email confirmation of the
inspection appointment to the public user.

Users can view which inspections are in the pending status at any time by filtering the Inspection Calendar
to show Requested Pending Inspections. You can view approved inspections in the inspection list by
selecting All Inspections in the Calendar Show drop-down list.

Administrators must do the following configuration tasks in Civic Platform to implement the request and
pending feature. First, you must pre-define the inspection types and must set the scheduling parameters.
Then, you must navigate to the inspection type tab in the inspection calendar administrator portlet and
choose the Request Only - Pending option from the Schedule Inspection in Citizen Access drop-down
list for applicable inspection types. This configuration changes the Schedule link to a Request link for the
applicable inspection type in the public user’s inspection list in Citizen Access. Then, you must navigate to
the Content Customize portlet to define the emails to use for the request and pending feature.

Administrators must also can navigate to a Module in Citizen Access Configuration and customize the
content or labels to use with the modular inspection scheduling web page. For additional information on
customizing web pages and complete inspection scheduling configuration details for Citizen Access, refer
to the Citizen Access Administrator Guide.

To configure request only and pending inspections

1. As a prerequisite, verify that you have correctly defined each inspection type and inspection schedule
parameter. For information on how to configure inspection types, refer to Establishing Inspection Types.

2. Configure Request Only-Pending scheduling option for Inspection Types in the Inspection Calendar.

a. Click the Admin primary tab.
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b. Navigate to the inspection calendar portlet and click the Inspection Type tab.

Civic Platform displays the inspection calendar details.

c. Choose the Request Only - Pending option from the Schedule Inspection in Accela
CitizenAccess drop-down list for those inspections to which you want to apply the request only
feature.

d. Click Submit.

3. Customize related emails.

a. Click the Admin primary tab.

b. Navigate to the Content Customize portlet.

Civic Platform displays the Content Customize portlet.

c. Configure the email sent to the public user after they request an inspection online.

ACA_EMAIL_INSPECTION_STATUS_CHANGE_CONTENT

ACA_EMAIL_INSPECTION_STATUS_CHANGE_SUBJECT

d. Configure the email sent to the public user after the agency approves the inspection appointment in
Civic Platform.

AA_EMAIL_INSPECTION_STATUS_CHANGE_CONTENT

AA_EMAIL_INSPECTION_STATUS_CHANGE_SUBJECT

4. Customize the labels and text on the Schedule an Inspection web page for a module in Citizen Access
Configuration. For steps, refer to “Working With Web Pages” in the Citizen Access Administrator Guide.

Working with Inspection Result Groups
Inspection result groups let you set up predefined results for inspections. In an inspection result group, you
can divide inspection results into several ranges based on the inspection scores and the number of major
violations. You can then map each range to an inspection status of “result” in the inspection result group.

Topics

• Creating an Inspection Results Group

• Adding a Result to an Inspection Results Group
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• Editing an Inspection Results Group

Creating an Inspection Result Group
You can add inspection result groups to the groups you already have. When you create an inspection
result group you must add at least one result. Otherwise, Civic Platform does not save the new inspection
result group.

To create an inspection result group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection Result Group.

3. Click Add.

4. Type in the Group Name that you want to add.

5. Click Save.

Civic Platform displays the Inspection Results group - Edit screen.

6. Add results to the new results group as needed. For instructions, see Adding a Result to an Inspection
Result Group.

Adding a Result to an Inspection Result Group
After you create an inspection result group, you can add more results to that group.

To add a result to an inspection result group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection Result Group.

3. Click Edit next to the group you want.

4. Click Add.

5. Type in the Result that you want to add.

6. Click Save.

7. Add more results by repeating step 3 as needed.

8. Click Update.

Editing an Inspection Result Group
After you set up an inspection result group, you can edit its results.

To edit an inspection result group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection Result Group.

3. Click Edit next to the group you want.

4. To delete an inspection result, click its Delete button.

5. To edit an inspection result, complete the fields Table 173: Inspection Result Fields.
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6. Click Update.

Table 173: Inspection Result Fields

Result Enter the name of the inspection result.

Display Order Enter a number to determine the position of the inspection result within a list of results.
For example, if you want to display one result before another result, enter “1.”

Result Type Select the Result type from the drop-down list that you want. There are three options:
Approved, Denied and Pending.Only when a user results an inspection to an approved
or denied status, Civic Platform regards the inspection as completed.

Display in Citizen
Access

Select the option you want to display in the Food Facility Inspection Details page in
Citizen Access. ScoreThe total scores of the checklists associated with the inspection.
ResultThe inspection result. BothDisplay both the Score field and the Result fields.
NoneDo not display the Score field or the Result field.

Maximum Score
Minimum Score

Set the inspection score range that the Result maps to. If you set both the inspection
score range and the major violation range (Maximum Major Violation and Minimum
Major Violation) for a result, Civic Platform links the ranges by the AND logical
conjunction before mapping to the result.

If the score and the major violation range does not fit with any result, the inspection
result (status) displays nothing.

Maximum Major
Violation Minimum Major
Violation

Set the range of the number of major violations that the Result maps to. If you set
both the inspection score range (Maximum Score and Minimum Score) and the
major violation range for a result, Civic Platform links the ranges by the AND logical
conjunction before mapping to the result.

If the score and the major violation range do not fit with any result, the inspection result
(status) displays nothing.

Working with Inspection Grade Groups
Inspection grade groups let you set up predefined grades for inspections. In an inspection grade group,
you can divide inspection results to several ranges based on the inspection scores and the number of
major violations. You can then map each range to an inspection grade.

Topics

• Creating an Inspection Grade Group

• Adding a Grade to an Inspection Grade Group

• Editing an Inspection Grade Group

Creating an Inspection Grade Group
To create an inspection grade group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection Grade Group.

3. Click New in the Grade Group List.

4. Type in the Grade Group that you want to add, create a Grade, and complete the fields described in
Table 174: Inspection Grade Fields.

5. Click Submit.
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Civic Platform adds the new grade group to the Grade Group List.

6. Add more grades to the new grade group as needed. For instructions, see Adding a Grade to an
Inspection Grade Group.

Adding a Grade to an Inspection Grade Group
After you create an inspection grade group, you can add more grades to that group.

To add a grade to an inspection grade group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection Grade Group.

3. Click the link at the grade group name to which you want to add a grade.

Civic Platform displays the grade details of the group in the Grade List.

4. Click New.

5. Type in the Grade that you want to add. Complete the fields described in Table 174: Inspection Grade
Fields.

6. Click Submit.

7. Add more grades by repeating step 3 as needed.

Editing an Inspection Grade Group
After you set up an inspection grade group, you can edit its grades.

To edit an inspection grade group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection Grade Group.

3. Click the link of the grade group to which you want to edit.

Civic Platform displays the grade details of the group in the Grade List.

4. To delete an inspection grade, select it and click Delete.

5. To edit an inspection grade, click the grade name, and then edit the grade fields in the Grade Form. For
field descriptions of the Grade Form refer to Table 174: Inspection Grade Fields.
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6. Click Submit.

Table 174: Inspection Grade Fields

Grade Enter the name of the inspection grade.

Grade Image Click the Associate Image link to associate an image to the inspection grade.

Maximum Score
Minimum Score

Set the inspection score range that the Grade maps to. If you set both the inspection
score range and the major violation range (Upper Major Violation and Lower Major
Violation) for a grade, Civic Platform links the ranges by the AND logical conjunction
before mapping to the grade.

If the score and the major violation range do not fit with any grade, the inspection grade
displays nothing.

Maximum Major
Violation Minimum Major
Violation

Set the range of the number of major violations that the Result maps to. If you set both
the inspection score range (Upper Score and Lower Score) and the major violation
range for a grade, Civic Platform links the ranges by the AND logical conjunction before
mapping to the grade.

If the score and the major violation range does not fit with any grade, the inspection
grade displays nothing.

Managing Checklist Groups
A checklist group is a collection of checklists. You can associate a checklist group with an inspection type
or a document type, so that inspectors or document reviewers perform their inspections or review tasks
following the checklists in the checklist group.

Topics

• Creating a Checklist Group

• Editing a Checklist Group

• Removing a Checklist from a Group

Creating a Checklist Group
You first create a checklist group and then add individual checklists to the group. You must create a
checklist before you can add to a checklist group. For instructions, see Creating a Checklist. A checklist
can belong to only one checklist group.

To create a checklist group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist Group.

Civic Platform displays the Checklist Group—List window.

3. Click Add.

Civic Platform displays the Checklist Group—Add window.

4. Enter the new group name in the Group Name field.

5. Click Submit.

Civic Platform displays the Checklist Group—Edit window.

6. Click Add.
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Civic Platform displays the Add Checklist to Group window.

7. Select the checklists that you want to add to the group.

8. Click Add.

9. Update these fields:

Display Order Enables you to sort the checklists in the order you specify.

Auto Create If you enable Auto Create, if the checklist group is associated with an inspection type,
Civic Platform automatically add the checklist to inspections of the inspection type; if
the checklist group is associated with a document type, Civic Platform automatically
adds the checklist as document review checklist for documents of the document type.

10.If you made changes, click Update.

11.Click Add.

Editing a Checklist Group
You can change the checklists that appear in a group or the order in which checklists appear in a group.

To edit a checklist group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist Group.

3. Click Edit next to the name of the group you want to edit.

Civic Platform displays the Checklist Group—Edit window.

4. Update these fields:

Display Order Enables you to sort the checklists in the order you specify.

Auto Create If you enable Auto Create, if the checklist group is associated with an inspection type,
Civic Platform automatically add the checklist to inspections of the inspection type; if
the checklist group is associated with a document type, Civic Platform automatically
adds the checklist as document review checklist for documents of the document type.

5. Click Update.

Adding a Checklist to a Group
You can add additional checklists to a checklist group. You must create a checklist before you can add to
a checklist group. For instructions, see Creating a Checklist. A checklist can belong to only one checklist
group.

To add a checklist to a group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist Group.

3. Click Edit to the right of the group that you want.

Civic Platform displays the Checklist Group—Edit window.

4. Click Add.

Civic Platform displays the Add Checklist to Group window.
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5. Select the checklist that you want to add to the group.

6. Click Add.

Removing a Checklist from a Group
If you no longer want a checklist within a particular group, you can remove it, enabling you to associate a
checklist with a different group.

To remove a checklist from a group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Inspection > Checklist Group.

3. Click Edit next to the group name.

4. Click Remove next to the checklist you want to remove.

5. Click OK.

Note:

These steps remove the checklist from the current group only. You can still add the checklist to another
group. To add a checklist to another group, see Adding a Checklist to a Group.

Establishing Checklists
Topics

• Creating a Checklist

• Editing a Checklist

• Deleting a Checklist

• Working with Checklists

• Carrying Over Failed Checklist Items

Creating a Checklist
You can create checklists and add them to your system as necessary. Users can choose from any
checklists defined on your system to help them complete a certain inspection or document review. When
you add a checklist, you must set up the values you to appear in the individual checklist items. For
instructions, see Adding an Item to a Checklist.

To create a checklist

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist page.
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3. Click the Add button next to the Checklist drop down list.

Civic Platform displays the Reference Checklist—Add page.

4. Enter the name of the checklist in the Checklist Name field.

5. Click Save.

Civic Platform adds the new checklist and displays the Reference Checklist page.

6. Add one or more items. For instructions, see Adding an Item to a Checklist.

Editing a Checklist
After you create a checklist you can determine the sequence order of checklist items; add title (guide text)
for the user; set defaults for comments, statuses, and scores; and set a points threshold for inspections. To
change a checklist item, see Working with Checklists.

To edit a checklist

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist page.

3. Choose the checklist that you want from the Checklist drop-down list.

4. Update the fields for each checklist item as described in Table 175: Checklist Fields.

Table 175: Checklist Fields

Application Spec Info
Group

Select the application-specific information group you want to display for the checklist
item.

The Application Spec Info Group might not be visible, depending on the settings for the
reference checklist item. For more information, see Associating Checklist Items with
ASI Groups.

Carry Over Failed Items Select this option to indicate that you want the item to automatically appear on a new
checklist if it fails (the user results the item with a denied status). If the item fails in a
checklist for an inspection, the item is transferred to the next inspection(s) that users
schedule on the record (in either Civic Platform or Citizen Access).

If the item fails in a checklist for a document review task, the item is transferred to the
document that users resubmit.

Default Comment Enter a default comment to display in the Comment field. The Default Comment might
not be visible, depending on the settings for the reference checklist item.

Default Status Choose the default status from the drop-down list. This status appears in the status
field for any inspection or document review task that uses this checklist, and the user
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can modify it. The default status might not be visible, depending on the settings for the
reference checklist item.

Default Score Choose a default score from the drop-down list. This is a number that appears in the
score field for any inspection that uses this checklist, but the user can modify it in the
specific inspection. The default score might not be visible, depending on the settings
for the reference checklist item.

Title Enter a question or provide instructions for the user.

Major Violation/Critical
Item

Select this option if you want to display the “Major Violation” check box for the checklist
item. If users select a status for a “Major Violation/Critical Item” checklist item, Civic
Platform applies the critical score of the status for the checklist item.

If users select a status for a non-“Major Violation/Critical Item” checklist item, Civic
Platform applies the non-critical score of the status for the checklist item.

Civic Platform automatically assigns the “Major Violation” status for the checklist item,
only when you select a “Major Violation” status for a “Major Violation/Critical Item”
checklist item.

Max Points If desired, enter the maximum number of points allowed before this type of inspection
cannot pass.

Order Enter the sequence in which Civic Platform should display the different checklist items.
If multiple items share the same order number, Civic Platform reorders duplicate
sequence numbers by increasing duplicates by one.

Required Select this option if you want the checklist item to be required in the checklist.

During inspections, inspectors must specify the status and score for every required
checklist item in a checklist to complete the checklist.

During document reviews, reviewers must complete all the required checklist items in a
document review task (that is, setting their statuses to an Approved result type) before
updating the task to a status that the Standard Choice for the document review status
group specifies as validation required.

Deleting a Checklist
If you no longer want users to follow a certain checklist when recording inspection or document review
results, you can delete it from your system.

To delete a checklist

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist window.

3. Use the Checklist drop-down list to choose the checklist that you want.

4. Click Delete.

Civic Platform displays a confirmation.

5. Click OK.

Working with Checklists
Topics

• Adding an Item to a Checklist

• Editing an Item on a Checklist
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• Deleting an Item from a Checklist

• Associating Checklist Items with ASI Groups

• Managing Checklist Status Groups

Adding an Item to a Checklist
After you create a checklist, you should add at least one checklist item. At any time, you can add and
delete checklist items.

To add an item to a checklist

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist page.

3. Use the Checklist drop-down list to choose the checklist that you want to work with.

4. Click the Add button that appears to the right of the Checklist Items section.

Civic Platform displays the Reference Checklist Item—Add page.

5. Complete the fields as described in Table 176: Checklist Item Fields.

6. Click Save.

Table 176: Checklist Item Fields

Title Enter the details about the item as you want it to display to users. You can use this
text to ask a question, or provide instructions. For example, you can ask the inspector
whether the builder used approved building materials.

Status Group Select the status group, or click Add or Edit. to choose the values that users see in a
status drop-down list. You can choose a group of statuses from the drop-down list, edit
the list to meet your needs, or add a new group of selections that users can choose
from. For instructions, see Creating a Status Group.

Status Visible Select this option if you want the status drop-down list visible.
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Score Visible Select this option if you want the score value visible.

Comment Visible Select this option if you want the comment box with your comments visible.

Max Points Visible Select this option if you want the Max Points column to display on the Admin Checklist
Item and Daily Checklist Detail pages. If you select this option, you must also select the
Score Visible option.

Application Spec Info
Group Visible

Select this option if you want the application-specific information group fields to display
on the Admin Checklist Item and Daily Checklist Detail pages. For more information,
see Associating Checklist Items with ASI Groups.

Editing an Item on a Checklist
If you want to change one of the items in a checklist, you can edit it. To change the checklist itself, see
Editing a Checklist Group.

To edit an item from on a checklist

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist page.

3. Use the Checklist drop-down list to choose the checklist that you want.

4. Click Edit next to the item you want.

Civic Platform displays the Reference Checklist Item—Add page.

5. Complete the fields as described in Table 176: Checklist Item Fields.

6. Click Save.

Deleting an Item from a Checklist
If you no longer want to include a certain item on a checklist, you can delete it. When recording inspection
results, users are no longer able to see any item that you delete.

To delete an item from a checklist
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1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist page.

3. Use the Checklist drop-down list to choose the checklist that you want.

4. Click Delete next to the checklist item that you want to delete.

Civic Platform displays a confirmation.

5. Click OK.

Associating Checklist Items with ASI Groups
Administrators can customize checklist item templates by associating the item with an application-specific
information (ASI) group. Checklist items are the actual specifications on a checklist. For example, an
Electrical checklist might contain items necessary for the inspector to pass off, such as Required Lighting
Outlets, Required Branch Circuits, and Ground Fault Protection. When you attach an ASI group to a
checklist item, the information determined within the ASI displays on the checklist as additional fields.

With this feature, you can use ASI and ASI table definitions for checklist item options such as fields, lists,
and check boxes. The ASI adds a single line to the checklist item, and ASI tables add multiple options.
This enables you to associate the ASI group Code to a record type or checklist item. You can arrange
these ASI items according to your agency's preferences with the Form Layout Editor.

To associate a checklist item template to an ASI group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist page.

3. Locate the existing checklist that contains the item you want to associate to the ASI group, or create
a new checklist. For example, you want to associate the Required Lighting Outlets with an ASI group
that contains the option to enter the number of lighting outlets currently installed and the total number of
outlets.

For instructions on creating a new checklist, see Creating a Checklist.

Civic Platform displays the selected checklist.

4. Add a new or edit an existing checklist item by clicking the Add button or the Edit button next to the
Checklist Item.

Civic Platform displays the Reference Checklist Item - Add or Reference Checklist Item - Edit page.

5. Select Application Spec Info Group Visible and click Save. Update the other fields as necessary.

For a description of the fields, see Table 176: Checklist Item Fields.

Civic Platform displays an Application Spec Info Group field next to the checklist item on the Reference
Checklist page.
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6. Click Search to locate the ASI group you want to associate with the checklist item template.

Note:

If Civic Platform displays an application-specific information group in the field, you cannot search for
another unless you delete the current ASI group.

Civic Platform displays an Application Specific Info - Browse screen.

7. Click Select next to the ASI group you want to associate with the checklist item.

Civic Platform displays the ASI group in the Application Spec Info Group field.

8. Edit the ASI group as necessary.

For instructions on adding an ASI subgroup to the Application-Specific Information group, or adding
or editing the fields within the ASI subgroup, see Defining Custom Fields (Application Specific
Information).

9. Click Save.

Managing Checklist Status Groups
Checklist status groups allow you to have more than one set of status values for users to choose from
when they complete a checklist. You can set up any number of statuses and group them together.

The status is like a disposition, or result, for a particular checklist item. You can assign scores to statuses.
When users select a status for a checklist item, the score of the status automatically fills in the score of the
checklist item. You can set a status as a major violation. When users select a “Major Violation” status for a
“Major Violation/Critical Item” checklist item, the number of major violations in an inspection increments by
1.
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After you create a checklist status group, you can associate it with a particular checklist item. For
instructions, see Associating a Status Group to a Checklist Item.

Topics

• Creating a Status Group

• Associating a Status Group to a Checklist Item

• Editing a Status Group for a Checklist Item

Creating a Status Group
To associate a status group with a checklist item, you must first create the status group. You can create
more than one status group for any checklist item, but you can associate only one status group with a
checklist item at any one time.

You can reuse checklist item status groups, so create an easily identifiable name. For example, you might
name a checklist item status group YESNO if the options are “yes” and “no.”

To create a status group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist window.

3. Use the Checklist drop-down list to choose the checklist that you want.

4. Click Edit next to the item you want.

Civic Platform displays the Reference Checklist Item—Edit window.

5. Click the Add button next to the Status Group drop-down list.

Civic Platform displays the Checklist Item Status Group—Add page.

6. Enter the Status Group Name that you want.

7. Click Save.

Civic Platform displays the Checklist Item Status Group—Edit page.
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8. Click Add.

Civic Platform displays the Add Status to Checklist Item Status Group page.

9. Enter the name of the new status in the Status field.

10.Click Save.

Civic Platform displays the Checklist Item Status Group—Edit window.

11.Complete the fields as described in Table 177: Checklist Item Status Fields.

12.Click Save.

13.Click Update.

14.Click Cancel to return to the Edit window.

Table 177: Checklist Item Status Fields

Critical Score Enter the critical score for the status. If a checklist item is a “Major Violation/Critical
Item” in the reference checklist, when users select a status for the checklist item, the
critical score of the status automatically fills in the score of the checklist item.

Display Order Enter a number to indicate the position of this status within the list.

LHS Select this option to designate the checklist item as LHS (Life/Health/Safety). For LHS-
type items, the maximum point value becomes the default score. Inspectors can edit
the number.

Major Violation Specify whether or not a status is major violation.

If a status is a major violation, when users select the status for a “Major Violation/
Critical Item” checklist item, Civic Platform automatically selects the “Major Violation”
check box for the checklist item.

Non-Critical Score Enter the non-critical score for the status. If a checklist item is not a “Major Violation/
Critical Item” in the reference checklist, when users select a status for the checklist
item, the non-critical score of the status automatically fills in the score of the checklist
item.
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Result Type There are three result types:Approved: Approves (passes) the checklist item.Denied:
Denies (fails) the checklist item.Informational: Indicates that the checklist items do not
need a status of approved or denied, but the agency wants to collect information in the
checklist for that inspection.

Status Enter the name of the status. What you enter here displays as a choice in the drop-
down list of statuses for this checklist item. Users can choose this status from a list
of values when completing a checklist. For more information, see “Completing a
Checklist” in the Accela Civic Platform User Guide.

Associating a Status Group to a Checklist Item
If you want users to be able to choose from a list of statuses for a checklist item when completing a
checklist, you can add a status group and associate it to a checklist item.

Before you begin, you must create a checklist item status group. For instructions, see Creating a Status
Group.

To associate a status group with a checklist item

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist window.

3. Use the Checklist drop-down list to choose the checklist that you want.

4. Click Edit next to the item you want.

Civic Platform displays the Reference Checklist Item—Edit window.

5. Choose the Status group that you want from the Status Group drop down list.

6. Click Save.

Editing a Status Group for a Checklist Item
You can edit the values in a status group.

To edit a status group for a checklist item

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Checklist.

Civic Platform displays the Reference Checklist window.

3. Use the Checklist drop-down list to choose the checklist that you want.

4. Click Edit next to the item you want.

Civic Platform displays the Reference Checklist Item—Edit window.
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5. Click Edit next to the Status Group drop down list.

Civic Platform displays the Checklist Item Status Group—Edit window.

6. Update the fields as described in Table 177: Checklist Item Status Fields.

7. If you want to add a status, click Add.

8. If you want to delete a status, click Delete next to the value you want to delete, then click OK.

9. Click Update.

10.Click Cancel to return to the Edit window.

Carrying Over Failed Checklist Items
If you enable the failed checklist item carry-over feature for an inspection type, Civic Platform or Citizen
Access carries over the failed checklist items from an inspection to the subsequent inspection (or
inspections) that users schedule in the same record, until all the failed items are resolved.

To enable the failed checklist item carry-over for an inspection type

1. Go to the Inspection - Edit page, and set the “Capture and carry over failed checklist items” option of
the target inspection type to Auto or Auto-All. If you set it to Prompt, the carry-over feature works in
Civic Platform and not in Citizen Access. For more information, see Editing an Inspection Type.

2. Go to the Inspection Results Group - Edit page of the result group which is associated with the target
inspection type, and set one or more results with the Result Type as Approved or Denied. For more
information, see Adding a Result to an Inspection Result Group.

3. Go to the Reference Checklist page, select the checklist which is associated with the target inspection
type, and mark the Carry Over Failed Items check box for one or more checklist items in the checklist.
For more information, see Editing a Checklist.

4. Open the checklist item status group edit page, and create one or more statuses with the Result Type
as Denied. For more information, see Editing a Status Group for a Checklist Item.
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Assigning Inspection Categories
You can associate an inspection type with one or more inspection categories. Locate the Inspection Group
Code and click the Configuration button, and select Inspection Categories option from the drop-down
menu. Following are complete instructions.

To assign an inspection type to one or several inspection categories

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

3. Search for the inspection group that you want.

For instructions, see Searching for an Inspection Group.

4. Click the red dot for the Inspection Group Code link corresponding to the inspection type you want to
modify.

See Table 172: Inspection Group Fields for complete field descriptions.

Civic Platform displays the Inspection - Edit screen.

5. Click the Configuration button. The Configuration button is at the far right side of the page.

The Configuration drop-down menu displays.

6. Click the Inspection Categories option.

Civic Platform displays the Inspection Type - Categories List.

7. Click Look Up.

Civic Platform displays the Categories Name and Description fields.

8. Enter the name in the Category field and click Submit.

Civic Platform displays the Categories Names that match.

9. Select the inspection category to associate with the selected Inspection Type.

10.Click Select.

Civic Platform associates the Inspection Type with the Category name.

Configuring Inspection Route Sheets
You can provide inspectors with the ability to create inspection route sheets so they can efficiently
plan inspections. This feature helps inspectors minimize the time and distance they travel to complete
inspections, which enables them to map their route with maximum efficiency for their business objectives.

For example, inspectors can minimize travel distance using the Optimized by Distance option, and can
minimize travel time using the Optimized by Time option.

Another example is that inspectors can click the Order By button and select a routing type from the drop-
down menu to optimize the inspection route by choice of routing type such as walking, driving, and public
transit. Before inspectors can have this feature, you must integrate a third-party route optimizer with Civic
Platform. Civic Platform sends requests to this route optimizer and the optimizer returns the optimized
route to Civic Platform. Civic Platform then updates the sequence of the inspections in a route sheet
accordingly.

To configure inspection route sheet functionality, you must configure the corresponding Function
Identifications (FIDs) and Standard Choices. For more information, see “Planning Inspection Route Sheets”
in the Land Management chapter of the Civic Platform Configuration Reference.
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This section provides you with instructions about integrating a third-party route optimizer. You can integrate
a third-party route optimizer with Civic Platform with either of these approaches:

• JAR Package Integration

• REST API Integration

JAR Package Integration
To integrate a third party routing optimizer using the JAR Package approach

1. Write a class that implements the following interface:

com.accela.aa.routeoptimize.RouteOptimizer

• Method:

optimizeRoute

• Description:

List<String> optimizeRoute(TravelMode travelMode, Set<String> waypoints,
 String startPoint, String endPoint) throws RouteOptimizeException

• Parameters:

travelMode The parameter specifies the mode of travel for the route. The possible values
are Driving, Walking, and Public Transit.

waypoints The parameter specifies a set of waypoints.

startPoint The parameter specifies the start location of a route.

endPoint The parameter specifies the end location of a route.

2. Package your class into a JAR file.

3. Place the JAR file under the Civic Platform system classpath.

4. Configure Standard Choice: ROUTE_OPTIMIZER_PROVIDER.

For more information, see the Standard Choice listing in the Accela Civic Platform Configuration
Reference.

REST API Integration
To integrate a third party routing optimizer using the REST API approach

1. Develop a route optimizing REST API.

• Parameters:

mode The parameter specifies the mode of travel for the route. The possible values
are driving, walking, and transit.

origin The parameter specifies the start location of a route.

destination The parameter specifies the end location of a route.

waypoints The parameter specifies a set of waypoints, separated by a vertical bar: |

• Response:
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Success Result The success result contains a set of waypoints in an optimized order, separated
by a vertical bar: |

Error Message error: + error messageFor example, error: cannot calculate route.

• Example:

Request URL http://www.bridgeview.gov/restful/route?
mode=driving&origin=O&destination=H&waypoints=A|B|C|D

Response Success response: “A|C|D|B”Error response: error: cannot calculate route

2. Configure Standard Choice: ROUTE_OPTIMIZER_PROVIDER.

For more information, see the Standard Choice listing in the Accela Civic Platform Configuration
Reference.

Managing Inspection Flows and Milestones
Topics

• Managing Inspection Flow Processes

• Managing Inspection Milestones

Managing Inspection Flow Processes
Topics

• Adding an Inspection Flow Process

• Reviewing an Inspection Flow Process and Status

Adding an Inspection Flow Process
Each Inspection Group Code defines its own inspection flow process, which lists a series of tasks you
must complete before issuing a certain type of permit or license. As necessary, you can set up additional
inspection flow processes at any time. You can also add or delete tasks from a process at any time.
However, as the inspection administrator, you must be certain to consider the effects when changing the
inspection flow process after a specific inspection flow task has started.

To add an inspection flow process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

Civic Platform displays the Inspection - Search screen.

3. Complete one of these options:

• Search for an inspection group code and then click Submit.

Civic Platform displays the Inspection - Browse screen.

1. Click Search or scroll through the list.

2. Click the red dot of the inspection group code you want.

Civic Platform displays the Inspection - Edit screen.
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• Create a new inspection group code and then click Add. For further details on this task, refer to
Adding an Inspection Type.

Civic Platform displays the Inspection Group-Add window.

1. Enter a name for the Inspection Group Code. The maximum number of characters for a group
code name is twelve. This code is not case sensitive. You can use any combination of upper and
lowercase characters.

2. Click Submit.

Refer to Table 172: Inspection Group Fields for complete field descriptions.

Civic Platform displays the Inspection - Edit screen.

4. Update any of the Inspection - Edit fields, specifying Yes in the Flow Enable drop-down list if the
Inspection Type belongs in the inspection flow process.

Refer to Table 172: Inspection Group Fields for complete field descriptions.

To add inspection types, see Establishing Inspection Types.

5. Click Update.

6. Click Inspection Flow.

Civic Platform displays the Inspection Flow Process - Edit screen.

7. Complete the fields.

Civic Platform supplies the default inspection flow process. Update the fields for each task in the
inspection flow process. For a description of fields, see Table 178: Inspection Flow Process Fields.

Note:

Click the yellow light bulb left of the task. Use the Task Flow Assistant to help you set up phase and next
numbers.

8. Click Add to add other inspection types to the inspection flow.
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9. Click Update.

Table 178: Inspection Flow Process Fields

Auto Reschedule Choose “Yes” if you want to automatically reschedule the inspection when the previous
inspection status attains Approved status.

Diagram View To obtain a visual reference of the inspection flow process, the diagram view link
displays a flow diagram of the inspection flow process. See Viewing a Process
Diagram

Delete To remove the Inspection Name from the inspection flow process. Note: If there is only
one Inspection Name in the flow process and you delete it, you also delete the entire
flow process from Civic Platform.

Department/Staff Use the Department button to search for the department that is responsible for the
task.

To search for a specific staff member, complete only the Staff field. Civic Platform
automatically populates the Department field with the corresponding department and
Staff information.

Inspection Name Enter the name of the inspection task you want to display for users.

Inspection Status View Review the hierarchy of the inspection flow process set up for the inspection group
code. See Viewing Process Status.

Next # Enter the 15-digit number that identifies one or more tasks in the workflow process
that you want to activate after this task is complete. For more information about each
component of a Next number, see Designing Workflows .

Next Inspection In
Advance (Days)

The number of days before you can schedule the next inspection in the flow.

For example, if you set this field to “8” and you schedule “Initial Building Inspection” for
8 days, meaning its status does not change for 8 days, then you can schedule the next
inspection type in the flow.

Phase # Enter the 15-digit number that identifies the position of this task in the workflow process
and its relationship to other tasks. For more information about each component of a
Phase number, see Designing Workflows .

Reschedule (Days) The number of days before you can schedule the inspection after it enters a pending
status. For example, if you set this field to 5, and the “Sewer Inspection” status
changes to Pending, you cannot reschedule this inspection until 5 days pass.

Staff Use the Staff button to search for a department and a staff member that is responsible
for the task.

Status Configuration Specify the status that the inspection type must obtain in the flow process. You can
also choose to define the next step or the resulting action for the inspection after
attains this status.

Reviewing an Inspection Flow Process and Status
Topics

• Viewing a Process Diagram

• Viewing Process Status

Viewing a Process Diagram
Viewing an inspection flow process lets you see a visual representation of the process using a flowchart.
Seeing a picture of a process can help to better understand how each task relates to other tasks, and can
help you catch any errors.
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To view a process diagram

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

Civic Platform displays the Inspection - Search screen.

3. Search for the inspection group code that you want.

• Click Submit to locate all inspection group codes.

• Enter part of the inspection code and then click Submit.

4. Click the red dot that next to the inspection code you want.

5. Click the Inspection Flow button.

6. Click the Diagram View link.

Civic Platform displays the flow chart.

7. To restore the size of the window, click Restore.

8. When you finish viewing the process, click Cancel or close the view window.

Viewing Process Status
You can view the status of every task in a workflow process. The Process Statuses view, lets you see the
relationship between tasks and task statuses, and link to the Inspection Flow Process Status in Figure 78:
Inspection Flow Process Status.

Figure 78: Inspection Flow Process Status

A Process.

Current inspection group code of this hierarchy.

B Task. Inspection type in order of first to last task.

C Status. Statuses set for the task. Click a status item to change it.

D Flow Control. The resulting action of the status item. Click a status item to change the flow control.
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To view an inspection flow process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Inspection > Inspection.

Civic Platform displays the Inspection - Search screen.

3. Search for the inspection group code that you want.

• Click Submit to locate all inspection group codes.

• Enter part of the inspection code and then click Submit.

4. Click the red dot that next to the inspection code you want.

5. Click the Inspection Flow button.

Civic Platform displays the Inspection Flow Process - Edit screen.

6. Click the Inspection Status View link.

Civic Platform displays the Inspection Flow Process Status - Edit screen.

7. Click the plus sign (+) to expand the task.

8. Click a Status item to modify its status.

Civic Platform displays the Inspection Flow Status - Edit screen.

9. Set the Inspection Status for the task, and modify the Resulting Action (in the flow control column) as
needed.

10.Click Save.
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Managing Inspection Milestones
After the supervisor updates the inspection milestone values in the application, Civic Platform re-generates
the inspection flow data based on the new inspection milestone values. For more information about
editing the inspection milestones for an application, see “Editing Inspection Milestones” in the Accela Civic
Platform User Guide.

To configure Inspection Milestones

Note:

You receive a warning message when you update the process configuration type. For example, if you
change the existing Inspection Flow to an Inspection Milestone flow, a confirmation displays, “Do you really
want to change the selection of “Configure By”? Civic Platform deletes the configured inspection flow and
related result status configuration information.”

1. Create or edit the inspection milestone flow.

a. Locate the Inspection Group Code for the inspection group to which you want to add milestones, or
add a new Inspection Group.

For information about searching for, editing, or adding an inspection group, see Managing Inspection
Groups.

Civic Platform displays the Inspection - Edit page.

b. Select the Inspection Milestone option and click Update.

c. Click the Inspection Flow button.

Civic Platform displays the Inspection Flow Process - Edit page.

d. Enter a Milestone value for each inspection type.

e. Click Update.
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Note:

Each Milestone listed on this page must have a value. To remove an inspection type, click Delete. To
add an inspection type, click Add.

f. Click Diagram View to view the flow order.

Civic Platform displays the inspection milestone flow.

2. Associate the inspection group code with the desired record type.

For information about adding the inspection group code to the application type, see Creating and
Configuring Records.
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Part 9: Asset Management
Civic Platform provides functions specific to an asset management solution.

Related Links

Attributes and Templates

Asset Types

Asset Condition Assessments

Setting Up a Parts Inventory

Configuring Work Order Templates

Attaching Assets to Records

Attributes and Templates
Attributes are characteristics of assets, structures, and establishments. When you define attributes in
your system, you create fields that can display in records to track information. Attributes enable you to
customize your asset, structure, and establishment records.

For instance, if your agency owns complex structures that contain both private residences and commercial
establishments, you can define attributes for the apartments such as keyed or code entry, available
parking, and elevators. For the commercial establishments, you can define attributes such as type of
cuisine, capacity, and number of employees. Some attributes the two types of establishment might share
are number of rooms and dimensions.

Define as many attributes as your agency requires. You can use each attribute in multiple templates.
You then use templates to create asset, structure, and establishment types, and you use these types to
create records. The asset, structure, or establishment records then contain fields that correspond to the
attributes included in their templates. As your agency adds new assets and asset types, you might need
to create new attributes for your system. You might also need to add attributes to existing asset templates
to accommodate the need for more information. To create an asset directly from an Asset Template, see
Creating a Template.

Click a topic title below for full details.

Related Links

Working with Attributes

Working with Templates

Working with Attribute Tables

Managing Associated Attributes

Working with Attributes
For information on working with asset types, see Asset Types. For information on working with structure
and establishment types, see Structures and Establishments.

Topics

• Creating an Attribute
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• Searching for an Attribute

• Editing an Attribute

• Deleting an Attribute

• Defining Attribute Values

Creating an Attribute
To create an attribute

1. Access the Structures & Establishments Attribute portlet (Navigating to the Setup Portlet) or the Assets
Attribute portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the Attribute Detail entry form to create an attribute.

3. Complete the required fields and other fields as described in Table 179: Attribute Fields.

Note:

If you select Yes from the Is Dropdown List field, you must define the attribute values for the item. You
define attribute values after clicking Submit for the attribute. The attribute values you define display in
a drop‑down list when the user creates an asset, structure, or establishment with this attribute type. For
more information about defining attribute values, see Defining Attribute Values.

4. Click Submit.

Civic Platform adds the attribute details.

Table 179: Attribute Fields

Attribute Group Use this field to organize the attributes. Choose a group for the attribute from the
drop-down list.

Attribute Label Enter the label of the attribute the user sees when adding or editing an asset,
structure, or establishment.

The label is what the user sees on the Asset, Structure, or Establishment Detail
form. This identifier need not be unique for all attributes. For example, you can
have an attribute called “District” for an asset, but different assets have different
districts. You can create multiple district attributes, for example DistrictWater and
DistrictPark, but give them all the same label.

Attribute Length Enter the number of characters the attribute field allows.

Attribute Name The attribute name is a unique name for the attribute. This name is only for
administrative organization, it does not display to users.

Default Value Set a default value for the attribute. When a user creates an asset, structure, or
establishment that includes this value or attribute, the field has this default value,
making the user experience more efficient. To apply a date, click the date picker.

Description Enter a description for the attribute.

Display Color This field is currently active.

Is Dropdown List Select Yes if you want the attribute to have a drop-down list providing specific
values for the user. These values display to the user when they create an asset
with this attribute.

Searchable Flag Set an attribute searchable flag to “Yes” to display the field when a user begins
a search for an asset, structure, or establishment. When searching, the search
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form displays the appropriate attributes when the user selects a Group and a
Type.

Unit Type Use the drop-down list to identify the unit type for the attribute such as dollars,
feet, hours, miles, and yards.

Use Shared Drop-down Lists Select this option to associate shared drop-down lists with an asset attribute.
When you select this option, a search field enables you to search for existing
shared drop-down lists. If you search for a shared drop-down list that does not
match any existing shared drop-down lists, then the Shared Drop-down List
Search page opens. Use this page to search for existing shared drop-down lists.
If you search for a shared drop-down list that matches one existing shared drop-
down list, then the existing shared drop-down list displays on the Attribute form.

If you search for a shared drop-down list that matches multiple existing shared
drop-down lists, then the Shared Drop-down List Select page opens and you can
select the desired drop-down list.

Value Data Type Use the drop-down list to identify the data value for the attribute such as text,
date, Y/N, number, drop-down list, text, and time.

This selection controls the behavior of the field validation on the form. For
example, if you select “date” the field displays the calendar button next to the field
and only accept valid dates.

Value Required Flag Use the drop-down list to identify whether or not the attribute is mandatory upon
entry.

Searching for an Attribute
Your agency can have thousands of attributes for the different assets, structures, and establishments your
agency manages. Before you can modify or review details about an asset, you must find it.

To search for an attribute

1. Access the Structures & Establishments Attribute portlet (Navigating to the Setup Portlet) or the Assets
Attribute portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Attribute Search page.

3. Enter any search criteria in the fields. For a description of the fields, see Table 179: Attribute Fields.

4. Click Submit.

Civic Platform displays the attributes that match your search criteria.

5. Click the link of the attribute you want to work with.

Civic Platform displays the details of the selected attribute.
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Editing an Attribute
You can edit existing attributes. You might need to change the size of the attribute’s field to accommodate
longer words, or change other elements of an attribute. For example, you might have an attribute for your
agency’s vehicles that records whether they have diesel engines or gasoline engines. As technology
advances, you can modify that attribute to include a classification for a hybrid electric engine.

To edit an attribute

1. Access the Structures & Establishments Attribute portlet (Navigating to the Setup Portlet) or the Assets
Attribute portlet (Navigating to the Setup Portlet).

2. Click the Attribute Name link for the attribute you want to edit.

Civic Platform displays the Attribute Detail portlet.

3. Make changes to any fields that display in the Attribute Detail secondary tab.

4. Click Submit to save changes.

Civic Platform saves the modifications for that attribute.

Deleting an Attribute
If you no longer need a particular attribute, you can delete it. If you include the attribute in a template, you
cannot delete it. Before you attempt to delete an attribute from your system, delete it from any templates.
To delete attributes from a template, see Deleting an Attribute Table from a Template.

To delete an attribute

1. Access the Structures & Establishments Attribute portlet (Navigating to the Setup Portlet) or the Assets
Attribute portlet (Navigating to the Setup Portlet).

2. Select each attribute you want to delete.

3. Click Delete.

Civic Platform removes the attribute.

Defining Attribute Values
Standardize attribute value options by defining a set of possible values in a drop-down list. If you create the
attribute Asset Inspection Category, you can provide the three category options of red, green, and yellow
to indicate that an asset is in good condition (green), in need of repairs (yellow), or in need of replacement
(red).

Use the attribute value secondary tab when you want to create new attribute values, view details of an
attribute value, or delete attribute values that are unnecessary.

Topics

• Creating an Attribute Table

• Deleting an Attribute Table

• Editing the Weighting Factor of an Attribute Value

Creating an Attribute Value
You might need to create attribute values to populate a drop-down list. For example, if you are creating an
attribute for inspection categories, you can create three categories of red, green, and yellow to indicate that
an asset is in good condition, in need of repairs, or in need of replacement.

To create an attribute value
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1. Find or create an attribute. For instructions see either Searching for an Attribute or Creating an
Attribute.

2. Click the Attribute Value secondary tab.

Civic Platform displays a list of existing attribute values for the attribute.

3. Click New.

Civic Platform displays the create Attribute Value form portlet.

4. Enter the Attribute Value. Attribute Value is the value that displays to the user from a drop-down list.

5. Specify a value for the Weighting Factor. See Editing the Weighting Factor of an Attribute Value.

An attribute value is a value that administrators assign to an attribute. You can give each attribute value
a weighting factor that indicates the priority or importance of the attribute value. A larger number gives
a higher priority, a smaller number is a lower priority. Users identify attribute values in the drop-down list
associated with an attribute field during creation or editing.

6. Click Submit.

Civic Platform adds the value to the attribute value list portlet.

7. Repeat through to add attribute values until the list of attribute values is complete.

Deleting an Attribute Value
If you no longer need a particular attribute value, you can delete it. For example, if you made a mistake
when creating an attribute value, you can delete the attribute value. Attributes you delete become historical
data.

To delete an attribute value

1. Find the attribute name whose values you need to delete or modify. For instructions, see Searching for
an Attribute.

If the Attribute Detail form portlet has Yes as the option in the Is Dropdown List field then the Attribute
Value tab activates.

2. Click the Attribute Value tab.

Civic Platform displays a list of existing attribute values for the attribute.

3. Select each attribute value you want to delete.

4. Click Delete.

Civic Platform removes the attribute value.

Editing the Weighting Factor of an Attribute Value
An attribute value is a value that administrators assign to an attribute. You can give each attribute value
a weighting factor that indicates the priority or importance of the attribute value. A larger number gives a
higher priority, and a smaller number is a lower priority. Users identify attribute values in the drop-down list
associated with an attribute field during asset, structure, or establishment creation or editing.

Civic Platform uses weighting factors as part of a rating formula to calculate the condition of an asset. This
helps to determine which assets need maintenance first, and which can wait. You can update the weighting
factor to change the priority of a specific attribute value. Users do not interact with the weighting factor or
the rating formula. For information on asset ratings, see Asset Condition Assessments.

For example, an inspector inspects a section of sewer line (asset) and discovers a leak (attribute). For this
agency, the leak sizes are 1/32”, 1/16”, 1/8”, 1/4”, and None (attribute values). See Table 180: Example
Leak Sizes and Weighting Factors. After the inspection, the inspector reports the size of the leak. Each
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leak size has a different weighting factor, beginning at 1 for None and ranging to 5 for 1/4”. The larger the
leak, the higher the priority. If the inspector lists the leak as 1/4”, it receives attention before a leak listed as
1/32” or None.

Table 180: Example Leak Sizes and Weighting Factors

Leak Size Weighting Factor

None 1

1/32” 2

1/16 3

1/8” 4

1/4” 5

The weighting factor is part of a rating formula that you use to prioritize which assets to take care of first or
need the most work. For more information about rating formulas, see Asset Condition Assessments. Users
do not interact with the weighting factor or the rating formula. Users can only view the attributes values in
the drop-down list. For example, an inspector views the size of the leak when viewing an asset.

To edit the weighting factor of an attribute value

1. Access the Structures & Establishments Attribute portlet (Navigating to the Setup Portlet) or the Assets
Attribute portlet (Navigating to the Setup Portlet).

2. Click the Attribute Name link you want to update.

For details on how to find an attribute, see Searching for an Attribute.

3. Click the Attribute Value tab. If you set the Is Dropdown List to Yes then the Attribute Value tab
activates. Each attribute value you define here is available for users to choose from a drop-down list.

Civic Platform displays the Attribute Value list portlet.

4. Click the link for the attribute value you want to view.

Civic Platform displays the Attribute Value detail portlet.

5. Update the Weighting Factor field.

6. Click Submit.

Civic Platform updates the Attribute Value list portlet.
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Working with Templates
For information on working with asset types, see Asset Types. For information on working with structure
and establishment types, see Structures and Establishments.

Topics

• Creating a Template

• Searching for a Template

• Editing a Template

• Deleting a Template

• Managing Template Attributes

• Managing Template Attribute Tables

Creating a Template
A template is a collection of selected attributes associated with a specific class of asset, structure, or
establishment. A template might also include a collection of selected attribute tables associated with
a specific asset class. You can attach templates to asset, structure, and establishment types, and the
records created from those types display the attribute fields contained in the template.

For example a vehicle template can have tire size, tread depth, tire pressure, engine size, and
transmission type as attributes. These fields display in any asset record created from an asset type based
on this template. For more information about creating an asset type see Asset Types. For information on
working with structure and establishment types, see Structures and Establishments.

To create a template

1. Access the Structures & Establishments Template portlet (Navigating to the Setup Portlet) or the Assets
Attribute Template portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the Create New Template portlet.

3. Complete the following fields:
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Template ID Enter the number used to identify the template.

Template Description Enter the description to identify the template.

4. Click Submit.

Civic Platform updates the Template detail portlet.

5. Click the Attributes tab.

Civic Platform displays the Attribute Template list portlet.

6. Add attributes to the template.

To add existing attributes, complete these steps:

a. Click Look Up.

Civic Platform displays the Attribute Template search page.

b. Complete any fields that display. For a description of the fields, see Attribute Fields.

c. Click Submit.

Civic Platform returns a list of attributes that match your search criteria.

d. Select any attribute(s) you want to add to the template.

e. Click Select.

Civic Platform adds the attribute(s) to the template.

7. To create new attributes for the template, see Creating an Attribute or complete these steps:

a. Click New.

Civic Platform displays the Create New Attribute page.

b. Complete these fields:

Attribute Label Enter the label of the attribute the user sees when adding or editing an asset,
structure, or establishment.

Attribute Name Enter a unique attribute name, such as Commercial Establishment Capacity.
This name only displays for administrators.

Value Data Type Use the drop-down list to identify the data value for the attribute such as text,
date, Y/N, number, drop-down list, text, and time.

c. Complete any other fields that display. For a description of the fields, see Attribute Fields.

d. Click Submit.
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Civic Platform creates the attribute and adds it to the template.

8. Add attribute tables to the template.

a. Click Look Up.

Civic Platform displays the Attribute Table search page.

b. Complete these fields:

Attribute Table Name Enter the name of the attribute table you want to find.

Description Enter a description of the attribute table you want to find.

Record Status Select the status of the attribute table you want to find.

c. Click Submit.

Civic Platform displays a list of attribute tables that match your search criteria.

d. Select the attribute table(s) you want to add to the template.

e. Click Select.

Civic Platform adds the attribute table(s) to the template, then displays a confirmation message.

Searching for a Template
Use the following procedure to search for a template. If you do not know the full name of the template, you
can perform a partial search by typing in part of the template name. For example, to find the backflow east
valve template, type backflow in to the Template ID field. Civic Platform returns all template IDs that have
“backflow” as part of the Template ID.

To search for a template

1. Access the Structures & Establishments Template portlet (Navigating to the Setup Portlet) or the Assets
Attribute Template portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Template search portlet.

3. Enter any search criteria in the fields.

4. Click Submit.

Civic Platform returns a list of templates that match the search criteria.

Editing a Template
After you create a template, you might need to update the template. For example, an agency adds lift
loaders to the bed of all trucks in the fleet. The assets need to indicate which vehicles have loaders. You
must add a loader attribute to the template so the attribute can display in the asset portlet for the user.

To edit a template

1. Access the Structures & Establishments Template portlet (Navigating to the Setup Portlet) or the Assets
Attribute Template portlet (Navigating to the Setup Portlet).

2. Click the Template ID link for the asset template you want to update.

Civic Platform displays the Template detail portlet.

3. Do any of the following:

• On the Attribute Template tab, update the template description as necessary.
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• On the Attributes tab, manage template attributes as explained in Managing Template Attributes.

• On the Attribute Tables tab, manage template attribute tables as explained in Managing Template
Attributes.

Deleting a Template
You can only delete templates that are not the basis for an asset, structure, or establishment type. For
information about creating a template, see Creating a Template.

To delete a template

1. Access the Structures & Establishments Template portlet (Navigating to the Setup Portlet) or the Assets
Attribute Template portlet (Navigating to the Setup Portlet).

2. Select the Template ID for each template you want to delete.

3. Click Delete.

Civic Platform deletes the templates and updates the Asset Template list portlet.

Managing Template Attributes
Topics

• Creating Template Attributes

• Copying Template Attributes

• Editing the Display Order of Template Attributes

Creating Template Attributes
To create template attributes

1. Access the Structures & Establishments Template portlet (Navigating to the Setup Portlet) or the Assets
Attribute Template portlet (Navigating to the Setup Portlet).

2. Click the Template ID link for the asset template you want to update.

Civic Platform displays the Template detail portlet.

3. Click the Attributes tab.

Civic Platform displays the Template Attribute list portlet.

4. Click New to add template attribute information to this template.

Civic Platform displays the Attribute Detail form portlet for the template.

5. Complete the fields you need to define the new template attribute.

6. Click Submit.

Civic Platform updates the Template detail portlet.

Copying Template Attributes
You do not need to create new attributes for every template. When you create an attribute for another
template, you can copy that attribute to any template you create.

To search and copy a template attribute
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1. Find the template from which you want to delete an attribute. For instructions, see or Creating a
Template.

2. Click the Template Attribute tab.

Civic Platform displays a list of existing attributes for the selected template.

3. Click Look Up.

Civic Platform displays the Template Attribute Search form.

4. Enter any search criteria in the fields.

5. Click Submit.

Civic Platform displays the attributes that match your search criteria.

6. Select each attribute you want to copy to the current template

7. Click Submit.

Civic Platform copies the selected attributes to the current template.

Editing Template Attributes
When you edit an attribute for a particular asset template, be aware that the attribute can have other
templates. Any changes you make to the attribute affect all templates that the attribute resides on. Be
careful that your changes do not negatively affect other templates.

To edit a template attribute

1. Find the template from which you want to delete an attribute. For instructions, see Searching for a
Template.

2. Click the Template Attribute tab.

Civic Platform displays a list of existing attributes for the selected template.

3. Click the link for the attribute you want to modify.

Civic Platform displays the attribute details.

4. Edit the necessary fields.

5. Click Submit.

Deleting an Attribute from a Template
If you want to remove an attribute from a template, you can delete it. However, Civic Platform removes
all relevant data stored in the database for asset, structure, and establishment types created using this
template when you delete an attribute.

To delete a template attribute

1. Find the template from which you want to delete an attribute. For instructions, see Searching for a
Template.

2. Click the Attributes tab.

Civic Platform displays a list of existing attributes for the selected template.

3. Select each attribute that you want to remove from the template.

4. Click Delete.
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Civic Platform displays a dialogue box informing you that deleting the attribute removes all relevant data
stored in the database for asset types using this template and asks you to confirm if you want to delete
the attribute.

5. Click OKto continue or Cancel.

If you Click OK, Civic Platform removes the selected attributes from the asset template. If you click
Cancel, Civic Platform returns to the Attributes list portlet.

Editing the Display Order of Template Attributes
Because you can use template attributes for multiple templates, you might need to order them differently
for each template. For example, suppose that you have an attribute called diameter that you use to record
the diameter of pipes, couplings, and drains. You can change the diameter attribute listed fourth for pipes,
seventh for couplings, and twelfth for drains.

In such a case, the display order field in the attributes detail are not sufficient to define the display order for
all three templates. You can override an attribute’s display order on each template.

To edit the display order of template attributes

1. Find an existing asset template or create a new one. For instructions, see Searching for a Template or
Creating a Template.

2. Click theAttributes tab.

Civic Platform displays a list of existing attributes for the selected template.

3. Locate the attribute for which you want to change the order. Scroll to the right until you find the Display
Order link.

4. Click the Display Order link.

Civic Platform displays the attribute display order form.

5. Enter the number of the order for the attribute in this particular template.

6. Click Submit.

Civic Platform overrides the attribute display order for the chosen template.

Managing Template Attribute Tables
Topics

• Associating an Attribute Table with a Template

• Deleting an Attribute Table from a Template

Associating an Attribute Table with a Template
After you create an attribute table, you can associate it with a template. This way, you can associate
multiple attributes with a template simultaneously.

For example, you might associate an attribute table named Pavement Inspection with a template named
Street Segment. When you associate the Pavement Inspection attribute table with the Street Segment
template, you also associate all the table attributes with the template. This includes the inspection date,
pavement rating, and inspection comment attributes.

You can associate each attribute table with multiple templates. Use templates to create asset, structure,
and establishment record types. When an agency user creates a new record, attributes display as fields in
the record form.

To associate an attribute table with a template
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1. Find the template from which you want to delete an attribute table. For instructions, see Searching for a
Template.

2. Click the Attribute Tables tab.

Civic Platform displays a list of existing attribute tables for the selected template.

3. Click Look Up.

Civic Platform displays the Attribute Table Lookup page.

4. Complete these fields:

Attribute Table Name Enter the name of the attribute table you want to find.

Description Enter the description of the attribute table you want to find.

Record Status Enter the status of the attribute table you want to find.

5. Click Submit.

Civic Platform displays the attribute tables that match your search criteria.

6. Select the attribute table(s) you want to associate with the template.

7. Click Select.

Civic Platform associates the selected table(s) with the template and displays a confirmation message.

Deleting an Attribute Table from a Template
You can remove the association between an attribute table and a template. When you delete an attribute
table from a template, you also delete all relevant data stored in the database for asset types created using
the associated template.

To delete an attribute table from a template

1. Find the template from which you want to delete an attribute table. For instructions, see or Creating a
Template.

2. Click the Attribute Tables tab.

Civic Platform displays a list of existing attribute tables for the selected template.

3. Select each attribute table that you want to remove from the template.

4. Click Delete.

Civic Platform displays a dialogue box informing you that deleting the attribute table removes all
relevant data stored in the database for asset types using this template and asks you to confirm if you
want to delete the attribute.

5. Click OKto continue or Cancel.

If you Click OK, Civic Platform removes the selected attribute tables from the asset template. If you
click Cancel, Civic Platform returns to the Attribute Tables list portlet.

Working with Attribute Tables
For more information on how to manage attributes collected in an attribute table, see Managing Associated
Attributes.

For more information on working with templates see Working with Templates.

Topics
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• Creating an Attribute Table

• Searching for an Attribute Table

• Editing an Attribute Table

• Deleting an Attribute Table

Creating an Attribute Table
Before you create an attribute table, decide which common attributes you want to collect in the table. When
you create an attribute table, you can associate existing attributes with the table or create new attributes.

When you create an attribute table, you identify the table name and provide a table description.

For more information on how to collect attributes in an attribute table, see Managing Associated Attributes.

To create an attribute table

1. Access the Assets Attribute Table portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the New Attribute Table page.

3. Complete these fields:

Attribute Table Name Enter a unique name to identify the attribute table, such as Pavement Inspection or
Street Light.

Description Enter a description of the attribute table.

4. Click Submit.

Civic Platform creates the attribute table and then displays a confirmation message.

Searching for an Attribute Table
You can search for and edit attribute tables as required.

To search for an attribute table

1. Access the Assets Attribute Table portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Attribute Table search page.

3. Complete these fields:

Attribute Table Name Enter the name of the attribute table you want to find.

Description Enter a description of the attribute table you want to find.

Record Status Select the status of the attribute table you want to find.

4. Click Submit.
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Civic Platform displays the attribute tables that match your search criteria.

5. Click the attribute table link you want to work with in the Attribute Table Name column.

Civic Platform displays the attribute table details.

Editing an Attribute Table
You can edit an attribute table description as required.

To edit an attribute table

1. Access the Assets Attribute Table portlet (Navigating to the Setup Portlet).

2. Find the attribute table you want to edit. For instructions on how to find an attribute table, see Searching
for an Attribute Table.

3. Click the attribute table link in the Attribute Table Name column.

Civic Platform displays the attribute table details.

4. Edit the attribute table description as required.

5. Click Submit.

Civic Platform saves the changes to the attribute table and then displays a confirmation message.

Deleting an Attribute Table
To delete an attribute table, you must first delete any associations between the attribute table and a
template. For instructions on how to delete an attribute table from a template, see Deleting an Attribute
Table from a Template.

When you delete an attribute table, Civic Platform changes the table’s record status to Inactive.

To delete an attribute table

1. Access the Assets Attribute Table portlet (Navigating to the Setup Portlet).

2. Find the attribute table you want to edit. For instructions on how to find an attribute table, see Searching
for an Attribute Table.

3. Select the attribute table you want to delete.

4. Click Delete.

Civic Platform deletes the selected attribute table and then displays a confirmation message.

Managing Associated Attributes
Attributes are characteristics of assets, structures, and establishments. When you create an attribute table,
you collect common attributes in one form.

You can associate existing attributes with an attribute table or create new attributes. When you create a
new attribute, you automatically add the attribute data to the Civic Platform database.

Topics

• Associating an Attribute with an Attribute Table

• Deleting the Association Between an Attribute and an Attribute Table
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Associating an Attribute with an Attribute Table
Populate an attribute table by associating attributes with the table. For example, you might have an
attribute table named Street Light. You could populate the table with street light attributes, such as bulb
type.

To associate an attribute with an attribute table

1. Access the Assets Attribute Table portlet (Navigating to the Setup Portlet).

2. Find the attribute table you want to associate attributes with. For instructions on how to find an attribute
table, see Searching for an Attribute Table.

3. Click the attribute table link in the Attribute Table Name column.

Civic Platform displays the attribute table details.

4. Click the Attributes tab.

Civic Platform displays a list of attributes associated with the selected table.

5. Complete one of these steps:

• To add existing attributes to the table

1. Click Look Up.

Civic Platform displays the Attribute search portlet.

2. Complete the fields that display. For a complete list of fields, see Table 179: Attribute Fields.

3. Click Submit.

Civic Platform displays a list of attributes that match your search criteria.

4. Select the attribute(s) you want to add to the table.

5. Click Select.

Civic Platform associates the attributes with the table.

• To create a new attribute for the table

1. Click New.

Civic Platform displays the Create New Attribute page.

2. Complete the fields that display. For a complete list of fields, see Table 179: Attribute Fields.

3. Click Submit.

Civic Platform creates the attribute and associates it with the attribute table.

Deleting the Association Between an Attribute and an Attribute Table
You can delete an attribute from an attribute table. When you delete an attribute from a table, you also
delete the link between the attribute table and any associated templates.
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You can recreate the association between an attribute table and a template as required. For instructions on
how to associate an attribute table with a template, see Creating a Template.

To delete the association between an attribute and an attribute table

1. Access the Assets Attribute Table portlet (Navigating to the Setup Portlet).

2. Find the attribute table you want to remove attributes from. For instructions on how to find an attribute
table, see Searching for an Attribute Table.

3. Click the attribute table link in the Attribute Table Name column.

Civic Platform displays the attribute table details.

4. Click the Attributes tab.

Civic Platform displays a list of attributes associated with the selected table.

5. Select the attribute(s) that you want to remove from the attribute table.

6. Click Delete.

Civic Platform displays a message informing you that deleting the attribute removes all relevant data for
templates that use this table and asks you to confirm if you want to delete the attribute.

7. Click OK to continue or Cancel.

If you Click OK, Civic Platform removes the selected attributes from the attribute table. If you click
Cancel, Civic Platform returns to the Attributes list portlet.

Asset Types
Asset types are categories used to group assets together. Each asset type has a set of standard attributes
that provide basic information about the asset type. When you create an asset type in the administration
portlet, it displays in the asset type drop-down list in other areas of Civic Platform.

Click a topic title below for full details.

Related Links

Creating an Asset Type

Assigning an Asset ID Mask

Searching for Asset Types

Editing an Asset Type

Deleting an Asset Type

Requiring the Asset Size Field

Associating an Asset Type with Work Order Types

Synchronizing Asset Type Records with GIS

Viewing Rating Types under Asset Type

Creating Usage Types

Working with Asset Class Types
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Creating an Asset Type
Create a new asset type each time an agency gets a new type of asset. For example, your agency adds
gas flow meters to the natural gas lines to track the amount of gas consumed each month. Add flow meters
as an asset type. The agency can now track and maintain the flow meters by associating work orders to it.
You can also maintain the assets in the legacy Accela GIS.

You can create the asset usage Unit Types and associate one or more to each asset type, which enables
administrators to specify the unit types that are applicable to specific asset types. Daily agency users
can then associate the appropriate unit type to the asset type in Asset management and Preventative
Maintenance Schedule portlets. Refer to the overview and steps in Creating Usage Types.

You can specify the type of work orders associated with Asset Types.

After you create a new asset, a tab called Node Types activates for those assets that belong to the Node-
Link Linear class type only. For more information about node types, see Associating Node Types with
Assets.

Figure 79: Asset Detail with Asset Type Drop-down List

Assigning an Asset ID Mask
The asset identification mask is the default prefix for an asset type. Enter an asset ID mask if your agency
uses customized abbreviations or number schemes for assets. Civic Platform adds this code as a prefix to
any new assets of this asset type.

An ID mask defines the format of the asset number. ID masks support 2-digit and 4-digit year, or any
length of sequence number. An asset ID mask can contain strings that show part of the asset number that
Civic Platform recognizes and acts on before showing the asset ID to users. The basic keys that Civic
Platform recognizes and defines are in Table 181: Asset ID Mask Keys. The delimiter to separate the keys
from the text is the ‘$’ sign. Enclose all of the keys in a pair of ‘$’ signs. For example, to make it easy to
identify a ball field the asset ID mask might start with BLF, which indicates ball fields. Examples of asset ID
mask numbering schemes and their output are in Table 182: Asset ID Mask Examples.

Table 181: Asset ID Mask Keys

Key Description Example

YY Two digit year 07 for 2007

YYYY Four digit year 2007

DD Two digit day 20 for 4/20/07

MM Two digit month 06 for June

MMM Three character month APR for April
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Key Description Example

TSEQAzz Generates a sequence number. This key
must be after a hyphen or at the end of
the ID Mask so the sequence number is
at the end of the asset ID. The sequence
number depends on the values of T and
zz. T specifies the level where you set the
sequence. For example, generate sequence
number at the Type level. A specifies that
the sequence number resets annually, as
the year changes.zz specifies the size of the
sequence number generated, which should
not be greater than 09. The sequence
number generated plus the rest of the asset
ID must not exceed thirty characters.

TSEQ03 generates a 3 digit sequence number. Many
asset ID masks include a brief description before the
sequence number such as BLD for the buildings asset
types or BLF for baseball fields

.Assets with the same group type share sequence
numbers. For example, a hydrant and manhole are
both nodes, which share the same sequence number
such as 131.

Assets with the same asset type have different
sequence numbers. For example, a water line and
a sewer line are different asset types. The sewer
line might have 012 as a sequence number and the
water line might have 023 as a sequence number. For
example: $YY$-$TSEQA05$,$MM$-$TSEQA02$, but
it does not support “$YY$-$GSEQA04$”

Table 182: Asset ID Mask Examples

Mask Output

Anything $YY$-$DD$-$MM$-$MMM$-anything-
$GSEQ04$-anything

Anything -07-20-04-APR-anything-013- anything

B$YY$-$GSEQ03$ B07-123

BP$YY$-$GSEQ03$ BP07-234

EP-$GSEQ04$ EP-2237

X$YY$-$GSEQ05$ X07-71984

$YY$BLD-00000-$TSEQ03$ 07BLD-00000-121

When you clone an asset ID, Civic Platform uses the Asset ID Mask if you leave the Asset ID prefix blank.
For example, you have set the Asset ID Mask for a hydrant to $YY$SW-$TSEQ03$. When a user clones
a hydrant asset, they have the choice of entering a custom asset ID prefix or leaving the field blank. If
the user leaves the asset ID prefix blank, all of the new clones start with generated Asset ID Mask. For
example, if you clone a hydrant in March 2008 the generated ID mask is 08SW-151.

Searching for Asset Types
Use the following procedure to search for an asset type. If you do not have the full name of the asset type,
you can use partial text. For example, to find a water line asset type, enter “water” into the Asset Type field.
The search returns all asset types that start with “water.”

To search for an asset type

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Click Search.

Accela Civic Platform - Asset displays the Asset Type Search detail portlet.
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3. Enter the search criteria in the Asset Type detail fields that display. For a description of the fields, see
Table 184: Asset Type Fields.

4. Click Submit.

Accela Civic Platform - Asset returns a list of asset types that match the search criteria.

5. Click the link to the Asset Type you want to work with.

Editing an Asset Type
You can make modifications to existing asset types when information changes. For example, if the icon
changes or you need to update the asset ID mask. For more information about updating the asset ID mask,
see Assigning an Asset ID Mask.

When you update the asset type, Accela Civic Platform - Asset updates system data so users can view the
updated data in the asset portlet.

To edit an asset type

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Click the Asset Type link you need to update.

Accela Civic Platform - Asset displays the Asset Type detail portlet.
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3. Update the Asset Type fields that display. For a description of the fields, see Table 184: Asset Type
Fields.

4. Click Submit.

Accela Civic Platform - Asset updates the Asset Type detail portlet.

Deleting an Asset Type
You can delete asset types when they become outdated or you no longer need them. For example, an
agency starts outsourcing all small maintenance tasks to a local company. For example, if you do not keep
small maintenance supplies in the agency offices, you can delete the small maintenance asset types.

After you delete an asset type, it no longer displays in the asset type drop-down when a user creates a
new asset. However, Civic Platform does not delete the assets within the asset types, it just labels them
inactive.

To delete an asset type

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Select each asset type you want to remove. You can do a search for assets to locate them before
deleting. See Searching for Asset Types for more information.

3. Click Delete.

Accela Civic Platform - Asset deletes the selected asset type and then updates the Asset Type list
portlet.

Requiring the Asset Size Field
You can track the size of certain types of asset, for example if you want to use asset size information when
reporting costs from work orders to assets. You can require that users complete the Asset Size field for
asset types that belong to the Linear, Node‑Link Linear, and Polygon asset class types.

The asset type you edit or create must belong to the Linear, Node-Link Linear, or Polygon asset class type
to require the Asset Size field.

For more information on asset class types, see Working with Asset Class Types.

To require the asset size field for an asset type
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1. Find an asset type or create a new asset type for which you want to require the Asset Size field.

To find an existing asset type, see Searching for Asset Types.

To create a new asset type, see Creating an Asset Type.

Note:

The asset type you edit or create must belong to the Linear, Node-Link Linear, or Polygon asset class
type to require the Asset Size field.

2. Select Require Size in the asset type detail portlet.

3. Click Save.

Accela Civic Platform - Asset updates the asset type to require users to complete the Asset Size field.

Associating an Asset Type with Work Order Types
When you create an association of an Asset Type with types of Work Orders, you consolidate and filter
data displayed for users to view during daily processing. As a result, the user only sees applicable work
order types for that particular asset type, which eliminates the possibility of accidentally choosing an invalid
option from a large list of choices.

You can define, edit, and remove the Work Order types and Asset Types resulting in the ability to have
many Work Order types associated with many Asset Types and many Asset Types associated with many
Work Order types.

To associate an Asset Type with a Work Order type

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Choose an Asset Type to which you want to assign a Work Order type. Use one of the options below:

• Click an Asset Type in the navigation tree.
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• Click an Asset Type from the Asset Type portlet list.

3. Click the tab Work Order Types in the Asset Type detail portlet.

Civic Platform displays a list of Work Orders associated with the Asset Type

4. Click Assign.

Civic Platform displays a Record Type navigation tree.

5. Select the Work Order types that you want to associate with the Asset Type.

You can click Search to locate a Work Order by typing all or part of the Work Order name.

6. Click OK.

If you select a higher level of organization, you also select its subordinate levels.

7. Click Submit.

Civic Platform displays a success message.

Synchronizing Asset Type Records with GIS
For information on how to create or edit an asset type, see Creating an Asset Type and Editing an Asset
Type.
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For more information on Civic Platform GIS or the legacy Accela GIS, refer to the Accela Civic Platform
GIS Administrator Guide. The legacy Accela GIS product was developed on a .Net Framework and it
integrates with ESRI ArcGIS Server technology.

Topics

• Performing a Manual Synchronization

• Reviewing the GIS Sync Log

• Linking GIS Attribute Fields to Asset Type Fields

• Syncing Asset Types with Feature Classes and Related Tables

Performing a Manual Synchronization
You can perform a manual synchronization for one asset type or multiple asset types at any time. Asset
inventory must already exist in Civic Platform; for information on how users add asset inventory, see
the “Assets” chapter in the Accela Civic Platform User Guide. The process for synchronization requires
two main steps. First, you must complete the legacy Accela GIS synchronization fields for the asset
types. Then, synchronize Civic Platform with legacy Accela GIS using the synchronization button for one
asset type or a synchronization menu option for multiple asset types. If you want to synchronize attribute
information, you must map the GIS attribute field to the Civic Platform attribute field prior to running the
sync. See Linking GIS Attribute Fields to Asset Type Fields.

To manually synchronize asset type records with legacy Accela GIS

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Search for the asset types you want to synchronize with legacy Accela GIS.

Note:  If you cannot find the asset type, you might need to create it. Make sure to select the Master
Inventory option in legacy Accela GIS and complete the related fields. See Table 184: Asset Type Fields
and Creating an Asset Type. If you want to move attribute information during the sync, you must link the
GIS attribute field with an attribute field in Civic Platform before running the synchronization. See Linking
GIS Attribute Fields to Asset Type Fields.

Civic Platform displays the results for the search in the Asset Type detail portlet.

3. Choose one of the following:

• To synchronize multiple asset types at a time, select the asset types to select them.

• To synchronize one asset type, select the asset type and then move into the detail portlet.

4. Choose one of the following:
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• If you are synchronizing multiple asset types, click the Menu button and choose Sync Selected with
GIS.

• If you are synchronizing one asset type, click the Sync with GIS button.

Civic Platform displays a message prompting the sync progress. When the sync is complete, Civic
Platform displays the message “Synchronized successfully with GIS.”

5. Click the GIS Sync Log tab to view any errors from the synchronization.

For a list of common error messages, see Table 183: GIS Sync Log Error Messages.

Accela Civic Platform - Asset lists any error messages from the synchronization by date, time, asset ID,
and error message.

Reviewing the GIS Sync Log
Review the GIS Sync Log for each asset type after you synchronized it with legacy Accela GIS. There is
no master GIS sync log if you synchronize multiple asset types at a time. The error messages displays by
date, time, GIS ID, Asset ID, Attribute Name, and reason.

To review the GIS Sync Log list

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Search for the asset type in which you want to review the GIS Sync log.

Civic Platform displays the asset type details in the detail portlet.
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3. Click the GIS Sync Log tab.

4. Review the error messages. See Table 183: GIS Sync Log Error Messages for a list of common error
messages.

5. Make any adjustments or corrections, if applicable.

6. Clean up the GIS Sync Log by doing one of the following options.

• To clear the entire GIS Sync Log, click Delete All.

• To delete one record at a time, select the error and click Delete.

Table 183: GIS Sync Log Error Messages

Error Message Description and Resolution

Duplicated in GIS This error means that the specified GIS ID exists multiple times in the GIS layer.
Accela Civic Platform - Asset already created the relationship between legacy
Accela GIS and the asset record during a previous synchronization. Accela Civic
Platform - Asset does not allow for duplicate asset ID’s in the same Asset Type. The
second attempt to save the record in GIS triggers this error message.

ID field NULL or Blank
in GIS

This error means that the returned GIS object’s ID (for Asset ID) is null or blank.
Resolution: Edit the GIS data and make sure each record has a unique value for the
ID.

ID exists in Civic
Platform as expired or
inactive asset

This error means that the Asset ID in Accela Civic Platform - Asset not current or
inactive, so it did not synchronize with GIS. Resolution: Determine if the asset is
active or expired. If expired, remove from the GIS layer. If active, then correct the
data in Accela Civic Platform - Asset.

ID in Civic Platform has
no match in GIS

This error means that there is an existing record in Civic Platform that did not have a
match in GIS. Resolution: Verify that the record in Civic Platform is valid. If it is, then
add the record to GIS and synchronize. If the asset is no longer active, then expire
the asset in Civic Platform.

GIS ID links to another
asset record in Civic
Platform

This error means that the listed GIS feature already has a link to another asset
record in Civic Platform. Resolution: Research the existing link and remove it or
correct the GIS data to map to the correct Asset Type.

Linking GIS Attribute Fields to Asset Type Fields
Civic Platform can import attribute information from legacy Accela GIS to an asset type during
synchronization. If you want to do this, you must specify the field where you want the attribute data stored
in Civic Platform. You do this by mapping a GIS attribute field to the Civic Platform attribute field. For more
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information about where the GIS attribute comes from and how Civic Platform determines its maximum
field length, see “Understanding Field Mapping” the Accela Extension for Esri ArcMap User Guide.

If an asset attribute links to a GIS attribute that associates with coded domains, the asset attribute
shows the coded domain description of the GIS attribute. You must make sure the data type of the
GIS attribute coded domain is compatible with the linking asset attribute, or the attribute does not
show any value. For more information on creating GIS attribute coded domains, connect to the http://
resources.arcgis.comArcGIS Resource Center and see the following help topic: http://help.arcgis.com/en/
arcgisdesktop/10.0/help/index.html#/A_quick_tour_of_attribute_domains/001s00000001000000/A quick
tour of attribute domains.

To link a GIS attribute field to a Civic Platform field

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Search for the asset type in which you want to link attribute fields.

Civic Platform displays the asset type details in the detail portlet.

3. Click the GIS Attribute Mapping tab.

Civic Platform displays the GIS attribute mapping list.

4. Use the drop‑down lists to select the appropriate Civic Platform fields to link to the GIS Attribute fields.

Note:  Make sure that each Civic Platform attribute is of the same data type and at minimum the same
data length with the mapped GIS attribute. For a numeric Civic Platform attribute that has decimal
places, make sure both its integer and its fraction length is no less than that of the mapped GIS attribute.
Otherwise, you cannot save the mapping.

5. Click Submit.

Civic Platform displays a message that the GIS Attribute Mapping updated successfully.

Syncing Asset Types with Feature Classes and Related Tables
If your agency uses Esri’s geodatabase as the main repository of assets and GIS objects, you can sync a
feature class in Esri’s geodatabase to an asset type in Civic Platform, and sync a standalone table related
to the feature class to another asset type. After you sync asset types with legacy Accela GIS, you establish
the parent and child hierarchy of assets in Civic Platform.

Topics

• Understanding GIS Requirements

• Syncing Asset Types with Feature Classes and Tables

http://resources.arcgis.com
http://resources.arcgis.com
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/A_quick_tour_of_attribute_domains/001s00000001000000/
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/A_quick_tour_of_attribute_domains/001s00000001000000/
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• Viewing Related Asset Types

Understanding GIS Requirements
Before you map and sync asset types in Civic Platform with feature classes and their related tables in
Esri’s geodatabase, ensure that you have added the related tables into your map document (.mxd). This
allows the Related Table drop-down list in the Asset Type edit form to retrieve the table names for your
selection. Later you must publish the map service with the map document and integrate the map service
into legacy Accela GIS for Civic Platform use.

This section provides you with instructions about how to add the tables that relate to feature classes into
your map document. For more instructions about how to publish a map service and how to integrate the
map service into legacy Accela GIS, see the Accela GIS for ArcGIS Server Configuration Guide and the
Accela Civic Platform GIS Administrator Guide.

To add feature-class-related tables into a map document

1. Open your map document (.mxd) in Esri ArcMap.

2. Drag and drop the tables that relate to feature classes into the map document.

The Layers panel in Esri ArcMap lists the related tables, which do not display in the Layers panel in
legacy Accela GIS.
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3. Save your map document and publish it as a map service.

Syncing Asset Types with Feature Classes and Tables
If your agency uses Esri’s geodatabase as the main repository of assets and GIS objects, you can map
and sync feature classes and their related tables in an Esri geodatabase to asset types in Civic Platform.

A feature class in the geodatabase (see Figure 80: Feature Classes and Tables in the Geodatabase) is
represented visually on the map as a layer and contains a collection of common features with the same
spatial representation, such as points, lines, or polygons. A stand-alone table in the geodatabase provides
descriptive information about features or contains a collection of features without spatial representation.
Your agency can associate objects in one feature class with objects in another, or associate objects in one
feature class with records in a table. However, you can only sync the relationships between the objects in
a feature class and records in the related tables in the geodatabase to the parent and child hierarchy of
assets in Civic Platform. The relationships between objects of different feature classes cannot be synced to
Civic Platform.
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Figure 80: Feature Classes and Tables in the Geodatabase

The asset type that a feature class is mapped to is the parent asset type while the asset type that a stand-
alone table is mapped to is the child asset type. When you perform a synchronization for the parent asset
type, Civic Platform does the following for both the parent asset type and the child asset type.

• Syncs the relationship between assets and GIS objects with GIS

• Syncs asset attribute fields with GIS attribute fields, if the GIS attribute mapping is established

• Syncs the parent and child hierarchy of assets based on the relationship in which the related table
participates

When you perform a synchronization for the child asset type, Civic Platform syncs the relationship between
assets of this type and GIS objects with legacy Accela GIS, and syncs asset attributes with GIS attributes,
as needed. Civic Platform does not synchronize the parent asset type or the sibling asset type with legacy
Accela GIS.

Use Case Example
Your agency has a point feature class of sign supports and a table containing traffic signs. And inspectors
use Civic Platform to perform inspections and maintenance on both the supports and the signs. The Sign
Supports feature class already relates to the Traffic Signs table in the geodatabase. All you need to do
in Civic Platform is to map the Sign Supports feature class to an asset type and the Traffic Signs table to
another asset type, and then sync the asset types with legacy Accela GIS.

To sync asset types with feature classes and related tables

1. Access the Asset Type Administration portlet (Navigating to the Setup Portlet).

2. Search for and select the asset type that you want to map to a feature class.

3. In the Asset Type tab, select Master Inventory in GIS.

This option allows you to map a feature class (GIS layer) or its related table in the geodatabase to the
asset type in Civic Platform. If you want to remove the mapping, clear this check box.

Civic Platform makes the GIS-related fields editable.
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4. Complete the following GIS-related fields. For a description of the fields, see Table 184: Asset Type
Fields.

• GIS Service

• GIS Layer

• (Optional) Related Table

• GIS ID for Asset ID

5. Click Save.

6. Go to the GIS Attribute Mapping tab and map each GIS attribute field to a Civic Platform field.

For more instructions about creating the field mappings, see Linking GIS Attribute Fields to Asset Type
Fields.

Note:  If you specify a related table for the asset type, the GIS Attribute Mapping tab lists the fields in the
related table as the GIS attribute fields. Otherwise, it lists the fields in the GIS layer (feature class).

7. Search for and select another asset type, and then complete through to map it to the feature class
related table.

8. Return to the Asset Type tab for the parent asset type, and then click the Sync with GIS button.

For more instructions, see Performing a Manual Synchronization.

Civic Platform displays a message prompting the sync progress. When the sync is complete, Civic
Platform displays the message “Synchronized successfully with GIS.”

Viewing Related Asset Types
After you map a feature class and its related tables in the geodatabase to asset types in Civic Platform, the
Related Asset Type tab appears and lists all related asset types for every asset type in the parent and child
hierarchy. The Related Asset Type tab is not available for the asset type that does not participate in any
relationships with other asset types.

The possible relationships between asset types are parent, child, or sibling relationships. The asset type
that maps to a GIS layer (also known as feature class) is the parent while the asset type that maps to a
table related to the GIS layer is the child. When a parent asset type has multiple child asset types, the
relationships between child asset types are “sibling relationships.” For more information about establishing
relationships between asset types, see Syncing Asset Types with Feature Classes and Tables.
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To view related asset types

1. Access the Asset Type Administration portlet (Navigating to the Setup Portlet).

2. Search for and select the asset type that you want to view its related asset types.

3. Click the Related Asset Type tab.

Civic Platform displays a list of related asset types for the asset type. The list is similar to that in the
Asset Type administration portlet. The only difference is that the Related Asset Type list has the
Relationship column while the Asset Type administration list does not. The Relationship column
indicates whether the asset type is the parent, child, or sibling of the current asset type.

4. Click the link to the asset type that you want to view.

Civic Platform displays the details of the asset type.

Viewing Rating Types under Asset Type
View the rating types associated to the asset type of the asset record you are working in.

To view rating types under asset type

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Click either the Asset Type icon or the Asset Type ID link of the asset type you want to view.

Accela Civic Platform - Asset displays the Asset Type Detail view.

3. Click the Rating Types secondary tab.

Accela Civic Platform - Asset displays the Rating Types linked to the selected Asset Type.
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Creating Usage Types
The asset Usage Types allows administrators to specify the usage types that are applicable to specific
asset types. Daily agency users can then associate the appropriate unit type to the asset type in Asset
management and the appropriate unit interval in the Preventative Maintenance Schedule portlets.

When you configure usage types, a tab called Usage Types displays in the Asset Type detail
administration portlet. The steps to create an asset type and associate usage types are in To create an
Asset Type and associate Usage Types.

The daily agency user selects the Unit Types that are applicable to the specific asset type in the Asset
Usage detail form portlet. The corresponding Last Reading and Last Reading Date fields populate with the
last usage reading and reading date as read-only fields, for your reference. Users can also select the unit
types from the Unit Interval drop-down list in the Preventative Maintenance Schedule detail form portlet.

To create an Asset Type and associate Usage Types

1. Access the Asset Type Administration portlet (Accessing the Asset Type Administration Portlet).

2. Create a new Asset Type. Use one of the following options.

• Click the Menu button and select New Asset Type from the drop-down list, or

• Right-click the navigation tree and choose New Asset Type, or

• Go to the Asset Type portlet and click New.

Accela Civic Platform - Asset displays the Asset Type detail portlet

3. Complete the Asset Type fields as described in Table 184: Asset Type Fields.

The asset ID mask field is an identifier that helps users immediately understand the type of asset. To
provide an asset ID mask, see Assigning an Asset ID Mask.

If you select the Master Inventory in GIS box, fields related to this function come into view. For more
information about how to synchronize an Asset Type to a GIS layer, see Synchronizing Asset Type
Records with GIS.

4. Click Save.

Civic Platform creates the new asset type.

5. Do one of the following optional steps:

• If you choose a node-link linear class type, continue with to associate node types to the asset type.

• If you want to associate one or more asset usage types, perform these substeps:
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1. Ensure that you configured asset usage types as explained in Creating Usage Types.

2. Click the Usage Types tab.

3. Click Look Up to locate all of the usage types.

4. Select each Usage Type you want to associate with the selected Asset Type.

5. Click Select to associate the usage types to the asset.

Civic Platform adds the unit types to the Asset Type.

• If you want to associate an asset type with work order types, click the Work Order Template tab
and complete the fields. For more information on how to associate an asset type with a work order
type, see Searching for Asset Types.

Accela Civic Platform - Asset creates the asset type and then displays it in the Asset Type detail
portlet.

6. For node-link linear class type assets, click the Node Types tab. The Node Types tab activates only if
the asset type contains a node-link linear class type.

Accela Civic Platform - Asset displays the Asset Type list portlet

7. Click Look Up to search for asset types to complete the node. For a description of the available lookup
fields, see Table 184: Asset Type Fields.

Accela Civic Platform - Asset displays the Node Type lookup portlet.
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8. Click Submit.

Accela Civic Platform - Asset returns the assets that meet the lookup criteria in the Node Types list
portlet

9. Select each asset type you want to add to the node types list.

10.Click Select.

Accela Civic Platform - Asset adds the node asset to the non-link linear asset type.

Table 184: Asset Type Fields

Asset Group Select the asset group identified by the agency.

Asset ID Mask Enter the prefix you want to use for the asset type. This prefix is the default prefix to
an asset type. It is an identifier that can contain strings that help users immediately
understand the type of asset. For example, an asset such as a van might use the mask
ID ‘VAN’. When you create a Van asset its Asset ID is VAN-001. To assign an asset ID
mask, see Assigning an Asset ID Mask.

Asset Type Select the type of asset identified by the agency.

Asset Type Code Enter the type code used to identify the asset type.

Class Type Select the asset class type. This list is a system-defined way that Civic Platform groups
objects that an agency owns or maintains. For more information on Class Types, see
Working with Asset Class Types. For Node-Linear class types, you can define the
node types.

Comments Enter any comments associated with the asset type.

Description Enter a description for the asset type.

GIS Version for Attribute
Edits

Choose the GIS version number. This field creates the GIS Attribute Mapping tab and
populates it based on the version specified.

ID Sequence Value Enter the order number you want to display the asset type in the drop-down list.

Icon Enter the icon used to visually identify the asset type. To choose a standard icon, click
the Standard option, then choose the graphic you want to use.

If you want a custom icon, click the Customize option and click Browse to select the
file you want to use for the icon.
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Master Inventory in GIS Select this option to synchronize Accela Civic Platform - Asset with GIS objects on
a GIS layer or entries in a related table. If you want to disassociate assets from GIS
objects or related table entries, clear this check box from an existing asset type. When
you select the Master Inventory in GIS option, the following fields become active:

GIS Service: Choose the GIS service that stores the information about assets and GIS
objects.

GIS Layer: Choose the GIS layer that the asset type maps to. In Esri ArcMap, a
feature class is represented visually on the map as a layer.

Related Table: If the asset type is the parent of other asset types or if the asset type
does not relate to any other asset types, you do not need to complete this field. If the
asset type is considered as the child of another asset type, select the table that this
asset type maps to. This drop-down list is populated with all the stand-alone tables that
the GIS layer (feature class) relates to in the geodatabase.

GIS ID for Asset ID: Select the GIS attribute that you want to use for the asset ID. If
you specify a related table, this drop-down list is populated with the fields in the table.
Otherwise, this drop-down list is populated with the fields in the GIS layer (feature
class).

Require Size This option activates when you select the Linear, Node-Link Linear, or Polygon asset
class. Select this option to require users to enter the length (for Linear or Node-Link
Linear) or area (for Polygon) in the Asset Size field in asset records of the type you are
creating.

Template ID Select a Template ID. The Template ID associates a set of custom attributes to the
asset. For more information about templates, see Attributes and Templates.

Working with Asset Class Types
For a description of the fields, see Table 184: Asset Type Fields.

Table 185: Asset Class Types

Component The component class specifies assets that are independent and do not connect assets
together. Components can be mobile objects such as vehicles, or stationery objects such
as a building or tools. A component is free of lines and nodes.

Linear The linear class type indicates a relationship between two assets. For example, a section
of street, sidewalk, or runway at the city municipal airport.

Node-link linear Node-link linear combines assets to indicate an explicit relationship between the assets.
Node-link linear requires the user to define the asset ID by identifying the assets on each
end of the linear asset. For example, define a sewer main by identifying its end points
such as Manholes. Manhole “MH-01” flows to manhole “MH-02” which flows to manhole
“MH-03.” The node-link linear allows for the creation of the Sewer Main asset by naming
the beginning and end point assets of each pipe. In this example, the agency can create
two Sewer Main assets such as class type of node-link linear defined as “MH-01 - MH-02”
and “MH-02 - MH-03.”

Point The point class type refers to an object that is either independent, or located at the end of
a line. For example, a street light, a stop sign, or a speed limit sign.

Polygon The polygon class type includes assets such as water drainage area, a storm drainage
area, or a catch basin.

Topics

• Associating Node Types with Assets

• Viewing Asset Node Types
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Associating Node Types with Assets
A node type is a type of asset used to link lines together. The Node Type tab activates only for asset types
with a Node-Link Linear class type.

To associate an asset node type with an asset

1. Access the Asset Type Administration portlet (Navigating to the Setup Portlet).

2. Click the Asset Type link you want to update the node list. The Asset Type must have a node-link
linear class type to set node types.

Accela Civic Platform - Asset displays the Asset Type detail portlet.

3. Click the Node Types tab.

Accela Civic Platform - Asset displays the Node Type list portlet.

4. Click Look Up.

Accela Civic Platform - Asset displays the Node Type lookup portlet.

5. Complete any of the fields that display. For a description of the fields, see Table 186: Asset Node Type
Fields.

6. Click Submit.

Accela Civic Platform - Asset returns a list of the asset types that match your search parameters.

7. Select the node type you want to add to the asset type.

8. Click Select.

Accela Civic Platform - Asset updates the Node Types list portlet.
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Table 186: Asset Node Type Fields

Asset Group Select the asset group. For example: component, line, or node.

Asset ID Mask Enter a value for the asset ID mask. An ID mask can contain strings that show part
of the asset number that Accela Civic Platform - Asset recognizes and acts on before
showing the application number.

Asset Type Enter an asset type. For example: sidewalk, sewer line, or street.

Asset Type Code Enter a value for the asset type code.

Class Type Select a class type. For example: component, linear, node-link linear, point, or polygon.

To view the node type, you much choose node link linear as the class type.

Comments Enter comments associated with the node type.

Description Enter a description of the node type.

Record Status Select a record status. Select Active to set the record status to active.

Select Inactive to set the record status to inactive.

Template ID Select a template ID. For more information about templates, see Attributes and
Templates.

Viewing Asset Node Types
You can view a list of asset types associated with a node. The Asset Type must have a node-link linear
class type. After you view the node list, you can add or remove asset types from the list of valid node Asset
Types. For more information about adding assets to a node list, see Associating Node Types with Assets.

To view an asset node type

1. Access the Asset Type Administration portlet (Navigating to the Setup Portlet).

2. Click the Asset Type link you want to update the node list. The Asset Type must have a node-link
linear class type to set node types.

Accela Civic Platform - Asset displays the Asset Type detail portlet.

3. Click the Node Types tab.

Accela Civic Platform - Asset displays the Node Type list portlet.

Asset Condition Assessments
Condition assessments apply to assets that change or deteriorate over time. These assets may require a
visual condition assessment to effectively manage their life cycle.

You can group assets together that require the same condition assessment, enter the condition
assessment findings, and create a history of assessments and performed maintenance.

Click a topic title below for full details.
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Related Links

Creating a Condition Assessment Type

Editing a Condition Assessment Type

Searching for a Condition Assessment Type

Deactivating a Condition Assessment Type

Working with Condition Assessment Attributes

Working with Observation Attributes

Viewing Calculated Rating Types

Working with Asset Ratings

Creating a Condition Assessment Type
When you create a condition assessment type, you create an option in the Condition Assessment drop-
down list that displays when a user creates a specific condition assessment. Refer to Figure 81: Condition
Assessment Drop-down List.

To include a condition assessment type in a drop-down list, you must associate a rating type to it. For
information on creating a rating type and associating it to a condition assessment type, see Creating a
Rating Type.

Figure 81: Condition Assessment Drop-down List

To create a condition assessment

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click New.

Civic Platform displays the following.

3. Complete the following fields:

Condition Assessment Enter the type of condition assessment.

Description Enter a description of the condition assessment.

4. Click Submit.

Civic Platform saves your changes and displays a success message.
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Editing a Condition Assessment Type
After you create a condition assessment type you can change its description. If the condition assessment
type is unused, you can delete it and create a new one.

After you use a condition assessment type, you cannot remove it. Accela Civic Platform - Asset sets it to
inactive status; it does not remove it. For more information on removing condition assessments types, see
Deactivating a Condition Assessment Type.

To edit a condition assessment type

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click the Condition Assessment link you want to update.

Civic Platform displays the following.

3. Update the condition assessment Description.

To change a condition assessment type you must delete the type and create a new one. For more
information about deleting or creating a condition assessment type, see Deactivating a Condition
Assessment Type and Creating a Condition Assessment Type.

4. Click Submit.

Civic Platform saves your changes and displays a success message.

Searching for a Condition Assessment Type
Use the following procedure to search for a condition assessment type. If you do not have the full name
of the condition assessment type, you can perform a partial text search. For example, to find a condition
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assessment on a vehicle, enter veh into the Condition Assessment field. The search returns all condition
assessment types that start with veh. When you find the condition assessment type you are looking for,
you can view the details, update the description, or remove the condition assessment type. You can also
search for an inactive condition assessment to reactivate it.

To reactivate a condition assessment type that removed by mistake, search for inactive records. In the
search results select the desired record and change the record status to Active. This reactivates the
record, making it available when setting up new condition assessments. Civic Platform restores any
attribute detail information originally associated with the condition assessment type.

To search for a condition assessment type

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click Search.

Civic Platform displays the Condition Assessment portlet.

3. Complete any of the fields below:

Condition Assessment Enter the name of the condition assessment type.

Description Enter a description about the condition assessment type.

Record Status Select active to search for an active condition assessment. Select inactive to search
for an inactive condition assessment.

4. Click Submit.

Civic Platform returns a list of condition assessment types that match your search parameters.

5. Click a Condition Assessment to access it.

Deactivating a Condition Assessment Type
The only way to change the name of a condition assessment type is to deactivate it and create a new
one. If you use the condition assessment type or attach something to it, you can only set it to inactive
status, you cannot delete it. When you set a condition assessment type to inactive, it is no longer available
when creating new condition assessment types. Accela Civic Platform - Asset does not remove it entirely.
However, the attributes remain active and available under attributes in the Admin portlet, which is important
to note, because you can leverage a single attribute on more than one condition assessment type.

If you remove the condition assessment type by mistake, you can reactivate it by searching for inactive
records and changing the status to active. For instructions and information about searching for a condition
assessment type, see Searching for a Condition Assessment Type.

To set a condition assessment type to inactive status

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Select the Condition Assessment link you want to inactivate.

3. Click Delete.

Civic Platform changes the condition assessment type to Inactive status.

Working with Condition Assessment Attributes
Topics

• Viewing and Editing a Condition Assessment Attribute
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• Associating an Attribute with a Condition Assessment Observation

• Editing an Observation Attribute Display Order

Viewing and Editing a Condition Assessment Attribute
A condition assessment attribute is a characteristic of a condition assessment, in addition to the
information displayed in the main record. Associate condition assessment attributes with the condition
assessment type to provide additional detail and information. For example, a hydrant condition assessment
has attributes such as test coefficient, flow coefficient, flow hydrant, flow hydrant location.

After you create a condition assessment attribute, you cannot change it. However, you can change the
display order of a condition assessment attribute or enable display flags. The only way to change the
name of a condition assessment attribute is to remove the attribute type and create a new one. For more
information on removing attribute types, see Attributes and Templates.

When you reactivate the condition assessment attribute, all of its attributes return too. This is because the
condition assessment type is the parent record, and when it is inactive the relationships are also inactive.
You define the attributes separately from the condition assessment type and then you associate them after
the fact.

To edit a condition assessment attribute

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click the link to the Condition Assessment that you want to view or edit.

3. Click the Attribute tab.

Civic Platform displays the Condition Assessment Attribute tab.

4. Click the Attribute Name link.

Civic Platform displays the Attribute Detail portlet.

5. Complete the Attribute Detail fields that display. For a description of the fields, see Table 187: Condition
Assessment Attribute Detail Fields.

6. Click Submit.

Table 187: Condition Assessment Attribute Detail Fields

Attribute Group Select the attribute group. For example: address, common, employee, equipment, field.
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Attribute Label Enter an attribute label.

Attribute Length Enter the length of the attribute.

Attribute Name Enter a name for the attribute.

Default Value Enter the default setting for the asset attribute

Description Enter a description about the attribute.

Display Order Enter a number for the display order.

Is Dropdown List Select Yes to make the attributes appear in a drop-down list.

Record Status Select a record status. For example: active, inactive.

Searchable Flag Select Yes to use the searchable flag.

Unit Type Select a unit type. For example: dollars, foot, hours, sqft, squaremile, or yard.

Value Data Type Select a value data type. For example: date, drop-down list, number, text, text area,
time, yes/no.

Value Required Flag Select Yes to require a value flag.

Select No not to require the value flag.

Associating Condition Assessment Attributes
Associating attributes with a condition assessment type determines what condition assessment type
specific attributes display on the condition assessment details table in the Condition Assessment portlet.
For example, an agency wants to record the water quality during a water line condition assessment. You
must associate the water quality attribute to the water line condition assessment type. After you associate
the attribute with the condition assessment, inspectors are able to record the water quality in the water
quality field when they record their findings from the water line condition assessment. For an example of
the attributes see Figure 82: Condition Assessment Detail Fields.

Figure 82: Condition Assessment Detail Fields

To associate a condition assessment attribute

1. Access the Condition Assessment portlet (Navigating to the Setup Portlet).

2. Click the link to the Condition Assessment that you want to associate.

Civic Platform displays the Condition Assessment portlet.
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3. Click the Attribute tab.

Civic Platform displays the Condition Assessment Attribute tab.

4. Click Look Up to locate the attribute you want to associate.

5. Enter search criteria in any of the fields to locate the attribute. For a description of the fields, see Table
187: Condition Assessment Attribute Detail Fields.

6. Click Submit.

Civic Platform returns a list of the attributes that match your search parameters.

7. Select the attribute you want to add to the condition assessment type.

8. Click Select.

Civic Platform associates the attribute.

Editing an Attribute Display Order
The display order determines how the attribute fields display on the asset details tab in the Condition
Assessments portlet. For example, you can change the display order of the pipe length attribute from “6”
to “1” to have the attribute display as the first attribute in the condition assessment detail portlet. For an
example see Figure 83: Condition Assessment Attribute Display Order.
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Figure 83: Condition Assessment Attribute Display Order

To edit a condition assessment attribute display order

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click the Condition Assessment link you want to update.

Civic Platform displays the Condition Assessment portlet.

3. Click the Attribute tab.

Civic Platform displays the Condition Assessment Attribute tab.

4. Click the Attribute Name link for the attribute that you want to move.

Civic Platform displays the Attribute Detail portlet.

5. Update the Display Order field.

6. Click Save.

Civic Platform updates the display order.

Working with Observation Attributes
You can change how an observation attribute displays for a user. For more information about changing the
display order, see Editing an Observation Attribute Display Order.
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Topics

• Viewing and Editing Observation Attributes

• Associating an Attribute with a Condition Assessment Observation

• Editing an Observation Attribute Display Order

Viewing and Editing Observation Attributes
You can view a list of observation attributes associated with an observation type to see what attributes
belong to a particular observation type.

After you create an observation type, you cannot change it. However, you can change its display order and
enable display flags.

The only way to change the name of an observation type attribute is to remove the attribute type and
create a new one. You can add or remove attributes from a condition assessment type or from an
observation level. To make an attribute inactive use the Attribute list portlet.

An attribute is any custom information you define.

Associating attributes with an observation type determines what attribute fields display for an observation.
For a sample list of fields, see Editing an Observation Attribute Display Order.

To review an observation attribute

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click the Condition Assessment link you want to view.

Civic Platform displays the Condition Assessment portlet.

3. Click the Observation Attribute tab.

Civic Platform displays the Observation Attribute tab.

4. Click the Attribute Name link you want to edit.

Civic Platform displays the Observation Attribute Detail portlet.

5. Complete the Attribute Detail fields that display. For a description of the fields, see Table 187: Condition
Assessment Attribute Detail Fields.
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6. Click Save.

Associating an Attribute with a Condition Assessment Observation
You can look up possible observation attributes that you need to associate with an observation type.
Inspectors cannot perform observations unless you have associated attributes with the observation type.

Associating attributes with an observation type determines what attribute fields display on the observation
details table in the Condition Assessment portlet.

To associate an observation attribute

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click the Condition Assessment link you want to view.

Civic Platform displays the Condition Assessment portlet.

3. Click the Observation Attribute tab.

Civic Platform displays the Observation Attribute tab.

4. Click Look Up.

Civic Platform displays the Observation Attribute Lookup page.

5. Enter search parameters in any fields on this page. For a description of the fields, see Table 187:
Condition Assessment Attribute Detail Fields.

6. Click Submit.

Civic Platform returns a list of all observations that match the lookup parameters

7. Select the attribute you want to add to the observation type.

8. Click Select.

Civic Platform associates the observation attribute.
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Editing an Observation Attribute Display Order
The display order determines where the attribute fields display on the observation details tab in the
Condition Assessments portal. For example, display position 1 starts on the upper left, position 2 is on the
upper right, position 3 is on the left. The fields continue alternating left and right down the screen.

To edit an observation attribute display order

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click the Condition Assessment link you want to view.

Civic Platform displays the Condition Assessment portlet.

3. Click the Observation Attribute tab.

Civic Platform displays the Observation Attribute tab.

4. Click the Attribute Name link you want to edit.

Civic Platform displays the Attribute Detail portlet.

5. Enter a value in the Display Order field.

6. Click Submit.

Viewing Calculated Rating Types
You can link each Condition Assessment to a Rating Type. Condition Assessment forms display both the
rating given in the condition assessment and the previous rating. Administrators can view the Calculated
Rating Types associated with a Condition Assessment.

To view a condition assessment’s calculated rating type

1. Access the Condition Assessment portlet (Accessing the Condition Assessment Portlet).

2. Click the Condition Assessment link you want to view.

Civic Platform displays the Condition Assessment portlet.

3. Click the Calculated Rating Types tab.

Civic Platform displays a list of calculated rating types.
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Working with Asset Ratings
Topics

• Creating a Rating Type

• Editing a Rating Type

• Searching for a Rating Type

• Creating a Rating Formula

Creating a Rating Type
Different types of asset require different types of rating. For example, it is useful to have a structural rating
for a water line but not for a vehicle. You can have a risk rating for a vehicle but not for a sidewalk. Accela
Civic Platform - Asset enables you to create rating types you can use to rate various asset types, including
evaluation of the largest or smallest observation scores. When an inspector creates an asset rating, the
inspector must choose a rating type from a drop-down menu of possible rating types. You associate each
rating type with an asset group, an asset type, and a condition assessment type so that only the relevant
rating types appear in the inspector’s drop-down list of possible rating types. For example, you can do
structural ratings of both waterlines and manholes. You can create one structural rating type and link it to
the Waterlines asset type and another structural rating type that you link to the Manhole asset type. When
an inspector wants to enter a structural rating for a manhole, only the structural rating type linked to the
Manhole asset type appears on the drop-down list of rating types. An administrator sets the value range for
each rating type.

You can assign ratings values manually or calculated by Civic Platform using an administrator-defined
formula. If you allow manual entry of rating values for a rating type, you can choose whether to create a
rating formula for that rating type. If you do not create a rating formula, inspectors must give ratings for that
asset manually entering rating values. If you do create a rating formula, inspectors can add manual rating
values in addition to the rating values generated by the formula. If you do not allow manual entry of rating
values for a rating type, you must create a formula to calculate ratings. See Creating a Rating Formula.

Before you can create a rating type, you must create a condition assessment type and an asset type
to associate to the rating type. For information on creating condition assessment types, see Creating a
Condition Assessment Type. For information on creating an asset type, see Asset Types. To enable asset
groups, configure the ASSET_GROUP Standard Choice. Refer to the Accela Civic Platform Configuration
Reference.

To create a rating type

1. Access the Rating Type portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the following.
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3. Complete these fields:

Rating Type Enter a name for the rating type.

Asset Group Select from a drop‑down list of available asset groups. The asset group determines
which asset types you can choose from.

Asset Type Select from a drop‑down list of available asset types. The asset type determines
which asset fields are available to use as variables for the expression.

Upper Limit and Lower
Limit

Enter the maximum and minimum possible rating values.

4. Select a condition assessment from the Condition Assessment drop‑down menu to assign the Rating
Type to.

5. If you select the Manual Entry Rating Value option, you can either create a rating formula or leave the
formula field blank. If you do create a formula, users can enter manual rating values in addition to the
calculated rating values. If you do not create a formula, you must enter rating values manually.

If you do not select the Manual Entry Rating Value option, you must create a rating formula.

For information on creating a formula, see Creating a Rating Formula.

6. Click Submit.

Civic Platform adds the rating type to your Rating Type list.

Editing a Rating Type
After you have created a rating type and linked it to an asset group and an asset type, you cannot change
its name or the link. You can change the condition assessment type for the rating type, as well as the
upper and lower limits for the rating values. You can make the ratings read-only or enable users to enter
new ratings.

To edit a rating formula

1. Access the Rating Type portlet (Navigating to the Setup Portlet).

2. Click the Rating Type link of the rating type you want to edit.

Civic Platform displays the Rating Type detail portlet.

3. Make the desired changes to the available fields.
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4. Click Submit.

Civic Platform updates the Rating Type.

Searching for a Rating Type
To search for a rating type

1. Access the Rating Type portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform returns the Rating Type search fields.

3. Enter search criteria in any of the fields and click Submit.

Civic Platform returns a list of Rating Types that match your search parameters.

Creating a Rating Formula
You can define rating formulas for each condition assessment/asset type combination. The formula can
calculate the rating based on a combination of many factors: condition assessments, work orders, service
requests, direct updates, and the asset’s rating history. For example, administrators can use specific
functions to get the largest or smallest observation scores on a condition assessment. The rating formula
also has access to asset details, asset attributes, condition assessment details, and condition assessment
attributes. See Rating Type Portlet.

You can manually calculate ratings and you can also set them up to trigger based on the completion of
condition assessments. To ensure your rating formula is functional, validate it before applying it to asset
records.

Civic Platform stores and date-stamps each rating entry, which enables users to view rating logs and
generate graphs of an asset’s rating history. Users can also graph the average condition of a group of
assets.

Before you create a rating formula, consider the following information:

• You associate rating formulas to asset types, so determine the Asset Type for which you want to create
a formula as well as the Asset Group to which it belongs.

• You tie rating types to Condition Assessments, which you in turn tie to Asset Types. So in addition to
Asset Type and Asset Group, you must know which Condition Assessment you want to contain the
rating formula.

• Expression criteria determine which records a formula evaluates. These criteria can use any type of
field, numeric or alphabetic.

• You can only include numeric fields in a formula, so when you determine which fields you want to
include in your rating calculation, ensure their value is numeric.

• Accela provides the Sum, Count, Average, Max and Min functions. You can use expressions that
work with the functions to determine which records a formula evaluates. These criteria can use any
type of field, numeric or alphabetic. To limit the records evaluated by a formula, consider creating an
expression for the function.
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• Accela gives you options to create either a classic style or EMSE style formula. The classic style only
supports simple scripting while the EMSE style allows rather complicated EMSE script. Please read the
steps in this section before deciding which option to take.

Figure 84: Rating Type Portlet

To add a rating formula to a rating type

1. Find the Rating Type for which you want to create a formula. See Searching for a Rating Type.

Civic Platform displays the rating detail portlet as shown in Rating Type Portlet

2. If you select the Manual Entry Rating Value option for the rating type, you can either create a rating
formula or leave the formula field blank. If you do create a formula, users can enter manual rating
values in addition to the calculated rating values. If you do not create a formula, you must enter rating
values manually.

If you do not select the Manual Entry Rating Value option, you must create a rating formula.

3. Select the Script Style, and define the rating formula.

Classic Style

In the classic style formula, you must directly specify a field value, or an expression, or a mathematical
calculation as the rating value. Although you can use IF-ELSE statement, the statement syntax must
stick to either of the following formats:

if($$CRITERIA$$){} else{} 

if($$CRITERIA$$){} else if($$CRITERIA$$){} else{} 
 

EMSE Style

EMSE Style supports normal EMSE scripts. You can define variables and functions, and use complex
IF-ELSE statements in the formula. If you use EMSE style, you must add the following function to set
the rating value:

ratingFormula.setReturnRating(returnValue)

4. Create a rating formula in the Formula text area that meets the script style you select in .

In the following sub steps, to are applicable to both the classic style and EMSE style; to are only
applicable to EMSE style.
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a. Select a variable from the Variables navigation tree to add to the formula.

The variables navigation tree lists all the asset fields and condition assessment fields for the rating
type. Use the + and - buttons to expand the navigation tree, find the variable, and then click the
variable name to add it in the formula.

Civic Platform adds the field to the rating formula.

b. Click one of the Math operators from the Operators section to apply it to the rating formula. You can
choose from the basic mathematical symbols, including [+], [-], [*], [/], and [%].

Civic Platform adds the operator to the rating formula.

c. Click one of the Functions from the Operators section for adding the mathematical operation result
into the formula.

The Sum, Count, Average,Max, andMin functions display in the Functions category. For
description of these functions, see Rating Formula Functions.
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Civic Platform displays the following.

d. Create Expression with the selected function.

e. Complete the following required fields:

Name Give the expression a unique name.

Lookup Table Name Select the table name for the observation associated with the function. The table
name you selected affects the options available in the Return column drop-down
list.

Return Column Select a Return Column from this drop‑down list. Return Column is the field in
the selected condition assessment that the function evaluates.

f. Click New in the upper right corner of the window to add a row of criteria to the expression. These
criteria determine which values the function includes from the Return Column.

Note:

Adding too many criteria to an expression can cause your system to run slowly or your screen to
freeze. To avoid this issue, limit your expression criteria to 30 or fewer.

g. Choose a field from the Field Namedrop‑down list. This list automatically populates with the fields
from the selected condition assessment.

h. Choose an operator from the Operator drop‑down list. For descriptions of available operator, see
Rating Formula Relational Operators.

i. Choose an operator from the Operator drop‑down list. For descriptions of available operator, see
Rating Formula Relational Operators.

j. Choose a value from the Value drop‑down list. The value you select is the value that the criteria
queries. For example, if you chose the Date field name and the = operator, you could enter 5/24/08
in the Value field. The function queries only records whose date field contains 5/24/08 as a value.
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k. Add additional criteria by clicking the New button. Determine the relationship between each criterion
by selecting AND or OR from the last Suffix drop‑down list.

l. Click Save at the bottom of the window to save the expression and add it to the formula.

m. To view or edit an expression, click its hyperlink name, located in the Expressions section of the
Rating Type portlet.

n. Add IF-ELSE statements in the formula. The classic style supports one-level IF-ELSE statements,
and the EMSE style supports complex IF-ELSE statements.

You can define criteria to add as criteria in the IF clause. The steps are the same as the criteria
definition steps for expressions except that you define the criteria in the Criteria section. See step d.

Below is a sample classic style formula with an IF-ELSE statement including a criteria and
expression. Note that the “if” and “else” must be in lower case.

if($$CRITERIA::ta$$) 

{$$EXPRESSION::test1$$+$$EXPRESSION::test1$$} 

else if($$CRITERIA::ba$$) 

{[ASSET::attr1]+10} 

else {0} 
 

o. (EMSE style only) Add variables and functions in the formula. You can define variables and
functions and use them in the formula, same as in normal EMSE scripts. For information on writing
EMSE scripts, see the Accela Civic Platform Scripting Guide.

p. (EMSE style only) Add the function ratingFormula.setReturnRating(returnValue) to set the return
value of the formula as the rating value.

Below is a sample EMSE style formula with user-defined variables and functions.

var tempValue1, tempValue2; 

if($$CRITERIA::CircleEqual2$$) 

   {tempValue1=[CA::LengthNum]} 

else{tempValue1=[CA::LengthNum}*5 

if($$CRITERIA::MeterLength7$$) 

   {tempValue2=[CA::LengthNum]} 

else{tempValue2=0} 

function addLength(a){return a+tempValue2;} 

ratingFormula.setReturnRating(tempValue1+addLength(10)) 
 

5. Before you save the formula, you can validate it to make sure it contains no errors. Click Validate.
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Civic Platform returns the validation passed message if the formula meets system criteria.

Civic Platform returns an error message under the following circumstances:

• The formula contains undefined variables.

• The formula contains non-numeric variables.

• The formula contains observation variables that you can only use in defining an expression.

• The formula contains undefined expressions.

• The formula contains undefined criteria. Civic Platform prompts you with correct syntax, if this is a
syntax error.

6. Click Submit.

Civic Platform updates the Rating Types list portlet.

Table 188: Rating Formula Functions

Sum This function returns the sum of the values of the selected field for the records that
match the expression criteria.

Count This function returns the number of records whose value for the selected field matches
the expression criteria.

Average This function returns the average value of the selected field for the records that match
the expression criteria.

Max Min Together, these functions return the largest or smallest value of the selected field for
the records that match the expression criteria. For example, administrators can use a
maximum function and a minimum function in the asset rating formula to get the largest
or smallest observation scores on a condition assessment.

Table 189: Rating Formula Relational Operators

!= Not equal to

< Less than

<= Less than or equal to

= Equal to

> Greater than

>= Greater than or equal to

IS NOT NULL Used to query fields that contain any value, regardless of what that value is.

When you use this operator, do not use a variable in the third field.

IS NULL Used to query fields that do not have a value. For example, you might set up a data
filter to query for records assigned to a certain department, but not to any individual
within the department.

When you use this operator, do not use a variable in the third field.

LIKE The alphabetic character field values that you want to include in the filter or query
contain a string (alphabetic characters). For example, if you want to set up a query
to list all contacts with the string “Jeff” in their email addresses, choose “Like” as the
relational operator and enter “Jeff” as the value.

IN This operator can substitute multiple criteria. Enter multiple values, and the operator
returns records that match any one of the values.
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When you use the IN operator in an expression, the values you enter must be
uppercase. Civic Platform supports only the values A, B, and C, and not a, b, and c, for
example.

Setting Up a Parts Inventory
Use the part inventory to add one or more new parts. Each time you add a new part to the inventory, Civic
Platform calculates the total supply on hand. These parts are also available for use when creating part
transactions and when creating work orders.

When you have more than one location for a part, you can update the location and quantity on hand for the
part by creating a part transaction. You generate a part transaction each time you assign a part to a work
order, a location receives a part order, you transfer a part between locations, you reserve a part, or you
make manual stock adjustments.

This section explains how to maintain the part inventory by adding and removing parts, identifying
locations, and adding and updating approved contacts.

Click a topic title below for full details.

Related Links

Adding a New Part Inventory

Editing a Part Inventory

Searching a Part Inventory

Deleting from a Part Inventory

Managing Part Locations

Managing Part Contacts

Adding a New Part Inventory
To add a new part to the part inventory

1. In V360 Administration, click the Part Inventory main link. If you are using the default settings, this
appears on the main console as a hyperlink name.

Civic Platform displays the list of all parts in the parts inventory.

2. Click New.

Civic Platform displays the part details portlet.
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3. Enter the Part Number first, and then enter the Units of Measure and Calculate Type

4. Complete any of the remaining fields in the part details.

For a list of field descriptions, see Table 190: Part Inventory Detail.

5. Click Submit.

Editing a Part Inventory
You can update the part inventory details as needed. For example, a vendor no longer carries a brand of
oil filters that your agency uses, but carries a different brand for the same type of an oil filter. In this case,
go the part inventory, search for oil filter, and then change the brand in the part details.

To edit a part

1. In V360 Administration, click the Part Inventory main link. If you are using the default settings, this
appears on the main console as a hyperlink name.

Accela Civic Platform - Asset displays the list of all parts in the parts inventory.

2. Click Search.

Accela Civic Platform - Asset displays the fields that apply to the part.
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3. Enter the Part Number if you have it. If you do not have the Part Number, select the Part Type, and then
enter the Part Description and Part Brand.

4. Complete any of the fields that display that apply to the part you are searching for.

5. Click Submit.

Accela Civic Platform - Asset returns a list of all parts that match your search parameters.

6. Open the part that you want to review and edit by clicking on the part number.

Accela Civic Platform - Asset displays the part details portlet.

7. Update any of the fields that display.

For a list of field descriptions, see Table 190: Part Inventory Detail.

8. Click Submit.

Table 190: Part Inventory Detail

Calculate Type Select the calculate type, Accela Civic Platform - Asset uses this type to calculate the
average cost of the part: Simple Average: The average cost is equal to the sum of
the unit cost of a current shipment and existing average cost, divided by two. Simple
Average provides the average value of the existing average cost and the cost per unit
of the current shipment.

Weighted Average: This is the same as the Simple Average, but weighted by quantity.
Weighted Average means that the existing part quantity is multiplied by the existing
average cost and then the quantity of the current shipment is multiplied by the unit cost
of the shipment. Then Accela Civic Platform - Asset divides the sum of these values by
the total part quantity.

Comments Enter any comments associated with the part.

Maximum Quantity Enter the maximum quantity of the part.

Minimum Quantity Enter the minimum quantity on hand for the part for all locations.
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Part Brand Enter the brand of the part. For example, Valvoline is the brand for motor oil.

Part Description Enter the description of the part.

Part Number Enter the part number to identify it in the parts inventory list, for example, enter the
manufacturer’s part number or the number that your agency uses for the part.

Part Status Select the status of the part.

Part Type Select the type of part. Example: Fittings, Fleet, Materials.

Reorder Due The status of reorder displays “Yes” if the total supply is greater than the minimum
quantity. The reorder due displays “No” if the total supply is less than the minimum
quantity.

Reorder Quantity Enter the quantity to you want to reorder.

Taxable Use this drop-down list to select the status of whether or not the part is taxable.

Total Supply The total quantity on hand for the part displays in this field. It is a read-only field, which
updates based on part inventory.

Unit of Measure Select the unit of measure for the part. Example: Hours, Miles.

Work Order Task Select the work order task associated with the part usage. Accela Civic Platform -
Asset records part costs only against work order tasks that you complete, or you
associate with a workflow task that is either complete or active.

Searching a Part Inventory
An agency can have thousands of parts at various locations. To find a specific fitting you want to replace
on the city water main, use a search to enter all information you have on the part to filter the search results.

The search criteria might begin with the Part Number. If you do not have the number, identify the Part Type
as fittings, because a fitting is the part needed to fix the water main. Then identify the part description and
the part brand. The unit cost can also help in limiting your search results.

To search for a part in the part inventory

1. In V360, click the Part Inventory main link. If you are using the default settings, this appears on the
main console as a hyperlink name.

Accela Civic Platform - Asset displays the list of all parts.

2. Click Search.

Accela Civic Platform - Asset displays the fields that apply to the part.
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3. Enter the Part Number if you have it. If you do not have the Part Number, select the Part Type, and then
enter the Part Description and Part Brand.

4. Complete any of the fields that display that apply to the part you are searching for.

5. Click Submit.

Accela Civic Platform - Asset returns a list of all parts that match your search parameters.

6. Click the part number for the part you want to review.

Deleting from a Part Inventory
Perhaps you entered a part by mistake or the part is no longer available or used. When you delete a part
from inventory, it is no longer available when creating part transactions and when creating work orders.
Deleting a part also affects the current total supply on hand. The total count subtracts the part from all
locations where the part resides.

To delete a part from the part inventory

1. In V360 Administration, click the Part Inventory main link. If you are using the default settings, this
appears on the main console as a hyperlink name.

Accela Civic Platform - Asset displays the list of all parts in the parts inventory.

2. Select each part from the parts inventory that you want to dissociate.

3. Click Delete on the toolbar.

Accela Civic Platform - Asset displays a message indicating record(s) deleted successfully.
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Managing Part Locations
You can define one or more locations for storing parts. Identifying part locations is helpful when trying to
locate and assign parts to work orders. In addition, each location maintains a current count of quantity
on hand for each part. This section includes the process for maintaining the part locations for the part
inventory.

Topics

• Adding a New Part Location

• Editing a Part Location

• Searching for a Part Location

• Deleting a Part Location

Adding a New Part Location
Adding part locations is necessary to track parts. Each part location maintains a current total supply on
hand for each part. Civic Platform uses the part supply when locating parts for work orders, re-orders, and
transferring of parts from locations. When you add a location, it is available for reference and association
with specific parts within the parts inventory.

To add a new part location

1. Access the Part Location portlet (Navigating to the Setup Portlet).

Accela Civic Platform - Asset displays a list of all existing part locations.

2. Click New.

Accela Civic Platform - Asset displays the part location details portlet.

3. Enter the Location Name.

4. Complete any of the fields that display.

For a list of field descriptions, see Table 191: Part Location Detail.

5. Click Submit.

Editing a Part Location
Use the following procedure to edit a part location if the contact or location changes. If the contact for the
location changes, find the location using the search, and then modify the contact name, phone number, or
its location to reflect the current information.

To edit a part location

1. Access the Part Location portlet (Navigating to the Setup Portlet).

Accela Civic Platform - Asset displays a list of all existing part locations.

2. Open the part location that you want to review and edit.

Accela Civic Platform - Asset displays the part location details portlet.
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3. Update any of the fields that display. For a list of field descriptions, see Table 191: Part Location Detail.

4. Click Submit.

Table 191: Part Location Detail

Address 1 Enter the first address of the location.

Address 2 Enter the second address of the location.

Business Enter the business name for the location.

City Enter the name of the city for the location.

Comments Enter any comments about the location.

Contact First Name Enter the first name of the contact for the location.

Contact Last Name Enter the last name of the contact for the location.

Contact Title Enter the title of the contact for the location.

Fax Enter the fax number for the location.

Location Name Enter the name of the location.

Location Type Use the drop-down field to select the location type. Example: Warehouse, Store Room,
Equipment.

Phone Enter the contact phone number for the location.

State Use the drop-down field for the name of the state for the location.

Zip Code Enter the zip code for the location.

Searching for a Part Location
Some agencies have multiple locations. When looking for a location, enter the information that you have on
the location in to the search to limit the results.

For example, if you are looking for a part location in your city, enter the city in your search criteria along
with any other information you want to use to filter the results. The search result provides you with all of the
locations in the specified city.

To search for a part location

1. Access the Part Location portlet (Navigating to the Setup Portlet).

Accela Civic Platform - Asset displays a list of all existing part locations.

2. Click Search.

Accela Civic Platform - Asset displays the fields that apply to the part location.
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3. Enter the Part Location Name if you have it. If you do not have the Part Location Name, enter the Part
Location Address or City.

4. Complete any of the fields that display.

5. Click Submit.

Accela Civic Platform - Asset returns a list of all locations that match your search parameters.

Deleting a Part Location
Perhaps you entered a location by mistake or it is no longer available for use. When you delete a part
location, it is no longer be available when agency users create parts or associate parts with work orders.

You can delete a part location you have never used. You can also delete a part location that does not
have any stored parts, which includes reserved parts and the quantity on hand. If a part location has any
reserved parts or if the part quantity is greater than zero, you cannot delete the part location.

For instructions on how to modify the number of reserved parts and part quantities, see the “Part Inventory”
chapter in the Accela Civic Platform User Guide.

To delete a part location

1. Access the Part Location portlet (Navigating to the Setup Portlet).

Accela Civic Platform - Asset displays a list of all existing part locations.

2. Select each part location that you want to dissociate.

3. Click Delete on the toolbar.

Accela Civic Platform - Asset displays a message indicating records deleted successfully.

Managing Part Contacts
Part contacts are vendors and manufacturers your agency has approved to supply the agency with specific
parts. You can link one or more contacts to parts and reference them for questions on pricing, orders,
defects, and use of the parts they supply. This section describes the process for maintaining the part
contacts for the part inventory.

Topics

• Adding a New Part Contact

• Editing a Part Contact

• Searching for a Part Contact
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• Deleting a Part Contact

Adding a New Part Contact
Part contacts are vendors that your agency has approved to supply parts your agency uses regularly. After
you add a contact you can associate it with specific parts, and then reference it for questions on pricing, re-
orders, defects, and use of parts they supply.

To add a new part contact

1. Access the Part Contact portlet (Navigating to the Setup Portlet).

Accela Civic Platform - Asset displays a list of all existing part contacts.

2. Click New.

Accela Civic Platform - Asset displays the part contact details in the detail portlet.

3. Select the Contact Flag, then enter the Contact Business Name.

4. Complete any of the fields that display.

For a list of field descriptions, see Table 192: Part Contact Detail.

5. Click Submit.

Editing a Part Contact
Use the following procedure to edit a part contact when a manufacturer's contact information changes.
Simply find the information and modify the name and the phone number to reflect the current information.

To edit a part contact

1. Access the Part Contact portlet (Navigating to the Setup Portlet).
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Accela Civic Platform - Asset displays a list of all existing part contacts.

2. Open the part contact that you want to review and edit.

Accela Civic Platform - Asset displays the part contact details portlet.

3. Update any of the fields that display.

For a list of field descriptions, see Table 192: Part Contact Detail.

4. Click Submit.

Table 192: Part Contact Detail

Address 1 Enter the first address for the contact.

Address 2 Enter the second address for the contact.

Business Name Enter the business name for the contact.

City Enter the name of the city for the contact.

Comments Enter any comments about the contact.

Contact Flag Use the drop-down field to select the contact flag: Manufacturer or Vendor.

Contact Last Name Enter the last name of the contact.

Contact Middle Name Enter the middle name of the contact.

Contact Title Enter the title of the contact.

Contact Type Use the drop-down field to select the contact type.

Email Enter the email address for the contact.

Fax Enter the fax number for the contact.

Phone Enter the phone number for the contact.

State Enter the name of the state for the contact.

Terms Enter any terms associated with contact arrangement.

Zip Code Enter the zip code for the contact.

Searching for a Part Contact
An agency can have many part contacts which supply many parts. If you are looking for a phone number
for a contact and you have the business name, enter the name into your search criteria along with any
other information you have. The search result provides you with all of the contacts with the same business
name.

To search for a part contact

1. Access the Part Contact portlet (Navigating to the Setup Portlet).

Accela Civic Platform - Asset displays a list of all existing part contacts.



 | Part 9: Asset Management | 947

2. Click Search.

Accela Civic Platform - Asset displays the fields that apply to the part contact.

3. Enter the Part Contact Business Name if you have it. If you do not have the Business Name, enter the
Part Contact Address or City.

4. Complete any of the fields that display.

5. Click Submit.

Accela Civic Platform - Asset returns a list of all contacts that match your search parameters.

Deleting a Part Contact
Perhaps you entered a contact by mistake or it is no longer available or used. When you delete a part
contact, it is no longer available for reference within the part inventory.

To delete a part contact

1. Access the Part Contact portlet (Navigating to the Setup Portlet).

Accela Civic Platform - Asset displays a list of all existing part contacts.

2. Select each part contact that you want to dissociate.

3. Click Delete on the toolbar.

Accela Civic Platform - Asset displays a message indicating record(s) deleted successfully.
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Configuring Work Order Templates
You can configure work order templates that streamline the work order process. The data entry process
for entering work orders can be repetitive and time consuming. Civic Platform provides a way to automate
the process by creating templates that enable you to pre-populate fields in a work order. You can define
one or more templates and specify the exact data to enter automatically when creating a new work order.
In addition to basic work order type, priority, and assignment information, you can also associate costing
information with the template, which speeds the process and improves user efficiency.

Click a topic title below for full details.

Related Links

Managing Work Order Templates

Managing Work Order Tasks

Managing Cost Groups

Managing Work Order Costing

Managing Work Order Templates
Topics

• Creating a Work Order Template

• Searching for a Work Order Template

• Editing a Work Order Template

• Deleting a Work Order Template

• Managing Cost Items within a Work Order Template

• Managing Work Order Template Parts

• Managing Work Order Tasks through a Work Order Template

Creating a Work Order Template
Use work order templates to pre-populate fields in a work order. Define and create work order templates
for specific work orders that you generate regularly. Use templates to eliminate repetitive and time
consuming data entry. The work order basic data that populates from a template are fields such as type,
priority, and assignment information. For information on creating work orders using a work order template,
see "Work Orders" in the Accela Civic Platform User Guide. In addition to basic information, you can also
associate costing, parts, and tasks with a work order template. For information on how to link cost items,
parts, and tasks to a work order, see Managing Work Order Costing, Managing Work Order Template
Parts, and Managing Work Order Tasks.

To create a work order template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the work order template details in the Work Order Template tab.
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3. Enter the Work Order Template Name. Civic Platform uses this name to identify the work order
template when creating new work orders.

4. Enter the Work Order Type, Priority and Assignment. Civic Platform uses these fields to pre-populate
the work order when selected.

Note:

The type data for a template is a combination of four fields: Group, Type, Subtype, and Category. Each
field is dependant upon the next. When you select group from the work order type drop-down list, a drop-
down list populates and the type displays. When you select the type, a drop-down list populates and the
subtype displays. When you select the subtype, a drop-down list populates and the category displays.
The data that you select from the drop-down lists pre-populates work orders when using this template.

5. Complete any other fields that display.

For a list of field descriptions, see Table 193: Work Order Template Definitions.

6. Click Submit.

Civic Platform displays the list of work order templates including the template just created in the tab.

Searching for a Work Order Template
The best way to search for a work order template is to perform a search for the work order template name.
The name of the template displays in the work order template drop-down list you see when creating a new
work order. If you do not have the work order name, the work order type group, type, subtype, or category
are other useful fields to use to limit your search results.

To search for a work order template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the fields that apply to the work order template.
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3. Enter the Work Order Template Name. If you do not have the name, enter the Type, Group, Subtype,
and/or Category.

4. Complete any other relevant search fields.

5. Click Submit.

Civic Platform returns a list of work order templates that match your search parameters.

Editing a Work Order Template
Use the following procedure to update a work order template. For example, the work order priority might
change for a specific type of work order. In this case, identify the work order template that defines the
incorrect priority and modify the template details to reflect the new priority. When you update a work order
template, the new information pre-populates new work orders you generate with that template. This update
does not affect work orders created with the template prior to the update.

To edit a work order template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template that you want to review and edit by selecting the link on the work order
template name.

Civic Platform displays the work order template details on the tabs.

3. Update any of the fields that display.

For a list of field descriptions, see Table 193: Work Order Template Definitions.

4. Click Submit.

Table 193: Work Order Template Definitions

Assigned to Department Select the department assigned to the work order. This field pre-populates the
Assigned to Department field on the work order when creating a work order using the
work order template.

Assigned to Staff Select the staff member assigned to the work order. This field pre-populates the
Assigned to Staff field on the work order when creating a work order using the work
order template.

Comments Enter any comments associated with the work order template.

Description Enter the description associated with the work order template.

Primary Use the drop-down list to set the work order template to be the primary one for
the associated record type. When you create a work order, the basic work order
information defined in the primary template automatically populates into the Assigned
to Department, Assigned to Staff, Description, Work Order Type and Priority fields on
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the work order form. When the work order is submitted, the cost items, parts, and work
order tasks within the primary template automatically associate with the work order,
and they display under the corresponding tab.

Record Status Record Status is a read-only field that indicates if a work order template is Active or
Inactive. The record status is always Active, unless you delete the template.

Work Order Priority Select the priority of the work order. This field pre-populates the Work Order Priority
field on the work order when creating a work order using the work order template.

Work Order Template
Name

Enter the name of the template created for the work order. Civic Platform uses this
name to identify the template when creating a new work order.

Work Order Type This field is a combination of four fields: Group, Type, Subtype, and Category. Each
field is dependant upon the next. Select the work order type group. When you select
the group, the type drop-down list displays. Select the type. When you select the type,
the subtype drop-down list displays. Select the subtype. When you select the subtype,
the category drop-down list displays. Select the category.

Civic Platform uses these fields to pre-populate the work order group, type, subtype,
and category when a user creates a work order using the work order template.

Deleting a Work Order Template
If you enter a work order template by mistake, or if you no longer need it, you can delete it. When you
delete a work order template, it is no longer available for use when creating new work orders. Work orders
previously created using the template remain the same.

To delete a work order template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Select each work order template that you want to remove.

3. Click Delete on the toolbar.

Civic Platform displays a message indicating record(s) deleted successfully.

Managing Cost Items within a Work Order Template
Topics

• Linking a Cost Item to a Work Order Template

• Editing Work Order Template Costing

• Deleting a Work Order Template Cost Item

Linking a Cost Item to a Work Order Template
You create and maintain the costing information you associate with work orders and work order templates
in the cost item definition portlet. For information on how to add cost items, see Managing Work Order
Costing.

To link a cost item to a work order template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template you want to add costing to.

Civic Platform displays details for the work order template.

3. Click the Costing tab.
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Civic Platform displays the list of costs associated with the work order template.

4. Click Lookup.

Civic Platform displays the details for the cost item definition.

5. Complete the fields associated with the cost item(s) you are linking to the template.

For a list of field descriptions, see Table 195: Work Order Cost Item Definitions.

6. Click Submit.

Civic Platform displays the cost item definition search results.

7. Select each cost item you want to associate with the work order template.

8. Click Submit.

Civic Platform creates an association for each cost item, and then displays the work order template
costing list.

Editing Work Order Template Costing
This procedure describes how to edit the costing associated with a work order template. When editing work
order template costing information, some of the cost item definition fields are read-only, such as cost type
and cost item. If you need to update any of the read-only fields, go to the Work Order Cost Item Definition
list portlet. For more information on how to do this, see Managing Work Order Costing.

To edit a work order template costing

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).
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2. Open the work order template you want edit.

Civic Platform displays details for the work order template.

3. Click the Costing tab.

Civic Platform displays the list of costing associated with the work order template.

4. Open the cost item that you want to review and edit.

Civic Platform displays the cost item details on the tabs.

5. Update any of the fields that display and are editable.

For a list of field descriptions, see Table 195: Work Order Cost Item Definitions.

6. Click Save.

Deleting a Work Order Template Cost Item
If you enter a cost item by mistake, or if you no longer need it, you can delete it. When you delete a work
order template cost item, you remove the association between the work order template and the cost item.
The cost item definition is still available when creating work orders and associating costing with other work
order templates.

To delete a work order template cost item

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template you want edit.

Civic Platform displays details for the work order template.

3. Click the Costing tab.

Civic Platform displays the list of costing associated with the work order template.

4. Select each cost item that you want to dissociate.

5. Click Delete on the toolbar.

Civic Platform displays a message indicating record(s) deleted successfully.
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Managing Work Order Template Parts
Topics

• Linking a Part to a Work Order Template

• Editing Work Order Template Costing

• Deleting a Work Order Template Cost Item

Linking a Part to a Work Order Template
Linking parts to a work order template can eliminate user error and can limit the repetitive and time
consuming data entry process of creating work orders. Your agency can define one or more templates and
specify the parts to use for specific types of work orders. There are two steps to linking a part to a work
order template. You must first find the parts using the lookup and you can then associate one or more parts
with the work order template.

The can create and maintain parts and associate them with work orders and work order templates in the
parts inventory portlet. See Setting Up a Parts Inventory for more information on working with parts.

When you create a work order using a work order template, a parts ISSUE transaction generates for each
part. Use these parts transactions to track the usage of the parts and update the current supply on hand
for the part and the location of the part. See Setting Up a Parts Inventory for more information on part
transactions.

To link a part to a work order template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template you want to add parts to.

Civic Platform displays details for the work order template.

3. Click the Parts tab.

Civic Platform displays the list of parts associated with the work order template.

4. Click Look Up

Civic Platform displays the fields associated with the part.
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5. Complete the fields that display to link the part(s) to the template.

For a list of field descriptions, see Setting Up a Parts Inventory.

6. Click Submit.

Civic Platform displays the part search results.

7. Select each part you want to associate with the work order template.

8. Click Save.

Civic Platform creates an association for each part selected with the work order template and displays
the work order template part list.

Editing Work Order Template Parts
Use the following procedure to edit a part in a work order template. However, certain part fields are
read-only. If you need to update any of the read-only fields, go to the Parts Inventory portlet. For more
information on editing parts, see Setting Up a Parts Inventory.

To edit a work order template part

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template you want edit.

Civic Platform displays details for the work order template.
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3. Click the Parts tab.

Civic Platform displays the list of parts associated with the work order template.

4. Open the part that you want to review and edit.

Civic Platform displays the part details on the tabs.

5. Update any of the fields that display and are editable.

For a list of field descriptions, see Setting Up a Parts Inventory.

6. Click Save.

Deleting a Work Order Template Part
If you enter a part by mistake, or if you no longer use a part with a template, you can delete it. When you
delete a work order template part, you remove the association between the work order template and the
part. The part is still available in the parts inventory and used when creating work orders and associating
parts with other work order templates.

To delete a work order template part

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template you want edit.

Civic Platform displays details for the work order template.

3. Click the Parts tab.

Civic Platform displays the list of parts associated with the work order template.

4. Select each part that you want to dissociate.

5. Click Delete on the toolbar.

Civic Platform displays a message indicating record(s) deleted successfully.

Managing Work Order Tasks through a Work Order Template
Users can create new work order tasks to attach to the work order template, attach existing tasks to the
template, and edit the task to fit the needs of the template. For more information on work order templates,
see Creating a Work Order Template.

Topics

• Creating a New Work Order Task from a Work Order Template

• Attaching Existing Work Order Tasks to a Work Order Template

• Editing a Work Order Task Associated with a Template

• Deleting a Work Order Task from a Work Order Template

Creating a New Work Order Task from a Work Order Template
Users can create a new work order task through the work order template. This not only associates the new
work order task with the template, but adds the new task to the Master Work Order list, which you can use
with other templates.

To create a new work order task attached to a work order template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).
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2. Open the work order template that you want to review and edit by selecting the link on the work order
template name.

Civic Platform displays the work order template details on the tabs.

3. Click the Work Order Task tab.

Civic Platform displays a list of all related work order tasks.

4. Click New.

Civic Platform displays the work order task details in the tab.

5. Enter the Task Code.

6. Update any other fields that display.

For a list of field descriptions, see Table 194: Work Order Task Fields.

7. Click Submit.

Attaching Existing Work Order Tasks to a Work Order Template
Linking existing work order tasks to a work order template can eliminate user error and can limit the
repetitive and time consuming data entry process of creating work orders. Your agency can define one or
more templates and specify the tasks required for specific types of work orders. The user can then add
details to the task to make it more applicable to the work order template. For example, a work order task



 | Part 9: Asset Management | 958

described as “Oil Change” can apply to templates for several types of vehicles, but the process might be
different for each.

The work order tasks that you can associate with the work order templates, which you create and maintain
in the work order tasks portlet.

To attach existing work order tasks to a work order template:

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template that you want to review and edit by selecting the link on the work order
template name.

Civic Platform displays the work order template details on the tabs.

3. Click the Work Order Task tab.

Civic Platform displays a list of the work order tasks associated with the template.

4. Click Look Up.

Civic Platform displays the add work order task form.

5. Enter the Work Order Task code and any other fields that display. For a list of field descriptions, see
Table 194: Work Order Task Fields.

6. Click Submit.

Civic Platform displays a list of Work Order Tasks that match the search criteria.



 | Part 9: Asset Management | 959

7. Select the Task Code(s) that you want to add to the template.

8. Update any other fields that display.

For a list of field descriptions, see Table 194: Work Order Task Fields.

9. Click Select.

Editing a Work Order Task Associated with a Template
Use the following procedure to edit a work order task. You might need to do this, for example, to make it
more specific to the work order template. When editing work order template task information, some of the
task definition fields, such as the task code, are read-only. If you want to change the read-only fields, you
must create a new task definition.

To edit a work order task associated with a template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template that you want to review and edit by selecting the link on the work order
template name.

Civic Platform displays the work order template details on the tabs.

3. Click the Work Order Task tab.

Civic Platform displays a list of all related work order tasks.
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4. Open the work order task that you want to review and edit by selecting the link on the work order task
name.

Civic Platform displays the work order task details.

5. Update any fields that display.

For a list of field descriptions, see Table 194: Work Order Task Fields.

Note:

If you assigned the work order task to a workflow task, the workflow task status must be Complete before
you can complete the work order task. When a work order task is complete, the task displays in green to
users of Civic Platform.

6. To reset fields to the default value, click the Reset button.

7. Click Submit.

Deleting a Work Order Task from a Work Order Template
If you enter a task by mistake, or if you no longer use a task with a template, you can delete it. When you
delete a work order task, you remove the association between the template and the task. The task is still
available in the task inventory and you can use it when creating work orders and associating tasks with
other work order templates.

To delete a work order task from a work order template

1. Access the Work Order Template portlet (Navigating to the Setup Portlet).

2. Open the work order template that has the task that you want to delete.

Civic Platform displays the work order template details in the tab.



 | Part 9: Asset Management | 961

3. Click the Work Order Tasks tab.

Civic Platform displays the list of work order templates in the tab.

4. Select the task you want to delete.

5. Click Delete.

Managing Work Order Tasks
You can manage work order tasks through the work order form. You might need to do this if the task is
relevant for multiple different work order templates. For example, a work order task described as “Oil
Change” can apply to templates for several types of vehicles.

Topics

• Creating a Work Order Task

• Searching for Work Order Tasks

• Editing Work Order Tasks

• Deleting Work Order Tasks

• Managing Work Order Templates within a Work Order Task

• Managing Work Order Types

Creating a Work Order Task
A work order task is a step in completing a work order activity. An administrator creates a standard set of
work order tasks for users to place in one or many templates. These tasks have little to do with the flow of
a work order, but instead become a checklist or set of instructions for the individual or crew performing the
work. For this reason, they are adjustable per work order. For example, vehicle needs maintenance. The
technician can create a single work order, and add multiple tasks to the work order, such as changing the
oil and inspecting the brakes.
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The basic data populates for the task include: Task Code, Description, and Default Standard Operating
Procedures. Civic Platform updates this data when you add a task to a work order template.

To create a work order task

1. Access the Work Order Task portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the work order task details in the tab.

3. Complete the Work Order Task Fields.

For a list of field descriptions, see Table 194: Work Order Task Fields.

4. Click Submit.

Table 194: Work Order Task Fields

Comments Enter any comments associated with the work order task. These comments default into
the Work Order Task when you associate the task with the Work Order Template.

Default Estimate The anticipated number of units of time, such as 3 weeks, required to complete the
task. If you do not check this box when adding the task to a work order template, Civic
Platform disables the Duration Unit option.

Description Enter the description associated with the work order task.

Duration Unit The anticipated unit of time needed to complete the task, such as day, week, or month.
This field works in conjunction with the Default Estimate field. For example, if you do
not check the Default Estimate field when adding the task to a work order template,
Civic Platform disables this option.

Effective Date The date the task was first active in the software. Administrators can create tasks
ahead of time to prepare for use in Civic Platform. The Effective Date must occur
before the Expire Date.

Allow Estimate Change Choose whether you want to allow changes to the estimate.

Expire Date The date the task expires. This allows administrators to remove tasks while still
maintaining history. The Expire Date selected must occur after the Effective Date.

Order The order of the task in comparison to the other tasks in the work order. This allows for
the tasks to ordered sequentially.

Record Status Civic Platform sets new work order tasks to Active automatically when created. When
you delete a task you set it to an inactive status. To reactivate a task, look up inactive
tasks and then select the active status.

Standard Operating
Procedures

Enter the established or prescribed method you want users to routinely follow for the
performance of the task. For example, “Clean sample tube with brush.”
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Task Code The identification code number for a work order task. This is a required field. You
cannot assign the same Task Code to two different tasks.

Updated By The user who last updated the work order task. This field is read-only.

Updated Date The most current date for the work order task record. This field is read-only.

Searching for Work Order Tasks
You can search for a work order task from the Work Order portlet or from the Work Order Task tab on
the Work Order Template portlet. After you have received the filtered search results list you can identify
the task you are looking for by clicking the link on the work order task name. For more information on
searching for a task from the Work Order Template portlet, see Attaching Existing Work Order Tasks to a
Work Order Template.

To search for a work order task definition

1. Access the Work Order Task portlet. Refer to Navigating to the Setup Portlet.

2. Click Search.

Civic Platform displays the work order task search form.

3. Enter the work order Task code and any other fields that display.

For a list of field descriptions, see Table 194: Work Order Task Fields.

4. Click Submit.

Editing Work Order Tasks
Use the following procedure to edit the default work order task definition fields. For example, if the Effective
Date for a task has changed, you can update that field. Editing a work order task definition does not
reset the values for tasks that you previously attached to templates and then altered, but your edits are
applicable to future templates. All fields except for the Task Code are available for editing. To change the
task code, you must create a new work order task definition. Refer to Creating a Work Order Task.

To edit a work order task definition

1. Access the Work Order Task portlet (Navigating to the Setup Portlet).

2. Open the work order task that you want to edit.

Civic Platform displays the work order task details in the tab.
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3. Update the desired fields.

For a list of field descriptions, see Table 194: Work Order Task Fields.

4. To reset fields to the default value, click the Reset button.

5. Click Submit.

Deleting Work Order Tasks
If you enter a work order task by mistake, or if you no longer use the task, you can delete it. When you
delete a work order task, it does not display in the Work Order Task list, and you cannot attach the task
to a template. Before you delete a task, you must remove any attached work order templates. You cannot
delete any work order tasks that you attached to a work order template. For more information on removing
attached work order templates from a task, see Deleting a Work Order Task from a Work Order Template.

To delete work order tasks

1. Access the Work Order Task portlet (Navigating to the Setup Portlet).

2. Select the task you want to delete.

3. Click Delete.

Managing Work Order Templates within a Work Order Task
You can associate a task with more than one work order template. Users can view the work order
templates related to a task on a separate tab of the work order task form. The tab presents the work order
template name, description, task SOP, estimate, comments, task, status, the date you last updated the
template, and the user who last updated the template. For example, you can use the task “Oil Change”
for several types of vehicle work orders. When the user selects that task, Civic Platform displays all the
templates you attached the task to.

Topics

• Linking a Work Order Template to a Work Order Task

• Editing a Work Order Task Specific to a Work Order Template

• Resetting Task Defaults

• Deleting a Work Order Template from a Work Order Task
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Linking a Work Order Template to a Work Order Task
You can link a work order template to a work order task. When you link a work order template to a work
order task, Civic Platform adds the work order template to the Work Order Template list. You can associate
the same work order template with multiple work orders.

For example, you can associate a work order task named “Oil Change” with templates for several types of
vehicles, but the task process for the oil change might be different in each template.

For more information on attaching existing work order tasks to a work order template, see Attaching
Existing Work Order Tasks to a Work Order Template.

To link a work order template to a work order task

1. Access the Work Order Task portlet (Navigating to the Setup Portlet).

2. Open the work order task that you want to view.

Civic Platform displays the work order task details in the tab.

3. Click the Work Order Templates tab.

Civic Platform displays a list of all existing work order task descriptions including the item just recorded.

4. Click New.

Civic Platform displays the Add Template task form.

5. Enter the Work Order Template name, task Standard Operating Procedure, and Estimate completion
time.

6. Complete any of the remaining fields that display.

For a list of field descriptions, see Table 194: Work Order Task Fields.

7. Click Submit.

Editing a Work Order Task Specific to a Work Order Template
Use the following procedure to edit a work order task to make it more specific to the work order template.
When editing work order task information, some of the task definition fields, such as the Task Code, are
read-only. If you want to change the read-only fields, you must edit the original task. To edit a new task,
see Editing Work Order Tasks.

To use the task form to edit a work order task associated with a work order template
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1. Find the work order task you want to edit.

For instructions on how to find a work order task, see Searching for Work Order Tasks.

2. Click the Work Order Template that you want to update.

Civic Platform displays the Work Order Template form.

3. Update the desired fields.

For a list of field descriptions, see Table 194: Work Order Task Fields.

Note:

If you assigned the work order task to a workflow task, you must set the workflow task to Active or
Complete before you can complete the work order task. When a work order task is Complete, the task
displays in green to users of Civic Platform.

4. To reset fields to the default value, click the button.

5. Click Submit.

Resetting Task Defaults
This procedure describes how to reset the default values for a work order task attached to a template. You
might need to do this, for example, if you enter a value that is no longer valid. For example, your agency
uses a new type of oil in all vehicles. Instead of having to manually update each task through the work
order template, the user can update the SOP in the work order task template. When you reset the values,
they automatically update to the values specified in the work order task description.

To reset task defaults

1. Access the Work Order Task portlet (Navigating to the Setup Portlet).

2. Click the Work Order Task attached to the template that you want to edit.

Civic Platform displays the Work Order Task Details.

3. Click the Work Order Template tab.

Civic Platform displays a list of all attached work order templates.

4. Select the Template where you want to reset the task default values.

5. Click the Reset Defaults button.
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Note:

You can also reset the work order task default values within the Work Order Task Detail tab by clicking
the Reset button before saving changes made.

Deleting a Work Order Template from a Work Order Task
If you enter a task by mistake, or if you no longer use a task with a template, you can delete it. When
you delete a work order template task, Civic Platform removes the association between the work order
template and the task. The task is still available in the task inventory and used when creating work orders
and associating tasks with other work order templates.

To delete a work order task from a work order template

1. Find the work order task you want to delete from a work order template.

For instructions on how to find a work order task, see Searching for Work Order Tasks.

2. Select the template you want to delete.

3. Click Delete.

Managing Work Order Types
When you associate a work order template with a work order task, Civic Platform associates the work order
type assigned to the template with the task. For more information on associating a work order template
with a work order task, see Linking a Work Order Template to a Work Order Task.

Topics

• Associating a Work Order Type with a Work Order Task

• Removing Associations between Work Order Types and Tasks

Associating a Work Order Type with a Work Order Task
You can associate a work order type with a work order task. For example, you might want to associate the
work order type for water pump maintenance to all the related work order tasks, such as flow test and oil
level check.

To associate a work order type with a work order task

1. Find the work order task to which you want to associate a work order type.

For instructions, see Searching for Work Order Tasks.

2. Click the name of the work order task.

Civic Platform displays the work order task details.
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3. Click the Work Order Types tab.

Civic Platform displays a list of all existing work order types related to the work order task.

4. Click Assign.

Civic Platform displays the Record Type Select page.

5. Expand and collapse the navigation tree and select the work order type you want to associate with the
selected work order task. Alternatively, you can search for a work order type using the Search button.

6. Select the work order type you want to associate with the selected work order task.

7. Click Submit.

Civic Platform associates the work order type with the selected work order task and then displays a
confirmation message.
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Removing Associations between Work Order Types and Tasks
You can remove the association between a work order type and a work order task. For example, you might
want to remove work order types from the tasks they no longer relate to, or you might need to correct an
error.

When you remove the association between a work order type and a work order task, you do not delete the
work order type.

You can also remove the association between a work order template and a work order task. When you
remove a template from a task, Civic Platform removes the association between the template’s work order
type and the work order task.

For more information on removing the association between a work order template and a work order task,
see Deleting a Work Order Template from a Work Order Task.

To remove the association between a work order type and a work order task

1. Find the work order task from which you want to remove a work order type.

For instructions, see Searching for Work Order Tasks.

2. Click the name of the work order task.

Civic Platform displays the work order task details.

3. Click the Work Order Type tab.

Civic Platform displays a list of all existing work order types related to the work order task.
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4. Select the work order type you want to remove from the selected task.

5. Click Delete.

Civic Platform removes the association between the work order type and the work order task and then
displays a confirmation message.

Managing Cost Groups
In your agency some cost items might always work together. For example, for the installation of the fire
hydrant, the cost items always include the contractor, a fire hydrant, a hose, and some other items. The
Work Order portlet allows users to look up and select cost items by cost groups. If you can group the cost
items together, you can simplify the work order creation process.

Topics

• Creating a Cost Group

• Searching for a Cost Group

• Editing a Cost Group

• Deleting a Cost Group

• Managing Cost Items in a Cost Group

• Managing Cost Group Permissions

Creating a Cost Group
You can select cost items and create a cost group for them.

To create a cost group

1. Access the Cost Group (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the cost group details in the secondary tab.

3. Specify the group name, provide a description for the group if you want, and then click Submit.

Civic Platform displays a list of all existing cost groups including the item just recorded.
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Searching for a Cost Group
You can search for a cost group and edit it.

To search for a cost group

1. Access the Cost Group (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the Cost Group search form portlet.

3. Specify the group name, provide a description for the group if you want, and then click Submit.

Civic Platform displays a list of cost groups that match the search criteria.

Editing a Cost Group
You can select a cost group and edit the details.

To edit a cost group

1. Access the Cost Group (Navigating to the Setup Portlet).

2. Click the link for the cost group you want to modify.

You might need to search for the cost item. For instructions on performing a search, see Searching for
a Cost Group.

Civic Platform displays the Cost Group details.

3. Update the necessary fields that display.

4. Click Save.

Civic Platform saves the changes for the cost group.

Deleting a Cost Group
You can delete any cost group that you no longer need.

To delete a cost group

1. Access the Cost Group (Navigating to the Setup Portlet).

2. Select each cost group that you want to delete.

Civic Platform displays the fields that apply to the cost group.

3. Click Delete.

Civic Platform displays a message indicating cost group(s) deleted successfully.

Managing Cost Items in a Cost Group
The Cost Item tab for a cost group lists all the cost items you add into the cost group.

Topics

• Adding Cost Items into a Cost Group

• Removing Cost Items from a Cost Group

Adding Cost Items into a Cost Group
If you find that some cost items are missing from the cost group, you can look up all available cost items to
find the cost items and add them to the cost group.
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To add cost items into a cost group

1. Access the Cost Group (Navigating to the Setup Portlet).

2. Click Look Up in the Cost Item tab for a cost group.

Civic Platform displays the fields that apply to the cost item for the look up.

3. Complete the appropriate fields based on which you want to look for cost items. For a description of
fields, see Table 195: Work Order Cost Item Definitions.

4. Click Submit.

Civic Platform displays the lookup result list.

5. Select the cost items you want to add to the cost group.

6. Click Select.

Civic Platform displays a confirmation message.

Removing Cost Items from a Cost Group
You can remove any cost item from a cost group.

To remove cost items from a cost group

1. Access the Cost Group (Navigating to the Setup Portlet).

2. Click the link for the cost group you want to modify. You might need to search for the cost item.

Civic Platform displays the cost group details in the secondary tab.

3. Select the Cost Item tab.

Civic Platform displays a list of cost items included in the cost group.

4. To remove one or more items, select the items and then click Delete.

Civic Platform displays a confirmation message.

Managing Cost Group Permissions
You can see the agencies, modules, user groups, departments, and users assigned to the cost group on
the Recipient tab in the Cost Group portlet (Navigating to the Setup Portlet). For more information, see
Setting Up Security Policies.

Managing Work Order Costing
Work orders must identify costing information such as employee hourly rates, and material and equipment
costs, to accurately track the total cost of a specific job. Administrators have the ability to create cost items,
associates cost rates to cost items, and assign cost items to user group, department or agency. Users with
permissions can associate cost items with work orders.

Topics

• Adding a Work Order Cost Item

• Searching for a Work Order Cost Item

• Editing a Work Order Cost Item

• Deleting a Work Order Cost Item
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• Managing Cost Rates

• Managing Cost Item Permissions

Adding a Work Order Cost Item
The breakdown of the cost information associated with work order is also very important. For example,
employee hourly rates, material and equipment costs are types of costing items you must identify and track
for work orders generated by an agency. You must identify the costing item definitions that you associate
with a work order before you can enter costing data for a work order. Some of the information recorded
for each cost item is read-only for users without administrative privileges, but is available for the user to
associate with the work order.

To add a new work order cost item

1. Access the Cost Item portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the cost item details in the tab.

3. Enter the Cost Type, Item, Factor, and Cost.

4. Complete any of the remaining fields that display.

For a list of field descriptions, see Table 195: Work Order Cost Item Definitions.

5. Click Submit.

Civic Platform displays a list of all existing work order cost items including the item just recorded.

Searching for a Work Order Cost Item
Use the search feature to find a specific work order cost item. For example, if you were looking for an
equipment cost item currently set at a fixed price of $50, enter the cost type of equipment and the fixed
price cost to 50 in your search criteria along with any other information you might you have on the item.
The search result provides you with all of the equipment cost items set at $50.

To search for a work order cost item

1. Access the Cost Item portlet (Navigating to the Setup Portlet).

2. Click Search.

Civic Platform displays the fields that apply to the work order cost item.

3. Complete the appropriate fields associated with the cost item you are searching for.

4. Click Submit.

Civic Platform returns a list of all work order cost items that match your search parameters.
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Editing a Work Order Cost Item
Use the following procedure to edit a cost item. For example, a contractor who installs fire hydrants
changes the unit cost. In this example, you can find and select the cost item for the specific contractor that
needs updating and modify the fixed cost, unit cost, and units of measure to reflect the current information.

To edit a cost item

1. Access the Cost Item portlet (Navigating to the Setup Portlet).

2. Open the cost item that you want to review and edit.

Civic Platform displays the cost item details on the tabs.

3. Update the necessary fields that display.

For a list of field descriptions, see Table 195: Work Order Cost Item Definitions.

4. Click Submit.

Table 195: Work Order Cost Item Definitions

Cost Account Select the appropriate cost account for the work order.

Cost Factor Select the cost factor. Example: 1.0 Regular Pay, 1.5 Overtime Pay, 2.0 Holiday Pay.
This field is primarily for labor cost types.

Cost Formula Enter the formula that identifies how you want to calculate the cost item.

Cost Item Enter the name for the cost item.

Cost Subgroup Enter the subgroup for the cost item

Cost Type Select the appropriate cost type, such as: contract, employee, materials.

Fixed Cost Enter the fixed cost amount you want to use for the cost item. Enter hours, dollars, etc.
using the appropriate units of measure for the cost item.

Record Status Select the status of the cost item record. This field should default to Active.

Unit Cost Enter the unit cost amount you want to use for the cost item. Enter hours, dollars, and
so forth, using the units of measure appropriate to the cost item.

Unit of Measure Select the unit of measure for the cost item.
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Work Order Task Select the work order task associated with the cost. Only the active or completed work
order tasks display in the list. This item is not for adding cost entries.

Deleting a Work Order Cost Item
If you enter a cost item by mistake, or if you no longer use the cost item, you can delete it. When you
delete a cost item you remove it from Civic Platform and it is no longer available for viewing or when
identifying costing for work orders or work order templates.

To delete a work order cost item

1. Access the Cost Item portlet (Navigating to the Setup Portlet).

2. Select each cost item definition that you want to remove.

3. Click Delete on the toolbar.

Civic Platform displays a message indicating record(s) deleted successfully.

Managing Cost Rates
Cost rates are a critical component of work order management. For example, you must track material and
equipment cost rates to identify and track the costs of work orders your agency generates. When you set
an asset type as a resource in the Administration portlet, you can define the cost rates for the asset. The
cost rates you establish become the default rates that populate into forms when you add assets into work
orders.

Topics

• Adding a Cost Rate

• Editing a Cost Rate

• Deleting a Cost Rate

Adding a Cost Rate
For each asset that you enable the “Asset as Resource” option, you can define multiple cost rates,
although only one cost rate can be effective at any given time.

To add a cost rate

1. Access the Cost Item portlet (Navigating to the Setup Portlet).

2. Select the cost item that you want to work with.

3. Click the Cost Rates tab.

Civic Platform displays the Cost Rate list portlet.

4. Click New.

Civic Platform displays the Cost Rate detail portlet.

5. Complete the fields as necessary.

For a description of the fields, see Table 196: Cost Rate Fields.

6. Click Submit.

Table 196: Cost Rate Fields

Active Date The date when the cost rate becomes effective.
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Expiration Date The date when the cost rate expires.

Default Cost Factor Select the cost factor. Example: 1.0 Regular Pay, 1.5 Overtime Pay, 2.0 Holiday Pay.
This field is primarily for labor cost types. The Standard Choice COST_FACTOR
defines the options for this field.

Fixed Rate The fixed cost amount you want to use for the cost item. Enter units of measure such
as hours, dollars, and so forth.

Unit Rate The unit cost amount you want to use for the cost item. Enter units of measure such as
hours, dollars, and so forth.

Editing a Cost Rate
You can edit any cost rate as necessary.

To edit a cost rate

1. Access the Cost Item portlet (Navigating to the Setup Portlet).

2. Select the cost item that you want to work with.

3. Click the Cost Rates tab.

Civic Platform displays the Cost Rate list portlet.

4. Select the cost rate that you want to update.

Civic Platform displays the Cost Rate detail portlet.

5. Update the fields as necessary.

For a description of the fields, see Table 196: Cost Rate Fields.

6. Click Save.

You can edit any cost rate as necessary.

Deleting a Cost Rate
You can delete the cost rate that is no longer useful.

To delete a cost rate

1. Access the Cost Item portlet (Navigating to the Setup Portlet).

2. Select the cost item that you want to work with.

3. Click the Cost Rates tab.

Civic Platform displays the Cost Rate list portlet.

4. Select the cost rate that you want to delete.

5. Click Delete.

Managing Cost Item Permissions
You can configure the display of cost item information through the Recipient tab in the Cost Item portlet
(Navigating to the Setup Portlet). Only the agency, module, user group, department, or user that you
add to the Recipient tab has permission to work with the cost item in Civic Platform and Mobile Office.
To make cost item permission take effect in Civic Platform, you must set FID 8461 Show Work Order
Cost Information and FID 8484 Cost Item Permission to Full Access or Read Only. However, the
cost item permission that you defined through the Recipient tab always takes effect in Mobile Office,
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regardless of the setting on FID 8484 Cost Item Permission. For instructions on configuring these Function
Identifications, see the Accela Civic Platform Configuration Reference.

In Civic Platform, users with permission can add the cost item to a work order, convert an assignment
to the cost item, and distribute the cost item to certain assets. Users can also view or edit the actual
numerical values of the cost information in the cost-related fields. Users without permission cannot add,
edit, or delete a cost item. Nor can such users convert an assignment to the cost item, or distribute the
cost item. Such users only see asterisks “***” in the cost-related fields for the cost item. See Table 197:
Cost-Related Fields in Civic Platform for a list of cost-related fields that are under control of cost item
permission.

In Mobile Office, users with permission can add the cost item to a work order, and can view, update, or
delete the cost item. Users without permission cannot add, update, or delete the cost item. The actual
values in the cost-related fields for the cost item display as asterisks (*****). See Table 198: Cost-Related
Fields in Mobile Office for a list of cost-related fields that are under control of cost item permission.

For the detailed procedure about using the Recipient tab for a cost item, see Setting Up Security Policies.

Table 197: Cost-Related Fields in Civic Platform

Field Name Field Description Example Access in Civic Platform

Cost The cost of each cost type. Summary tab for a work orderDistribution History
tab for a work order

Cost per Unit The cost per each actual product
unit. Cost per Unit = Total Job Cost/
Actual Prod. Units

Work Order listRecord tab for a work
orderSummary form for a work orderApplication
History tab for a work order

Est. Job Cost(or
Estimated Cost)

The total estimated cost for the work
order.

Work Order listAssignments and Costs tab for a
work order

Fixed Rate The fixed cost rate for the cost item,
based on its unit of measure, such as
hours or dollars.

Assignments and Costs tab for a work order

Total Job Cost (or Total
Cost)

The total calculated job cost for the
work order.

Work Order listSummary tab for a work
orderApplication History tab for a work
orderAssignments and Costs tab for a work order

Undistributed Cost The cost for the work order not
distributed to assets.

Work Order listRecord tab for a work order

Unit Rate The unit cost rate for the cost item,
based on the unit of measure, such
as hours or dollars.

Assignments and Costs tab for a work order

Note:

If users do not have permission to work with the cost items listed on the Application History tab or the
Distribution History tab, they see asterisks “***” instead of actual values in the cost-related fields for all the
cost items.

Table 198: Cost-Related Fields in Mobile Office

Field Name Field Description Example Access in Mobile Office

Total Cost The total calculated job cost for the
work order.

Cost and Parts tab for a work orderCost subtab
for a work orderWork Order Tasks tab for a work
order

Unit Cost The unit cost rate for the cost item,
based on the unit of measure, such
as hours or dollars.

Cost subtab for a work order
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Field Name Field Description Example Access in Mobile Office

Fixed Cost The fixed cost rate for the cost item,
based on the unit of measure, such
as hours or dollars.

Cost subtab for a work order

Attaching Assets to Records
When you associate asset types with record types, you consolidate and filter the data that displays for
users to view during daily processing. As a result, the user only sees applicable record types for that
particular asset type, which eliminates the possibility of accidentally choosing an invalid option from a large
list of choices.

Click a topic title below for full details.

Related Links

Overview of the Assets Common Component

Overview of the Assets Common Component
The Assets Common Component portlet enables users of non-Accela Civic Platform - Asset solutions (the
Land Management, Licensing and Case Management, and Service Request solutions) to access a subset
of asset management functionality, including the following tabs:

• Asset Detail

• Address

• Records

• Linked Assets

• Documents

• Condition

• Contact

Users with the proper permissions can access relevant records from the Assets portlet. For example, a
user with permission to access the Asset Management and Service Request solutions can view Service
Request records from within the Assets portlet.

Enabling Asset Management Across Solutions
To enable this feature, you must set the following FIDs, at a minimum:

• 8189-Asset Data Management

Enables users of the Land Management, Licensing and Case Management, and Service Request
solutions to access the Asset Common Component.

• 8203-Daily Record Asset

Enables the Assets tab on Record Details.

Depending on your configuration of Civic Platform, you might need to set additional FIDs. Refer to the
following for full details:
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• Accela Civic Platform Configuration Reference, Asset Management chapter.

This cross-reference provides a complete list of Asset Management FIDs, organized according to
product area or by feature use case.

• Accela Civic Platform Configuration Reference, Function IDs Reference chapter

In this numerical listing, refer to FID 8189-Asset Data Management, the parent FID, which includes a
detailed listing of all subordinate FIDs with interdependencies, and interoperability information.

Providing Access to the Assets Common Component
To enable users to view and manage assets outside of the Asset Management solution, for example, in the
Land Management, Licensing and Case Management, and Service Request solutions, you must provide
access to the portlet named Assets Common Component. Do this by Adding a Main Link to it.

Main links display along the top of the page in the Civic Platform console, and provide a means of
accessing the portlets where users perform their daily tasks.

Associating Asset Types with Record Types
When you associate asset types with record types, you consolidate and filter the data that displays for
users to view during daily processing. As a result, the user only sees applicable record types for that
particular asset type, which eliminates the possibility of accidentally choosing an invalid option from a large
list of choices.

To associate an asset type with a record type

1. Access the Asset Type Administration portlet (V360 Admin > Assets > Type).

2. With the navigation tree, choose the Asset Type you want to associate with a record type.

3. Click the Record Types tab in the Asset Type detail portlet.

Civic Platform displays the record types currently associated with the asset type.

4. Click Assign.

Civic Platform displays a Record Type navigation tree.

5. Select the record types that you want to associate with the asset type.

• You can click Search to locate a record by typing all or part of the record name.

• Selecting a higher level of organization also selects its subordinate levels.
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6. Click Submit.

Civic Platform displays a success message.

Setting Asset Security to Enable Asset Look Up
To enable public users to use the Look Up feature to locate assets in Citizen Access, you must set the
asset’s security level to Read or Full. If you accept the default security level of None, public users cannot
locate assets with the Look Up feature.

To set security to enable asset look up in Citizen Access

1. Access the Asset Security Administration portlet (V360 Admin > Assets > Security).

2. Navigate to Asset Type by Group, and select the asset type in the navigation tree.

3. Click Assign > Assign Agency.
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4. Select an asset access level of Read or Full, depending on your agency objectives.

5. Click Submit.

Civic Platform displays a success message, Status Saved Successfully.

Configuring the Asset Component in Citizen Access
To enable public users to add assets to applications during the application creation process, you must
configure the asset component’s page flow and page layout. Refer to the Citizen Access Administrator
Guide for instructions on configuring page flows and page layouts.
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Part 10: Licensing
Civic Platform provides functions specific to a licensing solution.

Related Links

Licenses and Education

License Renewal

Licenses and Education
The Education portlet enables you to configure and collect the education information necessary to issue a
professional or occupational license. Refer to Managing Education to configure the education feature.

The Continuing Education portlet enables you to record and track the continuing education requirements
being fulfilled for each of the individuals licensed or certified through your agency. See Managing
Continuing Education to configure the continuing education feature.

The Examination portlet enables you to record the exam scores obtained by individuals seeking to acquire
or maintain their professional certification. See Managing Examinations to configure the examination
feature.

CAUTION: When an administrator uses the Continuing Education or Examination portlets, Civic Platform
automatically creates the Standard Choices CONTINUING_EDUCATION_ REQUIRED_HOURS
and CONTINUING_EDUCATION_WORKFLOW_TASK_STATUS for Continuing Education, and
EXAMINATION_WORKFLOW_TASK_STATUS for Examination, and uses them to store specific data in the Civic
Platform database. Administrators should not manually add or modify the Values or Value Descriptions for these
Standard Choices through the common Standard Choices pages. If an administrator incorrectly configures or
disables one of these Standard Choices, it impacts the functionality of the corresponding Continuing Education or
Examination portlet.

You must also create provider records for each of the educational institutions and any other organizations
offering professional degrees, continuing education, or certification examinations that you want to track.
Refer to “Working with Providers” in the Accela Civic Platform User Guide for specifics on managing
providers.

This section explains how to create provider records, and associate those providers with the specific
education degrees, continuing education offerings, and examinations required to obtain or maintain a
variety of professional licenses.

Click a topic title below for full details.

Related Links

Configuring License Renewal

Managing Expired Licenses and Insurance Lapses

Managing Education

Managing Continuing Education

Managing Examinations
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Configuring License Renewal
To configure renewal functionality, define the expiration code, the renewal record type, and the workflow
associated with the renewal process, for each parent record type requiring renewals. For example, an
electrical license must have the initial electrical license type defined. This is the parent record type.
The electrical license renewal must also have a record type defined. It operates as a child record to the
parent record throughout the renewal process. For complete information on how to configure record
types, see Creating and Configuring Records. Some licenses require a specified number of hours of
additional classroom training or a passing score on an exam before the issuance of a license renewal.
For information on how to configure the renewal process with continuing education and examination, see
Managing Continuing Education and Managing Examinations.

If your agency uses Citizen Access, administrators must perform the following tasks:

• Configure specific fee item settings for Citizen Access Input Required, Auto Assess, and Auto Invoiced.
For information on fees for Citizen Access, see “Configuring Fees and Online Payments” in the Citizen
Access Administrator Guide.

• Configure online payment processing to enable the ability to receive payments online.

• Customize the associated web pages.

• Depending on your implementation, you might need to approve a license associated with a public user
through the Public User portlet in Civic Platform. For information on license approval in the Public User
portlet, refer to Managing Contacts, Licensed Professionals, and Public Users.

For complete information on how to configure license renewals in Citizen Access, see “License Verification
and Online Renewal” in the Citizen Access Administrator Guide.

To configure license renewal

1. If necessary, log in to Civic Platform.

Civic Platform displays your personalized home page.

2. Create an expiration code for the renewal process. Civic Platform assigns this expiration code to the
renewal record type. For additional instructions about expiration codes and renewal processes, refer to
License Renewal.

3. Define the record types for the parent license records and the child renewal records. For instructions on
how to configure Record Type information, refer to Creating and Configuring Records.

Verify the record type has the following list of supporting record type configurations defined and
assigned:

• Renewal option

• Renewal Record Type

• Fee Schedule

• Expiration Code

• Applicable Workflow

• SmartChoice Group

• ASI Group Code

4. For Civic Platform users: If your agency implements continuing education and examinations, refer to
Configuring Continuing Education and Configuring Examinations for setup instructions.
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For Citizen Access users: If your agency implements continuing education and examinations in Citizen
Access, refer to “Certifications and Education” in the Citizen Access Administrator Guide for setup
instructions.

If your agency implements license renewal in Citizen Access, you must define fee items with special
fee item settings for Citizen Access renewals and perform additional configurations in Citizen Access
Admin to enable functionality. Refer to “License Verification and Online Renewal” in the Citizen Access
Administrator Guide for setup instructions.

Managing Expired Licenses and Insurance Lapses
Topics

• Defining Record Type and License Type Expiration Settings

• Configuring Expired License Notifications

Defining Record Type and License Type Expiration Settings
Go to the license verification portlet and define the insurance/license type relationships with record types.

To define record type and license type expirations

1. Access the License Verification Maintenance portlet (Navigating to the Setup Portlet).

2. Create a new record type and license type relationship. Click New.

Civic Platform creates a new row so you can define a record type relationship.

3. Complete each field as defined in Table 199: License Verification Maintenance Fields

4. Click Submit.

Table 199: License Verification Maintenance Fields

Record Type Click the picker icon to search and select the record type you want to define.

License Type Use the drop-down menu to search and select the license type you want to associate
with the record type.

Allow Expired License Use the drop-down menu to define the permissions for the license expiration on the
record type. You can choose For Civic Platform, For ACA, For Both, or None. If you
choose None, you restrict licensed professionals with an expired license from the
record type.

Allow Expired Insurance Use the drop-down menu to define the permissions for the insurance expiration on the
record type. You can choose For Civic Platform, For ACA, For Both, or None. If you
choose None, you restrict licensed professionals with an expired insurance from the
record type.

Allow Expired Business
License

Use the drop-down menu to define the permissions for the business license expiration
on the record type. You can choose For Civic Platform, For ACA, For Both, or None. If
you choose None, you restrict licensed professionals with an expired business license
from the record type.
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Configuring Expired License Notifications
To enable notification functionality, you must define the record type and license type expiration relationship
in the License Verification Maintenance portlet as described in Defining Record Type and License Type
Expiration Settings.

Maintain the email notification list by setting up a batch job that scans Civic Platform for expired licenses,
business licenses, and insurance.

After collecting the expiration data, Civic Platform sends an email notification to the stakeholder associated
with the license, business license, or insurance. You must customize the content of the email notification
EMAIL_NOTICE_LICENSE_EXPIRED. For information on how to customize the content of emails, see
Working with Communication Manager .

To enable expired license and insurance notifications

1. Log in to Civic Platform

2. Define the record type and license type expiration settings. See Defining Record Type and License
Type Expiration Settings

3. Customize the subject and content of the related email. For complete instructions, see Working with
Communication Manager .

• EMAIL_NOTICE_LICENSE_EXPIRED_SUBJECT

• EMAIL_NOTICE_LICENSE_EXPIRED_CONTENT

4. Define a batch job for collecting a list of email addresses associated with expired licenses in the
software. Civic Platform sends an email notification to that list. For information about creating this batch
Job, see Processing Batch Jobs.

Managing Education
Topics

• Configuring Education

• Creating and Using Education Records

Configuring Education
Topics

• Determining Access to Education on Forms

Determining Access to Education on Forms
When a user creates a new application in Civic Platform, the SmartChoice group code associated with the
application type determines which standard sections display on the application. As administrator, you can
choose to define and associate the Education SmartChoice Group to an application type.

To set the Education option in the SmartChoice group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Application > SmartChoice Group.

Civic Platform displays a list of SmartChoice groups.

3. Click the red dot by the SmartChoice group that you want to edit.
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Civic Platform displays the SmartChoice Group Details-Edit page.

4. Update the values for the Continuing Education section of the application as desired.

5. Click Save.

Creating and Using Education Records
Before using the education feature to track education requirements for licenses, you must perform the
following setup tasks:

• Verify the necessary education provider records exist, or create new education provider records, if
needed. Refer to “Contacts and Licensed Professionals” in the Accela Civic Platform User Guide.

• Create and enable an education record containing information about the degree.

• Associate the education record with the education providers that offer the degree.

• Associate the education record with the corresponding record types. You typically associate education
records with new license record types.

You must complete those steps for each education provider, education record, and licensed professional
record type you need to track.

Topics

• Creating an Education Record

• Associating an Education Record with Education Providers
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• Associating an Education Record with a Record Type

• Viewing Education Records

• Searching for Education Records

• Editing Education Records

• Deleting Education Records

Creating an Education Record
An education record contains information about an educational program and degree for a licensed
professional.

To create an education record

1. Access the Education Maintenance portlet (Navigating to the Setup Portlet).

2. Click New.

Civic Platform displays the Education detail portlet.

3. Complete the fields as described.

Education Name Enter a unique name for the education record. For example, you can use the
name of the degree the licensed professional holds, such as Nurse - RN, Nurse -
LPN, Electrical Engineer, or Teacher - Elementary Ed.

Degree Choose the degree required for this educational program from the drop-down list.

Status Enable or disable an education record by selecting an option from the drop-down
list.

Template Choose a default template to associate with the education record. When you make
a selection, the template (ASI/ASIT) fields display on the new education form.
You can enter data in the template fields or leave them blank. If you enter data, it
becomes default data for those same fields when a user or citizen creates a new
education or examination record with that associated template in Civic Platform or
Citizen Access. If you leave any of the template fields blank, the fields are simply
available for the user or citizen to use

Comments Enter any relevant comments about this Education record

4. Click Submit.

Civic Platform adds the education record to the Education Maintenance portlet.

Associating an Education Record with Education Providers
Because multiple Providers might offer the same degree program, you can associate the Education record
with as many Providers as apply.

To associate an Education record with the Education Providers

1. Access the Education Maintenance portlet (Navigating to the Setup Portlet).

2. From the Education Maintenance portlet, select the desired Education record.

Civic Platform displays the Education record in the Education detail portlet.

3. From the Education detail portlet, select the Providers tab.

Civic Platform lists any Providers already associated with this Education record.
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4. To associate this record with another Provider, click Assign.

Alternatively, from the Education Maintenance portlet, select the Education names you need to
associate with Providers, and then click Assign > Assign Provider.

Civic Platform displays a Search window.

5. Enter a portion of the desired Provider Name or Provider Number in the search field, and then click
Submit.

Civic Platform displays a list of Providers that match the search criteria.

6. If the desired Education Provider displays, select the Provider name and click Submit. If there are
multiple Providers that provide this Education, you can select all that apply.

Civic Platform adds the provider to the list of Providers associated with the selected Education records.

• If the desired Education Provider does not display, click Search to retry your search using different
search parameters.

• If you cannot find the desired Education Provider, refer to the “Contacts and Licensed Professionals”
chapter in the Civic Platform User Guide for instructions on creating a new Education Provider
record or adding an existing Continuing Education or Examination Provider to the Education
Provider list.

Associating an Education Record with a Record Type
You can associate an Education record with each of the record types to which it applies.

To associate an Education record with a record type

1. Access the Education Maintenance portlet (Navigating to the Setup Portlet).

2. From the Education detail portlet, select the Record Types tab.

Civic Platform lists any record types already associated with this Education Record.

3. To associate this record with another Record Type, click Assign.

Civic Platform displays the list of available Record Type categories.

4. Expand the Record Type to view subtypes within the category.

Note:

If you are having difficulty locating the desired Record Type, click Search. Enter all or part of the Record
Type alias in the Search Field and click OK. Note that the Search is case‑sensitive. Civic Platform
highlights any Record Types matching your search criteria, making it easier for you to view them in the
list.

5. When you have located the desired Record Types, select the Record Type aliases and click Submit.

Civic Platform adds the Record Type to the list of Record Types associated with this Education record.

6. To remove a Record Type, select the Record Type and click Delete.

Civic Platform removes the Record Type from the list of Record Types associated with this Education
record.

Viewing Education Records
You can view Education records through the Education Maintenance portlet.

To view Education records

1. Access the Education Maintenance portlet (Navigating to the Setup Portlet).
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The Education records that currently exist in Civic Platform display. Civic Platform provides links to
additional pages if it cannot display all records on one page.

Searching for Education Records
You can Search the Education Maintenance portlet for a specific Education record.

To search for an Education record

1. Access the Education Maintenance portlet (Navigating to the Setup Portlet).

2. From the Education Maintenance portlet, click Search.

Civic Platform displays a Search window.

3. Enter a portion of the desired Education record name, and/or any other relevant information, and then
click Submit.

Civic Platform displays a list of Education records that match the search criteria.

4. If the desired Education record does not display, click Search again to retry your search using different
search parameters.

Editing Education Records
You can edit education records through the Education Maintenance portlet.

To edit an Education record

1. Access the Education Maintenance portlet (Navigating to the Setup Portlet).

2. From the Education Maintenance portlet, select the Education record.

Civic Platform displays the Education record in the Education detail portlet.

3. Select the desired tab, and edit the Education record as necessary:
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• Education tab – On this tab, you can view or edit the details about the Education. See Creating and
Using Education Records.

• Providers tab – On this tab, you can view, assign or delete the Education Providers associated with
this Education. See Associating an Education Record with Education Providers.

• Record Types tab – On this tab, you can view, assign or delete the Record Types associated with
this Education. See Associating an Education Record with a Record Type.

Deleting Education Records
Because of the many ways you can connect Education records to other records within Civic Platform,
such as Provider records and Licensed Professional records, the process of deleting an Education record
disables it; it does not remove or delete it from Civic Platform. Instead, Civic Platform performs a “soft
delete,” and changes the record's status to Disabled. Disabling the record allows the record to remain in
any previous associations, but prevents you from using it again. If at some point in the future you need to
use the disabled record, you can edit the record to change its status to Enabled.

To delete (disable) an Education record

1. Access the Education Maintenance portlet (Navigating to the Setup Portlet).

The Education records that currently exist in Civic Platform display.

2. Select the Education you need to disable, and then click Delete.

• If you associated the selected Education record with a Provider and/or a Licensed Professional
Record Type, you cannot delete it.

• If you associated the selected Education record with a Provider and/or a Licensed Professional
Record Type, Civic Platform changes its status to Disabled.

Managing Continuing Education
Topics

• Configuring Continuing Education

• Creating and Using Continuing Education Records

Configuring Continuing Education
Continuing Education provides the capability for a Record to capture and require Continuing Education
information. Users can enter this information on either an application intake form, or the Continuing
Education tab on the Record. Administrators can configure Continuing Education requirements and link
them to Record Types and Continuing Education Providers, as well as to a workflow, preventing Task
completion until the requirements are met. Before creating and working with Continuing Education records,
perform the prerequisite configuration tasks.

Note:

When an administrator uses the Continuing Education portlet, Civic Platform automatically
creates the Standard Choices CONTINUING_EDUCATION_ REQUIRED_HOURS and
CONTINUING_EDUCATION_WORKFLOW_TASK_STATUS, and uses them to store specific data.
Administrators should not manually add or modify the Values or Value Descriptions for these Standard
Choices. If an administrator should incorrectly configure or disable these Standard Choices, it impacts the
functionality of the Continuing Education record setting portlet, and the user receives the error message:
Standard Choice configuration error. Please contact administrator.
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Topics

• Determining Access to Continuing Education on Forms

• Continuing Education Workflow Configuration

Determining Access to Continuing Education on Forms
When a user creates a new application in Civic Platform, the SmartChoice group code associated with
the application type determines which standard sections display on the application, what information
is mandatory. As administrator, you can choose to define and associate the Continuing Education
SmartChoice Group to an application type.

To set the Continuing Education option in the SmartChoice group

1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Application > SmartChoice Group.

Civic Platform displays a list of SmartChoice groups.

3. Click the red dot by the SmartChoice group that you want to edit.

Civic Platform displays the SmartChoice Group Details-Edit page.

4. Update the values for the Continuing Education section of the application as desired.

5. Click Save.

Civic Platform updates the SmartChoice group using the settings you specified.
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Continuing Education Workflow Configuration
Civic Platform uses Workflow Tasks to track the successful completion of Continuing Education
requirements so that the professional license renewal process can proceed to the next task. You define the
workflow process assigned to the record type when you create the record type; however, you must also
assign it to the Continuing Education process through the Record Setting tab of the Continuing Education
Maintenance portlet.

For more information on workflow, refer to Designing Workflows .

Topics

• Assigning a Continuing Education Workflow Task to a Record Type

Assigning a Continuing Education Workflow Task to a Record Type
Assigning a workflow task to Continuing Education takes place at the Record Type level. This setting
instructs Civic Platform which workflow logic to use for a particular Record Type.

To assign a Continuing Education workflow task to a Record Type

1. Access the Continuing Education Maintenance portlet (Navigating to the Setup Portlet).

2. Select the Record Setting tab.

Any Record Types that have already assigned a corresponding Workflow Task/Status Check display.

3. Click Add to add a new Record Type.

Civic Platform adds a blank line to the list.

4. Expand the Record Type navigation tree and browse to locate the desired Record Type. Refer to
Designing Workflows  for more information.

Civic Platform adds the selected record type to the Record Type list.

5. Enter the number of Hours required to meet the Continuing Education requirement at the Record Type
level.

6. Expand the Workflow Task/Status Check navigation tree and browse to locate the desired workflow
task status.

7. From the Record Status drop-down list, select Enabled to activate this Record Setting.

8. Repeat through for each Record Type you need to associate with a Workflow Task.

9. Click Submit.

Civic Platform associates the listed Record Types with the specified Workflow Tasks.

Creating and Using Continuing Education Records
Before using the Continuing Education feature to track ongoing Continuing Education requirements for
Licenses, you must perform the following setup tasks:

• Verify you have created and enabled the necessary Continuing Education Provider records, or create
new Education Provider records, if needed. See the “Contacts and Licensed Professionals” topic in the
Accela Civic Platform User Guide.

• Create and enable a Continuing Education record containing information about the courses and/or
hours required to maintain or renew the specified Professional License.

• Associate the Continuing Education record with the Continuing Education Providers that offer the
degree.
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• Associate the Continuing Education record with the corresponding Licensed Professional Record
Types. You typically associate Continuing Education record with a “renewal license” record type.

You must complete these steps for each Continuing Education Provider, Continuing Education Record,
and Licensed Professional Record Type you need to track.

Topics

• Creating a Continuing Education Record

• Associating Education Records with Education Providers

• Associating a Continuing Education Record with a Record Type

• Viewing Continuing Education Records

• Searching for Continuing Education Records

• Editing Continuing Education Records

• Deleting Continuing Education Records

Creating a Continuing Education Record
A Continuing Education record contains information about ongoing professional development that the state
requires for a Licensed Professional.

To create a Continuing Education record

1. Access the Continuing Education Maintenance portlet (Navigating to the Setup Portlet).

2. Click New to create a new Continuing Education record.

Civic Platform displays the Continuing Education detail portlet.

3. Complete the fields as described.

Education Name Enter a distinctive name for the continuing education record. For example, you can
create a name using an abbreviated form of the course, professional development
program, trade journal, or other program.

Grading Style Select an option from the drop-down list: Pass/Fail, Passing Score, Passing
Percentage, or None. If you select Passing Score or Passing Percentage, an
additional field displays, enabling you to enter the score/percentage required to
pass the course.

Status Enable or disable a continuing education record by selecting an option from the
drop-down list.

Template Choose a default template to associate with the continuing education record.
When you make a selection, the template (ASI/ASIT) fields display on the new
continuing education form. You can enter data in the template fields or leave them
blank. If you enter data, it becomes default data for those same fields when a user
or citizen creates a new continuing education record with that associated template
in Civic Platform or Citizen Access. If you leave any of the template fields blank,
the fields are simply available for the user or citizen to use.

Comments Enter any relevant comments about this continuing education record

4. Click Submit.

Civic Platform creates the Continuing Education record in the Continuing Education Maintenance
portlet.
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Associating Education Records with Education Providers
Because there are often multiple continuing education providers that offer the same professional
development program, you can associate a Continuing Education record with as many continuing
education providers as applicable.

To associate a Continuing Education record with the Continuing Education Providers

1. Access the Continuing Education Maintenance portlet (Navigating to the Setup Portlet).

2. From the Continuing Education Maintenance portlet, select the desired Continuing Education record.

Civic Platform displays the Continuing Education record in the Continuing Education detail portlet.

3. From the Continuing Education detail portlet, select the Providers tab.

Any Providers already associated with this Continuing Education record display in a list.

4. To associate this record with another Provider, click Assign.

Alternatively, from the Continuing Education Maintenance portlet, select the Continuing Education
names you need to associate with Providers, and then click Assign > Assign Provider.

Civic Platform displays a Search window.

5. Enter a portion of the desired Provider Name or Provider Number in the search field, and then click
Submit.

Civic Platform displays a list of Providers that match the search criteria.

6. If the desired Continuing Education Provider displays, select the Provider name and click Submit. If
there are multiple Providers that provide this Continuing Education, you can select all that apply.

Civic Platform adds the provider to the list of Providers associated with the selected Continuing
Education records.

• If the desired Continuing Education Provider does not display, click Search to retry your search
using different search parameters.

• If you cannot find the desired Continuing Education Provider, refer to the “Contacts and Licensed
Professionals” topic in the Accela Civic Platform User Guide for instructions on creating a new
Continuing Education Provider record or adding an existing Education or Examination Provider to
the Continuing Education Provider list.

Associating a Continuing Education Record with a Record Type
You can associate a Continuing Education record with each of the Licensed Professional record types to
which it applies.

To associate a Continuing Education record with a Record Type

1. Access the Continuing Education Maintenance portlet (Navigating to the Setup Portlet).

2. From the Continuing Education detail portlet, select the Record Types tab.

Any Record Types already associated with this Continuing Education record display.

3. To associate this record with another Record Type, click Assign

Civic Platform displays the list of available Record Type categories.

4. Expand the Record Type to view subtypes within the category.

If you are having difficulty locating the desired Record Type, click Search. Enter all or part of the
Record Type alias in the Search Field and click OK. The Search is case-sensitive. Civic Platform
highlights any Record Types matching your search criteria, making it easier for you to view them in the
list.
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5. When you have located the desired Record Types, select the Record Type aliases and click Submit.

Civic Platform adds the Record Type you selected to the list of Record Types associated with this
Continuing Education record.

To remove a Record Type, select the Record Type and click Delete.

Civic Platform removes the record type from the list of Record Types associated with this Continuing
Education record.

Viewing Continuing Education Records
You can view Continuing Education records through the Continuing Education Maintenance portlet.

To view Continuing Education records

1. Access the Continuing Education Maintenance portlet (Navigating to the Setup Portlet).

The Continuing Education records that currently exist in Civic Platform display. If there are more
records than Civic Platform can display on a single page, links to additional pages display.

Searching for Continuing Education Records
You can Search the Continuing Education Maintenance portlet for a specific Continuing Education record.

To search for a Continuing Education record

1. Access the Continuing Education Maintenance portlet (Navigating to the Setup Portlet).

2. From the Continuing Education Maintenance portlet, click Search.

Civic Platform displays a Search window.

3. Enter a portion of the desired Continuing Education record name, and/or any other relevant information,
and then click Submit.

Civic Platform displays a list of Continuing Education records that match the search criteria.

4. If the desired Continuing Education record does not display, click Search again to retry your search
using different search parameters.

Editing Continuing Education Records
You can edit Continuing Education records through the Continuing Education Maintenance portlet.

To edit a Continuing Education record

1. Access the Continuing Education Maintenance portlet (Navigating to the Setup Portlet).

2. From the Continuing Education Maintenance portlet, select the Continuing Education record you need
to edit.

Civic Platform displays the Continuing Education record in the Continuing Education detail portlet.

3. Select one of the following tabs, and edit the Continuing Education record as necessary.

• Continuing Education tab – to view or edit the details about the Continuing Education, see
Creating a Continuing Education Record.

• Providers tab –to view, assign, or delete the Continuing Education Providers associated with this
Continuing Education, see Associating Education Records with Education Providers.

• Record Types tab – to view, assign, or delete the Record Types associated with this Continuing
Education, see Associating a Continuing Education Record with a Record Type.
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Deleting Continuing Education Records
Because of the many ways you can connect Continuing Education records to other records within the
Civic Platform system, such as Provider records, Record Types, and so forth, the process of deleting
a Continuing Education record does not actually remove the record from Civic Platform. Instead, Civic
Platform performs a “soft delete,” and changes the record's status to Disabled. Disabling the record, rather
than fully deleting it, allows the record to remain in any previous associations, but prevents you from using
it again. If at some point in the future you need to use the disabled record, you can edit the record to
change its status to Enabled.

To delete (disable) a Continuing Education record

1. Access the Continuing Education Maintenance portlet (Navigating to the Setup Portlet).

The Continuing Education records that currently exist in Civic Platform display.

2. Select the Continuing Education you want to delete, and then click Delete.

• If you associated the selected Continuing Education record with a Provider and/or a Licensed
Professional Record Type you cannot delete it.

• If you did not associate the selected Continuing Education record with a Provider and/or a Licensed
Professional Record Type, Civic Platform changes its status to Disabled.

Managing Examinations

• Configuring Examinations

• Creating and Using Examination Subjects

Configuring Examinations
Examination provides the capability for a Record to capture and require Examination information. You
can enter this information on either an application intake form, or the Examination tab on the Record.
Administrators can configure Examination requirements and link them to Record Types and Education
Providers, as well as to a Workflow Task and Status, preventing Task completion until the requirements
are met.

Before creating and working with Examinations, you must perform the following setup tasks:

When an administrator uses the Examination portlet, Civic Platform automatically creates the Standard Choice
EXAMINATION_ WORKFLOW_TASK_STATUS, and uses it to store specific data. Administrators should not
manually add or modify the Values or Value Description for this Standard Choice. If an administrator should
incorrectly configure or disable this Standard Choice, it impacts the functionality of the Examination portlet, and the
user receives the error message:“Standard Choice configuration error. Please contact administrator.”

• Determining Access to Examinations on Forms

• Configuring Examination Workflows

Determining Access to Examinations on Forms
When a user creates a new application in Civic Platform, the SmartChoice group code associated with the
application type determines which standard sections display on the application, and what information Civic
Platform requires. As administrator, you can choose to define and associate the Examination SmartChoice
Group to an application type.

To set the Examination option in the SmartChoice group
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1. Access the Classic Administration page (Accessing Classic Administration).

2. Navigate to Application > SmartChoice Group.

Civic Platform displays a list of SmartChoice groups.

3. Click the red dot by the SmartChoice group that you want to edit.

Civic Platform displays the SmartChoice Group Details-Edit page.

4. Update the values for the Examination section of the application as desired.

5. Click Save.

Civic Platform updates the SmartChoice group using the settings you specified.

Configuring Examination Workflows
Civic Platform uses Workflow Tasks to track the successful completion of Examination requirements so
that the professional license process can proceed to the next task. You assign the workflow process to the
Application Type when you create the application; however, you must also assign it to the Examination
process through the Record Setting tab of the Examination Maintenance portlet.

Assigning an Examination Workflow Task to a Record Type
Assigning a workflow task to Examinations takes place at the Record Type level. This setting instructs
Civic Platform which workflow logic to use for a particular Record Type.

To assign an examination workflow task to a record type
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1. Access the Examination Maintenance portlet (Accessing the Examination Maintenance Portlet).

2. Select the Record Setting tab.

Any Record Types you previously assigned a corresponding Workflow Task/Status Check display.

3. Click Add to add a new Record Type.

Civic Platform adds a blank line to the list.

4. Expand the Record Type navigation tree, and browse to locate the desired Record Type.

Civic Platform adds the selected record type to the Record Type list.

5. Expand the Workflow Task/Status Check navigation tree, and browse to locate the desired workflow
task status.

6. From the Record Status drop-down list, select Enabled to activate this Record Setting.

7. Repeat steps 4 - 8 for each Record Type you need to associate with a Workflow Task.

8. Click Submit.

Civic Platform associates the listed Record Types with the specified Workflow Tasks.

Creating and Using Examination Subjects
Before using the Examination feature to track ongoing Examination requirements for Licensed
Professionals, perform the following setup tasks:

• Verify you have created and enabled the necessary Examination Provider records, or create new
Examination Provider records, if needed. See “Contacts and Licensed Professionals” in the Accela
Civic Platform User Guide.

• Create and enable an examination subject containing information about the examination required to
maintain or renew the specified Professional License.

• Associate the examination subject with the Examination Providers that offer the examination.

• Associate the examination subject with the examination providers that offer the examination. You can
also do this in the examination provider (licensed professional) record. For complete information, see
“Contacts and Licensed Professionals” in the Accela Civic Platform User Guide.

Complete those steps for each Examination Provider, examination subject, and Licensed Professional
Record Type you need to track.

• Creating an Examination Subject

• Searching for Examination Subjects

• Editing Examination Subjects

• Associating an Examination Subject with Examination Providers

• Associating an Examination with a Record Type

• Setting Email Reminders

Creating an Examination Subject
Examination Subject contain information about the competency exams that the state requires for Licensed
Professionals to obtain or maintain their license.
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To create an examination subject

1. Access the Examination Maintenance portlet (Accessing the Examination Maintenance Portlet).

2. Click New to create a new examination subject.

Civic Platform displays the Examination detail portlet.

3. Complete the fields as described.

Examination Name Enter a distinctive name for the Examination. For example, Registered Nurses are
required to pass the National Council Licensure Exam, which is titled NCLEX-RN

Grading Style Select an option from the drop-down list: Pass/Fail, Passing Score, Passing
Percentage, or None. If you select Passing Score or Passing Percentage, an
additional field displays, enabling you to enter the score/percentage required to
pass the course.

Status Enable or disable a continuing education record by selecting an option from the
drop-down list.

Workflow Task/Status Check
in ACA

Specify one or more workflow tasks or statuses that can enable public users to
schedule such an examination in Citizen Access.

Note:

This workflow restriction does not apply to agency users. Agency users
can always schedule examinations on a record, regardless of the record's
workflow status.

Template Choose a default template to associate with the continuing education record.
When you make a selection, the template (ASI/ASIT) fields display on the new
continuing education form. You can enter data in the template fields or leave them
blank. If you enter data, it becomes default data for those same fields when a user
or citizen creates a new continuing education record with that associated template
in Civic Platform or Citizen Access. If you leave any of the template fields blank,
the fields are simply available for the user or citizen to use.

Comments Enter any relevant comments about this examination record.

4. Click Submit.

Civic Platform creates the examination subject in the Examination Maintenance portlet.

Searching for Examination Subjects
You can Search the Examination Maintenance portlet for a specific examination subject.

To search for an examination subject

1. Access the Examination Maintenance portlet (Accessing the Examination Maintenance Portlet).

2. From the Examination Maintenance portlet, click Search.

Civic Platform displays a Search window.

3. Enter a portion of the desired examination subject name, and/or any other relevant information, and
then click Submit.

Civic Platform displays a list of examination subjects that match the search criteria.

4. If the desired examination subject does not display, click Search again to retry your search using
different search parameters.
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Editing Examination Subjects
You can edit examination subjects through the Examination Maintenance portlet.

To edit an examination subject

1. Access the Examination Maintenance portlet (Accessing the Examination Maintenance Portlet).

2. From the Examination Maintenance portlet, select the examination subject you need to edit.

Civic Platform displays the examination subject in the Examination detail portlet.

3. Select one of the following tabs and edit the examination subject as necessary.

• Examination tab – to view or edit the details about the Examination, see Creating an Examination
Subject.

• Providers tab – to view, assign, or delete the Examination Providers associated with this
Examination, see Associating an Examination Subject with Examination Providers.

• Record Types tab – to view, assign, or delete the Record Types associated with this Examination,
see Associating an Examination with a Record Type.

• Available Schedules - lists the exam schedules defined in the examination provider (licensed
professional) records. To schedule the exam, see “Contacts and Licensed Professionals” in the
Accela Civic Platform User Guide. You can send email reminders to examinees of the selected
examination schedules. See Setting Email Reminders.

Associating an Examination Subject with Examination Providers
Because there are often multiple Providers that offer the same certification level examination, you can
associate an examination subject with as many Providers as apply.

To associate an examination subject with examination providers

1. Access the Examination Maintenance portlet (Accessing the Examination Maintenance Portlet).

2. From the Examination Maintenance portlet, select the desired examination subject

Civic Platform displays the examination subject in the Examination detail portlet.

3. From the Examination detail portlet, select the Providers tab.

Any Providers already associated with this examination subject display.

4. To associate this record with another Provider, click Assign.

Alternatively, from the Examination Maintenance portlet, select the Examination names you need to
associate with Providers, and then click Assign > Assign Provider.

Civic Platform displays a Search window.

5. Enter a portion of the desired Provider Name or Provider Number in the search field, and then click
Submit.

Civic Platform displays a list of Providers that match the search criteria.

6. If the desired Examination Provider displays, select the Provider name and click Submit. If there are
multiple providers for the Examination, you can select all that apply.

Civic Platform adds the provider to the list of Providers associated with the selected examination
subjects.

7. If the desired Examination Provider does not display, click Search to retry your search using different
search parameters.
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8. If you cannot find the desired Examination Provider, refer to “Contacts and Licensed Professionals” in
the Civic Platform Online Help for instructions on creating a new Examination Provider record or adding
an existing Education or Continuing Education Provider to the Examination Provider list.

Associating an Examination with a Record Type
You can associate an examination subject with each of the Licensed Professional record types to which it
applies.

To associate an examination with a record type

1. Access the Examination Maintenance portlet (Accessing the Examination Maintenance Portlet).

2. From the Examination detail portlet, select the Record Types tab.

Any Record Types already associated with this Education record display.

3. To associate this record with another Record Type, click Assign

Civic Platform displays the list of available Record Type categories.

4. Expand the Record Type to view subtypes within the category.

If you cannot locate the desired Record Type, click Search. Enter all or part of the Record Type alias
in the Search Field and click OK. Note that the Search is case‑sensitive. Civic Platform highlights any
Record Types matching your search criteria, making it easier for you to view them in the list.

5. When you have located the desired Record Types, select the Record Type aliases and click Submit.

The Record Types you selected display on the list of Record Types associated with this examination
subject.

6. To remove a Record Type, select the Record Type and click Delete.

Civic Platform removes the Record Type from the list of Record Types associated with this examination
subject.

Setting Email Reminders
In the Available Schedules portlet, you can configure email reminders to auto-notify examinees of an
upcoming examination. You can also configure email notifications to auto-send to exam proctors, notifying
them of a pending proctor exam assignment or about removing them as a proctor. When proctors receive
a notification of pending assignment, they can click an Accept or a Reject link embedded in the email. Civic
Platform uses this response to update the proctor assignment status.

When you set up a reminder, a batch job is auto-created to auto-generate and send out the notification
emails as specified. You can further configure the batch job to run one time only, or at regular intervals. For
information on how to work with Batch Jobs, see Working with Batch Jobs.

As a prerequisite to this feature, you must do the following before you set the email reminder.

• Create a notification template. See Notification Templates .

• Create an EMSE script named AUTO_GENERATE_EMAIL_REMINDER for examinees or the
ProctorAssignedAfter and ProctorUnassignedAfter for proctor notification.

• To access sample scripts, go to the Help & Training page on Accela's Success Community. Contact
Accela Customer Support for further assistance.

Note:

Contact an Accela Implementation specialist or a system administrator who has received training from an
Accela Implementation specialist to review the script you must run to implement this feature. Improperly
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written scripts can seriously damage your system by incorrectly altering or deleting data for many records.
For information on writing and implementing scripts, see the Accela Civic Platform Scripting Guide.

To set up an email reminder

1. Access the Examination Maintenance portlet (Accessing the Examination Maintenance Portlet).

2. From the Examination Maintenance portlet, click the examination name.

Civic Platform displays the examination detail portlet.

3. Click the Available Schedules tab.

4. Select one or more desired exam sessions for which you want to send reminder emails.

5. Click Set Reminders.

Civic Platform displays the Set Reminder window.

License Renewal
The Licenses module of Civic Platform uses most of the same features as other modules in Civic Platform.
In addition to the functions available in other modules, however, this module has some unique functions.
These include determining renewal requirements for business licenses and adding or editing application
types.

Click a topic title below for full details.

Related Links

Establishing Renewal Information

Managing Application Types

Establishing Renewal Information
Setting up renewal information enables you to determine the expiration date, renewal process and penalty
periods for business licenses. After you configure the renewal information, you can associate the expiration
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code that identifies the renewal process with a certain application type. Any new business license of that
type follows the renewal process that you set up. You can update an existing renewal process as well as
copy a renewal process to create a new one.

Topics

• Creating a Renewal Process

• Searching for a Renewal Process

• Editing a Renewal Process

• Copying a Renewal Process

Creating a Renewal Process
When you create a renewal process, you establish the expiration code to identify the process as well as
the expiration period, grace period, and penalty period intervals. In addition to setting up these intervals,
you determine the fee function to use during batch processing to process licenses with this renewal
process.

Note:

You can also manually create renewal information, workflow status, and fees for an individual license after
you issue the license.

To create a renewal process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > Renewal Info.

Civic Platform displays the Find Expiration Code—Search page.

3. Click Add.

Civic Platform displays the Expiration Code—Add page.
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4. Complete the necessary fields as described in Expiration Code Fields.

5. Click Submit.

Civic Platform saves the renewal process.

Table 200: Expiration Code Fields

Expiration Code Enter a short, descriptive name to identify this renewal process so users can easily
locate the appropriate expiration code.

Description Enter a description to identify what the renewal process does. For example, enter
“Applies to quarterly renewal fee.”

Initial Expiration Method Select the method you want to use to calculate expiration dates. To enable a fixed
expiration date, choose “Fixed Date.” To generate an expiration date based on the
application's initial filing date, choose “Filed Date.”

Expiration Date If you chose Fixed Date in the Initial Expiration Method field, use this drop-down list to
choose the month and date when the license expires. Every license with this expiration
code expires on this day.

Expiration Interval Enter the number of days or months that a license remains active before expiring, then
specify the date unit (days or months) from the drop-down list. For example, to enable
an expiration interval of 2 months, enter “2” in the first field and choose “Months” from
the drop-down list.

Grace Period Interval Enter the number of days or months between the time that the license expires and the
first penalty period, then specify the date unit (days or months) from the drop-down
list. For example, to enable a grace period of 10 days, enter “10” in the first field and
choose “Days” from the drop-down list.

Penalty Interval Enter the number of days or months that each penalty period lasts, then specify
the date unit (days or months) from the drop-down list. After the penalty interval, a
subsequent penalty period can begin depending on the number of penalty periods you
specify in the Number of Penalty Periods field.

Number of Penalty
Periods

Enter the number of penalty periods that can pass before a license becomes inactive.
For each penalty period, you might need to assess an additional penalty fee.

Renewal Fee Function Select the function you want to use to generate the renewal fee. Run this function
within the License batch process. Choose “None” if there is no renewal fee.
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Renewal Fee Code Select the code for the fee item you want to use to calculate the renewal fee.

Penalty Fee Function Select the function you want to use to generate the penalty fee. Run this function within
the License batch process. Choose “None” if there is no penalty fee.

Penalty Fee Code Select the code for the fee item you want to use to calculate the penalty fee.

Pay Period Group Select the payment period group you want to use for this renewal process. For any
license that follows this renewal process, Civic Platform assesses only fees that
belong to a payment period within this group. For example, you can configure a “2013”
payment period within the Retail License payment period.

Status If you want to start using this renewal process, click “Enable”; otherwise, click
“Disable.”

Searching for a Renewal Process
To review, update, or copy an existing expiration code, you must first search for it.

To search for a renewal process

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > Renewal Info.

Civic Platform displays the Find Expiration Code—Search page.

3. Complete the necessary fields as described in Expiration Code Fields.

4. Click Submit.

Civic Platform displays a list of all expiration codes that match your search.

Editing a Renewal Process
After you add a renewal process to Civic Platform, you might need to change some details about it, such
as the expiration interval or the fee function used to assess penalty fees. Any changes that you make here
do not affect existing licenses.

Note:

You cannot change the expiration code or delete the renewal process because existing business licenses
can reference them.

To edit a renewal process

1. Search for an expiration code. For instructions, see Searching for a Renewal Process.

2. Click the red dot next to the expiration code you want.

Civic Platform displays the Expiration Code—Edit page.
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3. Complete the necessary fields as described in Expiration Code Fields.

4. Click Save.

Civic Platform saves the expiration code.

Copying a Renewal Process
Instead of adding a new renewal process, you can copy an existing process and change the expiration
code, description, intervals, and other details.

To copy a renewal process

1. Search for a expiration code. For instructions, see Searching for a Renewal Process.

2. Click the red dot next to the expiration code you want.

Civic Platform displays the Expiration Code—Edit page.

3. Click Copy.

Civic Platform displays the Expiration Code-Add page with the same values as the first expiration code.
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4. Complete the necessary fields as described in Expiration Code Fields.

5. Click Submit.

Civic Platform saves the new renewal process.

Managing Application Types
Application types let you organize the complex processes, inspection tasks, and any other important
information required to issue a permit or license. Each time a user wants to perform a daily task in Civic
Platform, such as schedule an inspection, the user must search for an existing application or create a new
application.

The application type determines what information users must provide for a new application, such as
information about a billing contact. It also dictates any activities that a user can perform for an existing
application, such as assessing certain fees or completing certain workflow tasks.

Note:

After a user creates a new application, they cannot change the application type. You can edit an application
type as well as any components associated with it, such as workflow processes, but those changes do not
affect existing applications.

Topics

• Adding an Application Type

• Editing an Application Type

Adding an Application Type
When you set up an application type, you specify the components of the application, such as the fee
schedule, the inspection group, and the workflow process.

You also determine the type of contact, licensed professional, owner, parcel, and address information
associated with the application. You set up these details in the SmartChoice group associated with the
application type.

If you require additional information about a specific application, you can add custom fields to the
application type. You set up these details in the Specific Information group associated with the application
type.

Before you create a new application type, you set up the fee schedules, the inspection lists, and the
workflow processes. You also set up the application specific information, SmartChoice, and document
group codes. Keep in mind that you can add this information later, also, when you edit the application type.

To add an application type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > App Type.

Civic Platform displays the Application Type page.
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3. Select the group to which you want to add a type.

4. Click Add.

Civic Platform displays the Application Type—Add page.

5. Complete these fields:

Type Enter the application type. You can also click Select to choose a pre-defined type.

Subtype Enter the application subtype. You can also click Select to choose a pre-defined
subtype.

Category Enter the application category. You can also click Select to choose a pre-defined
category.

6. Click Submit.

Civic Platform displays the Application Type—Add Detail page.
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7. Enable for ACA: If you use Citizen Access, specify the following.

• Enable Application: Click this option to allow Citizen Access users to submit this type of application
online.

• Also Enable Issuance: If you specify Enable Application, you have the additional option to approve
and issue the application type through Citizen Access.

• Enable Fee Estimation: You must enableFID 0244 for this option to become available. Click
this option if you want to allow users to create a partial application in Citizen Access that includes
a calculation of estimated fees. Civic Platform does not count partially completed applications as
regular permit applications.

Note:

This option only applies to record types that you specify as “available for fee estimation.” For
instructions on making record types available for fee estimation, see Enabling Fee Estimation.

8. Complete the necessary fields as described in Permit Application Type Fields.
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9. Click Submit.

Civic Platform adds the application type to Civic Platform.

Table 201: Permit Application Type Fields

Status If you want to start using this application type in Civic Platform, select “Enable”;
otherwise, select “Disable.”

Category Code Enter a unique three-character code to identify this application category. Civic Platform
appends this code as a prefix to any new applications in this category.

Fee Schedule Select a pre-defined fee schedule.

Inspection Group Code Select a pre-defined inspection group code.

Workflow Select a pre-defined workflow process code.

App Specific Info Group
Code

Select a pre-defined specific information group code.

SmartChoice Group
Code

Select a pre-defined SmartChoice group code.

Email for Hearing
Notification

Enter the email address for the individual responsible for attending hearings. Hearing
notifications and changes to hearing schedules go to this email address.

Expiration Code Choose an expiration code from the drop-down list. Your agency defines these values.

Document Code Select a default document code and document type. Your agency defines document
codes and document types; see Managing Documents for Attachments.

Appl Status Group Code Enter the code that applies to the specific status group you want to access. For more
information, see Working with Application Status Groups.

Editing an Application Type
After you set up an application type, you might need to make changes to it. You can change any of the
components associated with the application type. For example, you can associate a new fee schedule with
an existing application type. You can also change the application type, subtype, or category name. Civic
Platform requires this for historical reference purposes.

To edit an application type

1. Access the Classic Administration page (Accessing Classic Administration).

2. Choose Application > App Type.

Civic Platform displays the Application Type page.

3. Select the application type, subtype, and category that you want to change.

Civic Platform displays all four application type levels.

Note:

You must select all application type levels to edit the type.

4. Click Edit.

Civic Platform displays the Application Category—Edit window.
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5. Enable for ACA: If you use Citizen Access, specify the following.

• Enable Application: Click this option to allow Citizen Access users to submit this type of application
online.

• Also Enable Issuance: If you specify Enable Application, you also have the option to approve and
issue the application type through Citizen Access.

• Enable Fee Estimation: You must enable FID 0244 for this option to become available. Click
this option if you want to allow users to create a partial application in Citizen Access that includes
a calculation of estimated fees. Civic Platform does not count partially completed applications as
regular permit applications.

Note:

This option only applies to record types that you specify as “available for fee estimation.” For
instructions on making record types available for fee estimation, see Enabling Fee Estimation.

6. Complete the necessary fields as described in Permit Application Type Fields.

7. Click Save.

Civic Platform saves the changes to the application type.
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Part 11: System Diagnostics
Civic Platform provides functions specific to GIS integration diagnostics.

Related Links

Accela GIS Integration Diagnostics

Accela GIS Integration Diagnostics
Civic Platform provides diagnostic tools that enable you to troubleshoot legacy Accela GIS integration
issues in these areas:

• Communication between Civic Platform and the legacy Accela GIS

• Data linking between Civic Platform and the legacy Accela GIS, namely, the association between
assets and GIS objects, between parcels and GIS objects, and between records and GIS objects.

• Auto-populating application-specific information into the application intake form

• Auto-assigning inspectors when users schedule inspections

• Parameters in the legacy Accela GIS related EMSE scripts

When legacy Accela GIS diagnoses an issue, it displays a diagnosis result that lists the specific problem,
possible cause of the problem, and a troubleshooting suggestion for possible solutions to resolve the
problem. If the troubleshooting suggestion does not resolve the problem, contact Accela Customer
Support.

To diagnose Civic Platform GIS (JavaScript version), go to the Diagnostics page of the Civic Platform GIS
Administration Site. For details about the Civic Platform GIS Diagnostics page, see the Civic Patform GIS
System Administration in Accela Civic Platform GIS Administrator Guide.

For information about legacy Accela GIS diagnostics, click a topic below for full details.

Related Links

Troubleshooting the Connection with GIS

Troubleshooting Data Linkage

Creating a Trace Log

Troubleshooting the Connection with legacy Accela GIS
The Connection diagnostic tool can diagnose the most common issues on the connection with the legacy
Accela GIS Server and offer solutions for you to troubleshoot the issues. For example, it checks whether
Civic Platform can communicate with the legacy Accela GIS server successfully and whether the GIS
Service settings are correct.

To troubleshoot the connection with legacy Accela GIS

1. Access the Accela GIS Integration Diagnostics Portlet (Accessing the the legacy Accela GIS Integration
Diagnostics Portlet).
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2. Click the Connection tab.

Civic Platform displays the Connection diagnostic tool.

3. Select the GIS service that you want to diagnose from the GIS Service drop-down list.

4. Click the Diagnose button.

Civic Platform tries to establish a connection with the selected GIS service and displays the diagnosis
result.

Troubleshooting Data Linkage
The Data Linkage diagnostic tool applies to legacy Accela GIS and examines whether there are any issues
in the association between assets and GIS objects, between parcels and GIS objects, or between records
and GIS objects. This diagnostic tool also offers solutions for you to troubleshoot any issues.

To troubleshoot the data linkage

1. Access the Accela GIS Integration Diagnostics Portlet (Accessing the the legacy Accela GIS Integration
Diagnostics Portlet).

2. Click the Data Linkage tab.

Civic Platform displays the Data Linkage diagnostic tool.
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3. Select the type of entity for which you want to check the data linkage from the Entity Type drop-down
list. There are three options in this drop-down list: Asset, Parcel, and Record.

Civic Platform displays the fields according to the entity type you selected.

4. Complete the fields that appear:

• For assets

Asset Group Select the group of the asset that you want to diagnose.

Asset Type Select the type of the asset that you want to diagnose.

Asset ID Enter the identification number of the asset that you want to diagnose.

• For parcels, enter the parcel number in the Parcel # field.

• For records, enter the record identification number in the Record ID field.

5. Click the Diagnose button.

Civic Platform examines any legacy Accela GIS object that has an association with the selected entity,
and then displays the diagnosis.

Creating a Trace Log
The Log Trace tool enables you to create a log of traces when you are troubleshooting problems in these
areas:

• Auto-populating application-specific information into the application intake form

• Auto-assigning inspectors when users schedule inspections

• Parameters in the legacy Accela GIS related EMSE scripts

To create a trace log
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1. Access the Accela GIS Integration Diagnostics Portlet (Accessing the the legacy Accela GIS Integration
Diagnostics Portlet).

2. Click the Log Trace tab.

Civic Platform displays the Log Trace tool.

3. Select the areas for which you want to enable tracing:

• ASI Population

• Auto Assigning Inspector

• GIS Related EMSE Scripts

4. Click the Start button.

Civic Platform turns on tracing.

5. Ask the user who reported the issue to reproduce the issue on his or her site.

You can also reproduce the issue on your own, if possible.

6. When the user reproduced the issue, click the Stop button on the Log Trace tool.

Civic Platform turns off tracing and displays trace information in the Diagnosis Result area.
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